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 382 ........................................................................... המסוננות  הנקודות מספר צמצום
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 כללי
 

  במידה   המינים  שני  לבני  מופנה  הינו  אולם,  זכר  בלשון  מנוסח  ההדרכה  ספר  :הערה חשובה 
 זהה.

 
הת של  כלליות  בפעולות  דן  שלפניך  גבי    כנה,והפרק  על  הנתונים  של  וארגון  מחלוקה  החל 

המסך, ריכוז פעולות כלליות ועוד. הפרק מהווה כמעין פתיחה ונותן מושג בהפעלה ראשונית  
 . תוכנהשל ה

 
 הנושאים בפרק זה:

 
 (. AutoCAD/ZWCADת תיב"מ אחרות )ועבודה כיחידה עצמאית או עם תוכנ 
 חלוקת המסך. 
    סרגלי הכלים. 
 . פרויקטים עבודה עם  
 )שחזור מידע הרוס(. Noname  -ו Prototypeהפרויקטים  
 טיפול בשכבות. 
 . Unused -ו  Pick  ,Locate , Selectההבדלים בין  
 אתחול המערכת.  
 (.ZIPלהעברה ממחשב למחשב )  פרויקטשמירת  
 CivilCAD 10שימוש בעזרה מתוך  

 

 ( /ZWCADAutoCADת תיב"מ אחרות )ועבודה כיחידה עצמאית או עם תוכנ
 

ת תיב"מ אחרות )בשלב זה, העבודה ומסוגלת לעבוד או עם תוכנ CivilCAD 10כנת תו
 (.ZWCADאו  AutoCAD 2018-2020אפשרית עם תוכנות 

 
מותקנת במערכת, ברצונך לעבוד עם   AutoCAD/ZWCAD -יתכן מצב, שלמרות שה

CivilCAD 10 :כיחידה עצמאית. במקרה כזה יש לבצע את סדר הפעולות הבא 
 

 .CivilCAD 10ת הפעל א .1
 File → Open Projectמסרגל התפריט הראשי הפעל:     .2
 (.Prototype.prj)יש לחפש קובץ:   Prototypeבחר בפרויקט   .3

 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  11עמוד 

 
 הפרויקט נמצא במיקום ברירת המחדל:  Windows 7/8/10במערכת הפעלה 

C:\ProgramData\SivanDesign\CivilCAD\Prototype.prj\ 
 

 . יפתח חלון. File → Configuration   לאחר שהפרויקט עלה, הפעל: .4
 (. General settingsבחר בלשונית הראשונה )  .5
 " NO"  –, העבר למצב העבודה הרצוי Auto launch   -ליד הכיתוב  .6
 .OKלחץ  .7
 ( לשמירת השינויים. Yes, ולחץ 'כן' )File → Exitהפעל:    .8

 
 

 חלוקת המסך 
 

 חלונות:  2, יופיע מסך עם CivilCAD 10עם הפעלת 
 לון השרטוט. ח .1
 . קואורדינטותהחלון עורך  .2
 

  מהתפריט הראשי יפתח חלון נוסף בהתאם. מסוימתבעת בחירה 
 

 חלון השרטוט
נו החלון המרכזי, התופס את מרבית אזור העבודה, וממוקם בחלקו העליון  יחלון השרטוט ה

לון זה  הנוכחי. חשוב לציין שמטרת ח והפרויקט תוכנהשל המסך.חלון זה מציג את שרטוטי ה
כנת  ואינה באה כתחליף מלא לת CivilCAD 10כנת ואינה לאפשר שרטוט ביד חופשית )ת

כנת שרטוט רגילה(, כי  ושרטוט, אלא משמשת ככלי עזר וביצוע פעולות שאינך יכול לבצע בת
תוך כדי ריכוז פעולות המאפשרות סריקת השרטוט,  גראפיתהנתונים בצורה את אם להציג 

אך הן קיימות  נן למעשה פעולות שרטוט יפעולות שה)קיים מס' רב של הוספת נתונים וכד' 
, כגון הוספת נקודות מתוך השרטוט, חיבור  תוכנהרק במסגרת הפעולות הסטנדרטיות של ה

(. בעבודה עם תוכנות תיב"מ אחרות הספרקווים וכד'. פעולות אלה ידונו בפרקים אחרים של 
 (. AutoCAD/ZWCADעמה עובדים )יוחלף חלון זה בחלון השרטוט של התוכנה 

 
 קואורדינטות החלון עורך 

מרכז את רשימת הנקודות של המצב הקיים )נקודות מדידה( ו/או המצב   קואורדינטותהחלון 
המתוכנן )נקודות מדידה לאחר ביצוע, נקודות תכנון וכד'(. )פעולות החלון הן נרחבות ונדונות  

 (. קואורדינטותהמאגר  -בהרחבה בפרק 
 

 נות העבודה שולח
חלון העבודה ממוקם בצד הימני של המסך. )ניתן בכל שלב לסגור חלון זה על מנת לאפשר 

מרחב גדול יותר לסביבת השרטוט(. על גבי חלון זה יופיעו מסכים שונים אשר יציגו את  
, כגון חישוב ושרטוט קווי גובה, שרטוט מבטים תלת ממדיים,  תוכנההפעולות האפשריות ב

 ומטריים ועוד. חישובים גיא
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 סרגל הכלים הסטנדרטי
סרגל הכלים הסטנדרטי מופיע בד"כ מתחת לתפריט הראשי ומעל לסביבת השרטוט.  

במסך   אזור  לכל  להזיזו  גם  אותוניתן  סביבת    ולנעול  בתוך  ננעל  )אינו  שונה  במיקום 
שניתן  הפעולות  הראשי.  בתפריט  גם  קיימת  הכלים  בסרגל  פעולה  כל  השרטוט(. 

 מסרגל זה:  להפעיל
 
 

  New  -  חדש.  פרויקטפתיחת 
 

  Open  -   קיים.   פרויקטפתיחת 
 

  Rotate points - או על פי שכבה קו על פי יישור נקודות . 
 
 

 Rotate by singleבחר באופציה:ו Rotate pointsעל כפתור  לחץ - ליישור נקודות על פי קו 
line . 

לבחירת  'Command + Enter 'S , –ה  הקלד בשורת .סמן את הקו שישמש כקו עזר
 .הקו לסיבוב(  עללבחירת כל הנקודות שנמצאות  'Enter  'A +הנקודות הרצויות לסיבוב )או

שוב ולאחר  Enterהקש  ,הזן זווית רצויה  .   Enterהקש סמן את הנקודות הרצויות בשרטוט ו
לזווית שהוזנה. כלי זה . הנקודות יסתובבו ביחס לקו בהתאם Refreshמספר שניות לחץ על 

לאורך קו, שוחות, עמודי תאורה וכו' ביחס לקו יעיל עבור יישור נקודות כגון כיתוב גבהים 
 משתנה כגון ציר דרך או מדרכה.

 Rotate byובחר באופציה:  Rotate pointsלחץ על כפתור  – ליישור נקודות על פי שכבה
line at layer, חלון .Rotate points’ block’  פתח: יי 

 

 
 

 ובחר שכבה מתוך השרטוט. Selectבחר את השכבה הרצויה מהרשימה או לחץ 
 . OKהגדר זווית רצויה לשינוי ולחץ 
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   Pick height - ור זה יש ללחוץ על דגימת גבהיי הקרקע. לאחר לחיצה על כפת
בחלקו התחתון   (ומתוכנן קיים) בשרטוט, התוכנה תציג את הגבהיםהמיקום הנדרש 

 .Height_D, Height_Tר של המסך ליד הכיתובים ביות
 
 

  Layers control  - .פתיחת חלון השכבות 
 

     Add To ZIP  -  Volume size "Auto detect"  –    כיווץ של הפרויקט לתוך
 . ZIPקובץ 

 

   Extract From ZIP –  קובץ מ  ישירותהפרויקט  פתיחתZIP . 
 

   Configuration - ת הראשי.הפעלת חלון ההגדרו 
 

   Extract -  ביצוע מהיר של פעולתExtract . 
 

  Tutorials - .הפעלת סרטוני הדגמה ללימוד התוכנה 
 

  Help  -  בפתח לפי השפה שמוגדרת יהעזרה )י הפעלת חלון- (Configurations  
 

    Refresh  -    יעודכנו בהתאם   קואורדינטותהרענון השכבות ע"ג השרטוט )שכבות
 האחרונים(.  לשינויים

 

  Refresh All -  קווי הרציפות ומשטחים מתוכננים.קואורדינטותהרענון שכבות , 
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 פרויקטים עבודה עם  
מתחילים, בין אם לצורך מיפוי טופוגרפי גדול מאד ובין אם לצורך   כל עבודה חדשה שאנו

ונה מסוים. מכאן שההפעלה הראש פרויקטחישובים גיאומטריים בסיסיים, תרוכז תחת 
שכבר עבדנו עליו(,   פרויקטלצורך התחלת עבודה )אלא אם כן אנו פותחים  תוכנהשנבצע ב

 (. Nonameחדש )ראה פרוט על פרויקט  פרויקטנה פתיחת יה
 

  File → New projectהפעל:  חדש  פרויקטלצורך פתיחת 
 (.  New projectלפניך תפתח "תיבת דו שיח קבצים" )עם כותרת: 

 
בתיקיית   prj.* -פעמיים באמצעות הכפתור השמאלי בעכבר על קובץ ה ניתן גם להקליק 

 הפרויקט 
 
 
 

 שיטת עבודה מומלצת  

  הפרויקט , נקיש את שם  File→ New projectחדש נפעיל    פרויקטכאמור, לצורך פתיחת  
ה מקש  על  ונלחץ  הקובץ"  "שם  בשורה  ה   Enter  -הרצוי  כפתור  או    "פתח " -במקלדת, 

בכותרת, שהיא ספריית  החדש    הפרויקטשבמסך.   .  הפרויקטיפתח בשם הספרייה המופיע 
ה פרויקט תפתח  זהה לשם    תוכנהלכל  רב של קבצים בעלי שם  אך בעלי  הפרויקטמספר   ,

בעבודה.   נוחות  לאי  לעתים  לגרום  עלול  רבים,  קבצים  פתיחת  של  זה,  מצב  שונה.  סיומת 
לכל   לפתוח תת ספרייה  כן,  , אם  כל שפרויקטמומלץ  כך  הוא להשתמש . לשם  יש לעשות 

שנוצרה   הספרייה  תוך  אל  להיכנס  הספרייה,  שם  את  לציין  חדשה,  ספריה  יצירת  בכפתור 
את שם   ולהקליד  בחלון(  המופיע  הספרייה  ציור  על  כפולה  בכיתוב    הפרויקט)לחיצה  הרצוי 

 ייווצרו בספרייה זו.  הפרויקטה שנוצרה וכל קבצי יפתח בתוך הספריי הפרויקט"שם הקובץ". 

 

 )שחזור מידע הרוס(   Noname-ו Prototypeהפרויקטים 
 

 . וקבועים ייחודיים קיימים שני פרויקטים   CivilCAD 10בתוכנת 
 

 Prototypeפרויקט 

אבPrototypeפרויקט   מהווה  הוא,  כן  כשמו  ע"י  -,  נפתחים  אשר  הפרויקטים  לשאר  טיפוס 
יימים כבר במערכת, וכל ישפיע על פרויקטים קודמים אשר ק  לא  Prototypeהתוכנה. ככלל  

 שינוי בפרויקט זה יבוא לידי ביטוי רק בפרויקטים חדשים.
ה מהלך   Prototype  -בפרויקט  כל  את  ישמשו  אשר  קבועות  הגדרות  על  להחליט  ניתן 

העבודה בתוכנה. דוגמאות להגדרות כאלה הנן שינוי כותרת החברה ע"ג הדוחות המודפסים,  
 קביעת קנ"מ לעבודה ועוד. 

 וי הגדרה יש לבצע הפעולות הבאות:לשם שינ

 . Prototypeפתיחת פרויקט  .1
 שינוי ההגדרה הרצויה.  .2
 יציאה מהפרויקט תוך כדי שמירת השינויים.  .3
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אוטומטי  אופן  ברש'  יצעת, וכל פרויקט חדש שיפתח 'ייישמרו השינויים שבימשלב זה והלאה  
 תכונות אלו.

 

 ם ברירת המחדל: הפרויקט נמצא במיקו Windows 7/8/10במערכת הפעלה 
C:\ProgramData\SivanDesign\CivilCAD\Prototype.prj 

 

 ושחזור מידע הרוס  Nonameפרויקט 

זה יה   Nonameפרויקט   פרויקט  הפעלתה.  ברגע  התוכנה  עם  שעולה  הראשון  הפרויקט  נו 
פרויקט   עבודה.  תחילת  לשם  חדש  פרויקט  לפתוח  ועליך  לשימוש  מיועד    Nonameאינו 

רג עבודה  ימאפשר  אך  התוכנה,  עם  מעבר  יילה  או  התוכנה  סגירת  עם  מיידי  באופן  מחק 
פרויקט   על  עבודה  התחלת  בכ"ז  אם  אחר.  פעולת  Nonameלפרויקט  את  להפעיל  תוכל   ,

Save as .ולשמור את העבודה שכבר בוצעה תחת שם חדש 
והוא  Nonameלפרויקט   תכנו מספר מקרים שבהם בוצעה י. יבשחזור מידע, תפקיד מרכזי 

בהפעלת י בעיות  חשמלי,  מתח  )נפילת  נתונים  שמירת  ללא  מהתוכנה  חוקית  לא  ציאה 
Windows    .)'וכוCivilCAD 10    ושומרת לפעולות שבוצעו  גיבויים  הפעלתה  במהלך  יוצרת 

( מהתוכנה  חוקית  יציאה  בוצעה  ולא  במקרה  נסתרים.  בקבצים  ( File → Exitאותם 
CivilCAD 10    ודשת שתבצע )לאחר נפילת התוכנה(ובהפעלה הראשונה המחתזהה זאת, 

תנסה התוכנה לשחזר את הפרויקט האחרון שעליו עבדה. השחזור שיבוצע )בין אם חלקי או  
פרויקט   לתוך  אוטומטי  באופן  יועתק  יש   Nonameמלא(  זה  בשלב  השחזור.  בסיום  ויוצג 

 . File → Save asלבצע באופן מיידי שמירת הפרויקט תחת שם חדש בעזרת 
 

 
 הפרויקט נמצא במיקום ברירת המחדל:  Windows 7/8/10ת הפעלה במערכ

C:\ProgramData\SivanDesign\CivilCAD\Noname.prj 
 

 בשרטוט. מופיעים.אינם אך אלה שחזרה נתונים  CivilCAD 10 -יתכן ו :הערה 
 במקרה זה תוכל לאלץ את התוכנה לבצע רענון השרטוט באופן הבא:  

 קודות.הבא את הסמן לשורת עריכת הנ .1
 . Enterלחץ על  .2

 שמעל לחלון השרטוט.   Refresh לחץ כפתור .3
 . Zoom Extentsהפעל  .4
 

 טיפול בשכבות 
נה תפיסה המאפיינת ימופרד השרטוט לשכבות. "תפיסת השכבות" ה  CivilCAD 10כנת  ובת

רבות אשר מחלקות את השרטוט לפי שכבה מסוימת לכל חלק מהשרטוט, וכך    תיב"מתכנות  
 ורה נוחה בתצוגה ובצבע של השכבה המסוימת. ניתן לשלוט בצ

הנוחות, ל לשם  שבו,  מצב  יתכן  קיימים,  גובה  קווי  גבי  על  תכנון  לבצע  ברצוננו  אם  דוגמא: 
כלשהו.  בהיר  בצבע  צביעתם  ע"י  נעשה  וזאת  עבודה  כרקע  להיות  הגובה  קווי  את  נעביר 

צרו שכבות  ויוי  נהתוכ, ז"א שבמהלך הפעלת היוצרת שכבות קבועות  CivilCAD 10כנת  ות
כגון   חריגות,  מספר  קיימות  זו  )לעובדה  שבצענו  הפעולה  לסוג  בהתאם  פעם  כל  ספציפיות 

 ניתן לקבוע שם ספציפי(. להן אשר שכבות הקודים 
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  Layers controlפעולות מסך 

המסך     בעזרת  השכבות  בתצוגת  לשלוט  זה Layers controlניתן  מסך  הפעלת  לשם   .
השכבו כפתור  על  השרטוט(.לחץ  חלון  )מעל  הראשי  הכלים  בסרגל  הנמצא  יפתח   ת  מימין 

 הספציפי.  בפרויקטחלון השכבות. החלון מציג את רשימת כל השכבות הקיימות 
-בחלקו התחתון של החלון מרוכזות הפעולות האפשריות של השכבות והן*: הקפאת שכבה  

Freezeויציר חדשה  שכבה  יצירת  שכבה,  מחיקת  שכבה,  צבע  שינוי  קובץ  ,  של    DXFת 
 שכבה/שכבות ספציפיות. 

 
תופיע רק האפשרות למחיקת שכבה. כל    AutoCAD/ZWCADבעבודה עם סביבת  הערה:*

שכבות   הקפאת  בהן  האפשרויות   Layer Properties-הבחלון    יבוצעוצבעים,  י  ונושישאר 
Manager  ה של  השכבות    AutoCAD/ZWCAD  .(CivilCAD 10  -הרגיל  את  תיצור 

במק בהחדשות  הן  ב  Layer control  -ביל  והן  ה  Layer control  -שלה  של   -הרגיל 
AutoCAD/ZWCAD   השכבות יהיו זהות מלבד שינוי קל בשמות השכבות, לדוגמא:שכבת .

Topography contours 0 ב- CivilCAD 10ו ,- Tcontours0 ב- AutoCAD/ZWCAD.) 

 . '’Layers Control  , לחץ על כפתור DWTעבור כל שכבת  Styleלהגדרת 
 ייפתח.  ’Layers Control‘חלון 

 .  ’Layers Settings‘לחץ על כפתור 
 

 . Styles –ע"י בחירתו מרשימת ה  DWTעבור כל שכבת  Styleהגדר 
 

 לשמירת ההגדרות.   לחץ על כפתור

ב   ובחר את הקובץ     שהוגדרו, בפרויקט חדש, לחץ על כפתור  Styles  –כדי להשתמש 
 הרצוי. 

 
Freeze - הקפאת שכבה 

מחק, אלא תוסתר באופן זמני. יבאפשרותנו להעלים שכבה שלמה מהשרטוט. שכבה זו לא ת
לסמן שכבה  ברשימת השכבות. באפשרותך  אלה  לשם הקפאת שכבה/שכבות סמן שכבות 

לאחר *יחדיו.  שכבות  מספר  או  וי אחת  סמן  הרצויות  השכבות  המילה "(  V)"   סימון  ליד 
Freezeלמות מיידית של השכבות האמורות.. תוכל להבחין בהע 

 
 * סימון מספר שכבות יחדיו יתבצע באחת מהצורות הבאות: 

 גרירת הסמן תוך כדי לחיצה על כפתור העכבר ע"ג השכבות הרצויות.  .1
האחרונה  .2 השכבה  על  העכבר  עם  לחץ  לסימון  בקבוצה.  הראשונה  השכבה  סימון 

החזק   את  Shiftכפתור  את  בקבוצה,  וסמן  לחוץ  האחרונה   במקלדת  השכבה 
 הרצויה.    

 במקלדת וסימון שאר השכבות הרצויות.  Ctrlסימון שכבה, החזקת כפתור  .3
 
 
 

 שינוי צבע שכבה 
 Colorשינוי צבע של שכבה/שכבות מתבצע ע"י לחיצה על ריבוע הצבע המופיע מימין למילה  

י לפניך  ולחץ  י .  הרצוי  הצבע  את  סמן  הצבע.  בחירת  חלון  צבע    O.Kפתח  לאישור. 
 השכבה/שכבות ישתנה בהתאם.
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 מחיקת שכבה 
כפתור   על  ולחץ  למחיקה  הרצויות  השכבות  את  מחיקת " מחק" סמן  הודעת  תופיע  לפניך   .

י האישור  לאחר  השכבותיהשכבות.  ניתן  מחקו  לא  זו  שבפעולה  לב  שים  מהשרטוט.  הנ"ל 
ה  Undoלבצע   הפעולה  של  חוזרת  הפעלה  ע"י  יתבצע  שנמחקה  שכבה  שיחזור  רצויה . 

לבצע   תוכנהב עליך  יהיה  מחדש  להציגן  וברצונך  הנקודות  שכבת  את  אם מחקת  )לדוגמא: 

כלשהו   על  שינוי  וללחוץ  הנקודות  אינו  Refreshברשימת  השינוי  בעל  .  להיות  חייב 
תלחץ    לדוגמא  שתשתולמספיק    -שמעות  מ אפילו  או  השורות,  באחת  נוסף    Enterרווח 

    Refreshכדי ליצור שינוי אשר בזמן לחיצה על די בכך  -עובד על שורה מסוימת  אתהכש
 ישחזר את השכבות הנ"ל(.    

 
 של שכבה DXFיצירת קובץ  
יצוא כל השרטוט  DXFיצוא קובץ   יכול להתבצע בשתי דרכים:  בעזרת כפתור  של השרטוט 

DXF    ראשי הנמצא בחלון השרטוט ו/או בעזרת כפתורDXF  השכבות. ליצוא   הנמצא בחלון
.   DXF  -ל שכבה/שכבות ספציפיות סמן תחילה שכבות אלה ולחץ על כפתור ה  ש  DXFקובץ  

הרצוי. הקלד   DXF  -להקליד את שם קובץ ה לפניך תופיע תיבת דו שיח קבצים ותתבקש  
 הכולל רק את השכבות המסומנות. DXFתיצור קובץ  תוכנה. הEnterאת השם ולחץ 

 
 

 Unused  -ו Pick, Locate, Selectההבדלים בים 
,  Pick    ,Locateמופיעה תיבה הכוללת את ארבע האופציות הבאות:    תוכנהבמסכים רבים ב

Select    ו–  Unused    .התיבה יכולה לכלול את כל ארבע האופציות או שילוב של חלק מהן(
 (.AutoCAD/ZWCADרק בגרסת  המופיע Selectאופציית )

יחסת למסך בו היא נמצאת.  לתיבה זו שימוש דומה בכל המסכים, כאשר בכל פעם היא מתי
. פירושו של ערך זה  Unusedכאשר נפתח מסך הכולל תיבה זו ערכה הראשוני תמיד יהיה  

 נה חסרת שימוש וחסרת השפעה ברגע זה.יהוא כי האופציה הנ"ל ה
 נם: ישלושת הערכים הנוספים ה

 Pick  -   ,בו תמקם את הסמן שלך ז"א שבכל מקום  "באופן חופשי",  נקודה  בחירת 
 : Topography planesבחר הנקודה. נדגים השימוש בפעולה זו ע"ג מסך ית שם

את Topography  →  planesהפעל   .1 בתוכו  הכולל  החלון,  יפתח  מימין   .
 התיבה האמורה. 

 השרטוט. אזור ועבור אל   Pickסמן בתיבה את המילה  .2
תוכל להבחין כי הנקודה סומנה,    -לחץ עם העכבר על אזור מסוים בשרטוט    .3

התחתונה וכמו כן, נוספה   קואורדינטותטה שלה נוספה לרשימת האאורדינהקו
 המשטח מימין.  הנקודה לרשימת הנקודות המגדירות את

 
וכן   הנוכחיות  הפעולות  כל  את  מיידי  באופן  תבטל  הימני  העכבר  כפתור  על  לחיצה  הערה: 

 .  Unused -תחזיר את מצב כל התיבות ל 
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 Locate  -  לנקודהיה )איתור(  ה  צמדות  במאגר  כבר  קיימת   קואורדינטותאשר 
ה כאשר  ב  יהתחתון.  משתמש  העכבר  Locate  -נך  סמן  כדי  מתחלף  לריבוע.   *

העיקר   היכן,  חשוב  )לא  הריבוע  תוך  אל  זו  נקודה  הבא  מסוימת,  לנקודה  להיצמד 
שבתוך הריבוע( ולחץ עם העכבר. הנקודה "תאותר" בהתאם לפעולה הרצויה. שים 

כי ההתייחסות ב יתכן מצב שבו    Locate  -לב  כך שלא  עצמה,  לנקודה  היא תמיד 
Locate .ייצמד לדוגמא לכיתוב הטקסט או כדומה 

 

 . Point-ל  ObjectSnapיופיע במקום ריבוע,    AutoCAD/ZWCAD*בגרסת 
: טעות נפוצה היא לנסות ללכוד נקודות ע"י הצלבת נקודות בין רשימת מצב קיים  טיפ

שבו נקודות ברשימת המצב הקיים    פרויקט: ברשותנו  לרשימת מצב מתוכנן, לדוגמא
(Topography Coordinates)   המתוכנן גם  ו המצב  ברשימת  נוספות  נקודות 

(Designed Coordinates)  נניח הנ"ל  ע"ג השרטוט את שתי הרשימות  .אנו נראה .
ורק למצב   Topography planesשהפעלנו את הפעולה   אך  זו מתייחסת  פעולה   .

כ שה  הקיים,  יאתר  Locate  -ך  זו  פעולה  נקודות  ו  אך  של   רשימתמתוך  רק 
Coordinates  Topographyבפ ננסה  אם  המופיעה  .  לנקודה  להיצמד  זו  עולה 

, למרות שנקפיד על הכללים של הסמן, נקודה זו  Designed Coordinates  רשימתב
 תילכד. לא

 
 Select  –   בגרסת רק  )אפשרי  השרטוט  מתוך  קיים  קו  בחירת 

AutoCAD/ZWCAD  .)קו מסוים אשר אמור לשמש כקו אי  קיים בשרטוטו  הנחהב-
א גובה,  קווי  גבול  קו להגדרת  כך רציפות,  אותו  לבחור  וברצונך  לכל שימוש אחר,  ו 

, לעבור לאזור Select  -עליך לבחור את אופציית ה    -  שישמש למטרה אליה הוא יועד
 יבחר ישמש לייעודו. י . הקו שEnterהשרטוט, לבחור את הקו הרצוי וללחוץ  
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 אתחול המערכת 
 

  פרויקטמאפשרת לקבוע הגדרות המאפיינות את צורת העבודה בכל  CivilCAD 10תוכנת 
אשר נתחיל לעבוד בו. בכל פעם שנרצה לקבוע או לשנות את ההגדרות הקבועות,   חדש

 ,נשנה את ההגדרות ונבצע שמירה Prototype–ב  המיועד לכך הפרויקטנפתח את 
 . קטלפרוי

 
 

 הפרויקט נמצא במיקום ברירת המחדל:  Windows 7/8/10במערכת הפעלה 
C:\ProgramData\SivanDesign\CivilCAD\Prototype.prj\ 

 
 

 הגדרת שפת עבודה 
מאפשרת לעבוד בשפה העברית ובשפה האנגלית, שפת העבודה  CivilCAD 10תוכנת 

נה ושרטוטי החתכים של תקבע את השפה בה יוצגו הדוחות השונים של התוכ בפרויקט
 התוכנה.

 כדי לקבוע את שפת העבודה בצע את הפעולות הבאות:
 . File → Open projectהפעל: 

 . OK, ולחץ Prototype.prjבחר את פרויקט  
 .File → Configurationהפעל: 

 . Languageשנה את השפה לשפה הרצויה תחת הכיתוב 
 . OKלחץ 

 . File → Exitצא מהתוכנה ע"י: 
 שמירת השינויים.  אשר את

 
 חות מודפסים "הגדרת כותרת חברה לדו

, חישובי  קואורדינטותחות רבים כגון רשימות " מאפשרת הדפסה של דו CivilCAD 10תוכנת 
טומט, חישובי עבודות עפר, חישובי נתוני ציר וכו'. ניתן לקבוע לתוכנה כותרת אשר  נתוני דיס

 תשמש דוחות אלה בזמן הדפסתם.
 .General → Captionראשי הפעל:  מסרגל התפריט ה

לפניך יפתח חלון הגדרת כותרות. בחלון תוכל להגדיר את הכותרת )כגון שם חברה(  , פרטי  
.  OKח וכן תוכל להוסיף כל מלל חופשי שתרצה שיופיע ע"ג הדוח. לסיום לחץ " מפיק הדו

 שר הכנסת. ח אשר יודפס בפרויקט הנוכחי )ובו בלבד(, יופיעו הנתונים א" מעתה בכל דו
נך ילהזין כותרת קבועה אשר תשמש את כל הפרויקטים שבה ה  מעונייןנך יסביר להניח שה

 עובד )ושלא יהיה צורך בכל פרויקט להזינה מחדש(. במקרה זה בצע את הפעולות הבאות:
 . File → Open projectהפעל: 

 . OK, ולחץ Prototype.prjבחר את פרויקט  
 .General → Captionהפעל: 

 ה את כותרת החברה לכותרת הרצויה. שנ
 . OKלחץ 

 . File → Exitצא מהתוכנה ע"י: 
 אשר את שמירת השינויים. 
רש' אוטומטית את הכותרת שהכנסת )מובן שתוכל לשנות כותרת ימעתה כל פרויקט חדש 'י 

 לעיל(. שצוינהזו בכל עת בפרויקט ספציפי בשיטה 
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 בחירת תוכנת תיב"מ כסביבה הגראפית

  
            2018-2020כגון:  ת תיב"מ אחרותומסוגלת לעבוד עם תוכנ CivilCAD 10תוכנת 

AutoCAD  ו-ZWCAD. התוכנה אשר תשמש אותנו במהלך העבודה   כדי לבחור את
 בצע את הפעולות הבאות: CivilCAD 10פית של תוכנת כסביבה הגרא

 . File → Open projectהפעל: 
 . OKץ , ולחPrototype.prjבחר את פרויקט  

 .File → Configurationהפעל: 
 את התוכנה הרצויה. Auto launchבחר ליד הכיתוב 

 . OKלחץ 
 . File → Exitצא מהתוכנה ע"י: 

 אשר את שמירת הנתונים.
 

התוכנה שתועלה בתור הסביבה   CivilCAD 10מעתה בכל פעם אשר תפעיל את תוכנת 
 היא התוכנה אשר בחרת. הגראפית

 
 אטיתשמירה אוטומהגדרת 
ביצוע שמירה אוטומאטית ע"פ הגדרת זמן קבוע  מאפשרת לעבוד  CivilCAD 10תוכנת 
 .)בדקות(

 בצע את הפעולות הבאות: הגדיר שמירה אוטומאטיתלכדי 
 . File → Open projectהפעל: 

 . OK, ולחץ Prototype.prjבחר את פרויקט  
 .File → Configurationהפעל: 
 גדר כל כמה זמן )בדקות( ברצונך שתתבצע שמירהוה  Auto Save באופציהV" סמן " 

 .אוטומאטית
 . OKלחץ 

 . File → Exitצא מהתוכנה ע"י: 
 אשר את שמירת השינויים. 
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 הגדרת מצבי עבודה לכבישים
 

 למצב ההגדרות בכבישים: להיכנסכדי  הבאות  ראשית נבצע את הפעולות
 . File → Open projectהפעל:  .1
 . OK, ולחץ Prototype.prjבחר את פרויקט   .2
 . Roads → Cross sectionsהפעל:  .3

 

 :של חתכי הרוחב והמספורהגדרת המרחקים 
לפניך יפתח חלון הגדרת חתכי   -(Define sectionsשבחלון הימני ) בןהללחץ על הכפתור 
 הרוחב.          

Start at station-  בדרך כלל נרצה  0מרחק רץ של חתך הראשון. ברירת המחדל תהיה .
 .   0חק הרץ שיינתן לחתך הראשון בקטע הציר המתוכנן יהיה שהמר

End at station-   מרחק רץ לחתך האחרון. ברירת המחדל תהיה על פי אורכו של הציר כפי
 Roadsשיחושב על ידי התוכנה )אורך זה מופיע מיד עם פתיחת חלון חתכי הרוחב: 

length.) 
Distance between sections- מ'.   20רוחב. ברירת המחדל הנה המרחק בין חתכי ה 

Name of first section- מספרו(.מספור שאר החתכים יהיה   שמו של החתך הראשון(
 בסדר עולה ממספר זה.

תיבה זו מאפשרת בחירה בין הגדרת כביש/ציר,   -By stations/By IPs -תיבת הבחירה
יו נקבעו על פי  אשר חתכי הרוחב שלו מסודרים בסדר עולה, לבין הגדרת ציר אשר חתכ

, תעלים את שאר  By IPs -( של התוואי האופקי. העברת המצב ל IP -נקודות המפנה )ה
 השדות במסך. 

  הצגת שמות החתכים: 
Format1.שמות החתכים יוצגו לפי הכנסתם בטבלת החתכים : 
Format2020ּ+0לתי קבוע+מרחק רץ  לדוגמא:  ח: שמות החתכים יוצגו לפי מרחק הת, 

 
 (.Define sections width חב ותצוגת החתכים  )הגדרת רו .4

הגדר את . תולפניך יפתח חלון הגדר .שבחלון הימני   Options -לחץ על כפתור ה  
אותו  ש מצב הקיים מתוך הטופוגרפיהה לשרוחב החתך לעבודה. הכוונה היא לרוחב הקרקע 

יגדירו את ו ייחדאשר . אנו נגדיר מרחק מהציר לשמאל ומרחק מהציר לימין  תדגום התוכנה
-)ברירת המחדל  Left -נגדיר בשדה הרוחב רצועת הקרקע. את קצהו השמאלי של החתך 

 מ'(.  20)ברירת המחדל  Right -מ'(, ואת קצהו הימני נגדיר בשדה ה 20
ניתן להגדיר חתכי רוחב בעלי גבהים   CivilCAD 10. בתוכנת dH -ל Elevationהעבר מ  

 (.  dH) בעלי גבהים יחסיים אבסולוטיים, או חתכים 
של   הגראפית. אופציה זו מגדירה את אופן ההצגה Design  -ל Earthwork -העבר מ

,  Earthworkהחתך. לתוכנה שתי אפשרויות של הגדרת חתך: חתך להצגת עבודות עפר  
. השוני בתצוגה יבוא לידי ביטוי הן בצורת החתכים Designוחתך להצגת חתכים מתוכננים 

טוט, הן בהדפסתם דרך התוכנה למדפסת, והן ביצירת קובץ חתכים על גבי גיליון  בחלון השר
AutoCAD/ZWCAD .נעמוד על ההבדלים העיקריים בפרק תכנון כבישים . 

 
החתכים  וצא מחלון  OKההגדרות ע"י לחיצה על לאחר בחירת ההגדרות צא מחלון  .5

 . Closeע"י לחיצה על 
 

 ל מתוך התפריט הראשי:  הגדרת אפשרויות נוספות בכבישים: הפע .6
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Roads -> Horizontal alignment לחץ על כפתור ,Options    יפתח חלון עם
אפשרויות נוספות ,להבנת אפשרויות אלו יש לעיין בפרק תכנון כבישים. שנה הגדרות  

 . OKאלו כרצונך ולחץ 
 

 ואשר את שמירת הנתונים.  File → Exitצא מהתוכנה ע"י:  .7
 

 נתוני דיסטומט הגדרת מצבי עבודה ל
 

 מאפשרת לקבוע מראש את צורת העבודה בנתוני דיסטומט, CivilCAD 10תוכנת 
 כדי לקבוע את האפשרויות בתוכנה בצע את הפעולות הבאות:

 . File → Open projectהפעל:  .1
 . OK, ולחץ Prototype.prjבחר את פרויקט   .2
 . Geometry → Distomats dataהפעל:  .3

 . Optionsלחץ על כפתור  .4
 Degrees/Gradsבחר את סוג הזוית  .5
 . Meters/Centimetersבחר את סוג המידות  .6
 .OKלחץ  .7
 OK.ע"י לחיצה על  Distomats data -צא מחלון ה .8
 . File → Exitצא מהתוכנה ע"י:  .9

 אשר את שמירת הנתונים. .10
 

 (. ZIPלהעברה ממחשב למחשב )  פרויקטשמירת  
 

היא יוצרת מספר קבצים בעלי אותו  ,לפרויקט מבצעת שמירה  CivilCAD 10כאשר תוכנת 
ממחשב למחשב או  פרויקט כאשר רוצים להעביר  .סיומת שונהעם ( אך הפרויקטהשם )שם 

לקובץ אחד בלבד )קובץ  הפרויקטהדרך הנוחה היא לכווץ את , לשלוח דרך דואר אלקטרוני 
ZIP 0נוכל לפתוח אותו ישירות מתוך תוכנת  מכווץ פרויקט(. וכשנקבלCivilCAD 1 . 

 
   ZIPכקובץ אחד מכווץ פרויקטיצירת 

 
 . File→Open projectשברצונך לכווץ ע"י  הפרויקטפתח את 
 . File→VolumeSize Auto detect הפעל 

 המקורי.  הפרויקטהמכווץ בתיקייה של  הפרויקטהתוכנה תבצע שמירה באופן אוטומטי של 
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 . CivilCAD 10מתוך  ZIPמכווץ מקובץ  פרויקטפתיחת 
 
 בצע את הפעולות הבאות: הפרויקטהמכיל את כל  ZIPמכווץ מקובץ  פרויקטלפתוח י כד

 . File→Extract from zip הפעל 
 שברצונך לפתוח.  ZIP-בחר את קובץ ה

 בחר את הקובץ הממוספר אחרון.  ZIPמכווץ למספר קבצי  הפרויקטאם 
 

יצה שבה נמצא  באופן אוטומטי ותסדר את הקבצים שלו במח הפרויקטהתוכנה תפתח את 
 .zip-קובץ ה

 

 שימוש בעזרה  
 

קיימת אפשרות להפעיל חלון עזרה. כדי להפעיל חלון זה יש ללחוץ   CivilCAD 10בתוכנת 

חלון    , או מסרגל הכלים הראשי ללחוץ עלHelp→ User manualבתפריט הראשי 
נות את  של.  על מנת תוכנהל ההעזרה יפתח בשפה כפי שהוגדרה בחלון ההגדרות הראשי ש

 השפה של חלון העזרה בצע את הפעולות הבאות:
 

 .File → Configurationהפעל: 
 . Languageהעבר לשפה הרצויה ליד הכיתוב 

 . OKלחץ 
 .Help->Helpהפעל שוב את חלון העזרה ע"י 

 
 בסרטוני הדגמה  צפייה

לות  המלמדים על שלבי הפעו )פלאש(  ניתן לצפות בסרטוני הדגמה  CivilCAD 10בתוכנת 

)בסרגל הכלים הראשי( או    בתוכנה. על מנת לצפות בסרטונים אלו יש ללחוץ על
 , יפתח חלון המכיל את רשימת הסרטונים.Help->Tutorialsמהתפריט הראשי 
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 קואורדינטותה: מאגר 2פרק 
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 כללי - קואורדינטות המאגר 
 

 גתן כשרטוט. , עריכתן, עיבודן והצקואורדינטותפרק זה דן באופן קליטת רשימת 
 

, ניתן להבחין בחלון המורכב  בד"כ יופיע בחלקו התחתון של המסך  קואורדינטות החלון מאגר  
( עריכת Editorמעורך  "חלון  נקרא  זה  חלון  זה.  עורך  על  המשפיעים  כפתורים  ומקבוצת   )

הנקודות. ה ועריכת  קליטת  דהיינו:  שהוזכרו,  פעולות  לאותן  אותנו  משמש  והוא  נקודות" 
הנה   לתשומ כחול(  ע"ג  לבן  )בצבע  החלון  כותרת     Topography Coordinatesתך: 

 המייצגות מצב קיים.  קואורדינטותשמשמעותה שכרגע הרשימה שבטיפול הנה רשימת 
 שימות שונות:  נדגיש שביכולתנו לטפל בשתי ר

)  קואורדינטות"רשימת   .1 קיים"   הכוונה Topography Coordinatesמצב  כאשר   ,  )
 הנוכחית. לרשימה 

שהינה רשימה נוספת    (Designed Coordinates)מתוכננות"     קואורדינטות. "רשימת  2
 של טופוגרפיה לאחר ביצוע עבודה ועוד.  קואורדינטותהמשמשת לתכנון, קליטת 

 
ניתן לעשות  יותר לסביבת השרטוט,  ניתן לסגור חלון זה בכל שלב אם ברצוננו מרחב גדול 

בחלקו הימני העליון של חלון זה, לפתיחה מחדש יש להפעיל   X  זאת ע"י לחיצה על כפתור
Topography->Coordinates  אוDesign->Coordinates  .לפי הצורך 

 
נציין   רק  ,כרגע  בהמשך  נדון  )שכבות(  הרשימות  שתי  בין  בהפרדה  שנעשה  השימוש  *על 

 Designed, ניתן לבצע גם על   Topography Coordinatesשהפעולות שאנו מבצעים על   
Coordinates . 

 
 באופן הבא:  Topography Coordinates ניתן לחלק את החלון  

 . קואורדינטותרשימת  .1
 קשורים לרשימה.כפתורי פעולה ה .2
 פעולות שניתן לבצע על גבי השרטוט ושישפיעו על הרשימה. .3
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 קואורדינטות הרשימת 
 

מספר  קואורדינטותהרשימת   להכיל  היכולה   , מתגלגלת  רשימה  של    הינה  מוגבל  בלתי 
במחשבים   זאת  אם  לקלוט.  הנקודות שבאפשרותה  במספר  מגבילה  אינה  )התוכנה  נקודות 
ואף   מאוד  לאט  תעבוד  התוכנה  שבו  מצב  יתכן  נמוכה,  עיבוד  יכולת  ואו  קטן  זיכרון  בעלי 

תקע' אם הרשימות יהיו ארוכות מדי(. הרשימה עצמה מציגה את הנקודות ומעליה נמצאת  י'ת
עריכת   לכיתוב  שורת  מתחת  המופרדת  )השורה  (  Topography coordinatesהנקודות 

. לצורך הבנת השימוש ברשימה נבצע תרגיל קצר שידגים  המשמשת לשינוי והוספת נקודות
 היטב את הנושא: 

 
 דוגמא

ושיוך   פתיחה  נדרשת  חדשה  עבודה  אשר    Noname  פרויקט    -  מסוים   לפרויקטבתחילת 
 עבודה. כפרויקטד לשמש נטען עם הפעלת התוכנה לא נוע

 
 . New Projectשיח  -. לפניך תופיע תיבת דוFile → New project הפעל: .1
. הקש  Coortest  -בשם    פרויקטאנו נקליד עתה    -לעבודה    הפרויקטהקלד את שם   .2

Enter .בסיום הקלדה 
שם   .3 מופיע  המסך  שבראש  הכחולה  שבכותרת  להבחין    הפרויקט נוכל 

 (.Pathהכיתוב המלא שלו ), ולצידו   Coortestשפתחנו,
 

 קואורדינטות ה רשימת הקלדת נתונים ידנית ב
 

 הבאה: קואורדינטותהרשימת נקליד את  .4
     Name X  Y  Z        Code 
 bm300 200  100.32 75.67   ST 
 1  125.32 132.27 
 2  131.23 80.76  60.31 
 3  50  50.41  62.23 
 /small grid 
 4  50          50  61.55 
 5  60          50  63.23  
 6  100         50  63.23  
 7  100         100  62.50 
 8  50          100  62.27 
 

: הבא את סמן הטקסט לשורת עריכת הנקודות. ע"מ לבצע זאת הבא אופן הקלדת הרשימה
שמופיע בתוך  את  העכבר לשורה הנ"ל ולחץ על כפתור העכבר. תוכל להבחין בסמן בצורת וו 

יש רווח אחד או יותר בין כל  השורה.  הקלד את הנקודה הראשונה ברצף, כאשר עליך להק
)  -פרמטר , רווח,   bm300תחילה הקש את שם הנקודה   )x  (200  ,רווח ,  )y    (100.32  ,  )

( וגובה  בסיום הקלדת הנקודה הקש   75.67רווח   .)Enter נכנסה תוכל להבחין שהנקודה   .
ת ושורת עריכת הנקודות התייצבה על שורה חדשה. המשך והקש את שאר  לרשימת הנקודו

 הנקודות.
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. הקלד את השורה בדיוק כפי שהיא  Small grid /: קואורדינאטה: השורה הבאה אינה הערה 
אופציה   להדגים  מנת  על  כאן  מובאת  זו  שורה  רשימות    הערות  שתילתלמופיעה.  בין 

דור הרשימות. הערה נפתחת בסימן / , והיא מורה  וסי  לארגוןשישמשו אותך    קואורדינטותה
. המשך והקלד את כקואורדינאטהלמחשב ששורה זו הנה שורת הערה ואין להתייחס אליה  

 שברשימה. קואורדינטותהשאר 
 

 Excelמקובץ  קואורדינטות טעינת נתוני 
 

קובץ ה  ת. לפני טעינת הרשימה, יש להמיר אExcelמקובץ  קואורדינטותניתן לטעון רשימת 
– Excel (*.xls / *.xlsx לקובץ טקסט מסוג )Comma Delimited (*.csv :לביצוע הפעולה .) 
 

)אין צורך להקליד את  ע"פ הדוגמא הבאה Excelהקלד נתונים בקובץ  .1
 :השורה בצהוב(

 

 
 

  בחר באופציה 'Save as type'תחת  File→Save As,לחץ על כפתור  .2
'CSV' (Comma Delimited) (*.csv)  קבע שם לקובץ ולחץ על כפתור ,

Save . 
של מערכת  Notepadבאמצעות עורך הטקסט  csv.* -פתח את קובץ ה  .3

 ההפעלה. הקובץ ייראה כך )הנתונים מופרדים באמצעות סימן פסיק(: 
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 ייפתח.  'Replace'. חלון Edit→Replaceלחץ על כפתור  .4
 

 
 

 הקלד סימן פסיק )","(. 'Find what'בשורת  .5
 הקלד רווח )באמצעות מקש רווח במקלדת(. 'Replace with'בשורת  .6
 . הפסיקים יוחלפו ברווחים. 'Replace All'כפתור  ללחץ ע .7

 

 
 

בחר באופציה   'Save as type'תחת , File→Save As רלחץ על כפתו .8
'TXT' Text Documents (*.txt) קבע שם לקובץ ולחץ על כפתור ,Save . 
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 . ’Topography→Coordinates'מהתפריט הראשי הפעל:  .9

בחר   'File of type'תחת , Load from text file    לחץ על כפתור .10
, בחר את הקובץ הרצוי ולחץ על כפתור  Text Files (*.txt)באופציה 

Open . 
 
 
 
 קואורדינאטה מבנה 

 
 טרים: פרמ  5-מתורכב  קואורדינאטה

                         
 ר נקודהשם/מספ           y            xגובה                  קוד   

                               
 הינו הכרחי ויכול להיות מורכב מתו אלפא נומרי להוציא רווח, כך ש: שם/מספר נקודה
                    ......A1 ,  1  ,   10095  ,   bm300   ,   At30       

 הנם שמות תקניים, בעוד:   
                       A    1   ,   bm   300                     

 . , משום שקיים רווח בין הסימניםהינם שמות שגויים
 
X -  הכוונה ל  -הכרחי- X   והוא יכול להיות כל מספר. אין הכרח להכניס אפסים  הגיאומטרי

 . 132 -זהה ל 132.00אחרי הנקודה עשרונית כך ש: 
 Y - כרחי. ה 
ללא גובה תשמש כנקודה רגילה, אך פעולות התלויות בגובה, כגון   נקודה -לא הכרחי - גובה 

 חישובי עבודות עפר או שרטוטי קווי גובה, לא יתחשבו בנקודה זו.    
 

ערך נוסף, אשר ניתן להוסיף בעמודה חמישית, הינו קוד הנקודה, אך עליו לא : הערה 
 . נדון בפרק זה

 
 קואורדינטותה עריכת רשימת 

 
ימה מעלה ומטה בעזרת החצים שמימין לרשימה. אם תרצה לשנות  תוכל לגלגל את הרש

נקודה תוכל להביאה אל שורת עריכת הנקודות ע"י הצבעה עליה עם העכבר. כאשר הנקודה 
מופיעה בשורה העליונה, הבא את סמן הטקסט לשורה זו ושנה את הנקודה. נוכל גם לשנות 

הטקסט לשורת עריכת הנקודות  הבא את סמן  -ך את הרשימה ללא שימוש בעכבר ולערו
 )שוב בעזרת העכבר(, משלב זה תשתמש במקשי העריכה הסטנדרטים:

 חץ כלפי מעלה                    -שורה אחת למעלה              
 חץ כלפי מטה -שורה אחת למטה               
   Pg Up -עמוד אחד למעלה               
 Pg Dn -עמוד אחד למטה               
              Ctrl - End - קפיצה לסוף הרשימה 
              Ctrl - Home -  קפיצה לתחילת הרשימה 
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 שרטוט הנקודות 
 

 , יש להניח שתרצה להציגן על גבי המסך.קואורדינטותהלאחר שסיימת להקליד את רשימת 
 

כפתור ה    Refresh  לחץ  רענון  הראשי(. שהינו מקש  הכלים  זו )בסרגל  פעולה  שרטוט. 
רשימת   של  סריקה  לבצע  לתוכנה  )במקרה   קואורדינטותהמורה  ברשימה   שינויים  לאתר 

פעם   בכל  אופן  באותו  המעודכנת.  הרשימה  את  ולשרטט  חדשה(  היא  הרשימה  כל  שלנו 
שתבצע שינוי ברשימה )הוספת קואו', שינוי קואו' של נקודה כלשהי וכד'( ותרצה לקבל שינוי  

 , לחץ על כפתור זה והשרטוט יעודכן בהתאם. על גבי השרטוט
 

לתוכנת  :הערה  להגדיר  ולהקפיא   CivilCAD 10 ניתן  )בעלות   קואורדינטות לסמן  חריגות 
 גובה או מרחק חריג( בצורה אוטומאטית תוך מתן התרעה למשתמש.

 
 / ’Design→Coordinates‘מהתפריט הראשי הפעל: 

‘Topography→Coordinates’  

 ייפתח.  ’Options‘. חלון   ’Options‘ לחץ על כפתור 
ולחץ על  ’Auto freeze exceptional points‘באופציה  ’V‘סמן  

 . ’OK‘כפתור 
 . ’Refresh‘לחץ על כפתור  
   .’OK‘בחלון ההודעה שיופיע לחץ על כפתור  

 
אשר רחוקות מתחום המדידה או בעלות גובה חריג תוקפאנה באופן  קואורדינטות

 שבנה בבניית האינטרפולציה. אוטומאטי ולא תחו
 

 מחיקת איזור חופף בין שתי מדידות 
 

 מאפשרת למחוק תחום חופף בין שתי מדידות. CivilCAD 10 תוכנת 

 לביצוע הפעולה: 

 . ’Topography→Coordinates'מהתפריט הראשי הפעל:  .1

 : באופציה ’V‘וסמן    'Options'לחץ על כפתור  .2

 ‘Subtract coordinates from overlap area’ . 

 ' לשמירת ההגדרה.OKלחץ על כפתור ' .3

  .טען את המדידה הראשונה ולאחר מכן את המדידה השניה .4

 בחלון שייפתח בחר באחת מהאפשרויות הבאות: .5

 בחר באופציה הראשונה להשארת שתי המדידות כפי שהן. 

של המדידה השניה שנטענה,   קואורדינטותבחר באופציה השניה למחיקת ה 

 מהתחום המשותף.
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של המדידה הראשונה  קואורדינטותבחר באופציה השלישית למחיקת ה 

 שנטענה, מהתחום המשותף. 

 לשמירת ההגדרה וביצוע הפעולה. 'OK'לחץ על כפתור  .6

 
 

 כפתורי פעולה הקשורים לרשימה
בחלון עריכת הנקודות )החלון התחתון(, נמצאת קבוצת כפתורים המאפשרת ביצוע פעולות  

 ות.שונות על רשימת הנקוד
 נעבור על כל אחת מפעולות אלה. 

 

 (    Reorder in columns)  קואורדינטותהעימוד  
   בעמודות עפ"י:   קואורדינטותהה תרווח את רשימת לחיצה על כפתור ז

   NAME     X     Y     Z     CODE 
 כאשר כל עמודה מיושרת לשמאל. 

 מזרחיות(.  -גיאומטרי X -)הערה: הכוונה ל
 

הנה חוקית אם תלחץ על כפתור זה כאשר   קואורדינטותהעולה זו מניחה שרשימת שים לב: פ
 הרשימה אינה חוקית, השורות שאינן חוקיות עלולות להשתנות בניגוד לרצוי. לדוגמא :

 נניח שבשורה מסוימת ברשימה מופיע: 
                               0     BM30     153700.25     179600.32     323.35                

 0משמאל(, תזהה התוכנה את    0מכיוון ששורה זו אינה חוקית )קיימת עמודה מיותרת של  
וכן הלאה, כך שX  כקואורדינאטה   bm300כשם הנקודה,   ימחק     323.35  -, )ז"א טעות!(  

 לגמרי מהשורה מכיוון שהוא הנתון האחרון והתוכנה אינה יודעת היכן לשייך אותו.  
 

 . undoלת העימוד אינה נתמכת ע"י פעולת הערה: פעו
 

 Save all data/current) את כל הנתונים או הבלוק המסומן שמור כקובץ טקסט 
block)   

)כותרת כחולה( , שבה      save as text fileשיח   -עם לחיצה על כפתור זה תופיע תיבת דו
קובץ  תפתח  התוכנה  קובץ.  שם  ולהקליד  ספריה  לבחור  המשתמש  בשם   יתבקש  חדש 

ותשמור בתוכו את   ה    ASCIIכקובץ     קואורדינטותהשהוקלד  קובץ  שיפתח     ASCII  -נקי. 
)יכלול שורות רווח או הערות, במידה    קואורדינטותישמר בדיוק כפי שהוא מופיע ברשימת הי

בפורמטים שונים.לצורך זה תוכל להיעזר   קואורדינטותהוהן קיימות(. ניתן לשמור את קובץ  
ה הדובאופציה  בתיבת  )-באה:  שורת  Save as text fileשיח  מופיעה    )Filter   ובתוכה
ובחר את הפורמט הרצוי לך    שמשמאל. לחץ על כפתור החץ הקטן    (*.*) All filesהכיתוב:   

(Med  ,Reg    מרגע זה אם תיתן הוראה לשמור קובץ טקסט .)'יתקבל קובץ עם סיומת    -  וכו
 שבחרת ובפורמט הרצוי.  

 
פע מהרשימהערה:  חלק  רק  לשמור  שניתן  כך  בלוקים,  על  בעבודה  נתמכת  זו  ע"י  ולת  ה 

 .כבלוק  קואורדינטותבחירת 
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 (Load from text file)קובץ טקסט מ קרא 
תתבקש לבחור   שבה    load from text file  שיח-ה על כפתור זה תופיע תיבת דולאחר לחיצ

ויופיע ייטען  הקובץ  לטעון.  שברצונך  הקובץ  שם  לב קואורדינטותהברשימת    את  שים   .
זו   יתווספו  לרשימה  ונתוני הקובץ  לא תמחק,  כזו,  קיימת  הנוכחית, אם  הנקודות  שרשימת 
תרצה   זאת  בכל  אם  מדידה.  אזורי  ולהגדיל  קבצים  מספר  לחבר  ניתן  זו  בצורה  בסופה. 
 שהרשימה שאתה קורא "תדרוס" את הרשימה הקיימת, יהיה עליך ללחוץ תחילה על כפתור

 '" ורק לאחר מכן לטעון את הרשימה החדשה.   קואורדינטותה"מחיקת כל 
 

  (Print)הדפסת רשימת הנקודות  
דו ומוכנה להדפסה  -הפעלת הכפתור תיצור תיבת  וודא שהמדפסת מחוברת  שיח הדפסות. 

 ולחץ על "אישור" להדפסת רשימת הנקודות.
 

 יתן להדפיס רק חלק מהרשימה.הערה: פעולה זו נתמכת ע"י עבודה על בלוקים, כך שנ
 
 

    (Erase All)  קואורדינטותהמחיקת רשימת   
 שברשימה. לפני המחיקה תופיע ההתראה:  קואורדינטותההפעולה תמחק את כל 

 All coordinates will be erased! . 
 לחץ על "אישור" לביצוע המחיקה.  

 
 ימה אינה ניתנת לשחזור.לפיכך הרש  Undoפעולה זו אינה נתמכת ע"י פעולת   :הערה 

 
 

      (Erase)מחיקת נקודה/ נקודות    
או בלוק של נקודות. סמן נקודה באמצעות העכבר   בודדתכפתור זה משמש למחיקת נקודה  

 )בתוך הרשימה( ולחץ על הכפתור. הנקודה תימחק מהרשימה.
 

 מכת בעבודה על בלוקים. והערה: פעולה זו ת
 
 

   (Copy)העתקה   
זו נקודה  קואורדינטותמשמשת להעתקת    Paste, בשיתוף הפקודה   פקודה  ניתן להעתיק   .

 או בלוק נקודות.  תבודד
 דוגמא לשימוש בפקודה זו בדוגמא הבאה: 

העכבר   .1 באמצעות  רשימת     3סמן  מתוך  הנקודה  קואורדינטותהנקודות  את  )סמן   .
הנקודו שתי  פני  על  הסמן  את  וגרור  לחוץ  העכבר  את  החזק  שלך,  ת  הראשונה 

 העוקבות לנקודה שסימנת(.
נמצא )  block לחץ עם העכבר בריבוע שמשמאל למילה    -סמן את הנקודות כבלוק   .2

 מימין לטבלת הקורדינטות(.
 Copy -לחץ על כפתור ה .3

הנקודות יועתקו, אך    -עתה הועתקו הנקודות אל תוך זיכרון המחשב. )אל תצפה לכל תגובה  
 לא תקבל שום הודעה על כך(.

 . Pasteדוגמא בפקודת ראה המשך 
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       (Paste)הדבקה    
פקודת    עם  ביחד  זו,  להעתקת    Copyפקודה  בהנחה שהשתמשת  קואורדינטותמשמשת   .

קטע     Copyבפקודה    שורה    blockלהעתקת  )או  לשכפלו תבודדמסוים  תוכל  לזיכרון,   )
 : Copy)ולהדביקו( בכל מקום שתרצה בתוך רשימת הנקודות. נתייחס לדוגמא שהחלה ב 

נקודות לזיכרון, דפדף עד שתגיע לסוף רשימת   3לאחר שסימנת והעתקת בלוק של   .4
 הנקודות.

אותה(  .5 סמן  )פשוט  הנקודות  עריכת  לשורת  ברשימה  האחרונה  השורה  את  הבא 
 ועבור עם סמן הטקס לשורה זו )הצבע עם העכבר על שורת עריכת הנקודות(.

 יוון שאין כזו תיווצר שורה חדשה.מכ -בכדי לרדת שורה אחת מטה  Enterלחץ על   .6
 מובא רק לצורך הדוגמא(.  -שוב ליצירת שורת רווח )לא הכרחי   Enterלחץ  .7
 A copy / בשורה החדשה רשום את ההערה הבאה )שוב, הערה זו אינה הכרחית(:  .8

sample  ו-  Enter  . 
מתוכו  תוכל להבחין שהנקודות שהועתקו לזיכרון יודבקו    -  Paste  -לחץ על כפתור ה   .9

בשורה שבה אתה נמצא. בכדי ליצור אבחנה בין נקודות אלה לנקודות שקיימות כבר 
 לפני כל נקודה.  C , יתווסף

            
להעתיק    הערה: מרשימת  ניתן  נקודות  קבוצת  אופן  הקיים     קואורדינטותהבאותו  של המצב 

Topography Coordinates     המתוכנן     קואורדינטותהלרשימת המצב   Designedשל 
Coordinates.  
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       (Find)חיפוש   
 פעולה זו מאפשרת איתור נקודה/נקודות ברשימה עפ"י שם גובה או קוד.  

 : findשיח  -עם לחיצה על כפתור הפקודה תופיע תיבת הדו
 

 : לאיתור נקודה לפי שם
 . Nameהעבר את החיפוש למצב  Find whatבתפריט:  
 . OKאו   Enterהקלד את השם שברצונך לאתר ולחץ  
 אפשרות לחיפוש מתקדם:  

 

לחיפוש מספר שמות יש להקליד לדוגמא:   
1000,1002,2003   

 1000-1004יש להקליד לדוגמא:   מסויםלחיפוש בתחום 
 10,50,60-40וגמא: ישנה אפשרות לבצע חיפוש משולב לד 

 
 אין חשיבות לסדר הקלדת הפרמטרים בתיבת החיפוש.  
 

 ופיע בשורת עריכת הנקודות.הנקודה תאותר, תסומן בכחול ות
תחפש את הנקודה הבאה ברשימה בעלת אותו שם )אם יש כזו( וכן   Enterלחיצה נוספת על 

 הלאה.  
להעביר תחת הכיתוב כדי שהתוכנה תסמן באופן ישיר את כל תוצאות החיפוש ברשימה יש 

SearchMode,  ממצבStepByStep  למצבAll.  ללחוץ עלFind All  . 
 

 ה לפי גובה: לאיתור נקוד
 ראינו , אם כן, שימוש לאיתור נקודות ע"י שם. באותו האופן ניתן לאתר נקודות עפ"י גובהן: 

למצב     Nameהעבר את החיפוש ממצב  Find whatבתפריט:  
Height. 

 . OKאו  Enterהקלד את הגובה שברצונך לאתר ולחץ  
 אפשרות לחיפוש מתקדם:  

 At Least-ל  SearchModeבשנה  מסויםלחיפוש גבהים מעל לגובה    
 At Most-ל  SearchModeבשנה  מסויםלחיפוש גבהים מתחת לגובה   
 בחיפוש שם. שצוינוישנה גם האפשרות של חיפוש מתקדם ע"פ השיטות    
 .Accurate,ALL,Heightיש לבחור:   235-ל 234: לחיפוש נק' בין הגבהים לדוגמא  
 

 לאיתור נקודה לפי קוד: 
 . Codeהעבר את החיפוש למצב  Find whatבתפריט:  
 . OKאו   Enterהקלד את הקוד שברצונך לאתר ולחץ  

 

 (Insert)הכנסת שורה ריקה  
השורה לחיצה על כפתור זה תדחוף שורה ריקה לפני השורה המוארת. לביצוע סמן את 

 הכפתור. שלפניה ברצונך לדחוף שורה ריקה ולחץ על 
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     (All)סמן את כולם   
מבצע צביעה של כל רשימת הנקודות כולל שורת רווח והערות. בדרך זו ניתן    All -הכפתור 

 ביתר קלות לסמן את כל הרשימה לצורך עבודה על בלוק הכולל את כל הנקודות .
 

 (Options)ספות  אופציות נו 
וגודל הכיתוב של הנקודות שיופיעו על המסך. עם אופציות אלו מאפשרות לשלוט על סוג 

על הכפתור יפתח חלון האופציות הראשי. בחלקו הימני התחתון של חלון זה ניתן  לחיצה
. נעבור ונפרט את הפעולות קואורדינטותהלהבחין באפשרויות הקשורות לרשימת 

 האפשריות בחלון זה:
 
 

Standard mode  –  ע"י שימוש בטקסטים:  קואורדינטותהתצוגת 
 

1. Names  – ו מסומנת יופיע שם הנקודה  תצוגת שמות הנקודות. אם אפשרות ז
 בצמוד לנקודה. 

2. Elevations - .תצוגת גובה הנקודה 
3. Codes - .תצוגת קוד הנקודה. הכוונה כאן היא לתצוגת טקסט הקוד 
4. Circles – .הצגת עיגול סביב הנקודה 
5. Crosses – .הצגת צלב ע"ג הנקודה 
6. Barracks - סוגי   הצגת סוגריים סביב גובה הנקודה. באפשרותך לבחור מספר

 (. Noneסוגריים או לבטל בכלל כיתוב בסוגריים )
7. Scale -  המידה היא:  הבחירת גודל כיתוב הטקסט. חלוקת גודל הפונט לפי קנ 

 0.1גודל פונט:   1:100עד 
 0.5גודל פונט:  1:250עד 
 0.7גודל פונט:  1:500עד 
 1.2גודל פונט: 1:1000עד 
 1.5גודל פונט: 1:1250עד 
 5:  גודל פונט 1:5000עד 
     10גודל פונט:  1:10000עד 

8. Format -    הפורמט שבו יוצגו הנקודות. קיימים שני פורמטים להצגת הנקודות
 (.Blocks)מלבד 

מטרים משמאל לנקודה   -גובה הנקודה יופיע בצידי הנקודה עצמה  -1פורמט  .9
 וסנטימטרים מימין. 

 גובה הנקודה יופיע מעליה.  -2פורמט  .10
11. Millimeter – ספרות אחרי הנקודה )במילימטרים(. 3בה עד הצגת הגו 
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Blocks mode –   ע"י שימוש בבלוקים קואורדינטותהתצוגת : 

 
מאוחדים בבלוק אחד אשר יוצג  ופיעו ילאחר בחירה זו, כל מרכיבי הנקודה )גובה,שם וסימון(  
. ראה הרחבה בפרק הקואורדינאטהבהתאם לספריית הבלוקים המוגדרת ומספר הקוד של 

 בודה עם קודים. ע – 3

  Cancel. לחיצה על   Refreshעל כפתור   ולאחר מכןOK לביצוע שינוי ושמירתו לחץ  
 תבטל כל שינוי.

 
-File זו יש להגדיר את השימוש בבלוקים ע"י: הפעלת * על מנת להשתמש באופציה

>Configuration מעבר ללשונית ,Drawing environment   וסימון האפשרות ,Blocks 

mode . 

    (Sort)מיין   

פעולה זו מאפשרת מיון רשימת הנקודות עפ"י מספרן בסדר עולה. עם לחיצה על הכפתור 
. לחץ על אישור לביצוע הפעולה. רשימת   All coordinates will be sortedתופיע ההודעה:  

הנקודות תמוין בסדר עולה עפ"י מספר הנקודות. כל הנקודות בעלות שם אלפאנומרי יועברו  
 תחילת הרשימה.  ל
 

 . undoהערה: פעולת העימוד אינה נתמכת ע"י פעולת 
 

 (Auto Numbersשינוי שם הנקודות ) 
ר זה יפתח  הנקודות באופן אוטומטי, לאחר לחיצה על כפתו  פעולה זו מאפשרת שינוי שמות

 חלון המאפשר את ההגדרות הבאות:
 

Start column – החדש. מיקום התו הראשון ברשימה לשם הנקודה 
End column –  מיקום התו האחרון ברשימה לשמות החדשים )התוכנה לא תעבור את

 .מיקום זה(
Start counting from – .הערך לתחילת המספור 
התוכנה תציג חלון לאישור השינוי, ולאחר האישור תשנה את כל   OK לאחר לחיצה על כפתור

השינויים יבוצעו רק על   Block"י שמות הנקודות ברשימה. במידה וחלק מהרשימה מסומן ע
 חלק זה.

 

 (Freeze)הקפאת נקודה/נקודות  
יע ע"ג השרטוט, אך לא פעולה זו מאפשרת לנטרל נקודה בחישוב. נקודה מוקפאת תופ

בה.בצורה כזו נוכל להקפיא תאי ביוב, שוחות ועוד. להקפאת נקודה תיכלל ביצירת קווי הגו
. המשך   <Fr>כפתור. משמאל לנקודה יופיע הסימון  סמן הנקודה מתוך הרשימה ולחץ על ה

והקפאת הנקודה  -וסמן את שאר הנקודות שברצונך להקפיא. לאחר מכן יש לרענן השרטוט 
ואז נוכל להבחין בשינוי בהתאם להקפאת   –תופיע ע"ג השרטוט.יש לחזור ולחשב קווי גובה 

וללחוץ שוב על כפתור   יש לסמנה   (Unfreeze)הנקודות.  בכדי להסיר הקפאת נקודה 
 ההקפאה.

 
 לנקודה הרצויה.  Frהערה: ניתן להקפיא נקודות מדידה גם ע"י הוספת הקוד 
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 (Zoom to point on drawing)רטוט אתר נקודה בש  
בעזרת הפעולה ניתן לאתר על גבי השרטוט נקודה מתוך הרשימה. סמן את הנקודה  

 )ברשימה( שברצונך לאתר ולחץ על הכפתור. 
: סמן העכבר יקפוץ למיקומה של הנקודה ויתייצב  Stand-aloneת בגרס 

 . בתנאי שהנקודה נמצאת בתוך אזור השרטוט שמופיע בחלוןעליה, 
במרכז  : הנקודה הרצויה תאותר ותמוקם AutoCAD/ZWCADבגרסת  

 השרטוט.
 
 

 (Compute height)חישוב גובה של נקודה   
שלה.   קואורדינטותהינטרפולציה, על סמך פעולה זו מאפשרת חישוב גובה של נקודה בא

 חישוב הגובה יתבצע אך ורק אם על גבי השרטוט מופיעים קווי גובה. 
 שימוש באופציה זו. נדגים 

 עם קווי גובה, וברצונך לאתר גובה של נקודה פרויקטנניח שברשותך  
 שלה ידועות . קואורדינטותשה

 .קואורדינטותההוסף את הנקודה החדשה לרשימת  
 עם העכבר את הנקודה בתוך הרשימה.סמן  
 לחץ על הכפתור. 
צעת תכנון, תוכל לחשב גבהים יבבמידה ו תוכל להבחין שלנקודה זו חושב גובה. 

מתוכננים של נקודות רצויות מתוך הטופוגרפיה המתוכננת ע"י ביצוע הפעולה שצוינה  
 כאן ע"ג רשימת הנקודות המתוכננות.

 . בלוקים פעולה זו נתמכת בעבודה על        
 
 

 (Add height)הוספת גובה לנקודות  
 דות או מקבוצת נקודות המסומנות כבלוק.פעולה זו מאפשרת הוספת/הורדת גובה מכל הנקו

 להפעלה לחץ על הכפתור. 
בתיבה שתיפתח הקלד את תוספת הגובה הרצויה. להורדת גובה הכנס תוספת  

 שלילית.
 לביטולה. Cancelלביצוע הפעולה או  OKלחץ  

 -הערה: להוספת/הורדת גובה רק בחלק של הנקודות סמן תחילה נקודות אלו וקבע אותן כ
Block . 

 

 אוגר נתונים/ Total Stationקליטת נקודות ישירה מ 
לאחר לחיצה על כפתור זה יפתח חלון תקשורת. וודא שהמכשיר שברשותך הנו המכשיר 

   Recieveהמכשיר. לחץ על  הנבחר ונתוני התקשורת תואמים את אלה המכוונים בתוך
 לשליחת נתונים אל המכשיר. Sendלקבלת נתונים מהמכשיר או 

אם ברצונך לשלוח רק חלק מהנקודות תוכל לבצע זאת ע"י סימון הנקודות הרצויות קביעתן  
של  Block. במקרה זה תופיע הודעה בדבר שליחת Send, ולחיצה על כפתור Block -כ

 נקודות ולא כולן. 
 

 . טות אשר הוגדרו גרפית ע"י המשתמש מיקום נתוני שם וגובה של קואורדינ שמירת 
 בלבד.  2ובפורמט  Standard Modeהשמירה תתבצע במצב עבודה 
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 / ’Design→Coordinates‘מהתפריט הראשי הפעל: .7

‘Topography→Coordinates’  

 ייפתח.  ’Options‘. חלון   ’Options‘לחץ על כפתור  .8

 .2ובחר בפורמט   ’Standard Mode‘סמן את האופציה  .9

 לשמירת ההגדרות. ’OK‘לחץ על כפתור  .10

בתפריט      'Save Coordinates Text According To Definitions'כפתור  .11

Topography Coordinates  .יהפוך לפעיל 

, יש ללחוץ על הכפתור הנ"ל  קואורדינטותלאחר שינוי מיקום נתוני הגובה ושם ה .12

 לשמירת ההגדרות.

תתווספנה  ’Design→Coordinates’ / ‘Topography→Coordinates‘בטבלת  .13

 השם והגובה על פי מיקומם החדש. קואורדינטותמודות מימין של ע

 הנתונים מימין ומשמאל יהיו זהים. –אשר לא בוצע בהן שינוי  קואורדינטותב :הערה 

Update Block Rotation  –  סריקת בלוקים 
 . קואורדינטותם מהשרטוט, וחישוב הזווית עבור רשימת הבלוקי פעולה זו מאפשרת סריקת

תבצע סריקה של הבלוקים  התוכנה   Update block's rotationלחיצה על כפתור לאחר 
. נקודה אשר הותאמה )מבחינת מיקום(  קואורדינטותבשרטוט והתאמה אל מול רשימת ה

דא שאת סיבוב הבלוק למיקום הבלוק בשרטוט תעודכן לזווית סיבוב בהתאם לבלוק. יש לוו
 . Insertion-point -בשרטוט עושים סביב ה

 

 קואורדינטות החלפת  
 .(Topography Coordinates) ברשימת הנקודות Y  -ל  X ביןכפתור זה יחליף 

 

 . יש ללחוץ על   Refresh על מנת לראות את השפעת הפעולה על השרטוט על כפתור
Zoom extents   החדש.כדי לעבור לאזור השרטוט 

 

 יצירת מערכת קואורדינטות חדשה   
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 פעולות המבוצעות בשרטוט ומשפיעות על הרשימה
 

שבחלקו התחתון של המסך, מופיעה מצד ימין רשימה הכוללת   קואורדינטותהבחלון רשימת 
 את הכיתוב:

Unused, Pick, Locate, Freeze, Erase, Move                                                       
                                      

Unused 
 המצב שבו אף אחת מהפעולות אינה פעילה. זהו מצב ברירת המחדל של הרשימה.

 
Pick   

 הוספת נקודה כלשהי באזור השרטוט. 
בתוך הרשימה כך שתסומן בכחול. בשורת הפקודות של ה  Pickלהפעלה לחץ על המילה 

AutoCAD/ZWCAD ע הכיתוב: יופיPick point <XXX>/(Esc)nd:   המספר בסוגרים הנו  .
. עבור עם  Enterהמספר שינתן לנקודה שתבחר. לשינוי מספר זה הקש את המספר הרצוי ו 

 -כבר ברצונך להוסיף ולחץ על כפתור העסמן העכבר לאזור השרטוט, עמוד על הנקודה ש
. לחיצה נוספת על העכבר תיצור  טותקואורדינהתוכל להבחין כי הנקודה התווספה לרשימת 

 . Escנקודה נוספת, וכן הלאה. לסיום הפעולה לחץ 
 

: כאמור, כל לחיצה תוסיף נקודה לרשימה. בפרויקטים שבהם חושבו קווי  גבהים של הנקודות
, תבצע התוכנה אינטרפולציה לגובה Topography → Contours)גובה )ע"י פעולת 
 .באופן אוטומטיותוסיף גובה זה  הנקודה החדשה

 
נוכל להבחין כי הנקודה שהתווספה קיבלה אוטומטית שם/מספר. קיימת אפשרות שליטה על 

שמות הנקודות שמתווספות )בנוסף לאפשרות לשנות שם נקודה באופן ידני, לאחר 
 שהתווספה( באופן הבא:

  בסרגל התפריט הראשי )שורת הפקודות שבראש השרטוט( הפעל:  .1
→Configuration File . 

, ניתן   Coordinates formatחלון ההגדרות הראשי יפתח, יש לבחור בלשונית  .2
 . New points counterלהבחין בכיתוב:  

 תחת כותרת זו קיימות שתי אפשרויות:  .3
 Autoליד הכיתוב    Vלהפעלה סמן  -מספור שמות אוטומטי .א

names אופציה זו מורה למחשב לתת אוטומטית שם שאינו .
לנקודות טופוגרפיה   Tשמות אלו יפתחו באות  מופיע ברשימה. 

 לנקודות מתוכננות.  Dובאות  
באפשרותנו להורות למחשב למספר את  -מספור בסדר עולה  .ב

הנקודות המתווספות בסדר עולה החל ממספר מסוים שנקבע. 
מופיעה שורת טקסט.  Start counting fromמימין לכיתוב 

ממנה יחל המספור. הקלד בשורת טקסט זו את מספר הנקודה ש
נעלם.    Auto names -תוכל להבחין כי סימון הוי משמאל ל 

משלב זה ואילך כל נקודה חדשה שתתווסף תמוספר בסדר 
תמנע כפילויות   לאעולה מהמספר שהקלדת. עם זאת התוכנה *

 בשמות הנקודות.
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פעולה זו זהה להכנסת מספר   AutoCAD/ZWCADבעבודה עם   הערה:
 . AutoCAD/ZWCAD -ר בשורת הנקודה באופן ישי

 
 . OKלאחר הבחירה הרצויה לחץ     .4 

 
אין מניעה לתת שם זהה לשתי נקודות שונות. במקרה כזה יוצגו שתי הנקודות *  :הערה 

במקומן הנכון ע"ג השרטוט ותוכל אף לחשב באמצעותן קווי  גובה. בעיות הנובעות בכפילויות  
ה יכללו במשטח מתוכנן, בקווי אי רציפות , צירים וכד'.  שמות ייווצרו אך ורק כאשר נקודות אל

 במקרים כאלה יש להימנע משימוש בשמות זהים לנקודות.
 

Locate 
 איתור נקודה/נקודות המופיעות ברשימה מתוך השרטוט.

 
 בתוך רשימת הפעולות. בשורת הפקודות של   Locateלהפעלה לחץ על המילה  

  ב:יופיע הכיתו  AutoCAD/ZWCAD – ה  
PolygonIn/PolygonOut/<Single>/(Esc)nd:. 

1. (Esc)nd -   לחיצה עלEsc  .תסיים הפעולה 
2. Single  – ברירת המחדל. איתור נקודה בודדה. ב- AutoCAD/ZWCAD   יופעל

. אם תבחר נקודה מסוימת היא  Point  –ל  Object Snapבאופן אוטומטי 
 צבע בכחול.י תאותר ברשימה למטה ות

3. PolygonIn  – נקודות בתוך צורה סגורה. לחיצה על  איתורI  וEnter  תפעיל ,
. כל  Enter -ו Cפקודה זו. סמן פוליגון סביב הנקודות הרצויות ולסגירתו הקש 

 הנקודות שבתוך הפוליגון יאותרו ויצבעו בכחול. 
4. PolygonOut-  איתור נקודות מחוץ לצורה סגורה. לחיצה עלO  וEnter  ,

לסיום. כל הנקודות    Cסביב הצורה הרצויה ו  תפעיל פקודה זו. סמן פוליגון
 שמחוץ לפוליגון יאותרו ויצבעו בכחול. 

 
Freeze 

הקפאת נקודה/נקודות ברשימה מתוך השרטוט. נקודה שהוקפאה תופיע על המסך אך 
 שרטוט קווי הגובה.  גובהה לא ישפיע על

 
 ל בתוך רשימת הפעולות. בשורת הפקודות ש   Freezeעלה לחץ על המילה   להפ
 Polygon  : יופיע הכיתוב  AutoCAD/ZWCAD – ה  

In/PolygonOut/<Single>/(Esc)nd:. 
1.  (Esc)nd -    לחיצה עלEsc  .תסיים הפעולה 
2. Single  – ברירת המחדל. הקפאת נקודה בודדה. בAutoCAD/ZWCAD -  יופעל

. אם תבחר נקודה מסוימת היא תאותר Point –ל  Object Snap -באופן אוטומטי ל
 ימה למטה ותוקפא. לאחר שהקפאת את כל הנקודות הרצויות לחץ על כפתורברש

 כדי שההקפאה תתבטא גם על גבי המסך. 
3. PolygonIn  –  הקפאת נקודות בתוך צורה סגורה. לחיצה עלI  וEnter  תפעיל ,

. כל  Enter -ו Cפקודה זו. סמן פוליגון סביב הנקודות הרצויות ולסגירתו הקש 

בכדי שההקפאה  ליגון יאותרו ויוקפאו. לחץ על כפתור הנקודות שבתוך הפו
 תתבטא על גבי המסך. 
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4. PolygonOut-  הקפאת נקודות מחוץ לצורה סגורה. לחיצה עלO  וEnter תפעיל ,
לסיום. כל הנקודות שמחוץ לפוליגון   Cפקודה זו. סמן פוליגון סביב הצורה הרצויה ו 

 שההקפאה תתבטא על גבי המסך. בכדי  יוקפאו ויצבעו בכחול. לחץ על כפתור  
 

Erase 
בתוך    Eraseמחיקת נקודה/נקודות מהרשימה באמצעות השרטוט. להפעלה לחץ על המילה   

 הפעולות.                                              רשימת
 (, אלא שכאן אותן פעולות יבצעו מחיקת נקודות. Freeze)ראה 

היא צמצום שטח  Erase -אמצעות פעולת ה אחד השימושים הטובים שניתן לבצע ב
 שלנו.  בפרויקטחורגות  קואורדינטותלאזור מוגדר, או מחיקת  הפרויקט
של מדידה  קואורדינטותחדש, שלתוכו ייבאנו קובץ   פרויקטנניח שברשותנו  שא:נדגים הנו

ת. של התחנו של נקודות האוריינטציה  קואורדינטותוובקובץ זה מופיעים גם תחנות המדידה 
במקרים רבים, נקודות כאלה הן נקודות רחוקות מאזור המדידה ועל כן לאחר יבוא הקובץ 

( ומספר קטן של הפרויקט(, נקבל אזור מרוכז של נקודות )אזור   ורענון שלו )כפתור
 → Eraseאו   Erase → Win outנקודות רחוקות שבהן אין צורך. נוכל להשתמש באופציית 

PolygonIn העבודה( למחיקת הנקודות שרחוקות מאזור הפרויקט שלנו.  )תלוי בתצורת

 לרענון השרטוט.   לאחר המחיקה לחץ על כפתור
 

Move 
 הזזת נקודה/נקודות ברשימה. 

 
רגילה(,   Move)פקודת  AutoCAD/ZWCAD -טעות נפוצה היא לחשוב שהזזת נקודה ב

ניתן להשתמש   של אותה נקודה ברשימה התחתונה. אם זאת קואורדינטותהתשנה את 
המתוארת כאן בכדי להזיז פיזית נקודה על גבי המסך, ובו בזמן לשנות את  Moveבאופציית 

 שלה ברשימה. קואורדינטותה
בתוך רשימת הפעולות. בשורת הפקודות של ה   Moveלהפעלה לחץ על המילה   

AutoCAD/ZWCAD   :יופיע הכיתוב 
PolygonIn/PolygonOut/<Single>/(Esc)nd: . 

1. (Esc)nd -   לחיצה עלEsc  .תסיים הפעולה 
2. Single  – ברירת המחדל. הזזת נקודה בודדה. ב- AutoCAD/ZWCAD    יופעל

. לאחר בחירת הנקודה הרצויה תתבקש Point  –ל  Object Snapבאופן אוטומטי 
לסמן את המיקום הראשון שיהווה נקודת הייחוס להזזה, ולאחר מכאן, את המיקום 

הנקודה   קואורדינטות  .Enterולאחר מכן לחץ   זזההשני שאליו תתבצע הה
הנבחרת ישתנו בהתאם למיקומה החדש ובהתאם לסימון בצלב צהוב. בסיום הזזת  

 לרענון השרטוט.   כל הנקודות הרצויות לחץ על כפתור
3. PolygonIn  –  .לחיצה על הזזת קבוצת נקודות בתוך צורה סגורהI  וEnter  תפעיל ,

. כל  Enter -ו Cסביב הנקודות הרצויות ולסגירתו הקש  פקודה זו. סמן פוליגון
הנקודות שבתוך הפוליגון יאותרו. סמן את המיקום הראשון שיהווה נקודת הייחוס 
להזזה, ולאחר מכן, את המיקום השני שאליו תתבצע ההזזה. בסיום ההזזה לחץ 

Enter . 
PolygonOut-  הזזת קבוצת נקודות שמחוץ לצורה סגורה. לחיצה עלO   וEnter  תפעיל ,

לסיום. כל הנקודות שמחוץ לפוליגון יאותרו.   Cפקודה זו. סמן פוליגון סביב הצורה הרצויה ו 
את המיקום השני שאליו ן מכסמן את המיקום הראשון שיהווה נקודת הייחוס להזזה, ולאחר 

 לרענון השרטוט.   כפתור  בסיום ההזזה לחץ על  .Enterולאחר מכן לחץ  תתבצע ההזזה
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 עבודה עם בלוקים 
   

ות עבודה על בלוקים. בלוק  ועוד, אשר מאפשר Copy ,Freezeקיימות פעולת רבות ביניהן 
שעליהן ניתן לבצע פעולות מסוימות. נבהיר את השימוש  קבוצת נקודותהנו למעשה 

 בבלוקים ע"י הדוגמא הבאה: 
 נניח שברצונך להדפיס חלק מרשימת הנקודות של הפרויקט לצורך זה: 

 
 צבע בכחול את הנקודות שברצונך להדפיס.  .1
לשם כך סמן ברשימה את הנקודה הראשונה להדפסה, עבור עם החצים שמימין  .2

לחוץ וסמן   Shift -לרשימה עד לנקודה האחרונה להדפסה, החזק את מקש ה 
 נקודה זו. כל הנקודות בין שתי הנקודות שסומנו יצבעו בכחול. 

ליד המילה  V. ע"י סימון Block -חול כ כעת נסמן את הנקודות הצבועות בכ .3
Block מרגע זה ואילך כל הנקודות המסומנות ברשימה "לכודות" ב .- Block. 

)כפתור עם ציור של מדפסת בתוך קבוצת   Printלחץ על מקש ההדפסה  .4
ולא כל   Block -הכפתורים התחתונה(. לפניך תופיע הודעה כי כרגע יודפס רק ה 

שיח להדפסות, -התהליך ולאחר הופעת תיבת הדו להמשך OKהרשימה. לחץ 
 אשר את ההדפסה. 

 
ראינו אם כן שפעולת הבלוקים מאפשרת הגדרת קבוצה של נקודות יחדיו ובצוע פעולה 

מסוימת על קבוצה זו. נדון עתה בפעולה נוספת )ושימושית מאד!( שניתן לבצע על בלוקים.  
ורות מסוימות יחדיו. נשתמש בדוגמא פעולה זו מאפשרת מחיקה והוספת עמודות לקבוצת ש

 הבאה: 
 

שייבאנו לתחתית הרשימה, אך בטור השמאלי ביותר של  קואורדינטותנניח  שלפנינו רשימת 
 , ז"א ששורה ברשימה תראה לדוגמא כך:0הרשימה מופיע הקוד  

                       30.15     100.37      500.32     Bm200     0 
מיותר. נוכל כמובן לעבור שורה, שורה ולמחוק   0ית, שכן הפרמטר שורה זו אינה תקנ

 טר זה, אך הדבר יגזול זמן רב. לביצוע עבודה עם בלוקים: פרמ
 סמן את הנקודה הראשונה ברשימה. .1
לחוץ   Shift -עבור עם החצים לנקודה האחרונה שברשימה, החזק מקש ה .2

 )במקלדת( וסמן עם העכבר את הנקודה האחרונה.
 (. Block)ע"י סימון וי  ליד המילה  Block -קבוצת הנקודות כ לכוד את  .3
  0הבא את סמן הטקסט אל שורת עריכת הנקודות, כך שיעמוד לפני הפרמטר   .4

 שמופיע בשורה. 
תוכל להבחין שכל העמודה שבה נמצא  -שבמקלדת  Delete -לחץ על מקש ה .5

 (.Block -הסמן נמחקה מכל השורות הרלוונטיות )השורות שב
 .  על בלוקיםתבטל את הפעולה   Block -שליד ה   V-הה נוספת על סימון לחיצ .6

 
 בצורה שהודגמה ניתן למעשה למחוק או להוסיף תווים/ רווחים לעמודות בקבוצה של נקודות.    
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 קודיםו : עבודה עם בלוקים3פרק 
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 ( sCodeעבודה עם בלוקים ) 
 

ע"ג השרטוט בצורת    בפרויקט קואורדינטותהאפשרות להציג את CivilCAD 10 לתוכנת 
 .שמוגדרים מראש בלוקים

ניתן למצוא את הספריות המכילות את הבלוקים של  CivilCAD 10לאחר התקנת תוכנת 
תן נעבוד הם  קריות שאי,הספריות העי Codesתחת ספריית ההתקנה בתיקייה  התוכנה,

MainHeb  המכילה את הבלוקים בעבריתMain שפה המכילה את אותם הבלוקים ב
 האנגלית. 

כל ספריית בלוקים  ל, נוכל לראות שWindows  - דרך ה CODES - אם נכנס לתיקיית ה
  יש קובץ   MainHebבעלי אותו שם, לדוגמא: לספריית  DXF  DWT נמצאים בנוסף קבציי

MainHeb.dwt  וקובץ MainHeb.dxf  . 
ודה עם קודים  אלו הם הקבצים אשר בתוכם מוגדרים כל הבלוקים של הספרייה )ראה עב

 בפרק זה(.
 

 התיקייה נמצאת במיקום ברירת המחדל: Windows 7/8/10במערכת הפעלה 
C:\ProgramData\SivanDesign\CivilCAD\Codes\ 

 
 

 הנושאים בפרק זה: 
 קביעת צורת העבודה בבלוקים 
 עבודה עם קודים  
 עם בלוקים.  פרויקטטעינת רקע חדש לתוך  
 Topography-Codesהפעולות בחלון  
 בלוקים בכבישים 
 template-הגדרת הצבעים בקובץ ה 
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 קביעת צורת העבודה בבלוקים
 

 כדי לשנות את מצב העבודה לבלוקים.  Prototypeראשית נפתח את הפרויקט 
 . File → Open projectהפעל: 

 . OK, ולחץ Prototype.prjבחר את פרויקט  
 .File → Configurationהפעל: 

 . Drawing enviormentעבור ללשונית 
 .BlocksModeבאפשרות  Vסמן 
 . OKלחץ 

 
 כעת נעבור לחלון הגדרת הקודים: 

 . Topography → Codesהפעל: 

 לחץ על כפתור התיקייה הצהובה. 
 . OK, בחר מתוכו את ספריית הקודים הרצויה ולחץ OpenSetנפתח החלון 

 SETתוב מופיע בחלק העליון של החלון תחת הכי הספרייהכעת נוכל לראות ששם 
   

 בחרנו את ספריית הבלוקים שבה אנו מעוניינים לעבוד. כעת נגדיר את בלוק ברירת המחדל
 שלא הוגדר לה קוד ברשימה. קואורדינטותלשל הפרויקט. בבלוק זה תשתמש התוכנה גם 

 בחר את מספר הבלוק מתוך הרשימה בחלק העליון של החלון.
 

 (Set block as default)  לחץ על 
 .   Yes אם ברצוננו להחליף לבלוק שבחרנו, לחץה תשאל כנהתו
 

כפתור   על  הקואורדינטות,  לחץ  לרשימת  מעל  הקואורדינטות ]  שנמצא  שרשימת    וודא 
Topography Coordinates  מופיעה בחלקו התחתון של המסך 

(Topography->Coordinates)  ]בחלון שיפתח סמן את האפשרותBlocks mode   ב  -ואשר 
OK . 
 

 . Save -ב ר את השינוייםשמו
 .   File → Exit צא מהתוכנה ע"י

 אשר את שמירת הנתונים.ביציאה, 
 

  חדש בתוכנה, נעבוד במצב של בלוקים.  פרויקט מעתה בכל פתיחת 

תעבוד במצב שהוגדר   קיימים )פרויקטים שיוצרו בעבר(, התוכנה פרויקטיםבפתיחת 
 . פרויקטלאותו 
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 (BLOCK)עבודה עם קודים 
 
 ביר את צורת העבודה עם בלוקים ע"י תרגיל. נס

 חדש, ונבצע את הפעולות הבאות: פרויקטלאחר שקבענו את צורת העבודה בבלוקים נפתח 
 ) כפתור תיקייה צהובה( Load from text fileלחץ על  קואורדינטותהברשימת 

 sample7.tcoטען את הקובץ: 
 
 

 ום ברירת המחדל: הקובץ נמצא במיק Windows 7/8/10במערכת הפעלה 
C:\ProgramData\SivanDesign\CivilCAD\Samples\Sample7\ 

 

 .   Refreshכפתור לחץ על 
לשרטוט כאשר הם מוצגים ע"י בלוק  קואורדינטותהכעת נוכל לראות שהתוכנה טענה את 

את הקוד המייצג לכל שורה התוכנה  קואורדינטותהשלא הקלדנו ברשימת  מכיווןקבוע, 
 ברירת המחדל שהגדרנו קודם לכן.  השתמשה בבלוק

 
 כעת נשנה את הרשימה: 

 בחר מספר שורות ברשימה והקלד בסופן מספרים שונים של קודים, ההקלדה תתבצע
 בשורת העריכה אחרי הגובה.     

)נקודה זו תוצג ע"י בלוק שהקוד שלו הוא     1     1000     1000     100.37      23לדוגמא:  
23) 

הנוכחית,כדי לראות את  הספרייהים להיות קיימים ברשימת הבלוקים של קודים אלו חייב
ובחלקו העליון של   Topography-codesרשימת הקודים הקיימים יש לפתוח את חלון

   החלון נוכל לראות את רשימת הקודים. 
 

  קואורדינטותה*)ברשימת  Reorder Coordinates לאחר ההקלדה לחץ על הכפתור  
 ימינה ושמאלה(, הריווחים ברשימה יסודרו באופן אוטומטי. כפתור עם חצים 

 , כעת התוכנה תשנה את הבלוקים בהתאם לשינויים שנערכו ברשימה.לחץ שוב על 
 

ברשימת    Options כדי לשנות את גודל הבלוקים בשרטוט יש ללחוץ על כפתור
ני של חלון זה  )בחלקו התחתון ימ Scale -ובחלון שנפתח יש לשנות את ה קואורדינטותה

, התוכנה תשנה את גודל הבלוקים OK( לגודל הרצוי וללחוץ  Coordinatesתחת הכיתוב 
 באופן אוטומטי. 

 
 *שלא כמו עבודה ללא בלוקים, עבודה עם בלוקים מחייבת ישור הנקודות בעמודות לפני 

 . לחיצה על 
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 עם בלוקים.  פרויקט טעינת רקע חדש לתוך  
 

 טוענת קובץ  CivilCAD 10חדש עם בלוקים תוכנת פרויקט  פעם שאנו פותחיםבכל 
TEMPLATE תה אנו רוצים לעבוד.  יהמכיל את כל הבלוקים ששייכים לספריית הבלוקים שא

 רקע חדש ע"י  לפרויקטאם נטען 
File → Open מתוך התפריט בAutoCAD/ZWCAD -   אנו נמחק את כל הבלוקים שהוגדרו

 קובץ ב
 . TEMPLATE - ה

  - AutoCAD/ZWCADב  INSERTנשתמש בפקודת  לפרויקטנרצה לטעון רקע  לכן כאשר
 .dxf-כונטען אותו כבלוק או 

 במידה ומחקנו בטעות את הגדרות הבלוקים, יש לבצע את הפעולות הבאות:
 - File → Open: AutoCAD/ZWCAD .הפעל דרך תפריט ה

  File of types :Drawing template file(dwt)-בחר ב
 Main.dwtלדוגמא:-codes  הרלוונטי בספריית ה - TEMPLATEקובץ פתח את 

 .  Refresh Allלחץ על כפתור   CivilCAD 10-ב
 . AutoCAD/ZWCAD :Zoom-Extends-הפעל ב

 של מחדש ושחזור TEMPLATEלאחר טעינת קובץ ה  הפרויקטכעת ניתן לראות את 
 השכבות. 

 

 קודיםבלוקים עם בניית 
 

 .”Prototype‘ים מתוך פרויקט יש ליצור את כל הקוד
 

ומהתפריט הראשי הפעל  ’Prototype’פתח את פרויקט  (1
‘Topography→Codes’.  

 

, הזן שם לסט החדש בחלקו העליון של החלון מימין()  ’New Set’ לחץ על כפתור (2

ובחר סט מתוך הרשימה    ’Open Set‘ , או לחץ על כפתורOKולחץ על כפתור ,
 יים. להוספת קודים לסט ק

 

  Blockליצירת  )בחלקו התחתון של החלון מימין(,   ’New Block’לחץ על כפתור  (3
 חדש עם קוד. 

לבחירת   ’Browse file name‘הזן שם רצוי לבלוק עם הקוד החדש ולחץ על כפתור  (4
 .Block  –של ה  DWG –ה 

 

  
 

 לשמירת ההגדרות. ’Set the changes to the block‘  לחץ על כפתור   (5
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 עבור כל בלוק עם קוד.  3-5על שלבים  חזור (6
 

 AutoCAD/ZWCADשל בלוק בתוכנת  DWGלאחר בניית כל הבלוקים, פתח כל  (7
 הכי ישנה שניתן. גירסהב  DXFושמור אותו כקובץ 

 
 של הבלוק להיות ממוקמים באותה תיקיה.  DXF  –וה  DWG –על קובץ ה  (8

 
 

  Codes -Topographyהפעולות בחלון
 

 חדש(:  SETים חדשה )ריית בלוקיקת ספיצירה, עריכה ומח
 

 New Set  –  פתיחת ספריית בלוקים חדשה, לחיצה על כפתור זה תציג חלון עם שמות
   New setלהקליד את שם הספרייה החדשה ליד הכיתוב   הספריות שקיימות, בחלון זה יש

 . CODESמיקומם של ספריות הבלוקים הוא בספריית  .OK וללחוץ
 
 

 התיקייה נמצאת במיקום ברירת המחדל: Windows 7/8/10במערכת הפעלה 
C:\ProgramData\SivanDesign\CivilCAD\Codes\ 

 

 Erase set -  לחיצה על כפתור זה ולאחר מכן בחירת הספרייה מתוך הרשימה הנפתחת
 ( Codesאת הספרייה מהרשימה ומתיקיית הקודים ) מוחקת באופן מוחלט

 

Open set  – לוקים קיימת, לחיצה על כפתור זה תציג את רשימת פתיחת ספריית ב
 . OKהספריות הקיימות בחלון נוסף, ולאחר בחירת הספרייה יש ללחוץ 

 

Set block as default   –  ,בחירת בלוק ברירת המחדל 
לאחר בחירת הבלוק מתוך רשימת הבלוקים בחלון זה, לחיצה על כפתור זה תקבע את 

שלא הוגדר לה קוד   לקואורדינאטה  ייוחסדל. בלוק זה הבלוק הנבחר כבלוק ברירת המח
 .קואורדינטותהברשימת 

 

 Preview  –  תצוגה מקדימה של הבלוק 
 לחיצה על כפתור זה תטען את הבלוק עצמו לסביבה הגראפית, ותציג אותו על המסך.

  יןיצחשוב ל. פעולה זו מוחקת את השרטוט הקיים, ולכן יש לבצע אחריה לחיצה על  
 .CivilCAD 10ה  זו תבצע שחזור אך ורק של השכבות הקשורות לתוכנת שפעול

 
 

 Browse file name –   בחירת קובץ בלוק מתוך תיקיית הבלוקים 
 כאשר אנו מעוניינים לבחור בלוק חדש ולהכניסו לתוך הספרייה ,נצטרך לפתוח את חלון זה

נלחץ על אחד מהבלוקים  ומתוכו נבחר את הבלוק שנרצה להגדיר לספרייה הנוכחית, כאשר
 הנפתחת, שם הקובץ של הבלוק הנבחר יופיע בשורת ההקלדה באופן אוטומטי.  ברשימה
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 New Block –   בחירת בלוק חדש 
מגדירה בלוק חדש, כדי לבחור בלוק מתוך הרשימה יש לפתוח את   לחיצה על כפתור זה
 החלון של רשימת

מתוך הרשימה, שם הקובץ יופיע ליד  . לאחר בחירת הבלוק  צה עליהבלוקים ע"י לח
 הכיתוב: 

File-name :את שם הבלוק יש למלא ליד הכיתוב .Blocks-name  את שם השכבה שבה ,
יש להשתמש באותה שכבה לכל הבלוקים   Layerיוכנס הבלוק יש להקליד ליד הכיתוב 

זהו   .Codeאת מספר הקוד שנבחר לבלוק החדש יש להקליד ליד הכיתוב באותה ספרייה.
כדי להשתמש בבלוק זה.לאחר שהגדרנו את כל  קואורדינטותההקוד אשר נקליד ברשימת 

, הבלוק יוכנס לרשימת הקודים אשר נמצאת בחלק יוהנתונים לבלוק החדש יש ללחוץ על
 העליון של חלון זה. 

 

 Erase block –  .מחיקת בלוק מהספרייה 
 ו מוחק את הקובץ שלו מתוךכפתור זה מסיר את הבלוק מרשימת הבלוקים, אך אינ

 התיקייה אליה הוא שייך, כך שנוכל בעתיד להחזירו לתוך הרשימה.
 
 

 בלוקים בכבישים 
 

 CivilCADובו מוגדרים כבישים, תוכנת   פרויקטבמצב עבודה של בלוקים, כאשר אנו יוצרים 
רת  ( ע"י בלוקים בצוIPsיוצרת את השכבות המייצגות את הנתונים של נקודות המפנה) 10

 שלטים, כך שאם ברצוננו לערוך את השרטוט שהתוכנה יצרה, נוכל לעשות זאת בקלות רבה.
 

 בצע את השלבים הבאים:בלוקים עם כדי להגדיר את מצב העבודה בכבישים 
 . Roads->Horizontal alignmentמתוך התפריט הראשי הפעל: 

 אשי. , יפתח חלון האופציות הרOptions בחלון שיפתח מימין לחץ על 
( תוכל להבחין Horizontal alignmentבחלקו השמאלי העליון של חלון זה )תחת הכיתוב 

 . Show all dataה את האפשרות י, סמן תחת IPs data in blocks modeבאופציה: 
 . OKלחץ 

 
עם בלוקים והגדר בו כביש, כאשר התוכנה תיצור את התנוחה   פרויקטכדי להמחיש זאת צור 

את אחד השלטים של נקודות המפנה   -AutoCAD/ZWCADזיז מתוך השל הכביש נסה לה
(IPs  תוכל לראות שהשלט מורכב כולו מבלוק אחד ובאפשרותך להגדילו או לסובבו לפי )

 הצורך. 
 

 Templateהגדרת הצבעים בקובץ ה  
 

, הוא האפשרות להגדרת CivilCAD 10עם בלוקים בתוכנת  בפרויקטיתרון נוסף לעבודה 
שיוצרת התוכנה מראש. לדוגמא, באפשרותך לקבוע את הצבעים בקווי   ותהצבעים בשכב

 הגובה שהתוכנה תיצור.
 

  - File → Open: AutoCAD/ZWCAD .הפעל דרך תפריט ה
 . File of types :Drawing template file(dwt)-בחר ב

 . MainHeb.dwtלדוגמא:-Codes הרלוונטי בספריית ה -TEMPLETEפתח את קובץ ה
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 . AutoCAD/ZWCAD-רשימת השכבות ב פתח את
 כרצונך.  Tcontoursשנה את הצבעים בשכבות 

 שמור את הקובץ.
 . CivilCAD 10הפעל את תוכנת 

 (.MainHebחדש עם בלוקים )במקרה הזה עם הספרייה  פרויקטפתח 
 .  Topography coordinatesלתוך ה קואורדינטותטען קובץ 

 .  Topography → Contoursגובה ע"י  קוויהרץ 
 

כעת תוכל לראות שהשכבות שהתוכנה יצרה כדי להציג את קווי הגובה, מוצגות בצבעים  
קודם לכן. בשיטה זו תוכל להגדיר לכל שכבה שהתוכנה  Templateה שהגדרת בקובץ

 מייצרת את הצבע מראש.
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 : יצירת קווי גובה 4פרק 
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 יצירת קווי גובה
 

בהמשך נדון באפשרויות  ,נדון באופציה הבסיסית בפרק זה נדון ביצירת קווי גובה. בהתחלה
 נוספות ולבסוף בנושאים מתקדמים כגון הגדרת קווי אי רציפות. 

 
 הפעלה ראשונה  
 נושאים בסיסיים והגדרת תחום קווי הגובה  
 פירוט כפתורי הפעולה בחלון קווי הגובה  
 קביעת הגדרות 
 Layersשכבות קווי הגובה  
 עיבוד נקודות ליצירת קווי גובה 
 קווי אי רציפות 
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 הפעלה ראשונה
 

 Contours Topography <-להפעלת אופציית קווי הגובה הפעל: 
 (Topography  .)מופיע בסרגל התפריט הראשי שבראש חלון השרטוט 

מימין לשרטוט, בחלון שולחנות העבודה, יופיע חלון קווי הגובה )עם כותרת 
 (.  Topography Contoursכחולה:

 
שבחלון יתחיל תהליך חישוב קווי הגובה, נתוני הקווים כגון:     Applyפתור  עם לחיצה על כ

, יבחרו אוטו' על ידי התוכנה על פי  `. שכבות הקווים וכו (intervals)הפרשי גבהים ביניהם 

 .( אשר ניתן להפעילו ע"י לחיצה על  Optionsברירות המחדל המופיעות בחלון האופציות )
 

 תחום קווי הגובה נושאים בסיסיים והגדרת 
 

חדש ונעתיק בו את רשימת  פרויקטלצורך הדגמת הנושאים שבהם נדון בהמשך נפתח 
 הנקודות הבאה:

 
15.50  40.00 20.00 1 
14.52 30.00 10.00 2 
15.00 20.00 0.00 3 
15.50 25.86 34.14 4 
14.52 15.86 24.14 5 
15.00 5.86 14.14 6 
15.50 15.59 59.93 7 
14.52 2.19 54.12 8 
15.00 14.78- 52.33 9 
15.50 22.28 88.51 10 
14.52 5.76 97.44 11 
15.00 5.41- 107.27 12 
15.50 42.76 109.95 13 
14.52 26.03 124.33 14 
15.00 12.70 138.97 15 

 

  ומיד אח"כ על כפתור מה שיהרכדי לסדר את  לאחר הקלדת הרשימה לחץ על כפתור  
 העליון של המסך(. הנקודות יופיעו ע"ג השרטוט. )נמצא בחלקו 

 
. intervals  -: בחלון קווי הגובה מופיע שדה ה קביעת ההפרשים בין קווי הגובה .1

את ההפרש   intervals לקביעת ההפרשים בין קווי הגובה הקלד בתיבת הטקסט שמימין ל
,   defaultמילה )הערה: אם בתיבת הטקסט מופיעה ה Applyהרצוי. לאישור הפעולה לחץ 

 מחק אותה והקלד את ההפרש הרצוי(. 
 
: עם פתיחת חלון קווי הגובה תוכל להבחין  הגדרת תחום אזור חישוב קווי הגובה .2

. מילה זו מציינת שקווי הגובה  Extentsבמסגרת גדולה המופיעה בחלון ובה המילה:  
השרטוט, ויתרה  ( בכל אזור Apply -יחושבו )כמובן לאחר הפעלת הפעולה ע"י כפתור ה
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קבע לשרטוט הקווים תהיה תמיד קמורה, לדוגמא באזור עם הנקודות  ימזאת, הצורה שת
 הנ"ל: 

                                                  
 
 
 
 
-10<-7<-4<-1אזור שבשרטוט הנ"ל יחושבו קווי הגובה גם בשטח הכלוא בין הנקודות ב
דיפים, ללא האזור  הנ"ל. לצורך חישוב קווי הגובה ללא  , ולא, כפי שאולי היינו מע1<-13<

 האזור שצוין, נגדיר את אזור קווי הגובה באופן הבאה: 
 מתוך רשימת המצבים שבחלון הימני. Locate -בחר ב  
עבור לאזור השרטוט ובחר את האזור הרצוי ע"י הגדרת הנקודות  

  9< --- 6< --- 3< --- 2< --- 1    התוחמות אותו: 
   בשורת הפקודות(.   Enter -ו Sלהקליד ם בסיו 
 לצורך יצירתם. Applyלאחר הגדרת תחום קווי הגובה לחץ  

 
 קיימות שיטות נוספות להגדיר את תחום קווי הגובה.להלן נראה שתי שיטות נוספות:

 
: בראש החלון שמימין הזנת שמות הנקודות התוחמות את אזור קווי הגובה

סמן לשורה זאת והכנס את הנקודות התוחמות מופיע שורת טקסט. עבור עם ה
. תוכל אף להכניס רצף Enterאת קווי הגובה. בין כל נקודה לנקודה הכנס 

.  100-110נקודות יחדיו בתנאי שנקודות אלו ממוספרות בסדר עולה, לדוגמא: 
 לקבלת קווי הגובה.  Applyלחץ   .Enterלאחר שתכניס ערך זה, לחץ 

 
בין הנקודות   Polyline, העבר AutoCAD/ZWCAD  -: בPolyline -שימוש ב

הרצוי, בחר   Polyline -התוחמות את אזור קווי הגובה. לאחר ששרטטת את ה 
  Polylineמתוך רשימת המצבים מימין. עבור לשרטוט, בחר את  Select -ב

. תוכל לראות שברשימת הנקודות שבחלון מימין מופיע  Enter -שסימנת ו
 לקבלת קווי הגובה.  Apply. לחץ <Noname>רשימת 

תוכל לעשות בכל שכבה רצויה. לנוחות עבודה, תוכל  Polyline -הערה: את שרטוט ה
למקסימום ע"י סגירת הפאנלים )רשימת  AutoCAD/ZWCAD -להגדיל את חלון ה

, תוכל להחזירם ע"י  Polyline -ושולחן העבודה מצד ימין( ולאחר שרטוט ה קואורדינטות
 . Topography->Contoursעל לחיצה בתפרי הראשי 

 
Show Triangles -   הצגת משולשי האינטרפולציה בשרטוט: סימון אופציה זו

יגרום לכך שבכל חישוב קווי גובה ישורטטו המשולשים ששימשו לאינטרפולציה 
אינטרפולציית   תוכנהביצירת קווי הגובה. לחישוב קווי הגובה מבצעת ה

אזור המחושב "יכוסה" במשולשים. , כך שכל ה(triangulation)משולשים 
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תבחר בעצמה את המשולשים, כך שכל נקודה תיקשר )במידת  תוכנהה
האפשר( לשתי הנקודות הקרובות ביותר אליה, ולא תיווצר חפיפת משולשים, או  

 אזור שלא יכוסה במשולשים. יישארשלא 
 

Fix borders - מדויק,   תיקון גבולות אוטומטי: כאמור, במידה ולא  הוגדר גבול
. באפשרותך להורות למחשב לבצע תיקון גבול אזור  הפרויקטיתבצע בכל אזור 

תגרום לחישוב קווי   OKקווי הגובה באופן אוטו'. סימון האופציה ולחיצה על 
לצמצם את גבולות החישוב, כך   תוכנהו תנסה ההגובה מחדש, חישוב שב

אופן זה נוכל למנוע  שמשולשים בעלי צלע ארוכה במיוחד יוסרו באופן אוטו'. ב
חיבור בין נקודות מרוחקות, כאלה שאין לנו צורך בחיבורן. הערה: אופציה זו  

מהי   ופרויקט פרויקט לכל  תוכנהמתבססת על חישוב מתמטי שבו מגדירה ה
והמרחק הממוצע  בין   הפרויקט"צלע ארוכה במיוחד", וזאת עפ"י צפיפות 

ם פתרון מושלם ובמקרים אלה נקודות. כמובן שחישוב זה אינו מהווה לעיתי
 נפנה לכלים אחרים המוסברים בפרק זה.  

 
Show borders  –   הצגת הגבול לקווי הגובה, אם הוגדר גבול התוכנה תציג

ווי הגובה שהיא יצרה  גבול זה, אם לא התוכנה תסמן את הגבול המחושב לק
 ותציג אותו. 

 
Create triangles only  – לא תציג את קווי   יצירת משולשים בלבד: התוכנה

הגובה אך תיצור את רשת המשולשים בזיכרון. ניתן יהיה לבצע כל חישוב 
 בתוכנה למרות שקווי הגובה לא קיימים בשרטוט. 

 
Smooth –   החלקת קווי הגובה: כברירת מחדל, יוצרת התוכנה קווי גובה

ל  שולשי האינטרפולציה. ניתן להורות לתוכנה לבצע "החלקה" שממדויקים על פי 
. התוכנה OK”( בשדה הנ"ל ולחץ Vקווי גובה אלו. לביצוע ההחלקה סמן וי )" 

הערה: קווי הגובה לאחר "החלקה" מאפיינים את מצב  ת קווי הגובה.תחליק א
פני השטח בדיוק נמוך יותר. באזורים עם קווי אי רציפות קווי הגובה עלולים  

 להיות שגויים. 
 

Max interpolation length – לאינטרפולציה:   מקסימאלירחק הגדרת מ
אינטרפולציית משלושים בין כל   CivilCAD 10כברירת מחדל, יוצרת תוכנת 

לביצוע  מקסימאליהנקודות הקיימות. באפשרותנו להגדיר לתוכנה מרחק 
מ' )יחידות העבודה לשדה   60 -אינטרפולציה זו. אם נכניס לדוגמא, ערך של כ

וכנה אינטרפולציה רק בין הנקודות  , תבצע התApplyהנם במטרים(, ונלחץ 
מ'. בצורה כזאת נוכל להסיר משולשים שאינם   60שהמרחק ביניהן אינו עולה על 

 רצויים כיוון שלהם צלע העולה על המרחק הנ"ל. 
 

"( ליד האופציה  Vעל מנת ליישם שימוש בכל אחת מהאופציות המוזכרות להלן, סמן וי )" 
את קווי הגובה בהתאם להגדרות שנקבעו,  . התוכנה תחשב Applyולחץ על כפתור 

התוכנה קווים אלו   תמחקותשרטטם. במידה והיו כבר קווי גובה על פי הגדרות קודמות, 
 ותציג רק את הקווים החדשים.

 
 ום ספציפיים על מיקכיתוב הגבה
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Pick height -  כיתוב הגבהים במקום ספציפי: קיימים מקרים שבהם מיקום כיתוב הגבהים
אינו מספק או לעתים אף אינו טוב. באפשרותנו להורות למחשב להוסיף  תוכנהשבחרה ה

ועבור לאזור השרטוט. צור קו בין שתי   Pickכיתוב גבהים בצורה הבאה: סמן את האופציה 
נקודות כלשהן )לחץ על כפתור העכבר ונוע עמו עד למקום חדש(, כך שקו זה יחתוך מספר 

ישורטטו באופן אוטו' גבהים בנקודות החיתוך עם קווי  קווי גובה. לאחר סיום סימון הקו 
הגובה. ניתן גם למנוע כיתוב גבהים בשכבות לא רצויות באופן הבא: הכנס לשכבות והקפא  

 Pick –את השכבות שבהן אין ברצונך לשרטט גבהים. חזור לחלון קווי הגובה ובחר שוב ב 
height ן שכבות שאינן מוקפאות. בסיום  לשרטוט קו החיתוך. כרגע יכתבו גבהים רק באות

קביעת הכיתוב החזר את השכבות המוקפאות למצב צפייה בהן. השכבות יוחזרו לשרטוט, 
 אך ללא כיתוב הגבהים.

 

 פירוט כפתורי הפעולה בחלון קווי הגובה: 
                    

 נעבור ונראה את שימושם של שאר הכפתורים המופיעים בחלון: 
 

ם קווי הגובה באופן מיידי: עם לחיצה על המקש יופיע קו צהוב סביב הבלטת תחו -  .   1

 תחום קווי הגובה. למחיקת הקו לחץ כפתור  
 

מחיקת רשימת הנקודות המגדירות את תחום קווי הגובה: לחיצה על המקש  -  .   2
תמחק את רשימת הנקודות התוחמות את גבול קווי הגובה, ותחזיר למצב של 

 חישוב כל השטח.
 

רות את תחום קווי הגובה: סמן את ימחיקת נקודה מרשימת הנקודות המגד -  .   3
הנקודה שברצונך למחוק מרשימת הנקודות ולחץ על הכפתור. לקביעת השינוי  

 .    כפתורעל  כסופי לחץ
 

קבע: לאחר כל שינוי בגבולות חישוב קווי הגובה, יש ללחוץ על כפתור זה  פעולת -  .   4
 את השינוי לתוקף.  על מנת להכניס

 

. ראה פירוט פעולות (Options)פתיחת כרטסת קביעת ההגדרות של קווי הגובה  -  .  5
 הכרטסת בפרק קביעת ההגדרות. 

 
 

 קביעת הגדרות 

. בחלקו השמאלי  (Options), יופיע חלון הכרטסת  כאמור, עם לחיצה על כפתור הכרטסת  
הכיתוב   )תחת  זה  חלון  של  נוContoursהעליון  הניתנות (  נוספות  באופציות  להבחין  כל 

 הפעולות האפשריות בחלון זה: להגדרה. נפרט כאן את
 

1. Auto elevations -   גבהים אוטומטיים: כאשר אופציה זו מסומנת, תלביש
באופן אוטו' את מספור קווי הגובה ע"ג התכנית. הסרת האופציה והרצת  תוכנהה

קווי גובה בלבד ללא כיתוב הגבהים חישוב קווי הגובה שוב תגרום לכך שישורטטו 
לידם. מכיוון שקווי הגובה מחולקים לשכבות עפ"י ההפרשים ניתן לקבוע באילו  

 בכך נדון בהמשך פרק זה. -שכבות יכתבו גבהים ובאילו לא 
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2. Barracks –   סוגריים: סימון האופציה תגרום לשרטוט סוגריים מרובעים סביב
ה תוכל ליצור הבחנה בין קווי גובה קיימים  כיתוב הגבהים בקווי הגובה. באופן ז
 לבין קווי גובה המתוכננים לדוגמא.

3. format    סימון האופציה יגרום לכיתוב הגבהים בפורמט  ##.#. נבהיר :'#.##'
. בין אם הפורמט הנ"ל 3.25זאת באמצעות דוגמא: נניח שאמור להיכתב הגובה: 

ת זאת, במקרה שבו אמור . לעומ3.25 - מסומן או לא, ייכתב הגובה תמיד כ
 יהיה הבדל בין הכיתובים:  3.20להיות 

 . 3.2 -ללא האופציה ייכתב  -        
 . 3.20 -עם האופציה ייכתב   -        

 
4. Scale -  גודל הכיתוב: באפשרותך לשלוט בגודל הכיתוב של קווי הגובה.   -קנ"מ

ובחר את גודל    defaultלשינוי גודל הכיתוב לחץ על החץ הקטן שמימין למספר/ 
כיתוב גדול יותר. המילה  ל תגרוםמספר גדול יותר בחירת  –הכיתוב הרצוי 

default להתאים את גודל הכיתוב לגודל השרטוט, אך במקרים   תוכנהתורה ל
 רבים אופ' זו לא תהיה יעילה, שכן צפיפות קווי הגובה תחייב כיתוב קטן יותר.  

 
 ה היא:חלוקת גודל הפונט לפי קני המיד        

 0.1גודל פונט:   1:100עד  
 0.5גודל פונט:   1:250עד  
 0.7גודל פונט:   1:500עד  
 1.2גודל פונט:   1:1000עד  
 1.5גודל פונט:   1:1250עד  
 5גודל פונט:   1:5000עד  
   10גודל פונט:  1:10000עד  

  100הערה: בשלב ההדפסה יודפס הכיתוב כפי שהוא נצפה ע"ג המסך. גודל כיתוב של 
 בקירוב.  1:250 -להדפסה בקנ"מ של כ מתואם
 

Show flow direction –   "( סימון ויV באופציה זו יראה את כיוון )" המים  זרימת
 Topographyלאחר ביצוע קווי הגובה בפעולה במצב הקיים בלבדחיצים  ע"י

contours → Apply -  
  OKלחץ  –( Watershed)קווי פרשת מים התוכנה תשאל האם להראות גם 

 לביטול. Cancelישור או לא
החץ הלבן מראה את הזרימה בגאיות ושאר החיצים )צהוב,כתום בהיר,כתום כהה 
 ואדום( מראים את הגבהים של הזרימה כאשר אדום הוא גובה הזרימה הכי נמוך.

    

 Layersשכבות קווי הגובה  
 

 1הפרשים של קווי הגובה מחולקים לשכבות לפי ההפרשים ביניהם, ז"א שכל קווי הגובה שב
וכולי(. באפשרותנו לשלוט על שכבות קווי   102, 101, 100מ', לדוגמא, יכנסו לשכבה אחת )

שעליהם החלטנו בזמן  הגובה. נציין שהחלוקה לשכבות תלויה בהפרשים בין קווי הגובה
, מתחת לכיתוב זה מופיעה   Layersמופיעה הכיתוב   (Options)החישוב. בחלון האופציות 

 ת קווי  הגובה: טבלת שכבו
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ה  כל מספר מייצג שכבה. ניתן לדפדף בין תכונות השכבות על ידי סימון השכבה הרצוי
וכולי... (  המופיעים במסגרת    Double, Unusedהעכבר. שאר הנתונים )  באמצעות

 מייצגים את תכונות השכבה המוארת: נדון עתה בתכונות אלה: 
 
1. Intervals - רשי קווי הגובה. כאמור, אנו מחלקים את קווי הגובה לשכבות עפ"י הפ

תוכל לקבוע את האפיון של השכבה, ז"א  Intervals  -ההפרשים ביניהם. בחלון ה 
לדוגמא, יכנסו כל הקווים בהפרשים של   0.5אילו קווים יכנסו לשכבה זו. אם תכתוב 

יס קווים שלהם לא הוגדרו  ולהכנ תוכנהבהפרשים מורה ל  0מ' לשכבה זו. סימון   0.5
 שכבות לשכבה זו.

 
 אם לדוגמא חלוקת השכבות שיצרנו היא כזו: 

 

 הפרש )מ'(   שכבה 

0 10 

1 5 

2 1 

3 0.25 

4 0 

 
,  100.2מ' , כל הקווים שאינם משויכים לשכבות )ז"א  0.1ואנו מבקשים קווי גובה כל  

 .4וכולי...( יופנו לשכבה    100.1
2  .Unused -  שימוש. סימון אופציה זו תנטרל את השכבה המסומנת, כך שלא  חסרת

תיווצר כלל. אם לדוגמא, ברצוננו שכל קווי הגובה יכנסו לשכבה אחת, נסמן בשכבה 
 . Unusedובכל שאר השכבות נסמן   (intervals)    0הפרשים של  0

3. Auto Elevation -    כיתוב גבהים אוטו'. אם אופציהAuto Elevations ,מסומנת 
 Autoאזי יבוצע כיתוב אוטומטי של הגבהים. כיתוב זה יושפע מהאופציה 

Elevations  שעבורה יבוצע כיתוב אוטו' של  מעונייניםשלפנינו. שיכבה שאיננו
נבטל את הסימון לידה. כך לדוגמא, אם ברצוננו שכיתוב הגבהים האוטו' לא  - גבהים

כבה זו ברשימה )נניח לדוגמא , אנו נאיר שי 0.25יבוצע לשכבה של הפרשי הגבהים 
 לידה.  Auto  Elevationsמ'( ונבטל הסימון   0.25 -היא כזו  3שקבענו ששכבה 

 

 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  59עמוד 

 עיבוד נקודות ליצירת קווי גובה
 

יצירת קווי הגובה תלויה כאמור בנקודות המדידה שבפרויקט. יתכן מצב שבו קיימות בפרויקט  
צירת קווי הגובה. נראה אופציות שונות בי תשתתפנהש מעונייניםבה אשר איננו ונקודות ג

 לטיפול בנקודות כאלה:
 

מאפשרת קליטת נקודות נקודות ללא גובה.  CivilCAD 10תוכנת -נקודות ללא גובה .1
קיימת הפרדה בין נקודות  CivilCAD 10להבדיל בתוכנות תיב"מ אחרות, בתוכנת 

בה, תוכנת  לבין נקודות ללא גובה. במקרה ובו לנקודה לא יהיה גו 0בגובה 
CivilCAD 10  .תדע באופן אוטומטי לא לשתפה ביצירת קווי הגובה 

 מעונייניםבאפשרותנו להקפיא נקודות, שיש להן גובה אך איננו   -הקפאת נקודות .2
 שיכללו ביצירת קווי הגובה. הקפאת נקודה תתבצע בשני אופנים: 

  כפתור פעולה  -קואורדינטותהמתוך הרשימה )ראה פרוט בפרק "מאגר  . 1
 המשפיעים על הרשימה וקשורים אליה"(.

פעולות המבוצעות    -קואורדינטותהראה פירוט בפרק "מאגר מתוך השרטוט ) . 2
 בשרטוט ומשפיעות על הרשימה"(. 

 נתרגל כאן הקפאת נקודה:            
  קואורדינטותהלות שבחלון המופיעה ברשימת הפעו  Freezeלחץ על המילה  

חירה מהתפריט  זה סגור ניתן להציגו ע"י בהמסך )אם חלון תית חבתשנמצא 
 (. Topography->Coordinatesהראשי: 

ד את אחת הנקודות שברצונך להקפיא. תוכל ועבור עם הסמן לאזור השרטוט ולכ 
 נוספה בצידה.  <Fr>להבחין שהנקודה אותרה ברשימה התחתונה והמילה  

 לצורך הצגת ההקפאה בשרטוט.   לחץ על כפתור הרענון   
 ע חישוב קווים. לון שרטוט קווי הגובה ובצפתח ח 

 תוכל להבחין בשינוי שהתבצע בקווי הגובה בהתאם לנקודה שהקפאת. אם תוסיף              
 לשים לחישוב קווי הגובה את שרטוט משולשי האינטרפולציה, תראה כי המשו            
 סודרו מחדש, כך שיתעלמו מהנקודה המוקפאת.            

שיופיעו  מעונייניםיתכנו נקודות המופיעות ברשימה שאיננו  -נקודה בשרטוטביטול  .3
בשרטוט. להבדיל מנקודות מוקפאות נקודות כאלו לא יופיעו כלל בשרטוט ומכאן  
 שלא יכללו בקווי הגבוה. בכדי להסיר נקודה מהשרטוט בצע הפעולות הבאות: 

 סמן את הנקודה הרצויה ברשימת הנקודות התחתונה. 
הרצויה והוסף את  ני הנקודהל שורת עריכת הנקודות, לפעמוד ע 

 הסימן "/" בתחילת הנקודה.

 . הנקודה תמחק מהשרטוט. לחץ  
                   

יתכן וברצוננו להשאיר נקודה כפי שהיא, הן   -הקפאת נקודה על ידי הקוד שלה .4
שפיע שת מעונייניםאין אנו  יחד עם זאתבשרטוט והן לשמור על שמה המקורי, אך 

על קווי הגובה. במקרה כזה נוכל להקפיא על ידי מתן קוד לנקודה. כאמור, קוד  
נקודות יופיע בעמודה החמישית של הנקודה )לאחר הגובה(. עוד ניזכר שלנקודה  

הוא גם כן גובה חוקי(.  0שברצוננו לתת לה קוד, חייב להופיע גובה כלשהו )גובה 
 ראה הדוגמא הבאה:  ”.FRהקוד שנוסיף להקפאת הנקודה יהיה " 

 הנקודה שברשותנו הנה:  
    15      175346.32    176728.76    153.14 . 

 ” בצורה הבאה: FRלנקודה הוסף את הקוד "  
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    FR  15      175346.32    176728.76    153.14 . 
על מנת שהקוד יופיע בעמודה הנכונה, לחץ כפתור עימוד   

ים ברשימת הכפתורים  הנקודות )כפתור ועליו שני חצים כחול
 התחתונה(. 

 לרענון השרטוט.  כפתור   על לחץ 
 חזור וחשב קווי גובה ותוכל לראות את ההשפעה.  

 

 קווי אי רציפות 
 

 קו אי רציפות מגדיר קו שבר בטופוגרפיה של פני השטח.
נו למעשה הגדרה גיאומטרית של קו אשר בשלב אינטרפולציות י. קו אי רציפות ה1

קווי גובה לא יהיה מצב שבו נקודות מצדו האחד של הקו ונקודות מצדו  המשולשים ליצירת 
 השני, יתחברו ביניהן ליצירת משולש.נבהיר הנושא עפ"י הדוגמא הבאה:

 
 

 לפנינו קטע כביש מדוד: 

  
 
 
 

ית  ישהתקבלו אינם נכונים. אם נתבונן באינטרפולצבשרטוט נוכל לראות מיד שקווי הגובה 
בא( שהתקבלה בכביש זה, נוכל להבחין שהיא אינה נכונה. ניקח  המשולשים )ראה שרטוט ה 

. האינטרפולציה שהתקבלה בנקודות אלה היא של המשולשים: 6,7,5,15לדוגמא את נקודות 
תתחבר  15הנה נקודה גבוהה ובהכרח אין ברצוננו שנקודה   7. נקודה  6,7,15 -ו   5,15,7

 .   5,15,6  -ו   5,7,6לנקודה זו. היינו רוצים שתתבצע האינטרפולציה  
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רציפות על מנת לפתור את -דוגמא לאופן שימוש: נשתמש כעת בקווי אי –. הגדרת הקווים 2

חדש שתפתח, ופרויקט זה תוכל להריץ  בפרויקטהבעיה. הקלד תחילה את הרשימה הבאה 
 את הדוגמא בהמשך. 

 
147.45 1722.34 1334.69            1    
147.91 1720.00 1336.84            2    
151.64 1719.62 1336.45                3 
148.74 1719.59 1344.39            4    
150.10 1716.48 1355.17            5 
151.15 1712.62 1363.76            6 
151.38 1713.75 1356.89            7 
153.82 1713.68 1356.38            8 
146.83 1728.75 1333.23            9 
146.95 1730.88 1333.64         10 
149.94 1730.88 1333.71         11 
149.63 1723.60 1352.31         12 
149.75 1724.98 1352.80         13 
152.66 1725.29 1354.37         14 
151.10 1719.02 1364.38         15 
151.13 1720.42 1365.50         16 
153.09 1720.61 1366.42         17    

 
   Lines <-רציפות: הפעל: -פתח את חלון קווי אי -חדש  פרויקטלאחר שפתחת 
Topography 

רציפות. החלון מחולק לשניים )להרחבה בנושא זה ראה פרק  -מימין יפתח חלון קווי האי
 חיבורי קווים(: 

 
מאפשר פעולות על  חלק תחתון המכיל את רשימת קווי האי רציפות ו 

 ועוד.   disהרשימה כמחיקת קו  שלם, שמירה כקובצי 
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(  Lines List -חלק עליון המציג את הקו המואר )זה שמואר ברשימת ה  
 ומאפשר פעולות על הקו עצמו כמו הוספת והורדת נקודות ממנו. 

 

 הגדרת קווי אי רציפות 
 

עם פתיחתו של  -Locateרציפות על ידי פעולת בחירת הנקודות בעזרת -הגדרת קו אי .1
ברשימת האפשרויות   Locate. לחץ על 1החלון, יפתח אוטומטית קו חדש בשם 

)את הקו סמן ע"י  6 -ו  5שבחלק העליון, עבור לאזור השרטוט וסמן קו בין נקודות 
 -” בשורת הפקודות של הSלהקליד " (. בסיום סימון הקו 6ולאחר מכן   5לכידת נקודה 

AutoCAD/ZWCAD .) 
 
לבצע אינטרפולציה נכונה ובכך לפתור את  תוכנהרציפות הנ"ל תאלץ את ה ה-דרת קו איהג

הבעיה )לביצוע האינטרפולציה מחדש יש להריץ קוויי גובה שוב(. נמשיך ונגדיר עוד מספר  

רציפות. קו חדש יפתח ותוכל ה-שבחלק התחתון של חלון קווי אי קווים: לחץ על כפתור 
וסמן את   Locate)שוב לחץ על   15,12,9יר קו זה בין נקודות (. נגד2להגדירו )קו מס' 

 הנקודות עפ"י הסדר.  
 

פתח קו חדש והגדר אותו בין   -רציפות על ידי הקלדת שמות הנקודות-הגדרת קו אי .2
מצאת בראש  סט הנלשורת הטק. לאחר פתיחת קו חדש עבור עם העכבר 1,4,5נקודות 

  5 -ו 4. המשך והקלד את נקודות Enter ולחץ 1החלון והצבע עליה. הקלד את הספרה 
 . Set. בסיום לחץ 

 
, בחר הפרשי  Topography -> Contoursרציפות. חזור והפעל ה-סיימנו להגדיר את קווי אי

. קווי הגובה החדשים יחושבו והתמונה Applyולחץ על כפתור  0.5  (intervals)גובה 
 שתתקבל תהיה:

 
 

תחום ספציפי לקווי הגובה )כפי שהוסבר בסעיף   נוכל להשלים את השרטוט ע"י הגדרת
 "נושאים בסיסיים והגדרת תחום קווי הגובה"(.
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)גם למשתמשי גרסת   Polylineרציפות על ידי בחירת -הגדרת קווי אי .3
AutoCAD/ZWCAD )ר קווי איבנוסף לשתי האופציות שהוצגו, ניתן אף להגדי  -בלבד-
)נדגיש שקווי   AutoCAD/ZWCAD  -מתוך ה 3Dpolylinesרציפות על ידי בחירת 

בשני ממדים אינם יכולים  Polylinesוכי   3Dpolylinesרציפות חייבים להיות  -האי
 לשמש להגדרת קווי אי רציפות(. לשימוש באופציה בצע הצעדים הבאים: 

רציפות  -אשר ישמשו כקווי איAutoCAD/ZWCAD  -ב 3Dpolylinesשרטט  
ולחבר בין הנקודות שיצרה   Node -ל Object Snap)תוכל להשתמש ב 

 (. (CivilCAD 10 תוכנת
 . Select -, ובחלון מימין בחר בTopography lines -הכנס לחלון ה 
ובחר את הקו הרצוי. לחץ   AutoCAD/ZWCAD -עבור לאזור השרטוט ב 

Enter.הקו ייקלט בחלון הימני . 

 (, ובחר את הקו הבא.פתח קו חדש )כפתור   
 ים הרצויים. המשך ובחר את כל הקוו

 
 
 

 Dwgסינון קווי אי רציפות מקובץ 
  

מאפשרת הגדרת קווי אי רציפות ע"י סינון קווים המוגדרים בקובץ    CivilCAD 10 תוכנת
DWG( ניתן לסנן קווים מכל סוג .Line,LwPolyline,3dPolyline,2dPolyline  רצוי .)

ללא גובה ולהגדיר להם את  שלקווים אלו יהיה בשרטוט גובה אך ישנה אפשרות לסנן קווים
 הגובה בשלב יותר מאוחר.נסביר בעזרת דוגמא כיצד ניתן לבצע את פעולת הסינון. 

 
 
  

 . File-->New projectע"י   CivilCAD 10-בחדש  פרויקטפתח  
ובחר את השרטוט  File-->Openהפעל  -AutoCAD/ZWCADמתוך התפריט ב 

 שממנו ברצונך לסנן את הקווים. 
 .Topography-->Linesהפעל   -CivilCAD 10במתוך התפריט  

 .((Filter breaklines from dwg file לחץ על כפתור   
, ואת השכבה תחת Entitiesבחלון שיפתח בחר את סוג הצורה תחת הכיתוב  

 Select, באפשרותך לסמן זאת גם באופן אוטומטי  ע"י לחיצה על Layersהכיתוב 
 השכבה וסוג הקו לסינון.  וסימון הקו או הקווים המייצגים את

, התוכנה תציג הודעה, השואלת אם ברצונך בנוסף לסינון הקווים,  Applyלחץ  
 NO. )לחיצה על  קואורדינטותהלהוסיף את הנקודות של הקווים המסוננים לרשימת 

 תוסיף אותם(.
ים ברשימה, התוכנה תציג הודעה השואלת אם ברצונך למחוק את אם ישנם קוו 

 או להוסיף את הקווים החדשים לרשימה זו.הרשימה הקיימת 

 כדי לרענן את הקווים בשרטוט. לחץ  
ולחיצה על  Topography->Contoursרענן את קווי הגובה בשרטוט ע"י הפעלת  

Apply  במידה והתוכנה תיתן הודעה שלמספר נקודות אין גובה, יתכן שביצענו סינון ,
יתן לתקן זאת ע"י אחת מהפעולות גובה. נ ללא מסוימות   נקודותלהם  אשרלקווים 
 הבאות:
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ניתן לאתר את הנקודות ולתקנם ידנית     –תיקון מתוך הרשימה באופן ידני  1

,  קואורדינטותההמופיע מעל לרשימת  ע"י הפעלת כפתור החיפוש 
ולחיצה על   Height,Accurate(, סימון 0בחלון שנפתח הכנסת הגובה )

OK.  0את הנקודות בהם יש גובה  טותקואורדינההתוכנה תסמן ברשימת  .
 יש להכניס את הגובה הרצוי בכל אחת מנקודות אלו.

רשימת הקווים או  י ע"  מסוימים  םקוויניתן למחוק   –  מסוימיםמחיקת קווים  2
 (. Topography/Design linesבפעולות בחלון )ראה  מסויםלפי גובה 

בהם חסרים  ע"י סימון הקווים  –קביעת גובה הקווים לפי הטופוגרפיה  3

לקבלת הגובה לפי המצב הקיים או    גבהים ברשימת הקווים ולחיצה על 

בפעולות בחלון  )ראה  לקבלת הגובה לפי המצב המתוכנן.   
Topography/Design lines .) 

  

כדי לעדכן את הקווים ע"פ השינויים    לאחר תיקון הגבהים בקווים הרצויים יש ללחוץ על  
 .ינטותקואורדהשבוצעו ברשימת 
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 חיבורי קווים :5פרק 
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 חיבורי קווים 
 

מאפשרת הגדרת קווי מדידה אשר מוגדרים בדרך כלל כקווי אי   CivilCAD 10תוכנת 
בפרק זה לקווי   ההתייחסותרציפות. בפרק זה נסביר כיצד להגדיר קווים אלו במספר דרכים. 

ק זה נכונות גם לגבי  (, אך כל הפעולות המתוארות בפרExistingמדידה של המצב הקיים )
 (. Designקווי מדידה של המצב המתוכנן 

 הנושאים בפרק זה:
 

 הגדרת קווי מדידה .  
 הגדרת הקווים.  ישינו 
 . Topography/Design linesפרוט הפעולות בחלון  
 . Dwgסינון קווים מקובץ  

 
 
 

 הגדרת קווי המדידה
 

. נסביר ע"י דוגמא כיצד  מאפשרת הגדרת קווי מדידה בדרכים שונות CivilCAD 10תוכנת 
ואת האפשרויות השונות )הדוגמא הנ"ל מתייחסת ליצירת קווים   בפרויקטלהגדיר קווי מדידה 

 של המצב הקיים, פעולות אלו מבוצעות באותו אופן לקווי מדידה של מצב מתוכנן(.
 
 .  Topography-->Lines. הפעל מתוך התפריט  1
( נמצאת רשימת הקווים, כעת מוגדר קו אחד  Lines list. ברשימת הקווים )תחת הכיתוב 2

 ללא נקודות נגדיר את קו זה ע"י אחת מהשיטות הבאות:
 Locate -   לאחר לחיצה עלLocate   עבור לחלון השרטוט ולחץ על נקודות

ונמצאות על השרטוט. לאחר לחיצה על כל נקודה, התוכנה  בפרויקט שמוגדרות כבר 
(. Topography linesות )שבראש החלון תוסיף את שם הנקודה לרשימת הנקוד

נקודות אלו מייצגות את הקו הנוכחי )המסומן בכחול( ברשימת הקווים תחת הכיתוב 
Lines list . 

 Select   הגדרת קו ע"י בחירת קו משורטט ע"ג השרטוט. לאחר לחיצה על הכיתוב
Select   יש לבחור מתוך השרטוטPolyline  )וללחוץ )רצוי שקו זה יוגדר עם גבהים

ENTER התוכנה תיצור נקודות חדשות המתחילות בשם .DIS   ותוסיף אותם
ן לסנן מספר קווים ממספר שכבות כיצד נית . בהמשך נראהקואורדינטותהלרשימת 

 . Dwgסינון קווים מתוך קובץ בפעולה אחת בסעיף: 
ניתן גם להקליד ידנית את שמות הנקודות )אם הם קיימות  - הקלדת שמות הנקודות 

והקלדת השם.   Name( ע"י לחיצה עם הסמן תחת הכיתוב קואורדינטותהברשימת 
על גבי השרטוט  קו ההתוכנה תצייר את  ENTERצה על לאחר הקלדת כל שם ולחי

ישנם נקודות רצופות )בעלי שמות עוקבים(   בהתאם לנקודות אם
, ENTERוללחוץ   1000-10003,ניתן להקליד   1000,1001,1002,1003לדוגמא:

 וכנה תכניס את כל הנקודות לפי הסדר לרשימת הנקודות ותיצור את הקו. הת
 
 ניתן להגדיר לכל קו רדיוסים בשתי שיטות: – הגדרת הרדיוסים. 3
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להגדרת רדיוס ע"י הכנסת ערכו בין שתי נקודות הקלד את ערך הרדיוס תחת   
 בשורת הנקודה השנייה מבין שתי הנקודות.  2Points+Rהכיתוב 

 

                            
 

על התא הנמצא   Vלסמן  להגדרת רדיוס ע"י שלוש נקודות הנמצאות על הקו יש  
ע"י דאבל קליק על העכבר   3Pointsה האמצעית תחת הכיתוב ורת הנקודבש

 בשדה זה. 
 

   
 

  New line  לקביעת הקו. להגדרת קווים נוספים לחץ על כפתור      כפתור. לחץ על 4
 . 2-4ות  וחזור על הפעול

 

כדי להוסיף את  . לאחר סיום הגדרת הקווים יש לרענן את השרטוט ע"י לחיצה על 6
שות ואת הקווים החדשים לשרטוט. קווי הגובה יעודכנו ע"י הפעלת  קודות החדהנ

Topography->Contours  ולחיצה על כפתורApply. 
 
 

 שינוי הגדרות הקווים 
 

וע את אופן הצגתו ואת האופן בו הוא ישפיע על  לכל קו המוגדר ברשימת הקווים ניתן לקב
 קווי הגובה. 

רשימת הקווים את הקו הרצוי או מספר קווים רצויים  הגדרות אלו יש לסמן בע לקבוכדי 

(. יפתח חלון האפשרויות,  סכרטי)כפתור בצורת יד עם     Optionsץ על כפתור וחלול
אפשרויות שונות, נסביר את ניתן להבחין ב Linesבחלקו הימני העליון תחת הכיתוב 

 האפשרויות בחלון זה: 
 

 Type - .אופן תצוגת הקו ע"ג השרטוט 
1. Continuous-  .)קו רציף )ברירת המחדל 
2. Dashed-  קו )בגרסת וקו מקוAutoCAD/ZWCAD    אופציה זו אינה

של    Linetypeשימושית מכיוון שניתן להשתמש בהגדרת 
AutoCAD/ZWCAD .) 

3. Fence  –  .סימון גדר 
4. Left/Right cliff-   סימון מצוק. כיוון שיני המצוק יקבע על פי הבחירה

Left/Right . 
5. Left/Right slope –   סימון מדרון. כיוון שיני המדרון יקבע על פי הבחירה

Left/Right . 
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6. Distances –   סימון מרחקי הביניים שבין מקטעי הקו לאורכו. גודל הכיתוב
 Widthיקבע על פי ה  

 
 Layer - ה יוצרו הקווים. כברירת מחדל תיצור התוכנה את כל הקווים השכבה שב

 בשכבה אחת. בחירת שכבה שונה לקו מסוים תיצור אותו בשכבה שנבחרה. 
 

 Width-   רוחב הקו. רוחב הקו הנו פרמטר לקביעת גודלו. הגודל ישפיע על הקו על פי
ב  גדול כיתו -Distancesתשורטט גדר רחבה יותר,  – Fenceסוגיו השונים: 

 המרחקים יגדל, וכן הלאה.
 

  Closed - ה קו קו סגור/פתוח: סימון ליד התיבה יגרום לכך שקו האי רציפות יהי
. קווי הגובה בתוך קו זה לא יחושבו ולא יבנה מודל תלת ממדי. בצורה זו נוכל סגור

לשרטט בהן קווי גובה, או  מעונייניםלהגדיר מבנים וצורות סגורות אחרות שאין אנו 
 -ן אנו מעוניים שיכנסו לחישוב הנפחים )לפרוט ראה פרק "יצירת קווי גובהשאי

 הגדרת תחומים שאינם לחישוב"(. 
 

 Breakline-  בכל הפרק ראינו את השימוש באופציית ה- Lines לצורכי קווי אי-
רבות בחלון המאפשרות שרטוט קל  דרכיםימות ים זאת ראינו כי קערציפות בלבד. 

רציפות. אם ברצוננו להשתמש -ם, ללא כל קשר להיותם קווי אימהיר ונוח של קווי
רציפות נשתמש -ים שאינם קווי איעל מנת לשרטט קוו Topography linesבחלון ה 
” מהשדה   Vשנסיר את סימון הוי "  רקכה, -בדיוק שהשתמשנו עד האפשרויותבאותן 

Breaklineה. . הקו יישאר בשרטוט אך לא ישפיע על יצירת קווי הגוב 
 
 

 רציפות -הוספה או החסרה של גובה לקווי אי 

 . 'Design→Lines'או  ’Topography→Lines‘מהתפריט הראשי הפעל:  .1

 ולחץ על כפתור   Lines Listסמן את הקו או הקווים הרצויים ברשימת  .2

3.  'Add dH to selected lines'   . 

  גובה או ערך שלילי בחלון שנפתח, הזן ערך חיובי )במטרים( להוספת .4

 להחסרת גובה. 

 לביצוע הפעולה.  'OK'לחץ על כפתור  .5

 לעדכון השרטוט.     'Refresh'לחץ על כפתור  .6

בנה את  'Design→Contours'או  'Topography→Contours'מתפריט:  .7

 ממדי מחדש )קווי גובה(.-המודל התלת

 

  Topography/Design lines-פרוט הפעולות בחלון   
 

 קיימות בחלון קווי האי רציפות.נעבור ונסקור את כל האופציות ה
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 . חלק עליון: 1
 

. סמן את  מת הנקודות המגדירות את הקומחיקת נקודה מרשי  -      .1
 .Setהנקודה שיש למחוק ולחץ על הכפתור. לאחר השינוי לחץ 

 

לא יכנסו הגדרות הקו החדשות   Set: כל עוד לא נלחץ הקו הנוכחי קביעת -  .2
 וג הקו וכדומה(. לתוקף )הוספת/הורדת נקודות, ס

 

תתאים  כפתור זה :  לחיצה עלקביעת גובה הקו הנוכחי לפי המצב הקיים -   .3
את גבהי הקו לכל נקודה לפי קווי הגובה האחרונים של המצב הקיים שהתוכנה 

בנקודות   קואורדינטותיצרה. התוכנה תשנה גם את הגבהים ברשימת ה
 הרלוונטיות. 

 

:  לחיצה על כפתור זה  המצב המתוכנןקביעת גובה הקו הנוכחי לפי  -   .4
קווי הגובה האחרונים של המצב המתוכנן קודה לפי תתאים את גבהי הקו לכל נ 

בנקודות  קואורדינטותהשהתוכנה יצרה. התוכנה תשנה גם את הגבהים ברשימת 
 הרלוונטיות. 

 

 . שינוי הגדרות הקווים ראה הרחבה בקביעת ההגדרות לקו הנוכחי. -  .5
 

 . בסינון קווים. ראה הרחבה ים מתוך השרטוטסינון קו -   .6
 

7. Find  -   איתור נקודה ברשימה מתוך השרטוט )אופצייתFind  בתיבת הבחירה- 
Locate, Select  )אופציה זו קיימת רק למשתמשי גרסת  -וכולי

AutoCAD/ZWCAD- בחר ב- Find  ברשימה מימין ועבור לאזור השרטוט. בחר
. התוכנה תאתר את הקו הנבחר ברשימה  Enterאת הקו שברצונך לאתר. ולחץ 

 .Lines list -ותסמנו ברשימת ה
8. Select -  .הגדרת קו ע"י בחירת קו משורטט ע"ג השרטוט 
9. Locate - .הגדרת קו ע"י איתור נקודות מוגדרות ע"ג השרטוט 

 
 . חלק תחתון: 2
 

 פתיחת קו חדש לעבודה. -   .     1 

לאחר לחיצה על כפתור זה יפתח חלון ובו האפשרויות  מחיקת קו או קבוצת קווים. - .    2 
 הבאות:
 Only selected lines -   .מחיקת הקווים המסומנים ברשימת הקווים 
 All lines –  .מחיקת כל הקווים מהרשימה 
 Lines above height factor –  מחיקת כל הקווים הכוללים בתוכם גבהים מעל

 .Height factorלגובה הנתון ליד הכיתוב 
 Lines below height factor –  מחיקת כל הקווים הכוללים בתוכם גבהים מתחת

 .Height factorלגובה הנתון ליד הכיתוב 
 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  70עמוד 

המשמשים להגדרת קווי אי   dis. אופציה זו מאפשרת יבוא קבצי  Disיבוא קבצי   - .    3 
רצונך  בחר את הקובץ שב -שיח קבצים -רציפות. עם לחיצה על הכפתור תפתח תיבת דו

ויתורגם כקווי אי רציפות. נקודות האי רציפות יצורפו    הפרויקטלייבא. הקובץ ייקרא אל תוך 
(  Topography Coordinates )בחלון התחתון  קואורדינטותהבמידת הצורך לרשימת 

 והגדרות הקווים )נקודות הקווים( יתווספו ברשימת קווי האי רציפות. 
        h      x          yעמודות עפ"י:        שם הקו     המיובא מחולק למספר  dis -קובץ ה 

שם/מספר נקודה.      בקבצים שונים ייתכן מצב של סידור עמודות שונה. כברירת מחדל 
את העמודות על פי סדר מסוים. ניתן לשלוט על קריאה זו על ידי סידור   תוכנהקוראת ה

הגדרות תצורה   –שאים כלליים העמודות במתואם למבנה הקובץ )לפרוט ראה פרק "נו
 כלליות"(. 

 

. לאחר שהגדרת קווי אי רציפות, באפשרותך לייצא קובץ  Dis יצוא קבצי -   .4
של קווים אלו. לחיצה על הכפתור תפתח את תיבת דו שיח הקבצים.  disבפורמט 

 בחר את המקום של הקובץ החדש והקלד את שמו.
 

רציפות בקובץ כולל  -ווי אימאפשרת שמירה של הגדרות ק CivilCAD תוכנת
 (. .Break/Closed/Type etcהגדרותיהם )

 
הרציפות כולל הגדרותיהם כסגורים או פתוחים, יש לטעון  -על מנת לטעון את קווי אי
 : CivilCAD 10את הקבצים שנוצרו ע"י 

 
 tbl.*רציפות של מצב קיים יישמרו בקובץ בעל סיומת -הגדרות קווי אי
 dbl.*של מצב מתוכנן יישמרו בקובץ בעל סיומת  רציפות-הגדרות קווי אי

 
וטעינתו בפרויקט חדש אינה  Dis.*רציפות כקובץ -הערה: שמירת קובץ אי

 . שומרת את הגדרות הקו כקו סגור או פתוח
 

. במקרים שבהם אזור העבודה הוא גדול ומורכב מקווי  הבלטת הקו הנוכחי -   .5
הקווים שכבר הגדרנו. אופציה זו  אי רציפות רבים נוצרת לעתים בעיה בזיהוי 

לטת הקווים לצורך זיהויים. סמן את הקו שברצונך לזהות  ברשימה  מאפשרת הב
( ולחץ על כפתור הפעולה. הקו יצבע בצבע צהוב. לחיצה Lines list)ראה רשימת  

 תבטל הבלטה זו.  על 
 

 רציפות. -הוספה או החסרה של גובה לקווי אי -   .6
 

 wgDסינון קווים מקובץ  
 

מאפשרת הגדרת קווי אי רציפות ע"י סינון קווים המוגדרים בקובץ    CivilCAD 10 תוכנת
Dwg( ניתן לסנן קווים מכל סוג .Line,LwPolyline,3dPolyline,2dPolyline  רצוי שלקווים .)

אלו יהיה בשרטוט גובה אך ישנה אפשרות לסנן קווים ללא גובה ולהגדיר להם את הגובה 
 וחר.נסביר בעזרת דוגמא כיצד ניתן לבצע את פעולת הסינון. בשלב יותר מא

 
 . File->New projectע"י   CivilCAD 10-בחדש  פרויקטפתח  
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ובחר את השרטוט  File->Openהפעל  -AutoCAD/ZWCADמתוך התפריט ב 
 שממנו ברצונך לסנן את הקווים. 

 .Topography->Linesהפעל   -CivilCAD 10מתוך התפריט ב 

 . Filter breaklines from dwg file    ורלחץ על כפת 
, ואת השכבה תחת Entitiesבחלון שיפתח בחר את סוג הצורה תחת הכיתוב  

 Select, באפשרותך לסמן זאת גם באופן אוטומטי  ע"י לחיצה על Layersהכיתוב 
 וסימון הקו או הקווים המייצגים את השכבה וסוג הקו לסינון. 

עה, השואלת אם ברצונך בנוסף לסינון הקווים,  , התוכנה תציג הודApplyלחץ  
 NO. )לחיצה על  קואורדינטותלהוסיף את הנקודות של הקווים המסוננים לרשימת ה

 תוסיף אותם(.
אם ישנם קווים ברשימה, התוכנה תציג הודעה השואלת אם ברצונך למחוק את  

 הרשימה הקיימת או להוסיף את הקווים החדשים לרשימה זו.

 רענן את הקווים בשרטוט.כדי ל  לחץ  
ולחיצה על  Topography->Contoursרענן את קווי הגובה בשרטוט ע"י הפעלת  

Apply  במידה והתוכנה תיתן הודעה שלמספר נקודות אין גובה, יתכן שביצענו סינון ,
בהם גובה. ניתן לתקן זאת ע"י אחת מהפעולות  מסוימותלקווים שחסר בנקודות 

 הבאות:
 

ניתן לאתר את הנקודות ולתקנם ידנית     –ימה באופן ידני תיקון מתוך הרש .1

(, סימון  0בחלון שנפתח הכנסת הגובה )  ע"י הפעלת כפתור החיפוש 
Height,Accurate   ולחיצה עלOK.  התוכנה תסמן ברשימת

הגובה הרצוי  . יש להכניס את0את הנקודות בהם יש גובה  קואורדינטותה
 בכל אחת מנקודות אלו.

ע"י ברשימת הקווים או   מסוימים  קוויםניתן למחוק   –  מסוימיםוים מחיקת קו .2
 (. Topography/Design lines)ראה בפעולות בחלון  מסויםלפי גובה 

ע"י סימון הקווים בהם חסרים   –קביעת גובה הקווים לפי הטופוגרפיה  .3

לקבלת הגובה לפי המצב הקיים או    גבהים ברשימת הקווים ולחיצה על  

הגובה לפי המצב המתוכנן. )ראה בפעולות בחלון  לקבלת    
Topography/Design lines.) 

 

כדי לעדכן את הקווים ע"פ השינויים    לאחר תיקון הגבהים בקווים הרצויים יש ללחוץ על  
 .קואורדינטותהשבוצעו ברשימת 
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 חישובי שטחים  :6פרק 
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 תחילת עבודה -חישובי שטחים
        

מאפשרת וביניהם לרכז את  CivilCAD 10שובי השטחים שתוכנת פרק זה דן באופציית חי
 הנתונים בטבלאות מסכמות.

 על מנת להסביר את השימוש לצורכי חישובי שטחים, נבצע המהלך הפרק הדגמה.
 (.File -> New projectחדש )להזכירך  פרויקט ח  . פת1
 . הקלד את רשימת הנקודות הבאה שנמדדה ברשת מקומית:2
 

100.0 100.0 1 

133.75 125.32 2 

105.20 129.22 3 

116.56 137.87 4 

108.92 120.28 5 

123.54 126.52 6 

112.83 108.74 7 

125.40 111.06 8 

112.79 98.96 9 

124.70 97.10 10 

112.79 108.96 11 

 
 

 . לקבלת הנקודות על גבי המסך  לאחר שסיימת לחץ על כפתור 
 

 לצורך הגדרת השטחים:  ניגש עתה לחיבור נקודות
 Topographyימין יפתח חלון  .  מTopography -> Planes. הפעל מהתפריט הראשי: 3

Planes   . 
 

 החלון מחולק לשניים: חלק עליון וחלק תחתון.                                                                      
                      בפרויקטפיעה רשימת המשטחים הקיימים בחלק זה מו  -חלק תחתון   -               
מציג את  -חלק זה מציג את המשטח הנמצא כרגע בעבודה  -חלק עליון   -               
 רשימת  
 הנקודות שלו ופעולות שניתן לבצע על המשטח.                  

 
" , וזאת 1" -שם אוטומטית משטח חדש שלו ניתן ה תוכנהעם פתיחת החלון פותחת ה

 משטחים אחרים.  בפרויקטבהנחה שלא קיימים 
 
סמן הטקסט )וו מהבהב(   - a1 -אנו נשנה את שם המשטח הזה ל  -. שינוי שם משטח 4

"  1. מחק )ע"י מקשי המקלדת( את השם " Nameנמצא כרגע בראש החלון על יד הכיתוב: 
שם נקלט ברשימת המשטחים .  תוכל להבחין כי הEnter, בסיום הקש  a1וציין שם חדש, 
(Planes list)  .בחלק התחתון של המסך 
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 שטחים. הגדרת מ
 

 נראה כעת כיצד ניתן להגדיר משטחים בתוכנה.
 הערה: ההסבר מתבסס על הדוגמא שהובאה בתחילת הפרק. 

 
 אשר בתיבת המצבים שבחלון הימני:  Locate. לחץ על 1

            
)הנקודה הימנית התחתונה(   3עבור לאזור השרטוט. עמוד על נקודה מספר 

  4ובחר אותה על ידי לחיצה על כפתור העכבר. המשך ובחר את יתר הנקודות : 
(. לסגירת  5 -מתחת ל 6משמאלה,  5ימנית עליונה,  - 4)   5<---6<---

שבחלון מימין )משתמשי גרסת  המשטח לחץ על כפתור 
AutoCAD/ZWCAD  יכולים להכניסC ו- Enter בשורת הפקודות של ה- 
AutoCAD/ZWCAD .) 

 
 נמשיך ונגדיר משטחים אחרים: 

 :     New plane -שמשמאל למטה   לחץ על כפתור  הוספת משטח חדש:. 2

( בחלון מימין(. נמשיך     Planes listתוכל להבחין שנוסף משטח חדש לרשימת המשטחים 
 5ועבור אל אזור השרטוט. סמן את נקודה     Locateה. לחץ שוב על  ונגדיר גבולות משטח ז

לאחר מכן כנקודה הראשונה במשטח )הנקודה השמאלית ביותר במשטח הקודם שהגדרנו(.  

    -( ו  7  -)מימין ל  6<  ---(  7)מעל    8והמשך וסמן את נקודות המשטח:  ,  7נקודה  המשך ל
 .  5לנקודה  ( לחזרהAutoCAD/ZWCADבשורת הפקודות של  C)או 

. 7< --- 8< --- 10< --- 9< --- 7האופן באמצעות נקודות  באותו 2המשך והגדר משטח 

 . על גבי השרטוט יופיעו שמות המשטחים.   לאחר שסיימת להגדיר את המשטחים , לחץ
 

Unused 
Locate  
Pick     

Select   
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 הגדרת משטח עם רדיוסים

 
 ניתן להגדיר לכל משטח רדיוסים בשתי שיטות: 

כו בין שתי נקודות הקלד את ערך הרדיוס תחת  להגדרת רדיוס ע"י הכנסת ער 
 בשורת הנקודה השנייה מבין שתי הנקודות.  2Points+Rהכיתוב 

 

                
 

על התא הנמצא   Vלהגדרת רדיוס ע"י שלוש נקודות הנמצאות על הקו יש לסמן  
ע"י דאבל קליק על העכבר    3Pointsבשורת הנקודה האמצעית תחת הכיתוב 

 בשדה זה. 
 

   
 

 
 Topography planesפרוט פעולות נוספות האפשריות בחלון 

 
 : להלן הפעולות הנוספות האפשריות בחלון חישובי שטחים

  
 חלק עליון של החלון: פעולות האפשריות על המשטח הספציפי שבטיפול:

לחיצה על  -    כפתור  -מת הנקודות התחתונהיאיתור נקודות המשטח ברש .1
תחתונה את כל הנקודות שבמשטח הנוכחי. הכפתור תאתר בטבלה ה

 -נקודות אלו יסומנו כך שיהיה ניתן לבצע בהן שינויים בעזרת פעולות ה
Block   .השונות 

סמן את הנקודה  -מחיקת נקודה מרשימת הנקודות המגדירות את המשטח .2

 .. לקביעת השינוי לחץ הרצויה למחיקה ולחץ על כפתור  
 

 על כל המשטחים:חלק תחתון של החלון: פעולות 

-לחיצה על הכפתור תפתח את תיבת הדו -  -קריאת קבצי משטחים .1
שהנם קבצי  Tplוקבצי   Dplשיח קבצים. באפשרותך לבחור בין קבצי 

.  אופציה זו שימושית Lotוקבצי   CivilCAD 10משטחים שיוצרת תוכנת 
 להעברת קבצי משטחים מפרויקט לפרויקט. 

. את המשטח/משטחים הרצויים ולחץ על   סמן -מחיקת משטח/קבוצת משטחים .2
 לאחר אישור ההתראה ימחקו המשטחים. 
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על מנת לאתר משטח בשרטוט, סמן את   -  -איתור משטח בשרטוט .3
המשטח הרצוי ולחץ על הכפתור. המשטח המסומן יאותר וגבולותיו יצבעו  

 . Refreshבצהוב. להסרת הסימון לחץ 
 

 נוי תכונות התצוגה יש
להגדיר משטחים בתוכנה. נראה כעת כיצד ניתן לשנות את אופן הצגת   ראינו כיצד ניתן 

המשטחים על גבי השרטוט, זאת אומרת, בנוסף לשם המשטח, נציג בשרטוט את השטח 
 שלו, מרחקי הגבולות ועוד. 

 
 לצורך שליטה בתצוגה על גבי המשטחים בצע הפעולות הבאות:

ברצונך לשנות את התצוגה. לבחירת סמן את המשטחים שבהם  Planes list -. ברשימת ה1
 .Shift -או ב  Ctrl -מספר משטחים ניתן להשתמש ב

יופיע ובחלקו השמאלי    Options -שבחלון מימין. חלון ה   Options -. לחץ כל כפתור ה2
 .  Planesהתחתון תוכל להבחין באופציות השונות תחת הכיתוב 

 
 :Options-. נעבור על כל התכונות האפשריות בחלון ה3

לשינוי גודל הכיתוב של המשטחים )גודל שם המשטח,   -Scale -גודל הכיתוב .1
  Defaultהשטח הרשום עליו, וכן הלאה(, לחץ על החץ הקטן שמימין לכיתוב 

 . ברשימה שתפתח בחר בקנה המידה הרצוי. Scale -שבשדה ה
בקירוב, בחר  1:250: על מנת לבחור גודל כיתוב המתאים לקנה מידה של הערה
 וכן הלאה.  200, בחר 1:500. לקנה מידה של 100

אם ברצוננו לצבוע את השטח שסומן יהיה עלינו  -Fill color + Solid -צביעת שטח .2
. לאחר מכן ניתן לבחור את הצבע הרצוי למילוי המשטח על Solid -תחילה לסמנו כ

צבע בחר את התח שנפ. בחלון Fill colorידי לחיצה על ריבוע הצבע שליד הכיתוב 
 הרצוי. 

הצגת שם המשטח בשרטוט )האופציה מסומנת כברירת  -Names -שם המשטח .3
 מחדל(.

 הצגת שטח המשטח. -Area -שטח .4
 הצגת היקף המשטח.  -Perimeter  –היקף  .5
 הצגת מרחקי גבולות המשטח בהיקפו.  -Distances -מרחקי גבולות .6
שים לב  הצגת שמות נקודות הגבול של המשטח. -Names -שמות נקודות הגבול .7

יוצרת שכבה של נקודות הגבול כבר כחלק משכבת    CivilCAD 10שתוכנת 
הנקודות הקיימות. הצגת שמות הנקודות באופציה זו תיצור אותן בשכבת נתוני 

 המשטחים, וכיתוב הנקודות יהיה קריא יותר. 
 הצגת הגבהים של נקודות הגבול.  -Elevations -גבהי נקודות הגבול .8
 . Circled -ב נקודות הגבול של המשטח שרטוט עיגולים סבי .9

 נקודות הגבול על ידן.  קואורדינטותהצגת   -Border coordinates -קואורדינטות .10
 
ב4 סמן  התצוגה  תכונות  לשינוי   .-  V    ולחץ הרצויים,  השדות  ללא )  OKאת  החלון  לסגירת 

 וט. , הנתונים יוצגו על גבי השרטApply( ולאחר מכן לחץ Cancelשינוי התכונות לחץ 
 

 הצגת השטחים בטבלה מסכמת 
 עם סיום הגדרת השטחים, ניתן לרכזם בטבלה מסכמת.
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. מימין יפתח חלון  Earthworks -> Topo. Planesמסרגל התפריט הראשי הפעל:   .1
 ריכוז הנתונים בטבלה מסכמת.

 
 על מנת לקבל את דו"ח המשטחים.  Applyלחץ על כפתור  .2
 

. עם פתיחת Totalת המשטחים ובסופה המילה בחלקו העליון של החלון מופיעה רשימ
החלון, רשימה זו מסומנת כולה אוטומטית )נצבעת(. כאשר ניתנת הוראה להציג הטבלה 

(, תחושב ותוצג טבלה רק לגבי אותם המשטחים אשר הנם  Applyע"י לחיצה על  -)הדו"ח 
שטחים  מסומנים. אם יהיה ברצוננו לצמצם הטבלה, יהיה ניתן לסמן רק את אותם המ

מציינת האם להציג שורה מסכמת בסוף  Totalשוב. המילה  Applyהרצויים לנו וללחוץ על 
 הטבלה או לא. 

 

    -הצגת טבלת המשטחים על גבי השרטוט .3
  

כפתור זה מאפשר הוספת טבלת הכמויות על גבי השרטוט. לביצוע לחץ על הכפתור. עבור  
 לאזור השרטוט ובחר את מיקום הטבלה הרצוי: 

 
מקם את הטבלה ולחץ עם  AutoCAD/ZWCADמשי גרסת משת

העכבר. במקום המיועד תופיע מסגרת צהובה זמנית. אם ברצונך 
לשנות את מיקום הטבלה, בחר את המקום החדש ולחץ שוב עם  

"( Set” )אופציית “Sהעכבר. לאחר שנבחר המקום הרצוי, הזן " 
. הטבלה תיווצר  AutoCAD/ZWCAD -בשורת הפקודות של ה

 קום הנבחר.במ
 

 פעולות נוספות אפשריות בחלון:
                          

רק   מעונייניםיתכן מצב שבו נרצה טבלה מצומצמת שלא תכיל את כל הנתונים )לדוגמא: אנו 
ברשימת שמות המשטחים ושטחם(. לשם כך ניתן לצמצם הטבלה ע"י שליטה בפרמטרים  

 שיופיעו בה:                  
 

 -Areaעת עמודות שטחים בטבלה     הופ                       
Perimeter-               הופעת עמודות היקפים בטבלה                          

Full Report-  הופעת הרשימה המפורטת של הגדרת כל משטח ומשטח בדו"ח 
Scale -  כפי שיופיע ע"ג השרטוטקביעת גודל הכיתוב של הטבלה  



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  78עמוד 

 

 

 שובי נפחים בעזרת משטחים חי :7פרק 
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 חישובי נפחים בעזרת משטחים 
 

דרך   עפר.  עבודות  כמויות  לחישוב  דרכים  בשתי  דנים  אחריו,  הבא  והפרק  הנוכחי,  הפרק 
עפר,   עבודות  לחישובי  נידונהנוספת  הנה    שאינה  פרוט על   בשיטת החתכיםבפרקים אלו 

ע עבודות  "חישובי  בפרקים  מובאים   חתכים  באמצעות  וחישובים  בכבישים"  "תכנון   -פר 
 . בהתאמה  14  -ו 13פרקים  כבישים" 

 
ובפרק  זה  בפרק  המוצגות  החישוב  שיטות  שתי  בין  העקרוני  ההבדל  את  בקצרה  נסביר 

 שאחריו:
 

דרך זו מאפשרת חלוקת שטח העבודה למשטחים   -  משטחיםחישובי נפחים בעזרת   .1
ישתנו. בלימוד דרך  )ראה הגדרת משטח בהמשך( עפ"י תכנון ופירוט החלוקה לפי דר 

, כיצד מגדירים אותו ונלמד הגדרת שיפועים וחישוב קווי דיקור.  זו נראה מהו משטח 
  

דרך זו תבצע חישוב כמויות ע"י הלבשת פני     -  מודל מול מודל חישובי נפחים בשיטת   .2
 -קרקע מתוכננים )מצב מתוכנן יכול להיות כמובן גם מצב לאחר ביצוע( על פני קרקע  

 וחישוב הפרש כמויות בין שתי השכבות.מצב קיים,  
 

לצרכי  ככלל לרשת  הפרויקט  שטח  יחולק  בו  מפורט  דו"ח  המקרים  בשני  לקבל  ניתן  יהיה   ,
 חישוב נפחים ע"פ הגדרתנו, כאשר רשת הנפחים "תולבש" על גבי השרטוט. 
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 הכנת המצב הקיים 
ינטות, קווי אי רציפות  )קואורדעלינו להכין תוכנית מצב קיים )טופוגרפיה(    ,להתחלת העבודה

דוגמאות ושיטות שונות להכנת תוכנית מצב קיים תוכל למצוא בפרק "תכנון ייצור קווי גובה(  ו
 הכנת המצב הקיים".  -כבישים

 אנו נראה בפרק זה שיטות נוספות:
חלוקה  בעזרת  עפר  עבודות  לחשב  מנת  על  לבצע  שיש  המלא  הפעולות  בסדר  עתה  נדון 

יסקור  הפירוט  )מפתיחת    למשטחים.  הפעולות  סדר  כל  דו"ח   פרויקטאת  קבלת  ועד  חדש 
כמויות עפר( וייתכן ויחזור על מספר דברים אשר נדונו בפרקים אחרים. מומלץ לקרוא בעיון  

 הפעולות, הן למניעת טעויות והן כחזרה. תולבצע את כל סדר
        

לו    פרויקטנפתח    -  פרויקטפתיחת   .1 נקרא  ב   Testחדש אשר  יישמר  מחיצת ואשר 
 10 CivilCAD\    במחיצת )השמירה   בד"כ,   אינה   \CivilCAD 10עצמה  מומלצת 

רצוי לפתוח מחיצה נפרדת לכל   ונוחות,  . הפתיחה כאן היא פרויקטשכן למען סדר 
: פתח פרויקט חדשבסרגל התפריט הראשי    .לשם הפשטות  \ CivilCAD 10במחיצת  

File -> New project  ח קבצים בשם :   . לפנינו תופיע תיבת דו שיNew  project  
בתוך השורה הריקה הנמצאת משמאל לכיתוב "שם  (Test)  הפרויקטהקש את שם  
חדש. )נוכל ה פרויקטה. התוכנה תעביר אותנו לעבודה בסביבת Enterהקובץ", ולחץ 

לראות זאת ע"פ הכותרת הכחולה שתופיע בראש המסך ותכלול את הספרייה ושם 
 עובדים, לדוגמא: החדש עליו אנו  הפרויקט

 C:\Program Files\CivilCAD 10\Test) 
 
קובץ   .2 דרכים  עבור    –  קואורדינטותיצירת/יבוא  שתי  יפורטו  שלהלן  בדוגמא  קיים.  מצב 

 להכנת מצב קיים :
 . קואורדינטותהקלדת א. 
 הבאת קובץ חיצוני. ב. 

  בין שתי הדרכים(.   באופן מלא)הערה: ניתן לשלב 
 : קואורדינטותהקלדת  .א

את סמן הטקסט אל שורת עריכת הנקודות )השורה הריקה הנמצאת בדיוק מתחת    הבא
אם רשימת (   שבחלק התחתון של המסך   Topography Coordinatesלכיתוב הכחול:   

הראשי:    קואורדינטותה מהתפריט  בחירה  ע"י  להציגה  ניתן  מופיעה  -Topographyלא 
>Coordinateשורה יש להצביע עם העכבר על (. תזכורת: כדי להביא את סמן הטקסט ל

 הבאה:  קואורדינטותההשורה וללחוץ על כפתור העכבר פעם אחת(. הקלד את רשימת 
 

10.15 0 0 1 

11.3 0 100 2 

12 100 100 3 

11.5 100 0 4 

13.5 50 50 C1 

 
סדר את הנקודות בעמודות: לחץ על כפתור סידור בעמודות )הכפתור   

 תורים אשר בחלק התחתון של המסך(. עליון מבין קבוצת הכפ-השמאלי

 .רענן את השרטוט על ידי הכפתור   

 חיצוני:   קואורדינטותקריאת קובץ  .1
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קובץ זה   . עלASCIIחיצוני אשר ניתן בפורמט    קואורדינטותכאמור, ניתן לייבא קובץ  
. ,    txtעם סיומת    text,  קבצי     regלהיות קובץ טקסט פשוט )כגון: קבצים עם סיומת   

יהיה עלינו   אבל   ASCII. וכולי(. התוכנה יכולה לקרוא כל סוג קובץ  בפורמט   inpקבצי  
קיים   מצב  קבלת  )לצורך  עמו   לעבוד  שנוכל  כך   קריאתו,  לאחר  הקובץ  את  לערוך 

בקבצי    לטיפול  חזקים  עבודה  כלי  התוכנה מספקת  עמודות,     ASCIIוכולי(.  )צמצום 
לכל סוגי הקבצים בשוק. בפרק זה לא   הוספת תווים וכולי( וזאת כדי לאפשר התאמה

  מהפורמט:   ASCII  נדון באופציות אלה, רק נציין שלבסוף עלינו לעבוד עם קובץ  

 שם/מס' נקודה.        y x        גובה       

 הערה: הגובה אינו הכרחי. 
 

. כעת עליך Load from text fileשיח:  -לפניך תפתח תיבת דו  .לחץ על כפתור  
תוכנה על שם הקובץ שאותו ברצונך לייבא. בדוגמא שלפנינו תוכל לתרגל להורות ל

)  פרויקט מתוך    קואורדינטות קובץ   שלך  במחשב  קיים  אשר  דוגמא   פרויקטאחר 
ה עם  לספריית     (.תוכנהשהותקן  הקובץ    Samplesהכנס  את   Sampleובחר 

7.Tco . 
 

 ל: הקובץ נמצא במיקום ברירת המחד Windows 7/8/10במערכת הפעלה 
C:\ProgramData\SivanDesign\CivilCAD\Samples\Sample7\ 

 
 
כעת ניגש לבניית מצב קיים שישמש כרקע לעבודה. לצורך כך נבנה קווי     -בניית מצב קיים .3

 גובה מנקודות הטופוגרפיה שבידנו. בסרגל התפריט הראשי הפעל:

  Topography -> Contours 

לוחות  משטח  באזור  המסך,  של  הימני  הגובה.   העבודה,  בחלק  קווי  שרטוט  חלון  יופיע 
עם מינימום פעולות ועל כן כל שעליך   אופטימאליכאמור, אנו מתרגלים פה עבודה במצב  

 .. התוכנה תחשב ותשרטט קווי גובהApplyללחוץ   לעשות בכדי לשרטט קווי גובה הוא

 סיימנו את שלב הכנת מצב קיים! 
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 הגדרת משטחים מתוכננים     
המתוכננים.  לאחר המשטחים  להגדרת  נעבור  הקיים  המצב  הכנת    –ה  תוכנת    שלמדנו 

CivilCAD 10    של   קואורדינטותהרשימת    -  לכל פרויקט  קואורדינטותמאחסנת שתי רשימות
של   הנקודות  רשימת  מופיע  התחתון  בחלון  המתוכנן.  המצב  של  והרשימה  הקיים,  המצב 

בחירת   ידי  על  הקיים.  ניתן   Design      Coordinatesהמצב  הראשי  התפריט  מסרגל 
ברשימת   ולצפות  לחזור  בכדי  המתוכנן.  המצב  של  הנקודות  ברשימת  לצפייה  להעביר 

 . Topography         Coordinatesהנקודות של המצב הקיים נבחר 
 
(, והקלד את רשימת Design       Coordinatesהעבר לרשימת הנקודות המתוכננות ) .1

 הנקודות הבאה:

11.2 20 30 D1 

11.2 30.5 60 D2 

14.3 80 20 1 

14.3 70 70 2 

14.3 72.3 85 3 

14.3 27.5 80 4 

 

)כפתור שמאלי  על ידי כפתור העימוד  קואורדינטותהרווח את עמודות  .2
 עליון בקבוצת הכפתורים התחתונה(. 

 לרענון השרטוט.  לחץ על כפתור   .3
 

נגדיר מהו משטח. אנו מבחינים   רויקטהפלפני שנתחיל בהגדרת משטחי    -הגדרת משטחים
 בין שני סוגי משטחים: 

 משטח שהוגדר ע"י נקודות גבול. -
 משטח שהוגדר עפ"י קו בסיס ושיפוע.  -

 
יהיה צורה סגורה, כל שהיא, אשר פני הקרקע של המשטח  עפ"י נקודות גבול משטח שהוגדר

)זאת אומרת שאם בתוך    עפ"י נקודות אלה  ואך ורקיחושבו אך ורק  עפ"י נקודות הגבול שלה  
את  ותבנה  אלה  מנקודות  התוכנה  תתעלם  הצורה  הגדרת  לאחר  נוספות,  נקודות  הצורה 

 המשטח רק עפ"י נקודות הגבול שלו(.
 

נגדיר ע"י ציון שתי הנקודות המהוות את בסיס השיפוע, ואת    קו בסיס ושיפועמשטח שהוא  
בנה באופן אוטומטי עד קו הדיקור עם  וכולי( לחפירה ומילוי. המשטח י 1:3,  1:2יחס השיפוע )

 הקרקע. 
נפרדים לכל   קו בסיס ושיפוע בדוגמה שלנו ניישם שימוש בשתי השיטות, אך במקום להגדיר  

"שיפוע מתמשך" לכל האזורים בפעם אחת )הדברים   לנו  ניתן הוראה לתוכנה לבנות  אזור, 
 יהיו ברורים בהמשך(.

 
. בצדו הימני של המסך יופיע חלון  Planes  Design    מסרגל התפריט הראשי הפעל:   .4

משטחים מתוכננים. מכיוון שעדיין לא הוגדרו משטחים קודמים, התוכנה פתחה לנו באופן  
משטח זה יופיע ברשימת המשטחים )ראה "  1" אוטומטי משטח חדש ונתנה לו את השם:  
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planes list  בחלקו ( שבחלקו התחתון של חלון המשטחים המתוכננים, והגדרתו תופיע
 (. נמשיך אם כן, בהגדרת המשטח.Nameהעליון של חלון זה )ראה: שם המשטח 

 
5. ( ראשון  משטח  העכבר  1הגדרת  בעזרת  שלנו(:  העבודה   -בדוגמא  מצב  את  העבר 

המשטחים  בחלון   הנמצאת  מצבים  שלושה  בעלת  )רשימה  המצבים   שברשימת 
ממצב   ה  locateלמצב    unusedהמתוכננים(  עם  הצבעה  ע"י  על וזאת  עכבר 

.  1שברשימה. עבור עם העכבר לאזור השרטוט ובחר את נקודה מספר      locateהמילה
 .  D2 ,D1, 2המשך ובחר את הנקודות הבאות על פי הסדר: 

 

כפתור  על  לחץ  הנקודות  בחירת  גרסת   בסיום  )למשתמשי  הימני  שבחלון 
AutoCAD/ZWCAD " להזין  ניתן   :C  "–  Closed  ה של  הפקודות    -בשורת 
AutoCAD/ZWCAD.התוכנה תסגור את המשטח לנקודה הראשונה שנבחרה .) 

 

.  חץ על כפתור  לעל מנת להגדיר את המשטח השני    -  פתיחת משטח חדש והגדרתו .6
המשטחים החדש     (planes list)רשימת  המשטח  בחלק  2  –יתווסף  תופיע  והגדרתו   ,

  4, 3, 2הנקודות:  העליון של חלון המשטחים המתוכננים. הגדר את המשטח החדש עפ"י  
 . D2 -ו

השרטוט .7 את  הכפתור    -רענן  על  שמות לחץ  יופיעו  גביו  ועל  יחודש  השרטוט   .
 המשטחים.

 

צענו אותה בכדי יבדוגמא שלנו ב  -הערה: פעולה של רענון אינה מחויבת לביצוע בשלב זה  

אשר למעשה "מארגן" לנו את השרטוט ומחדש      -לחזור ולהדגיש את חשיבות כפתור ה  
 תו.או
 

ולפיכך   אנכית. בפרק  יבנו  הם ילמשטחים שהוגדרו בפרק זה לא הוגדרו שיפועים בשוליים, 
 משטחים אשר ימשיכו את השוליים עד לקו הדיקור. הבא נראה כיצד להגדיר 

 

 Designed planesפרוט פעולות נוספות האפשריות בחלון 
 

 להלן פעולות נוספות אפשריות בחלון תכנון משטחים: 
  

 יון של החלון: מאפשר  פעולות על המשטח הספציפי שבטיפול:חלק על

התחתונה .1 המתוכננות  הנקודות  ברשימת  המשטח  נקודות  . כפתור    -  איתור 
לחיצה על הכפתור תאתר בטבלה התחתונה את כל הנקודות המתוכננות שבמשטח 

לערוך    הנוכחי ניתן  שיהיה  כך  יסומנו  אלו  הענקודות  פעולות  בעזרת  שינויים   -ליהן 
Block .השונות 

המשטח .2 את  המגדירות  הנקודות  מרשימת  נקודה  הנקודה    -מחיקת  את  סמן 

 .על כפתור המחק. לקביעת השינוי לחץ   למחיקה ולחץ הרצויה
 
 

 חלק תחתון של החלון מאפשר פעולות על כל המשטחים:

שיח קבצים. -לחיצה על הכפתור תפתח את תיבת הדו  -    -קריאת קבצי משטחים .1
קבצי  באפשרותך   בין  תוכנת   Tplוקבצי    Dplלבחור  שיוצרת  משטחים  קבצי  שהנם 

CivilCAD 10    וקבציLot  אופציה זו שימושית מאד על מנת להעביר קבצי משטחים .
רקע  גבי  על  ולהלבישם  מסוים,  בפרויקט  מסוים  מדידה  רקע  גבי  על  תוכננו  אשר 

קרוא מהפרויקט  שיש ל  Dpl  -מדידה חדש בפרויקט אחר. יש לציין שבנוסף לקובץ ה
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 -(, לתוך חלון הDco.האחר, יש לקרוא גם את קובץ רשימת הנקודות המתוכננות )
Designed coordinates   .שלמטה 

. סמן את המשטח/משטחים הרצויים ולחץ על    -מחיקת משטח/קבוצת משטחים .2
 לאחר אישור ההתראה ימחקו המשטחים. 

סמן את המשטח הרצוי על מנת לאתר משטח בשרטוט,   -איתור משטח בשרטוט .3
הסימון   להסרת  בצהוב.  יצבעו  וגבולותיו  יאותר  המסומן  הכפתור. המשטח  על  ולחץ 

 .לחץ 
מחדש  .4 המשטחים  חומה   -בנית  של  ציור  עם  כפתור  שקבוצת   -  באמצעות  יתכן 

נקודות   של  גובהן  שינוי  ידי  על  משטחים,  של  קבוצה  הוגבהו  או  הונמכו  משטחים 

במקרה   אותן.  היצורות  על  הגבול  לחיצה  לאחר  באופן  כזה,  התוכנה  תשנה   ,
אוטומטי את גובה המשטחים על פי גובה הנקודות ששונו. אם זאת, במקרה ובו יצרנו  

הוגדרו כקו בסיס ושיפוע, יהיה על התוכנה לחשב את קווי הדיקור של  ר  שאמשטחים  
משטחים אלו מחדש. פעולה זו אינה מתבצעת באופן אוטומטי )זאת אומרת, לאחר 

ביצוע ל  ע(. לביצוע הפעולה לחץ על כפתור הנוכחי. התוכנה תתריע  לחיצה על  
בנו כל המשטחים מחדש, ביניהם השיפועים בהתאם לקווי  י פעולה. לאחר האישור י ה

 הדיקור החדשים. 

בחר את שכבת .     לביצוע הפעולה לחץ על כפתור  -בנית משטחים מתוך שרטוט   .5
ע"י   על    Selectהמגרשים  את ’Apply‘ולחץ  ותוסיף  את השרטוט  התוכנה תסרוק   .

 .'Planes list'המגרשים לרשימת 

המגרשים   שמות  את  גם  לסרוק  וברצונך  כפתור    -במידה  על  את ,    לחץ  בחר 

כפתור    שכבת על  ולחץ  כפתור  Enterהמגרשים  על  לחץ  יש  מכן  לאחר   . 
Options “ וסמןv  ” 

 scan from layer םהמגרשי . בחר את שכבת שמותScan planes names–ב 

 .  Apply  -ו  OK, לחץ על כפתור    

 התוכנה תסרוק בנוסף למגרשים גם את שמותיהם בהתאמה. 

 ץלח  ,  בקלות  קואורדינטותלמצוא את נתוני המגרש ברשימת ה  כדי  -  מציאת מגרש  .6

)מתחת לרשימת המגרשים בצד ימין(, הזן את שם המגרש ולחץ   Findעל כפתור 
OK.  ש גם ע"י בחירה באופציה  ניתן למצוא מגרFind     ולגעת עם העכבר בתוך תחום

 המגרש. המגרש יסומן בכחול ברשימת המגרשים.

המגרש   .7 שם  ע"פ  המגרשים  רשימת  כפתור    ץ לח   -מיון  )מתחת     Sortעל 
ימין(,   בצד  המגרשים  שייפתחלרשימת  ברשימת .OKלחץ    ובחלון  המגרשים 

ת זו  אופציה  שמותיהם.  ע"פ  יסודרו  בדו"ח המגרשים  המגרשים  סדר  על  גם  שפיע 
 הכמויות. 

סמן את המגרש מתוך רשימת המגרשים   –  סידור רשימת המגרשים בצורה ידנית .8
ולחץ   על החץ   Order Planes List  כפתורבשברצונך להעלות או להוריד ברשימה 

 בהתאמה. 

Order Planes List    = 
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 הגדרת השיפועים 
פי הגדרת קו בסיס ושיפוע. משטחים אלו יכולים  ה נראה כיצד מגדירים משטחים על  בפרק ז

לשמש, כאשר מצמידים אותם למשטחים שהוגדרו על פי נקודות גבול, כשיפועים לסגירה עד  
 דיקור. 

 "הגדרת משטחים מתוכננים". -ההסבר בפרק זה מסתמך על הדוגמה שנבנתה בפרק הקודם

( הקודם  בפרק  שהגדרנו  המשטחים  בקצות  השיפועים  סימון  (  2  -ו  1את  ידי  על  נגדיר   ,
 הנקודות המגדירות משטחים אלו בתוספת יחס השיפוע בחפירה ובמילוי: 

לפניך יפתח תת חלון   הימניהכפתור שבחלון    -  לחץ על כפתור השיפוע המתמשך )רציף(  
 . (Continuous slope)"שיפוע מתמשך" המאפשר הגדרת השיפוע המתמשך 

בפעולת   גרסת    , Locateבחר  בשורת  -  AutoCAD/ZWCAD)למשתמשי  הפקודות    הקלד 
, סמן את הנקודות המגדירות את השיפוע עפ"י    ('AutoCAD/ZWCAD  'P + Enter  -של ה

 הסדר הבא : 
1 ,2 ,3  ,4 ,D2 ,D1  1-וסגור ל . 

גרסת   של   -  AutoCAD/ZWCAD)למשתמשי  הפקודות  בשורת  הקלד  לסיום 
AutoCAD/ZWCAD  'S + Enter' .) 

 :הבא את סמן הטקסט לשדה שליד הכיתוב -לחפירה ולמילויהקלד את יחס השיפוע 
  "Sl .   Cut  1 :" לצורך הדוגמה(. לחץ   3", והכנס את היחס לחפירה )הכנס "Enter  -    סמן

 . 2". הקלד : Sl.  Fill  1הטקסט יעבור לתיבה מימין להגדרת יחס המילוי:  " 
    .'OK'כפתור על לחץ 

 

 שינוי תכונות המשטחים

(, מופיע שמו של כל  ם משטחים מתוכננים ומרעננים את השרטוט )כפתור  יירלאחר שמגד
להוסיף נתונים שונים ורבים, מלבד    CivilCAD 10משטח על גבי השרטוט. באפשרות תוכנת  
ש מילוי,  נפח  חפירה,  נפח  כגון  של השם,  הכרטסת  באפשרויות  ידון  זה  פרק  וכולי.  טח 
 המשטחים המתוכננים, לשינוי תכונותיהם. 

 
בעזרת  נפחים  "חישובי  הפרק  במהלך  שהוצגה  הדוגמה  על  מסתמך  זה  בפרק  ההסבר 

  משטחים".
 
, אשר ברצונך לשנות את  (planes list)סמן את המשטחים בתוך הרשימה שבחלון הימני   .1

את   לגלגל  הרצוי,  הראשון  את  לסמן  תוכל  משטחים  של  קבוצה  לסימון  תכונותיהם. 
 לחוץ, ולסמנו. Shiftלהחזיק את מקש הרשימה עד למשטח האחרון הרצוי, 

חלון האפשרויות יפתח ובחלקו התחתון השמאלי )תחת בכיתוב   הכנס לחץ על כפתור   .2
Planes יופיעו אפשרויות המשטחים. כל שינוי בחלון זה ישפיע על כל המשטחים שסומנו )

 ".planes listברשימה " 
 . נעבור על כל התכונות האפשריות בכרטסת:3

הכית .1 המשטח,    -  Scale  -ובגודל  שם  )גודל  המשטחים  של  הכיתוב  גודל  לשינוי 
לכיתוב   שמימין  הקטן  החץ  על  לחץ  הלאה(,  וכן  עליו,  הרשומות    Defaultהכמויות 

 . ברשימה שתפתח בחר בגודל הרצוי. Scale -שבשדה ה

גודל כיתוב המתאים לקנה מידה של   בקירוב, בחר   1:250הערה: על מנת לבחור 
 וכן הלאה.  200, בחר 1:500ה של . לקנה מיד100
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אם ברצוננו לצבוע את השטח שסומן יהיה עלינו   -Fill color + Solid  -צביעת שטח .2
. לאחר מכן ניתן לבחור את הצבע הרצוי למילוי המשטח על Solid  -תחילה לסמנו כ

. בחלון שפיתח בחר את הצבע Fill colorידי לחיצה על ריבוע הצבע שליד הכיתוב  
 הרצוי. 

הצגת נפח החפירה של המשטח. בכדי שהתוכנה תוכל   -Cut volume  -ח חפירהנפ .3
להיות  חייבות  שלו  הגבול  נקודות  כל  מסוים,  משטח  של  החפירה  נפח  את  לחשב 
הגדרת  מעצם  קיים  זה  תנאי  ושיפוע,  בסיס  קו  שהינו  )במשטח  גובה  בעלות 

 המשטח(. 
 הצגת נפח המילוי של המשטח.  –  Fill volume -נפח מילוי .4
 הצגת שטח המשטח. -Area -טחש .5
 הצגת היקף המשטח.  -Perimeter  –היקף  .6
 הצגת מרחקי גבולות המשטח בהיקפו.  -Distances -מרחקי גבולות .7
שרטוט קווי גובה למשטח המתוכנן. ההפרש בין קווי    -Show contours  -קווי גובה .8

 . Designed contours -שבחלון ה Intervals -הגובה יהיה כפי המוזן בשדה ה
נקודות הגבול .9 נקודות הגבול של המשטח. שים לב   -Names  -שמות  הצגת שמות 

יוצרת שכבה של נקודות הגבול כבר כחלק משכבת הנקודות  CivilCAD 10שתוכנת 
המתוכננות. הצגת שמות הנקודות באופציה זו תיצור אותן בשכבת נתוני המשטחים,  

 ותמקם את כיתוב הנקודות באופן קריא ונח יותר. 
 הצגת הגבהים המתוכננים של נקודות הגבול. -Elevations -יי נקודות הגבולגבה .10
 . Circled -שרטוט עיגולים סביב נקודות הגבול של המשטח  .11
נקודות הגבול .12 קיים של  הצגת הגבהים הקיימים     -Topo. Elevations  -גבהי מצב 

 של נקודות הגבול. הגבהים יחושבו באינטרפולציה מתוך קווי הגובה. 
ג .13 למתוכנן    -Height intervals  -ובההפרש  הקיים  המצב  בין  הגובה  הפרש  הצגת 

 בנקודות הגבול.
 נקודות הגבול על ידן.  קואורדינטותהצגת   -Coor_borders -קואורדינטות .14
הכיתוב .15 אחת    -Location  -מיקום  הגבול.  נקודות  ליד  הכיתובים  מיקום  בחירת 

נקודות הגבול על גבי השרטוט    מהבעיות העיקריות שנוצרות כאשר מציגים את נתוני
לעיתים  אינפורמציה.  עודף  הנה  וכולי(,  קיים  גובה  מתוכנן,  גובה  גבהים,  )הפרש 

ת לשני משטחים או יותר, כאשר בכל משטח קרובות, מכיוון שנקודת גבול אחת שייכ
עולים הכיתובים אחד על גבי  )ובוואדי הפרש גבהים שונה(,  גובה שונה  זו  לנקודה 

 ת לפתור בעיה זו ניתן להגדיר מיקום שונה לכיתוב הנתונים:השני. על מנ
 Top- .כיתוב הגבהים מעל הנקודה עצמה 
 Inside-  .כיתוב הגבהים בתוך המשטח אליו שייכים הנתונים 

ב נבחר  )  Inside  -אם  כיתוב  גודל  ונבחר  צמודים,  גדול  Scaleלמשטחים  שאינו   )
 ב לא יעלה אחד על גבי השני. מידי, יוכנסו הנתונים לתוך המשטחים כך שהכיתו

בחלון     Applyולאחר מכן    OKלאחר שבחרת את התכונות הרצויות למשטחים, לחץ   .16
 הימני. התוכנה תציג את הנתונים על גבי השרטוט במקומות הרלוונטיים.  

 
 

 יצירת שיפוע דו כיווני למגרש 
 

 . ’Design→Planes‘מהתפריט הראשי הפעל:  .1
 תכנן מגרש כרצונך.    .2

 .  ’Add height to current plane‘כפתור לחץ על  .3
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 , תתבקש לבחור את המגרש.AutoCAD/ZWCADשל   ’Command‘ –בשורת ה  .4
 גע עם הכפתור השמאלי של העכבר במרכז המגרש. המגרש יסומן בצהוב. .5
והקש   ’Slope‘עבור    ’S‘הקש    AutoCAD/ZWCAD,של    ’Command‘  –בשורת ה   .6

 .’Enter‘על כפתור 
 תתבקש לבחור צד.  AutoCAD/ZWCAD,של   ’Command‘ –בשורת ה  .7
לקו  .8 )קרוב  השיפוע  יתחיל  שממנו  בצד  העכבר  של  השמאלי  הכפתור  עם  גע 

 בשרטוט, בתוך תחום המגרש(.
ה   .9 נקודת   AutoCAD/ZWCAD,של    ’Command‘  –בשורת  את  להזין  תתבקש 

 הגובה הראשונה. 
 (. הזן את הגובה עבור הנקודה הראשונה של הצלע )בכיוון השעון .10
ה   .11 נקודת   AutoCAD/ZWCAD,של    ’Command‘  –בשורת  את  להזין  תתבקש 

 הגובה השניה. 
 הזן את הגובה עבור הנקודה השניה של הצלע )בכיוון השעון(.   .12
ה   .13 אחוז   AutoCAD/ZWCAD,של    ’Command‘  –בשורת  את  להזין  תתבקש 

 וע יורד(.השיפוע )עבור נתון חיובי יחושב שיפוע עולה ועבור נתון שלילי יחושב שיפ
 . ’Enter‘הזן את אחוז השיפוע הרצוי והקש על כפתור  .14
התוכנה תעדכן את כל הגבהים של המגרש, כולל הגבהים של הצלע )חשוב למקרה  .15

 שלא הוזנו עדיין גבהים שלהם או רוצים לשנות אותם(.
כפתור   .16 על  הגבהים   ’Apply‘לחץ  ע"פ  המגרש  של  ממדי  תלת  מודל  לבניית 

 המחושבים.
 

 ודות הגבהים יחושבו בניצב לקו שנבחר לתחילת השיפוע. נק :הערה 
 

 

 תכנון מגרש עם רדיוס 
 

 . ’Design→Planes‘מהתפריט הראשי הפעל:  .1
 . ’Enter‘של המגרש ולחץ על כפתור  Polyline –בחר את ה  .2
 ייפתח.  ’Arc Segmentation‘חלון  .3
ולחץ .4 פיו תחולק הקשת למקטעים  על   הגדר את האורך הרצוי )במטרים( אשר על 

 . ’OK‘כפתור 
 

 
 

 של המגרש למקטעים. Polyline –התוכנה תחלק את ה  .5
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 נקודות  3הגדרת גבהי המגרש ע"פ  

 
 . ’Design→Planes‘מהתפריט הראשי הפעל:  .1
 לבניית מודל תלת ממדי של המגרש. ’Apply‘תכנן מגרש ולחץ על כפתור  .2

 .  ’Add height to current plane‘לחץ על כפתור  .3
 , תתבקש לבחור את המגרש.AutoCAD/ZWCADשל   ’Command‘ –בשורת ה  .4
 גע עם הכפתור השמאלי של העכבר במרכז המגרש. המגרש יסומן בצהוב. .5
 Calculate‘עבור    ’C‘הקש    AutoCAD/ZWCAD,של    ’Command‘  –בשורת ה   .6

Heights By 3 Points’   והקש על כפתור‘Enter’ . 
ה   .7 הנקודה  ת  AutoCAD/ZWCAD,של    ’Command‘  –בשורת  את  לסמן  תבקש 

 הראשונה. 
 גע עם הכפתור השמאלי של העכבר באחד מקודקודי הצלעות של המגרש.  .8
ה   .9 הנקודה    AutoCAD/ZWCAD,של    ’Command‘  –בשורת  את  לסמן  תתבקש 

 השניה. 
 גע שוב עם הכפתור השמאלי של העכבר באחד מקודקודי הצלעות של המגרש. .10
ה   .11 הנקודה    AutoCAD/ZWCAD,של    ’Command‘  –בשורת  את  לסמן  תתבקש 

 השלישית. 
 גע שוב עם הכפתור השמאלי של העכבר באחד מקודקודי הצלעות של המגרש. .12
 הנקודות שנבחרו.  3התוכנה תעדכן את כל הגבהים של קודקודי המגרש, ע"פ  .13
 לבניית המודל התלת ממדי.  ’Apply’לחץ על כפתור .14

 
 

 קבלת טבלה מסכמת  
 

בעזרת נפחים  "חישובי  הפרק  משטחים    במהלך  הוגדרו  שבו  האופן  הוסבר  משטחים", 
מתוכננים. כשלב סופי של תהליך הגדרת המשטחים, נרצה בקבלת טבלה מסכמת של נפחי  

 הכמויות לחפירה ומילוי. 
 

הפרק  במהלך  שהוצגה  הדוגמא  על  להתבסס  ניתן  זה  בפרק  ההסבר  את  ליישם  מנת  על 
 "חישובי נפחים בעזרת משטחים".  

 
 .  Earthworks  -> Designed planes      הראשי הפעל:. מסרגל התפריט 15
 . Designed Planes Earthworkבצדו הימני של המסך יפתח חלון:        
 
. לפניך יופיע דו"ח מסכם עבודות Apply, ולחץ  Full reportאת האופציה     )”V. סמן בוי )" 16

גדרו בפרויקט, כולל  עפר. הדו"ח יכלול טבלה מסכמת הכוללת את רשימת כל המשטחים שהו
שיפועים, כאשר לכל משטח ומשטח יופיע נפח חפירה, נפח מילוי, שטח חפירה, שטח מילוי,  

לפניך   -שטח כולל והיקף. עיין בדו"ח )גלגל הדו"ח כלפי מטה ע"י החצים הצמודים לו מימין(  
 המגדירות אותו.  קואורדינטותהיופיע פירוט לגבי כל משטח ומשטח לגבי 

מציג דו"ח מלא הכולל פרוט של נתוני המשטחים מלבד הטבלה    Full reportן  הערה: סימו
 המסכמת. 
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. הדפס את הדו"ח בעזרת כפתור המדפסת שנמצא בתחתיתו. בחלון המדפסת שיפתח 17
 הגדרת את הפרמטרים הרצויים ולחץ להמשך.

 
 נעבור על האופציות השונות הקיימות בחלון: 

כל  -רשימת המשטחים .1 יופיע  בתוספת   ברשימה  המשטחים המתוכננים שבפרויקט 
כולל Totalהשורה   הנ"ל  המשטחים  כל  אוטומטי  באופן  יסומנו  החלון,  בהיפתח   .

Total  ילחץ כאשר   .Apply    המשטחים לכל  הנתונים  יחושבו  הדו"ח,  לקבלת 
הרצויים  אלו  את  סמן  מהמשטחים,  חלק  רק  בדו"ח  להציג  ברצונך  אם  המסומנים. 

המלה   בטבלה מסמ  Totalלהצגה.  תוצג  שיבחרו,  המשטחים  לנתוני  שבנוסף  נת 
 המסכמת גם שורת סה"כ. 

גובה .2 ומהיר של עבודות   -dH  -הפרש  נוח  שדה הפרש הגובה מאפשר קבלת איזון 
גובה עבודות העפר, אילו היינו משנים  ניתן לדעת מה היה  זה  עפר. בעזרת שדה 

בשד הכנס  מסוים.  בהפרש  המתוכננים  המשטחים  כל  של  גובהם  את את  זה  ה 
. הדו"ח החדש שיופיע יהיה על בסיס הגובה Applyההפרש הרצוי, במטרים, ולחץ  

בקלות  ניתן  זאת  בצורה  המוכנס.  הגובה  הפרש  בתוספת  המקורי  המתוכנן 
ובמהירות, לקבל הערכות כמויות לגבהים שונים, ולאחר שקיבלנו את הגובה הרצוי,  

 שטחים כרצוי. נחזור ונשנה בצורה פיזית את הגובה המתוכנן במ
 הערה: להנמכת הגובה הכנס הפרש גובה שלילי.

 קביעת הנתונים הרצויים בדו"ח: .3
 Cut vol- .נפח החפירה במשטחים 
 Fill vol-  .נפח המילוי במשטחים 
 Area-  .שטח המשטחים 
 Cut area- .שטח החפירה במשטחים 
 Fill area-   שטח המילוי

 במשטחים.
 Perimeter- .קבלת היקף המשטחים 

4. Full report-  .)קבלת דו"ח מפורט של המשטחים )בנוסף לטבלה המסכמת 
5. Scale-   גבי גודל הכיתוב של טבלת הכמויות, למצב שבו מוסיפים את הטבלה על 

 "הוספת הטבלה על גבי השרטוט"(. -השרטוט )ראה כפתור
את    -Caption  -כותרת .6 מחק  בדו"ח,  הכותרת  לשינוי  המתקבל.  הדו"ח  כותרת 

 "( המופע  הערה: Planes earthworksהכותרת  החדשה.  הכותרת  את  והכנס   )"
 אופציה זו קיימת רק לגבי דוחות באנגלית.

השרטוט .7 גבי  על  הטבלה  טבלת   -הוספת  הוספת  מאפשר  זה  כפתור   .
הכמויות על גבי השרטוט. לביצוע לחץ על הכפתור. עבור לאזור השרטוט ובחר 

 את המיקום הרצוי של הטבלה:
ולחץ עם העכבר.    AutoCAD/ZWCAD  -משתמשי גרסת מקם את הטבלה 

במקום המיועד תופיע מסגרת צהובה זמנית. אם ברצונך לשנות את מיקום 
שנבחר  לאחר  העכבר.  עם  שוב  ולחץ  החדש  המקום  את  בחר  הטבלה, 

 " הזן  הרצוי,  “Sהמקום  )אופציית   ”Setה של  הפקודות  בשורת   )"- 
AutoCAD/ZWCAD .הטבלה תיווצר במקום הנבחר . 

 

 חבה: גבהים מתוכננים במשטחים  הר
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במהלך הפרק, בחלק "הגדרת משטחים מתוכננים", ראינו כיצד להגדיר משטחים מתוכננים 
של הנקודה,   מהקואורדינאטהבתוכנה. את הגדרת הגבהים לנקודות המשטחים הזנו כחלק  

 "( המתוכננות  הנקודות  ברשימת  אומרת  פעם  Designed coordinatesזאת  בכל   .)"

תוכנת  ם  שלוחצי עוברת   ,CivilCAD 10   את ומעדכנת  המתוכננים,  המשטחים  כל  על 
ה התחתונה. זאת אומרת, שאם ברצוננו לשנות גובה  גובה נקודות המשטחים בהתאם לרשימ

ונלחץ   הנקודות  ברשימת  זה  גובה  נשנה  מתוכנן,  משטח  יוכנס של  בגובה  השינוי   .
 planes“  -ביע על משטח ברשימת ה אוטומטית לתוך הגדרת הנקודה במשטח, כך שאם נצ 

list  של שהגובה  לראות  נוכל  המשטחים,  חלון  של  העליון  בחלק  אותו  לראות  מנת  על   ”
 הנקודה עודכן.  

 הגדרת גובה לנקודה יכול להתבצע בשני האופנים הבאים:
כחלק   .1 שהודגם,  כפי  הגובה,  הנקודה    מהקואורדינאטההזנת  הנקודות  ת  ימ ברששל 

 המתוכננות. 

 לחץ על כפתור  ה לנקודה במשטח עצמו. להגדרת גובה במשטח עצמו הזנת גוב .2
הקלד את הגובה . המבוקש על גבי השרטוטהמשטח  בתוך תחום ולחץ עם העכבר

   .  Applyולאחר מכן  Enter, לחץ  הרצוי 
 

אם לנקודה קיים גובה ברשימת הנקודות המתוכננות נציין את הכלל החשוב הבא: 
(Designed coordinates-  אז גובה זה הוא "הקובע", זאת אומרת ,)הרשימה התחתונה

יחזור    -שגם אם תשנה את הגובה הנ"ל בהגדרת הנקודה במשטח, לאחר לחיצה על ה
את הגובה שהוכנס. על מנת להכניס לנקודה גובה  וימחקהגובה שברשימה התחתונה 

ה את הגובה )זאת אומרת בהגדרתה במשטח עצמו(, נהיה חייבים למחוק תחיל 2בשיטה 
, ורק לאחר מכן לשנותו בתוך המשטח Designed coordinates -של הנקודה ברשימת ה

 עצמו. 
 

שורת הפקודות של ב  S + Enterהקש  ו על כפתור   ץלהזין שיפוע למגרש לח כדי
AutoCAD/ZWCAD צד שממנו יתחיל השיפוע ע"י הקלקה קרוב לקו  את ה בחר. לאחר מכן

שיפוע   ןמתחיל השיפוע , הז עבור הפאה שממנהמגרש פינה של ה כלגובה ל ןבשרטוט , הז
 בפינות המגרש יתקבלו –  Enter  לחץרצוי באחוזים )ניתן להזין שיפוע חיובי או שלילי( ו

 גבהים בהתאם לשיפוע.
 נקודות הגבהים יחושבו בניצב לקו שנבחר לתחילת השיפוע. 
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  חישובי מודל מול מודל  :8פרק 
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 טת מודל מול מודל חישובי נפחים בשי 
 

בפרק הקודם דנו בחישובי נפחים עפ"י חלוקה למשטחים. שיטה זו של חישובי כמויות  
ישורי שטח, חלוקה לפרצלציות וכדומה.  אופיינית לשטח אשר ביצעו בו פיתוח אחיד כגון י 

שבו ביצעו עבודות. יתרונה של שיטה זו  בכל שטחחלק זה של הפרק דן בחישובי כמויות 
לכל סוגי השטח. חסרונה לעומת השיטה הראשונה הוא ביכולת השליטה בהתאמתה 

 ובנוחות ההפעלה לגבי אותם שטחים אשר צוינו )פרצלציות וכד'(. 
 

את צורת החישוב בפרק נסביר בעזרת דוגמא. בדוגמא שלפניך ניגע בקצרה בסדר הפעולות  
 ות. שלבי החישוב יהיו: רגיל ונדון בהרחבה בנושאים הקשורים לחישוב כמוי  לפרויקטהבסיסי 

 
 חדש.  פרויקטפתיחת  
ביצוע   לפניכמצב קיים נגדיר את מצב השטח  -קליטת נתוני המצב הקיים   

 העבודה בו. 
 חישוב קווי גובה מצב קיים.  
 כמצב מתוכנן נגדיר את מצב השטח לאחר ביצוע. -קליטת נתוני מצב מתוכנן  
 לחישוב.עיבוד הנתונים והגדרת האזור לחישוב/אזורים שאינם   
 חישוב קווי גובה מצב מתוכנן. 
 הוצאת דו"ח ופירוט כמויות עבודות העפר.  

 
 
 

 הכנת מודל )קווי גובה( של המצב הקיים 
 

הכנת קווי הגובה של המצב לצורך חישובי כמויות תהיה זהה להכנת קווי הגובה המתוארת  
 (. נעבור בקצרה על השלבים:4בפרק "יצירת קווי הגבוה" )פרק 

 
 יקט חדש. פתח פרו  .1
הבאה לטבלת הנקודות שבחלון התחתון  קואורדינטותההזן את רשימת  .2
 "Topography coordinates:" 
 

         11             0         0        1 
       12.5        100         0          2    
       13.2            100     100            3         
        10             0     100          4 
     15.7            50            50          5   
     14.8     37.25        25          6 
     11.5         10        10          7 
     11.7         10          80          8 
     11.9      90.5        11              9 
 

ביצוע עבודות. בסיום הקלדת  לפניאלה יהוו מצב קיים, כלומר מצב השטח  קואורדינטות

 על מנת להציגה על גבי השרטוט.  הרשימה לחץ 
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הערה: הדוגמה המתורגלת כאן הנה של הקלדת נתונים ידנית. לקריאת נתוני המדידה  

וי  ולבחור את הקובץ הרצוי )ראה דוגמה בפרק "יצירת קו מקובץ ניתן ללחוץ על כפתור 
 הגובה"(. 

 
 . חישוב קווי הגובה:  3

. מימין יפתח חלון:  Topography -> Contoursמסרגל התפריט הראשי הפעל: 
Topography Contours  . 

לחישוב קווי הגובה. כיוון שלא הוגדרו המרווחים בין קווי הגובה, יבחרו   Applyלחץ על כפתור 
 ת המרווחים ראה פרק קווי הגובה(. מ' )להגדר 1 -המרווחים באופן אוטומטי ויקבעו  ל

 
בשלב זה, הוכן המודל התלת ממדי שעל בסיסו יבוצע חישוב הנפחים. מודל זה יחושב 

באינטרפולציה של משולשים. ניתן לראות את גובהי האינטרפולציה על ידי הבאת העכבר 
  AutoCAD/ZWCADלאזור השרטוט ולחיצה על הכפתור השמאלי בעכבר )משתמשי גרסת 

הנמצא בסרגל הכלים הראשי  Pick height יו צריכים תחילה לסמן ללחוץ על כפתור  יה
יופיע     Height_tורק לאחר מכן לעבור לאזור השרטוט(. בתחתית השרטוט, ליד הכיתוב

. זוהי שכבת הגובה המתוכנן. מכיוון  Height_dהגובה הקיים. תוכל להבחין גם בכיתוב 
 כננת, יהיה הגובה המתוכנן זהה לגובה הקיים.שכרגע עדיין לא חושבה קרקע מתו

בעזרת שיטה זו של הקלדה על כפתור העכבר באזורים שונים של השרטוט תוכל לדעת 
בדיוק היכן חושב מודל מתכנון גם אם שכבת השרטוט של קווי הגובה המתוכננים מוקפאת,  

כל שעליך לעשות  נמחקה או שפשוט אין קווי גובה מתוכננים באזור מסוים )היינו מישור(.
 -ל Height_t  הוא לנוע על גבי השרטוט, ללחוץ על כפתור העכבר ולאתר הפרשים בין

Height_d  . 
 
 . שינוי צבע של שכבת המצב הקיים: 4

לצורך נוחות המשך העבודה שנה את צבע שכבת המצב הקיים לאפור בהיר, כך שתראה  
הגובה של המצב הקיים, ושכבות  יוצרת שכבות קבועות לקווי CivilCAD 10כרקע. תוכנת 

קבועות לקווי הגובה של המצב המתוכנן. שכבות קווי הגובה של המצב הקיים יתחילו ב  
Topography contours  למשתמשי גרסת(AutoCAD/ZWCAD שמות שכבות אלו ,

 (. Tcontours -יתחילו ב
 

 קליטת נתוני מצב מתוכנן/מצב לאחר ביצוע 
 

לאחר ביצוע כנתוני התכנון. בחלק זה של הפרק, נראה כיצד כאמור הגדרנו את הנתונים ש
 ניתן לקלוט את נתוני התכנון על גבי המצב הקיים. 

 
ההסבר כאן מתבסס על הדוגמה המלווה את ההסבר לאורך כל הפרק "חישובי נפחים  

 בשיטת מודל מול מודל".
 
לון התחתון  שבח קואורדינטותה.  רשימת     Design   ->   Coordinates. הפעל: 5

 . Designed Coordinatesל   Topography Coordinatesתתחלף מ 
 . הקלד את הרשימה הבאה כנקודות מתוכננות:6
 

Height  North East Name 
14.15 78.79 51.66    1 
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15.01 66.72  71.13 2 
14.94 45.29 62.90 3 
12.72 39.29 85.94 4 
13.42 22.01 69.21 5 
12.51 14.06 77.71 6 
12.35 11.87 48.64 7 
13.59 23.39 22.59 8 
12.28 40.39 11.34 9 
13.86 67.82 20.67 10 
13.98 25.58 50.56 11 
14.94 36.55 56.32 12 
15.10 36.55 40.96 13 
14.50 30.52 46.45 14 
13.30 19.82 46.45 15 
13.44 21.19 59.34 16 
           

 לרענון השרטוט והצגת הנקודות.  לאחר הקלדת הרשימה לחץ 
 

ת: רשימת נקודות למצב קיים ורשימת  ו שתי רשימ פרויקט, מנהלת לכל CivilCAD 10תוכנת 
, מציגה התוכנה בחלון  CivilCAD 10 תוכנת נקודות למצב מתוכנן. כאשר מפעילים את 

ין שתי  (. ניתן לדפדף בTopography coordinatesהקיים בלבד )התחתון את רשימת המצב 
לבין   Topography -> coordinatesהרשימות על ידי בחירה בסרגל התפריט הראשי בין:  

Design -> coordinates .בכל בחירה תוחלף הרשימה התחתונה ברשימה הרצויה . 
 

 הגדרת אזורים שאינם לחישוב
 

מנת שבם התוכנה תחשב נפחים. על  מעוניינים לעיתים קרובות, קיימים אזורים שבהם איננו 
לא תיצור בהם קווי גובה.   CivilCAD 10 להגדיר אזורים כאלה, נהיה צריכים לדאוג שתוכנת 

מחשבת נפחים רק לאותם אזורים בהם יש חפיפה בין קווי גובה  CivilCAD 10תוכנת 
נו מישור ואז גם כן תחשב התוכנה  יקיימים וקווי גובה מתוכננים )אלא אם כן אחד האזורים ה

יטה הטובה ביותר בכדי להגדיר אזור כשטח שאינו לחישוב נפחים הוא  את הנפחים(. הש
רציפות סגור נוכל להגדיר הן  -רציפות המוגדר כסגור. נציין כי קו אי-על ידי קו אי ם אותולתחו

בכל מקום שבו יהיה שטח שיוגדר על ידי קו כזה, או   במצב הקיים והן במצב המתוכנן, כאשר
 שניהם(, לא תחשב התוכנה נפחים לשטח זה. במצב הקיים או במתוכנן )או ב

 
קווי אי   -רציפות סגור ראה פרק "יצירת קווי גובה-הערה: פירוט על אופן הגדרת קו אי

 רציפות/הגדרת תחומים שאינם לחישוב".
 

 נמשיך בדוגמא שהתחלנו במהלך הפרק הנוכחי להסברת הנושא. 
ן יפתח חלון קווי אי הרציפות:   . מימיDesign -> Lines. מסרגל התפריט הראשי הפעל: 7

Designed Lines  . 
 

במהלך ההסבר בחוברת נלמדו מספר שיטות בהן ניתן להגדיר או לבחור נקודות להגדרת קו 
 אי רציפות. אנו ניישם אחת מהשיטות הנ"ל: 
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הקלד את רשימת הנקודות הבאה בתוך הטבלה ,   Designed Linesלאחר שייפתח חלון 

 לאחר כל מספר(  ENTER. )לחץ Name  : 3  ,5 ,16 ,15  ,11  ,14 ,13 ,12 ,3תחת הכיתוב 
 
, נפתח את חלון האפשרויות ונגדיר  חסרת קווי גובהבצורה סגורה  מעוניינים. מכיוון שאנו 9

. בחלון   האפשרויות יש ללחוץ על כפתורקו זה כקו סגור. על מנת לפתוח את חלון 
  מעוניינים. ייתכן מצב שבו אנו  Closedהמילה  ליד  V(, נסמן Linesשייפתח )תחת הכיתוב 

בקו אי רציפות סגור אשר יכלול קווי גובה )וחישוב כמויות(. לשם כך פשוט נסגור את הצורה 
. לסיום הגדרת הקו/צורה לחץ  Closed"( ליד המילה Vכפי שעשינו זה עתה, אך לא נסמן וי )" 

OK   ובחלון הימני לחץ על. 
 

 ים הגדרת תחום חישוב הנפח
 

אזורים בהם קיימת חפיפה בין קווי גובה למצב הקיים, ובין   יכלול תחום חישוב הנפחים 
האזורים שבהם חושבו קווי גובה למצב המתוכנן. להגדרת תחום קווי הגובה במצב הקיים אין  

שובי הנפחים. לעומת זאת הגדרת תחום קווי הגובה המתוכננים חשוב חשיבות גדולה בחי
קפדנית. בהרצת קווי גובה למצב המתוכנן, ללא הגדרת תחום, יתכן  ה רבצווצריך להתבצע 

מצב שבו התוכנה תבצע אינטרפולציות אשר אין ברצוננו בהן. אינטרפולציות אלו יהיו בעיקר  
בקצוות הטופוגרפיה, שכן התוכנה מבצעת אינטרפולציה בין כל שתי נקודות סמוכות, גם אם  

ם ליצירת משולשים )משולשי אינטרפולציה( שאינם הן רחוקות זו מזו, דבר הגורם לעיתי
השיטות   3שיטות עיקריות. הפעלת  3רצויים. למניעת יצירת משולשים אלו, עומדים לרשותנו 

 אשי(:)הפעלה מסרגל התפריט הר Design -> Contoursמתבצעת בחלון 
בו תיצור  הגדרת גבול מדויק, על ידי הגדרת היקפו, ש  -הגדרת גבול על ידי נקודות גבול .1

 התוכנה את קווי הגובה המתוכננים.
הפעלת אופציה אוטומטית, שבו תצמצם התוכנה את גבולות קווי   -Fix bordersשיטת  .2

 הגובה המתוכננים לכדי אופטימום אשר נקבע באופן שאינו בידי שליטת המשתמש.
לאינטרפולציה בין  מקסימאליהגדרת מרחק  -Max interpolation lengthשיטת  .3

ות. לאחר שנגדיר מרחק כזה, תיצור התוכנה משולשי אינטרפולציה אך ורק בין  נקוד
 נקודות שהמרחק ביניהן אינו עולה על המוזן. 

 
והגדרת   נושאים בסיסיים -לפירוט הפעלת כל אחת מהשיטות ראה פרק "יצירת קווי גובה

 תחום קווי הגובה".
 

 הכנת מודל )קווי הגובה( של המצב המתוכנן 
 

בין אופן יצירת קווי הגבוה של המצב המתוכנן וקווי   כמעט מוחלטתימת זהות כעקרון, קי
הגובה של המצב הקיים, מלבד המסכים שבהם הפעולה מתבצעת. קווי הגובה של המצב  

תיצור   CivilCAD 10ווי גובה מצב קיים. תוכנת על רקע של ק רקהמתוכנן יכולים להיווצר, 
 ות לשכבות קווי הגובה של המצב הקיים. קווים אלו באופן אוטומטי בשכבות חדש

 
. מימין יפתח חלון יצירת Design -> Coordinatesמסרגל התפריט הראשי הפעל:  .1

 קווי הגובה. 
 . התוכנה תחשב קווי גובה ותיצור אותם. Applyבחלון מימין לחץ  .2
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"הגדרת  -כפי המוסבר בשני החלקים הקודמים של הפרק )"הגדרת אזורים שאינם לחישוב" ו
תחום חישוב הנפחים"(, ניתן לבצע בקווי הגבוה המתוכננים אותן פעולות שניתן לבצע על 

קווי הגובה הקיימים. כל הפעולות של קווי הגובה המתוכננים יבוצעו על רשימת  
)קווי הגובה של המצב הקיים   Designed coordinatesהמתוכננות, דהיינו  קואורדינטותה

(, קווי אי Topography coordinates -הקיימות תקואורדינטוהמחושבים על רשימת 
, וכאמור גבולות קווי הגובה המתוכננים Designed linesרציפות המתוכננים יוגדרו בחלון  ה

 . Designed contoursיוגדרו בחלון 
 

לאחר חישוב קווי גובה מתוכננים, יוצרת התוכנה מודל תלת ממדי חדש, בנוסף למודל המצב 
לאזור השרטוט, למקום שבו חושבו הן קווי גובה קיימים והן מתוכננים הקיים. אם נעבור 

)אזורי חפיפה(, ונלחץ עם כפתור העכבר, נוכל לראות שבמקומות אלו שני גבהים. את 
למתוכנן, המופיעים   Height_D -לקיים ו  Height_Tהגבהים ניתן לראות בשני השדות, 

 Pickישתמשו באופציית  AutoCAD/ZWCADמתחת לחלון השרטוט. משתמשי גרסת 

height מתוך סרגל הכלים הראשי(.  , לביצוע הפעולה, בצורה הבאה: לחץ על כפתור(
עבור לאזור השרטוט ולחץ עם העכבר במקום חפיפה של קווי גובה. תוכל להבחין שהתוכנה  

 כפי שהוסבר.Height_D -ו Height_T  מציגה את האינטרפולציה בשדות 
 
 

 חלון עבודות עפר כלליות  -קבלת טבלת נפחים 
 

מודל".   מול  "מודל  בשיטת  עפר  עבודות  לחישובי  השלבים  אחר  עקבנו  הפרק  במהלך 
ל נותר  אשר  כל  המתוכננים,  הגובה  קווי  את  לחשב  סיכום משסיימנו  את  לקבל  הוא  עשות 

הראשי   התפריט  מסרגל  כלליות.  עפר  עבודות  חלון  את  נפעיל  כך  לשם  הכמויות.  חישוב 
 . מימין יפתח חלון "עבודות עפר כלליות". Earthworks -> Generalהפעל: 

 
בחלון שנפתח לחץ כפתור  -חישוב עבודות עפר כלליות ללא רשת )"השיטה המדויקת"( . 1

Apply  התוכנה תבצע חישוב הפרשים בין שתי השכבות )מודל המצב הקיים ומודל המצב .
נפח הכולל:  נפחים  דו"ח  ותציג  הפרויקט,  לכל  חפירה   המתוכנן(,  מילוי, שטח  נפח  חפירה, 

 )מקורב(, שטח מילוי )מקורב(.
רשת    CivilCAD 10לתוכנת   "שיטת  מהן,  )אחת  עפר  עבודות  לחישובי  שיטות  מספר 

השונות   החישוב  שיטות  בין  מיד(.  תוסבר  כי    וצרו ייו המרובעים",  נציין  הפרשים.  בהכרח 
רות מקדימות(, הנה השיטה  בחלון ללא כל הגד  Applyהשיטה שזה עתה הוצגה )לחיצה על  

החישוב.   הוכחת  היא  זו  בשיטה  הבעיה  המדויקת".  "השיטה  שמה  ומכאן  ביותר  המדויקת 
שוב הכמויות )על ידי המשתמש(, ומכאן הבעיות  בשיטה זו לא מתקבל כל מעקב על אופן חי
 שבהגשת כמויות אלו לצורכי פיקוח לדוגמא. 

 
)"   -שיטת רשת המרובעים .  2 . בשדות Create full grid"(, את השדה  Vסמן בחלון מימין 
“Grid's stepsב הכנס   ,"-  X  וב-  Y    בכיוון המרובעים,  ברשת  המרווחים    Yובכיוון    Xאת 

בחלון. התוכנה תבצע חישוב הנפחים    Apply(. לחץ על כפתור  10X10)ברירת המחדל הנה  
וב חלוקת הרשת,  גבי השרטוט תופיע  על  כל הפרויקט, בשיטת המרובעים.  תיצור  על  נוסף 

לכל   הביניים  סיכומי  מרובע,  לכל  והמילוי  החפירה  נפח  יצוין  בו  כמויות  דו"ח    10התוכנה 
" ליד  Vמרובעים, וסה"כ ריכוז הכמויות לכל הפרויקט. קיימים הפרשים בחישוב בין אם סומן " 

  " Vגם בעת סימון "   מדויקתובין אם לא סומן. על מנת לקבל תוצאה    Create full gridהכיתוב  
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)כיתוב זה יופיע בחלון    Use accurate system" גם ליד הכיתוב:  Vליד כיתוב זה, יש לסמן " 
 . Applyתסומן( וללחוץ   Create full gridרק כאשר האופציה 

 
בשתי השיטות שזה עתה ראינו, הוצג חישוב הכמויות לכל  -הגדרת תחום חישוב הנפחים. 3

בעז נגדיר  החישוב  אזור  את  ככלל,  תהפרויקט.  זאת, ירת  אם  המתוכננים.  הגובה  קווי  חום 
בשיטת רשת המרובעים, בחישוב כמויות לכל הפרויקט, תיווצר רשת גם באזורים שבהם אין 

, ועל כן לא ישפיעו  0חפיפה בין מצב קיים למצב מתוכנן. נפח החפירה למרובעים אלו יהיה  
לצמצם את הרשת )כולל   על חישוב הנפחים. מסיבות אסתטיות, ומסיבות נוחות, נרצה אם כן

לשיטה  והן  מרובעים  לרשת  )הן  הנפחים  לחישוב  תחום  להגדרת  הנלווה(.  הדו"ח  צמצום 
 המדויקת( בצע הפעולות הבאות:

מימין  )בחלון  הרצויה  בשיטה  שהנך  וודא   ,Create full grid  –   לרשת מסומן 
מרובעים או לא מסומן לשיטה המדויקת(. אם ברצונך רשת מרובעים המחושבת 

 Use accurate system. סמן גם את האופציה:  המדויקתלפי השיטה 
גבולות   Pickבחר    את  והגדר  השרטוט  לאזור  עבור  שמימין,  הבחירה  בתיבת 

 " כפתור  לחץ  הגבולות  הגדרת  לסיום  לחישוב.  הרצוי  מימין Setהתחום   "
 -” בשורת הפקודות של הSניתן להזין "   AutoCAD/ZWCAD)למשתמשי גרסת  

AutoCAD/ZWCAD  משתמשי גרסת .)AutoCAD/ZWCAD   יוכלו להגדיר את
 גבולות החישוב בצורה הבאה:

 אשר יגדיר את אזור החישוב. Polylineשרטט  
 בתיבת הבחירות שמימין.  Select -בחר ב 
 .טרטששו Polyline -עבור לאזור השרטוט ובחר את ה 

באApplyלחץ    רק  המוגדרת  השיטה  פי  על  הנפחים  את  תחשב  התוכנה  זור . 
 שנבחר.

 להיות בנוי ממקטעים ללא קשתות או רדיוסים.  Polyline-הערה: על ה 
 
נועד בעיקר    -)תוספת לתכנון(  Add to design  -איזון כמויות בעזרת שדה.  4 שדה זה 

משטחים   מים,  מאגר  להיות  יכול  כזה  פרויקט  שתוכנן.  לפרויקט  עפר  עבודות  איזון  לביצוע 
גובה מתוכנני ידי הכנסת מתוכננים או קווי  ם על פי נקודות גובה. שימוש בשדה יתבצע על 

על   ולחיצה  )במטרים(  לפרויקט  הרצוי  הגובה  דו"ח  Applyתוספת  ותציג  תחשב  התוכנה   .
חדש אשר הכמויות בו יחושבו כך שהתכנון בפרויקט גבוה מהתכנון המקורי בתוספת הגובה 

"(. בצורה כזו של 1.05-גמא " שהוכנסה. להורדת גובה הפרויקט נכניס תוספת שלילית )לדו
שינוי הגובה המתוכנן בפרויקט, ניתן להגיע לאיזון עבודות עפר בקלות, ללא שינוי הגבהים  

 הפיסיים. 
למילוי בפרויקט. בעזרת  בין החפירה  היחס  גם  מופיע  בדו"ח הכמויות שמתקבל,  לב:  שים 

 נתון זה ניתן ביתר קלות לעקוב אחר האיזון המתקבל.
 
לחישוב נפחים בפרויקט שבו יש לבצע  חישוף   -Stripping depth -דות עפרחישוף עבו. 5

( ובאזור מילוי .Cut arפני הקרקע , יש להזין את עומק החישוף )במטרים( באזור החפירה )
(Fill ar.  וללחוץ ,)Apply  התוכנה תבצע חישוב מחודש של נפחי הפרויקט, ותציג דו"ח ובו .

לאחר התחש עפר  עבודות  לחפירה  כמויות  החישוף  נפחי  כולל  המוזן,  החישוף  בעומק  בות 
 ומילוי.  

הערה: אם אין חישוף באחד מהאזורים )חפירה או מילוי(, יש להשאיר את השדה הרצוי ריק  
 ".0או להזין " 
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השרטוט.  6 גבי  על  הכמויות  דו"ח  בצע    -הצגת  השרטוט  גבי  על  הכמויות  דו"ח  להצגת 
 השלבים הבאים:

 . Applyגיל על ידי לחיצה על  תחילה חשב הדו"ח כר 

 . לחץ על הכפתור  
 עבור לאזור השרטוט: 

מקם את הטבלה באזור הרצוי   -AutoCAD/ZWCADלמשתמשי גרסת  
ולחץ עם העכבר. במקום המיועד ליצירת הדו"ח תופיע מסגרת צהובה. 

 " הכנס  כרצוי,  הוא  הטבלה  מיקום  חזור  Sאם  ולא,  הפקודות,  בשורת   ”
במקום   הטבלה  את  “ומקם  על  לחיצה  לאחר  שכבה Sהרצוי.  תיבנה   ”
 שתכיל את הדו"ח הרצוי.

 
 פירוט הכפתורים המופיעים בחלון ושימושיהם: 

 

לחיצה על הכפתור הנ"ל תאתר את גבולות חישוב הנפחים    -  איתור גבולות החישוב     .7

 )בסרגל הכלים הראשי( ייעלמו גבולות אלה. בצורה  ותצבע אותן בצהוב. לאחר לחיצה על  
 זו תוכל לאתר את גבולות חישוב הנפחים שהגדרת. 

 

החישוב   .8 גבולות  עומדת   -מחיקת  שהיא  התוכנה  תתריע  הכפתור  על  לחיצה  לאחר 
י  ההודעה,  אישור  לאחר  שהוגדרו.  החישוב  גבולות  את  לא ילמחוק  אם  אלו.  גבולות  מחקו 

 ט. יוגדרו גבולות חדשים, אזי חישוב הכמויות הבא יבוצע לכל שטח הפרויק
 

גבול  .  9 נקודת  הנק  -מחיקת  ברשימת  הנקודה  את  על  סמן  ולחץ  הימני  שבחלון  ודות 
לחץ  הפעולה  לאישור  מחדש.  יוגדרו  החישוב  וגבולות  תימחק מהרשימה  הנקודה  הכפתור. 

 " על  Setכפתור  לחיצה   ."Apply   בעזרת החדשים.  לגבולות  בהתאם  מחודש  חישוב  תבצע 
אפשר לערוך את גבולות חישוב הנפחים כרצוי. נציין כאן    Pickפעולה זו ובשיתוף עם פעולת  

שבכדי לשנות את גבולות החישוב, ניתן לסמן את אחת הנקודות ברשימת הנקודות שמימין,  
ולעבור לאזור השרטוט. התוכנה תמשוך קו מהנקודה שהצבעת עליה,   Pickללחוץ שוב על  

 קודה הנ"ל. יתווספו לאחר הנחדשות הכך שבחירת נקודות גבול החישוב 
 

כפתור זה יפתח את חלון    -  הגדרות חלון עבודות עפר כלליות  -Options  כפתור       .10
ההגדרות השייכות לחלון עבודות העפר הכלליות. ראה בהמשך פירוט הפעולות האפשריות 

 בחלון זה.
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 עבודות עפר נושאים נוספים  :9פרק 
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 נושאים נוספים  -עבודות עפר
 

"חישובי נפחים בשיטת מודל מול מודל" נלמדו  -בעזרת משטחים" ו בפרקים "חישובי נפחים
שתי שיטות לחישובי עבודות עפר. בסוף שני הפרקים הנ"ל, נלמדו מספר שיטות להצגת 

 כמויות הנפחים: 
שיטה האפשרית להצגה רק כאשר מחשבים  -הצגת הכמויות על פי דו"ח מגרשים 

קבלת  -י נפחים בעזרת משטחיםלפרוט ראה פרק "חישוב -כמויות על פי מגרשים
 טבלה מסכמת". 

ר מחשבים שיטה זו אפשרית להצגה הן כאש -הצגת הכמויות בשיטה המדויקת 
לפרוט ראה פרק  -בשיטת המשטחים והן כאשר מחשבים בשיטת מודל מול מודל

קבלת טבלת נפחים חלון עבודות עפר   -"חישובי נפחים בשיטת מודל מול מודל
 כלליות". 

שיטה זו אפשרית להצגה הן כאשר מחשבים  -ת בעזרת רשת מרובעיםהצגת הכמויו 
לפרוט ראה פרק  -בשיטת המשטחים והן כאשר מחשבים בשיטת מודל מול מודל

קבלת טבלת נפחים חלון עבודות עפר   -"חישובי נפחים בשיטת מודל מול מודל
 כלליות". 

 
מאפשרת, ושלא פורטו   תוכנההפרק הנוכחי מציג מספר נושאים הקשורים בעבודות עפר שה

 בפרקים הקודמים:  
 

 חישובי עבודות עפר באמצעות משולשים.
 רשת איזון עבודות עפר.  .1
 . 0 -( כולל קו ה-קווי גובה עבודות עפר )+/ .2

 

 חישוב עבודות עפר בשיטת המשולשים 
 

ככלל, חישוב עבודות עפר בשיטת המשולשים אפשרי רק כאשר מחשבים נפחים בשיטת 
השיטה מאפשרת הצגת חישוב הנפחים בשרטוט מלווה בדו"ח של  "מודל מול מודל".

משולשי האינטרפולציה של קווי הגובה המתוכננים. נעבור על סדר הפעולות להפעלת 
 האופציה: 

 
. חזור ובצע חישוב של קווי גובה קיימים מול קווי גובה מתוכננים, כמוסבר בפרק "חישוב 1

הכנת קווי הגובה המתוכננים, המשך על פי פרק   נפחים בשיטת מודל מול מודל". לאחר סיום
 זה )ולא כפי המופיע בפרק המקורי(.

. לאחר שברשותך קווי גובה מתוכננים על גבי קווי גובה קיימים, הפעל מסרגל התפריט  2
 . מימין יפתח חלון חישוב המשולשים. Earthworks -> Trianglesהראשי: 

כנה תחשב ותציג את רשת המשולשים על גבי  בחלון שנפתח. התו Apply. לחץ על כפתור  3
השרטוט. לכל משולש תציג התוכנה מספר סידורי ואת הפרשי הגובה הקיים והמתוכנן 
 בקצותיו. לשרטוט יתלווה דו"ח המציג את שטח ונפח החפירה והמילוי לכל משולש כזה. 

 
בכל פינת רציפות המתוכננים. -רשת המשולשים תיבנה על בסיס נקודות הגובה וקווי האי

משולש תתקבל שכבת שרטוט של נתוני רשת המשולשים בנוסף לשכבת נקודות הגובה 
 המתוכננות. 
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 פרוט פעולות נוספות אפשריות בחלון:

 
בשדה זה ניתן להכניס תוספת לגובה  -Add to design -תוספת לגובה המתוכנן. 1

ת הגובה הכנס מספר המתוכנן )במטרים(, כך שהדו"ח יחושב בהתאם לתוספת הנ"ל. להורד
התוכנה לא תשנה את גובה  -"(. היתרון כאן הוא במהירות הביצוע1.05-שלילי )לדוגמא " 

הנקודות המתוכננות בפרויקט, אך תחשב את הכמויות ותציג את הדו"ח בהתאם לשינוי 
 הנ"ל. 

לפרויקט שבו קיים חישוף בשטח העבודה. את  -Stripping depth -עומק חישוף. 2
( .Cut arניס כעומק )במטרים(, תוך כדי הפרדה לעומק חישוף לשטח החפירה )החישוף נכ

(. לפרויקט שבו קיים חישוף רק לאחד מהשטחים  .Fill arועומק החישוף לשטח המילוי )
)או נשאיר את השדה הריק( לגבי השטח הרצוי. התוכנה תחשב את הכמויות   0נכניס 

רה יפחית מכמות החפירה, ועומק חישוף  בהתאם לחישוף המוזן, כאשר עומק חישוף בחפי
 במילוי יוסיף לכמות המילוי. 

מאפשר הוספת טבלת הנפחים על גבי  -הוספת טבלת הנפחים על גבי השרטוט . 3
 השרטוט במקום רצוי. לביצוע הפעולה עקוב אחר סדר הפעולות הבא:

הפקת דו"ח הערה: הפעולות אפשריות רק לאחר חישוב דו"ח כפי שמוסבר בתחילת הפרק. ו
 רגיל, עבור על הפעולות הבאת על מנת למקמו על גבי השרטוט. 

 לחץ על הכפתור. 
 עבור לאזור השרטוט ומקם את הטבלה במקום הרצוי. 
לחץ עם העכבר לקביעת  AutoCAD/ZWCAD -למשתמשי גרסת 

הטבלה. על גבי השרטוט תופיע מסגרת צהובה שבו תמוקם הטבלה. 
ר החדש ולחץ שוב עם העכבר. לאחר לבחירת מיקום שונה עבור לאזו

  -" בשורת הפקודות של הSשבחרת את המיקום הרצוי, הזן " 
AutoCAD/ZWCAD  המסגרות הצהובות ימחקו, והדו"ח ימוקם במקום .

 האחרון שנבחר.

לחיצה על הכפתור תפתח את חלון הגדרות  -הגדרות תצוגת רשת המשולשים   .4
 החלון ראה בהמשך. לותתצוגת רשת המשולשים. על פרוט פעו

 
 (:Statusפרוט פעולות חלון הגדרות תצוגת המשולשים )

 
Scale- בשדה זה ניתן להגדיר את גודל כיתוב הטקסט הן ברשת  -הגדרת גודל הכיתוב

המשולשים, והן בטבלת דו"ח הנפחים על גבי השרטוט. לשינוי הגודל המופיע לחץ על כפתור  
נם פקטור מסוים  ידל החדש. המספרים המוצגים ההחץ הקטן שמימין לשדה, ובחר את הגו

 פקטור גדול יותר, יגדל גודל הכיתוב.  הככל ש
 

לאישור השינוי, וחזור ובצע חישוב   Okהערה: גודל הכיתוב לא ישתנה באופן מיידי. לחץ על  
( בחלון הראשי. לבניית טבלת דו"ח נפחים חדשה, חזור ובצע את הפעולה Apply)כפתור 

 המתאימה. 
 

Designed elevations-   הצגת הגבהים המתוכננים בפינות המשולשים. הורדת סימון הוי
 "(V”(  .מהשדה תסיר הצגת גבהים אלו 

Barracks-  .הצגת הגבהים המתוכננים בסוגריים 
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Topo. Elevations –   הצגת גבהים של הקרקע הקיימת בפינות המשולשים. הורדת סימון
 ים אלו.מהשדה תסיר את הצגת גבה )”Vהוי )" 

Barracks-  .הצגת גבהיי הקרקע הקיימת בסוגריים 
 

Height intervals-  .הצגת ההפרש בין הגובה המתוכנן לגובה הקיים בפינות המשולשים
 מהשדה יסיר את הצגת ההפרשים. )”Vהורדת סימון הוי )" 

 
OK/Cancel-  .אישור/ביטול השינוי שבוצע בהגדרות 

 

 יצירת רשת איזון עבודות עפר 
 
פציית חישוב עבודות עפר בשיטת רשת איזון, אפשרית גם כאשר מחשבים נפחים "בשיטת או

המשטחים" וגם כאשר מחשבים נפחים בשיטת "מודל מול מודל". השיטה מאפשרת קבלת  
רשת מרובעי נפחים, במרווחים הרצויים. שיטת החישוב וההצגה כאן דומה מאד לשיטת 

 -קבלת טבלת נפחים -ים בשיטת מודל מול מודלנפחחישוב הנפחים שנלמדה בפרק "חישוב 
 חלון עבודות עפר כלליות", אך שונה בשתי נקודות עיקריות: 

 אופן תצוגת הרשת.  .1
רשת איזון עבודות העפר ניתן להכין בכל כיוון רצוי בעוד רשת מרובעי נפחים ניתן  .2

 להכין  רק בכיוון לצפון. 
 

 נעבור על סדר הפעולות להפעלת האופציה: 
בשיטת המשטחים בצע השלבים עד סיום   -ובצע את כל השלבים בחישוב כמויות  . חזור1

הגדרת כל המשטחים המתוכננים, ובשיטת מודל מול מודל בצע השלבים עד קבלת קווי גובה 
 מתוכננים.

. לאחר שברשותך קווי גובה מתוכננים על גבי קווי גובה קיימים )או משטחים מתוכננים על 2
. מימין יפתח  Earthworks -> Gridם(, הפעל בסרגל התפריט הראשי: גבי קווי גובה קיימי

 חלון יצירת רשת איזון עבודות עפר. 
והמרווח   Xהכנס את המרווח הרצוי בכיוון   Grids steps -. בשדה הגדרת מרווחי הרשת3

 (.10X10)ברירת המחדל הנה  Yהרצוי בכיוון 
ע הרשת, נגדיר בעזרת שלוש נקודות:  את מידות החלון שבו תבוצ  -. הגדרת גבולות הרשת4

שתי נקודות שיגדירו את בסיס החלון ונקודה שלישית אשר תגדיר את גובה החלון. בחלון  
,  קואורדינטותה(, של שלושת נקודות הגבול של רשת Y -ו X) קואורדינטותהמימין נראה את 

א הנקודה  הי End corner -הנן נקודות הבסיס, ו Base second -ו Base firstכאשר 
 הסוגרת. קיימות שלוש שיטות להגדרת חלון הרשת:

 נקודות הגדרת הרשת בשדות הנ"ל.  קואורדינטותהקלדת 
, עבור לאזור השרטוט וסמן )בעזרת לחיצה עם העכבר( את Pickלחץ על    -Pick  -שימוש ב

נקודת הגבול השמאלית תחתונה של הרשת. עבור וסמן את נקודת הגבול הימנית תחתונה, 
כך תיצור את קו הבסיס של הרשת. המשך וסמן נקודה נגדית לקו הבסיס אשר בעזרתה  וב

זה.   מקו  הרשת  גובה  את  שבחלון   קואורדינטותתגדיר  בשדות  יופיעו  שהגדרת  הנקודות 
 מימין. 

ב גרסת    -Select  -שימוש  קווי    -בלבד  ZWCAD/AutoCADלמשתמשי  תחילה, העבר שני 
Line  ב-  AutoCAD/ZWCAD   בצורה הבאה: קו    קואורדינטותהו את רשת  אשר יגדירLine  

שני יגדיר את גובה הרשת ביחס לקו הבסיס.    Lineראשון יגדיר את קו הבסיס של הרשת וקו  
. עבור לאזור השרטוט, ובחר את הקווים שהגדרת לפי  Select  -לאחר שרטוט הקווים בחר ב
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גובה   את  הקו שמגדיר  את  מכן  ולאחר  הבסיס  קו  את  תחילה    קואורדינטותהרשת.  הסדר: 
 הקווים שבחרת יופיעו בחלון מימין. י לפהנקודות שהוגדרו 

לחץ  5 הימני,  תיצור רשת  Apply. בחלון  פי ההגדרות הקיימות.    קואורדינטות. התוכנה  על 
יופיע הגובה הקיים המתוכנן   הרשת תיווצר בניצב לקו הבסיס, כאשר בכל פינה של הרשת 

י תכנון בנקודות אלו(. כל מרובע ברשת ימוספר על פי סדר  וההפרש ביניהם )בתנאי שיש נתונ
עולה, ובכל מרובע  יופיע נפח חפירה ונפח מילוי. לרשת יתלווה דו"ח מפורט שבו יופיע נפח  

חלקי   ריכוז  כדי  תוך  מרובע,  לכל  והמילוי  הנפחים החפירה  של  כולל  וסיכום  החשבון  של 
צעים של פינות המרובעים על מנת חישוב זה מתבצע על סמך חישוב סך הממושחושבו.  

 . Use accurate system יותר יש לסמן את האופציה: מדויקלקבל חישוב 
 
 

 פעולות נוספות אפשריות בחלון:
רשימת  .  1 מסובבת   קואורדינטותיצירת  רשת  רשימת    -של  קבלת  מאפשרת  זו  אופציה 

ופציה שימושית של רשת כלשהי כאשר ידוע קו הבסיס והגובה של הרשת. הא  קואורדינאטת
של רשת, גם ללא הקשר לנושא עבודות העפר. ליצירת רשימת   קואורדינטות מאד לחישוב  

 עקוב אחרי השלבים הבאים: קואורדינטותה
 למעלה. 3הגדר את מרווחי הרשת כפי שמוסבר בסעיף 

 . 4הגדר את גבולות הרשת הרצויה לחישוב באחת מהשיטות המפורטות מעלה בסעיף 
הכפתור  לחץ   הכיתוב  על  ועליו  לרשימת  Topoהכחול  תוסיף  התוכנה    קואורדינטות ה . 

של   קואורדינטותה(, את  Topography coordinates  -הקיימות )הרשימה שבחלון התחתון
המתוכננת    קואורדינטותהנקודות הרשת שהוגדרה. כדי להורות על יצירת הנקודות ברשימת  

(Designed coordinatesיש ללחוץ על הכפתור האד ) ום עם הכיתובDesign . 

כפתור   על  גבי    לחץ  על  הנקודות  רשימת  את  לקבל  מנת  על  הראשי(  הכלים  )בסרגל 
 השרטוט.

 לחיצה על המחק תנקה את שדות הרשת.   -מחיקת שדות הגדרת הרשת    .2

גבולות הרשת לכל שטח הפרויקט   .3 גבולות   -  הגדר את  לחיצה על הכפתור תכניס 
)או אחד מהכפתורים   OKשל הרשת בשדות המתאימים. לחיצה על  הפרויקט כנקודות הגבול

Topo/Design .תיצור את הרשת כרצוי ,) 
שדות החישוף נועדו לפרויקט שבו קיים חישוף בשטח    -Stripping depth  -עומק חישוף.  4

לשטח  חישוף  לעומק  הפרדה  כדי  תוך  )במטרים(,  כעומק  נכניס  החישוף  את  העבודה. 
( )(  .Cut arהחפירה  רק  .Fill arועומק החישוף לשטח המילוי  חישוף  קיים  לפרויקט שבו   .)

)או נשאיר את השדה הריק( לגבי השטח הרצוי. התוכנה תחשב   0לאחד מהשטחים נכניס  
החפירה,   מכמות  יפחית  בחפירה  חישוף  עומק  כאשר  המוזן,  לחישוף  בהתאם  הכמויות  את 

 ועומק חישוף במילוי יוסיף לכמות המילוי.

השרטוט     .5 גבי  על  הנפחים  טבלת  דו"ח    -הוספת  הוספת  מאפשרת  זאת  פעולה 
 הנפחים על גבי השרטוט במקום רצוי. לביצוע הפעולה עקוב אחר סדר הפעולות הבא: 

הפרק. לאחר  כפי המוסבר בתחילת  דו"ח  חישוב  רק לאחר  הערה: הפעולה הנ"ל אפשרית 
 למקמו על גבי השרטוט.ופק כבר דו"ח רגיל, עבור על הפעולות הבאת על מנת שה

 לחץ על הכפתור.
 עבור לאזור השרטוט ומקם את הטבלה במקום הרצוי.

לחץ עם העכבר לקביעת הטבלה. על גבי השרטוט    AutoCAD/ZWCAD  -למשתמשי גרסת
ולחץ תופיע מסגרת צהובה שבו תמוקם הטבלה. לבחירת מיקום שונה עבור לאזור החד ש 

שבחרת לאחר  העכבר.  עם  המיק  שוב  " את  הזן  הרצוי,  הSום  של  הפקודות  בשורת   "- 
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AutoCAD/ZWCAD  האחרון במקום  ימוקם  והדו"ח  ימחקו,  שיצרת  הצהובות  המסגרות   .
 שנבחר.

האיזון     .6 רשת  תצוגת  חלון    -(Options)  הגדרות  את  תפתח  הכפתור  על  לחיצה 
 הגדרות תצוגת רשת האיזון. על פרוט פעולות החלון ראה בהמשך. 

 
 (: Options-חלון הגדרות תצוגת רשת האיזון )מתוך חלון הפרוט פעולות 

 
1  .Scale-  תוב הטקסט הן ברשת  בשדה זה ניתן להגדיר את גודל כי  -הגדרת גודל הכיתוב

על   לחץ  הגודל המופיע  לשינוי  גבי השרטוט.  על  דו"ח הנפחים  והן במיקום טבלת  הנפחים, 
הגודל המוצג הנו פקטור מסוים  כפתור החץ הקטן שמימין לשדה, ובחר את הגודל החדש.  

 ככל שהפקטור גדול יותר, כך יגדל הכיתוב.  
לאישור השינוי, וחזור ובצע חישוב    OKהערה: גודל הכיתוב לא ישתנה באופן מיידי. לחץ על  

( בחלון הראשי. לבניית טבלת דו"ח נפחים חדשה על גבי השרטוט, חזור ובצע  Apply)כפתור 
 למעלה. 5את המוסבר בסעיף 

 
2  .Volumes-   הצגת נפחים בתוך הרשת. לכל מרובע ברשת הנפחים מופיע מספר המרובע

”(, משדה זה תסיר את כיתוב הנפחים  V"וי" )"   -ונפח החפירה והמילוי שלו. הסרת סימון ה
 בתוך השרטוט, ותשאיר רק את שם המרובע. דו"ח הכמויות הנלווה לשרטוט לא ישתנה. 

 
3  .Designed elevations-  פינה של הרשת. הסרת ההצג הגובה המתוכנן בכל  "וי"    -ת 
 "(V”( .משדה זה תסיר את הצגת הגובה המתוכנן 

Barracks-  .הצגת הגובה המתוכנן בסוגריים 
 
4  .Topo. Elevations-  ה הסרת  הרשת.  של  פינה  בכל  הקיים  הגובה  )"   -הצגת   )”V"וי" 

 משדה זה תסיר את הצגת הגובה הקיים. 
Barracks- בה הקיים בסוגריים. הצגת הגו 

 
5  .Height intervals-   הצגת הפרש גבהים בין הקיים למתוכנן בפינות ברשת. הסרת ה-  

 משדה זה תסיר את הצגת ההפרש.  )”V"וי" )" 
 

 "( 0" -יצירת קווי גובה עבודות עפר )כולל קו ה
 

ו זה  נו הקו המפריד בין אזור החפירה לאזור המילוי בשטח הפרויקט. הצגת קי"קו האפס" ה
נם יעל גבי התכנית מאפשרת הבחנה ברורה בין האזורים השונים. קווי גובה עבודות עפר ה

או    + הגובה  תוכנת    –קווי  האפס.  לקו  אלו    CivilCAD 10ביחס  קווים  שרטוט  מאפשרת 
עפר באחת משתי השיטות עבודות  בו  וחישוב    -לפרויקט שחושבו  בשיטת משטחים  חישוב 

 בשיטת מודל מול מודל.
 

 ור על שלבי העבודה ביצירת קווים אלו: נעב
המפורטים  1 השלבים  פי  על  הקיימות  השיטות  משתי  באחת  העפר  עבודות  וחשב  עבור   .

 "חישובי נפחים בשיטת מודל מול מודל". -בפרקים "חישובי נפחים בעזרת משטחים" ו
קווי  . מימין יפתח חלון יצירת  Earthworks -> Contours. מסרגל התפריט הראשי הפעל:  2

 הגובה המתוכננים.
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(. זאת  Intervalsמ' )ראה שדה    100. ברירת המחדל של הפרשי קווי הגובה בחלון הנה  3
מ' )ואלה    100אומרת, שבכל פרויקט שבו הפרשי הגובה בין החפירה למילוי אינו עולה על  

על   לחץ  האפס.  קו  את  רק  התוכנה  תיצור  הפרויקטים(,  מרבית  קווי   Applyכמובן  לקבלת 
 ובה עבודות עפר. קווי הגובה יחושבו וישורטטו בשכבה חדשה.הג
 

 פרוט הפעולות בחלון: 
 
הכנס את   -קווי גובה עבודות עפר נוספים לקו האפס  שייווצרו. שינוי הפרש קווי הגובה כך  1

ה בשדה  הרצוי  ולחץ    1)לדוגמא    Intervals  -ההפרש  שכבה Applyמ'(,  תיצור  התוכנה   .
 ישמר בשכבה נפרדת. 0 -ה. שים לב שקו החדשה לקווים אותם חישב

ברירת המחדל של התוכנה הנו כיתוב גבהים    -Auto elevations  -. כיתוב גבהים אוטומטי2
"( מהשדה תבטל את הפעולה. ראה Vבאופן אוטומטי על גבי קווי הגובה. על ידי הסרת הוי )" 

 להוספת כיתוב גבהים באופן ידני.  Pick -פעולת ה
לכית3 סוגרים  הגבהים.  העפר    -Barracks  -וב  עבודות  גובה  קווי  הצגת  מאפשר  זה  שדה 

 בסוגריים או ללא סוגריים. 
כיתוב הגבהים על גבי קווי הגובה בפורמט   – ”##.#“  Format      -. פורמט כיתוב הגבהים4

 ". 1.00"  -" למשל, יופיע כ1של שתי ספרות אחרי הנקודה. הגובה " 
יופיע כקו    -Doubled (0)  -. הבלטת קו האפס כקו עבה5 האופציה תגרום לכך שקו האפס 

 עבה.
גודל כיתוב הגבהים על גבי קווי הגובה )גודל הטקסט(   -Scale  -. שינוי גודל כיתוב הגבהים6

נקבע על פי הפקטור המופיע בשדה הנ"ל. שינוי הפקטור למספר גדול יותר, יגדיל את גודל 
 ודל זה.מספר קטן יותר יקטין ג  -כיתוב הגבהים ולהפך

ידני7 האופן  הגובה  קווי  גבי  על  גבהים  כיתוב   .-  Pick-    גובה קווי  כיתוב  להוסיף  מנת  על 
 במקום רצוי על גבי השרטוט בצע הפעולות הבאות: 

 . Pick -סמן את שדה ה 
קווי הגובה במקום הרצוי    יחצה את  קו אשר  וסמן  עבור לאזור השרטוט 

בנקודות   גבהים  תוסיף  התוכנה  הגבהים.  הקו לכיתוב  בין  החיתוך 
ששורטט לבין קווי הגובה. תוכל להמשיך ולהוסיף גבהים כרצונך. לסיום  

 . AutoCAD/ZWCAD -בשורת הפקודות של ה Escהפעולה לחץ 
 

(, מחייבת הרצה מחודשת של  Pick  -)מלבד פעולות ה  לעילהערה: כל הפעולות המצוינות  
 ( על מנת לראות את השפעתם. בחלון Applyקווי גובה עבודות עפר )לחיצה מחודשת על 
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 חתכים מהירים  :10פרק 
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 חתכים מהירים 
 

מאפשרת יצירת חתכים של פני קרקע קיימת ופני קרקע מתוכננת ע"י   CivilCAD 10תוכנת  
הוא   זו  שיטה  של  יתרונה  התוכנית.  גבי  על  החתך  קצוות  שתי  המהוות  נקודות  שתי  סימון 

 בל חתך בכל מקום מבוקש.ובאפשרות לק במהירותה ונוחות ההפעלה שלה
זו מחושב באופן שונה מאופן חישוב    חתך הקרקע  -דיוק השיטה.  1 ידי שיטה  המבוצע על 

)תפריט   כביש  של  האורך  או  הרוחב  בחתכי  הקרקע  זו  Roadsחתך  בשיטה  החתכים   .)
כבישים,   שבתכנון  החתכים  בעוד  דיוקם.  חשבון  על  יבוא  אשר  מהיר  מאד  באופן  יחושבו 

דיוק גבוה מאד )דיוק של מילימטרים(, חתכי הרוחב בשיטה זו עם    הציארפוליחושבו באינט
פרק ראה  )לפרוט  הפרויקט  של  הפרמטרים  הגדרת  על  בהתבסס  קירוב  ידי  על   -יחושבו 

שינוי דיוקי המודל"(. ככל שנעבוד בדיוק גדול יותר בהגדרת הפרמטרים, כן    -"נושאים כלליים
 ו.יגדל הדיוק בחתכים הנוצרים בשיטה ז

שטחים שנתוניהם חושבו בשיטת ו  משטחים,  . שיטה זו מאפשרת יצירת חתכים של כבישים2
 שני מודלים בלבד.

 . השיטה מאפשרת יצירת חתך בין שתי נקודות בלבד.3
 

 נעבור על השלבים הנדרשים ליצירת חתך מהיר: 
 הערה: ליצירת החתך, תהיה חייב ליצור קווי גובה קיימים לפחות. 

. מימין יפתח חלון יצירת החתכים Design -> Sectionsריט הראשי הפעל:  . מסרגל התפ1
 המהירים. 

 . ליצירת החתך ניתן להשתמש באחת מהשיטות הבאות:2
ידני  קואורדינטותהזנת    ה    -החתך באופן   First  -של ה  Yה    Xבשדות 

corner  וה-  End corner  של שתי נקודות הקצה    קואורדינטות ה, הזן את
)התחל  כפתור  של החתך  ולחץ  וסוף(  בין  Applyה  . התוכנה תציג חתך 
 שתי הנקודות הללו.

ב   –  Pick  -שימוש ב  ברשימה מימין. עבור לאזור השרטוט   Pick  -בחר 
את   תציג  התוכנה  ליצירת החתך.  הרצויות  הנקודות  בין שתי  קו  והעבר 

 החתך בין שתי הנקודות הללו. 
שיהווה את   AutoCAD/ZWCAD  -ב  Lineשרטט    -  Select  -שימוש ב 

ב   בחר  לראות.  שברצונך  לאזור    Selectהחתך  עבור  מימין,  בחלון 
ובחר את   ששורטט. התוכנה תציג את החתך לאורך הקו  קו  ההשרטוט 

 הנ"ל. 
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 פעולות נוספות אפשריות בחלון: 
 

שדות     החתך   קואורדינטותהמחיקת  קצוות  הכפתור    -  של  על  לחיצה 
 ת וסוף החתך.של התחל קואורדינטותהאת שדות  תימחק

 
ב גבהים  בחירההוספת  פי  על  רצויות  מיצירת   -Pick height  -נקודות  כחלק 

יוצרת תוכנת   נתונים של המצב הקיים, המתוכנן,    CivilCAD 10החתך,  טבלת 
והמרחק הרץ, לאורך החתך. הגבהים יוצגו במרחקים רצים על פי הקבוע בחלון  

יתן להוסיף גבהים על גבי  בסעיף הבא(. נ  Statusההגדרות של הגבהים )ראה  
רצוי, מלבד אותם גבהים שיצרה התוכנה באופן  רץ  גרפי במרחק  החתך באופן 

. Pick heightליד השדה    )” Vאוטומטי. להוספת גובה על גבי החתך סמן בוי )" 
את  תוסיף  התוכנה  הרצוי.  הרץ  במרחק  הכבר  עם  וחץ  החתך  לאזור  עבור 

בטבלת   אוטומטי  באופן  שנבחר  הרץ  בשדות המרחק  וכן  התחתונה,  הנתונים 
Design ,Exist ו- Dist  .אשר בחלון מימין 

 

כיתוב הגבהים  על הכפתור תפתח את    -(  Options)  חלון הגדרות  לחיצה 
לכיתוב  האוטומטיות  ההגדרות  נקבעות  זה,  בחלון  הגבהים.  הגדרות  חלון 

באופן , ניתן להוסיף גבהים  2הגבהים על גבי השרטוט )כמוסבר בסעיף הקודם,  
 ידני(. האפשרויות בחלון הן:

 Dibbling points-    הקיימת הקרקע  בנקודות המפגש של  גבהים  כיתוב 
 ומתוכננת.

 Turning points-    כיתוב גבהים בנקודות שבהן שינוי שיפוע חזק בקרקע
 )נקודות שבר קרקע(.

 Steps-    גבי החתך על  יכתבו  הגבהים  קבוע.  רץ  במרחק  גבהים  כיתוב 
 שיקבעו בשדה. במרחקים הרצים

 
, מופיעים  Colorבשדות הצבעים המרוכזים תחת הכותרת    -שינוי הצבע של שכבות החתך

צבעי השכבות של החתך. לחיצה על ריבוע הצבע של השכבה תפתח את חלון הצבעים של 
. צבע השכבה ישתנה בשרטוט Apply. בחלון בחר את הצבע הרצוי ולחץ  CivilCAD 10  -ה

 בהתאם. 
 

 לחיצה על הכפתור תפתח חלון מצד ימין. בחלון הזן קנה מידה לגובה -ךהדפסת החת 
 (Height( ולאורך )Long של החתך. לחץ על כפתור )OK .להדפסה   
 
החתךבנ לשרטוט  שונה  צירים  ראשית  לקבוע  ניתן  אם   -New origin  -וסף 

ברצוננו להדפיס את החתך, שלא בפינה השמאלית התחתונה )ראשית הצירים( 
נוכל לקבוע לנו ראשית צירים חדשה. ראשית הצירים החדשה תינתן של הדף  ,

 . Yובכיוון   Xביחידות מטרים, ביחס לקנה המידה של השרטוט, בכיוון  
 

לחיצה על הכפתור תפתח את חלון מימין. בחלון הכנס   -של החתך  DXFיצירת קובץ     
כנס את שם הקובץ  ה  שנפתח. בחלון הקבצים  OKקנה מידה לאורך ולגובה של החתך ולחץ  

 של החתך. DXF(. התוכנה תיצור קובץ Saveשל החתך, ולחץ שמור )
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 מודל תלת ממדי 
 

מודל תלת ממדי.    CivilCAD 10הקיים, יוצרת תוכנת  של המצב  ה  הגובבמהלך חישוב קווי  
בעזרת מודל זה מבצעת התוכנה את החתכים השונים, את חישובי כמויות עבודות העפר, וכן  

. התוכנה יכולה לאחסן Pick height  -קבלת גובה בנקודות רצויות על ידי פעולת המאפשרת  
מודלים בו זמנית לפרויקט בודד, אחד למצב הקיים ואחד למצב המתוכנן. במצב שבו   2  -כ
תיצור  יוי אחרת,  תכנון  צורת  כל  או  מתוכננים  משטחים  יוגדרו  מתוכננים,  גובה  קווי  וצרו 

 ל גבי מודל המצב הקיים. התוכנה מודל שני ותלבישו ע
 
 

ומתוכנן(   )קיים  מהמודלים  אחד  כל  הצגת  מאפשרת  ממדי"  תלת  "מודל  אופציית 
 בפרספקטיבה תלת ממדית. 

 
יפתח  Design -> 3D view. להתחלת האופציה, הפעל מסרגל התפריט הראשי:  1 . מימין 

 חלון הצגת המודל התלת ממדי. 
נה תחשב את המודל ותציגו על גבי חלון נפרד.  בחלון הימני. התוכ  Apply. לחץ על כפתור  2

לחיצה על כפתור שמאלי )בעכבר( בתוך השרטוט תתקרב אליו, וכפתור ימני תתרחק ממנו.  
כפתור   השרטוט.  את  לגלול  מנת  על  הגלילה  בפסי  להשתמש  כל    Applyניתן  את  יציג 

 השרטוט.
 

 אפשרויות נוספות לשימוש בחלון: 
 
את המודל של   CivilCAD 10כברירת מחדל, מציגה תוכנת    -. הגדרת אזור הצגת המודל1

 First   -של חלון האזור המיועד להצגה מופיעות בשדות ה  קואורדינטותהכל שטח הפרויקט.  
corner ו- End corner  שבחלון מימין. ניתן להגדיר חלון ספציפי שבו יחושב המודל. לשם כך

 ניתנות שתי אפשרויות:
בפינות החלון. הגדר את נקודות התחום של    טותקואורדינהשינוי ידני של   

. המודל  Applyהחלון, פינה שמאלית תחתונה ופינה ימנית עליונה, ולחץ  
 שיוצג יהיה על פי התחום שהוגדר.

גבי השרטוט  על  )"   -סימון החלון הרצוי  וי   Window  -"( בשדה הVסמן 
פינה   הרצוי,  החלון  את  בחר  השרטוט.  לאזור  ועבור  הימני  שבחלון 
את   תעדכן  התוכנה  עליונה.  ימנית  ופינה  תחתונה  שמאלית 

שבשדות מימין, ותציג את המודל התלת ממדי של החלון    קואורדינטותה
 שנבחר.

הפרויקט2 שטח  לכל  הגבולות  החזרת  ע"י    ושונאם    -.  או  הפרויקט,  או  Windowגבולות   ,
ידי לחיצה על כפתור    קצוות הפרויקט לשדות על  קואורדינטותידנית, ניתן להחזיר את  ה  בצור

E . 
בשדה זה ניתן להחליט על מקדם עיוות המודל התלת ממדי   -Height factor  -. מקדם גובה3

 " הנו מקדם  ברירת המחדל של השדה  "ימתח" 1לגובה.  העיוות,  ככל שנגדיל את מקדם   ."
המודל בכיוון האנכי. במצבים שבהם הפרשי הגובה בפרויקט קטנים, הגדלת המקדם תגרום  

שינוי לי לאחר  קיצוני.  יותר  באופן  יורגשו  הגובה  שהפרשי  כך  לגובה  הקרקע  עיוות  צירת 
 לקבלת המודל מחדש. Applyהמקדם לחץ 
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יוצרת מודל    CivilCAD 10תוכנת    -Extrapolate borders  -. ביצוע אקסטרפולציה לגבולות4
במצב   א  שבומלבני.  עיהמודל  למלבן  הגבולות  את  התוכנה  מלבני, משלימה  ביצוע  נו  ידי  ל 

מודל  לקבלת  גורמת  שלעיתים  אסתטית,  חשיבות  זו  לפעולה  גבהים.  של  אקסטרפולציה 
 . Apply"(, ולחץ שוב על כפתור Vשאינו מדויק. לביטול האקסטרפולציה הסר את סימון הוי )" 

כברירת מחדל, מציגה    -Layer- Exist/Design  -. החלפה בין מודל מצב קיים למצב מתוכנן5
מודל הקרקע המתוכננת. במצב שבו אין מודל קרקע מתוכננת )אין תכנון(, תציג  התוכנה את  

ומתוכנן(,   )קיים  בפרויקט  מודלים  שני  קיימים  זאת  בכל  אם  הקיים.  המצב  את  התוכנה 
  -ל  Designשבחלון, ממצב    Layer  -וברצוננו לאלץ צפייה במודל הקיים, נעביר את שדה ה

Exist ונלחץ ,Apply  . 
יוצרת צפייה במודל מכיוון כניסה "קדמי"   -Direction  -ייה. כיוון הצפ6 , לפי  Front  -התוכנה 

ה זה  צפייה  כיוון  הצפייה  יהגדרתה.  זווית  את  לשנות  ניתן  הפרויקט.  של  הדרומי  הכיוון  נו 
מתוך   לאחד  האפשריים  4במודל  ימני/Frontחזיתי/  -הכיוונים   ,Right/אחורי  ,Rear  ,

 לקבלת השרטוט המחודש. Applyיש ללחוץ . לאחר שינוי השדה Leftשמאלי/
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 חישוב נתוני דיסטומט  :11פרק 
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 חישוב נתוני דיסטומט 
 

הפרק שלפניכם דן באופן חישוב נתוני תצפיות )מרחקים וזוויות( אשר התקבלו ממכשיר 
מספקת כלי נוח וגמיש להפעלה, אשר בעזרתו ניתן לערוך   CivilCAD 10הדיסטומט. תוכנת 

בליווי דו"ח   קואורדינטותלבצע שינויים ותאומים שונים ולחשב את קובץ ה נתוני דיסטומט,
 מפורט. 

 
 הנושאים עליהם נדון בפרק זה:

 
 הפעלת חלון הדיסטומט.  
 מעבר תחנות. 
 תאום צלעון.  
 . Options-פירוט חלון ה 
 פורמט הכנסת הזווית. 
 פרוט הפעולות בחלון הדיסטומט. 
 תאום צלעון.  – 1נספח  

 
 

 
 

 הדיסטומטהפעלת חלון 
 

  : על  לחיצה  ע"י  מתבצעת  החלון  מהתפריט    Geometry -> Distomat data  הפעלת 
 הראשי. 

 
 נבצע כעת תרגול קצר אשר ידגים את השימוש באפשרות זו:  

 ( File->New project)התחל את התרגול בפתיחת פרויקט חדש: 
 

של   .1 ה  Topography Coordinatesבחלון  את  התחנ  קואורדינטות נקליד  ות של 
 הידועות בצורה הבאה: 

 

CP 100 1000 1000 ST1 

CP 100 1000 2000 TRG0 

 
הכנס את הנתונים עם רווח אחד או יותר בין נתון לנתון. לכל נקודה ידועה הכנסנו את 

)  קואורדינטותה וקוד  Y,X,Zשלה   )CP  –  ( כידועה  הנקודה  את   Controlהמסמן 
point .) 

 
 . Geometry->Distomats dataיצה על ע"י לח Distomats dataעבור לחלון  .2
 
המכשיר  .3 וגובה  התחנה  שם  את  והקלד  בטבלה  הראשונה  לשורה  הסמן  עם  עבור 

הכיתוב   תחת  לטור  עבור  הבאה:    לטור   ,ST1והקלד    Ho./Stationבצורה  עבור 
 . 1.5והקלד  Ve./Heightתחת הכיתוב 
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ות ריקות לפניה ככלל, שורה ראשונה תהיה תמיד התחנה )אין חשיבות אם ישנם שור
 בטבלה(. 

 
נקודה זו תשמש כנקודת אוריינטציה   –בשורה הבאה הקש את התצפית הראשונה   .4

(Backsight)  בטור תחת הכיתוב :Name    הקלדTRG0    ובטור תחת הכיתובHo 
 .  2500302הקלד 

 
  2500302–הנה האוריינטציה לפי כיוון    TRG0משמעותה של שורה זו היא שנקודה  

ללא רווחים, פסיקים, או נקודות   2500302  -הוכנסה כ  (Ho)ופקית  אליה. הזווית הא
פורמט הכנסת הזוויות בהמשך(. בעמודה   פירוט על    - 0951010הכנס    Ve)ראה 

  –  Prismמרחק משופע ובעמודה    –  Slope dist.  –  1005הזווית האנכית, בעמודה  
 גובה הפריזמה. –  1.6
                  

 ורה הבאה:הקלד את המשך הרשימה בצ .5
 

  1.5 ST1  

1.6 1005 0951010 2500302 TRG0 

1.6 50 0901515 030210 100 

1.6 78.76 0900000 2121010 101 
     

 
 

 פעולה תקבל הודעה הבאה: ה. כתוצאה מApplyלחץ על כפתור  .6
 
 
 
 
 

 . נקבל חלון, שכולל דו"ח שגיאות ונקודות מחושבות :Okלחץ  .7
 

a.  
 
 
 
 
 
 

ב שגיאת  מרחק  קיבלנו  פרמטר שאפשר   –  Max delta L  –יקורת 
ה בחלון  בהמשך(.   Options-להכניס  נראה  החלון  של  מלא  )פירוט 

בין   0.100ברירת המחדל הינה   מ'. במקרה שלנו, מכיוון שההפרש 
( בהיטל האופקי( לבין המרחק    –מ'    0.912המרחק המדוד לנקודה 

מהפרש   כתוצאה  מ  נטותקואורדיההמחושב  ',  מ  0.100  -גדול 
 על כך.ה מתריעהתוכנה 

 
b.  קיבלנו הודעה : –תאום צלעון 

Errors have been found in 

the computations. 
Please check errors report. 

 

 ST1&TRG0שגיאה בביקורת מרחק נקודות:  

 Max delta L  = 0.100מותר  יסימלכממרחק 

 0.912הפרש המרחק = 
 1000.912מרחק מדוד אופקי = 

  1000ק מחושב = מרח



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  114עמוד 

 
 
 

אין לנו סגירה, לכן אין אפשרות    –משמעות ההודעה היא שאין צלעון  
 בסוף הפרק(.  1לבצע תאום. )להסבר על תאום צלעון ראה נספח 

 
c.   מחושבות וידועות.  –קיבנו דו"ח נקודות 
 

 . Topography Coordinates -בחלון הנוכחי עבור ל Closeלחץ  .8
 
 לקבלת התוצאה בשרטוט.   בסרגל הראשי Refreshלחץ  .9

 
 . Distomat1שמור הפרויקט בשם   .10

 
 
 
 
 
 

 מעבר תחנות 
 

חישוב ה והמשך  פרויקט מעבר תחנות  באותו  לבצע  ניתן  כיצד  נלמד    קואורדינטות כעת 
 מתחנה חדשה. נדגים על גבי הפרויקט שהובא בתחילת הפרק: 

 
הפעל:     .1 שהכנסנו  מסך Geometry-> Distomat dataבפרויקט  יופיע,  לפניך   .

 הנתונים.
 
נוסיף כעת נתונים חדשים. אם קיים צורך, הוסף שורה ריקה אחרי השורה האחרונה  .2

לחיצה   )ע"י  בטבלה   של  כפתור  על  או    ENTERעל  שהקלדת  נתונים  הכנס   .)
 שוב על מנת ליצור שורת רווח. Enterלחץ  ST2נקודת 

 
 הבאה:השלם הטבלה בצורה  .3

 

  1.5 ST1  

1.6 1005 0951010 2500302 TRG0 

1.6 50 0901515 030210 100 

1.6 78.76 0900000 2121010 101 

 100.5 0803040 0402015 ST2 

     

  1.6 ST2  

1.6 100.5 2205054 2204532 ST1 

1.6 25 0752101 0402211 103 

1.6 49.25 0900530 0500304 104 

1.6 85.56 0801020 2100503 105 

VTPV = No adjustment 
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 : כאשר מבצעים מעבר תחנה יש להכניס שורת רווח )אחת לפחות(.  הערה
 

הודעה זאת אומרת   –  Yes to All  –ו    Ok. בהודעה המתקבלת לחץ  Applyלחץ    .4
, כלומר התוכנה זיהתה כי הנקודות שחושבו מתחנה קואורדינטותצעו שינויים בושב

ST1  מחדש. בנוסף להודעת השגיאה שהייתה לנו   קיימות כבר ברשימה ולכן יחושבו
 בדוגמא הקודמת התווספה לנו עוד הודעה: 

 
 
 
 
 
 

 
)הגדול מהמותר במקרה שלנו   1.375משמעותה של ההודעה היא שקיים הפרש של  

–  Max delta L = 0.100  בין המרחק המדוד מנקודה )ST1  ל-ST2    למרחק המדוד
 . ST1 -ל ST2החוזר מ 

 
ו  Closeלחץ   .5 הבדו"ח  ולחץ Distomats data-בחלון  הראשי  לחלון  עבור   ,

Refresh   .להצגת הנקודות בשרטוט. שמור פרויקט 
 

 
 תאום צלעון 

 
נקודות  יוצאים משתי  כאשר  רגיל  פתוח  נתחיל בצלעון  צלעון.  עם תאום  עבודה  נדגים  כעת 

 ידועות וסוגרים בשתי נקודות ידועות. 
 

  Traverse – 4CP.prj לצורך הדוגמא פתח פרויקט קיים: .1
 

 
 נמצא במיקום ברירת המחדל:  פרויקטה Windows 7/8/10במערכת הפעלה 

C:\ProgramData\SivanDesign\CivilCAD\Samples\Traverse-4CP \ 
 

 
 . Geometry->Distomats data -כנס ל .2
 
.  Applyשים לב, באיזו צורה הנקודות מסודרות )רווח בין כל מעבר התחנה(. לחץ   .3

 ת שקיבלנו: ננתח את השגיאו
a.  

 
 
 
 

 ST1&ST2: מרחקים מדודיםשגיאה בביקורת 
 Max delta L  = 0.100מותר  ימקסימאלמרחק 

 1.375הפרש המרחק = 
 ST1-ST2  =99.125מרחק מדוד 

  ST2-ST1  =100.500מדוד מרחק 

 48R&25Rאי סגירה זוויתית בצלעון שגיאה בביקורת 

 = Max bearings differenceאי סגירה מותרת 

10.000 

 °0’’45’00אי סגירה זוויתית =
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. אי   25Rונסגר בנקודה   48Rהתוכנה איתרה צלעון המתחיל בנקודה 
)נתון שמכניסים ב  °0’’10’00הסגירה הזוויתית המותרת במקרה שלנו היא 

– Options ב- Max. bearings difference ( בצלעון הנ"ל .)48R & 25R  )
כך )ראה פירוט  על ה התרע. לכן קיבלנו °0’’45’00התקבלה אי סגירה של 

 בהמשך הפרק(. Options-של חלון ה
 

b.   48שתי הודעות נוספות מתייחסות לאי סגירה קווית באותו צלעוןR&25R  
   Max. linear difference (e(Y)נתונים  Options-. בחלון הX -ו Yלפי ציר  

בהמשך(. נסו לשנות    Options-)ראה פירוט של חלון ה0 -( שווים לe(X) -ו
 .  Applyלו ותראו את ההבדל לאחר לחיצת את הערכים הא

 
c.  שים לב לנתוןTraverse iteration   ו3ששווה ,-  VTPV    ראה הסבר בנספח(

דו"ח חישוב הכולל את כל התחנות    -דוחות 2בסוף הפרק(. כמו כן קיבלנו  1
השגיאות לכל תחנה )ראה  אליפסת, תיקון מרחק וערכי זווית, עם תיקון 

 ודות מחושבות.הסבר בהמשך( ודו"ח נק
 

 
 Refresh, עבור לחלון הראשי ולחץ Distomats dataבדו"ח ובחלון ה Closeלחץ  .4

 לקבלת הנקודות בשרטוט. 
 

צלעון היוצא משתי נקודות ונסגר באותן הנקודות.   -הדוגמא הבאה תתייחס לצלעון סגור 
 .Traverse_round_4CP.prj)צלעון טבעת(  נדגים הנושא על פרויקט קיים בשם 

 
 
 

 . Traverce_round_4CP.prjפתח פרויקט  .1
 
 . Geometry->Distomats data -עבור ל .2

 
 
ח נקודות  " נקבל דו"ח חישובים, הפעם ללא שגיאות )התראות(, כולל דו – Applyלחץ  .3

 מחושבות עם תיקון מרחק וזווית. 
 
ע"י לחיצת כפתור  Options-, עבור לחלון הCloseסגור חלון הדו"ח ע"י לחיצה על  .4

במקום   100-ושנה אותו ל Max bearings differenceעבור לנתון ליד כיתוב  .
ה התרעלקבלת חישובים חדשים. קיבלנו  Applyולחץ  Options. סגור חלון של 500

. בתחילת הדו"ח קיבלנו הודעת שגיאה על Yes to all -ו Okעל קבלת שגיאות, לחץ 
 Max bearingsבפרמטר  Options-אי סגירה זוויתית כתוצאה מהשינוי שביצענו ב

difference גדול מהפרש אותו   ’’19’0°02. רואים שההפרש הזוויתי, שקיבלנו
 . 100’’ -אפשרנו 

 
 
 . Closeסגור חלון הדו"ח בלחיצת   .5
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 Preview traverse) עבור לצפייה בתרשים הצלעון ע"י לחיצת כפתור   .6
diagramיק שמאלי וימני (. על מנת לקרב או להרחיק את השרטוט השתמש בקל

שמאלה/ימינה/למעלה/למטה השתמש בפסי   בעכבר בהתאם. להזזת השרטוט
גלילה. הנקודות הידועות מוצגות כמשולש, והנקודות המחושבות מופיעות כאליפסות 

(. ניתן לבצע הדפסה של המסך, או לשמור  1)ראה פירוט אליפסת השגיאות ב נספח 

 .  -ו ע"י לחיצה על  Dxfאת השרטוט בקובץ 
 

בדוגמא האחרונה שלנו נראה את המקרה של צלעון הנסגר בנקודה אחת בלבד. התנאי 
 כיוון ומרחק מתחנה הידועה לנקודה הקודמת)*(:  –ההכרחי לצלעון מסוג זה 

 
 

 ידועות   -  
 מחושבות  -  

 
                  )*( 

        

 
 
 

            
 
 

ה משתי נקודות וסגירה בשתי נקודות נשתמש בדוגמא שלנו עם יציא
(Traverse_4CP.prj נמחק נקודה ידועה אחת מתוך .Topography coordinates   בשם

25Rבחלון    , ומתוך רשימת התצפיות– Distomats data   נמחק את כל השורות החל
ח והחישוב. רואים שהחישוב אפשרי,  " לקבלת הדו  Apply. נלחץ 24Rמתחנה אחרונה 

ח הנקודות. לצפייה בתרשים הצלעון לחץ  " שתי הודעת שגיאה על אי סגירה קווית ודוקיבלנו 

. 
 

 Options-פירוט חלון ה
 

של ביצוע החישובים. כניסה להגדרות  Options -להלן נפרט את אופציות חלון השבהסבר 

 . Distomat data -שבחלון ה   Options -אלו ניתן לבצע על ידי לחיצה על כפתור ה

 
 Working units –  :הגדרת יחידות העבודה 

בגראדים ניתנות לעבודה   זוויותאפשרות לעבודה במעלות או גראדים.  – זוויות 
 עם/בלי נקודה עשרונית. 

 אפשרות לעבוד עם מטרים או סנטימטרים.  –מרחק  
 

 Traverse iteration התכנסות האיטרציות שהתוכנה מבצעת לצורך  מספר
. במקרה ובו  איטרציות 3ברירת מחדל הינה  – Auto   תאום צלעון.הפתרון בתהליך 

 . 3-קבוע מספר גדול מ, ניתן להפתרון מתכנסהמשתמש מניח כי 
 

 Standard deviation   



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  118עמוד 

 Bearings precision  (STDD )–  דיוק זה מושפע   .בודד כיוון דיוק קריאת
, דיוק הקליע לעבר הקריאהממספר גורמים ומורכב ממספר שגיאות כגון: דיוק 

הפריזמה, תנאים אטמוספריים, דיוק הכיוון ישמש לקביעת המשקל של הזויות 
 . ’’15 -ברירת המחדל  בתהליך התיאום.

 Distance’s precision  (STDL )– דיוק זה נגזר מתהליך . מדודרחק דיוק מ
הכיול של המכשיר )קבוע הפריזמה והדיוק היחסי(. דיוק המרחק ישמש לקביעת 

 מ"מ. 25 -ברירת המחדל תתפים בתיאום. משקלם של המרחקים המש
 

 Traverse misclosure   
 Max bearings difference  –    מקסימאלית מותרת. במהלך   זוויתיתאי סגירה

סגירה  לסופו. האי  בין תחילת המהלך  זוויתית  אי סגירה  צלעון מתקבלת  תאום 
 מחושבת לפי הנוסחה:  הזוויתית

 

=

−+−+=
n

i

ni AznAz
0

0 )1(180difference bearings 
. 

 הזויות בכל תחנת צלעון.  iכאשר   
 n  .מספר עמדות הצלעון : 

 nAzAz  והסופי.  יהם האזימוט ההתחלת 0,
 
המצוינת בשדה הנ"ל    הזוויתיתסגירה  העל כל צלעון החורג מאי  תתריע  המערכת   

 (. מומלץ לשנות ערך זה בהתחשב בתקנות המדידות.’’500)ברירת מחדל 
שים לב כי התוכנה תבצע החישוב גם אם אינו עומד בנתון שהכנסנו. הנתון קובע 

   .התרעהאשר החל ממנה תופיע  הסטייהת א
 Max linear difference  – ציר  בכיוון מקסימאלית אי סגירה קוויתY   ו-X  .

המערכת תתריע במקרה של כל צלעון החורג מהאי סגירה קווית המצוינת 
 מ'(.  0.3בשדות הנ"ל )ברירת מחדל 

 Max. misclosure/ distance  –  .תתריע המערכת אי סגירה קווית יחסית
במקרה והיחס בין אי הסגירה הקווית הכוללת לבין סה"כ אורך הצלעון חורג  

 (.1/3000מהמותר )ברירת מחדל 
 

 Face Right/Left   
 Max epsilon –  ,כחלק מתהליך ביקורת על המדידות המתבצע לפני החישוב

מתבצעת בדיקת תקינות הכיוונים המדודים. התוכנה מבצעת בדיקת הפרש 
פנים שמאל לבין פנים ימין שנמדדו מאותה תחנה לעבר אותה מטרה.   כיוונים בין

במידה והפרש זה )בכיוון האופקי או בכיוון האנכי( עולה על ההפרש המכסימלי  
 . ’’100 -המותר המופיע בשדה הנ"ל תתקבל הודעת הזהרה. ברירת המחדל 

 
 Max delta L –  מקרים: לושהנתון זה מגדיר תחום התראה לש 

מדד מרחק בין שתי נקודות ידועות תתבצע בדיקה של המרחק המדוד במידה ונ 
. מקרה ובו ההפרש בין המרחק המדוד קואורדינטותמהלעומת המרחק המחושב  

)ברירת מחדל   על ההפרש המכסימלי המותר  יעלה   0.1לבין המרחק המחושב 
 מ'( תתקבל התראה על כך.

מטר  לעבר  שנמדדו  המרחקים  של  מיצוע  מתבצע  תחנה  . (x)  מסוימתה  בכל 
וימין.  שמאל  הפנים  בשני  או  פנים  באותו  תצפיות  מספר  כוללים  אלו  מרחקים 
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( מטרה  לעבר  המדודים,  מהמרחקים  אחד  בין  והפרש  ממוצע xבמידה  לבין   ,)
 המרחקים יעלה על הערך המותר תתקבל התראה על כך.

המדודים    המרחקים  של  הממוצע  או  המדוד  המרחק  בין  ההפרש  ובו  מקרה 
אחת  מנקו מהנקודה    לשנייהדה  החוזר  על   השנייהוהמרחק  עולה  לראשונה 

 ההפרש המכסימלי המותר. 
 

 Max orient. difference –  ביקורת אוריינטציה בתחנות ידועות אשר מהן נמדד
ון לעבר שתי תחנות ידועות או יותר. בבדיקה זו יחושב בשלב הראשון כל אחד וכי

הידועות. בשלב שני  קואורדינטותבוך שימוש מהאזימוטים לעבר התחנות הידועות  ת
מתבצע חישוב של הזויות בין הכיוונים המדודים. בשלב האחרון מחושבות הזויות 

 זוויתבין  הזוויתיהתואמות תוך שימוש באזימוטים מהשלב הראשון במידה וההפרש 
מחושבת מהפרש כיוונם עולה על   זוויתמחושבת מהפרש אזימוטים לבין אותה 

 . התרעה( תתקבל ’’100ברירת מחדל המותר )
 

 Max height difference –  בדיקת ביקורת גבהים בין שתי נקודות ידועות. אם
הפרש הגבהים בין הגובה המדוד והגובה הידוע )של נקודה ידועה( גדול מההפרש 

 .ההתרעהתוכנה תיתן  –מ'(   0.2המותר )ברירת מחדל 
 

 Report– רשימת הדוחות אשר יוצגו למשתמש. 
 Non computed points – ח הנקודות שלא חושבו." התוכנה תציג דו 
 Traverse adjustment  –  :דו"ח תאום צלעון 
 Full report –  גם את  , דו"ח החישובים יכלול, בנוסף לתחנות והנקודות הידועות

 נקודות הטופוגרפיה, כולל התיקונים שלהן.
 semi-major|semi-manor –  גיאות של כל  הצגת פרמטרי אליפסת הש

-חציהגדול ו הציר-חציהינם  semi-manor -ו semi-majorנקודה ונקודה. 
 הקטן של אליפסת השגיאות. הציר

 ΣY| ΣXY ΣX| - קואורדינטותדיוק ה X,Y   והתלות ביניהן )ראה הסבר
 , אליפסת השגיאות(. 1בנספח 

 Points –  .התוכנה תציג את דו"ח הנקודות 
 

 Display   
 Max. distance  – לי של נקודה להצגה בתרשים הצלעון אהמרחק המכסימ

מ' לא יוצגו  2000-כל נקודות במרחק של יותר מ – 2000)אם, לדוגמא מכניסים 
 בתרשים אלא באופן סכמטי(.

 

 ת זוויפורמט הכנסת  
 

 עבודה במעלות  .1
 

  3, זאת אומרת:   DDDMMSSאנכית תוכנס בפורמט:   זוויתאופקית והן   זוויתככלל, הן 
 ספרות לשניות.  2ספרות לדקות,  2למעלות,  ספרות

שניות(.  30  –דקות ו  32מעלות,  5)ז"א   53230,    2122012,    1732012דוגמאות:  
הספרות לשניות ולדקות הן חובה,   2המספרים יוכנסו ללא רווח, פסיק, או נקודה ביניהם. 

חד: במקרה שיוקלדו פחות  ספרות. לכלל זה יוצא דופן א 3או   1,2בעוד למעלות ניתן להקליד  
  173לכל הזויות( יקרא המספר שיוכנס כמעלות בלבד )הקלדת   –ספרות )סה"כ  5 –מ 
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נה אפשרות ואין  יה 0(. מכאן שהקלדת 1730000 –מעלות בדיוק  173 –לדוגמא, יפורש כ  
 . 00000הכרח להקליד 

 
 עבודה בגראדים .2

 
שרות לבצע זאת עם או בלי נקודה  דים יוקלדו הזויות בצורה עשרונית פשוטה. יש אפאבגר

 (.Options -עשרונית )יש לסמן האופציה המתאימה בחלון ה
 עם נקודה עשרונית.   –וכו'   89.7231, 135.2315לדוגמא:   

 ללא נקודה עשרונית.  -  897231, 1352315    
 

ספרות מימין כספרות  4: שים לב כי בעבודה ללא נקודה עשרונית התוכנה קוראת הערה
 פני הנקודה.ל
 
 

 
 פירוט פעולות חלון נתוני הדיסטומט 

 
 

)אם   Excell. התוכנה תפתח את תוכנת הExcelייצוא כל טבלת הדיסטומט לקובץ     .1
 קיימת במחשב( ותמלא גיליון באופן אוטומטי עם כל נתוני התצפיות. 

 

2.   Load from text file  –  דיסטומט נתוני  מקובץ  הנתונים  זו   -  קריאת  אופציה 
ויתורגם אוטומטית    Distomatשרת קריאת קובץ נתוני  מאפ יקרא  בפורמטים שונים. הקובץ 

עריכה   עיבוד,  לצורכי  המתאימות  בעמודות  שיסודר  כך   , התוכנה  מכירה  אותו  לפורמט 
 וחישוב. 

 ניתן לייבא נתונים מקבצים בעלי הפורמטים הבאים:  
 (txt)  Text files      
  (job)  Job files      
 (*.dat/*.gt7/8.gts7) Dat files/GTS-7      
 Leica gre format 8-bit      (*.gsi/*.gif) 
 Leica gre format 16-bit      (*.gsi/*.gif) 
 Sokkia files      (*.crd/*.sdr) 

 NTS600 (*.dat ) 
 : הערות
a.  קיימים שני פורמטים של קבצים במכשיריLeica –  8  ו--bit16 (8  ספרות   16-ו

 SaifanN-16.frt(. כמו כן יש להעתיק לתוך המכשיר פורמט בשם Y -ו  Xבנתונים 
כדי לאפשר לתוכנה לקלוט נתונים ממכשירים אלה. ניתן להעתיק את הקובץ מדיסק 

 (. Utilities/Leica Geosystemsההתקנה של התוכנה)תיקיית 
b.  בעבודה עם מכשיריTopcon  יש לשמור את הקובץ בפורמטGTS-7  על מנת

 כל לקרוא את הנתונים בצורה תקינה.שהתוכנה תו
בעת קריאת הקובץ כברירת מחדל, הפעל מסרגל  תוכנהלקביעת הפורמט בו משתמשת ה

. לאחר בחירה  Configuration. יפתח חלון File -> Configurationהתפריט הראשי:  
ניתן לשנות את סוג הפורמט שבו תשתמש התוכנה ע"י בחירה  File-settingsבלשונית 
   Save/Load from text fileימה: מהרש
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כדי לקבוע פורמט שישמש כברירת מחדל, ז"א שישמש את כל הפרויקטים, יש   - )להזכירך
 ולשנות שם את האופציה הנ"ל(.   Prototypeלהיכנס לפרויקט 

 להלן רשימת הפורמטים האפשריים: 
 

 Standard ASCII -  קריאת הקובץ בצורתו המקורית כפי שיופיע בכלeditor  של
Dos .ללא כל שינוי 

 Geodimeter-Geotool -  קריאת קובץjob/are   אשר נקרא ממכשיר ה– 
Geodimeter  כנת התקשורת ובעזרת תGeotool . 

 Pentax – Sc5/CMT Mc II  (Kermit) -  קריאת קובץ אשר הועבר מה– data   
collector –  Sc5  של מכשיר ה–  Pentax  בעזרת תכנתKermit  .או דומיה 

 Pentax – Dc – 1Z - קריאת קובץ אשר הועבר מDCIZ – data collector  של ,
 או דומיה.  Kermitבעזרת תכנת  Pentaxמכשיר 

 TopCon – 210 - כנת תקשורת וקריאה מקובץ שנוצר בעזרת תTopComm   
 תוכנה, הConvertor –. )הערה: אין צורך בשימוש ב TopCon – 210ממכשיר 

 שהועבר(. תקרא ישירות את הקובץ
 TopCon-Fc5 -  כמוTopCon210  רק לגבי הFc-5 data collector . 
 Hp-48/Topcon_700 -   קריאת קובץraw כנת תקשורת  ואשר נוצר בעזרת ת

 . Hp-48 –סטנדרטית להעברת קבצים מ 
 Topcon_700- Dat files –  קריאת קובץDat   אשר ניתן לקרוא ישירות מתוך כונן

 . Topcon_700מדגם  ( של מכשירPCMCIAניתק )
 Topcon_2102 –  תקשורת  תוכנתקריאה מקובץ שנוצר בעזרתTopComm  

 . Topcon -. ההבדל הוא בסוג ההעברה מתוך הTopCon - 210ממכשיר 
 NTS600  –   קריאת קובץDat  של מכשיר מדגםNTS600  של חברתSouth . 

 

3. Save as text file   –    שמור את הנתונים בקובץText  -  צה על הכפתור  לאחר לחי
נקי   Asciiתופיע תיבת דו שיח קבצים. נתוני הדיסטומט ישמרו בקובץ שיקבע בפורמט  

 לדוגמא(. Dos  –)לצרכיי עבודה ועיבוד ב 
 

4. Print   –   הדפסת קובץ הנתונים. ככלל עדיף יהיה להיכנס לדו"ח שהתקבל כתוצאה
 מהחישוב ולהדפיס אותו.  

 

5. Preview traverse diagram   –  הצלעון.  אהדיאגר   הצגת של   הדיאגראמהמה 
 (.Apply)לחיצה עם  בשו חיתוצג רק לאחר ביצוע 

 

6. Erase   -  נו קבוצת שורות ימחיקת שורה אחת או בלוק של שורות . ככלל , בלוק ה
 מסומנות. ניתן להפעיל פעולה זו גם ע"י לחיצה על כפתור ימני בעכבר. 

 
   

7. Clear all   –  מוחק את כל נתוני ה  –  distomat   הקיימים  )במידה והנתונים נקראו
 לא יפגע הקובץ המקורי(.   Load from text fileמקובץ חיצוני בעזרת 

 
 

8.   Mark all  –   סימון כל השורות. ניתן להפעיל פעולה זו גם ע"י לחיצה על כפתור ימני
 בעכבר.
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9. Insert   -    נציין רווח.  שורת  השפעהלשורת  כי  הכנסת  קיימת  בנתו  רווח  ני מכרעת 
שורה כזו באה לציין מעבר תחנה(. ניתן להפעיל פעולה זו גם ע"י לחיצה על  –הדיסטומט 

 כפתור ימני בעכבר. 
 

10  . Copy –   מעתיק שורה אחת או בלוק של שורות לזיכרון. את תוכן ההעתקה ניתן
. ניתן להפעיל פעולה זו גם ע"י לחיצה על כפתור ימני   Pasteלהדביק בכל מקום רצוי ע"י 

 בעכבר.
 
 

11  . Paste –   מדביק" את תוכן הזיכרון שהועתק ע"י"Copy  מיקום   –למקום רצוי
 הסמן. ניתן להפעיל פעולה זו גם ע"י לחיצה על כפתור ימני בעכבר.

 
 

12  . Undo –  חזור פעולה אחת אחורה. נציין שכפתור ה– Undo  כאן מתייחס רק
תן להפעיל פעולה זו גם ע"י לחיצה על כפתור  לפעולה שהתבצעה בחלון נתוני הדיסטומט. ני

 ימני בעכבר.
 
 

13  . Report –  .צפייה בדו"ח חישוב נתוני הדיסטומט 
 
 
 

14  . Options –   פתיחת חלון ה–  Options  שלDistomat data . 
 
 

15.Intersection 2 distances    - חיתוך שני מרחקים. פעולה זו מאפשרת חיתוך  
ות בעזרת מרחק נתון לכל אחת מהנקודות. לחיצה על הכפתור תפתח משתי נקודות ידוע 

מימין את חלון החיתוך משני מרחקים. אל חלון זה יועתקו באופן אוטומטי הנתונים עליהם  
 אנו עומדים לבצע את החיתוך:

של התחנה( יכנס  קואורדינטותשם התחנה )ההנחה היא שברצוננו לחשב את ה -
 . New pointבתור 

כנס בתור נקודה שמאלית לכיוון והראשונה שמתחת לשורת התחנה ת הקריאה -
 .Radius1הצפייה שלנו והמרחק המדוד אליה יתורגם למרחק אופקי ויכנס לשדה 

כנס כנקודה ימנית. המרחק אליה  והקריאה השנייה שמתחת לשורת התחנה ת - 
 . Radius2יתורגם למרחק אופקי ויכנס לשדה 

ווסף תתיחושבו והנקודה  קואורדינטותה –החישוב  תבצע את Applyלחיצה על  -
שלנו כך שנוכל לבצע עליה פעולות שונות )כגון המשך חישוב  קואורדינטותלרשימת ה

 כל נתוני הדיסטומט(.
 

16  . Intersection 3 angles (Resection) –  מרחקים. לחיצה על הכפתור  3חיתוך
 כיוונים:  3 –תפתח מימין את חלון החיתוך מ 

הקריאות הראשונות מיד לאחר התחנה. הנתונים יועתקו עפ"י סדר   3חלון יועתקו נתוני ל
 Newעולה משמאל לימין כשלכל נקודה תועתק הקריאה האופקית אליה. כנקודה חדשה 
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point  תועתק התחנה. לחיצה עלApply   תבצע את החישוב ותוצאותיו יאגרו ברשימת
 נתוני הדיסטומט שלנו מתחנה זו. , כך שכעת נוכל לחשב את קואורדינטותה
 
  

. לחיצה על   Intersection 2 angels & distance –כיוונים ומרחק  2 -חיתוך מ .  17
כיוונים ומרחק. לחלון יועתקו הנתונים של שתי  2 –הכפתור תפתח את החלון חיתוך מ 

הנקודות הראשונות לאחר התחנה משמאל לימין. לנקודה הראשונה תועתק הקריאה 
והמרחק ולנקודה השנייה תועתק הקריאה בלבד )המרחק שיועתק יתורגם אוטומטית למרחק 

תחשב את התחנה  Applyתועתק התחנה. לחיצה על  New point -אופקי(. בשדה ה
 , כך שניתן לבצע עליה פעולות נוספות. קואורדינטותותוסיף אותה לרשימת ה

 
 

18  .  Distomat –  קריאת נתונים ממכשירDistomat לחיצה על הכפתור תפתח את .
חלון קליטת נתוני הדיסטומט. בחלון יש לבחור סוג הדיסטומט ממנו קוראים את הנתונים 

(Topcon, Sokkia, Pentax  ( את מספר הפורט במחשב ,)'וכוCom1,Com2 ...( שאר ,
  וכו'(. אחרי Max speed, Parityלהגדרות במכשיר עצמו ) ותזה להיות  חייבותההגדרות 

בחלון ולהתחיל בשליחת הנתונים במכשיר.  Receiveשבחרנו את כל ההגדרות יש ללחוץ 
את המספרים   Status: Receivingתוך כדי הורדת הנתונים נראה בחלון מתחת לשורה 

 זה הסימן שהנתונים עוברים למחשב.   –הרצים 
 

Apply 
 .   לחיצה על כפתור זה מבצעת חישוב הנקודות, ומציגה דו"ח. 19
   

Close 
 . סגור החלון. נתוני הדיסטומט יושארו בזיכרון ויהיה ניתן לחזור אליהם בכל זמן רצוי. 20
 
. ניתן להקפיא נקודות, שלא ישתתפו בחישובים ע"י לחיצה על קליק ימני בעכבר )לעמוד 21

או ע"י לחיצה   Freeze pointsבאותה שורה שאותה רוצים להקפיא( ובחירת אופציה 
. הצבע של השורה שהקפאנו משתנה, ניתן לשחרר את ההקפאה Frהנקרא פעמיים בטור 

. כדי לשחרר Frאו לחיצה פעמיים בטור  Unfreeze pointsע"י אותה פעולה, רק לבחור 
 . Unfreeze all points  את כל הנקודות )במידה והקפאנו את כולן( ע"י בחירה

 
שיש צורך בהצגתן  אורדינטותקובמקרים בהם נדרשת מדידה "דו ממדית" )מדידה של . 22

במפת המדידה אך ללא התחשבות בהן בבניית המודל התלת ממדי(, ניתן להגדיר גובה  
 פריזמה

  ’Geometry→Distomat Data‘  במכשיר המדידה, לאחר פריקת התצפיות לחלון -99 –כ 
יזמה שהוגדר עבורן גובה פר קואורדינטותלחישוב התצפיות, כל ה  ’Apply‘ולחיצה על כפתור 

 (. 0.00יתקבלו ללא גובה ) –זה 
באמצעות לחיצה על   קואורדינטותברשימת ה 0.00ניתן לאתר את כל הנקודות בעלות גובה 

 .  ’Find‘כפתור 
 Find‘וללחוץ על כפתור   0או  0.00להגדיר חיפוש ע"פ גובה מדויק, להזין גובה  Findבחלון 

All’. 
 יסומנו בכחול.  0.00ובה אשר להן ג קואורדינטותכל הנקודות ברשימת ה
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 Blockליד המילה  ”V“על מנת שנקודות אלה לא תחושבנה במודל התלת ממדי, יש לסמן 
  ’Freeze current line\block‘(, ולאחר מכן ללחוץ על כפתור קואורדינטות)מימין לרשימת ה

. 
 שמציין כי הנקודות הוקפאו.  <.Fr>ליד שם הנקודות יופיע הכיתוב 

דל התלת ממדי, נקודות אלה תופענה ע"ג המסך אך לא יילקחו בחשבון בעת בעת בניית המו
 בניית המודל.

 
 

 תאום צלעון קשיח - 1נספח 
 

 אופן החישוב 
 התוכנה מאתרת את כל המהלכים הקיימים.  ▪
 סוגי המהלכים המוגדרים כדלקמן: 3-כל מהלך מאופיין כאחד מ ▪

o  צלעון פתוח 
o  צלעון הנסגר לנקודה אחת בלבד 
o סגר לשתי נקודות ידועות צלעון הנ 

התוכנה ממשקלת את כל המהלכים ומביאה לתאום קשיח כולל של כל הצלעונים  ▪
 אז של צלעון בודד.  –במדידה. במידה ויש צלעון בודד 

 2 -יציאה משתי נקודות לא ידועות וסגירה ב –התוכנה יכולה לטפל גם במהלך הפוך  ▪
 פתוח(.  נקודות ידועות )צלעון זה יאופיין כמובן כצלעון

בנוסף מטפלת התוכנה גם בצלעונים מסוג טבעת )צלעון שנקודות המוצא הן גם   ▪
נסגר לנקודה ידועה או  –נקודות הסיום( ומאפיינת אותה לאחד משני המקרים מעלה 

 לשתי נקודות ידועות. 
 
 

 סוגי צלעונים 
 

ל שתי הינו הצלעון הכי פשוט שניתן למדוד בשטח. צלעון מסוג זה מבוסס ע  צלעון פתוח
נקודות ידועות ואינו מומלץ מכיוון שאין כל ביקורת על המדידות, במילים אחרות שגיאה גסה  
באחת מהצלעות או הכיוונים תגרום לתוצאה רחוקה מהאמת מבלי שתהיה אפשרות לזהות 

זאת. הדיוק של הנקודות החדשות ילך ויקטן ככל שהצלעון יהיה יותר ארוך מסיבה של  
 הצטברות של שגיאות.

 
 

 
 

Figure A-1, Open polygon 
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מאפשר מידה מסוימת של ביקורת על התוצאות ובנוסף   צלעון הנסגר לנקודה אחת בלבד
. במילים אחרות, אם נחשב את  Cעל צלעון זה לקיים שני תנאים של סגירה קווית בנקודה  

כצלע הזה  לנקודה  הצלעון  נתייחס  כאשר  חופשי,  רוצים,     Cון  היינו  ידועה  לא  כנקודה 
ה"אמיתיות" או הידועות של נקודה    קואורדינטותיהיו זהות ל  Cשל הנקודה    קואורדינטותשה

שגיאה מסיבות רבות התלויות במכשור, תנאי עבודה,    חסרותזו. מכיוון שהמדידות הן אינן  
הפרשי נקבל  אנו  וכו',  המפעיל  במיומנות  נקודה    קואורדינטותם  של  לעומת    Cהמחושבות 

נקודה   את  לאלץ  דואג  התיאום  תהליך  נקודה.  אותה  של  הידועות  במקומה    Cאלה  להיות 
דיוק מדידות   וזוויות לפי משקלים המחושבים על סביב  הנכון תוך תיקון המדידות )מרחקים 

 אלו(.
 
 

 
 
 
 

Figure A-2, type II, Close polygon to single Known point at the end 
 

ידועות נקודות  לשתי  הנסגר  שני D  -וC)  צלעון  על  אחד  תנאי  עוד  להוסיף  מאפשר    )
התנאים שהצלעון הקודם אפשר. תנאי זה קשור לאזימוטים וכיוונים המדודים. בעזר אזימוט 

אולם אזימוט זה, צפוי    CDהקו    המוצא והזוויות )הכיוונים( בכל תחנה ניתן לישב את אזימוט
מ שונה מהאזימוט המחושב  איD-ו  Cנקודות    קואורדינטותלהיות  נקרא  זה  הפרש  סגירה -. 

סגירה זו הינה בגדר המותר, לאחר תיאום הצלעון היא תפוזר על הזוויות  -זוויתית. במידה ואי
 המדודות בכל תחנה. 

 
 

Figure A-2, type II, Close polygon to couple Known points at the end 
 

בזמן העבודה בשטח מומלץ לבצע מדידות נוספות מעל הנדרש, לדוגמה, מודד העומד מעל  
לנקודות    3pתחנה   ל    4P-ול  2Pמודד  מודד  גם  הוא  ביקורת  1P  –אולם  מוסיפה  זו  מדידה   .

 דיוק התוצאה בחלק מהנקודות.  למדידות ועשויה לשפר את 

Az0 = Start Azimuth 
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התנאים כל  את  אוטומטית  בצורה  מזהה  הקשיח  התאום  מערכת   תהליך  ובונה  האפשריים 
שהפתרון   היא  הדרישה  כאשר  תנאים  עם  מדידות  תיאום  מסוג  הוא  התיאום  משוואות. 

 .  Minimum Least Squareועי התיקונים" של המדידות או שמתקבל יענה על "מינימום ריב
 

יעמוד בתנאים מסויימים   מסוימתתקנות המדידה של כל מדינה מחייבות שצלעון מדרגה 
בביקורת הכיוון וביקורת המרחק )אי סגירה קווית ואי סגירה זוויתית(. כפי שכבר הוסבר, 

עמידה בתנאים כפי שהוזנו על על ה עמתריהתוכנה מבצעת חישובים כמעט בכל תנאי אך 
. עם זאת, במקרה ואי סגירה זוויתית חורגת באופן ברור  Options -ש בחלון הידי המשתמ

 * W1 < 5מתחום הסביר, לא תבצע התוכנה חישוב. תחום הסביר מוגדר בתוכנה כדלקמן:  
45 * (n)^0.5 כאשר ,W1  הינה אי הסגירה המתקבלת ו- n  הינו מספר מעברי התחנות

 לעון.  בצ
 

Az0 = Start Azimuth 
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 אליפסת השגיאות 
 

 יך התיאום מחושבים הדיוקים לנקודות החדשות:כתוצאה מתהל

ΣX -    מתאר את דיוק הקואורדינאטהX . 

ΣY  -    מתאר את דיוק הקואורדינאטהY . 

ΣXY-   קואורדינטותמתאר את התלות ה X ו-Y . 

 

 לדוגמא:

 

X = 302341.23 +/- 3Cm 
Y = 122555.20 +/- 4Cm 

 
ΣX = 3Cm 
ΣY = 4Cm 

 

המתבטאת   קואורדינטותונניח שקיבלנו גם שישנה תלות בין ה

 )וואריאנס קווריאנס(. ΣXY = 0.5Cm -ב

 .  ΣXY = 0ניתן למצוא שני כיוונים ראשיים עבורם מתקבל 

בהינתן שני ערכי קיצון אלו ניתן להגדיר את דיוק הנקודה 

 .במרחב ע"י אליפסת השגיאות

 

 . 95%טחון של בת לפי רמת ב: אליפסת השגיאות מחושהערה

 

: קיימת הסתברות של אליפסת השגיאות סביב נקודה מסוימת מוגדרת באופן הבא

הנכונות של נקודה זו נמצאות בתוך האליפסה שהצירים הראשיים   קואורדינטותשה 76.18%

 (.STDש.ר.ב )-שלה שווים לערכם המכסימליים של ה

 

 בהתאמה. Y-ו Xהם דיוק הערכים של אינם תיקונים.   MX , MYהערה: הערכים של 

Semi-
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 הודעות שגיאת מערכת לתאום צלעון 
 

במהלך החישוב התוכנה מבצעת בדיקות גובה, הפרשי זווית והפרשי מרחק ומוציאה הודעות 
שגיאה כאשר המדידות ו/או הצלעונים )במידה ויש כאלה( חורגים מתנאים מסוימים )הפרש 

 וכו'(. להלן הודעות השגיאה שהמערכת מציגה: וויתקגובה מכסימלי, אי סגירה זוויתית או 
 

ההפרש בין המרחק המדוד למרחק המחושב או ההפרש בין מרחק קדימה ומרחק  ▪
 (. Max delta Lחוזר בין נקודות גדול מהמכסימלי המותר )נתון 

הפרש הכיוונים פנים שמאל ופנים ימין בין נקודות בכיוון האופקי או האנכי גדול  ▪
 (.  Max epsilonתר )הנתון מהמכסימלי המו

 Maxהמותרת )נתון  זוויתיתבצלעון גדולה מהאי סגירה  הזוויתיתאי הסגירה  ▪
bearings difference .) 

 (. Max. misclosure/ distanceשגיאה בביקורת  דיוק האי סגירה בצלעון )נתון  ▪
 Max linearאי הסגירה הקווית בצלעון גדולה מהאי סגירה הקווית המותרת )נתון  ▪

difference .) 
המדוד בין שתי נקודות ידועות גדול מההפרש המחושב המותר  הזוויתיההפרש  ▪

 (. בדיקת ביקורת כיוון בין שתי נקודות ידועות. Max orient difference)נתון 
הפרש הגבהים בין הגובה המדוד והגובה הידוע גדול מהפרש הגבהים המותר  ▪

 יקורת גבהים בין שתי נקודות ידועות. (. בדיקת בMax height difference)נתון 
ההודעה מתקבלת, כאשר התוכנה לא מצליחה  –אין מספיק נקודות ידועות לקיום הפתרון 

 Topography –ברשימת הנקודות   CPלבצע תאום )לדוגמא לא סימנו נקודה ידועה בקוד 
coordinates .) 
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 חישובים גיאומטריים  :12פרק 
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 חישובים גיאומטריים 
 

(. הפרק מפרט את COGO) קואורדינטותלפניכם דן בנושא חישובים גיאומטריים על הפרק ש
. בנוסף לפרק זה הוקדשו  CivilCAD 10כל הפעולות הגיאומטריות האפשריות בתוכנת 
"תאום צלעון". חישוב גיאומטרי נוסף   -פרקים נפרדים לנושא "חישוב נתוני דיסטומט" ו

ברץ וניצב לאורך ציר אורכי,   קואורדינטותנו חישובי יהאפשרי בתוכנה ולא מפורט בפרק זה ה
חישובים גיאומטריים   -ישר או הכולל קשתות. אפשרות חישוב זו קיימת בפרק "תכנון כבישים

 לאורך ציר".
 

 הגדרות לחישובים גיאומטריים 
 

את החישובים שלה על בסיס בנק של נקודות. נקודות   CivilCAD 10ככלל, מבצעת תוכנת 
 Topography/Designedשבחלון התחתון ) קואורדינטותהו ברשימת אלו יוכנס

coordinates .כך שבחלונות החישובים הגיאומטריים נכניס את השם/מספר שלהן בלבד ,)
  קואורדינטותי בחלק החישובים הגיאומטריים, קיימות מספר אופציות המאפשרות חישוב

רשימת  – קואורדינטותעובדת עם שתי רשימות של  CivilCAD 10חדשות. תוכנת 
של  קואורדינטות( ורשימת Topography coordinatesשל המצב הקיים ) קואורדינטות

של המצב המתוכנן  קואורדינטותה(. רשימת Designed coordinatesהמצב המתוכנן )
שימושית בעיקר במקרים של חישובי כמויות ו/או תכנון, ומכאן שבמרבית המקרים של 

 ם לא נשתמש ברשימה זו כלל. חישובים גיאומטריי
אם אילו מהרשימות ברצוננו לעבוד וביכולתנו   CivilCAD 10אנו יכולים להגדיר לתוכנת  

 להגדיר אף עבודה משולבת בין שתי הרשימות:
 
ן יפתח  י. מימGeometry -> Geometry parameters. מסרגל התפריט הראשי הפעל: 1

 חלון ההגדרות לחישובים גיאומטריים. 
 חלון מופיעות שתי מסגרות:. ב2

1 .Points use -  לעבוד )קיימת, מתוכננת או שניהם(. מעונייניםקביעת הרשימה אתה 
2 . Working units- גראדים או מעלות. -יחידות העבודה לזוויות 
 

Points use- :האפשרויות ברשימה הן 
  1 .Designed points only – המתוכננות בלבד. כל הפעולות יבוצעו על רשימת הנקודות 
  2 .Topo. Points only-  קיים בלבד.המצב הכל הפעולות יבוצעו על רשימת נקודות 
  3 .Topo. + Designed- Create designed -  לצורך החישובים תשתמש התוכנה
הקיימות בשתי הרשימות, אך כל נקודה חדשה שתחושב תיווצר ברשימת  קואורדינטותב

 . הנקודות המתוכננות בלבד
  4 .Topo. + Designed- Create topo. -   לצורך החישובים תשתמש התוכנה
הקיימות בשתי הרשימות, אך כל נקודה חדשה שתחושב תיווצר ברשימת  קואורדינטותב

 הנקודות מצב קיים בלבד. 
 

Working units -  :)יחידות העבודה )לזוויות 
העבודה יהיו בגראדים או   ויות במהלךואם הז תגדרנה שתיקבענה כאןיחידות העבודה 

במעלות. קביעות אלו ישנו גם את יחידות העבודה לחלון נתוני הדיסטומט ובכך לתצפיות  
 האופקיות והאנכיות שבו. 

 
 תבטל את השינויים שבוצעו.  Cancel. לחיצה על OKבסיום שינוי ההגדרות לחץ  



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  131עמוד 

 
. על  ותו פרויקט בלבדישפיעו רק לגבי אהערה: שינוי יחידות העבודה בתוך פרויקט מסוים 

מנת לקבוע הגדרות כלליות לאופן הכולל של העבודה בתוכנה, הכנס תחילה לפרויקט  
Prototype שיפתח על   חדש , ושנה שם את ההגדרות הרצויות. לאחר שינוי זה, כל פרויקט

 ידי התוכנה יעבוד עם ההגדרות החדשות שקבעת.
 

 הסבר כללי 
 

לכל או לחלק מפעולות החישובים הגיאומטריים.   קיימות מספר אפשרויות אשר משותפות
 נרכז כאן הסבר כללי עליהם:

הבחירה:  1 טבלת   . Unused, Pick, Locate, Select של שילוב  מאפשרת  זו  טבלה   .
 חישובים עם אופציה גרפית.

 Unused-   ברירת המחדל לפתיחת החלון שמשמעותה כי כל הפעולות ברשימה אינן
 בשימוש כרגע.

 Pick-  הנקודותבחיר ברשימת  מופיעות  שאינן  השרטוט  בתוך  אקראיות  נקודות   ת 
שבחלון התחתון. אופן השימוש הוא בסימון האופציה, מעבר לאזור השרטוט ובחירת 

 הנקודות הרצויות. 
 Locate-   הנקודות שבחלון התחתון. התוכנה קיימות ברשימת  נקודות אשר  בחירת 

רשימת המצב   -ימה התחתונהתחפש את הנקודה שנבחרה, ואם תמצא אותה ברש
קביעת  )על  שנקבעו  להגדרות  בהתאם  המתוכננות,  הנקודות  רשימת  או  הקיים, 

 הרשימה לשימוש ראה סעיף "הגדרות לחישובים גיאומטריים" שבפרק זה(.
 Select-  בחירתPolyline   אוLine אשר שורטט ב- AutoCAD/ZWCAD אופציה זו .

 בלבד. AutoCAD/ZWCADשימושית כמובן למשתמשי גרסת 

מחיקה של נקודה אחרונה מתוך רשימת נקודות, אם קיימת רשימה כזו. לפעולות   -    .2
 ין רשימת נקודות ישמש המחק למחיקת כל השדות שבחלון.שבהן א

 מחיקת כל הנקודות בפעולות שבהן יש רשימת נקודות.  -  .3
 

ית )האנגלי(, תחת התפריט שים לב: כל הפעולות הגיאומטריות מסודרות על פי סדר האלף ב
Geometry . 

 
 ריכוז דוחות חישובים: 

דו"ח המרכז את כל החישובים הגיאומטריים   CivilCAD 10לכל פרויקט, שומרת תוכנת 
שבוצעו בו. בכל שלב עבודה ניתן להציג או להדפיס את הדו"ח הרצוי. בתוך חלונות הפעולה  

"ח )כפתור ועליו ציור של ספר(. לחיצה  של החישובים הגיאומטריים, מופיע כפתור הצגת הדו 
 או מחיקתו. Asciiעל הכפתור תציג את הדו"ח, ותאפשר הדפסתו, שמירתו בקובץ 

 

 חישובי שטחים 
 

 . מימין יפתח חלון. Geometry -> Areaהפעלה מסרגל התפריט הראשי: 
 

ב להשתמש  ניתן  נקודות.  רשימת  בין  הכלוא  שטח  חישוב  מאפשרת  זו   -ו  Pick  -אופציה 
Locate   כפי המוסבר בסעיף "הסבר כללי". ברשימה מימין, בשדה למעלה, ניתן להכניס את

ו נקודה  שם  נכניס,  הנקודות  את  לחישוב.  השטח  את  התוחמות  הנקודות  .  Enter  -רשימת 
בצורה:   תחום  הכנסת  ידי  על  נקודות  קבוצת  להכניס  זה Enter  -ו  10-15ניתן  במקרה   .
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. השטח בין  Apply. לחישוב השטח לחץ  15ל    10מספרן בין  מה כל הנקודות שייתווספו לרש
 , ויתווסף לדו"ח החישובים אשר ניתן להדפסה.Areaהנקודות יופיע בכיתוב 

 
 

 חישוב קשת על פי מרכז ונקודה על הקשת 
 

 . מימין יפתח חלון. Geometry -> Arc Center + 1 pointהפעלה מסרגל התפריט הראשי: 
 

 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 
 

נקודת מרכז ידועה, ונקודה נוספת  קואורדינטותאופציה זו מאפשרת חישוב קשת על פי 
 ידועה על הקשת. הכנס את הנתונים הבאים בשדות המופיעים בחלון: 

1. Center point- .נקודת מרכז הקשת הידוע 
2. From point- וצע לחישובי הקשת.נקודה ידוע על הקשת שתשמש נקודת מ 
3. Distance-   .מרחק הנקודה/נקודות החדשות שיחושבו מהנקודה הידועה על הקשת

 מרחק זה יכול להיות: 
 במקרה זה תחושב נקודה בודדה על פי המרחק שהוכנס.  -מרחק בודד 
הנו המרחק של הנקודה הראשונה    X, כאשר:  X > Y : Zנוסחה בפורמט:      

המרחק בין הנקודות.    Z  -חרונה ליצירה והמרחק של הנקודה הא  Yליצירה,  
רצים  50:10<0לדוגמא:   במרחקים  הקשת  לאורך  נקודות  תפזר  התוכנה   .
 מ'.  10, כל  50ועד   0 -שנעים מ

4. New point-   קבוצת שתיווצר  במקרה  התוכנה.  שתיצור  החדשה  הנקודה  שם 
 נקודות, תמספר התוכנה נקודות אלו החל מהמספר שהוכנס בשדה.

 
 .Enter -לעבור בין השדות השונים בחלון על ידי לחיצה על ההערה: ניתן 

 
לחץ   החישוב  הנקודות Applyלביצוע  לרשימת  ותכניסם  הנקודות  את  תחשב  התוכנה   .

רשימת    קואורדינטות)רשימת   או  קיים  בחלון    קואורדינטותמצב  שהוגדר  כפי  מתוכנן(  מצב 
אם גיאומטריים"(.  לחישובים  "הגדרות  סעיף  )ראה  בודדה,    ההגדרות  נקודה    עו יופיתחושב 

שבחלון. לחיצה על כפתור הדו"ח תציג את   Y  -וה  X  -שלה בנוסף בשדות ה  קואורדינטותה
 חלון הדו"ח ובו יופיע החישוב שזה עתה בוצע.

 
 

 חישוב קשת על פי שתי נקודות ורדיוס 
 

 . מימין יפתח חלון.Geometry -> Arc 2 pointsהפעלה מסרגל התפריט הראשי: 
 

 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ן להשתמש ב נית
 

נקודות ידועות על קשת ורדיוס. הכנס את הנתונים   2אופציה זו מאפשרת חישוב קשת על פי  
 הבאים בשדות המופיעים בחלון: 

1. From point- .נקודה ראשונה ידועה על הקשת 
2. From point-    הנקודה    שנייהנקודה הקשת.  על  הקשת    יההשניידועה  בהמשך  תהיה 

 בכיוון השעון. 
3. Radius- .רדיוס הקשת 
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4. Distance-   על הידועה  הראשונה  מהנקודה  שיחושבו  החדשות  הנקודה/נקודות  מרחק 
 הקשת. מרחק זה יכול להיות:

 במקרה זה תחושב נקודה בודדה על פי המרחק שהוכנס.  -מרחק בודד 
הנקודה הראשונה  הנו המרחק של    X, כאשר:  X > Y : Zנוסחה בפורמט:      

המרחק בין הנקודות.    Z  -המרחק של הנקודה האחרונה ליצירה ו  Yליצירה,  
רצים  50:10<0לדוגמא:   במרחקים  הקשת  לאורך  נקודות  תפזר  התוכנה   .
 מ'.  10, כל  50ועד   0 -שנעים מ

ל    הידועות  הנקודות  שתי  בין  המקטע  שווים  Xחלוקת  .  "X/"    -חלקים 
 חלקים שווים.  5 -המקטע ל, תחלק את 5/לדוגמא, הכנסת 

:".  X"    -מטרים  Xחלוקת המקטע בין שתי הנקודות הידועות לפי מרחק של   
 מ' על הקשת. 2:, תיצור נקודות כל 2לדוגמא, הכנסת 

5. New point-    ,נקודות קבוצת  שתיווצר  במקרה  התוכנה.  שתיצור  החדשה  הנקודה  שם 
 תמספר התוכנה נקודות אלו החל מהמספר שהוכנס בשדה.

 
 .Enter -ערה: ניתן לעבור בין השדות השונים בחלון על ידי לחיצה על הה
 

לחץ   החישוב  הנקודות Applyלביצוע  לרשימת  ותכניסם  הנקודות  את  תחשב  התוכנה   .
קיים או רשימת    קואורדינטות)רשימת   מצב מתוכנן(, כפי שהוגדר בחלון    קואורדינטותמצב 

גיאומ לחישובים  "הגדרות  סעיף  )ראה  יופיעההגדרות  בודדה,  נקודה  תחושב  אם    ו טריים"(. 
שבחלון. לחיצה על כפתור הדו"ח תציג את   Y  -וה  X  -שלה בנוסף בשדות ה  קואורדינטותה

 חלון הדו"ח ובו יופיע החישוב שזה עתה בוצע.
 

 חישוב קשת על פי שלוש נקודות
 

 . מימין יפתח חלון.Geometry -> Arc 3 pointsהפעלה מסרגל התפריט הראשי: 
 

 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 
 

נקודות ידועות על הקשת. הכנס את הנתונים   3אופציה זו מאפשרת חישוב קשת על פי 
 הבאים בשדות המופיעים בחלון: 

1. Point 1- .נקודה ראשונה ידועה על הקשת 
2. Point 2- ה ידועה על הקשת. ינקודה שני 
3. Point 3-  ית ידועה על הקשת.שלישנקודה 

 שלושת הנקודות יסודרו על הקשת בכיוון השעון. 
4. Distance-  מרחק הנקודה/נקודות החדשות שיחושבו מהנקודה הראשונה הידועה

 על הקשת. מרחק זה יכול להיות:
 במקרה זה תחושב נקודה בודדה על פי המרחק שהוכנס.  -מרחק בודד 
מרחק של הנקודה הראשונה  הנו ה  X, כאשר:  X > Y : Zנוסחה בפורמט:      

המרחק בין הנקודות.    Z  -המרחק של הנקודה האחרונה ליצירה ו  Yליצירה,  
רצים  50:10<0לדוגמא:   במרחקים  הקשת  לאורך  נקודות  תפזר  התוכנה   .
 מ'.  10, כל  50ועד   0 -שנעים מ

חלוקת המקטע בין הנקודה הראשונה לנקודה השלישית הידועות על הקשת,  
שווים  Xל   הכנסת  "X/"    -חלקים  לדוגמא,  ל5/.  המקטע  את  תחלק   ,-  5  

 חלקים שווים. 
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חלוקת המקטע בין הנקודה הראשונה לנקודה השלישית הידועות על הקשת  
מ'    2:, תיצור נקודות כל  2:". לדוגמא, הכנסת  X"    -מטרים  Xלפי מרחק של  

 על הקשת. 
5. New point- צת נקודות,  שם הנקודה החדשה שתיצור התוכנה. במקרה שתיווצר קבו

 תמספר התוכנה נקודות אלו החל מהמספר שהוכנס בשדה.
 

 .Enter -הערה: ניתן לעבור בין השדות השונים בחלון על ידי לחיצה על ה
 

. התוכנה תחשב את הנקודות ותכניסם לרשימת הנקודות  Applyלביצוע החישוב לחץ 
ן(, כפי שהוגדר בחלון  מצב מתוכנ קואורדינטותמצב קיים או רשימת  קואורדינטות)רשימת 

  וההגדרות )ראה סעיף "הגדרות לחישובים גיאומטריים"(. אם תחושב נקודה בודדה, יופיע
שבחלון. לחיצה על כפתור הדו"ח תציג את  Y -וה X -שלה בנוסף בשדות ה קואורדינטותה

 חלון הדו"ח ובו יופיע החישוב שזה עתה בוצע. 
 

 חישוב קשת על פי שלוש נקודות חוסמות 
 

 . מימין יפתח חלון. Geometry -> Arc 3 outside pointsהפעלה מסרגל התפריט הראשי: 
 

 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 
 

נקודות ידועות, החוסמות את הקשת )ראה שרטוט  3אופציה זו מאפשרת חישוב קשת על פי 
 הנתונים הבאים בשדות המופיעים בחלון: בחלון(, והרדיוס של הקשת ליצירה. הכנס את 

1. Point 1-  .נקודה ראשונה ידועה 
2. Point 2-  ידועה. שנייהנקודה 
3. Point 3-  .נקודה שלישית ידועה 
4. Radius- .רדיוס הקשת החסומה על ידי שלושת הנקודות 
 

 שלושת הנקודות יסודרו כך שיחסמו את הקשת בכיוון השעון.
 

 .Enter -ים בחלון על ידי לחיצה על ההערה: ניתן לעבור בין השדות השונ
 

 . התוכנה תחשב נקודות לאורך הקשת. Applyלביצוע החישוב לחץ 
 

 חישוב מקטע קשת 
 

 . מימין יפתח חלון. Geometry -> Arc segmentהפעלה מסרגל התפריט הראשי: 
 

 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 
 

חישוב שטח הכלוא בין קשת לבין קו ישר. בנוסף תחשב התוכנה את  אופציה זו מאפשרת 
אורך הקטע הישר ואורך קטע הקשת החוסמים את השטח. לחישוב נתוני השטח, הזן את 

 הנתונים הבאים:
1. From point-  .נקודת ראשונה של המקטע 
2. To point-  של המקטע. שנייהנקודה 
3. Radius- .רדיוס קשת המקטע 
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 .Enter -בין השדות השונים בחלון על ידי לחיצה על ההערה: ניתן לעבור 

 
 . התוכנה תחשב את נתוני המקטע ותציגם בשדות הבאים:Applyלביצוע החישוב לחץ 

 Arc- .אורך קשת המקטע 
 Dist- .אורך הישר בין שתי הנקודות 
 Area-  .שטח המקטע הכלוא בין הנקודות 

 
 יופיע החישוב שזה עתה בוצע.לחיצה על כפתור הדו"ח תציג את חלון הדו"ח ובו 

 

 חישוב מרחק מתמשך 
 

 . מימין יפתח חלון. Geometry -> Continuous distanceהפעלה מסרגל התפריט הראשי: 
 

אופציה זו מאפשרת חישוב מרחק סכומי של קו המוגדר על פי מספר נקודות. ניתן להשתמש  
כללי".  Select  -ו  Pick  ,Locate  -ב "הסבר  בסעיף  המוסבר  בשדה   כפי  מימין,  ברשימה 

למעלה, ניתן להכניס את רשימת הנקודות המגדירות את הקו לחישוב. את הנקודות נכניס, 
ו נקודה  בצורה:  Enter  -שם  תחום  הכנסת  ידי  על  נקודות  קבוצת  להכניס  ניתן    -ו  10-15. 

Enterלרש יתווספו  זה  במקרה  בין  י.  הנקודות שמספרן  כל  המרחק 15ל    10מה  לחישוב   .
בכיתוב  Applyלחץ   יופיע  בין הנקודות  פירוט  Distance. המרחק  יופיעו  בדו"ח החישובים   .

 של מרחקי הביניים בין הנקודות, כולל המרחק המצטבר הסופי. 
 
 

 קואורדינטותהתמרת מערכת 
 

הראשי:   התפריט  מסרגל  מימין  Geometry -> Coordinates transformationהפעלה   .
 יפתח חלון. 

 
מאפשר זו  האופציה  התמרת  הזנת   קואורדינטותת  פי  על  ברשימה  הנקודות  של 

ה  קואורדינטותה והזנת  הנוכחית,  במערכת  נקודות  שתי  שתי    קואורדינטותשל  אותן  של 
 ן מימין הזן: נקודות במערכת החדשה שאליה רוצים להתמיר. בחלו

Old system : 
)  X  ,Y  קואורדינטותהזן    ראשונה  נקודה  נקודה  Point1של  ושל  (  Point2)  שנייה ( 

 ידועות במערכת הישנה.
New system : 

 של אותן שתי נקודות במערכת החדשה. קואורדינטותהזן  
 

ב להשתמש  הישנה   Select  -וב  Pick  -תוכל  במערכת  הנקודות  שתי  את  לבחור  מנת  על 
 פי. א)הנוכחית( מתוך השרטוט באופן גר

 
ביצוע ההתמרה תתבקש  לביצוע הפעולה. לפני    Applyלאחר הכנסת ארבעת הנקודות לחץ  

יופיע ה  Rהחדשות בחלון התחתון. לחץ    קואורדינטותלאשר את הפעולה. לאחר ההתמרה 
 על מנת לשרטטם מחדש על גבי המסך.
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 פעולות נוספות אפשריות בחלון:
 

, גם של המצב הקיים  קואורדינטותנה התמרת שתי רשימות היברירת המחדל של התוכנה ה
שליד   V -ברצונך להתמיר רק אחת מהרשימות הסר את סימון הוגם של המצב המתוכנן. אם 

 הכיתוב המתאים:
 Topo points –  קייםהרשימת הנקודות של המצב . 
 Designed points – .רשימת הנקודות של המצב המתוכנן 

 

 וית לקבוצת נקודות וחישוב מרחק וז
 

 יפתח חלון. . מימין Geometry -> Distance & angleהפעלה מסרגל התפריט הראשי: 
 

וית יחסית מנקודה ידועה )תחנה כלשהי(  ואופציה זו מאפשרת חישוב של מרחק, אזימוט וז
 לקבוצת נקודות לסימון. בחלון מימין הכנס:

 Station- .שם תחנת המוצא ממנה יחושבו הנתונים 
 Zero point- תוכנת  -שם נקודת האפסCivilCAD 10  מפיקה דו"ח הכולל

ויות פתיחה לנקודות מנקודת מוצא, שתשתמש ו והן זהן אזימוטים לנקודות  
הזן את הנקודה שתשמש כנקודת  Zero point  -כנקודת האפס. בשדה ה

  -אפס. אם אין נקודה כזו הכנס בשדה זה את שם התחנה כפי שהכנסת בה
Station . 

ברשימה תוכל להכניס את כל הנקודות אליהן ברצונך   -To point -רשימת ה 
עמוד על השדה שבראש הרשימה והכנס את הנקודות  לחשב את הנתונים.

(, קבוצת לשנייהבין אחת  Enterהרצויות. תוכל להכניס נקודה אחר נקודה )
 All(, או להקליד את המילה 1-10)לדוגמא   -ועד -נקודות על ידי הגדרת מ

 , על מנת להכיל את כל הנקודות שברשימת הנקודות.Enter -ו
 

ויות  ו. התוכנה תחשב את רשימת המרחקים והזApply, לחץ לאחר שיש בידך את הרשימה
 וית. וותציגם בדו"ח. שים לב להבדל בין עמודת האזימוט לעמודת הז

 
הערה: הדו"ח המתקבל מאופציה זו אינו שייך לדו"ח הכולל של החישובים בתוכנה המתקבל  

 משאר הפעולות האפשריות. 
 
 

 חישוב מרחק ואזימוט לנקודה בודדה 
 

 . מימין יפתח חלון. Geometry -> Distance & Azimuthסרגל התפריט הראשי: הפעלה מ
 

 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 
 

אופציה זו מאפשרת חישוב מרחק וזווית בין שתי נקודות ידועות. הכנס את הנתונים הבאים 
 בשדות המופיעים בחלון: 

 
1. From point- ה ידועה. נקודה ראשונ 
2. To point-  ידועה. שנייהנקודה 
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 .Enter -הערה: ניתן לעבור בין השדות השונים בחלון על ידי לחיצה על ה
 

, תחשב התוכנה את האזימוט והמרחק בין שתי  To pointבשדה  Enterלאחר לחיצה על 
. כמו כן תעדכן התוכנה את  Azimuth -ו  Distanceהנקודות ותציג את הנתונים בשדות 

 ישוב בדו"ח החישובים. הח
 

 חיתוך שני מרחקים 
 

. מימין יפתח  Geometry -> Intersection - 2 Distancesהפעלה מסרגל התפריט הראשי: 
 חלון. 

 
 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 

 
 החלון בשדות. ידועות נקודות לשתי  מרחקים חיתוך ידי  על נקודה מציאת מאפשר זה חלון
 : הכנס

1. Center point 1-   נקודה ראשונה ממנה מבצעים החיתוך. נקודה זאת תהיה הנקודה
השמאלית לכיוון הצפייה )ההגדרה "שמאלית" באה בכדי לצמצם את מקום החיתוך 

 לנקודה בודדה מתוך שתי הנקודות שמהם נחתכים המרחקים(
2. Distance 1- ית(. מרחק לנקודה הידועה הראשונה )הנקודה השמאל 
3. Center point 2-  ממנה מבצעים החיתוך. נקודה זאת תהיה הנקודה  שנייהנקודה

 הימנית לכיוון הצפיה. 
4. Distance 2 –  הנקודה הימנית(. השנייהמרחק לנקודה הידועה( 
5. New point-  .שמה של הנקודה החדשה שתיווצר 
 

 .Enter -הערה: ניתן לעבור בין השדות השונים בחלון על ידי לחיצה על ה
 

החיתוך )אם אכן המרחקים   קואורדינטות. התוכנה תציג את Applyלביצוע החיתוך לחץ 
 . כמו כן יעודכן דו"ח החישובים בהתאם.Y -ו Xדות (, בש!נחתכים

 
 

 חיתוך שתי זוויות ומרחק
 

.  Geometry -> Intersection - 2 angles + distanceהפעלה מסרגל התפריט הראשי: 
 מימין יפתח חלון. 

 
 כפי המוסבר בסעיף "הסבר כללי".  Locate -ניתן להשתמש ב 

 
חלון זה מאפשר מציאת נקודה על ידי חיתוך בין תצפיות לשתי נקודות ידועות ומרחק 

 לשמאלית ביניהן. בשדות החלון הכנס:
1. Point 1-   נקודה ראשונה ממנה מבצעים החיתוך. נקודה זאת תהיה הנקודה

 תקבע לפי הזווית אל הנקודה(. השמאלית לכיוון הצפייה )שמאלית 
2. Angle 1- .)התצפית אל הנקודה הראשונה )השמאלית 
3. Distance-  .)מרחק לנקודה הידועה הראשונה )הנקודה השמאלית 
4. Point 2-  ממנה מבצעים החיתוך. נקודה זאת תהיה הנקודה הימנית  שנייהנקודה

 לכיוון הצפייה. 
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5. Angle 2-  הימנית(. השנייההתצפית אל הנקודה( 
6. New point-  .שמה של הנקודה החדשה שתיווצר 
 

 עבודה במעלות:
נדגיש כאן שאת הזויות נכניס באופן מלא, מופרד על ידי פסיקים, בצורה הבאה:   -

DDD,MM,SS :5,17,10,     56,12,10,     186,22,32. דוגמאות לזווית        
, רק על ידי ציון המעלות, וכולי. עוד נציין כי ניתן להכניס זוויות הניתנות במעלות מלאות

 מעלות(. 90)עבור   90לדוגמא: 
שים לב: פורמט הזוויות בחישובים גיאומטריים שונה מהפורמט בחישוב נתוני דיסטומט שם 

 יוכנסו הזוויות ללא כל הפרדה.
 עבודה בגרדים: 

 זווית בגרדים תוכנס כרגיל, כולל נקודה עשרונית אם צריך.  -
 

 .Enter -ות השונים בחלון על ידי לחיצה על ההערה: ניתן לעבור בין השד
 

החיתוך )אם אכן הנתונים   קואורדינטות. התוכנה תציג את Applyלביצוע החיתוך לחץ 
 . כמו כן יעודכן דו"ח החישובים בהתאם.Y -ו X(, בשדות !נחתכים

 

 חיתוך שלוש זוויות 
 

. מימין יפתח  Geometry -> Intersection - 3 anglesהפעלה מסרגל התפריט הראשי: 
 חלון. 

 
 כפי המוסבר בסעיף "הסבר כללי".  Locate -ניתן להשתמש ב 

 
חלון זה מאפשר מציאת נקודה על ידי חיתוך בין תצפיות לשלוש נקודות ידועות. דיוק חיתוך  
זה מושפע באופן ישיר מהפרש הזויות שבין התצפיות, וככל שהפרש זה מחולק באופן שווה  

 צורת מרצדס"( יגדל דיוק החיתוך. בשדות החלון הכנס:בין שלושת הכיוונים )" 
1. Point 1-   .נקודה ראשונה ממנה מבצעים החיתוך 
2. Angle 1-  .תצפית לתחנה ראשונה 
3. Point 2-  ממנה מבצעים חיתוך.  שנייהנקודה 
4. Angle 2-   שנייהתצפית לתחנה. 
5. Point 3-   .נקודה שלישית ממנה מבצעים החיתוך 
6. Angle 3- ה השלישית.התצפית אל הנקוד 
7. New point-  .שמה של הנקודה החדשה שתיווצר 
 

 עבודה במעלות:
נדגיש כאן שאת הזויות נכניס באופן מלא, מופרד על ידי פסיקים, בצורה הבאה:   -

DDD,MM,SS :5,17,10,     56,12,10,     186,22,32. דוגמאות לזווית        
מעלות מלאות, רק על ידי ציון המעלות, וכולי. עוד נציין כי ניתן להכניס זוויות הניתנות ב

 מעלות(. 90)עבור   90לדוגמא: 
שים לב: פורמט הזוויות בחישובים גיאומטריים שונה מהפורמט בחישוב נתוני דיסטומט שם 

 יוכנסו הזוויות ללא כל הפרדה.
 עבודה בגרדים: 

 זווית בגרדים תוכנס כרגיל, כולל נקודה עשרונית אם צריך.  -
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 .Enter -בור בין השדות השונים בחלון על ידי לחיצה על ההערה: ניתן לע

 
החיתוך )אם אכן המרחקים   קואורדינטות. התוכנה תציג את Applyלביצוע החיתוך לחץ 

 . כמו כן יעודכן דו"ח החישובים בהתאם.Y -ו X(, בשדות !נחתכים
 
 

 חיתוך קשת וקו ישר 
 

 . מימין יפתח חלון. Geometry -> Intersection line-arcהפעלה מסרגל התפריט הראשי: 
 

 כפי המוסבר בסעיף "הסבר כללי".  Pick -ו  Locate -ניתן להשתמש ב 
 

חלון זה מאפשר מציאת נקודות החיתוך בין קשת המוגדרת על ידי נקודת המרכז והרדיוס  
 שלה, וקו ישר המוגדר על ידי שתי נקודות. בשדות החלון הכנס:

1. Center point-  הקשת.  נקודת המרכז של 
2. Radius- .רדיוס הקשת 
3. From point- .נקודה ראשונה על הישר 
4. To point-  על הישר. שנייהנקודה 
5. New point 1- .שם נקודת החיתוך הראשונה ליצירה 
6. New point 2-  ליצירה.  השנייהשם נקודת החיתוך 
 

 .Enter -הערה: ניתן לעבור בין השדות השונים בחלון על ידי לחיצה על ה
 

  X -החיתוך, בשדות ה נקודות קואורדינטות. התוכנה תציג את Applyהחיתוך לחץ לביצוע 
 . כמו כן יעודכן דו"ח החישובים בהתאם.Point 2 -ו Point 1של  Y -וה
 
 

 חיתוך שני ישרים 
 

 . מימין יפתח חלון. Geometry -> Intersection line-lineהפעלה מסרגל התפריט הראשי: 
 

 כפי המוסבר בסעיף "הסבר כללי".  Pick -ו  Locate -ניתן להשתמש ב 
 

 חלון זה מאפשר מציאת נקודת החיתוך בין שני ישרים. בשדות החלון הכנס:
1. Point 1- .נקודה ראשונה על הישר הראשון 
2. Point 2-  על הישר הראשון. שנייהנקודה 
3. Point 1- .נקודה ראשונה על הישר השני 
4. Point 2-  על הישר השני. שנייהנקודה 
5. New point-  .שם נקודת החיתוך ליצירה 
 

 .Enter -הערה: ניתן לעבור בין השדות השונים בחלון על ידי לחיצה על ה
 

  -ו Xנקודות החיתוך, בשדות   קואורדינטות. התוכנה תציג את Applyלביצוע החיתוך לחץ 
Y.כמו כן יעודכן הדו"ח בהתאם . 
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 איתור נקודות על קו 
 

 . מימין יפתח חלון. Geometry -> Locate point on lineהפעלה מסרגל התפריט הראשי: 
 

 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 
 

אופציה זו מאפשרת חישוב נקודות על קו ישר. הכנס את הנתונים הבאים בשדות המופיעים  
 בחלון: 

1. From point- נקודת   נקודה על הישר שתשמש כנקודת המוצע לחישוב הנקודות(
 הנקודה ממנה יוכנסו המרחקים(. -המוצא

2. To point-  על הישר. שנייהנקודה 
הערה: לאחר שיכונסו שתי הנקודות המגדירות את הישר, יופיע בשדה התחתון )מתחת 

 ( המרחק בין שתי נקודות אלו. Y -וה X -לשדות ה
 
3. Distance- קשת. מרחק הנקודה/נקודות החדשות שיחושבו מהנקודה הידועה על ה

 מרחק זה יכול להיות: 
 במקרה זה תחושב נקודה בודדה על פי המרחק שהוכנס.  -מרחק בודד 
הנו המרחק של הנקודה הראשונה    X, כאשר:  X > Y : Zנוסחה בפורמט:      

המרחק בין הנקודות.    Z  -המרחק של הנקודה האחרונה ליצירה ו  Yליצירה,  
הי50:10<0לדוגמא:   לאורך  נקודות  תפזר  התוכנה  רצים  .  במרחקים  שר 
 מ'.  10, כל  50ועד   0 -שנעים מ

ל    הידועות  הנקודות  שתי  בין  המקטע  שווים  Xחלוקת  .  "X/"    -חלקים 
 חלקים שווים.  5 -, תחלק את המקטע ל5/לדוגמא, הכנסת 

:".  X"    -מטרים  Xחלוקת המקטע בין שתי הנקודות הידועות לפי מרחק של   
 מ' על הישר.  2:, תיצור נקודות כל 2לדוגמא, הכנסת 

4. New point-   ,שם הנקודה החדשה שתיצור התוכנה. במקרה שתיווצר קבוצת נקודות
 תמספר התוכנה נקודות אלו החל מהמספר שהוכנס בשדה.

 
 .Enter -הערה: ניתן לעבור בין השדות השונים בחלון על ידי לחיצה על ה

 
שימת הנקודות  . התוכנה תחשב את הנקודות ותכניסם לרApplyלביצוע החישוב לחץ 

מצב מתוכנן( כפי שהוגדר בחלון   קואורדינטותמצב קיים או רשימת  קואורדינטות)רשימת 
ההגדרות )ראה סעיף "הגדרות לחישובים גיאומטריים"(. אם תחושב נקודה בודדה, יופיע  

שבחלון. לחיצה על כפתור הדו"ח תציג את  Y -וה X -שלה בנוסף בשדות ה קואורדינטותה
 ובו יופיע החישוב שזה עתה בוצע.חלון הדו"ח 
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 איתור נקודה על ידי אזימוט ומרחק 
 

. מימין יפתח  Geometry -> Locate point by azimuthהפעלה מסרגל התפריט הראשי: 
 חלון. 

 
 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 

 
מנקודה ידועה. הכנס את הנתונים  אופציה זו מאפשרת חישוב נקודה על ידי אזימוט ומרחק

 הבאים בשדות המופיעים בחלון: 
 
1. From point-  .הנקודה הידועה ממנה יחושבו הנקודות 
2. Azimuth-  .אזימוט לנקודה המחושבת 

 עבודה במעלות:
נדגיש כאן שאת האזימוט נכניס באופן מלא, מופרד על ידי פסיקים, בצורה הבאה:   -

DDD,MM,SS :וכולי. עוד נציין כי   5,17,10,     56,12,10,     186,22,32. דוגמאות לזווית
  90)עבור  90ניתן להכניס זוויות הניתנות במעלות מלאות, רק על ידי ציון המעלות, לדוגמא:  

 מעלות(.
שים לב: פורמט הזוויות בחישובים גיאומטריים שונה מהפורמט בחישוב נתוני דיסטומט שם 

 יוכנסו הזוויות ללא כל הפרדה.
 ודה בגרדים: עב
 זווית בגרדים תוכנס כרגיל, כולל נקודה עשרונית אם צריך.  -
 
3. Distance-  .מרחק לנקודה המחושבת 
4. New point-  .שם הנקודה החדשה שתיצור התוכנה 

 
 .Enter -הערה: ניתן לעבור בין השדות השונים בחלון על ידי לחיצה על ה

 
ה ותכניסה לרשימת הנקודות . התוכנה תחשב את הנקודApplyלביצוע החישוב לחץ 

מצב מתוכנן( כפי שהוגדר בחלון   קואורדינטותמצב קיים או רשימת  קואורדינטות)רשימת 
הנקודה יופיעו בשדות   קואורדינטותההגדרות )ראה סעיף "הגדרות לחישובים גיאומטריים"(. 

שוב שזה  שבחלון. לחיצה על כפתור הדו"ח תציג את חלון הדו"ח ובו יופיע החי  Y -וה X -ה
 עתה בוצע.
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 איתור נקודה על ידי מרחק וזווית 
 

. מימין יפתח  Geometry -> Locate point by angleהפעלה מסרגל התפריט הראשי: 
 חלון. 

 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 
ה הנוצרת אופציה זו מאפשרת חישוב נקודה על ידי מרחק מנקודה ידועה, וזווית פתיח

 מאותה נקודה ומנקודה ידועה נוספת. הכנס את הנתונים הבאים בשדות המופיעים בחלון: 
1. From point-  .הנקודה הידועה ממנה יחושבו הנקודות 
2. To point- ( לכיוון. 0 -נקודה ידועה נוספת אשר תיצור את קו הבסיס )נקודת ה 
3. Angle-  לחשב.זווית הפתיחה מקו הבסיס לנקודה החדשה שברצוננו 

נדגיש כאן שאת הזווית נכניס באופן מלא, מופרד על ידי פסיקים, בצורה הבאה:   
DDD,MM,SS :וכולי. עוד נציין כי   5,17,10,     56,12,10,     186,22,32. דוגמאות לזווית

  90)עבור  90ניתן להכניס זוויות הניתנות במעלות מלאות, רק על ידי ציון המעלות, לדוגמא:  
 מעלות(.

לב: פורמט הזוויות בחישובים גיאומטריים שונה מהפורמט בחישוב נתוני דיסטומט שם שים 
 יוכנסו הזוויות ללא כל הפרדה.

 
4. Distance- .מרחק לנקודה החדשה 
5. New point-  .שם הנקודה החדשה שתיצור התוכנה 

 
 .Enter -הערה: ניתן לעבור בין השדות השונים בחלון על ידי לחיצה על ה

 
. התוכנה תחשב את הנקודה ותכניסה לרשימת הנקודות Applyוב לחץ לביצוע החיש

מצב מתוכנן( כפי שהוגדר בחלון   קואורדינטותמצב קיים או רשימת  קואורדינטות)רשימת 
הנקודה יופיעו בשדות   קואורדינטותההגדרות )ראה סעיף "הגדרות לחישובים גיאומטריים"(. 

ח תציג את חלון הדו"ח ובו יופיע החישוב שזה  שבחלון. לחיצה על כפתור הדו"  Y -וה X -ה
 עתה בוצע.
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 חישוב נקודת השלכה על ישר 
 

 . מימין יפתח חלון. Geometry -> Offset on lineהפעלה מסרגל התפריט הראשי: 
 

 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 
 

ידועה מחוץ לישר כלשהו, על הישר  אופציה זו מאפשרת חישוב נקודת השלכה של נקודה
עצמו. נקודת השלכה זאת תהיה המפגש בין הישר לניצב לו היוצא מהנקודה הידועה )ראה 

 שרטוט בחלון(. הכנס את הנתונים הבאים בשדות המופיעים בחלון: 
1. From point- .נקודה ידועה ראשונה על הישר 
2. To point- .נקודה ידועה נוספת על הישר 
3. External point-  .נקודה ידועה מחוץ לישר אשר לה תחושב נקודה ההשלכה 
4. New point-  .שם הנקודה החדשה שתיצור התוכנה 

 
 .Enter -הערה: ניתן לעבור בין השדות השונים בחלון על ידי לחיצה על ה

 
. התוכנה תחשב את הנקודה ותכניסה לרשימת הנקודות Applyלביצוע החישוב לחץ 

מצב מתוכנן( כפי שהוגדר בחלון   קואורדינטותקיים או רשימת   מצב קואורדינטות)רשימת 
הנקודה יופיעו בשדות   קואורדינטותההגדרות )ראה סעיף "הגדרות לחישובים גיאומטריים"(. 

שבחלון. לחיצה על כפתור הדו"ח תציג את חלון הדו"ח ובו יופיע החישוב שזה   Y -וה X -ה
 עתה בוצע.

 
 
 

 חישוב קווים מקבילים 
 

 . מימין יפתח חלון. Geometry -> Parallel linesמסרגל התפריט הראשי:  הפעלה
 

 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 
 

אופציה זו מאפשרת חישוב שתי נקודות הנמצאות על קו המקביל לקו עליו נמצאות שתי 
 החלון הכנס:נקודות ידועות, כאשר נתון המרחק בין שני הקווים. בשדות 

1. Point 1- .נקודה ידועה ראשונה על ישר 
2. Point 2-  על ישר. שנייהנקודה ידועה 
3. Offset- אשר המרחק בין שני הקווים המקבילים. מרחק זה יוכנס כמספר חיובי  כ

הקו המקביל נמצא מימין לקו הידוע, וכמספר שלילי כאשר הקו המקביל נמצא  
"ימין" יקבעו על פי סדר הנקודות המגדירות  -משמאל לקו הידוע. ההגדרות "שמאל" ו

 (.  Point 1, Point 2את הקו הידוע  )
4. New point 1- נקודה ראשונה לחישוב על המקביל. נקודה זאת תהיה נגדית ל- 

Point 1   
5. New point 2-  לחישוב על המקביל. נקודה זאת תהיה נגדית  שנייהנקודה מקבילה

 . Point 2 -ל
 

 .Enter -השדות השונים בחלון על ידי לחיצה על ה הערה: ניתן לעבור בין
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. התוכנה תחשב את הנקודות ותוסיף אותן לרשימת הנקודות Applyלביצוע החישוב לחץ 

מצב מתוכנן( כפי שהוגדר בחלון   קואורדינטותמצב קיים או רשימת  ותקואורדינט)רשימת 
הנקודות יופיעו בשדות   נטותקואורדיההגדרות )ראה סעיף "הגדרות לחישובים גיאומטריים"(. 

שבחלון. לחיצה על כפתור הדו"ח תציג את הדו"ח הכולל את החישוב שזה עתה   Y -וה X -ה
 בוצע. 

 
 
 

 חישוב טנגנטות 
 

 . מימין יפתח חלון. Geometry -> Tangentsהפעלה מסרגל התפריט הראשי: 
 

 כפי המוסבר בסעיף "הסבר כללי".  Locate -ו Pick -ניתן להשתמש ב 
 
ופציה זו מאפשרת חישוב שתי נקודות השקה לקשת, כאשר הנתונים הידועים הנם נקודת א

מרכז הקשת, רדיוס הקשת, ונקודה מחוץ לקשת שדרכה עוברים קווי ההשקה. בשדות החלון  
 הכנס את הנתונים הבאים:

1. Center point- .נקודת מרכז הקשת הידועה 
2. Radius- .רדיוס הקשת הידועה 
3. External point- .נקודה ידועה מחוץ לקשת, אשר קווי ההשקה עוברים דרכה 
4. New point 1- .נקודת השקה ראשונה לחישוב 
5. New point 2-  לחישוב. שנייהנקודת השקה 

 
 .Enter -הערה: ניתן לעבור בין השדות השונים בחלון על ידי לחיצה על ה

 
לרשימת הנקודות . התוכנה תחשב את הנקודות ותוסיף אותן Applyלביצוע החישוב לחץ 

ן  מצב מתוכנן( כפי שהוגדר בחלו קואורדינטותמצב קיים או רשימת  קואורדינטות)רשימת 
הנקודות יופיעו בשדות   קואורדינטותההגדרות )ראה סעיף "הגדרות לחישובים גיאומטריים"(. 

שבחלון. לחיצה על כפתור הדו"ח תציג את הדו"ח הכולל את החישוב שזה עתה   Y -וה X -ה
 ע. בוצ
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 חישובי עבודות עפר בכבישים :13פרק 
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 חישובי עבודות עפר בכבישים
 

 בחישובי עבודות עפר בכבישים.  בפרק זה נדון
את אחת התוכנות המובילות והנוחות לחישובי עבודות   CivilCAD 10ככלל, מהווה תוכנת 
תמקד, מהווה גם כלי חזק לתכנון כבישים. בפרק זה נ CivilCAD 10עפר לאורך כבישים. 

בעזרת דוגמאות, בעיקר בחישובי כמויות ופחות באספקת התכנוני, אם כי, כמובן לא ניתן  
 ים.ילבצע הפרדה מלאה בין השנ

בכדי להסביר את השימוש בתוכנה לצורכי חישובי עבודות עפר בכבישים, נראה דוגמאות 
של אשר ממחישות את התהליך. במהלך הדיון בדוגמאות נעבור על כפתורי ההפעלה 

 התוכנה ונלמד את פעולותיהם.
לצורכי חישוב כמויות,   CivilCAD 10: על מנת להעמיק את הידע בהפעלת תוכנת הערה

מומלץ לעבור ולקרוא את פרק "תכנון כבישים". בפרק "תכנון כבישים", תמצא פרוט נרחב של 
צורכי  כל פעולות התוכנה לאורך צירים וכבישים, אשר חלקם הגדול יהיה שימושיות גם ל

 חישובי כמויות בחתכים. 
 

 דוגמת עבודה 
 

נדגים כעת את שלבי העבודה לחישובי עבודות עפר בחתכים. הדוגמה הנה פשוטה יחסית 
 ואינה משלבת טכניקות מורכבות הקיימות בתוכנה.

 (. פרויקטיםחדש )ראה: עבודה עם  פרויקטפתח  .1
 . Roads→ Cross sectionsהפעל:     .2

ת חתכי  . הגדר אDefine sectionsלפניך יפתח חלון .   בחלון הימני לחץ על .3
 הרוחב בצורה הבאה:

 Start at station  –  0מרחק רץ לחתך ראשון, אנו נשאיר את הנתון . 
 End at station –  :100מרחק רץ לחתך אחרון, הקלד . 
 Distance between sections –  20מרחק בין חתכים, השאר את הנתון . 
 Name of first section –   ,0השאר שם החתך הראשון . 

 . OKלחץ  לסיום הפעולה
(. בחלון  Optionsבחלון הימני לחץ על הכפתור שעליו ציור של יד מחזיקה כרטסת ) .4

 שיפתח הגדר את הדברים הבאים:
 Sections width  –  לחתכים משמאל ומימן  המקסימאליהגדר את הרוחב

משמאל )המרחקים    - 20. אנו נגדיר תחום עבודה של   Left, Rightלציר: 
 מימין.  20משמאל לציר הם שלילים( ו 

.  Design -ו Existing, וסמן  Earthworks –בחר ב   Sections format -ב 
הגדרה זו קובעת את תצורת הצגת החתך בשרטוט. לצורך חישובי כמויות  

  -, ולצרכי תכנון נשתמש בEarthworksעבודות עפר נשתמש בד"כ בפורמט 
Design . 

   Elevation)ראה:  Elevationבודה נוסף שעלינו להגדיר בחלון זה הוא:  מצב ע 
ביחס   יםאבסולוטי( כך אנו מגדירים לתוכנה שהגבהים המוזנים הנם dH -ו 

 ראה: תכנון כבישים(.  –לפני הים )לעומת גבהים יחסים לחתך האורך שהוגדר  
 . OKלסיום הפעולה לחץ 

(, Name) 5עד   0-ימת החתכים, מעם סיום ההגדרה תופיע טבלה מימין של רש .5
. נוסיף כעת חתך ביניים לרשימת  100עד   0 -( מStationרצים ) ע"פ מרחקים

פתח י. ת Enterולחץ  1חתך מספר  על. עמוד עם העכבר 15החתכים במרחק רץ 
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, לחץ חץ ימינה    1.1שורת רווח ריקה. עמוד על השורה הריקה והכנס שם חתך 
 . 15ס מרחק רץ , והכנStationלמעבר לעמודת 

: אם ברצונך למחוק חתך שהוכנס בטעות תוכל לעשות זאת בצורה הבאה: הערה

 בקבוצת הכפתורים.  עמוד על החתך הרצוי בטבלה מימין ולחץ על כפתור  
 

בטבלה מימין. תוכל   0כעת נעבור להזנת נתוני החתכים. סמן את חתך מספר  .6
,  Sections name: 0ב: להבחין שבראש המסך, בכותרת העליונה מופיע הכיתו

. עבור לטבלה השמאלית התחתונה 0המציין כי כרגע אנו עובדים על חתך מספר 
(Existing G.L והחל בהקלדת )0חתך מספר של  קייםנתוני המצב ה : 

Offset  Elevation 
-2 -10  100 
-1 -5   100.32 
0 0  100.17 
1 5  99.15 
2 10  100.15 
3 20  100.37 

 
 Offset נם משמאל ייליים ה תו מרחק )במטרים( מהציר, כאשר מספרים שלמשמעו

נו הגובה במרחק הנתון. בעמודה השמאלית ביותר מופיע  יה Elevationלציר, וחיוביים מימין. 
, כך  40 -ל  – 40מספר סידורי המהווה את מספר המקטע. המספרים הסידוריים הנם בין 

(. ניתן לגלגל את הטבלה  0+מקטע מספר  X 40 2מקטעים ) 81שלכל חתך ניתן להכניס עד 
  Apply -ה ומטה בעזרת פס הגלילה מימין. בסיום הקלדת הנתונים לחץ על כפתור המעל

 שבחלון הימיני לקבלת שרטוט החתך. 
 

(, והכנס את Designed G.Lנית התחתונה )יעבור עם העכבר לטבלה הימ .7
 הנתונים הבאים כמצב מתוכנן:

Offset  Elevation 
-1 -5   99.5 
0 0  99.5 
1 5  99.5 

( מייצגת את השיפוע  %Slopeהזנת הנתונים כאן דומה למצב הקיים. העמודה השלישית )
באחוזים בין המקטע הקודם למקטע הנוכחי, בכיוון היוצא מהציר. ניתן אם כן להכניס 

הנתונים או כגובה או כשיפוע כאשר לאחר הכנסת אחד מהם, יחושב השני באופן אוטומטי.  
( לא נדון כאן אלא רק בתכנון כבישים. בסיום הקלדת הנתונים Coverעמודה הרביעית )ב

שמימין. תוכל לשים לב ששיפועי החתך בקצוות ניבנו באופן אנכי.    Apply -לחץ על כפתור ה
זאת כיוון שלא הגדרנו שיפועי דיקור. בשני קצוות החתך, מלמעלה ומלמטה מופיעים  

 הכיתובים: 
 

Slp. Left: Cut 1:                    Fill 1: 
 
Slp. Right: Cut 1:                  Fill 1: 

 
(,  Leftבמקומות אלו ניתן להזין את שיפועי הדיקור כאשר למעלה נזין את השיפוע משמאל )

, למצב מילוי  Fillאת השיפוע למצב חפירה ול  Cut(, ב Rightולמטה את השיפוע מימין ) 
אם החתך נמצא בחפירה או במילוי ותשתמש בנתון הרצוי(. את שיפוע  )התוכנה תבדוק ב
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. ז"א שאם ברצוננו שמצידו השמאלי של החתך, אם הוא X -ל 1הדיקור נכניס כיחס של 
, את :Slp Left: Cut 1  נזין תחת 2-ל 1יפוע לדיקור יהיה במצב חפירה, היחס בבניית הש

 (. 0.5 -נזין כ 2:1)הערה: יחס של  2הנתון 
לארבעת התיבות.  2לכל המצבים. הכנס את הנתון  1:2דוגמא שלנו נזין לחתך יחס של ב

 בכדי לקבל את מבנה החתך החדש.  Applyלחץ 
 

ע"י סימונו   1נרצה כעת להמשיך ולמלא את שאר נתוני החתכים. עבור לחתך  .8
 בטבלה הימנית. הזן את הנתונים הבאים לטבלאות:

 מצב קיים: 
Offset  Elevation 

-2 -7.5  100.97 
-1 -5   99.56 
0 0  99.36 
1 5  99.15 
2 7.2  100.15 
3 15  100.55 

 
 מצב מתוכנן:

Offset  Elevation 
-1 -5  99.7 
0 0  99.7 
1 5  99.7 

 
 לקבלת מבנה החתך. Applyלכל ארבעת המצבים. לחץ  1:2שוב נכניס שיפועים של 

שימוש   אופצייתכאן  את שאר נתוני החתכים, לא נזין באופן ידני. נדגים .9
 באינטרפולציה בין חתכים:        

של המצב הקיים ע"מ להעתיק נתונים אלו לזיכרון המחשב  Copy לחץ על כפתור   
 נמצא משמאל לטבלת המצב הקיים(. Copy -)כפתור ה

 (.5עבור בטבלה מימין לחתך האחרון )חתך מס'  

להדביק את הנתונים שמשמאל לטבלת המצב הקיים ע"מ  Paste לחץ על כפתור   
 .Applyלחץ  לחתך הנוכחי.

של המצב המתוכנן )כפתור זהה לקודם, אלה  Copyחזור לחתך הראשון ולחץ   
 שמשמאל לטבלת התכנון(. 

 . Applyעבור לחתך האחרון והדבק את נתוני התכנון לחתך זה. לחץ  
ן  בחלו dHמ'. לחץ על הכפתור  1  -כעת נגביה את נתוני התכנון בחתך האחרון ב 

 Designed. בחלון שנפתח העבר ממצב קיים למצב מתוכנן OKולחץ  1הימיני. הזן 
G.L בחלון רשימת החתכים בחר את החתך האחרון ושוב לחץ .OK  נתוני המצב

 המתוכנן יוגבהו בהפרש הרצוי. 
 לקבלת דיקורים מחודשים.  Applyלחץ  

 
אר ללא נתונים. נרצה כעת , מלאים, ואילו הש5-ו  1, 0שלנו שלושה חתכים:  בפרויקטכעת 

 לבצע אינטרפולציה לחתכים הריקים: 

 .  לחץ על כפתור האינטרפולציה שבחלון הימני 
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. כעת תתבצע אינטרפולציה לכל החתכים  OKבחלון שנפתח ולחץ  Design All בחר 
 הריקים. 

: לאחר ביצוע אינטרפולציה יתמלאו כל החתכים הריקים בנתונים. לביצוע אינטרפולציה  הערה
 חוזרת יהיה עליך למחוק את נתוני החתכים הרצויים ורק אז להורות על ביצועה. 

 

 שבסרגל הכלים בחלקו העליון של המסך: להדפסת החתכים לחץ על כפתור  
קנ"מ לאורך.   -Lengthקנ"מ לגובה ,  -Heightבחלון שיפתח הגדר קנ"מ להדפסה:    

 להמשך. OK (. לחץ 1:100/1:100)קנ"מ של    100, 100אנו נכניס 
בחלון שיפתח הגדר את סוג, גודל הדף, ושאר הפרמטרים הרצויים הקשורים   

 )או "אישור"( להמשך.  OKבמדפסת שברשותך. לחץ  
  Aכעת בחר את החתכים שברצונך להדפיס. לבחירת כל החתכים לחץ כפתור  

 להדפסה. OKשבתחתית החלון. לחץ 
 

ת העבודה המוגדרת במערכת. לשינוי התוכנה תדפיס את החתכים באופן רציף, על פי שפ
 שפה בצע הפעולות הבאות:

 . Cancelצא מחתכי הרוחב על ידי  
 . File → Configurationהפעל  
 את השפה הרצויה.  Languageבחלון שייפתח בחר תחת   
 (. Roads → Cross sectionsוחזור לחתכי הרוחב ) OKלחץ  
 חזור והדפס את החתכים כנלמד. 
 

 ות: נעבור לחישוב הכמוי
בחלון מימין. התוכנה תחזור לחלון    Closeחץ על מנת לצאת מחלון חתכי הרוחב ל

 הראשי.
. מימין יפתח חלון חישוב Roads→Earthworksבסרגל התפריט הראשי הפעל:   

 כמויות עבודות עפר. 
 .יפתחדו"ח עבודות עפר ע"מ לקבל טבלה מרכזת של חישובי נפחים. חלון  Applyלחץ 

 Show Strippingאת האופציה  V-יש לסמן בדו"ח שטחי חישוף על מנת להציג  .10
table להצגתו גלגל את החלון כלפי   -)הדו"ח נמצא בהמשך דו"ח עבודות העפר

 מטה בעזרת חיצי הגלילה(.
 להדפסת הדו"ח לחץ כפתור המדפסת המופיע בתחתיתו.  .11
העפר   .12 עבודות  בדו"ח  )גם  בדוחות  שיופיעו  העמודות  את  לבחור  וגם באפשרותנו 

שבחלון הימני.     Optionsחץ על כפתור ה  בדו"ח שטחי החישוף(. לעשות כן ל
הכיתוב   תחת  סמן  שיפתח  העמודות   Earthworksבחלון  את  סימון(  בטל  )או 

 לאישור. OKהרצויות בדו"ח. לחץ 
ה .13 כפתור  על  לחיצה  הרצויים.  החתכים  נתוני  של  מפורט  דו"ח  לקבל   -נוכל 

Sections data report   פתח חלון ובו יופיע הדו"ח. לגבי כל חתך נקבל את  , ת
בחפירה  אורכו  במילוי,  החתך  שטח  בחפירה,  החתך  שטח  שהוכנסו,  הנתונים 

 ואורכו במילוי. לחיצה על כפתור המדפסת שבתחתית תגרום להדפסת הדו"ח.
לחישוב עבודות  לבחירת כביש מסוים, מס' כבישים או כל הכבישים מתוך רשימה .14

 . ’Roads→Earthworks‘מהתפריט הראשי הפעל:  עפר בכבישים,
 ייפתח מימין.  ’Roads Earthworks‘חלון 

 .OK, סמן את הכבישים הרצויים לחישוב ולחץ על כפתור ’Select‘לחץ על כפתור 
 לחישוב דו"ח עבודות עפר בכבישים. ’Apply‘לחץ על כפתור 
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 ,להפרדת חישוב כמויות לתעלות צד בדו"ח עבודות עפר בכבישים .15
הפעל:   הראשי  חלון  ’Roads→Earthworks‘מהתפריט   .‘Roads Earthworks’ 

 ייפתח. 

ולאחר מכן לחץ על כפתור      ’Exclude ditches‘באופציה    ’V‘סמן  
‘Apply’    הצד תעלות  עבור  הכמות  כאשר  בכבישים  עפר  עבודות  דו"ח  להפקת 
 נפרדת.

 

 Excelעקום הובלות ע"י  ת דיאגראמיצירת 
 

של עקום הובלות מצטבר המציג את הכמויות המצטברות  דיאגראמהבאפשרותך לקבל 
)חפירה או מילוי( בכל חתך לאורך הציר הנוכחי או לפי חתכים כאשר הכמויות מוצגות באופן  

קיימת   Microsoft excelרגיל )לא מצטבר( בכל חתך. )אופציה זו אפשרית רק אם תוכנת 

יפתח חלון המציג שתי   excel mass haul diagram במחשב(. לחץ על כפתור: 
 אפשרויות: 

 
 Accumulated mass haul diagram –  המציגה את כמויות   דיאגראמה

 החפירה/מילוי המצטברות לאורך הציר. 
 Sections volumes diagram – המציגה את כמויות החפירה/מילוי   דיאגראמה

 לכל חתך.
 

. על  EXCELLבחלון של  ההדיאגראמהתוכנה תציג את   OKבחר מאחת האפשרויות ולחץ 
. חלון זה לא נשמר עם  EXCELL-חלון ה בתוךמור מסמך זה יש לבצע שמירה מנת לש
 ולכן יש לבצע בו שמירה לחוד. הפרויקט

 
התראה  תינתןבמחשב עליו מופעלת התוכנה,   Microsoft excelבמידה ולא קיימת תוכנת 

 ופעולה זו תופסק.
 
 

 Excel-קליטת נתונים מ
 

.  Excelמאפשרת קליטה )ייבוא( של נתוני החתכים לרוחב מקובץ   CivilCAD 10תוכנת 
 לצורך המחשה נעבוד ע"פ הדוגמה הבאה:

 
 הכנת קובץ הנתונים 

 ומלא את הנתונים לפי ההסבר הבא:   Excel פתח מסמך חדש בתוכנת
, הטור השני 1כל שורה בטבלה מייצגת חתך. הטור הראשון מייצג ערך קבוע שתמיד יהיה  

 ייצג את שם החתךמ
  Offsetוהטור השלישי מייצג את המרחק הרץ לאותו חתך. שאר הטורים מייצגים את ערכי 

, גובה.....  Offset, גובה, Offsetשל החתך ואת הגובה בהתאם. הערכים מוכנסים בסדר של 
בעל ערך שלילי מייצג את המרחק משמאל למרכז החתך.)ראה בשרטוט  Offset-וכו',   כש

 והלאה(.  E-ו  D-טורים
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 . Textכקובץ  Excel-ה לגיליוןלאחר שהקלדנו את הנתונים נבצע שמירה 
 שמירה בשם(. -)קובץ  File-save asהפעל   Excelמתפריט ה 
 . :Text(Tab delimited)(*.txt)בחר בחלון שיפתח שמירה בסוג  
 . Saveהקובץ ולחץ הקלד את שם  

 
 
 

 CivilCAD 10לתוך   Excel-קליטת הנתונים מ
 

אותו לתוך   נוכל לייבא ,Excell-ה מגיליוןלאחר שיצרנו קובץ טקסט שמכיל את הנתונים 
 הטבלה הרצויה בחתכי הרוחב.

 
 . CivilCAD 10הפעל את תוכנת  
 חדש.  פרויקטפתח  
 .Roads→ Roads Listהפעל  
 ם.הכנס כביש לרשימת הכבישי 
 . Roads→ Cross Sectionsהפעל  

 (. Load sections from text file) לחץ על כפתור   
 .Files of type   :Text(Tab delimited)(*.txt)בחר ליד הכיתוב  
 בחר את הקובץ עם הנתונים. 
 בחלון שייפתח בחר את הטבלה שאליה אתה רוצה לייבא את הנתונים.  
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 תכנון כבישים :14פרק 
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 ים תכנון כביש 
 

תכנון כבישים. תהליכי תכנון כבישים   - פרק זה ידון באחת האופציות העיקריות בתוכנה
כוללים בתוכם מרכיבים רבים אשר התוכנה, כמכלול מלא על כל פעולותיה, נותנת לו פתרון.  

די הכביש, לדוגמא, אינם מפורטים בפרק זה ועל כך ניתן  יהסדרת המגרשים והחלקות בצ
"חישובי נפחים בעזרת משטחים". הפרק ידון בשלבי התכנון   לקרוא בהרחבה בפרק

  הכוללים:
 

 הכנת הרקע לעבודה. 
 . בפרויקטארגון רשימת הצירים  
 Horizontal alignment -תכנון התוואי האופקי  
 הגדרת התוואי האופקי.  
 חלון ההגדרות לתכנון התוואי האופקי.  
 כלים מתקדמים לתכנון התוואי האופקי.  
 - Vertical alignmentורך תכנון חתך הא 
 הגדרת חתך האורך. 
 .AutoCAD/ZWCAD-הגדרת חתך האורך בסביבת ה 
 . Vertical alignment-פעולות כלליות בחלון ה 
 . תכנון חתך אורך אלטרנטיבי 
 מחתך האורך.  לגיליונותוחלוקה  DXFיצירת קבצי  
 הצטלבויות כבישים בחתכי האורך. 
 Cross sectionsתכנון חתכי הרוחב  
 הגדרת חתכי הרוחב.  
 תכנון החתכים.  
 פרוט הפעולות בחלון החתכים.  
 . Super Elevationsהגדרת מעברי שיפועים  
 . -Coverתכנון תעלות צד והרחבת פעולות ה 
 תכנון ברמות. 
 עבודה עם חתכים טיפוסיים. 
 נושאים מתקדמים בתכנון חתכי הרוחב.  
 . לאורך הציר גיאומטרייםחישובים  
 . ישינוי התוואי האופק  
 .שינוי תוואי הכביש לאחר תכנון מלא 
 . תכנון צמתים אוטומאטי 
 . בדיקת מעטפת ראות 
 . בדיקת מרחקי בלימה 
 . עם שיפוע "הפוך"   תכנון מגרשים בין כבישים  
 . תכנון גשרים 
 .תכנון מנהרות 
 

אנו נעבור לאורך הפרק, ע"פ שלבים, על כל המרכיבים הקשורים בתכנון כבישים. השלבים 
הצעה לסדר פעולות מומלץ. לאחר צבירת ניסיון בתוכנה יוכל כל משתמש  נם ישיתוארו ה

 להגדיר לעצמו סדר פעולות רצוי לפי הרגלי העבודה שיסגל.
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 הכנת רקע לעבודה )הכנת המצב הקיים( 
 

 (, ותן שם לעבודה.File -> New projectפתח פרויקט חדש ) .1
 . File->Openהפעל AutoCAD/ZWCAD  -מתוך תפריט ה 
שישמש רקע לעבודה ופתח   Dwg -הקבצים שיפתח בחר את קובץ ה בחלון 

 אותו.
. התוכנה תיצור העתק של File>-Saveהפעל  CivilCAD 10מתוך תפריט  

המקורי שבחרת בספרית הפרויקט שלך )קובץ זה יקבל  Dwg -קובץ ה
 בתוספת התו '_'(. CivilCAD 10 -בהמשך שם כשם הפרויקט ב

 
מתבסס על מודל תלת מממדי. על בסיס מודל זה  CivilCAD 10 עיקרון הפעולה של תוכנת

מבצעת התוכנה את פעולותיה: הוצאת חתכים, חישובי כמויות וכדומה. ע"מ ליצור את המודל 
בפורמט טקסט  קואורדינטות. אם ברשותך קובץ קואורדינטותהנ"ל חייבת התוכנה קובץ  

((ASCII   ולא המשך מכאן.5רגיל עבור לסעיף , 
 

. באם וקובץ זה אינו קיים יכולה התוכנה לייצר  קואורדינטותר, זקוקה התוכנה לקובץ כאמו
 (, וזאת בתנאים מסוימים: Dwg -קובץ זה מתוך קובץ השרטוט )ה

 
 בלבד: AutoCAD/ZWCADלמשתמשי גרסת  .2

 . יפתח חלון מצד ימין. General -> Filteringהפעל  
רטוט הנו של סינון מהש קואורדינטותעקרון הפעולה של יצירת קובץ 

*(Filtering ( שכבה )שכבת שרטוטAutoCAD/ZWCAD בה נמצאים ,)
 -הנקודות או קווי הגובה. אם כן, יהי עליך תחילה לאתר את השכבה הרצויה  ב

AutoCAD/ZWCADהגובה  -. לשכבה זו חייב להיות ממד ה
אשר בהם כן ניתן לסנן גבהים   מסוימיםפרט למקרים  (-AutocAD/ZWCAD)ב

 .0מהשרטוט גם אם הגובה שלהם הוא 
 

 Dwgטיפול בקבצי  ראה פרק  Filtering*להסבר בהרחבה על           

 
החלון הימני מחולק לשנים. בחלק העליון מופיע רשימת שכבות השרטוט ובחלק  

 ( לבחירה.Entitiesהתחתון רשימת ישויות )
 . Layersסמן את השכבה הרצויה לסינון ברשימה, תחת הכיתוב  
 . Entitiesבחר את סוג הישות הרצוי לסינון ברשימה, תחת הכיתוב  

 
נפרט כיצד ניתן לקבוע מהו סוג הישות הרצוי. נבדוק תחילה האם בשרטוט קיימת שכבת  
נקודות מדודות. אם שכבה זו אינה קיימת נסנן במקומה את שכבת קווי הגובה )בהנחה וזו 

ושבות הנקודות המדודות נבדוק את סוג קיימת(. לאחר שמצאנו את השכבה/שכבות שבהן י
( וזאת ע"י סינון השכבה בהם יושבים הבלוקים.  Blocksהישות. ככלל נעדיף לסנן בלוקים )

( בשרטוט, ואם הן עם  Points entitiesאם אין בשרטוט בלוקים, נחפש האם קיימות נקודות )
ם לסנן את הטקסטים (, נבצע עליהן סינון. בעדיפות נמוכה מזאת נוכל גZגובה )יש להן 

(Text entities  אך יש להביא בחשבון שיתכן ומיקום הטקסט שונה במקצת ממיקום ,)
 הנקודה המדודה עצמה.  
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הגובה יש באפשרותך לקבוע את הגובה על פי   מצויןובטקסט  0אם גובה הטקסט הוא 
בפרק    Optionsקביעת גבהים בחלון הראה  Options-בהכיתוב בטקסט ע"י שימוש 

 Dwg יפול בקבציט
 

אם בקובץ אין כלל גבהים מדודים )נקודות מדודות(, נעבור לעדיפות נמוכה יותר והיא סינון  
, והאם יש להם גובה Polylinesאו  linesנם יקווי הגובה. לעשות כן נבדוק האם קווי הגובה ה

(Z.) 
 

כאשר אנו מסננים קווי גובה, התוכנה תיצור מספר רב של נקודות במיוחד   
ווי גובה מעוגלים או מורכבים, לכן יש לצמצם את מרחק הנקודות  בק

 DWGטיפול בקבצי המסוננות. להסבר מלא על אפשרות זו ראה פרק 
 צמצום מספר הנקודות המסוננות. סעיף: 

על מנת שהתוכנה תסנן את הנקודות   Topographyסמן את האופציה:  
 . Topography coordinates-לרשימת ה

לון הימני. התוכנה תחל בסינון השכבה הנבחרת ע"פ סוג בח Applyלחץ על  
המסוננות  קואורדינטותההישות שנבחרה. בסיום התהליך תופיע רשימת 

 (. Topography coordinatesבחלון התחתון )

שמעל לחלון לשרטוט. התוכנה תיצור שכבת נקודות  לחץ על כפתור   
 *חדשה ע"ג השרטוט.

 
 *CivilCAD 10 דות חדשה משלה. שכבה זו תהיה בנוסף לשכבה שכבר  יוצרת שכבת נקו

 קיימת כבר. 
 בלבד:  AutoCAD/ZWCADלמשתמשי גרסת .3

-רציפות. לנושא קווי אי-יתכן מצב שבו בקובץ המדידה, בנוסף לנקודות, קיימים קווי אי
רציפות מוקדש חלק נרחב בתוך פרק קווי הגובה ועל כן לא נרחיב כאן את הדיון בנושא. אם ה

י נפרד מקובץ המדידה ועליהם לעבור תהליך סינון  חלק בלת םה ,ימים קווים כאלהאכן קי
 רציפות בשרטוט, תוכל לדלג לסעיף הבא(.-נוסף )במידה ואינך יודע האם קיימים קווי אי

 
 Topography->Linesהפעל  

 . Filter breaklines        - לחץ על כפתור ה 
על     Filter breaklinesבחלון    קו Selectלחץ  על  ולחץ  לשרטוט  הסמן  עם  עבור   ,

 או סמן את השכבה וסוג הקו ברשימות שבחלון. הקוויםמתוך השכבה של 
רציפות בלבד, ה-תיצור את קווי אי  Yes. לפניך תופיע הודעה. לחיצה על  Applyלחץ   

, תיצור הן את קווי  No  -ללא הוספת נקודות לרשימת הנקודות הקיימות. לחיצה על
וכן-האי נקודות השבר  רציפות,  קווי האי  (Vertex)  תוסיף את  רציפות לרשימת -של 

 הנקודות הקיימות. 
הערה: ברוב המקרים, אין צורך בהוספת נקודות השבר לרשימה הקיימת שכן נקודות אלו 

כבר קיימות שם. מכאן, שרק אם אתה יודע בפרוש כי ברצונך להוסיף את נקודות השבר לחץ  
No  ובכל מקרה אחר לחץ ,Yes . 

רציפות והם יתווספו  ה-לאחר אישור ההודעה, יבוצע סינון של קווי אי 
 . לפרויקט
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 Topography(, ורשימת הנקודות התחתונה )Filteringאם ביצעת את פעולת הסינון )
coordinates אם לא המשך מכאן:7( מלאה, דלג לסעיף . 

 של המצב הקיים:  קואורדינטותקליטת קובץ  .4
 Load from textפתור של פתיחת קבצים ) בחלון התחתון, לחץ על הכ  

file )  הרצוי. לאחר בחירת הקובץ תופיע   קואורדינטותהובחר את קובץ
 רשימת הנקודות בחלון התחתון. 

שמעל לחלון לשרטוט. התוכנה תיצור שכבת  לחץ על כפתור הרענון   
 שרטוט של נקודות קיימות מהרשימה.

 
הקיים במערכת ומותקן עם התוכנה. לשם כך  קואורדינטותלמימוש ההסבר נשתמש בקובץ 

 Samples, היושב בספריית  Sample7.Tco( את הקובץ 5פתח )על פי ההסבר בסעיף 
 
 

 הקובץ נמצא במיקום ברירת המחדל:  Windows 7/8/10במערכת הפעלה 
C:\ProgramData\SivanDesign\CivilCAD\Samples\Sample7\ 

  
 

 , ולא המשך מכאן:7ת דלג לסעיף רציפו-אם אין בידך קובץ קווי אי
 רציפות:-קליטת קובץ קווי אי .5

 . מימין יפתח חלון. Topography -> Linesבסרגל התפריט הראשי הפעל:  

. לפניך יפתח חלון    בחלון מימין לחץ על הכפתור של פתיחת קבצים 
 Filter -בלבד )ה Disהקבצים כאשר הקבצים שתתבקש לבחור יהיו קבצי  

 (. Dis.* -יהיה ל של סוגי הקבצים
-טען, ורשימת קווי איירציפות שבידך. הקובץ י ה-בחר את קובץ קווי אי 

-רציפות תופיע בחלון הימני. התוכנה תיצור שכבת שרטוט של קווי איה
 רציפות. ה

 
  חיבורי קווים אי רציפות ראה פרק -להרחבה בנושא קווי
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 יצירת קווי גובה: .6

שיש  Dwgירת קווי הגובה. גם אם ברשותך קובץ  השלב האחרון בהכנת המצב הקיים הוא יצ 
בו כבר קווי גובה, יהיה עליך לבצע שלב זה מכיוון שבשלב יצירת קווי הגובה, יוצרת התוכנה, 

גם את המודל התלת ממדי שעליו היא מתבססת. מודל זה אינו נראה למשתמש )למרות 
              שניתן להציגו( אך חשוב להמשך העבודה בתוכנה.                

          
. מימין יפתח  Topography -> Contoursבסרגל התפריט הראשי הפעל:  

 חלון. 
בחלון מימין הגדר את ההפרש האנכי בין קווי הגובה. לעשות כן מחק את  

, והכנס את ההפרש הרצוי  Intervalsשמימין למילה  Defaultהמילה 
 (. 1במטרים )לדוגמא: 

ירת קווי הגובה. יתכן מצב שבו תאתר . התוכנה תחל ביצApplyלחץ  
התוכנה בקובץ הנקודות בעיה כלשהי אשר תמנע יצירת הקווים. אם הבעיה  
ניתנת לפתרון באופן פשוט יחסי, תתקבל הודעה על הבעיה/בעיות. פרוט  

פשוט(. מכיוון שאין   Editor -בלפתיחה )אשר ניתן  Logהבעיות יופיע בקובץ 
קווי הגובה, אנו נאשר את ההודעה על הבעיה,  יצירתפרטי לברצוננו להיכנס 

 והתוכנה תמשיך בפעולתה באופן רגיל. 
-נו פונקציה של מספר הנקודות בפרויקט ושל מספר קווי איי יך יצירת קווי הגובה התהל
רציפות )אם יש כאלה(. יתכנו מקרים בהם תעבוד התוכנה זמן ממושך ועל כן יש להמתין ה

ם התהליך יסתיים באופן תקין, תיצור התוכנה שכבות שרטוט בסבלנות עד סיום התהליך. א
מתאימות שבהן יופיעו קווי הגובה. אם לא מופיעות שכבות אלו, אזי קיימת בעיה שאינה ניתן 
לפתרון באופן אוטומטי ויהיה עליך לעבד את קובץ הנקודות )על יצירת קווי הגובה ועיבודם  

 ראה פרק נפרד(. 
 

 מצאות המודל התלת ממדי:יתקינות והנראה כעת אמצעי לבדיקת 
 איתור גובה קיים בנקודה כלשהי: .7

השרטוט. עבור עם העכבר   לחלוןאשר נמצא מעל    Pick Height  לחץ על כפתור   
לשרטוט, והעמד את הסמן באזור קווי הגובה. לחץ לחיצה בעכבר. גובה הנקודה בה  

  -ו  height_dהכיתוב    אתה נמצא יופיע בחלקו בתחתון ביותר של חלון התוכנה, ליד
height_t . 

ה   גובה,  איתור  זה של  להיכלי  ביותר  הנוח  ותקינות המודל התלת  ינו המדד  מצאות 
נו הגובה המתוכנן. בהעדר  יה  height_d  -נו גובה המצב הקיים, ויה  height_tממדי.  

 תכנון, יהיו שני גבהים אלו שווים. 
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 ארגון רשימת הצירים בפרויקט 
 

ן את הרקע לעבודה )המצב הקיים(, נתחיל בתכנון. נלמד בחלק זה של  לאחר שסיימנו להכי
 את הצירים הרלוונטיים לפרויקט הנוכחי.  CivilCAD 10הפרק כיצד מארגנת תוכנת 

 
. מימין יפתח חלון.  Roads -> Roads listמסרגל התפריט הראשי הפעל:  

חת תוכנת  בחלון מופיע רשימת הצירים של הפרויקט. בהעדר הגדרת צירים, פות
CivilCAD 10  באופן אוטומטי ציר בשםRoad1  אם נכנסו למסך רשימת .

 ימחק ציר זה והרשימה תהיה ריקה.יהצירים )המסך הנוכחי(, 
הקלד בטבלה מימין את רשימת הצירים בפרויקט הנוכחי. לכל ציר בפרויקט יש  

ם  לתת שם כלשהו. השם יכול להיות אלפא נומרי או מספר. שמות הצירים אינ
 . Enterידך. לאחר כל שם ציר הקלד -חשובים והם רק לצורך ארגון החומר על

 . Cancelבסיום הקלדת הרשימה לחץ  
 

 . Road1למימוש הדוגמה הכנס ציר בודד ותן לו את השם 
 

בראש כל חלון שיופיע בשלבי תכנון הכביש )הגדרת התוואי האופקי, תכנון חתך האורך, 
הנמצא בעבודה. אם קיימים מספר צירים בפרויקט, תוכל תמיד  וכו'(, יופיע גם הכביש הנוכחי

לדפדף בין הצירים בעזרת החץ הקטן שמופיע בצד שם הכביש לעבודה. התוכנה תציג את 
שמות הצירים ותציג אותם בצורה הבאה: מספר/שם, לדוגמא אם שם הכביש הראשון הוא 

Road1  :התוכנה תציג )בהמשך( את הכביש בשםRoad1/1 . 
 
 

 רוט הפעולות הנוספות בחלון:פ
 

 מה. . לפני ביצוע הפעולה תתקבל התראה מתאימחיקת כל הצירים בפרויקט 
 

. הציר שימחק הנו הציר המסומן ברשימה. לפני ביצוע הפעולה תתקבל  מחיקת ציר בודד 
 התראה. 

 

. לאחר לחיצה על כפתור זה ייפתח חלון ובו ניתן להקליד הערות אשר הוספת הערות 
 שמרו ביחד עם הגדרות הכביש.יי
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 הגדרת התוואי האופקי 
 

 בסיום ארגון רשימת הצירים נתחיל בתכנון התוואי האופקי של הכביש.
. מימין  Roads -> Horizontal Alignmentמסרגל התפריט הראשי הפעל:  .1

(  Topography coordinatesיפתח חלון. שים לב כי הרשימה בחלון התחתון )
שימת הנקודות הקיימות, הופיע רשימה חדשה, ריקה, של התחלפה, ובמקום ר

 (. Designed coordinatesהנקודות המתוכננות )
 

 :של הציר IP -הזנת נתוני ה .2
 של הציר. אנו נבחן שתי שיטות:  IP -קיימות מספר שיטות להזנת נתוני ה

 בלבד(   AutoCAD/ZWCADשיטה א': )למשתמשי גרסת  -
(, שיהווה את התוואי  2D Polyline) Polyline, העבר AutoCAD/ZWCAD -ב 

 האופקי של הציר. 
 ,Unused, Pick, Locateבטבלה מימין )הטבלה ובה הרשימה  Selectבחר  

Select .) 
 Enter an option תופיע ההודעה: AutoCAD/ZWCAD-בשורת הפקודות של ה 

(<Polyline>/Segment**) הקלד ,p  ולחץEnter.   האפשרותSegment  תוסבר
 ף הבא.בסעי

. הטבלה Enterהמשורטט, ולחץ  Polyline –עבור לאזור השרטוט, בחר את ה  
,  Polyline -( בVertexשל הציר. כל שבר ) IP -בחלון מימין תתמלא ברשימת ה

 שלהם. קואורדינטותה של הציר, ובחלון התחתון תופיע רשימת  IP -יקבע כ
                     

מספר   x,   כאשר xIPyר יקבעו ע"פ:    לצי IP -* הערה: שמות נקודות ה
ראשונה(,   Select. בציר הראשון שיבחר )פעולת  IPמספר ה   y -הציר, ו

וכו'. בכל פעולת   1IP1 ,1IP2 ,1IP3  ,1IP4בצורה הבאה:  IP -ימוספרו ה
Select חדשה, יגדל ה- x . 

 
עם כלים  AutoCAD/ZWCAD-** קיימת שיטה נוספת ליצירת התוואי בעזרת ה 

 דמים ראה הרחבה בסעיף הבא )כלים מתקדמים לתכנון התוואי האופקי(.מתק
 
 

 שיטה ב':  -      
 של הציר, לדוגמא: IP -בחלון התחתון הקלד את רשימת ה 

 
IP1               175143.56             256123.76 
IP2               175200.40             256325.56 
IP3               175256.00             256327.12 

      
כפי שהוקלדו ברשימה  IP -בטבלה מימין הקלד את שמות ה 

  IP -נקליד כמובן תחת הכיתוב IP -התחתונה. את ה
 בטבלה. בדוגמא שלנו נזין את הרשימה בצורה הבאה:
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 : הזנת הרדיוסים של הציר .3
. אם  IP -ב הבא בהגדרת התוואי האופקי יהיה הגדרת הרדיוסים בנקודות ההשל

 . 0 -לא נגדיר רדיוסים תתייחס התוכנה לרדיוסים כ
 IP -בטבלה מימין, הזן את הרדיוס הרצוי. ל IPמול כל  

 הראשון והאחרון לא נגדיר רדיוס כלל.
 & Layout  -מימין. לפניך יפתח חלון  Applyלחץ על כפתור   

contours. 
שוב )לא נפרט כאן את השימוש  OKבחלון שיפתח לחץ  

בחלון הנ"ל. אנו נחזור לחלון זה בהמשך ואז נפרט על 
 השימוש בו(.

, יופיעו  IPהתוכנה תיצור את התוואי האופקי של הציר, אשר יופיע בשכבות נפרדות. ליד כל 
 נתוני הקשת. -שלה, וליד כל קשת קואורדינטותה
 

 בלבד: AutoCAD/ZWCADלמשתמשי גרסת 
מורכב,   Polylineמסוגלת להוציא את נתוני התוואי האופקי מתוך  CivilCAD 10תוכנת 

המורכב על   Polylineהבנוי מאוסף של קשתות וקווים ישרים יחדיו. לאחר שתבחר את ה 
, תבנה התוכנה את הציר כך שיכלול את הקשתות. לכל קשת יחושב Select  -ידי פעולת ה 
)ראה  OK -ו Applyשלה, אשר יופיעו בטבלה מימין. לאחר לחיצה על  IP -הרדיוס וה

 למעלה(, יופיע נתונים אלה ע"ג השרטוט.
 

בתוך הוואדי של הפרויקט   Polylineסעיפים קודמים(, העבר   2למימוש הדוגמא )ראה 
העבר כך שיכלול הן  Polyline -(. את ה\Sample7.Tco \Samples)כאמור, קובץ מדידה  

 (. Polyline  -בזמן ציור ה \Arc\רים והן קשתות )בחירת קווים יש
 
 

 הזנת קלוטואידות: .4
ליצירת קלוטואידות בציר, נזין את אורך עקומת המעבר בכניסה לקשת בשדה  

Clot.In  ואת אורך עקומת המעבר ביציאה מהקשת נזין בשדהClot.Out. 
ת לראות את  על מנ OK -ו   Applyלאחר כל שינוי בטבלה מימין, ניתן ללחץ שוב 

 השינויים על גבי השרטוט. 
  
נוכל להבחין בסימונים הבאים על   Applyלאחר שנזין את הקלוטואידות ונלחץ  
 הקשת: 
 TS- .המעבר מקטע ישר לעקומת המעבר 
 SC -  .מעבר מקשת מעבר לעקומה מלאה 
  CS- .מעבר מעקומה מלאה לקשת מעבר יציאה 
 ST- .יציאה מעקומת מעבר חזרה לקטע הישר  

 
 : IP -. שינוי מיקום ה5 
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של הציר, ואת הרשימה   קואורדינטותההתוכנה קושרת את הרשימה התחתונה, בה מופיעות 
העליונה )מימין(, של הגדרת הציר, על פי שמות הנקודות. מכאן שכל עוד נשמור על שמות 

נקודות זהים, הן ברשימה העליונה והן ברשימה התחתונה, ישמר קשר זה. שינוי 
ושוב   בחלון הימני, Applyשל נקודה מסוימת, ברשימה התחתונה, ולחיצה על  דינאטהקואור

OK   בחלון שיפתח, תזיז את כל תוואי הציר בהתאם למיקום החדש. נראה כעת כיצד ניתן
 , כאם ע"י שינוי גרפי: הקואורדינאטהלא ע"י שינוי ידני של  IPלהזיז 

  Unused, Locate, Pickמתוך הרשימה ) Moveבחלון התחתון, בחר  
 וכו'(.

 : AutoCAD/ZWCADלמשתמשי גרסת  
ה  כי  )תוכל להבחין  ובחר את הנקודה הרצויה להזזה   Object  -עבור לשרטוט 

Snap ל- Node .)הופעל , 
עצמה   הנקודה  את  שוב  שתבחר  להניח  )סביר  להזזה  הייחוס  נקודת  את  סמן 

 כנקודת ייחוס(. 
 .סמן את המקום אליו ברצונך להזיז את הנקודה 

שמעל לחלון השרטוט. הנקודה תזוז למיקום   להשלמת הפעולה לחץ כפתור   
 החדש.

ושוב    Applyחץ  ל  הימני,  למיקום   OKבחלון  יזוז בהתאם  הציר  בחלון שיפתח. 
 .IP -החדש של ה

 : Stand Aloneלמשתמשי גרסת  
הריבוע   בתוך  הנקודה  את  )הכנס  הרצויה  הנקודה  את  ובחר  לשרטוט  עבור 

 שמופיע(.
 . IP -ת המיקום החדש של הסמן א 

 שמעל לחלון השרטוט.  לחץ על כפתור   
ושוב    Applyלחץ    הימני,  למיקום   OKבחלון  יזוז בהתאם  הציר  בחלון שיפתח. 

 .IP -החדש של ה
 . Close. בסיום הגדרת התוואי האופקי לחץ 6 

 
 

 פירוט פעולות נוספות בחלון: 
 

 Dis/LLD/xml/Rdsץ  קריאת נתוני הציר מתוך קובכפתור פתיחת קובץ.  
 

 .העהתר. לפני ביצוע הפעולה תבוא מחיקת כל נתוני הציר 
 

, ובחלון שנפתח  Applyניתן ללחוץ  IP -. לאחר מחיקת הבודד בציר IPמחיקת  
 ע"מ לקבל את תוואי הציר החדש.  OKללחוץ שוב 

 

לאחר לחיצה על כפתור זה, התוכנה  )הפיכת כיוון הכביש(. IPs-הפיכת סדר ה 
אשון יהפוך להיות הר IP-כך שה קואורדינטותהברשימת  -IPsתשנה את מספור ה

( התוכנה תבנה את OK-ו Applyהאחרון. לאחר יצירת התוואי מחדש )לחיצה על 
 תנוחת הכביש הפוך.   
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אופציה זו מאפשרת הוספת חתך במקום ספציפי בין חתכים   הוספת חתך .  
 מטרים.  20נה יצרה כל כשהתו

 

יקט ובו מספר רב . אופציה זו שימושית כאשר יש ברשותנו פרוIP-שמות ה  מספור 
אינם לפי הסדר הפיזי שלהם  IP-של כבישים ומספור הכבישים או נקודות ה

והוספנו אחרי המחיקה   מהפרויקט  מסוים)לדוגמא: אם מחקנו כביש  בפרויקט
ל מנת לשמור לא יהיו עוקבים בין הכבישים(. ע IP-כבישים נוספים שמות תחילת ה

יש לבצע את הפעולות הבאות: לאחר לחיצה על כפתור זה   בפרויקטעל "סדר" 
 מחדש:  IPs-יפתח חלון ובו שני אפשרויות עיקריות למספור ה

 
 . ) IP (xIPy:  שינוי המספור בתחילת השם לפני ואחרי הכיתוב 1אפשרות 

  Rename roads number first number (x)סמן את האפשרות:  
בשדה מימין   IPאשר ייצג את תחילת שמות ה (X)ד את המספר הראשוןהקל 

 Applyלאפשרות זו )אם ברצונך למספר את כל הכבישים סמן את האפשרות: 
changes to all roads 1(. לצורך הדוגמא הקלד . 

עצמו   IP-מספור ה -IP (Yמצד ימין של שם ה  הספרהאם ברצונך למספר גם את  
, Rename IPs numbers first number (y)אפשרות: , סמן את ה)בתוך הכבישׂ

 . 0והקלד את תחילת המספור בשדה מימין לאפשרות זו. לצורך הדוגמא הקלד 
 Fit IPs names in layoutהנ"ל תופיע אפשרות נוספת "   האפשרותאם סימנת את  

boxes to IP numbersסימון אפשרות זו מגדיר לתוכנה למספר גם את ה ,"-   
IPsט התנוחה לפי מספור זה.בשרטו 

השתנה, הכביש הראשון יתחיל  IPs-תוכל להבחין שמספור ה OKלאחר לחיצה על  
 וכך הלאה...   ..2IP0,2IP1,2IP2הכביש השני ב:   1IP0,1IP1,1IP2ב: 

 
 

 
  האחרון )ללא מספור הכביש(. IP-הראשון ועד ה  IP-:  שינוי המספור מה2אפשרות 

 . Rename all ips in all roads without prefix numberסמן את האפשרות:  
הראשון בכביש הראשון בשדה מימין לאפשרות זו,   IP-הקלד את המספר של ה  

 . OK. ולחץ 0לצורך הדוגמא: 
האחרון בכביש  IP-וה …IP0,IP1,IP2תוכל להבחין שהכביש הראשון מתחיל ב: 

 בכל הכבישים. IPS-האחרון מסתיים עם סה"כ מספר ה
 
 

 וספות בחלון זה:אפשרויות נ
 

  - Clear unused IPs from coordinates list ,במידה ואפשרות זו מסומנת
, התוכנה תנקה את כל הנקודות שמכילות את האותיות  OKלאחר לחיצה על כפתור 

IP  מסוימיםושאינן נמצאות בשימוש. אופציה זו שימושית לאחר מחיקה של כבישים 
 . מהפרויקט

 Update layout automatically -   זו מסומנת, לאחר לחיצה על  רותואפשבמידה
, התוכנה תבצע את השינויים הדרושים ובנוסף תעדכן את שרטוט  OKכפתור 

 התנוחה בהתאם לכל השינויים. 
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ע"ג הציר   העל הכפתור ולאחר מכן הקלק יצהלח בדיקת מרחק רץ ע"ג הציר. 
ת המרחק  א AutoCAD/ZWCAD -של Command –בשורת ה  , תציגבשרטוט

 הרץ מתחילת הציר ועד לנקודה זו. 
 כל הקלקה נוספת ע"ג הציר תציג את המרחק הרץ לגבי הנקודה הנוכחית. 

 
' במקלדת Aכדי להכניס חתך ביניים במקום בו הקלקת, יש ללחוץ על מקש '

 . OKואח"כ על כפתור  Addעבור 
 

 . Cross Sectionsחתך הביניים יתווסף לרשימת חתכי הרוחב בחלון 
 

תיבנה תנוחת  Create Layoutלאחר הזנת תכנון בחתך הנ"ל ולחיצה על כפתור 
 הכביש כולל החתך שהתווסף.

 
 

 חלון ההגדרות הכלליות בתכנון התוואי האופקי 
 

  Options -  לחיצה על כפתור זה תפתח את חלון ההגדרות הראשי. בחלון זה ניתן
 Horizontal ת הכיתוב לקבוע את ההגדרות הבאות )הגדרות אלו נמצאות תח

alignment:)נסביר את האפשרויות לפי סדר הופעתם בחלון , 
 

על מנת לשנות את גודל הכיתוב  :Scale -שינוי קנה המידה של גודל הכיתוב 
בנתוני הציר בחר את הקנ"מ הרצוי מתוך הרשימה. לצורך זה לחץ על כפתור החץ 

נו ביחידות יצוי )קנה המידה ההקטן ליד המספר הנתון  בתיבה ובחר את הגודל הר
  OKהוא הגודל הנבחר(. לאחר הבחירה לחץ  X, כאשר X:1מטרים על פי יחס של 

 -לסגירת החלון. *כדי לשנות את השרטוט , יהיה עליך ללחוץ שוב על כפתור ה
Apply  שמימין, ושובOK   .בחלון שיפתח 

 

, ויצירה  OKלחיצה על * על מנת לראות כל שינוי בתנוחה יש לאשר את השינויים ע"י 
 בחלון שיפתח OKשמימין, ושוב  Applyמחדש של התנוחה ע"י לחיצה על 

 
 
 Create layout –  .שיטת שרטוט התנוחה 
  -2D Polyline+buldges  התוכנה תשרטט את קווי התנוחה ללא גובה. אופציה זו

יעילה כאשר רוצים להוריד ממשקל הקובץ )של השרטוט(, מפני שהתוכנה 
פחות נקודות בקו ותשתמש בבלג'ים )רדיוסים( כדי ליצור את   תשרטט

 העקמומיות. 
 3D Polyline  –   התוכנה תשרטט את קווי התנוחה עם גובה אך תיצור את הקו

אין אפשרות לשרטט  3Dממספר רב יותר של נקודות, מפני שבמצב של 
Polyline .שמורכב מרדיוסים 

 
 IP's and cross sections – הגדרת ה-IPs .והחתכים לרוחב 
Pick( :IP counter in coordinates .)כאשר עובדים עם  IP –שינוי מספור ה  

 -מתוך הרשימה )ראה חלון קודם Pickניתן להגדיר את התוואי האופקי ע"י בחירת  
Select, Pick, Locate  וכו'(. כדי לקבוע את מספור ה- IP כפי שיבנו ע"י ה- Pick ,
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ע"פ המספר   IP -הבאה, יקבע מספור ה Pick -ההכנס מספר רצוי. בפעולת  
 שהוכנס. 

לכל ציר, ממספרת   -(IP counter in layoutבתנוחה: ) IP -שינוי מספור ה  
. נדגיש שאין קשר בין שם 0 -שלו לפי סדר עולה החל מ IP -התוכנה את ה

כפי שהיא מופיע ברשימת תוואי הציר/ברשימת   IP -טה של האהקואורדינ
 IPחה. ז"א, שיתכן ובטבלה )ע"ג התנו IP -מתוכננות, ובין מספור הה קואורדינטותה

   Radius    ClotIn    ClotOut ( יופיע שם נקודה כלשהו )אשר חייב להיות זהה
מספור אחר.   IPלשם שמופיע ברשימה שבחלון התחתון(, וע"ג התנוחה, יופיע לאותו 

הראשון בציר   IPהזנת מספר בשדה הנוכחי, יקבע את המספר הסידורי של ה
 הנוכחי, על גבי התנוחה. 

 Define sections  –  .התוכנה מאפשרת את הגדרת  הגדרת חתכי הרוחב
חלוקת חתכי הרוחב ללא צורך בהגדרת נתוני החתכים עצמם. לאחר לחיצה על חלון  

 זה יוצגו האפשרויות הבאות:
 Sections format –  .האפשרות הראשונה היא שיטת מספור החתכיםFormat1  

 name of first, המציגה את שמות החתכים בסדר עולה ממספר החתך הראשון )
sectionוהלאה. אם נבחר את האפשרות ) Format2    ע"י שינוי הפרמטרים ,

שיופיעו, התוכנה תציג את שם החתך בצורה הבאה:  מרחק רץ+קמ ,לדוגמא: אם 
, 000+0רה הבאה: , התוכנה תציג את החתכים בצוKM :0נשאיר את הערך בשדה 

020+0 ,040+0 ....,380+0 . 
 

Distance between sections -   המרחק בין חתכי הרוחב. נראה בהמשך שאין חובה
ביצירת חתכי רוחב סדרתיים, ויתרה מזאת, ניתן להגדיר את כל החתכים לרוחב באופן שאינו  

 סידרתי.
Show all sections-  שמות חתכי הרוחב בתנוחה אפשרות זו תגדיר לתוכנה להציג את כל

 לא בהכרח סידרתי(. בינםמים חתכי רוחב מוגדרים והמרחק )במידה וקיי
Show sections by steps-   אפשרות זו תגדיר לתוכנה להציג בתנוחה רק את חתכי הרוחב

 . Distance between sectionsבמרחקים הרצים הקבועים שהוגדרו באופציה: 
 

 Show slopes on edges – עם שיפוע גדול   מדרוןדה וקיים במי
 . באזור הדיקורים, התוכנה תסמן קווים )זקנים( לפי הצורך

 Show side slopes –  פעולה זו אפשרית כאשר אפשרותOutside 
layout אפשרות זו מציגה את השיפועים בתוך הכביש ע"ג , מסומנת

 .   סימון החתך
 Show stations of tangents – חתכים את התוכנה תסמן בנוסף ל

 .  מיקום הטנגנטות
 

 Cross sections display 
 Inside layout - שמות החתכים יהיו על התנוחה בצמוד לציר . 
 Outside layout - שמות החתכים יופיעו מחוץ לתנוחה. 

 
 בלבד(.  format 2-כיוון תצוגת שמות החתכים )ב 
 Parallel to C.L. - שמות החתכים יופיעו במקביל לציר . 
 Perpendicular to C.L. - שמות החתכים יופיעו במאונך לציר. 

 
 Angle's units  –  בשיפועי הכביש:  זוויתפורמט 
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 Grads  – השיפועים יוצגו בגראדים ערכי . 
 Degrees – ערכי השיפועים יוצגו במעלות . 

 
 IP'S data in standard mode –   מצב תצוגת הנתונים ע"י טקסטים

 להציג ע"ג התנוחה. סמן את השדות אשר ברצונך. בלבד
 IP'S data in blocks mode 
 Show only coordinates –  ע"   קואורדינטותההתוכנה תציג רק את

 בלוקים. 
 Show all data -  התוכנה תציג את כל הנתונים של הכביש

 ע"י בלוקים.  קואורדינטותוה
 

,  Cancel -, תאשר השינויים שבוצעו, ולחיצה עלOKלחיצה על כפתור  
 שמירה. תצא ללא 

 
 : הצגת נקודת המעבר ממצב מילוי למצב חפירה בתנוחת הכביש  
 

 Roads→Horizontal‘להצגת נקודת המעבר, מהתפריט הראשי הפעל: 

Alignment’ . 

 ייפתח.   ’Options‘. חלון .  ’Options‘לחץ על כפתור  .8

 . 'Cut/Fill Zone Display'את באופציה  ’V‘ –סמן ב  .9

 גדרות.לשמירת הה ’OK‘לחץ על כפתור  .10

 . 'OK' –ו   'Apply'לחץ על כפתור  ’Roads→Horizontal Alignment‘בתפריט  .11

 בתנוחה יופיע קו המעבר בין מילוי לחפירה עם ציון המרחק הרץ. .12

 
 Horizontal alignmentהמשך הסבר הפעולות בחלון 

 
1. Pick, Locate –   

ף על פעולת פית של הציר, בנוסא מאפשרות הגדרה גר  Locate -וה Pick -פעולות ה
 שנלמדה בתחילת הפרק. נראה את השימוש בפעולות אלו:  Select -ה

 : Pick -שימוש ב
 ברשימה. Pickבחר  
בשורת   'Sעבור לאזור השרטוט, והחל בסימון הציר. בסיום סימון הציר, הכנס ' 

המשך במתן רדיוסים   .Enterולחץ  AutoCAD/ZWCAD -הפקודה של ה
 ושאר שלבי תכנון הכביש. 

 :Locate -ב שימוש
 ברשימה.  Locateבחר  
. אם  IP -עבור לאזור השרטוט, הצבע על הנקודות בשרטוט אשר יהוו את ה 

  Object Snap -, תוכל לשים לב שAutoCAD/ZWCAD -הנך משתמש ב
, יהפוך הסמן לריבוע  Stand-Aloneהופעל באופן אוטו'. בגרסת  Node -ל

בשורת   'Sיום, הכנס 'אשר אליו יש להכניס את הנקודות הנבחרות. לס
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המשך במתן רדיוסים  . Enterולחץ  AutoCAD/ZWCADהפקודה של ה 
 ושאר שלבי תכנון הכביש. 

 
יוצרת נקודות חדשות, בעוד   Pickנו שפעולת יה Locate -ו  Pickבין  ההבדל העיקרי

Locate   בוחרת נקודות שקיימות במאגר הנקודות. יתרונה של פקודתLocate   הוא בכך
,  Locateמכבידה" על הרשימה. יתרון חשוב נוסף הוא, בצירוף שני צירים, ע"י שאינה " 

 לאותה נקודה, כך שאם נזיז את הנקודה הנ"ל, יזוזו שני הצירים יחדיו. 
 
 
 

 כלים מתקדמים לתכנון התוואי האופקי  
 

מאפשרת תכנון תוואי אופקי בקלות רבה ע"י כלים חדשים אשר  CivilCAD 10תוכנת 
ן ליצור חיבורי קווים וקשתות עד ליצירת שרטוט התוואי האופקי כולו. לאחר בעזרתם נית

שרטוט התוואי ניתן להורות לתוכנה להגדיר את תוואי הציר מהשרטוט שנוצר ע"י סימון  
 הקטעים אשר התוכנה יצרה. ראשית נסביר את כל הפעולות האפשריות: 

 

  Line Line Curve -   ים.חיבור עקום בין שני קווים ישר 
 לחץ על כפתור זה או ע"י:   

Roads->Horizontal Alignment Tools ->Line_Line_Curve . 
 AutoCAD/ZWCAD :תציג הודעה *Select first line עבור לאזור השרטוט ולחץ ,

 על הקו הראשון.  
 AutoCAD/ZWCAD  :תציג הודעהSelect second line .בחר את הקו השני , 
 AutoCAD/ZWCAD  :תציג הודעהEnter cloto in (0)** הכנס את אורך ,

 . Enterהקלוטואידה בכניסה לעקום ולחץ 
 AutoCAD/ZWCAD  :תציג הודעהEnter radius  הכנס ערך לרדיוס הקשת בעקום ,

 .Enterולחץ 
 AutoCAD/ZWCAD  :תציג הודעה,Enter cloto out(0)   הכנס את אורך

 . Enterהקלוטואידה ביציאה מהעקום ולחץ 
הוכנס רדיוס מתאים ולא ניתן ליצור חיבור משיק לקלוטואידות, התוכנה במידה ולא  

 . Tangent not on lineתציג את ההודעה: 
 . AutoCAD/ZWCAD -כלל הפונקציות זהות ל * 
 (.0ללא הכנסת ערך תיצור קשת ללא קלוטואידה )אורך קלוטואידה  Enterלחיצה על  **
 

 Line Line Recurve –   הפוך( בין שני קווים. חיבור עקום משלים( 
 לחץ על כפתור זה או ע"י:  

Roads->Horizontal Alignment Tools ->Line_Line_ReCurve . 
 AutoCAD/ZWCAD  :תציג הודעהSelect first line עבור לאזור השרטוט ולחץ ,

 על הקו הראשון.  
 AutoCAD/ZWCAD  :תציג הודעהSelect second line .בחר את הקו השני , 
 AutoCAD/ZWCAD  :תציג הודעהEnter cloto (0)   הכנס את אורך הקלוטואידה

 . Enterבכניסה ויציאה מהעקום )אורך זהה( ולחץ 
 AutoCAD/ZWCAD  :תציג הודעהEnter radius הכנס את רדיוס הקשת בעקום ,

 .Enterולחץ 
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במידה ולא הוכנס רדיוס מתאים ולא ניתן ליצור חיבור משיק לקלוטואידות, התוכנה  
 . Tangent not on lineג את ההודעה: תצי

 

    Line Line Fit Cloto(Radius) –   חיבור עקום בין שני קווים הבנוי משתי
 קלוטואידות צמודות, ללא קשת, ע"י הכנסת רדיוס. 

 לחץ על כפתור זה או ע"י:  
Roads->Horizontal Alignment Tools ->Line_Line_Fit_Cloto(Rad). 

 AutoCAD/ZWCAD  הודעה: תציגSelect first line עבור לאזור השרטוט ולחץ ,
 על הקו הראשון.

 AutoCAD/ZWCAD  :תציג הודעהSelect second line .בחר את הקו השני , 
 AutoCAD/ZWCAD  :תציג הודעהEnter radius הכנס ערך לרדיוס המקסימום ,

 . Enterבעקומה ולחץ 
בור משיק לקלוטואידות, התוכנה במידה ולא הוכנס רדיוס מתאים ולא ניתן ליצור חי 

 . Tangent not on lineתציג את ההודעה: 
 

  Line Line Fit Cloto(Len)   -   חיבור עקום בין שני קווים הבנוי משתי קלוטואידות
 צמודות, ללא קשת, ע"י הכנסת אורך הקלוטואידות. 

 לחץ על כפתור זה או ע"י:  
Roads->Horizontal Alignment Tools ->Line_Line_Fit_Cloto(Len) . 

 AutoCAD/ZWCAD  :תציג הודעהSelect first line עבור לאזור השרטוט ולחץ ,
 על הקו הראשון.

 AutoCAD/ZWCAD  :תציג הודעהSelect second line .בחר את הקו השני , 
 AutoCAD/ZWCAD  :תציג הודעהEnter Cloto In (0) הכנס את אורך ,

 . Enterהקלוטואידה הראשונה ולחץ 
 AutoCAD/ZWCAD  :תציג הודעהEnter Cloto Out (0) הכנס את אורך ,

 . Enterיה ולחץ יהקלוטואידה השנ
 Tangentבמידה ולא הוכנסו אורכי קלוטואידות נכונים, התוכנה תציג את ההודעה:  

not on line . 
 

  Line Line Fit ReCloto  –   חיבור עקום משלים )הפוך( בין שני קווים הבנוי משתי
 , ללא קשת, ע"י הכנסת הרדיוס.לוטואידות צמודותק
 לחץ על כפתור זה או ע"י:  
 Roads->Horizontal Alignment Tools ->Line_Line_Fit_Recloto. 
 AutoCAD/ZWCAD  :תציג הודעהSelect first line עבור לאזור השרטוט ולחץ ,

 על הקו הראשון.
 AutoCAD/ZWCAD  :תציג הודעהSelect second line .בחר את הקו השני , 
 AutoCAD/ZWCAD  :תציג הודעהEnter radius הכנס ערך לרדיוס המקסימום ,

 . Enterבעקומה ולחץ 
במידה ולא הוכנס רדיוס מתאים ולא ניתן ליצור חיבור משיק לקלוטואידות, התוכנה  

 . Tangent not on lineתציג את ההודעה: 
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  Line Arc Line Fit Cloto  – שלמת  ם בין שני קווים וקשת נתונים ע"י החיבור עקו
 קלוטואידות. 

 לחץ על כפתור זה או ע"י:  
Roads->Horizontal Alignment Tools ->Line_Arc_Line_Fit_Cloto . 

 AutoCAD/ZWCAD  :תציג הודעהSelect first line עבור לאזור השרטוט ולחץ ,
 על הקו הראשון.  

 AutoCAD/ZWCAD  :תציג הודעהSelect arc ,  .בחר את הקשת 
 AutoCAD/ZWCAD  :תציג הודעהSelect second line .בחר את הקו השני , 
 Can't create requestedבמידה ולא יהיה פתרון לעקומה, התוכנה תציג הודעה: "  

segment ." 
 

  Line Arc Line Fit ReCloto  –   חיבור עקום משלים )הפוך( בין שני קווים וקשת
 ואידות. נתונים ע"י השלמת קלוט

 לחץ על כפתור זה או ע"י:  
Roads->Horizontal Alignment Tools ->Line_Arc_Line_Fit_ReCloto. 

 AutoCAD/ZWCAD  :תציג הודעהSelect first line עבור לאזור השרטוט ולחץ ,
 על הקו הראשון.

 AutoCAD/ZWCAD  :תציג הודעהSelect arc .בחר את הקשת , 
 AutoCAD/ZWCAD  :תציג הודעהSelect second line .בחר את הקו השני , 
 Can't create requestedבמידה ולא יהיה פתרון לעקומה, התוכנה תציג הודעה: "  

segment ." 
 

  Clo) )Arc Arc Fit Tangent –   חיבור שתי קשתות ע"י טנגנטה ושתי קלוטואידות
 .ע"י הכנסת אורך קלוטואידות

 לחץ על כפתור זה או ע"י:   
Roads->Horizontal Alignment Tools ->Arc_Arc_Fit_Tangent(Clo). 

 AutoCAD/ZWCAD  :תציג הודעהSelect first arc עבור לאזור השרטוט ולחץ על ,
 הקשת הראשונה. 

 AutoCAD/ZWCAD  :תציג הודעהSelect second arc השנייה, בחר את הקשת. 
 AutoCAD/ZWCAD  :תציג הודעהEnter Cloto out (0) אורך , הקלד את

 .Enterולחץ  הקלוטואידה ביציאה מהקשת הראשונה
 AutoCAD/ZWCAD  :תציג הודעהEnter Cloto in (0) הקלד את אורך ,

 . Enterולחץ  השנייההקלוטואידה בכניסה לקשת 
 Can't create requestedבמידה ולא יהיה פתרון לעקומה, התוכנה תציג הודעה: "  

segment ." 
 

  Len) )Arc Arc Fit Tangent –   חיבור שתי קשתות ע"י טנגנטה ושתי קלוטואידות
 ע"י הכנסת אורך הטנגנטה.

 לחץ על כפתור זה או ע"י:   
Roads->Horizontal Alignment Tools ->Arc_Arc_Fit_Tangent(Len). 

 AutoCAD/ZWCAD  :תציג הודעהSelect first arc עבור לאזור השרטוט ולחץ על ,
 הקשת הראשונה. 

 AutoCAD/ZWCAD  :תציג הודעהSelect second arc השנייה, בחר את הקשת. 
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 AutoCAD/ZWCAD  :תציג הודעהEnter Length הקלד את אורך הקטע הישר ,
 . Enterהמחבר את שתי הטנגנטות ולחץ 

 Can't create requestedבמידה ולא יהיה פתרון לעקומה, התוכנה תציג הודעה: "  
segment ." 

 

   Arc Point Fit Tangent –   חיבור נקודה לקשת ע"י טנגנטה )השלמת טנגנטה
 לקשת ע"י בחירת נקודה(.

 לחץ על כפתור זה או ע"י:  
Roads->Horizontal Alignment Tools ->Arc_Point_Fit_Tangent 

 AutoCAD/ZWCAD  :תציג הודעהSelect arc עבור לאזור השרטוט ולחץ על ,
 הקשת. 

 AutoCAD/ZWCAD  :תציג הודעהSelect point לחץ על הנקודה שבה יסתיים ,
 הקו.

 AutoCAD/ZWCAD  :תציג הודעהEnter Cloto (0) הכנס את אורך הקלוטואידה ,
 .Enterביציאה מהקשת ולחץ 

 Can't create requestedבמידה ויוכנסו ערכים לא הגיוניים התוכנה תציג הודעה: "  
segment ." 

 

    LineEdge Line Fit Arc – קו לקו משיק ע"י קשת**.חיבור קצה * 
 לחץ על כפתור זה או ע"י:  

Roads->Horizontal Alignment Tools ->LineEdge_Line_Fit_Arc 
 AutoCAD/ZWCAD  :תציג הודעהSelect first line עבור לאזור השרטוט ולחץ ,

 הקו שממנו תצא הקשת.  
 AutoCAD/ZWCAD  :תציג הודעהSelect second lineיק  , לחץ על הקו המש

 לקשת. 
 הקו הראשון שיבחר. לקצההקשת תתחבר  * 
 הקשת תהיה משיקה לקו השני שיבחר. **
 בפונקציה זו לא יוזנו קלוטואידות. ***
 

    LineEdge Point Fit Arc – .חיבור קשת מקצה קו עד לנקודה 
 לחץ על כפתור זה או ע"י:  

Roads->Horizontal Alignment Tools ->LineEdge_Point_Fit_Arc 
 AutoCAD/ZWCAD  :תציג הודעהSelect line עבור לאזור השרטוט ולחץ הקו ,

 שממנו תצא הקשת.  
 AutoCAD/ZWCAD  :תציג הודעהPick point  לחץ על הנקודה אליה תתחבר ,

 הקשת. 
 

    LineEdge Radius Fit Arc  –  .חיבור קשת מקצה קו ע"י רדיוס 
 לחץ על כפתור זה או ע"י:  

Roads->Horizontal Alignment Tools ->LineEdge_Radius_Fit_Arc 
 AutoCAD/ZWCAD  :תציג הודעהSelect line עבור לאזור השרטוט ולחץ הקו ,

 שממנו תצא הקשת.  
 AutoCAD/ZWCAD  :תציג הודעהPick side  בחר את צד כיוון הקשת ביחס לקו ,

 )שמאל או ימין(. 
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 AutoCAD/ZWCAD  :תציג הודעהEnter radiusס את רדיוס הקשת ולחץ , הכנ
Enter . 

 

   Line_ArcFit Clotho   – .חיבור עקום בין קו ישר לקשת 
 לחץ על כפתור זה או ע"י:  

Roads->Horizontal Alignment Tools ->Line_Arc_Fit Clotho 
 AutoCAD/ZWCAD  :תציג הודעהSelect lineעבור לאזור השרטוט ובחר את , 

 .הקו
 AutoCAD/ZWCAD עה: תציג הודSelect arc עבור לאזור השרטוט ובחר את ,

 הקשת. 
 התוכנה מייצרת עקום מעבר ביניהם. 

 

   Connect Arc   –  .חיבור שתי קשתות ברצף 
 AutoCAD/ZWCAD  :תציג הודעהSelect first arc  עבור לאזור השרטוט ובחר ,

 קשת הראשונה. ה את
 AutoCAD/ZWCAD  :תציג הודעהSelect second arc לאזור השרטוט  , עבור

 ובחר את הקשת השניה. 
 . תייצר שתי קשתות ברצףהתוכנה 

 

Arc_Arc Fit to Cloto    –  לעקוםחיבור שתי קשתות 
 .יש להשלים תאור 
 יש להחליט על מיקום  

 
 יצירת התוואי האופקי מהשרטוט שנוצר 

נת לשרטט את התוואי האופקי נרצה להגדיר את הציר לפי שרטוט זה. על מ לאחר שסיימנו
 לעשות זאת, בצע השלבים הבאים:

 . Roads->Horizontal Alignmentהפעל מתוך התפריט הראשי:  
 בחר את שם הכביש מתוך הרשימה בחלקו העליון של חלון זה.  
 . Selectלחץ על הכיתוב  
 AutoCAD/ZWCAD  :תציג הודעהEnter an option (<Polyline>/Segment) ,

 . Enter-ו Sלחץ 
ולחץ לפי הסדר על מקטעי הכביש. תוכל להבחין שהתוכנה   עבור לאזור השרטוט 

סימנה באופן אוטומטי מקטעים אלו ע"י סימון עיגולים בטנגנטות. כמו כן תוכל  
 להבחין שלאחר כל בחירת מקטע, התוכנה תסמן חץ ליד המקטע הנבחר.

 . Enterלאחר בחירת כל המקטעים לחץ  
בחלון מימין ותכניס את ערכי    IPs-התוכנה תמלא באופן אוטומטי את טבלת ה 

 הרדיוסים והקלוטואידות בהתאם.
 .  OKובחלון שיפתח לחץ Applyלהצגת הציר שנוצר לחץ על  

 
 
 

 הגדרת חתך האורך 
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לאחר שהגדרנו את התוואי האופקי של הכביש, נעבור לטפל בחתך האורך של הציר. תוכנת  
CivilCAD 10 בסביבת השרטוט של  מאפשרת תכנון חתך לאורך בשתי שיטות: תכנון

. על מנת להגדיר את שיטת העבודה יש לפעול  AutoCAD/ZWCADהתוכנה ותכנון בסביבת 
 לפי השלבים הבאים:

 
 . File->Configurationמהתפריט הראשי הפעל: 

 , בחר באחת מהאפשרויות:Vertical alignment modeליד הכיתוב 
Stand alone- טה הישנה(. עבודה בסביבת השרטוט של התוכנה )בשי 

Drawing environment interface-  עבודה בסביבתAutoCAD/ZWCAD . 
 

תוסבר בסעיף הבא   השנייה, האפשרות Stand-alone*לצורך הדוגמא, נבחר באפשרות 
 .AutoCAD/ZWCADהגדרת חתך האורך בסביבת 

 
  . לפניך יפתח חלון Roads -> Vertical Alignment .  מסרגל התפריט הראשי הפעל:1

 חתך האורך.
 החלון שיפתח מחולק ל: 

 האזור המרכזי של החלון )המשטח השחור(. -אזור השרטוט
 (. Topoהטבלה משמאל למטה )  -טבלת נתוני המצב הקיים

 הטבלה מימין למטה.  -טבלת נתוני התכנון
 החלון הימני. -חלון הפעולות

 
)גם למשתמשי  AutoCAD/ZWCADשים לב שאזור השרטוט אינו חלון 

AutoCAD/ZWCADאם ברצונך לעבוד עם חלון ה .)-AutoCAD/ZWCAD    עבור לסעיף
התוואי האופקי והמצב הקיים, נמצאים בחלון נפרד שנמצא מתחת  -הבא. השרטוט המרכזי

 לחלון החתך לאורך )הקטנת החלון למינימום תגלה שוב את החלון הקודם(. 
 

וואי האופקי ותחשב את גבהי בחלון מימין. התוכנה תעבור לאורך הת Applyלחץ כפתור 
החתך לאורך. גבהים אלו יופיע בטבלת המצב  הקיים )הטבלה השמאלית התחתונה(, 

 מצב קיים.  -כפונקציה של מרחק רץ וגובה. בחלון השרטוט יופיע שרטוט החתך לאורך
 נבהיר מספר נקודות: 

 (.View)תחת הכיתוב  Length -ו Heightלפי הערכים בשדות  מידה החתך ניתן בקנה
הגבהים שבטבלה בתחתית החתך מופיעים לפי מיקום חתכי הרוחב. אם לדוגמא חתכי רוחב  

מ. על מנת לשלוט במיקום הגבהים   20מ', יופיעו הגבהים בחתך האורך כל  20קיימים כל 
 מ':  25הנתונים יש לשנות את מיקום חתכי הרוחב. נשנה לדוגמא את המיקום כל 

 Vertical. יפתח חלון ההגדרות הראשי, תחת הכיתוב ((Options  לחץ על כפתור  
Alignment  :הכנס את המרחק הרצוי ליד הכיתובData intervals . 

 . OKעל מנת לסגור את חלון ההגדרות הראשי לחץ 
 על מנת לחדש את השרטוט. Applyבחלון מימין לחץ 

 
את החתך ע"י הזנת   גם אם לא קיים תוואי אופקי, או שאין בידינו טופוגרפיה ניתן ליצור

(, STנתונים ידנית לטבלת המצב הקיים. לעשות כן יש למלא את הטבלה בנתוני מרחק רץ )
 בחלון הימני.  Apply(. בכדי לקבל את החתך לאחר הזנת הנתונים לחץ Elevוגובה )

אם, בעקבות נתוני טופוגרפיה שגויים, התקבל חתך אורכי שגוי בחלקו, ניתן לערוך את נתוני 
הקיים שהתקבלו באופן ידני. בכדי למחוק שורה בטבלה, עמוד אם העכבר על טור   המצב
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. השורה תמחק. לקבלת Delהמספר הסידורי של השורה )העמודה השמאלית ביותר(, ולחץ 
 בחלון מימין.  Applyהשינוי ע"ג השרטוט לחץ 

 
 : תכנון נקודות המפנה האנכיות

 פי: אונים בטבלה או ע"י שרטוט גרתכנון החתך לאורך יכול להתבצע ע"י הזנת נת
 הזנת נתונים בטבלה. -שיטה א'

מס"ד )העמודה  -טבלת נתוני התכנון )הטבלה הימנית התחתונה( מחולקת לעמודות על פי
(, שיפוע בין מקטעים הניתן Ele(, גובה )STללא כותרת(, מרחק רץ ) -השמאלית ביותר

 (.2T( ואורך הקשת האנכית )%Slopeבאחוזים )
את הנתונים בטבלה, כאשר לכל מקטע הגדר את המרחק הרץ שלו ואת גובהו. התוכנה הזן 

תחשב בין כל שני מקטעים את השיפוע ותציגו מול המקטע הרלוונטי. במקום גובה ניתן להזין  
את השיפוע ממקטע קודם ואז תמלא התוכנה את עמודת הגובה. למחיקת שורה שגויה,  

סידורי )העמודה השמאלית ביותר( מול השורה עמוד עם העכבר על עמודת המספר ה
 בחלון הימני.  Apply. לקבלת שרטוט החתך המתוכנן לחץ Delהרלוונטית ולחץ 

 שרטוט הנתונים גרפית.  -שיטה ב'
 
 

 לשרטוט נתוני התכנון על גבי המצב הקיים, נראה שתי שיטות: 
ר לאזור (. עבוUnused, Pick, Locate,Overwriteברשימה התחתונה ) Pickבחר 

השרטוט, עמוד בצדו השמאלי ביותר של החתך )ניתן לחרוג מעט שמאלה מהמצב הקיים(,  
בטבלת   וולחץ על כפתור העכבר. הנקודה שבחרת תיקבע כנקודת מפנה אנכית ונתוניה יופיע

התכנון )למטה(. המשך לשרטט את חתך האורך. במהלך תנועתך על גבי אזור השרטוט, 
שמימין   Elevation -ו Stהמדויק, גובה ומרחק, תחת הכיתוב תוכל לראות את מיקומך 

 בחלון הימני.  Applyלשרטוט. בסיום השרטוט לחץ 
שים לב: אם תבחר נקודה מחוץ לגבולות המצב הקיים, משמאל או מימין, תקבע התוכנה את  

לשמאל או סוף הקרקע הטבעית לימין(, וזאת  0נקודת המפנה במרחק הרץ הקיצוני ביותר )
 ובה שבו עמדת.בג

דומה   Locate -. השימוש בLocateלשרטוט חתך האורך, הנה בעזרת  השנייההשיטה 
אלא, שכאשר תבחר נקודת מפנה במרחק רץ כלשהי,  Pick -מאד באופן פעולתו לשימוש ב

 היא תקבע בדיוק בגובה המצב הקיים שבאותו מרחק. 
. סמן  Moveחדש נבצע זאת ע"י  אנכי קיים למיקום IP. אם ברצוננו להזיז  Move-שימוש ב

ברשימה, עבור  Moveאותו ברצונך להזיז, בחר  IPבטבלה התחתונה את השור של ה
 בחלון מימין כדי לחדש את השרטוט. Apply. לחץ IPהלשרטוט וקבע את מיקומו החדש של 

פי(. לאחר שניבחר החתך אניתן, כמובן, לשלב בין שתי השיטות )הזנה ידנית ותכנון גר
לקבלת   Applyית, ניתן לשנות את הנתונים שהתקבלו בחלון התחתון, וללחוץ פאגר

לשינוי הגובה   Enterהשינויים )תוכל לדוגמא, לשנות את השיפוע מול מקטע מסוים, ללחוץ 
 לעדכון השרטוט(.  Applyבהתאם לשיפוע, וללחוץ 

וספת נו מנקודת המפנה האחרונה לנקודת מפנה חדשה בהמשך. להיפי האהתכנון הגר
נקודת מפנה באמצע החתך, סמן עם העכבר את השורה של נקודת המפנה הקודמת )זאת  
שאחריה תופיע הנקודה החדשה שברצוננו להוסיף(, עבור לשרטוט וסמן את נקודת המפנה 

מימין להסדרת  Applyהחדשה. הנקודה החדשה תיווסף בטבלה במקום הרצוי. לחץ 
 השרטוט.
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 :תכנון הקשתות האנכיות
 

לאחר שבטבלה קיימים נתוני תכנון נקודות המפנה האנכיות, הוסף את נתוני הקשת האנכית  
 (. את נתוני הקשתות ניתן להזין בשתי צורות: 2Tבעמודה הימנית ביותר )

אורך הקשת יינתן כפונקציה של המרחק בין טנגנטות הקשת האנכית. לאחר  -אורך הקשת
 ון השרטוט.בחלון הימני לעדכ Applyהזנת הנתון לחץ 

  2Tבכדי להזין רדיוס קשת אנכית )במקום אורך(, לחץ עם העכבר על הכיתוב  -רדיוס הקשת
. עתה תוכל להזין את רדיוס הקשת. לחיצה  R -)על כותרת העמודה(. הכיתוב ישתנה ל

 . 2T -, תחזיר לעבודה בRנוספת על הכיתוב 
 
 
 

 : Applyלחץ  לצורך המחשה הקלד הנתונים הבאים בטבלת התכנון. בסיום
 

 
 

 בחלון הימני לסיום תכנון חתך האורך.  Closeלחץ 
 
 

 . ZWCAD/AutoCAD-הגדרת חתך האורך בסביבת ה
 

בסעיף הקודם הוסבר כיצד ניתן לתכנן את חתך האורך ע"י שימוש בסביבת שרטוט עצמאית.  
. על מנת להגדיר את AutoCAD/ZWCAD-בסעיף זה נסביר את אפשרות התכנון בעזרת ה

 טת העבודה יש לפעול לפי השלבים הבאים:שי
 

 . File->Configurationמהתפריט הראשי הפעל: 
 Drawing environment , בחר באפשרות:Vertical alignment modeליד הכיתוב 
interface  . 

 לאישור השינויים.  OKלחץ 
 והמשך לפי השלבים הבאים: Roads->Vertical alignmentהפעל את חלון החתך ע"י:  

 
התוואי האופקי   -. השרטוט המרכזיAutoCAD/ZWCADשים לב שאזור השרטוט הוא חלון 

והמצב הקיים, נמצאים בחלון נפרד שנמצא מתחת לחלון החתך לאורך )הקטנת החלון  
 למינימום תגלה שוב את החלון הקודם(. 

 
הי בחלון מימין. התוכנה תעבור לאורך התוואי האופקי ותחשב את גב Applyלחץ כפתור 

החתך לאורך. גבהים אלו יופיע בטבלת המצב  הקיים )הטבלה השמאלית התחתונה(, 
 מצב קיים.  -כפונקציה של מרחק רץ וגובה. בחלון השרטוט יופיע שרטוט החתך לאורך

 נבהיר מספר נקודות: 
 (.View)תחת הכיתוב  Length -ו Heightלפי הערכים בשדות  מידה החתך ניתן בקנה
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חתית החתך מופיעים לפי מיקום חתכי הרוחב. אם לדוגמא חתכי רוחב  הגבהים שבטבלה בת
מ. על מנת לשלוט במיקום הגבהים   20מ', יופיעו הגבהים בחתך האורך כל  20קיימים כל 

 מ':  25הנתונים יש לשנות את מיקום חתכי הרוחב. נשנה לדוגמא את המיקום כל 

 Verticalשי, תחת הכיתוב (. יפתח חלון ההגדרות הרא(Options  לחץ על כפתור  
Alignment  :הכנס את המרחק הרצוי ליד הכיתובData intervals . 

 . OKעל מנת לסגור את חלון ההגדרות הראשי לחץ 
 על מנת לחדש את השרטוט. Applyבחלון מימין לחץ 

 
גם אם לא קיים תוואי אופקי, או שאין בידינו טופוגרפיה ניתן ליצור את החתך ע"י הזנת  

(, STם ידנית לטבלת המצב הקיים. לעשות כן יש למלא את הטבלה בנתוני מרחק רץ )נתוני
 בחלון הימני.  Apply(. בכדי לקבל את החתך לאחר הזנת הנתונים לחץ Elevוגובה )

אם, בעקבות נתוני טופוגרפיה שגויים, התקבל חתך אורכי שגוי בחלקו, ניתן לערוך את נתוני 
ני. בכדי למחוק שורה בטבלה, עמוד אם העכבר על טור  המצב הקיים שהתקבלו באופן יד

. השורה תמחק. לקבלת Delהמספר הסידורי של השורה )העמודה השמאלית ביותר(, ולחץ 
 בחלון מימין.  Applyהשינוי ע"ג השרטוט לחץ 

 
 

 : תכנון נקודות המפנה האנכיות
 פי: אט גרתכנון החתך לאורך יכול להתבצע ע"י הזנת נתונים בטבלה או ע"י שרטו

 
 הזנת נתונים בטבלה. 

פי נתוני התכנון )הטבלה הימנית התחתונה( מחולקת לעמודות על  מס"ד )העמודה   -טבלת 
ביותר )  -השמאלית  רץ  מרחק  כותרת(,  )STללא  גובה   ,)Ele  הניתן מקטעים  בין  שיפוע   ,)

 (.2T( ואורך הקשת האנכית )%Slopeבאחוזים )
ע הגדר את המרחק הרץ שלו ואת גובהו. התוכנה הזן את הנתונים בטבלה, כאשר לכל מקט

תחשב בין כל שני מקטעים את השיפוע ותציגו מול המקטע הרלוונטי. במקום גובה ניתן להזין 
שגויה,   שורה  למחיקת  הגובה.  עמודת  את  התוכנה  תמלא  ואז  קודם  ממקטע  השיפוע  את 

ביותר(   השמאלית  )העמודה  הסידורי  המספר  עמודת  על  העכבר  עם  השורה עמוד  מול 
 בחלון הימני.  Apply. לקבלת שרטוט החתך המתוכנן לחץ Delהרלוונטית ולחץ 

 
 : AutoCAD/ZWCAD-תכנון הקו בעזרת סביבת ה

ה  בחלון  להבחין  תוכל  לאורך,  בחתך  עבודה  השכבה   AutoCAD/ZWCAD-במצב  ששם 
ה אתVerEdit נו:  יהנוכחית  לבצע  נצטרך  החתך  שרטוט  את  לעדכן  שנרצה  פעם  בכל   , 

. התוכנה Applyהשינויים בשכבה זו. העבר את קו החתך בשרטוט לפי הצורך ובסיום לחץ  
בשם:   לשכבה  התכנון  קו  את  ותעתיק  התכנון  נתוני  טבלת  את  ניתן  Designתמלא  כעת   .

 לבצע שינויים בנתוני החתך ע"י עדכון הנתונים בטבלת התכנון או בשרטוט עצמו. 
         

 :תכנון הקשתות האנכיות
 
 "י הזנת נתונים בטבלה. ע

לאחר שבטבלה קיימים נתוני תכנון נקודות המפנה האנכיות, הוסף את נתוני הקשת האנכית 
 (. את נתוני הקשתות ניתן להזין בשתי צורות: 2Tבעמודה הימנית ביותר )

יינתן כפונקציה של המ  -אורך הקשת רחק בין טנגנטות הקשת האנכית. לאחר אורך הקשת 
 בחלון הימני לעדכון השרטוט. Applyהזנת הנתון לחץ 
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  2Tבכדי להזין רדיוס קשת אנכית )במקום אורך(, לחץ עם העכבר על הכיתוב    -רדיוס הקשת
ל ישתנה  הכיתוב  העמודה(.  כותרת  לחיצה R  -)על  הקשת.  רדיוס  את  להזין  תוכל  עתה   .

 . 2T -, תחזיר לעבודה בRנוספת על הכיתוב 
 

 : Applyבטבלת התכנון. בסיום לחץ  לצורך המחשה הקלד הנתונים הבאים
 

 
 
 
 

)בעבודה עם סביבת   נקודה אשר דרכה תעבור הקשת    AutoCAD/ZWCADע"י סימון 
 בלבד(. 

עם   עבודה  בטבלה   AutoCAD/ZWCADבמצב  הרדיוס  ערך  מלבד הקלדת  לאורך,  בחתך 
  ניתן לבחור מתוך השרטוט היכן תעבור הקשת הרצויה. על מנת להגדיר את הרדיוס בצורה 

 זו בצע את השלבים הבאים:
 את השורה ברצונך לעדכן את ערך הרדיוס.   -designסמן בטבלת ה

 .  -designהנמצא משמאל לטבלת ה לחץ על כפתור  
ה לחלון  במידה   AutoCAD/ZWCAD-עבור  הקשת.  תעבור  דרכה  אשר  הנקודה  את  וסמן 

הו תוצג  הגיונית,  לא  עקב בחירה  זו  פעולה  תוכל להשלים  לא   No such aדעה:  והתוכנה 
curve  . 

בטבלת   אותו  ותעדכן  החדש  הרדיוס  ערך  את  תחשב  התוכנה  הנקודה  בחירת  לאחר 
 .  -designה

 בחלון מימין.  Applyעל מנת לעדכן את השרטוט יש ללחוץ 
 

 : Design-פעולות נוספות בטבלת ה
 

Pick point  -  פתור  . לאחר לחיצה על כמסוימתבדיקת נתוני קרקע ושיפועים בנקודה
את    Design-זה יש לבחור את הנקודה הרצויה בשרטוט. התוכנה תציג מעל לטבלת ה

 הנתונים הבאים:
Station –  .המרחק הרץ של נקודה זו על הציר 

Elevation –  .גובה הנקודה 
Slp(T) –  .שיפוע הקרקע הקיימת בנקודה זו 
Slp(D) –  .שיפוע התכנון בנקודה זו 

 

Define designed slope  – פעולה זו מאפשרת הגדרת הגדרת שיפוע מתוכנן .
השיפוע לשרטוט הקו על מנת לעשות כך בצע את השלבים הבאים: לחץ על כפתור זה 

-הקלד את ערך השיפוע הרצוי. כעת אם תעביר בחלון ה AutoCAD/ZWCAD-ובחלון ה
AutoCAD/ZWCAD  למצבORTHO בחלקו התחתון של חלון ה(-AutoCAD/ZWCAD )

 טט את קו התכנון בשיפוע אשר הוגדר. תוכל לשר
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 כפתורים בחלון הימני: 
 

טקסט   קובץ  מתוך  אורך  חתך  נתוני  קוראת ASCII)  קליטת  זו  פעולה   .)
נתוני מצב קיים לתוך הטבלה )הטבלה השמאלית התחתונה( מתוך קובץ טקסט 
שורות  של  להיות  צריך  הקובץ  מבנה  וגובה.  רצים  מרחקים  רשימת  שבו  פשוט 

 חק רץ וגובה מופרדים ברווח/פסיק. ובהן מר
 

בקובץ טקסט   האורך  נתוני חתך  זו שומרת  את ASCII)  שמירת  (.פעולה 
קובץ טקסט.   ידנית(, לתוך  )או הוזנו  נתוני המצב הקיים שנקראו מהטופוגרפיה 

 הטקסט תהיה רשימה של מרחקים רצים וגובה.ץ קובמבנה 
 

האורך   לחתך  תעלה  גדות  נתוני  תוכנת    -Get edges  כפתור  -הוספת 
CivilCAD 10   כזה תכנון  נחלים.  תעלה/הסדרת  תכנון  לצורכי  לשמש  יכולה 

כ ישמש  דומה לתכנון כביש, אלא שחתך האורך   Invert Level  -יתבצע בצורה 
(IL ,של תחתית התעלה. באפשרות התוכנה להוסיף לחתך האורך של התעלה )

ימין. להלן סדר הפעולות גם את חתך האורך של גדות התעלה/הנחל, משמאל ומ
 לקבלת חתכי אורך אלו:

 הגדר חתך אורך של תחתית התעלה )כפי המפורט בסעיף זה(.
)לפרוט ראה פרק   רוחב והסדר את חתכי הרוחב של התעלה/נחל  עבור לחתכי 

 הגדרת חתכי הרוחב(.
נתוני  את  תקרא  התוכנה  הנ"ל.  הכפתור  על  ולחץ  האורך  חתך  לחלון  חזור 

ח מתוך  בחתךהתכנון,  ותוסיפם  התעלה,  קצוות  של  הרוחב,  הן    -תכי  האורך 
 כשרטוט, והן כשורות נוספות בטבלה התחתונה.  

 

ב     הטופוגרפיה  גבהיי  גבהיי הנתון   Offset-קבלת  את  להציג  מנת  על   .
 מהציר יש לבצע את השלבים הבאים: מסוים הטופוגרפיה במרחק 

מימין לאפשרות זו את המרחק והקלד בשדה    G.L. at offset (L)סמן את האפשרות   
 מהצד השמאלי של הציר. 

האפשרות    את  את   G.L. at offset (R)סמן  זו  לאפשרות  מימין  בשדה  והקלד 
 המרחק מהצד הימני של הציר. 

 . התוכנה תוסיף שכבות אלו ע"ג החתך.Applyלאחר מילוי נתונים אלו, לחץ  
 

 . Vertical alignment -פעולות כלליות בחלון ה 
 

1. Accurate/By sections –    .הצגת חתך אורך מדויק או בחתכים בלבד
את חתך האורך מתוך הטופוגרפיה, היא   CivilCAD 10כאשר קוראת תוכנת 

מבצעת זאת באופן מדויק המושפע מצפיפות הנקודות המדודות )התוכנה 
בונה את חתך האורך על פי מפגשי צלעות המשולשים שהיא יוצרת מתוך  

המרחקים הרצים שבהם דגמה התוכנה את הגבהים, קובץ המדידה(. את 
ניתן לראות בטבלה השמאלית התחתונה )טבלת במצב הקיים(. לעיתים,  
דגימה זאת, אל אף שהיא מדויקת, אינה טובה למשתמש )לדוגמא: בקובץ 
המדידה נפלה טעות, המופיעה בחתך לאורך אך היא אינה רלוונטית כיוון  

 Byלבין  Accurateרת מצב הבחירה בין שאינה באחד מחתכי הרוחב(. העב
sections:תפתור בעיה זאת בצורה הבאה , 
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 Accurate  –   דגימה מדויקת של החתך. קו שרטוט החתך יהיה בדיוק
ע"פ הדגימה שבוצעה מהטופוגרפיה. הגבהים בטבלה התחתונה יופיע  

מ'(, ובנוסף יופיע גבהים   20כל  -על פי חתכי הרוחב )ברירת מחדל
 קריטיות. בנקודות 

 By sections –   דגימה מדויקת של החתך אך קו שרטוט החתך יבנה
ע"פ הגבהים בחתכי הרוחב בלבד. הטבלה התחתונה תישאר כפי  

 שהייתה.
 נו "בהחלקת" חתך האורך. חסרונה הוא בדיוק.יה By sectionsיתרונה של שיטת  
 

2. Centerline/DitchR/DitchL/References -  ך  מעבר בין תכנון חת
 . מסויםהתייחסות לקו /האורך של הציר/תעלת צד ימין/תעלת צד שמאל

מאפשרת הפרדה בין הגדרת חתך האורך של הציר,  CivilCAD 10תוכנת 
של תחתית תעלה, משמאל או מימין לציר, אם קיימת  IL -ובין הגדרת ה

של אחת מהתעלות, ניתן לבחור את התעלה  ILכזאת. למעבר להגדרת 
המלא של הגדרת תעלות צד, עיין בסעיף "תכנון תעלות   הרצויה )לתהליך
 צד" שבפרק זה(.

 
3. Include R. Ditch/ L. Ditch  אם קיים תכנון תעלה בכביש הנוכחי ,

-בחתכי הרוחב ואפשרויות אלו מסומנות, התוכנה תציג על החתך את ה
Invert Level  של תחתית התעלה בצד שמאל וימין בהתאם לסימון -

R.ditch וימין- L.Ditch-.שמאל 
 

4. ) Unlock datum  חלון עם    –בלבד(    AutoCAD/ZWCADבעבודה 
ושרטוט  זו    במידה  אפשרות  לסמן  יש  הנתונים  טבלת  לתוך  חורג  החתך 

התוכנה תגביה את רשת החתך על מנת שהקווים בשרטוט    .Applyוללחוץ  
יהיה  גובה הרשת  לא מסומנת  זו  ואופציה  יחרגו לתוך הנתונים. במידה  לא 

 עול". "נ
 

5. View-  תוכנת  קביעת קנה מידה לתצוגת החתך .CivilCAD 10    מאפשרת
קנה  את  לקליד  יש  השרטוט.  בחלון  החתך  יוצג  בו  המידה  קנה  את  לקבוע 

  Apply( וללחוץ  view)תחת הכיתוב    Height,Lengthהמידה הרצוי בשדות  
 לעדכון השרטוט. 

 
 

 כפתורים בחלון השרטוט: 
 

6.    Zoom Extents  -  לחיצה על כפתור זה תחזיר את   כל החתך.צפייה ב
השרטוט   את  המשתמש  הזיז  ובו  במקרה  השרטוט.  בכל  הצפייה 
על   בלחיצה  השרטוט  הגדיל/הקטין  או  הגלילה,  פסי  בעזרת  שמאלה/ימינה 
כפתור שמאלי/ימני באזור השרטוט, לחיצה על כפתור זה תחזיר את הצפייה  

 לכל אזור השרטוט.
 

יצירת )לאופן הפעולה ראה פירוט בסעיף    של החתך  DXFיצור קובץ      .7
 (.לגיליונותוחלוקה  DXFקבצי 
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 כפתורים בחלון התחתון:            

 

ה     .8 ביצוע   -Designבטבלת  לפני  מהטבלה.  התכנון  נתוני  כל  מחיקת 
 התרעה. הפעולה תופיע הודעת

 

לאורך     .9 החתך  של  הגבהים  גובה    -הגבהה/הנמכת  להורדת/הוספת 
 לאורך בצע הפעולות הבאות:לגבהים של החתך 

 . dHלחץ על כפתור  
הגבהים   את  סמן  האורך.  בחתך  המתוכננים  הגבהים  רשימת  תופיע  שיפתח  בחלון 

  dH  -( בתחתית. בשורת הAll)  Aשברצונך לשנות. לשינוי כל הגבהים לחץ כפתור  
( שלילי  בסימן  הפרש  הכנס  גובה  להורדת  להוספה.  הגובה  את  הכנס  (. -)למטה(, 

 ביצוע הפעולה. ל OKלחץ 
בטבלת התכנון התחתונה. לקבלת השינויים  נו  ישתהגבהים שנבחרו                      

 )מימין(.  Applyעל גבי השרטוט לחץ 
 

לפני ביצוע    מחיקת כל נתוני המצב הקיים מהטבלה.  -Topoבטבלת ה     .10
 הפעולה תופיע הודעת התרעה.

 

ע   -קריאת חתך האורך מתוך הטופוגרפיה   .11 זה תפתח  לחיצה  כפתור  ל 
,  Existing G.L  -חלון. בחלון בחר את הטבלה אליה יוכנסו נתוני הטופוגרפיה

הקיים,   המצב  לחץ  Designed G.Lלטבלת  המתוכנן.  המצב  לטבלת   ,OK  
 להמשך. הנתונים יכנסו לטבלה בהתאם. 

 

לחיצה על כפתור זה    -  קריאת חתך האורך מתוך טופוגרפיה מתוכננת   .13
בחלון חלון.  הטופוגרפיה    תפתח  נתוני  יוכנסו  אליה  הטבלה  את  בחר 

, לטבלת Designed G.L, לטבלת המצב הקיים,  Existing G.L  -המתוכננת
 להמשך. הנתונים יכנסו לטבלה בהתאם.   OKהמצב המתוכנן. לחץ 

 

. לחיצה על  העתקת המרחקים של המצב הקיים לתוך המצב המתוכנן   .14
בלבד הרצים  המרחקים  את  תעתיק  זה  טבלת    כפתור  מתוך  הגובה(  )ללא 

 המצב הקיים אל טבלת המצב המתוכנן.
 

ניתן לשנות לכל סוג של שכבה בתצוגה את הצבע   –  שינוי הצבעים בתצוגה .15
שלה ע"י לחיצה על אחד מכפתורי הצבעים שנמצאים בחלקו הימני עליון של 

שבו יש    Colorחלון השרטוט. לחיצה על כל אחד מצבעים אלו תפתח חלון  
 ת הצבע הרצוי. הצבעים מחולקים לפי הפרוט הבא:לבחור א

   

C.L. Center level – חתך האורך המתוכנן 

G.L. Ground level  –  חתך המצב הקיים 

D.R. Ditch right – חתך התעלה הימנית 

D.L. Ditch left  –  חתך התעלה השמאלית 
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שכבות לא יופיעו.  כפתורי הצבעים של ה  AutoCAD/ZWCADבעבודה עם סביבת  * הערה: 
 .AutoCAD/ZWCAD-את שינוי הצבעים יהיה ניתן לבצע מתוך רשימת השכבות ב

   
יצירת שתי שכבות טופוגרפיה באותו פרויקט. שכבה אחת    CivilCAD 10תוכנת   מאפשרת 

תהיה טופוגרפית מצב מתוכנן. פרק "תכנון  שנייהתקרא שכבת טופוגרפית מצב קיים, ושכבה 
חילתו על הוצאת נתונים מתוך טופוגרפית מצב קיים בלבד, שכן שימוש כבישים" מתבסס בת
מצב   גובה  נן  וכמתבטופוגרפית  קווי  ליצירת  מתוכנן,  מצב  טופוגרפית  משמשת  ככלל  נדיר. 

יי שטחים,  בהסדרת  אלא  כבישים  בתכנון  שלא  חישובי  מתוכננים  ומשטחים,  מגרשים  שורי 

 יהיה מועט.   עוד. השימוש, אם כן, בכפתור  עבודות עפר בשטח פתוח )ולא בתוואי אורכי( ו
 
 
 
 

 תכנון חתך אורך אלטרנטיבי
 

 ניתן לתכנן מס' אלטרנטיבות בחתך אורך של כביש.
 . Roads→Vertical Alignment‘ ’לביצוע הפעולה, מהתפריט הראשי הפעל: 

כפתור   על  )לדוגמא:     ’Add new alternative‘לחץ  האלטרנטיבי  לחתך  שם  והגדר 
Alternative1 .) 

 ותכנן את חתך האורך האלטרנטיבי. OKלחץ 
 (, Centerlineכדי להגדיר את החתך האלטרנטיבי כחתך האורך העיקרי )

 ייפתח:   ’Set as centerline‘. חלון   ’Set as centerline‘לחץ על כפתור 
 

  
 

 בחר באופציה הרצויה על פי ההנחיות בחלון. 
' תעדכן רק את  ’Applyאך לחיצה על כפתור    ’VerEdit‘הערה: שכבת חתך האורך תישאר  

 טבלת 
 של חתך האורך האלטרנטיבי והשרטוט. Design –ה 

חובה להגדיר את    –כדי שחתכי הרוחב של הכביש יתעדכנו על פי חתך האורך האלטרנטיבי  
 (.Centerlineחתך האורך האלטרנטיבי כחתך העיקרי )

 
  :ת חתך אורך אלטרנטיביכפתורים מסוימים יהיו נגישים רק לאחר הגדר
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 עבור כל חתך אורך אלטרנטיבי יתקבלו שכבות נפרדות על פי שם החתך בחלון 
 ‘Layer Properties Manager’ 

 . OKולחץ    ’Erase current alternative‘כדי למחוק חתך אלטרנטיבי, לחץ על כפתור 

כפתור   על  לחץ  כל החתכים האלטרנטיביים,     ’Delete all alternative‘כדי למחוק את 
 . OKולחץ 

בכפתורים השתמש  אחר,  אלטרנטיבי  לחתך  אחד  אלטרנטיבי  מחתך  נתונים  להעתיק   כדי 

‘Copy/Paste’    /  

 

 

 מחתך האורך.  לגיליונות וחלוקה  DXFיצירת קבצי  
 

 : של חתך האורך  DXFיצור קובץ 
 

)נוכל גם כמובן לעשות של חתך האורך    DXFלאחר שסיימנו את התכנון, נרצה להוציא קובץ  
 כן למצב הקיים בלבד(:

 הנמצא בסרגל הכלים שמעל לחלון לשרטוט.    לחץ כפתור 
.  X  –ל    1בחלון שיפתח הגדר קנה מידה לאורך ולרוחב. קנה המידה הנו ביחס של   

  Long  -(, ובתיבת ה100הקש את קנה המידה לגובה )לדוגמא:    Heightבתיבת ה   
 (.  1000דוגמא: הקש את קנה המידה לאורך )ל

תחת הכיתוב:   No Divisionללא חלוקה בחר באפשרות    DXFעל מנת ליצור קובץ   
Divide by paper size אם ברצונך ליצור חלוקה לפי גודל דף בחר מתוך הרשימה .

 את גודל הדף הרצוי. 
 .OKלהמשך לחץ  
לשמירת   Saveשיח קבצים שתפתח הכנס את שם קובץ השרטוט. לחץ  -בתיבת דו 

 בץ.הקו
 

 :ליונותיחלוקת חתך האורך לג
 

באופן אוטומטי. פעולה    גיליונותמאפשרת חלוקת חתך האורך למספר    CivilCAD 10תוכנת  
בצע    לגיליונות. על מנת לחלק את החתך  AutoCAD/ZWCAD  -זו אפשרית בעבודה רק עם

 את השלבים הבאים:

 מתוך סרגל הכלים שנמצא מעל לחלון השרטוט.  לחץ על כפתור   
 חלון שייפתח קבע את ההגדרות הבאות:ב 
 . Scaleהקלד את קנה המידה תחת הכיתוב  
 . Divide by paper sizeבחר את גודל הדף לחלוקה ליד הכיתוב  
על מנת לכלול בגיליון את התוואי האופקי באותו  –  Show layoutסמן את האפשרות  

 קטע.
 את החתך עצמו.  בגיליוןעל מנת לכלול  –  Show sectionsסמן את האפשרות  
 . Paper overlappingליד הכיתוב:  הגיליונותהכנס מרחק חפיפה בין  
 . Frames grid stepsהכנס את מרווחי הרשת ליד הכיתוב:  
הכיתוב   ליד  הכפתור  על  לחץ  הצפון  חץ  את  המכיל  בלוק  קובץ  לייבא  ברצונך  אם 

Arrow-block  .ובחר את מיקום הקובץ 
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את לוגו/פרטי החברה לחץ על הכפתור ליד הכיתוב אם ברצונך להטביע בלוק המכיל   
Table-block  הקובץ מיקום  את  או   .ובחר  מימין  הבלוק  מיקום  את  סמן  בחרת  אם 

 . Table positionמשמאל לגיליון באפשרות 
 . Rangeתחת הכיתוב  בגיליונותהקלד את תחום החתך שיופיע  
 להמשך. OKלחץ  
 .Paper space-ב הגיליונותהתוכנה תיצור את חלוקת  

 

 הצטלבויות כבישים בחתכי האורך 
 

ויצרנו   תוכנת    פרויקטבמידה  זה  עם  זה  כבישים המצטלבים  מתוכננים   CivilCAD 10שבו 
( Vertical alignmentתסמן באופן אוטומטי את הצטלבויות אלו בחלון תכנון חתכי האורך)

כיוון הה יסמנו את  אלו  עצמו. דגלים  גבי שרטוט החתך  דגלים על  צטלבות, שם הכביש ע"י 
 המצטלב ואת המרחק הרץ של ההצטלבות. 

 
דגל  האורך  בחתך  לראות  נוכל  נקודה,  באותה  כיוונים  לשני  שמצטלב  כביש  ותכננו  במידה 
המסמן את שני הכיוונים, ובמידה ונתכנן כביש שממנו המפגש עם כביש אחר הוא לכיוון אחד  

 כיוון זה בלבד.  ( נוכל לראות את הסימון ע"י דגל המסמן אתT)צומת 
 

           

 הצטלבות לכיוון אחד              הצטלבות לשני כיוונים

 
 

 נבהיר מספר נקודות:  
במידה ולא קיים תכנון של חתך האורך בכביש המצטלב נקבל בסימון ההצטלבות את  

 גובה המצב הקיים בנקודת ההצטלבות. 
התוכנה תעדכן באופן אוטומטי    בכל שינוי בתוואי האופקי שיתבצע בצירים מצטלבים,  

 את ההצטלבות בחתך האורך.
 
 

 תכנון חתכי הרוחב 
 

נו החלק המורכב ביותר בתכנון הכביש. נראה כיצד ניתן להגדיר חתך יתכנון חתכי הרוחב ה
טיפוסי, להשליכו לאורך כל הכביש, להגדיר מספר חתכים טיפוסיים, להגדיר מעברי 

 שיפועים ועוד. 
 ק הקודם, חתך אורך לכביש, נעבור להגדרת חתכי הרוחב: לאחר שהגדרנו, בפר

 
 הגדרת החתכים 

. לפניך יפתח Roads -> Cross sections.    מסרגל התפריט הראשי הפעל:  1 
 חלון חתכי הרוחב. 
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 חלון חתכי הרוחב מחולק לשלושה חלקים:
השרטוט  הנוכחי    -אזור  החתך  של  שמו  החתך.  שרטוט  יופיע  שבו  המרכזי  האזור 

 א בעבודה יופיע בכותרת מעל השרטוט.הנמצ
 החלון הימני.  -טבלת רשימת חתכי הרוחב 
הטבלאות בחלקו התחתון של    -טבלאות נתוני המצב הקיים והמתוכנן לכל חתך וחתך 

 -Designed G.Lנתוני המצב הקיים בטבלה השמאלית,    –  Existing G.Lהמסך:  
 נתוני המצב המתוכנן בטבלה הימנית.

 
סוף הפרק מלווה ההסברה בהדגמה. את ההדגמה ניתן לעשות על בסעיף הבא ועד 

הפרויקט שהותחל בפרק "הכנת רקע לעבודה" וליווה את ההסברה על שלבי תכנון הכביש 
 עד כה.

 

כפתור  2 על  לחץ   .   (Define sections  חלון יפתח  לפניך  הימני.  שבחלון   )
 הגדרת חתכי הרוחב. בחלון הגדר את הנתונים הבאים:

 Start at station-    בדרך כלל 0מרחק רץ של חתך הראשון. ברירת המחדל תהיה .
 .  0נרצה שהמרחק הרץ שיינתן לחתך הראשון בקטע הציר המתוכנן יהיה 

 End at station-    מרחק רץ לחתך האחרון. ברירת המחדל תהיה על פי אורכו של
חל פתיחת  עם  מיד  מופיע  זה  )אורך  התוכנה  ידי  על  שיחושב  כפי  חתכי הציר  ון 

 (. Roads length -הרוחב, בחלון מימין
 Distance between sections-   שאין נראה בהמשך  הרוחב.  חתכי  בין  המרחק 

החתכים  כל  את  להגדיר  ניתן  מזאת,  ויתרה  סדרתיים,  רוחב  חתכי  ביצירת  חובה 
 לרוחב באופן שאינו סידרתי.

 Name of first section-  כנה תמספר את שמו של החתך הראשון )מספרו(. התו
המצוין בחלון, נסביר את שני מצבי     Format-שאר החתכים בסדר עולה בהתאם ל

 : Formatה 
היא   הראשונה  מופיעים   Format1האפשרות  שהם  כפי  החתכים  שמות  את  המציגה   ,

 ברשימת החתכים. 
, ע"י שינוי הפרמטרים שיופיעו בתחתית החלון     Format2 אם נבחר את האפשרות 

ג את שם החתך בצורה הבאה:  מרחק רץ+קמ ,לדוגמא: אם נשאיר את התוכנה תצי
בצורה הבאה:  KM  :0הערך בשדה   , 020+0,  000+0, התוכנה תציג את החתכים 

040+0  ....,380+0 
הבחירה  הגדרת   -By stations/By IPs  -תיבת  בין  בחירה  מאפשרת  זו  תיבה 

הגדרת ציר אשר חתכיו   כביש/ציר, אשר חתכי הרוחב שלו מסודרים בסדר עולה, לבין
,  By IPs  -( של התוואי האופקי. העברת המצב ל  IP  -נקבעו על פי נקודות המפנה )ה
 תעלים את שאר השדות במסך.

הגדרת חתכי רוחב על פי נקודות המפנה, שימושי בעיקר בתכנון הסדרת 
נחלים שבו נרצה חתכי רוחב בנקודות ספציפיות. להרחבה בנושא ראה  

 לות והסדרת מאגרים".פרק: "תכנון תע
 

בהתאם   OKלחץ    מימין  בטבלה  תופיע  שנבנו  החתכים  רשימת  החתכים.  לבניית 
 (. Station( ומרחק רץ )Nameלהגדרות שנבחרו, ולכל חתך יופיע שם )

 , בכל רגע נתון. לעשות כן בצע: לפרויקטניתן להוסיף חתכי ביניים  
 ף חתך לפניה. מקם את הסמן )בעזרת העכבר( על השורה שברצונך להוסי 
 )במקלדת(. השורה תקפוץ כלפי מטה ותופיע שורה חדשה. Enterלחץ  
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לכלול   יכול  החתך  שם  החדש.  החתך  של  )מספרו(  שמו  הכנס  החדשה  בשורה 
,  2  –ל    1"/" )אך לא אותיות(. אם החתך החדש הנו לדוגמא בין חתך    -מספרים, "." ו

לו בשם   לעמו1.1תוכל לקרוא  ).  עבור עם החץ הימני  (,  Stationדת המרחק הרץ 
 והכנס את המרחק הרץ של החתך שהוספת.

 
ניתן לעבור מיד לחלון   ידי הכפתור הלבן  הערה: במקום להגדיר חתכים באופן אוטומטי על 

 שם ומרחק רץ לכל חתך וחתך.  -הימני ולבנות הטבלה באופן ידני
 

ה .4 כפתור  על  שמח  Options    -  לחץ  יד  ועליו  )כפתור  הימני  זיקה  שבחלון 
 כרטסת(. לפניך יפתח חלון: 

הגדר את רוחב החתך לעבודה. הכוונה היא לרוחב הקרקע שתדגום התוכנה למצב  
לימין   מהציר  ומרחק  לשמאל  מהציר  מרחק  נגדיר  אנו  הטופוגרפיה.  מתוך  הקיים 

ו יגדירו את רוחב רצועת הקרקע. את קצהו השמאלי של החתך נגדיר בשדה ישיחד
)ברירת   Right  -מ'(, ואת קצהו הימני נגדיר בשדה ה  20-)ברירת המחדל    Left  -ה

 נו מספר שלילי ומרחק מימין הנו חיובי.  ימ'(, כאשר מרחק משמאל לציר ה 20המחדל 
מימין )או משמאל( לציר שלנו. במקרים  יתכן מצב שבהן נרצה ברצועת ציר שכולה  *  

רחקים הרצים  כאלה ניתן להגדיר חתך שכולו מימין )או משמאל( וזאת בעזרת המ
 המתאימים.

 ניתן להגדיר רוחב קרקע משתנה בכל חתך על פי שכבה.
 . Roads→Horizontal Alignment‘לביצוע הפעולה, מהתפריט הראשי הפעל: '

לצד הציר המבוקש )במידה ונדרש רוחב משתנה משני צידי הציר,    Polylineשרטט  
מות הציר ושניהם באותה אחד בכל צד כאשר כיוונם לפי כיוון התקד  Polylineשרטט  
 שכבה!(. 

 .Roads→Cross Sectionsמהתפריט הראשי הפעל: 

 ייפתח.  ’Options‘. חלון   ’Options‘לחץ על כפתור 
 

 ולאחר מכן לחץ על כפתור  ’By Layer‘באופציה  ’V‘סמן 

 ‘Get section width by layer’  חלון .‘Width by layer’  .ייפתח 

  OK  -ו  Enter, סמן את השכבה מתוך השרטוט, לחץ    ’Select‘בחר באופציה  
 . OKאו בחר את השכבה מתוך הרשימה ולחץ 

 התוכנה תבצע סריקה ובסיומה תתקבל ההודעה הבאה:
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  Get section width by layer‘השכבה שנבחרה תופיע ליד כפתור 

. 
 .’Options‘לשמירת ההגדרות וליציאה מחלון  OKלחץ 

 . OKולאחר מכן לחץ     ’Get topo data for all sections‘לחץ על כפתור 

לעדכון רוחב החתכים בשרטוט     ’Interpolate empty sections‘לחץ על כפתור 
 ע"פ ההגדרות החדשות.

 
מ    בתוכנת  dH  -ל   Elevation  –העבר   .CivilCAD 10   רוחב חתכי  להגדיר  ניתן 

ים. עבודה בגבהים אבסולוטיים  בעלי גבהים אבסולוטיים, או חתכים בעלי גבהים יחסי
להגדיר   אותנו  ותחייב  הרוחב,  חתכי  על  האורך  חתך  השפעת  את  למעשה  תבטל 
תכנון נפרד לכל חתך וחתך )או מילוי חתכי ביניים על ידי אינטרפולציות כפי שמודגם  
חתכים  עם  בעבודה  נדון  הפרק  בהמשך  בכבישים"(.  עפר  עבודות  "חישובי  בפרק 

 הים יוגדרו באופן יחסי.  טיפוסיים ועל כן הגב
 

. אופציה זו מגדירה את אופן ההצגה הגרפית של  Design  -ל Earthwork -העבר מ 
עפר   עבודות  להצגת  חתך  חתך:  הגדרת  של  אפשרויות  שתי  לתוכנה  החתך. 

Earthwork  מתוכננים חתכים  להצגת  וחתך   ,Design  ליידי יבוא  בתצוגה  השוני   .
והן   רטוט, הן בהדפסתם דרך התוכנה למדפסתביטויי הן בצורת החתכים בחלון הש

גיליון   גבי  על  חתכים  קובץ  ההבדלים  AutoCAD/ZWCADביצירת  על  נעמוד   .
 עיקריים שבין שתי התצוגות:ה

אפשרות   תכנון,  לצורכי  בחתך  בלבד.  שכבות  שתי  מופיעות  עפר  עבודות  בחתך 
 שכבות )קיים, עבודות עפר, פני מבנה חתך(.  3להצגת 

מ  לקבוע  הבחירה  ניתן  כאשר  האפשריות:  שלוש  מתוך  שיופיעו  השכבות  שתי  הן 
על   לבחירה:  Earthworkמסומנת  השכבות  רשימת  תופיע   ,Existing-    ,קיים מצב 

Design-    ,גובה עבודות עפרStructure-   פני מבנה כביש. בחר את שתי השכבות
 שברצונך להציג.

ן עובי לאספלט, הוספת בחתך תכנון אפשרויות שונות של הגדרת פני מבנה כמו מת 
להגדיר   גם  ניתן  תכנון  בחתך  ועוד.  בטיחות  מעקה  שפה,  אבן  כגון:  לחתך  בלוקים 

 תעלות צד.
בחתך לצורכי    -טבלת הנתונים שונה בין חתך לצורכי תכנון לבין חתך לעבודות עפר 

טבלת נתוני הקרקע הקיימת בתחתית, ונתוני התכנון ממוקמים על גבי   התכנון מופיע
עפר  ע  -החתך עבודות  לצורכי  בחתכים  מעל.  מבנה  פני  וגובה  מתחת,  עפר  בודות 
כל הנתונים בטבלה התחתונה, וכן יופיעו שתי שורות נוספות בטבלה המציגות    ויופיע 

 את אופן חישוב שטח החתך בחפירה ובמילוי, תוך כדי חלוקה למקטעים. 
מ  .  Close design to structure  -ל  Close design to existing  -העבר 

האפשרות   התכנון,  בקצוות  הדיקורים  סגירת  אופן  את  מגדירה  זו   Closeאופציה 
design to structure  ואילו  המבנה   לקצוות  המתוכנן  המצב  קצוותאת    תסגור 

למצב   Close design to existing   האפשרות המתוכנן  המצב  קצוות  את  תסגור 
 הקיים. 

 כל חתך רוחב בנפרד:  עבור  Existing –ל  Design –להגדרת דיקור ה  
 .’Roads→Cross Sections‘מהתפריט הראשי הפעל: 
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בחלון   המחדל  ברירת  כלומר  הינה    ’Options‘הערה:   ,
Designed G.L.    ה שיפוע  את  ה    Structure  –ימשיך  בטבלת  ההגדרות  פי    –על 

Structure . 
חתכים  או  חתך  על  להחלה  ניתנת  ואינה  הרוחב  חתכי  כל  על  חלה  זו  הגדרה 

 וימים. מס
לדקר ל     .Designed G.Lכדי  מסוים  רוחב  חתך    ’V‘סמן   ,.Existing G.L  -של 
 באופציה

 ‘Close to existing’    ולחץ על כפתור‘Apply’. 
חלון   על  הימני בעכבר  עם הלחצן  נוספים, הקלק  כדי לשלוח את ההגדרה לחתכים 

 ייפתח.  ’Send to‘הבחירה הנ"ל. חלון 
ליהם אתה רוצה לשלוח את ההגדרה או לחץ על כפתור  סמן את החתכים ברשימה א

‘All’   לסימון כל החתכים ברשימה ולחץOK . 

כפתור   על  ע"פ      ’Interpolate empty sections‘לחץ  החתכים  שרטוט  לעדכון 
 ההגדרות החדשות.

ה   סימן  את  הסר  המחדל,  ברירת  למצב  החתכים  הגדרות  את  להחזיר    ’V‘  –כדי 

 .מהאופציה  
לש חלון  כדי  על  הימני בעכבר  עם הלחצן  נוספים, הקלק  לוח את ההגדרה לחתכים 

 ייפתח.  ’Send to‘הבחירה הנ"ל. חלון 
סמן את החתכים ברשימה אליהם אתה רוצה לשלוח את ההגדרה או 

 . OKלסימון כל החתכים ברשימה ולחץ    ’All‘לחץ על כפתור 

ון שרטוט  לעדכ   ’Interpolate empty sections‘לחץ על כפתור 
 החתכים ע"פ ההגדרות החדשות.

 

היא כי  תתריע. התוכנה OK. בחלון שיפתח לחץ   GetT allלחץ על כפתור  .5
הקודמים  לשנות את נתוני המצב הקיים לנתונים חדשים וכי הנתונים דת ומע
להמשך. התוכנה תעבור לאורך הציר ותדגום את נתוני המצב   OKמחקו. לחץ  יי

 כים שהוגדרו. הקיים לאורכו, לפי החת
פעולת דגימת נתוני המצב הקיים תלויה במספר נקודות המדידה שבפרויקט,  

רציפות שבו ובמספר חתכי הרוחב שהוגדרו. בפרויקטים גדולים  ה-מספר קווי אי
אינה מוגבלת בגודל  CivilCAD 10יתכן ופעולה זאת תיקח זמן מה. תוכנת 

לי זיכרון מועט, יתכן  הפרויקט ובאורך הציר, אך במחשבים איטיים או בע
 ופעולתה תיקח זמן רב ולעיתים אף "תיתקע".

(, התבקשת Select table -)חלון ה בחלון שניפתח לאחר לחיצה על כפתור  
לבחור את הטבלה שאליה יוכנסו נתוני הטופוגרפיה. ברירת המחדל של התוכנה  

)המצב הקיים( של  Existing G.L -הנה הכנסת הנתונים לתוך טבלת ה
חתכים. יתכנו מקרים בהם נרצה לקרוא את נתוני הטופוגרפיה לטבלאות ה

אחרות, כגון המצב המתוכנן. לביצוע זאת יש לבחור את הטבלה הרצויה ורק  
 . OKאחרי כן ללחוץ 

 
בסיום קריאת נתוני המצב הקיים יופיע החתך הראשון בחלון השרטוט ונתוני  

עמוד )בכותרת שמעל המצב הקיים יופיעו בטבלה משמאל למטה. בראש ה
, ובנוסף  Sections name: 1השרטוט(, יופיע שמו של החתך המוצג, לדוגמא    

יופיע הגובה המתוכנן בציר של החתך הנ"ל )הגובה שנקבע לו בחתך האורך(, 
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. ניתן לעבור בין החתכים על ידי הצבעה על  Elevation: 233.85/לדוגמא 
ופיע באופן אוטומטי על גבי  החתך הרצוי בטבלה מימין. כל חתך שיבחר י

נך נמצא יהשרטוט, ונתוניו יופיע בטבלאות למטה. להמשך ההדרכה וודא שה
 בחתך הראשון.

 
  -  נעבור כעת להגדרת תכנון החתך הטיפוסי. אנו נתחיל בתכנון פני מבנה החתך )פני הכביש

ודות העפר  גובה האספלט, פני המדרכה, השוליים וכולי( ולאחר מכן נעבור להגדרת גובה עב
 לביצוע:  

 
. העבר, בעזרת החץ Designed G.Lבטבלה הימנית התחתונה מופיע הכיתוב   .6

)כאמור, אנו מתחילים בתכנון פני המבנה   Structure  -הקטן שמימין לכיתוב, ל
 ורק לאחר מכאן נגדיר את גובה עבודות העפר(. 

כאשר   שורות,  מופיעות  בטבלה  התכנון.  טבלת  מבנה  את  בקצרה  כל  נסביר 
מ ממוספרים  המקטעים  מקטע.  מייצגת  כ  40+ועד     40-  -שורה    81  -)סה"כ 

מופיעות   בטבלה  חתך(.  לכל  אפשריים  ביותר   5מקטעים  )השמאלית  עמודות 
ללא כותרת(. לצורך ההסבר, נמספר עמודות אלה בסדר עולה משמאל לימין כך 

 : 1שהעמודה השמאלית ביותר הנה מספר 
 

 אינו מופיע המספר הסידורי של המקטע. מספר זה  : בעמודה זאת  1  עמודה מספר 
מייצג מרחק כלשהו. מקטעים משמאל לציר יוצגו במספר שלילי ומספרים מימין לציר  

 יוצגו במספר חיובי. 
מספר    מהציר.    -(Offset)  2עמודה  המקטע  של  המרחק  את  מייצגת  זאת  עמודה 

ל כחיובי.  יוכנס  מימין  ומספר  כשלילי  יוכנס  לציר  משמאל  מהציר שתי מרחק  מרחק 
, כפי שמודגם כאן )ראה dHאופציות: מרחק אבסולוטי או מרחק יחסי. בעבודה עם  

נו למעשה י(, יוכנסו הנתונים כמרחק יחסי, זאת אומרת שהמרחק שיוכנס ה24סעיף  
עם   בעבודה  מהציר.  אבסולוטי  מרחק  ולא  המקטע  נתונים  Elevationאורך  יוכנסו   ,

 אלו כמרחק אבסולוטי.
מ  אופציות:    -(dH)  3ספר  עמודה  שתי  זאת  או   dHלעמודה  כאן(  שמודגם  )כפי 

Elevationהאופציות נקבעות בחלון ה .-  Status    (. בעבודה עם  24)ראה סעיףdH  ,
ה שיוכנס  שהגובה  כך  הקודם,  המקטע  לגובה  ביחס  כיחסיים,  הגבהים  נו ייוכנסו 

 אבסולוטיים. , יוכנסו גבהים Elevationלמעשה גובהו של המקטע. בעבודה עם 
מספר    המקטע.    –  (%Slope)  4עמודה  שיפוע  את  להכניס  ניתן  זה  בעמודה 

הזנת   הנתונים:  משני  אחד  להכניס  מספר    dHבאפשרותך  את 3בעמודה  תחשב   ,
, ולעומת זאת, הזנת שיפוע, תחשב 4שיפוע המקטע באופן אוטומטי ותזינו בעמודה  

 . 3ותכניסו בעמודה  dH -אתה
עמודה זאת מגדירה את אופי המקטע. לעמודה מספר   -( Cover)  5עמודה מספר   

על   הרחבה  )ראה  צד    Coverאופציות  תעלות  "תכנון  ובסעיף  זה,  סעיף  בהמשך 
 "(. Coverוהרחבת פעולות ה" 

 
החל בהזנת נתוני התכנון בטבלה. לצורך הבהרת הנושא, אנו נדגים כאן נתונים  .7

 הבאים לטבלה:לחתך טיפוסי שילווה בהסבר מפורט. הזן את הנתונים 
". זה עתה 0, ושוב " Enter",  0. הזן " 2עם העכבר, בעמודה מספר   0עמוד על מקטע  

 הגדרת שהגובה בציר זהה לגובה שתוכנן בחתך האורך.
, עבור עם החץ ימינה Enter",  3. הזן " 2, עמודה מספר  1עבור עם החצים למקטע   

"   3לעמודה מספר   ו  -2והזן   "Enterה  . התוכנה תחשב את הפרש-  dH   "(0.06- .)"
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מ' בירידה    3  -נו מקטע האספלט לנתיב הימני שהוגדר כיהמקטע שזה עתה הוגדר ה
 "(.-)את הירידה הגדרנו על ידי ה "  2%של 

 
 לפני שנמשיך נסביר כעת מספר פעולות עריכה שניתן לבצע על הטבלה:

ו ע"י  בשדה מסוים תגרום למחיקת השדה הנ"ל כולו) רק לאחר סימונ  Delלחיצה על   
 העכבר(.

 את התו האחרון בשדה. תמחק)חץ אחורה(,  Backspaceלחיצה על  
למחיקת שורה שלמה או צמצום שורות, עמוד על העמודה השמאלית ביותר )עמודה  

ולחץ  (  1מספר   הרצוי,  את Delבמקטע  ותצמצם  המקטע  את  תמחק  התוכנה   .
 השורות.

חתכי    לשאר  הנוכחי,  הרוחב  מחתך  מקטע,  להעתיק  העתקה ניתן  לביצוע  הרוחב. 
ב ובחר  ימני  כפתור  ולחץ  ביותר  בטור בשמאלי  הרצוי  על המקטע  .  -send toעמוד 

כל  )לבחירת  המקטע  נתוני  יועתקו  אליהם  החתכים  את  סמן  שתפתח  בטבלה 
כפתור   לחץ  ולחץ    Allהחתכים  המקטע OKבתחתית(  נתוני  את  תעתיק  התוכנה   .

להעתי וברצונך  במידה  שנבחרו.  החתכים  מתא  לכל  ערך  רק  כל   מסויםק  את  ולא 
 המקטע, סמן את התא שברצונך להעתיק ובצע את אותם השלבים.

 
 המשך במילוי הטבלה: 

שה  במקטע  יוודא  מספר  3נך  עמודה   ,2 " והזן  ו  0,   "Enter  מספר בעמודה  של   3. 
 ס"מ.   17. המקטע הנ"ל מציין אבן שפה בגובה Enter" ו 0.17אותו מקטע הזן " 

,  4. עבור חץ ימינה לעמודה  Enter" ו  2, והזן " 2, עמודה  4למקטע  עבור עם החצים   
  2נו מדרכה ברוחב  י" במספר חיובי(. מקטע זה ה2" אחוז עולה )" 2והזן שיפוע של " 

 מ'.
והשל  ציין  עבור  שהפעם  אלא  השלילים,  במקטעים  בדיוק  נתונים  אותם  את  ם 

 " )מינוס(. -המרחקים ב " 
" ובחר -1( במקטע " 5)עמודה    -coverמודת ה( על עDouble-clickהקלק פעמיים ) 
"   -asphaltב למקטע  בצע  התהליך  אותו  הרשימה.  כעת  1מתוך  לתוכנה   ציינת". 

 " מציינים אספלט. -1"  -" ו1שמקטעים:   " 
 

 בסיום הזנת הנתונים, הטבלה צריכה להראות כך:
     

 
 

 בחלקה העליון והתחתון של הטבלה, מופיעים הכיתובים: 
  

Slp. left :  Cut 1:  Fill 1:   

Slp right :  Cut 1:  Fill 1: 
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ה הדיקור  סגירת  ומימין.  משמאל  החתך,  של  הדיקור  סגירת  את  מייצגים  אלו  נה  ישדות 

ביותר/הימנית  בין הנקודות הקיצוניות בחתך )השמאלית  כיחס, שיבנה  יוכנס  השיפוע, אשר 
 ביותר(, לבין הקרקע הטבעית:

 
(, Slp right, שבתחתית הטבלה )ליד הכיתוב  :Cut 1  הכנס בשדה יחס החפירה .8

". את אותם 3, שלידו, את המספר " :Fill 1", ובשדה יחס המילוי  2את המספר " 
 "( ו2נתונים  ליד הכיתוב  3"   -"  גם  , שבראש הטבלה. התוכנה Slp left"( הכנס 

תזהה האם החתך נמצא בחפירה או במילוי בכל קצה )בקצה השמאלי ובקצה  
זאת הימני(,   שהוזנו,  הנתונים  פי  על  הקרקע  עם  למפגש  עד  שיפוע  ותבנה 

במצב של   1:3למצב של חפירה, ושיפוע ביחס של    1:2אומרת שיפוע ביחס של  
 מילוי. 

 
 בחלון הימני. התכנון יופיע על גבי השרטוט. Applyלחץ כפתור  .9

ס עבודות יכעת  גובה  להגדרת  נעבור  מבנה החתך שלנו.  פני  את  להגדיר  ימנו 
 ר.העפ

.  31הערה: אם אינך מעוניין להכניס את גובה עבודות העפר בחתך, עבור לשלב  
נדגיש כאן ששכבת גובה עבודות העפר, יכולה לשמש כשכבה נפרדת לחלוטין 

שכבת פני מבנה הכביש ומכאן שניתן להשתמש בה לצרכים רבים ושונים, ולא  מ
 רק להצגת גובה עבודות עפר. 

 
בעזר העבר,  השמאלית,  הכיתוב  בטבלה  שליד  הקטן  החץ  לטבלת Existing G.Lת   ,

Designed G.L:הזן, באותה צורה שהוזנו פני מבנה החתך, את הנתונים הבאים בטבלה . 
 

 
 

 בסיום הזנת הנתונים.  Applyלחץ 
 

   Designed G.L. / Structureניתן להעביר שיפוע ממקטע קודם למקטע נוכחי בטבלת  
 

( ולחץ על כפתור Designed G.L. / Structureלה הרצויה )לביצוע הפעולה, בחר את הטב

‘Slopes Inheritance’    חלון .‘Slopes Inheritance’  :ייפתח 
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 בחר את המקטע אשר "יירש" את שיפוע המקטע שלפניו )לכיוון הציר( בטבלה.
בחר את החתכים אליהם אתה רוצה לשלוח את השיפוע החדש    ’Send to‘ובחלון    OKלחץ  

 לשליחת השיפוע החדש עבור המקטע המבוקש לכל החתכים.   ’All‘או לחץ על כפתור 
 
 

ס"מ. כפי    20ס"מ, ובמדרכה    60אנו יצרנו פני מבנה חתך, כך שגובה המבנה באספלט יהיה  
 , אינו תלוי בגובה עבודות פני המבנה ומנוהל באופן עצמאי.  Designed G.Lשצוין, גובה ה 

 
 טיפוסי לאורך כל הציר שבנינו:כעת נשליך את החתך ה

ה .10 כפתור  על  התוכנה     Copy  -לחץ  הלחיצה  לאחר  הימני.  בחלון  שנמצא 
תעתיק את כל הטבלאות של החתך הנוכחי )מתוכנן+תעלות צד אם קיימות וכו'( 

 לזיכרון המחשב. 
לשרטוט(,  .11 החתכים שמימין  רשימת  )טבלת  הימני  בחלון  בעזרת הטבלה  עבור, 

ברשימ האחרון  ה  לחתך  כפתור  על  לחץ  )הכפתור      Pasteה.  הימני  בחלון 
ה לכפתור  תוך Copy  -שמתחת  אל  מהזיכרון  הנתונים  את  להעתיק  מנת  על   )
  הטבלאות בחתך זה.

 
תוכנת   של  העבודה  משתנה  יה   CivilCAD 10עיקרון  שבהם  בחתכים  הנתונים  בהזנת  נו 

ציות ביניים.למחוק : במעברי  הכביש )ורק בחתכים אלו!(, ומילוי שאר חלקי הכביש באינטרפול
שינוי   מתבצע  שבהם  החתכים  את  נמלא  אנו  בהמשך,  שנראה  כפי  לדוגמא,  שיפועים, 

 השיפוע, והתוכנה תמלא באינטרפולציה את שאר החתכים שבין המעברים. 
בידנו שני חתכים מלאים בנתונים. שאר החתכים עדין ריקים )תוכל לראות זאת על   כעת יש

 החתכים(:טבלת רשימת   -עזרת לחיצה על חתך מסוים בטבלה הימניתידי דפדוף ביניהם ב

כפתור   .12 על  לחץ  ביניים:  אינטרפולציות   Interpolate empty  ביצוע 
sectionsבחלון שיפתח החלף מטבלת ה .-  Designed  ל-All    מעוניינים )אנו  

. OK(. לחץ כפתור  Structure  -וגם ל  Designed G.Lלבצע אינטרפולציה גם ל  
ומכיוון  התוכ בפרויקט,  הריקים  בפרויקט  החתכים  לכל  אינטרפולציה  תבצע  נה 

שבידנו שני חתכים בלבד )ראשון ואחרון(, אשר זהים בתכולתם, תמלא התוכנה  
 את כל החתכים באותם נתוני תכנון. 

לעבור   תוכל  מעוניין,  הנך  זה, אם  בין החתכים. בשלב  לדפדף  תוכל  בסיום האינטרפולציה, 
 נות את תכולתו.לחתך מסוים ולש

 
 הוצאת החתכים לגיליון שרטוט:  .13

 הגדרות הגיליונות. שמעל לחלון השרטוט. יפתח חלון    -לחץ על כפתור ה  
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 . Model Spaceלמצב  Paper Spaceהעבר ממצב  
(. קנה המידה  Long(, ולאורך )Heightקנה מידה לחתך לגובה )  הזן   ההגדרותבחלון   

 . OKלאורך. לחץ   100לגובה ו  100. הזן לדוגמא Xל  1יוכנס כיחס של 
להגדרת החתכים בגיליון עם    ’Other‘או לבחור באופציה  באפשרותך לבחור גודל דף   

 מידות מיוחדות. 
.לעבודה עם גיליון ללא  ’No Division‘ניתן גם להגדיר גיליון ללא מידות ע"י האופציה   

 .’No Division‘מידות, הכנס לתפריט הגיליונות ובחר באופציה 
והפרש בח לחתך  חתך  בין  אנכי  הפרש  טור,  בכל  חתכים  כמות  הגדר  שיפתח  לון 

 אופקי בין חתך לחתך. 
כפתור   על  לחץ  ולחץ   ’Arrange‘לסיום  בגיליון  חלוקות החתכים  סכמה של  לקבלת 

OK . 
בגיליונות    או  בגיליון  יסודרו  החתכים  כל  כי  הינה  המחדל  לבחור     ברירת  מנת  על 

 ’Select‘פציה בחר באו -חתכים ספציפיים 
 . OKבחלון שיפתח, סמן את החתכים שברצונך להוציא לגיליון שרטוט ולחץ   
אחד או שהתוכנה תחלק את    לגיליוןבאפשרותך לבחור האם לייצא את כל החתכים   

 בהתאם להגדרות שהגדרת. לגיליונותהחתכים 
 

טוט. ב נו קובץ שרטוט אשר ניתן לייבוא על ידי רוב תוכנות השריה DXFהערה: קובץ 
AutoCAD/ZWCADוגמא, ניתן לייבא קובץ זה על ידי פקודת , לדDXFIN או על ידי ,File -

> Open  והעברת ,Filter   הקבצים לDXF לאחר יבוא הקובץ לחץ .Zoom  ו- Extents  על ,
 מנת לראות את כל החתכים.

 

מימין. בחלון שיפתח סמן        Layout: לחץ על כפתור  קבלת תנוחת הכביש  .14
(. לחץ Layout, Contours, Distancesמות )את שלושת האפשרויות הקיי  V  -ב

כפתור   לא   OKעל  זו  תנוחה  גבי השרטוט.  על  תנוחה  תיצור  התוכנה  להמשך. 
 תכלול קווי גובה. בשלבים הבאים נראה כיצד לשלב קווי גובה בתנוחה.

 כולל בתוכו שלוש אופציות:  Layout  -חלון ה 
 Layout-  סימון  V  אופ התנליד  קווי  את  תיצור  זו  כיתוב ציה  ואת  הכביש  של  וחה 

 הגבהים בחתכים.
 Contours-    סימוןV    יוצרו הגובה  קווי  בכביש.  גובה  קווי  תיצור  זו  אופציה  ליד 

שבחלון. על מנת שהתוכנה תיצור קווי    Intervals-בהפרשים על פי המופיע בתיבת ה
קווים א למקם  יש  את המקטעים שבהם  לה  לציין  יש  פירוט  גובה,  ראה  כך  על  לה. 

 .37בשלב 
 Distances-    סימוןV   התוכנה בין החתכים.  מרחקים  תיצור שכבת  זו  אופציה  ליד 

והטנגנטה  החתך  בין  המרחקים  את  וכן  וחתך,  חתך  בן  המרחקים  את  תרשום 
 הסמוכה אליו.

 
, יעבור חלון חתך הרוחב למצב מינימום  Layout  -בחלון ה   OK הערה: לאחר לחיצה על ה

מנת שתוכל לראות את השינויים בתנוחה(. להגדילו חזרה לחץ עליו "בסרגל המשימות"    )על
 אשר בתחתית המסך. Windowsשל 
 

ובחלון שייפתח בחר האם לחפש ע"פ שם       Findלחץ על כפתור    –חיפוש חתך   
 . OKהחתך או ע"פ המרחק הרץ והזן את הנתון המבוקש. לחץ 
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ביניים )חתכים אשר משמאלם מופיע הסימן להסתרת חתכי    –  הסתרת חתכי ביניים 
 Hide intermediate sectionsבאופציה  "V"סמן  -* 

 
 הגדרת קווי הגובה:

את  .15 נבחר  אנו  מימין(.  )הרשימה  החתכים  ברשימת  הראשון  החתך  את  בחר 
אנו   שבהם  רק    מעונייניםהמקטעים  גובה  קווי  ניצור  שלנו  בדוגמא  גובה.  בקווי 

מייצגים את קטעי האספלט בחתך. עבור עם הסמן   ,-1ו    1באספלט. מקטעים  
מספר  Cover)  5לעמודה   במקטע   ,)1( העכבר  עם  פעמיים  ולחץ   ,Double 

click  2(. ברשימה שתפתח בחר- Contours בצע אותו תהליך במקטע מספר .
1-. 

. תוכל כמובן  -1ו    1נך מעוניין בקווי גובה רק במקטעים  יכעת ציינת לתוכנה כי ה
ג כן  תוכל לעשות  החתכים,  בשאר  תדפדף  אם  וכדומה.  המדרכה  למקטעי  ם 

את   כעת  נשליך  אנו  הראשון.  בחתך  רק  קיימת  שנקבע,  ההגדרה  כי  להבחין 
 השינוי הנ"ל אל שאר החתכים: 

. לחץ על הכפתור הימני בעכבר. לפניך 1שבמקטע    Cover  -על עמודת ה  עמוד .16
טבלת   להעתיקSend toתפתח  יש  את החתכים שאליהם  השינוי.   . בחר  את 

ידי כפתור ה .  OKשבתחתית. לחץ כפתור    All  -אנו נבחר את כל החתכים על 
. -1השינוי שבמקטע יועתק לשאר החתכים. המשך ובצע את התהליך במקטע  

כפתור   על  שוב  לחץ  החתכים,  לכל  השינויים  העתקת  את  שביצעת  לאחר 

Layout   .התוכנה תוסיף את קווי הגובה המתוכננים לתנוחה . 
 לסיום.  Close.  לחץ על כפתור 19

  
 

 פרוט פעולות חלון חתכי הרוחב:
  

נידונו בשלבי   כעת את הפעולות הנוספות הקיימות בחלון חתכי הרוחב, שלא  ונפרט  נעבור 
 ההדגמה:

  
 פעולות בחלון רשימת חתכי הרוחב )החלון הימני(: 

  לפרויקט ישים השונים  בתיבה זו ניתן לדפדף בין הכב  -שבראש בחלון הימני  Roadתיבת ה  
 מרובה צירים. 

בודד חתך  כפתור    -מחיקת  על  ולחץ  הרשימה,  בתוך  למחיקה  הרצוי  החתך  על   עמוד 
 שבחלון רשימת החתכים )החלון הימני(. התוכנה תמחק חתך זה מהרשימה.

הפרויקט חתכי  כל  הכפתור    -מחיקת  על  לפני    לחץ  תתריע  התוכנה  הימני.  שבחלון 
 למחיקה.  OKחץ  מחיקת כל החתכים. ל

 :  (Load from text file) של החתכים Textטעינת קובץ 
של החתכים שימושים רבים, ביניהם העברת נתונים מפרויקט    Textלטעינה ושמירת קובץ  

לפרויקט והעברת נתונים בין מצב קיים למתוכנן והפוך.על מנת לדפדף בין הפעולות השונות 
ובחר מאחת האופציות     Files of type פתחת  האפשריות בחלון זה השתמש ברשימה הנ

 הבאות:
  

 Pas)*.Roads(-  ייחודיים ל  CivilCAD   10ות קודמות של תוכנתגירסהקבצים אלו 
 .  Along roadsשבוצעו בתוכנת  פרויקטיםומאפשרים פתיחת 
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 Sec)*.Sec files(-   קבציSec    הנם קבציText    בפורמט מיוחד, אשר יכולים להיווצר
 .  IDAN, או מספר תוכנות מקבילות כגון תוכנת CivilCAD 10ת על ידי תוכנ

 Txt) *.Text(Tab delimited)(-  יוצר ב להרחבה  Excel-קריאת קובץ נתונים אשר 
 .  Excel -ייבוא נתונים מראה בפרק עבודות עפר בכבישים: 

 Tml) *.Template (-    חתכים קובץ  טיפוסי. קריאת  פרק    להרחבה  להרחבה  ראה 
  ים טיפוסיים.עבודה עם חתכ

 Geopak sections (*.XSR) – 
 LDD Sections (*.*) –   
 Cross sections coordinates (*.*) -   
ניתן לדפדף בין הכבישים השונים   -שבראש בחלון הימני  Roadתיבת ה    זו  בתיבה 

 מרובה צירים.  לפרויקט
 

קובץ     )  Textיצירת  החתכים  כפתור(Save sections to fileשל  על  לחץ  יצירת    : 
ברשימה  הנמצאות  מאפשרויות  אחת  את  בחר  שיפתח  בחלון  הימני.  בחלון  הקבצים 

     Save of typeהנפתחת:
 

 Sec)*.Sec files(-    קבציSec     מצבים של  להעברה    לפרויקט   מפרויקטנועדו 
  פרויקטלמצב קיים של    מסוים  פרויקט לדוגמא: אם ברצוננו להעתיק מצב מתוכנן של  

תוכנן של הפרוייקט, נפתח פרויקט חדש ובחתכי הרוחב  מב ה אחר, נשמור את המצ
 נקרא את נתוני הקובץ שיצרנו אל טבלת המצב הקיים. 

 Tml) *.Template(-    חתכים קובץ  טיפוסי.קריאת  פרק    להרחבה  להרחבה  ראה 
   עבודה עם חתכים טיפוסיים.

  
על   לחיצה  ולאחר  חלון שבו    Saveהקלד את שם הקובץ  יפתח 

הטבלה שיש לשמור את נתוניה )מצב קיים, גובה יש לבחור את  
 . OKעבודות עפר, גובה פני מבנה כביש(, וללחוץ 

   

נתוני קרקע מתוכננת   יצירת הכביש ראינו כייבוא  נתוני . באחד משלבי  לייבא  ניתן  יצד 
כי   הדגשנו  כן,  כמו  הקיים(.  הגובה של המצב  )קווי  הקיימת  הטופוגרפיה  מתוך  רוחב  חתכי 

ך טבלת המצב הקיים של החתך, או לכל טבלה אחרת שלו. עוד  א נתונים אלו אל תוניתן לייב
,  GetD all, אפשרות ליצירת קווי גובה מתוכננים. כפתור CIVILCAD 10הזכרנו, כי בתוכנת 

הג )קווי  הטופוגרפיה  מתוך  רוחב  חתכי  יצירת  תוך ומאפשר  אל  ויבואם  המתוכננים,  בה( 
 טבלאות החתך. 
לדגו ברצונך  האם  טבלת  אל  מתוכננת  קרקע  נתוני  לחלון  Design-ם  עבור  ראשית   ,

 Design Devote -40,וסמן את האפשרות:    Options   האפשרויות ע"י לחיצה על כפתור  
to 40 Segments   ע"י סימון אפשרות זו, התוכנה תדגום את נתוני הקרקע המתוכננת תוך
אלו נשמרים בד"כ לתוספות   גמנטיםמסבטבלת התכנון. חלק    הסגמנטים  81כדי שימוש בכל  

שונות בתכנון, כגון ברמות, תעלות וכו'... לכן, אם לא סימנת אפשרות זו ייתכן והתוכנה לא 
 . OKתדגום את כל נתוני הקרקע. סגור את חלון האופציות ע"י לחיצה על 

. לפניך תיפתח טבלה. ברירת המחדל   על מנת לדגום את נתוני הקרקע לחץ על כפתור
)  היא החתך  של  המתוכננת  הטבלה  תוך  אל  החתכים  נתוני  ניתן  Designed G.Lיבוא   .)

. התוכנה תתריע כי היא עומדת למחוק את OKלדפדף ולבחור כל טבלה רצויה. להמשך לחץ  
להמשך. הנתונים יקראו אל תוך הטבלאות המתוכננות   OKנתוני התכנון מכל החתכים. לחץ  

 של החתכים.
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: לצורך מחיקת נתוני מספר חתכים יחדיו, לחץ על כפתור ת חתכיםמחיקת נתוני קבוצ    
הנתונים   Clear all  -ה את  בחר  שיפתח  בחלון  הימני(.  )החלון  החתכים  רשימת  שבחלון 

(, גובה פני מבנה  Designed G.L(, גובה עבודות עפר )Existing G.Lמצב קיים )  –למחיקה  
( לחץ  Structureהכביש  הצד.  תעלות  נתוני  או   )OK   את סמן  שתפתח  בטבלה  להמשך. 

כפתור   לחץ  החתכים  כל  לבחירת  למחוק.  ברצונך  נתוניהם  שאת  לחץ    Allהחתכים  למטה. 
OK  .התוכנה תמחק את נתוני החתכים שנבחרו .  
  

החתכים     לנתוני  גובה  גבהים  הוספת  עם  בעבודה  בעיקר  שימושית  זו  אופציה   :
גובה חתך האורך על פני נתוני חתכי הרוחב(.  אבסולוטיים )בגבהים יחסיים נעדיף לשנות את  

גובה   )להורדת  הגובה הרצויה  על הכפתור. בחלון שיפתח הכנס את תוספת  לחץ  להפעלה 
להמ  שלילי(.  גובה  לחץ  הכנס  לשנות OKשך  שברצונך  הנתונים  את  בחר  שיפתח  בחלון   .

נוסף בחר את להמשך. בחלון ה  OK)מצב קיים, גובה עבודות עפר, או גובה פני מבנה(. לחץ  
. התוכנה תוסיף את OKלמטה, תבחר את כל החתכים(. לחץ    Allהחתכים לשינוי )לחיצה על  

 הגובה הרצוי לחתכים הנבחרים, ובטבלה שבחרת )קיים ,מתוכנן…(. 
  

מעבר     עקומת  בפרק    –  Elevations uperS  -הגדרת  ראה  עקומת  לפרוט  הגדרת 
 .מעבר

   

   Optionsפעולות בחלון  
חלק אותן   על  את  כן  אם  נפרט  זה.  שבסעיף  השלבים  במהלך  דנו  זה,  בחלון  מהפעולות 

 פעולות שלא פורטו: 
  

 Max/Min interval  –    ,החתכים אל  חריגים  נתונים  יקראו  בו  מצב  יתכן  לעיתים, 
מתוך הטופוגרפיה. קיימות מספר סיבות לתופעה זאת כגון נתוני מדידה שגויים, גבול 

הרצ מגבול החתך  צר  תופעה מדידה  למניעת  ועוד.  הגובה  בקווי  אקסטרפולציות  וי, 
לגובה נתון קרקע מהגובה בציר.    המקסימאליזאת ניתן להגדיר לתוכנה את ההפרש  

מתחומי   חורג  אינו  לפחות  )או  נכון  תמיד  בציר  הגובה  כי  היא  ההנחה  נקודת 
יחוס. אנו מורים לתוכנה מהו ההפרש  נקודת  גובה זה משמש  כן  ועל   הטופוגרפיה( 

בגובה שאנו מתירים לשבר קרקע בחתך. כל שבר קרקע החורג מהפרש  המקסימאלי
,  230.55מחק מנתוני הקרקע. לדוגמא, אם הגובה בציר הנו  יזה )למעלה או למטה( י

או גבוה   227.55מ', כל נתון קרקע הנמוך מ    3  -של כ  Max/Min intervalואנו הזנו  
י 233.55מ   הי,  החתך.  של  הקרקע  מנתוני  לאחר מחק  רק  תתרחש  הנתון  שפעת 

כפתור   ידי  על  קרקע  דגימת  קיימים  GetT allשנבצע  קרקע  נתוני  כבר  יש  אם   .
ליציאה, ונחזור על פעולת   OKשאותם ברצוננו לשנות, נזין את ההפרש הרצוי, נלחץ  

 . GetT all -ה
  

 Include edges-    עקרון הפעולה של תוכנתCIVILCAD 10   בדגימת נתוני קרקע
: התוכנה תדגום תמיד את נתוני המצב הקיים בציר, וכל שבר קרקע שיזוהה הוא כזה

בתחום רוחב החתך, יוכנס גם הוא לטבלה. בנוסף לנתונים אלו, תדגום התוכנה את  
מנת  על  שהוגדר.  הרוחב  פי  על  ומימין,  משמאל  החתך,  בקצה  הקיים  המצב  גובה 

ה   את  הסר  בקצוות,  הדגימה  את  על  Vלבטל  וחזור  .  GetT allפעולת    שבסימון 
 התוכנה תדגום הנתונים מחדש, ללא דגימת הקצוות. 

  



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  194עמוד 

 Include center line-    פי בסעיף    העיקרוןעל  להורות    2המוסבר  ניתן  מעלה, 
 . center-שבשדה זה, לא לדגום את נקודת ה V-לתוכנה, על ידי הסרת ה

  
Close Design to Structure/Close Design to Existing – גירת הדיקורים.  הגדרת ס 

Close Design to Existing  –    התוכנה תשנה את החתכים כך שגובה קצה עבודות העפר
(Design( ייסגר למצב הקיים )Existing .והמבנה ייסגר לגובה עבודות העפר .) 

המבנה   שקצה  כך  החתכים  את  תשנה  תמיד    (Structure)התוכנה  אוטומטי  באופן  ייסגר 
( העפר  עבודות  בקצוות  Designלגובה  המרחקים  את  תשלים  התוכנה  מילוי  של  במצב   .)

עד לשיפוע של קצה עבודות העפר, תחשב את המרחקים עד לשיפוע    (Structure)המבנה  
 בהמשך הטבלה )לקראת סופה(. Structureותוסיף אותם לטבלת ה

  
דש ללא  באפשרותך להגדיר את שמות החתכים מח  -שינוי שמות של חתכים קיימים 

ה כפי  מחיקת  אותם  הגדר  החתכים  שמות  את  לשנות  כדי  בהם.  הקיימים  נתונים 

לח ע"י  זה  בפרק  כפתורישהוסבר  על  אופציית    צה  תופעל  כאשר   .Define 
sections ,   חתך שהמרחק( קיים  לכל חתך  קיימים.  לאיתור חתכים  בדיקה  תתבצע 

אחת  לבצע  המשתמש  ברצון  האם  התוכנה  תשאל  בטבלה(,  נמצא  כבר  של  הרץ 
 ש אפשרויות:משלו

 Rename section  – .)לשנות את שם החתך לשם החדש )לפי ההגדרה החדשה 
 Overwrite section –  .למחוק החתך הקיים ולהגדיר החתך החדש במקומו 
 Leave existing section – .להשאיר בחתך כפי שהיה 

או   בכל חתך כדי לאשר את הפעולה  OKהתוכנה תציג הודעה לכל חתך, באפשרותך ללחוץ  
 . Cancelלאישור הפעולה לכל החתכים. לביטול לחץ   OK to Allללחוץ 

 
 Road Expansion  –    ביצוע לקביעת  מתוכנן  לכביש  קיים  כביש  בין  עומק  בדיקת 

 . עבודות עפר
 . Roads→Horizontal Alignment‘לביצוע הפעולה, מהתפריט הראשי הפעל: '

אשר יגדירו את גבולות הכביש לאורך התוואי האופקי של הכביש    Polylinesשרטט  
 הקיים. 

 .Roads→Cross Sections‘מהתפריט הראשי הפעל: '

כפתור   על  חלון      'Get references by layers‘לחץ   .‘Get references by 
layers'  .ייפתח 

באופציה   לחץ    ’Select‘בחר  השרטוט,  מתוך  השכבה  את  סמן   ,Enter  ו-  
OK לחץ או בחר את השכבה מתוך הרשימה וOK . 

 התוכנה תבצע סריקה ובסיומה תתקבל ההודעה הבאה:
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 . ’References‘שנה את אחת הטבלאות בתחתית המסך לטבלת 

   Reference –(, הגדר את ה ’Cover‘)תחת עמודת  Reference –בשורת ה 
 . Break –כ 

בתא  בעכבר  הימני  הלחצן  עם  הקלק  נוספים,  לחתכים  ההגדרה  את  לשלוח  כדי 
‘Cover’  בשורת ה- Reference חלון .‘Send to’ .ייפתח 

 . OKולחץ  Current cellעבור  Yesבחר 
 סמן את החתכים ברשימה אליהם אתה רוצה לשלוח את ההגדרה או לחץ על 

 . OKלסימון כל החתכים ברשימה ולחץ    ’All‘כפתור 

ע"       ’Interpolate empty sections‘לחץ על כפתור   פ  לעדכון שרטוט החתכים 
 ההגדרות החדשות.

 ייפתח.  ’Options‘. חלון   ’Options‘לחץ על כפתור 
 , הגדר עומק מינימאלי ועומק מקסימאלי )בס"מ(. ’Road Expansion‘באופציה 

 

  
 

ימין בנפרד ועבור צד שמאל  התוכנה תבצע בדיקת עומק בכל חתך וחתך עבור צד 
  (.Designed G.L)ש המתוכנן  לבין הכבי  (.Existing G.L)בנפרד, בין הכביש הקיים  

 שמאלית.  Breakימנית ונקודת  Breakבשלוש נקודות: מרכז החתך, נקודת 
 

בכל חתך, אם תוצאת בדיקת העומק גדולה מהגדרת העומק המקסימאלי או קטנה 
, כלומר יבוצע חישוב עבודות Breakמהגדרת העומק המינימאלי, התוכנה לא תבצע  

 . Break –עפר בתחום ה 
 

תך, אם תוצאת בדיקת העומק קטנה מהגדרת העומק המקסימאלי וגם גדולה בכל ח
, כלומר לא יבוצע חישוב עבודות  Breakמהגדרת העומק המינימאלי, התוכנה תבצע  

 . Break –עפר בתחום ה 
 

 Guard rails display conditions   -   ושרטוטו בחתך  בטיחות  מעקה    הגדרת 
 .בתנוחה )מצב מילוי בלבד( 

 
יר מעקה בטיחות בחתכי הרוחב על פי תנאי גובה ויחס שיפוע ושרטוט קו  ניתן להגד

 :לביצוע הפעולה (.Horizontal Alignmentהמעקה בתנוחה )
 .’Roads→Cross Sections‘מהתפריט הראשי הפעל:  
 .’Guard Rails‘שנה את אחת הטבלאות בתחתית המסך לטבלת  
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 ’Set Default Values‘ל כפתור  אם ברצונך להשתמש בערכי ברירת המחדל, לחץ ע 

 . 
תתמלאנה   ’Working Width‘  –ו    ’Height Difference Condition‘טבלאות   

 בנתוני ברירת המחדל.

 

באפשרותך למלא את הטבלאות באופן ידני ולשמור את ההגדרות ע"י לחיצה על   

      ’Save‘כפתור

, בחר     ’Load‘כדי לטעון את ההגדרות ששמרת בפרויקט אחר, לחץ על כפתור  
 . ’Open‘את הקובץ ולחץ על כפתור  

 
ישנם שלושה מקטעים למקרה של   ’Working Width‘שים לב כי בטבלת   :הערה 

 רוחב פעיל עם אבן שפה. 
 

כדי למחוק נתון באחד התאים, סמן את התא המבוקש למחיקה ולחץ על כפתור  
‘Delete’ .במקלדת 

  –ו      ’Delete‘לחץ על כפתור  כדי למחוק את כל הנתונים משתי הטבלאות,  
‘OK’. 

 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  197עמוד 

 According‘ברירת המחדל להצגת מעקות הפרדה עם רוחב פעיל הינה  :הערה 
To Conditions’ . 

אם ברצונך בכל מקרה, להציג בחתך את מעקות ההפרדה עם הרוחב הפעיל, עלייך  
 .’Always‘לסמן את האופציה 

 

בכל צד ע"פ התנאים  16,17,18 התוכנה תוסיף את נתוני הרוחב הפעיל  למקטעים 
 שהוגדרו. 

 . -16או  16נתון בלוק מעקה הבטיחות, יופיע במקטע 
 

על מנת שהתוכנה תבצע את הבדיקה ע"פ התנאים שהוגדרו, יש לוודא כי : הערה 
 . ’Enable Automatic Guard Rails‘מסומנת האופציה  ’Options‘בחלון 

 

 

ובמקטעים   ע"י   -18. -17,-16/16,17,18במידה  ידני  באופן  שהוזנו  נתונים  קיימים 
 המשתמש, יופיע חלון הודעה כדוגמת חלון ההודעה הבא:
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ולאחר המחיקה  ידני  באופן  תכנון  בוצע  בהם  הנתונים מהמקטעים  את  למחוק  יש 
לחלון    Enable Automatic Guard‘באופציה    ’V‘ולסמן    ’Options‘להיכנס שוב 

Rails’. 
 

כפתור    על  התנאים    ’Apply‘לחיצה  ע"פ  הנוכחי  החתך  שרטוט  את  תעדכן 
 שהוגדרו. 

כדי לשלוח את ההגדרות לחתכים נוספים, סמן עם הלחצן השמאלי בעכבר את  
 אחד התאים ולחץ על הכפתור הימני בעכבר. 

 ייפתח.   ’Send To‘. חלון ’Send to‘בחלון הבחירה שנפתח, בחר באופציה  
ח את ההגדרה או לחץ על כפתור  סמן את החתכים ברשימה אליהם אתה רוצה לשלו 

‘All’    לסימון כל החתכים ברשימה ולחץOK . 

לעדכון שרטוטי החתכים ע"פ        ’Interpolate empty sections‘לחץ על כפתור   
 הגדרות מעקות הבטיחות והרוחב הפעיל. 

 

קו בשכבת    :הערה  ייתווסף  יופיע    Guard Railsבתנוחת הכביש   ובחתכי הרוחב 
 בהתאמה לכל צד של הכביש.  GR-r או GR-lבלוק 

 

בלוק   וקיים  הישנה  בשיטה  הפרדה  מעקות  הוגדרו  בהם  ישנים   W-lבפרויקטים 
בלוק   W-rאו יש למחוק תחילה את  על מנת להשתמש בממשק החדש,   ,W-l    או

W-r  .על מנת שלא יופיעו בתנוחה שני קווים 
 

לא ירגיש שינוי,    , המשתמשbarriersבפרויקטים ישנים בהם בוצע תכנון בטבלת   
לא תהיה    -אלא אם ירצה לשנות את ההגדרות של מעקות הבטיחות. במקרה זה  

 לו גישה לממשק הישן.
למחוק   עליו  ויהיה  החדש  הממשק  באמצעות  מעקות  להגדיר  יצטרך  המשתמש 

 W-rאו    W-lתחילה, את המקטעים בהם הגדיר רוחב פעיל באופן ידני ואת הבלוקים  
 . מהחתכים הרלוונטיים

 
 פעולות נוספות בחלון השרטוט:

 

  Zoom extents    –  :לשליטה בתצוגת החתך קיימות מספר פעולות 
 פסי הגלילה למטה ומשמאל לשרטוט. 
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כפתור שמאלי בתחומי השרטוט  על  פי    -לחיצה  על    2הגדלה  לחיצה  של השרטוט. 
 . 2הקטנה פי   -כפתור ימני

 ל אזור השרטוט.מחזיר את הצפייה לכ -E (Zoom extents)כפתור  
 פעולות בחלון הטבלאות )החלון התחתון(:  

 
על   פעולות  המאפשרים  כפתורים  מספר  מופיעים  וימנית,  שמאלית  טבלה,  לכל  משמאל 

 טבלאות אלו: 
 

 מחיקת נתוני כל הטבלה בחתך הנוכחי. -מחק  
 

של     הקיים  המצב  נתוני  הנוכחי ייבוא  הקיימת  החתך  הטופוגרפיה  דיל להב).  מתוך 

, מייבא כפתור זה את נתוני המצב הקיים של החתך הנוכחי בלבד. (      GetT allתור  מכפ
ביצ נתוני המצב הקיים הנוכחים. אשר לפני  וע הפעולה תתקבל הודעת התרעה על מחיקת 

 את ההודעה להמשך. 
 

   GetD-   .הטופוגרפיה המתוכננת מתוך  הנוכחי  נתוני המצב המתוכנן של החתך  ייבוא 

נתוני המצב המתוכנן של החתך (      GetD allור  תלהבדיל מכפ) , מייבא כפתור זה את 
ן ביצוע הפעולה תתקבל הודעת התרעה על מחיקת נתוני המצב המתוכנהנוכחי בלבד. לפני  

 הנוכחים. אשר את ההודעה להמשך. 
 

 (. תכנון חתכי הרוחבהוסברו במהלך הפרק  Paste  -ו Copy)פעולות כפתור 
 

 ( Super Elevationsם )הגדרת מעברי שיפועי
 

בפרק תכנון חתכי הרוחב נלמד כיצד ניתן להגדיר חתכי רוחב לכביש. עסקנו בהגדרת חתך  
ניתן,   ניתן להשליכו באינטרפולציה לאורך כל הכביש. נראה כעת כיצד  וראינו כיצד  טיפוסי, 

ס  להגדיר מעברי שיפועים בכביש. עקרון בניית מעבר שיפוע מתבס  CivilCAD 10בתוכנת  
על הגדרת המרחקים הרצים בכניסה וביציאה מהעקומה, בתחילת ובסוף מעבר השיפוע; הן  

 בכניסה והן ביציאה.
 

 הגדרת מרחקי המעברים 
 
לפתוח    פרויקטפתח   .1 באפשרותך  הרוחב.  חתכי  תכנון  כולל  כביש  תכנון    פרויקט המכיל 

 . Sample7דוגמא המכיל תכנון של כביש בספריית הדוגמאות של התוכנה: 
 (.Roads->Cross sectionsכנס לחתכי הרוחב )ה .2

 בחלון הימני של המסך.  שנמצא   Super Elevations לחץ על כפתור  .3
 המציג את הטבלה הבאה:   Define & Create Super elevations יפתח חלון  .4
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 הסבר מבנה הטבלה:
 

 IP  –  שם הIPהתוכנה תמלא את הטבלה מה ,IP  יש השני ועד האחרון השייכים לכב
 הנוכחי.

 Geometry  –   :המרחקים מהכניסה לטנגנטה הראשונה ועד ליציאה מהאחרונה 
 TS .מרחק הכניסה לעקומת המעבר עד לתחילת העקומה המלאה : 
 SC  ליד החץ  סימון  ממנה.  היציאה  ועד  המלאה  העקומה  תחילת  מרחק   :

 רדיוס העקומה מציין את כיוון התפנית של העקומה )ימינה במקרה הנ"ל(. 
 CS .מרחק היציאה מהעקומה המלאה ועד ליציאה מקשת המעבר : 

 
תחת   הטנגנטות  שני  את  התוכנה  תציג  מעבר  קשתות  ואין  במקרה 

 . TGהכיתוב 
 

 Geometry station  -   וסוף תחילת  של  המרחק  את  התוכנה  חישבה  מקטע  לכל 
 המקטע ע"פ הנתונים הגיאומטריים. 

 Superelev. Station  –   יקבעו את וסיומו.    המרחקים אשר  תחילת מעבר השיפוע 
של  החישוב  לפי  להיות  חייבים  אינם  כאשר  המשתמש  ע"י  יוכנסו  אלו  מרחקים 

. כאשר לא מוכנסים ערכים  Geomtry station התוכנה כפי שהם נמצאים בשדה  
ב   אלו  הרוחב ,  מסוים  IPבשדות  בחתכי  השיפועים  מעברי  את  תיצור  לא  התוכנה 
מקטע.   להעתי  באותו  ברצונך  בשדה  אם  מופיעים  שהם  כפי  המרחקים  את     ק 

Geometry station    כפתור על  לחץ  זה,   Copy Geo. Stations to  שדה 
Super elevation stations. 

 Slope Left/Slope Right  -   ,בשדות אלו יוכנסו השיפועים הרצויים לכל מצב ומצב
הנ"ל   בדוגמא  לראות  הוא  שבתחילתנוכל  הצדדים  לשני  השיפוע  בשיא   -2  המעבר 

 . -2ולאחר היציאה מהקשת הוא שוב  2העקומה ועד היציאה מהקשת הוא 
 

בדוגמא להלן, הוגדרו קשתות מעבר לפני ואחרי העקומה. במידה ולא הגדרנו קשתות מעבר 
נהיה צריכים לקבוע את מיקום תחילת מעבר השיפוע וסופו, בכניסה וביציאה מהקשת, באופן 

העמ על  עמוד  כן,  לעשות  הידני.  שבשורת  הראשונה  ולחץ   TG-ודה  לעקומה(,  )בכניסה 
ENTER  השיפוע מעבר  לתחילת  הרץ  המרחק  את  הכנס  חדשה.  שורה  תפתח  התוכנה   .
והכנס את המרחק הרץ לסוף   TG-. עבור לשורה שממול הSuperelev. Stationבעמודה  

 מעברי השיפוע. חזור על התהליך ביציאה מהעקומה.
 
 

 חתך התאמת השיפועים למקטעי ה
 

התוכנה תבצע את מעברי השיפועים רק על המקטעים שהוגדרו לה לכל צד )שמאל וימין( של 
בחתכי הרוחב.    Structure -ושל גובה פני הכביש    )גובה עבודות עפר(   .Designed G.L  -ה

 להגדרת המקטעים שעליהם התוכנה תבצע את המעבר בצע את הפעולות הבאות:
בטבלה, בחר את    Slope left/Slope rightיד השדות  פתח את רשימת המקטעים מתחת ל

  ׁ . כדי לבחור לכל צד את המקטעים של    (structure)מספרי המקטעים לכל צד של המבנה
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את    (slope left/slope right, בחר מתוך רשימת המקטעים )ליד הכיתוב  (Design)התכנון  
ה )של  המקטע  )    (structure -מס'  שיפתח  האפשרות .Designed G.Lובחלון  את  סמן   )

הרצויה:  אם ברצונך כי התוכנה תבצע את המעברים על התכנון באותם מקטעים של המבנה  
האפשרות   את  לקבוע    , Use identical designed G.L. segmentסמן  ברצונך  אם 

 Use differentסמן את האפשרות    (,Structureמקטע שונה מהמקטע שבחרת למבנה )
designed G.L. segment    ובחר מתוך רשימת המקטעים בחלון את המקטע הרצוי. לחץ

OK  .לסגירת החלון 
 
 
 

 
 

לחץ   הנתונים  הגדרת  מעברי   Super elevationsבחלון    OKלאחר  את  תיצור  התוכנה   ,
ליצירת    Create Layoutהשיפועים בחתכי הרוחב, בחלון החתכים מצד ימין לחץ על כפתור  

נדגיש כי את קביעת המקטעים   קווי הגובה של הכביש.התנוחה מחדש ותוכל להבחין בשינוי  
השיפועים   מעברי  נתוני  הכנסת  לפני  נבצע  השיפועים  מעברי  את  לבצע  ברצוננו  שעליהם 

 כניסה לחלון מעברי השיפועים.  עםלטבלה, כשלב ראשון מיד 
 

סעיף  נראה  זה  בפרק  הובא  אשר  החתך  בדוגמאות  להתבונן  נוכל  הדברים  הבהרת  לצורך 
 -גם ב 1 -ו -1בדוגמא הנ"ל הוגדר חתך אשר מקטעי האספלט שלו היום . תכי הרוחבתכנון ח

Structure ב ה  .Designed G.L -וגם  את  נקבל  אנו  כן,  אם   .Structure segment  
שלהם יהיו   .Designed G.L   -בהתאמה, כאשר מקטעי ה 1 -ו -1לשמאל ולימין כמקטעים 

 (. Identical) 1 -ו  -1גם כן 
 . Define & Create Super elevationsנוספים בחלון  כפתורים

Slopes Inheritance   -   למקטעים אוטומאטית  מסוים  מקטע  של  שיפוע  העברת 
 אחרים. 

 

Clear all Super elevations stations and all its slopes   -    כפתור זה מוחק את
 "י המשתמש. ע-Slopes וה  -Superelev. stationכל הנתונים שהוכנסו לשדות ה

 

- Erase current Super elevations slops     כפתור זה מוחק את הערכים שהוכנסו
 . Slope left ,Slope rightבשורה הנוכחית תחת השדות 
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 Cover  -תכנון תעלות צד והרחבת פעולות ה
 

ועד חתכי הרוחב. בפרק   עד כה ראינו כיצד מתכננים כביש על כך חלקיו, החל מהתנוחה, 
פעולות  הקוד בשתי  נדון  זה  בפרק  הרוחב.  בחתך  שיפועים  מעברי  להגדיר  כיצד  דנו  ם, 

 נוספות האפשריות בחתכי הרוחב:
 הגדרת תעלות צד. .1
 נוספות.  Coverפעולות  .2

 
 תעלות צד  תהגדר .1

 
בנפרד    -בשלב ראשון התוכנה בודקת האם החתך נמצא בחפירה ומילוי בנקודת קצה החתך  

מצב שבו באותו חתך תהיה תעלה במצב חפירה בצד שמאל  , כלומר יכול להיות    לכל קצה
לחפירה   ע"פ ההגדרות המתאימות  מכן תפעל התוכנה  ימין.לאחר  בצד  מילוי  ותעלה במצב 

 ומילוי. 
 
 בחפירהצד תעלות הגדרת 

  

 
 

בקצה   Design  –ל    Structure  –התעלה תתחיל תמיד מקצה החתך )נקודת החיבור בין ה  
  .From Existing G.L   -קבע ע"פ הנתון "העמוק יותר", במקרה זה  החתך(. עומק התעלה יי

 ועומק התעלה יהיה ממרכז תחתית התעלה ועד לגובה מצב קיים. 
 

 
 

From Design G.L.  –    התעלה תתחיל מגובה ה–  Design    וחישוב העומק ייעשה מגובה
 . Design –ה 

From Structure Lev.  –    ה מגובה  ייעשה   Structure  -התעלה תתחיל  העומק  וחישוב 
 . Structure -מגובה ה 

 

 
 

At Design G.L.  –  התעלה תסתיים בגובה ה– Design . 
At Structure Level –   התעלה תסתיים בגובה ה– Structure . 

 
גם את נתוני התעלה ניתן לשלוח לחתכי רוחב אחרים לפי בחירה. לשימוש באפשרות זאת 

הרצוי השורה  על  הסמן  עם  לעמוד  יש  יש  שנפתח  בעכבר.בחלון  ימני  כפתור  על  וללחוץ  ה 
עבור הנתון שסומן בלבד ולאחר מכן לסמן את    'No'עבור כל נתוני התעלה או    'Yes'לבחור  

  Ctrlוגם ע"י    Shiftהחתכים אליהם רוצים לשכפל את הנתון )ניתן לסמן מספר חתכים גם ע"י  
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שנבחרו הרוחב  לחתכי  תועתק  הבחירה  עוקבים(.  לא  לבצע  לחתכים  יש  מכן  לאחר   .
 אינטרפולציה. 

 
 צד במילוי תעלות הגדרת 

  

  
 

התעלה תתחיל מקצה הדיקור של   -  From Side-Stickאם סומנה האופציה    -במצב מילוי  
 לבן(.\החתך עם הקרקע )ראה חץ אדום

האופציה   סומנה  חץ    –  From Sec. Edgeאם  )ראה  החתך  מקצה  תתחיל  התעלה 
 לבן(.\כחול

הח קצה  באם  נמצא  ב  תך  המוגדר  מהערך  גבוה  אשר  ,  From section's edge  -מילוי 
 . In Fill –עומק התעלה ייקבע ע"פ הנתון המוגדר ב 

ב   המוגדר  מהערך  נמוך  אשר  במילוי  נמצא  החתך  קצה  ,  From section's edge  -אם 
 . .From Existing G.L  -עומק התעלה ייקבע ע"פ הנתון המוגדר ב 

 

 
 

From Design G.L.  –    התעלה תתחיל מגובה ה–  Design    וחישוב העומק ייעשה מגובה
 . Design –ה 

From Structure Lev.  –    ה מגובה  ייעשה   Structure  -התעלה תתחיל  העומק  וחישוב 
 . Structure -מגובה ה 

 

 
 

At Design G.L.  –  התעלה תסתיים בגובה ה– Design . 
At Structure Level –  ה ה התעלה תסתיים בגוב– Structure . 

 
גם את נתוני התעלה ניתן לשלוח לחתכי רוחב אחרים לפי בחירה. לשימוש באפשרות זאת 
יש   שנפתח  בעכבר.בחלון  ימני  כפתור  על  וללחוץ  הרצויה  השורה  על  הסמן  עם  לעמוד  יש 

עבור הנתון שסומן בלבד ולאחר מכן לסמן את    'No'עבור כל נתוני התעלה או    'Yes'לבחור  
  Ctrlוגם ע"י    Shiftאליהם רוצים לשכפל את הנתון )ניתן לסמן מספר חתכים גם ע"י  החתכים  

לבצע   יש  מכן  לאחר  שנבחרו.  הרוחב  לחתכי  תועתק  הבחירה  עוקבים(.  לא  לחתכים 
 אינטרפולציה. 
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 Shouldersשיפועי הגדרת 

 
Shoulders  –    הדיקור שיפוע  תחילת  ובין  לתעלה  החתך  קצה  בין  המרחקים  קביעת 

 לה.לתע
 

 
 

שיפועי "כתפיים" לתעלה במילוי או בחפירה. פעולה זו מתבצעת מתוך תפריט     יר להגד  ניתן
Roads→Cross sections  מתוך טבלתLeft/ Right ditch . 
 )מילוי(. Shoulders in Fill )חפירה( או  Shoulders in Cut –בחלון הגלילה ניתן לבחור ב 

ה"כתף" השמאל רוחב  יוגדרו  ה"כתף"  בצד שמאל  רוחב  יוגדרו  ימין  ובצד  והשיפוע שלה  ית 
 הימנית והשיפוע שלה.

השיפוע של  כיוון  על  ישפיעו  חיובי  שיפוע  נתון  או  מינוס(  )בסימן  שיפוע שלילי  נתון  הגדרת 
 ה"כתף".  

 
 בדיקת שיפוע הקרקע הטבעית בתכנון תעלה 

 
 בדיקת שיפוע הקרקע הטבעית בעת תכנון תעלות ע"י פעולת 

Check existing G.L. slope at offset: 
 

 
 

 בדיקה זו מתייחסת למצב מילוי בלבד. 
תפריט    מתוך  זו מתבצעת  טבלת    Roads→Cross sectionsפעולה   Left/ Rightמתוך 

ditch.   
“ לסמן  בvיש  מרחק  ולהגדיר  זו  באופציה   ”-offset  ב והלאה     dH-וגובה  תהיה  שמהם  לא 

על נתון    יעלה  offset  –ועד למרחק שהוגדר ב  , במידה והפרש הגובה מקצה החתך    תעלה
 . dH -הגובה שהוגדר ב 

 
גם את אופציה זו ניתן לשלוח לחתכי רוחב אחרים לפי בחירה. לשימוש באפשרות זאת יש  

ימני בעכבר. בתפריט שייפתח יש לסמן  vלעמוד עם הסמן על סימון ה” וללחוץ על כפתור   ”
האפשרות   את  'Send to'את  לסמן  מכן  הנתון   ולאחר  את  לשכפל  רוצים  אליהם  החתכים 

לחתכים לא עוקבים(. הבדיקה תועתק   Ctrlוגם ע"י    Shift)ניתן לסמן מספר חתכים גם ע"י  
 לחתכי הרוחב שנבחרו.
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 העתקת הנתונים לחתכים נוספים
 

כל  לאורך  נתונים  אותם  להשליך  ברצוננו  ומשמאל,  מימין  לתעלה  הנתונים  הזנת  לאחר 
אם אינך בשדה לחץ  (.  Slope L)נך בשדה הראשון של נתוני תעלה שמאל  הכביש. וודא שהי

 עם העכבר על כפתור שמאל בתוך השדה הנ"ל.
 

 כדי להעתיק את לשאר החתכים בצע את הפעולות הבאות:
לחץ על הכפתור הימני בעכבר בתוך השדה הנ"ל, התוכנה תשאל אם ברצונך להעתיק את 

ע"י הצגת ההודעה:  את השדה שבו לחצת עם העכבר  כל נתוני התעלה בחתך הנוכחי או רק
.Send the whole ditch?    על לחץ  השדות  כל  של  העתקה  לבצע  ברצונך  .  Yesאם 

שברצונך  החתכים  את  סמן  זה  בחלון  החתכים,  רשימת  את  המכיל  חלון  תציג  התוכנה 
"י  . באפשרותך לבחור את החתכים הרצויים ע   OKלהעתיק אליהם את החתך הנוכחי ולחץ  
. בכדי להעתיק את הנתונים לכל החתכים Namesסימונם או הקלדת שמותיהם ליד הכיתוב  

. חזור ובצע  OKהרשימה תסומן במלואה ולאחר מכן ללחוץ על      ניתן ללחוץ על כפתור  
 .השנייההפעולה גם לתעלה 

 

 הסדרת התעלה בחתך לאורך 
 

ע"   CivilCAD 10תוכנת   הצד  תעלות  תחתית  את  להציג  ושינוי  מאפשרת  האורך  חתך  ג 
אוטומטי   באופן  תעדכן  התוכנה  לאורך  בחתך  שינויים  לאחר שנבצע  התעלות.  הנתונים של 
את חתכי הרוחב של התעלות. כדי להציג את נתוני תעלות הצד ע"ג החתך לאורך בצע את 

 הפעולות הבאות:
 

מתוך  ראשית יש ל"אפס" את עומק התעלות בחתכים לרוחב. במידה ולא נאפס את העומק  
 תתייחסנתוני החתכים, התוכנה תחשב את עומק התעלה מהנתונים שקיימים בחתכים ולא  

 לנתונים מחתך האורך. על מנת לבצע זאת, בצע את השלבים הבאים:
 . Roads->Cross sectionsהכנס לחלון חתכי הרוחב ע"י 

 .  Right ditch-ו  Left ditchהעבר ברשימות אשר נמצאות בתחתית המסך ל:
)בשדות:    אפס התעלות  עומק  נתוני  כל   depth in cut, depth in fill, depth inאת 

between  .)( בתעלה הימנית והשמאלית )במידה והוגדרו 
 Sendעמוד על כל אחד מהשדות שאיפסת ולחץ על הכפתור הימני בעכבר, תופיע ההודעה " 

the whole ditch?  זה לחץ " " , אם ברצונך להעתיק את כל נתוני התעלה בחתךYes אין( "
 " בחרת  אם  זו  בתעלה  השדות  לכל  זו  פעולה  לבצע  רק  Yesצורך  להעתיק  ברצונך  אם   .)"

  .NOשדה זה לחץ 
על  לחץ  התעלה.  נתוני  את  אליהם  להעתיק  שברצונך  החתכים  את  בחר  שיפתח,  בחלון 

 לאישור.  OKעל מנת להעתיק את הנתונים לכל החתכים. לחץ  כפתור  
וקיימות תעל )במידה  לשני הטבלאות  צידי הכביש, בצע את הפעולות הנ"ל   rightות בשני 

ditch ו-Left ditch .) 
הפעל: הראשי  התפריט  )מסרגל  האורך  חתך  למסך   Roads -> Vertical  הכנס 

Alignment.) 
וכן בנתוני ה  IL-תוכל להבחין בחתך האורך של ה ומימין  בטבלה     IL-תעלות הצד משמאל 

  Include R. Ditchלים שדות אלו הסר את הסימון ליד השדות:התחתונה. אם ברצונך להע 
L. Ditch      ולחץApply  .בחלון חתך האורך יופיע חתך האורך הקיים והמתוכנן של הכביש .

)השתמש בחץ הקטן    DitchR  -, העבר לCenterlineברשימה שבחלון הימני, ליד הכיתוב  
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יעלם והטבלאוCenterlineשמימין לכיתוב   ת שמתחתיו יתחלפו. שים לב לשינוי  (. השרטוט 
(  Invert Level  -(. הטבלה מייצגת כרגע את תכנון חתך האורך )הDesignבטבלת התכנון )

 (. DitchRשל תחתית התעלה הימנית )
,  1בשדה לידו הכנס    ". Right ditch dist. From road edgeבחלון הימני מופיע הכיתוב " 

הקרקע הקיימת. חתך אורך זה יבנה במרחק של   . לפניך יופיע חתך אורך שלApplyולחץ  
מ' )כפי שהגדרנו זה עתה(, מימין לקצה חתך הרוחב המוגדר. תוכל להבחין כי נתוני    1  -כ

ה   בטבלת  מופיעים  שהם  כפי  שנלקחו,  ה  Topoהקרקע  התחתונה(,  לפי י)השמאלית  נם 
לאורך חתכים    מ'(. התוכנה עברה  20המרחקים הרצים של החתכים שהגדרנו )בדרך כלל כל  

 1 -אלה, מצאה את מרחקה של נקודת הדיקור הימנית בכל חתך וחתך, הוסיפה למרחק זה כ
נבנה החתך   אלו  נקודות  אוסף  בעזרת  זאת.  בנקודה  הקיימת  הקרקע  גובה  את  ודגמה  מ', 

 שלפנינו )גובה חתך האורך המתוכנן של הציר נשאר כפי שהיה(.
 חתך האורך של התעלה. בחלון הימני, לסיום הגדרת  Closeלחץ 

 
 
 נוספות Coverפעולות  .2
 

  5, מופיע עמודה  Designed G.L  -והן ב  Structure  -בטבלאות הגדרת חתך הרוחב, הן ב
הכותרת   בטבלת הCoverבעלת  בעיקר  זו  עמודה  כבישים, תשמש  בתכנון   .-  Structure  .

יהיה   לא  בהן  אשר  תעלות,  "תכ  Structureבתכנון  בפרק  הרחבה  )ראה  תעלות  כלל  נון 
. פעולה אחת של עמודה זו,  Designed G.L  -של ה  Cover  -ומאגרים"(, נשתמש בעמודת ה

והיא   הרוחב",  חתכי  "הגדרת  הפרק  במהלך  הדיון  Contours -2נדונה  את  כעת  נרחיב   .
 .Cover -בשאר פעולות ה

וממוספרת  מקטע  נקראת  הרוחב  בחתך  שורה  כל  )תזכורת:  הרוחב  בחתך  מקטע  לכל 
קיימת הגדרת  במספרי ושליליים לשמאלו(,  לימין הציר,  חיוביים  נפרדת.    Coverם סידוריים 

. להגדרת  None -0, או כפי שהיא מוגדרת  Coverברירת המחדל לכל המקטעים הנה ללא  
Cover שממול למקטע ולחץ לחיצה כפולה עם העכבר  5 -למקטע מסוים עמוד על העמודה ה

(Double clickתיפתח רשימה ה   (. בשדה  נפרט את האפשרויות   Cover  -לבחירת  הרצוי. 
 לבחירה:

 
הערה: כל הפרוטים המופיעים מטה, למעט הגדרת קווי הגובה, רלוונטיים אך ורק לעבודה 

)ראה: בחירת   Earthworksואינם רלוונטיים לעבודה עם חתכים מסוג    Designעם סוג חתכי  

 (. Options   - יצה על כפתור ההנפתח בלח Define sections widthסוג החתכים בחלון 
 

None-  ומשמעותו כי למקטע אין    0  -ברירת המחדל של כל מקטע. שדה ריק שקול לCover 
 מוגדר. 

Asphalt  בחירת  )-)אספלטAsphalt    :אופנים בשני  המקטע  על  תשפיע  מסוים  למקטע 
 -2מסוג    Coverלמקטע זה יוגדרו קווי גובה, בדיוק באותה צורה כפי שהיו לו אם היה נבחר  

Contours  ראה הרחבה בהמשך(, וכן יינתן עובי לקו מבנה פני הכביש )קו ה(-  Structure  ,)
לחץ   על החתך  הבחירה  את השפעת  לראות  בכדי  הנ"ל.  הנבחר Applyבמקטע  . המקטע 

 יודגש בקו עבה. 
Contours    )גובה ב    -)קווי  הפרק  Contoursמסוג    Coverהשימוש  במהלך  כבר  הודגם   ,
רוחב".  "הגדרת   הגובה   Coverחתכי  קווי  יוצגו  שבו  התחום  להגדרת  משמש  זה  מסוג 

  Contours  -בתנוחה. אם ברצוננו בקווי גובה אך ורק בתחום האספלט של הכביש, נבחר ב 
רק במקטעים המגדירים אספלט. לקבלת קווי גובה על המדרכה לדוגמא, נסמן גם מקטעים  

יש  . חשוב לציין שעל מנת לקContours  -אלו ב בל קווי גובה בתנוחה, במקטעים הרצויים, 
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לא נראה   Contoursלאורך מספר חתכים במקטע מקביל. לאחר שיבחר    Contoursלהגדיר  
 כל השפעה על גבי חתך הרוחב. ההשפעה תמומש רק בשלב שרטוט התנוחה. 

 
 

Sidewalk    )בחירת   -)מדרכהSidewalk   קו כפול במקטע למקטע מסוים תגרום לשרטוט 
 בי חתך הרוחב. על ג

Garden    )בחירת    -)צמחיהGarden   על במקטע הנבחר,  צמחיה  מסוים תשרטט  למקטע 
 גבי חתך הרוחב. 

  
 Block    )אבני   -)בלוקים כגון  הרוחב  בחתך  בלוקים  "שתילת"  זו מאפשרת  אופציה 

ועוד.   בטיחות  מעקה  תוכנתשפה,  של  ההתקנה    קיימת  CivilCAD 10  בתיקיית 
, אשר Dwgים )הכוונה היא לבלוקים של שרטוט(, בפורמט  ספרייה ובה אוסף בלוק

את  נגדיר  הספציפי,  הרוחב  הטיפוסי/בחתך  בחתך  הרוחב.  לחתכי  להוסיפם  ניתן 
בצע  כן  לעשות  החתך.  משרטוט  כחלק  יופיע  הוא  מכן  ולאחר  הבלוק,  וסוג  מיקום 

 הפעולות הבאות:
 . coverלחץ על המקטע הרצוי, תחת העמודה  
שנפ  הקבצים  התוכנה בחלון  של  הבלוקים  מותקנים  שבה  לספרייה  עבור  תח 

יותקנו הבלוקים האלה בספריית   כלל  (, (CivilCAD 10\Roads blocks)בדרך 
 (. Open) ובחר את הקובץ הרצוי. לאחר הבחירה לחץ על "פתח" 

התוכנה תמקם את הבלוק הנבחר בחתך, במיקום של קצה המקטע אליו הוא  
 שויך. 

וק שנבחר לשדה מסוים, יש לבחור שדה זה  הערה: על מנת לצפות בבל
העכבר(   )סמן  הסמן  עם  ולהמתין  השדה(,  על  העכבר  עם  אחת  )לחיצה 

  שניות יופיע שמו של הקובץ בכיתוב צהוב. 2 -עליו. לאחר כ
 של חתכים הכוללים בלוקים בצע את הפעולות הבאות: DXFלקבלת קובץ 

 חתכי הרוחב"(.של השרטוט כרגיל )ראה פרק "תכנון  DXFיצר קובץ  
 .AutoCAD/ZWCADפתח חלון  
החתכים  AutoCAD/ZWCAD  -של  DXFINבפעולת    קובץ  את  בחר   ,

 שיצרת. הקובץ יוצג כשבחתכים הבלוקים שנבחרו. 
 

 In cut only-    )בלבד היא   -)בחפירה  אליו  המקטע  הגדרת  מאפשרת  זו  אופציה 
 שייכת, כמקטע אשר יופיע רק אם הוא בחפירה. 

 In fill only-   )אופציה זו מאפשרת הגדרת המקטע אליו היא שייכת,   -)במילוי בלבד
 .כמקטע אשר יופיע רק אם הוא במילוי

 
שערכו לא    Coverהרצוי.     Coverחלק מהגדרת החתך הטיפוסי כולל בתוכו את הגדרת ה  

יהיה   וביצוע אינטרפולציה על מנת  0ישונה  , כלומר ללא כל השפעה. העתקת חתך טיפוסי 
ל שאר החתכים )ראה פרק "תכנון חתכי הרוחב"(, תכלול בתוכה את העתקת ה להשליכו ע

Cover    להוסיף ברצוננו  אם  החתך    Coverשלו.  השלכנו  שכבר  לאחר  חתכים  למספר 
ה   בפעולת  להשתמש  נוכל  החתכים,  על  רוחב"(.    Send toהטיפוסי  חתכי  "תכנון  )ראה 

לחוץ כפתור ימני בעכבר. בטבלת  במקטע הרצוי ול  Coverלעשות כן יש לעמוד על שדה ה   
ה   את  להעתיק  ברצוננו  אליהם  החתכים  את  לבחור  יש  וללחוץ  Coverהחתכים שתיפתח   ,

OK ה .Cover   .יועתק לחתכים הנבחרים 
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 תכנון ברמות 
 

ע"י    CivilCAD 10תוכנת   אוטומטי,  באופן  הרוחב  בחתכי  ברמות  של  הוספה  מאפשרת 
 וש באפשרות זו ע"י דוגמא: נדגים את השימ .Berms   שימוש במצב

 
 . File->Open projectהפעל 
   Sample7לצורך הדוגמא: עם כביש מוכן  פרויקטפתח 

 
 הפרויקט נמצא במיקום ברירת המחדל:  Windows 7/8/10במערכת הפעלה 

C:\ProgramData\SivanDesign\CivilCAD\Samples\Sample7\ 
 
 

 . Roads->Cross sectionsהכנס לחתכי הרוחב ע"י 
 עבור לחתך הראשון ברשימת החתכים שנמצאת בחלון הימני. 

 מתוך הרשימה הנפתחת. Bermsלמצב  .Designed G.Lהעבר את טבלת 
 בטבלה שתופיע מלא את הנתונים לפי הדוגמא הבאה:

 

                 
 

 כדי להציג את השינויים על גבי השרטוט.  Applyלחץ 
 

 טבלה: הנסביר את מבנה 
 

בירוק    R  ו   L  השורות נת  אינן המסומנות  להכנסת  בין    אלאונים  שורות  המפרידות  שורות 
 תכנון הברמות בקצה הימני לקצה השמאלי של החתך.

 מציינות את תכנון הברמות במצב של חפירה.  Cut Zoneהשורות 
 מציינות את תכנון הברמות במצב של מילוי.   Fill Zoneהשורות 

 
Width – המדרגה לפני כל ברמה רוחב. 

Height – הברמה עצמה גובה. 
Slope – ניתן לקבוע שיפוע בעל ערך שלילי. המדרגה לפני כל ברמה שיפוע , 

 
 Designedשיפוע בהרמה יהי זהה לשיפוע שיקבע לסגירת הדיקור אותו מגדירים בטבלת  

G.L :בשדות 
Slp. left : Cut 1:        Fill 1:   
Slp right: Cut 1:        Fill 1: 
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 ת תכנון הברמה לחתכים נוספים העתק 
 

בחתך   הברמות  תכנון  את  להעתיק  ליד  מסויםכדי  הנמצאים  בכפתורים  להשתמש  ניתן   ,
או ללחוץ על הכפתור הימני בעכבר כאשר הסמן נמצא על הטבלה    Pasteו     Copyהטבלה  
ובחלון שיפתח לסמן את החתכים שברצוננו להעתיק אליהם את הטבלה.  -Send to לבחור ב

 בכדי להעתיק את הטבלה לכל החתכים.  ון זה ניתן ללחוץ על כפתור בחל
 

 ( Tmlעבודה עם חתכים טיפוסיים ) 
 

בתכנון חתכי הרוחב,קובץ זה שומר   Templateמאפשרת יצירת קבצי    CivilCAD 10תוכנת  
בחתך   המצבים  כל  של  טיפוסי  תכנון  צד   מסויםבתוכו  התכנון,המבנה,תעלות  את  הכוללים 

נסב קובץ  וברמות.  ליצור  ניתן  כיצד  הבאה  הדוגמא  ע"י  מכן TMLיר  ולאחר  אותו  לשמור   ,
 . מסוים בפרויקטלהשתמש בו למילוי החתכים 

 
 

    Templateיצירת קובץ 
 

 .Roads-> Cross sectionsחדש והפעל   פרויקטפתח 
 בחלון חתכי הרוחב הכנס חתך אחד לרשימת החתכים בחלון הימני. 

כפתור   על  מ     Optionsלחץ  חתך  dHלמצב    Eelevationוהעבר  יוצרים  שאנו  מכיוון   ,
 טיפוסי נצטרך לעבור למצב עבודה בגבהים יחסיים. 

בקובץ   להכיל  ומלא את הטבלאות שברצונך  בצדו התחתון של המסך  עבור לטבלאות  כעת 
בפרק    Templateה שמוסבר  הרוחבכפי  חתכי  מלאתכנון  הדוגמא  לשם  ה .  מצבי  -את 

Design  וה- Structure   .בחתך זה 

 .  Save sections to fileלאחר מילוי המצבים לחץ על כפתור 
 . Save as typeליד הכיתוב   Template(*.Tml)בחלון הקבצים שיפתח העבר למצב
 . Saveבחר את שם הקובץ לתבנית זו ולחץ 

אשר נתכנן בו חתכים לרוחב.    פרויקט כעת שמרנו את החתך ונוכל מעתה להשתמש בו בכל  
ה  רצוי קובץ  זה לשם   Templateלשמור את  לרכז קבצים מסוג  מיוחדת המיועדת  בתיקייה 

 מציאתם בקלות לשימוש בעתיד. 
 

 לתוך לתכי הרוחב   Templateייבוא מקובץ 
 

 בצע את הפעולות הבאות TMLעם חתכי רוחב הממולאים ע"י קובץ   פרויקטכדי ליצור  
 . File->New projectע"י -CivilCAD 10 ב חדש פרויקטפתח 

כפי שהוסבר  Roads->Horizontal alignment ע"י האופקי   התוואיואת   הגדר כביש חדש
 האופקי. התוואיתכנון בפרק 

ע"י   האורך  חתך  לחלון  הרצוי    Roads->Vertical alignmentעבור  הכביש  את  בחר 
 . התוכנה תדגום את המצב הקיים לתוך החתך.Applyמרשימת הכבישים בחלון הימני ולחץ 

הה בטבלת  נתוניו  מילוי  ע"י  המתוכנן  האורך  החתך  את  השימוש   Design  -גדר  ע"י  או 
 .הגדרת חתך האורךכפי שהוסבר בפרק   pickבפקודה 

 כדי לעדכן את השרטוט לפי הנתונים שמולאו בטבלה.  Applyלחץ 
 . -closeע"י לחיצה על כפתור ה Vertical alignmentצא מהחלון 

 . Roads->Cross sectionsי עבור לחלון חתכי הרוחב ע" 
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מ    Optionsלחץ על כפתור   , מכיוון שאנו מייבאים חתך dHלמצב    Eelevationוהעבר 
 טיפוסי נצטרך לעבור למצב עבודה בגבהים יחסיים. 

 .  Define sections ע"י לחיצה על כפתור  ביניהםהגדר את מספר החתכים והמרחקים 

 . Existingת המצב הקיים אל תוך טבלת ה כדי לדגום א GetTAll     לחץ על כפתור

 .   Load sections from text fileלחץ על כפתור 
ה קובץ  את  *בחר  הקבצים  להבחין    TMLבחלון  תוכל  החתכים.  לתוך  לטעון  שברצונך 

 בתחתית החלון בתצוגה המראה את צורת החתך המסומן בחלון הקבצים. 
 . TMLי קובץ ה, התוכנה תמלא את חתכי הרוחב בנתונOpenלחץ על 

 
 . Templates*לצורך הדוגמא תוכל לבחור מקבצים שכבר קיימים בתוך התיקייה:  

 
 הפרויקט נמצא במיקום ברירת המחדל:  Windows 7/8/10במערכת הפעלה 

C:\ProgramData\SivanDesign\CivilCAD\Templates\ 
 
 

 נושאים מתקדמים בתכנון חתכי הרוחב. 
 

 ם:בסעיף זה, נדון בנושאים הבאי
 

  Changing side slopes –שבירת שיפוע במקטעי הדיקור  
  Beside road –תכנון מעבר לתחום הכביש  
  Land development –פיתוח שטח  
 דיקור תנוחת הכביש אל מגרשים בצידי הכביש  
  Utilities–תשתיות  
  Side slope by road height–שיפועי צד לפי גובה הכביש  
 . Attach lines to roads –קווים מהתנוחה   שינוי החתכים ע"י בחירת 
 "דפדוף" מהיר בין חתכי רוחב 
 ריבוי שכבות 

 
 

  Changing side slopes –שבירת שיפוע במקטעי הדיקור 
מהקרקע CivilCAD 10 תוכנת   גובה  הפרש  לפי  בדיקור  שיפוע  שינוי  הגדרת  מאפשרת 

ה מרום  גובה  הפרש  או  זDesign G.L  -הטבעית,  לבצע  מנת  על  השלבים  .  לפי  פעל  את 
 הבאים: 

 .  Roads->Cross sectionsמתוך התפריט הראשי הפעל:
 מתוך הרשימה.  Changing Side Slopes -העבר באחת הטבלאות שבתחתית המסך ל

 הטבלה מחולקת לדיקור צד שמאל ולדיקור צד ימין, למצבי חפירה ומצבי מילוי.  
ה )ההפרDepth/Height  -בעמודת  הגובה  את  הגדר  לפי  ,  השיפוע  שינוי  יתבצע  ממנו  ש( 

 הכללים הבאים:
 שבירת השיפוע תתבצע בהפרש מהמצב הקיים.  -ערך חיובי
 )גובה עבודות עפר(.  Design G.L -שבירת השיפוע תתבצע בהפרש מגובה ה -ערך שלילי
, הגדר את יחס השיפוע שלאחר השבירה )השיפוע שלפני השבירה יוגדר  Slope  -בעמודת ה
 (.  Design G.L -בשיפועי הצד של הבאופן רגיל 
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, ניתן להגדיר מרווח ליצירת מדרגה )ברמה( בין שני השיפועים. המרווח  Space  -בעמודת ה
 יוגדר במטרים. 

 על מנת לראות את השינויים בשרטוט החתך. Applyלחץ 
על מנת להעתיק נתונים אלו לכל החתכים או לחלק מהחתכים לחץ בטבלה על כפתור ימני  

לחץ  Send toובחר  בעכבר   או  מספרי החתכים  את  בחר  שייפתח  בחלון  כל   .  לבחירת 
 . OKהחתכים ולחץ 

 
 

  Beside road –תכנון מעבר לתחום הכביש 
ר תכנון במקטעים שמעבר לכביש )לדוגמא: אם ברצוננו לתכנן תעלה אחרי  יהגדל  באפשרותך

 קו הדיקור( .על מנת לבצע זאת פעל לפי השלבים הבאים:
 .  Roads->Cross sectionsתפריט הראשי הפעל:מתוך ה

 מתוך הרשימה.   Beside road -העבר באחת הטבלאות שבתחתית המסך ל
 הטבלה מחולקת לדיקור צד שמאל ולדיקור צד ימין, למצבי חפירה ומצבי מילוי.  

( ומילוי  חפירה  ולמצבי  ימין/שמאל  לצד  הבאים  הנתונים  את  (  Cut zone/Fill zoneמלא 
 ורך:בהתאם לצ
Distance  – .מרחק התכנון מקצה החתך 

Width –  .רוחב תחתית התעלה/מבנה 
Dh(+/-) – )גובה התכנון ביחס לגובה קצה החתך )ניתן להכניס ערך שלילי ע"י מינוס. 

Slope  –  1:2יגדיר שיפוע  2שיפוע דפנות התעלה/מבנה )לדוגמא הכנסת ערך(. 
 ט החתך.על מנת לראות את השינויים בשרטו Applyלחץ 

על מנת להעתיק נתונים אלו לכל החתכים או לחלק מהחתכים לחץ בטבלה על כפתור ימני  

ובחר   לחץ  Send toבעכבר  או  מספרי החתכים  את  בחר  שייפתח  בחלון  כל   .  לבחירת 
 . OKהחתכים ולחץ 

 
  Land development –פיתוח שטח 
צורך המחשת הנושא נסביר  ר סימון של פיתוח שטח בתוך חתכי הרוחב. ליהגדל  באפשרותך

 את הדוגמא לפי השלבים הבאים:
 .  Roads->Cross sectionsמתוך התפריט הראשי הפעל:

 מתוך הרשימה.  Land development -העבר באחת הטבלאות שבתחתית המסך ל
 מלא את הנתונים הבאים לצד ימין/שמאל:

Parcel no – .שם/מספר המגרש 
Development elev. – ח )גובה אבסולוטי(.גובה הפיתו 

Earthworks elev. – .)גובה עבודות העפר )גובה אבסולוטי 
בשרטוט החתך.  Applyלחץ   השינויים  את  לראות  מנת  גבהי   על  של  בסימון  להבחין  תוכל 

 הפיתוח על גבי השרטוט. 
על מנת להעתיק נתונים אלו לכל החתכים או לחלק מהחתכים לחץ בטבלה על כפתור ימני  

ובחר   לחץ  Send toבעכבר  או  החתכים  מספרי  את  בחר  שייפתח  בחלון   .A   כל לבחירת 
 . OKהחתכים ולחץ 

 
 דיקור תנוחת הכביש אל מגרשים בצידי הכביש

 כדי לדקר כביש אל מגרש מתוכנן:
 . Explodeסמן את המגרשים שאליהם ידוקר הכביש ובצע פעולת   
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פעולת    ביצוע  המגרשיExplodeלאחר  קווי  של  השכבה  את  שנה  לצד  ,  הפונים  ם 
 (.  Referenceהכביש, לשכבה חדשה בשם רצוי )

 .  ’Roads→Cross Sections‘מהתפריט הראשי הפעל:  

 ייפתח.   ’References‘. חלון   ’Get References By Layer‘לחץ על כפתור  
  –מסומנת ב    ’Add sections according to reference edges‘וודא כי האופציה   

‘V’. 
ה    את  כפתור    Reference  –בחר  על  לחץ  או  רשימת השכבות  מתוך  של השכבה 

‘Select’  סמן את השכבה מתוך השרטוט, הקש על כפתור ,‘Enter’   במקלדת ולחץ
 .   ’OK‘על כפתור 

 . Referencesשנה את אחת הטבלאות בתחתית המסך לטבלת  
 .’Edge Attachment‘באופציית   'Cover'בחר בעמודת    Referencesבטבלת  
לחתכי רוחב אחרים לפי בחירה, עמוד    ’Edge Attachment‘לשלוח את הגדרת    כדי 

 ולחץ על הכפתור הימני בעכבר. ’Cover‘עם הסמן על השורה בתא של עמודת 
ולאחר מכן סמן את החתכים אליהם   'Send to'בתפריט שייפתח סמן את האפשרות   

ע"י   גם  חתכים  מספר  לסמן  )ניתן  הנתון  את  לשלוח  ע"י    Shiftברצונך   Ctrlוגם 
לחתכים לא עוקבים(. הבחירה תועתק לחתכי הרוחב שנבחרו. לאחר מכן יש לבצע 

 אינטרפולציה. 

בגבולות המגרש   . התוכנה תיצור חתכי ביניים   ’Create Layout‘לחץ על כפתור   
 לצורך דיקור מדוייק של הכביש למגרש בתנוחה. 

 Design –ב  Applyלחיצה על ע"י   3D Polylineניתן להחזיר את המגרשים לשכבת 
planes . 

 
  References–תשתיות 

המחשת יהגדל  באפשרותך לצורך  החתך.  בתחום  עוברים  אשר  תשתית  קווי  של  סימון  ר 
 הנושא נסביר את הדוגמא לפי השלבים הבאים:

 .  Roads->Cross sectionsמתוך התפריט הראשי הפעל:
ל המסך  שבתחתית  הטבלאות  באחת  שתי    References  -העבר  נסביר  הרשימה.  מתוך 

 שיטות למילוי הנתונים: 
 שיטה א': ע"י הכנסת הנתונים הבאים באופן ידני לטבלה:

Name  –  .)...שם השכבה של קו התשתית )חשמל,ביוב,טלפון וכו 
Offset  –  .המרחק ממרכז הציר 

Elevation –  .)גובה התשתית בחתך )גובה אבסולוטי 
Depth  – שתית ביחס לגובה מבנה הכביש. ניתן להכניס את עומק הת 

Diam (cm)  –  .)קוטר צינור התשתית )בס"מ 
 

)למשתמשי   התנוחה  שרטוט  מתוך  שכבות  בחירת  ע"י  ב':    AutoCAD/ZWCADשיטה 
 .בלבד(

 בצד ימין של חלון החתכים.  לחץ על כפתור  
 שרטוט התנוחה יופיע ומעליו יפתח חלון עם רשימת השכבות.

השכב שמות  את  ברשימה  על  סמן  לחץ  או  השכבות   Selectות  את  השרטוט  מתוך  וסמן 
 הרצויות. 

 . OKלסיום לחץ 
 בין החתכים.  דפדוף( ע"י הרלוונטייםתוכל להבחין סימון התשתיות ע"ג החתכים )

 ניתן לתקן נתונים אלו ולהשלימם לפי המוסבר בשיטה א'.
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  Side slope by road height–שיפועי צד לפי גובה הכביש 
ל ההגד באפשרותך  לאחר  הכביש.  עומק  או  לגובה  בהתאם  צד  שיפועי  התוכנה רהגדיר  ה 

תחשב את שיפועי הצד בהתאם לאפשרויות שהוגדרו. ניתן להגדיר מספר אפשרויות בהתאם 
 לצורך. כדי להגדיר את שיפועי הצד בשיטה זו בצע את השלבים הבאים: 

 .  Roads->Cross sectionsמתוך התפריט הראשי הפעל:
באח ל העבר  המסך  שבתחתית  הטבלאות  מתוך   SideSlopes by road height  -ת 
 הרשימה. 

 מלא את הנתונים הבאים לצד ימין/שמאל:
Depth/height  –    התוכנה תיצור את  1הכנס את הגובה/עומק )לדוגמא ע"י הכנסת הערך ,

 מ'(.1השיפוע המוגדר באותה שורה כאשר גובה או עומק התכנון יהיה עד  
Cut 1: – (. 1:2תיצור שיפוע  2הצד במצב חפירה )הכנסת ערך  שיפוע 
Fill 1: –  .שיפוע הצד במצב מילוי 
  על מנת לראות את השינויים בשרטוט החתך. Applyלחץ 

על מנת להעתיק נתונים אלו לכל החתכים או לחלק מהחתכים לחץ בטבלה על כפתור ימני  
העתיק את כל נתוני הטבלה  אם ברצונך ל  Yes. בחלון ההודעה לחץ  Send toבעכבר ובחר  

על מנת להעתיק רק את הנתון הנוכחי. בחלון שייפתח בחר את מספרי החתכים או   Noאו  
 . OKלבחירת כל החתכים ולחץ  Aלחץ 

 
 .מתוכנן בכל חתךלמצב הקיים המצב  ההפרש הגבהים בין   התוכנה תבצע בדיקה של

 
העומק/גובה   הגדרותעל עם  בפו  הגבהים  הפרש  בטבלה, התוכנה תשווה את  ההגדרותעל פי  

ההפרש  Depth/Height  תועמודב אם  את    תחשב התוכנה    -נתון  המ   קטן.  חתך  לאותו 
 . המתאימה ע"פ בדיקת הגובה שורהמתוך ה  Slopeעמודת שיפוע שבה

הפרש   התוכנה תחשב    גדולגבהים  האם  ברשימה,  הנתונים  השיפוע מכל  את  לאותו חתך 
 ס הוא הערך הגבוה(.האחרון שברשימה )בהנחה שאחרון שהוכנ

 
Attach lines to roads  .שינוי החתכים לרוחב ע"י בחירת קווים בתנוחה  

הזזת     CivilCAD 10בתוכנת   ע"י  החתכים  תכנון  את  לשנות  בטבלאות   הסגמנטיםניתן 
  הסגמנט )שכבות( בשרטוט התנוחה. התוכנה תצמיד את    מסוימיםהתכנון לפי בחירת קווים  

 ם בשכבה אשר נבחר. לביצוע פעולה זו בצע את השלבים הבאים:)האופסט( הרצוי לקווי

 .ל ץ על הכפתור הנ" בחלון חתכי הרוחב לח
 חלון החתכים ירד וחלון שרטוט התנוחה יופיע ומעליו חלון. 

 הרצוי.  הסגמנט, בחר את -Sections segmentsברשימת ה
 Don’t changeת:  זה מבלי לשנות את גובהו, סמן את האפשרו  סגמנטאם ברצונך להזיז  

elevation . 
גובה   את  לשנות  ברצונך  האפשרות:    הסגמנטאם  את  סמן  להזיזו,   Don’t changeמבלי 

offsets . 
 . Structureאו   Designבחר את הטבלה שברצונך לשנות 

מרחק   הכיתוב    מקסימאליהקלד  ליד  הציר(  ממרכז  )מרחק  הקווים  לחיפוש   Search)מ'( 
range . 
ור לשרטוט ולחץ על קו אחד המייצג את שכבת הקווים שברצוננו להצמיד , עבSelectלחץ על 

 .Enterלתכנון ולחץ 
 OK. לעדכון החתכים לחץ 
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Attach ditch to line  תנוחה.עזר מהקו ל הצמדת תעלת צד  
 מאפשרת "להצמיד" תעלה לקו עזר. לביצוע הפעולה:  CivilCAD 10 תוכנת

 . Roads→Horizontal Alignment‘מהתפריט הראשי הפעל: ' 
 שרטט פוליליין אשר יהווה את קו העזר אליו תוצמד התעלה. 
 .Roads→Cross Sections‘מהתפריט הראשי הפעל: ' 

 ייפתח. 'Attach Ditch To Line'. חלון   'Attach Ditch To Line'לחץ על כפתור  
 סמן את הצד הרלוונטי )תעלה ימנית או תעלה שמאלית(. 
ובחר   'Select'העזר מרשימת השכבות או לחץ על כפתור    בחר את השכבה של קו 

 את קו העזר מתוך השרטוט.
 . 'OK'לחץ על כפתור  

 

התעלה נצמדת לקו העזר בנקודת הקצה של תחתית התעלה בהתאמה לצד ימין או    :הערה 

 שמאל. 

 
 

 
 "דפדוף" מהיר בין חתכי רוחב

בין חתכ ע"פ הגדרת מרחק  רוחב  בין חתכי  ל"דפדף"  רץ אשר ממנו  באפשרותך  ומרחק  ים 
 יתחיל ה"דפדוף"* 

 
 לפני כן(.  Triangles*לצפייה בלבד )יש לבנות את תנוחת כל הכבישים כולל אופצית 

 
 . ’Roads→Horizontal Alignment‘מהתפריט הראשי הפעל:  
 ייפתח.  ’Layout & Contours‘. חלון ’Apply‘לחץ על כפתור  
 . ’OK‘ולחץ על כפתור  ’V‘ –מסומנת ב  ’Triangles‘וודא כי אופצית  
 .’Roads→Cross Sections‘מהתפריט הראשי הפעל:  

 ייפתח.  ’Quick Sections View‘. חלון   ’Quick Sections View‘לחץ על כפתור  
 Start( ומרחק רץ אשר ממנו יתחיל הדפדוף )Step Sizeהגדר מרחק בין חתכים ) 

From Station.) 
 או על החץ השמאלי לחזרה לחתך הקודם. לחץ על החץ הימני למעבר לחתך הבא 

 
 

 ריבוי שכבות 
 ניתן להגדיר מבנה שכבות עבור חישוב עבודות עפר ע"פ שתי שיטות:

 הגדרת מבנה שכבות שווה לכל רוחב החתך: 1שיטה  -
 שונה עבור כל מקטע בחתך Structureהגדרת מבנה שכבות : 2שיטה  -

 
 : הגדרת מבנה שכבות שווה לכל רוחב החתך1שיטה 

 
 .Roads→Cross Sections‘מהתפריט הראשי הפעל: '

 ייפתח.  ’Layers Manager‘. חלון  ’Insert Layers‘לחץ על כפתור 
 שכבת העבודה אשר בעבורה ברצונך לייצר תתי שכבות. לדוגמא:בחר את 
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בין   שכבות  תתי  לייצר  ברצונך  את  Structure  –ל    .Designed G.Lאם  לבחור  עליך   ,
Structure ת העבודה.כשכב 

 .’OK‘הזן שם לשכבה ולחץ ,   ’Define a new layer‘לחץ על כפתור 
לטבלת   המסך  בתחתית  הטבלאות  אחת  את  כן   ’Structure‘שנה  גם  השניה  הטבלה  ואת 

בתת  Structure‘לטבלת   אוטומאטית  תיפתח  השניה  הטבלה  שכבות,  תתי  כיוון שהוגדרו   .
 . ’Layers Manager‘בחלון  השכבה הראשונה ע"פ סדר השכבות כפי שהוגדר

 
ע"פ עובי    ’Structure‘  –גובה הנמוך מזה של טבלת ה    0תכנן את תת השכבה והזן במקטע  

 השכבה הרצוי.
 

בתא   בעכבר  הימני  הלחצן  עם  הקלק  נוספים,  לחתכים  ההגדרה  את  לשלוח  של    ’dH‘כדי 
 ייפתח.   ’Send to‘המקטע  שהוגדר ולחץ על כפתור ימני בעכבר. חלון 

 ’All‘את החתכים ברשימה אליהם אתה רוצה לשלוח את ההגדרה או לחץ על כפתור    סמן

 . OKלסימון כל החתכים ברשימה ולחץ  
 

 תתי השכבות שהגדרת. כל  חזור על פעולה זו עבור 
 

 . עבור לחתך האחרון ברשימתר סמן את החתך הראשון ברשימת החתכים ולחץ על כפתו

 .ר  החתכים, סמן אותו לחץ על כפתו

לעדכון שרטוט החתכים ע"פ ההגדרות    ’Interpolate empty sections‘לחץ על כפתור 
 החדשות.

 
 Roads→Earthworks‘מהתפריט הראשי הפעל: 

מופיעות    ’Structure‘. שים לב כי בתחתית החלון, בריבוע של   ’Options‘לחץ על כפתור 
 עפר.עבור חישוב עבודות ה ’V‘ –גם תתי השכבות ומסומנות ב 

 דו"ח עבודות עפר. הפקת עבור  ’Apply‘ולאחר מכן לחץ   ’OK‘לחץ 
  –על מנת להשתמש בתבניות הנ"ל בפרויקטים עתידיים, יש ליצור אותן ב   :הערה 

Prototype . 
 
 

 שונה עבור כל מקטע בחתך Structureהגדרת מבנה שכבות : 2שיטה 
 

 .Roads→Cross Sections‘מהתפריט הראשי הפעל: '

 ייפתח.  ’Options‘. חלון   ’Options‘כפתור לחץ על 

 ייפתח.  ’Materials‘. חלון  ’Materials‘לחץ על כפתור 
 . לדוגמא: OKולחץ  Structure –הזן את האלמנטים אשר ירכיבו את מבנה ה 
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 . OKולחץ   ’Delete one material‘כדי למחוק אלמנט מהרשימה, לחץ על כפתור 

ולחץ      ’Delete all materials‘ים מהרשימה, לחץ על כפתור  כדי למחוק את כל האלמנט
OK.  

, בחר שם ומיקום לשמירת הקובץ   כדי לשמור את רשימת האלמנטים, לחץ על כפתור
 . ’Save‘ולחץ 

 . ’Open‘, בחר את הקובץ הרצוי ולחץ   כדי להעלות רשימת אלמנטים, לחץ על כפתור
 

אשר ישויכו למקטעים. ניתן להגדיר לכל תבנית   לאחר הגדרת האלמנטים יש להגדיר תבניות
 אלמנטים שונים בסדר שונה מתוך רשימת האלמנטים. 

 

 ייפתח.  ’Structure Layers‘. חלון    ’Structure Layers‘לחץ על כפתור 
 (.Template1בחלקו העליון של החלון, הגדר רשימת תבניות )ברירת המחדל הינה 

התחתון של החלון בחר את האלמנטים אשר מרכיבים   סמן את התבנית הראשונה ובחלקו
 את התבנית הנוכחית מתוך הרשימה והגדר את העובי בס"מ של כל אלמנט. לדוגמא:
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 .Template width (cm)בתחתית החלון יופיע עובי התבנית הכולל בעמודת 
תון בחלקו  לשינוי סדר האלמנטים בתבנית, סמן את האלמנט ולחץ על החץ העליון או התח 

 הימני של החלון.
 

 : כפתורים נוספים בחלקו העליון של החלון

 .OKולחץ    ’Erase one template‘כדי למחוק תבנית מהרשימה, לחץ על כפתור 

כפתור   על  לחץ  כל התבניות מהרשימה,  את  למחוק  ולחץ     ’Clear all templates‘כדי 
OK . 

, בחר שם ומיקום לשמירת הקובץ ולחץ   כדי לשמור את רשימת התבניות, לחץ על כפתור 
‘Save’ . 

 .’Open‘, בחר את הקובץ הרצוי ולחץ   כדי להעלות רשימת תבניות, לחץ על כפתור
 

 : כפתורים נוספים בחלקו התחתון של החלון

 . OKולחץ   ’Erase one material‘כדי למחוק אלמנט מהרשימה, לחץ על כפתור 

ולחץ      ’Clear all materials‘, לחץ על כפתור  כדי למחוק את כל האלמנטים מהרשימה
OK . 

'  ’Copy/Paste‘כדי להעתיק אלמנטים מתבנית אחת לתבנית אחרת, השתמש בכפתורים 

/. 

  , להוספת שורה חדשה עבור אלמנט נוסף. ’New Material‘לחץ על כפתור 
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 לשמירת ההגדרות. OKלחץ 
 . ’Structure‘שנה את אחת הטבלאות בתחתית המסך לטבלת 

 .’Sublayers‘ –תשתנה ל  ’Cover‘. המילה ’Cover‘לחץ על עמודת 
 

 
 

מול המקטע הרצוי ובחר עבור המקטע את התבנית הרצויה   ’Cover‘הקלק פעמיים בעמודת 
 מתוך רשימת התבניות.

 ’Sublayers‘כדי לשלוח את ההגדרה לחתכים נוספים, הקלק עם הלחצן הימני בעכבר בתא 
 ייפתח.  ’Send to‘הוגדר ולחץ על כפתור ימני בעכבר. חלון של המקטע  ש

 ’All‘סמן את החתכים ברשימה אליהם אתה רוצה לשלוח את ההגדרה או לחץ על כפתור 

 . OKלסימון כל החתכים ברשימה ולחץ  
 Roads→Earthworks‘מהתפריט הראשי הפעל: 

 עבור דו"ח עבודות עפר.  ’Apply‘ולחץ  
 

  –ש בתבניות הנ"ל בפרויקטים עתידיים, יש ליצור אותן ב  הערה: על מנת להשתמ
Prototype . 

 
, לחץ על Structure –על פי מבנה שכבות ה  .Designed G.Lלעדכון הנתונים בטבלת 

 . Update Designed G.L. by Structure Sub Layers כפתור  

לעדכון כל     ’All‘בחר אילו חתכים מהרשימה לעדכן או לחץ על כפתור  ’SenD To‘בחלון 
 . ’OK‘ושוב  ’OK‘החתכים ולאחר מכן לחץ על כפתור 

 
 
 

 חישובים גיאומטריים לאורך הציר 
 

ביניהם    CivilCAD 10תוכנת   שונות,  מצורות  הציר  לאורך  גיאומטריים  חישובים  מאפשרת 
ברץ וניצב לאורך הציר, דו"ח נתונים גיאומטריים של הציר ועוד. את רוב    קואורדינטותחישובי  

הפעולות בחלון זה ניתן לבצע מיד לאחר הגדרת התוואי האופקי של הציר, וללא כל הגדרה 
של נקודות   קואורדינטותהשל חתכי רוחב. אם זאת, כפי שנראה, קיימת אפשרות לחשב את  

 הדיקור בחתכים ולכך חייבת התוכנה שבפרויקט המחושב יוגדרו חתכי רוחב. 
ל הכנס   גיאומטריים  חישובים  . Roads -> Coordinates computations   -להפעלת 
 בחלון שיפתח קיימות האפשרויות הבאות:

 
  -חישוב נקודה בודדה -לאורך הציר או בניצב לו קואורדינטותחישובי 

 .Coord -הנך נמצא ב  Geom -ל Coordוודא שבאפשרויות הבחירה המופיעות בחלון בין 
של הנקודה שברצונך לחשב. לחישוב הכנס את המרחק הרץ )במטרים(,    Station  -בשדה ה

 להמשך. Enter. לחץ 20נקודה בחתך השני לדוגמה, הכנס 
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נקודה  Offset  -בשדה ה לחישוב  לו(.  )בניצב  מהציר  הנקודה המחושבת  היסט  את  הכנס   ,
או השאר את השדה ריק. לחישוב נקודה משמאל לציר הזן מרחק שלילי   0בציר עצמו הזן  

 להמשך. Enterולימינו מרחק חיובי. לחץ 
להיות New pointבשדה   יכול  הנקודה  שם  שתחושב.  החדשה  הנקודה  שם  את  הכנס   ,

 מספר, או שם אלפאנומרי הכולל אותיות.
על   כפתור    Enterלחץ  על  ותוסיף    הקואורדינאטה. התוכנה תחשב את  Applyאו  הרצויה, 

 שבחלון התחתון.  קואורדינטותהאותה לרשימת 
 

  Designed coordinates  -המחושבת לרשימת ה  ואורדינאטההקווסף  תתכברירת מחדל,  
ידי בחירת   או    Topography ->Coordinates)דפדוף בין הרשימות מתבצע, כאמור, על 

Design -> Coordinates   רשימה לאיזו  לתוכנה  להגדיר  ניתן  הראשי(.  התפריט  בסרגל 
 תבצע את חישוביה. לעשות כן, בצע את הפעולות הבאות:

התפ הפעל:  מסרגל  הראשי  יפתח  Geometry -> Geometry parametersריט  מימין   .
 חלון. 

 Designedלחישוב הנתונים לטבלה הקיימת או    Topo points onlyבחלון שנפתח בחר  
points only.לחישובם לטבלה המתוכננת , 

 לאישור.  OKלחץ 
יש לבצע את סדר הפ  זו לכל הפרויקטים של התוכנה,  עולות הנ"ל  )על מנת לקבוע הגדרה 

 "(. Noname -ו Prototype. על כך ראה בהרחבה בפרק "הפרויקטים Prototypeבפרויקט 
                   

 -חישוב רצף נקודות -לאורך הציר או בניצב לו קואורדינטותחישובי  .1
 -נך נמצא ביה  Geom  -ל  Coordוודא שבאפשרויות הבחירה המופיעות בחלון בין   

Coord. 
את המרחק הרץ של הנקודה הראשונה שברצונך לחשב ולחץ   , הכנסFromבשדה   

Enter 0. לתחילת הציר הכנס. 
ולחץ Toבשדה    לחשב  שברצונך  האחרונה  הנקודה  של  הרץ  המרחק  את  הכנס   ,

Enter . 
. על מנת Roads lengthהתוכנה חישבה את אורך הציר והציגה אותו ליד השדה   

ל האורך  את  הכנס  הציר  כל  לאורך  נקודות  הלחשב  בשדה  לחץ  To  -יד   .Enter  
 להמשך. 

 הקלד הרץ בין הנקודות שהתוכנה תחשב. Stepsבשדה  
, הכנס את היסט הנקודות המחושבות מהציר )בניצב לו(. לחישוב Offset  -בשדה ה 

או השאר את השדה ריק. לחישוב נקודה משמאל לציר הזן   0נקודות הציר עצמו הזן  
 להמשך. Enterמרחק שלילי ולימינו מרחק חיובי. לחץ  

 
היסטים   מספר  להכנסת  אחת.  בפעולה  שונים  בהיסטים  נקודות  מספר  לחשב  באפשרותך 
בכביש  החתכים  נקודות  את  לחשב  ברצוננו  אם  לדוגמא,  להיסט.  היסט  בין  ברווח  הפרד 

אנו   חתך  כ  מעונייניםכשלכל  של  בהיסט  ומימין  משמאל  ובנקודות  עצמו,  הציר    5  -בנקודת 
 ".  5 0 5-את הנתון "  Offsetה מטרים, אזי נזין לשד

ה  התוכנה New point  -בשדה  שתיווצר.  הראשונה  הנקודה  מספר  את  הכנס   ,
 תמספר את הנקודות ממספר זה והלאה.

כאשר עובדים עם רצף של נקודות )להבדיל מחישוב נקודה בודדה(, על שם הנקודה המוזן  
וזאת בכדי שהתוכנה תוכל למספר  New pointבשדה   הנקודות בסדר עולה.   להיות מספר 

שדה   קיים  כך  לשם  כלשהו.  מאפיין  תחילי  שם  לנקודות  לתת  וברצוננו  אם  Prefixיתכן   .
 . CLאת הנתון:  Prefix -ברצוננו, לדוגמא, לחשב את נקודות הציר עצמו, נכניס בשדה ה
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לרשימת Applyאו    Enterלחץ    אותן  ותוסיף  הנקודות  את  תחשב  התוכנה   .
הוכנס  שבחלון    קואורדינטותה אם  עם    Prefixהתחתון.  יהיו  הנקודות  שמות  אזי 

לחץ  החישוב  סיום  לאחר  המתאימה.  כפתור    התחילית  את   על  לקבל  מנת  על 
 הנקודות על גבי השרטוט. 

 
שס מאגר  ילאחר  מופיע  התחתונה  וברשימה  החישובים,  נוכל    קואורדינטות הימת  הרצוי, 

בקובץ   הרשימה  את  )הרחב  Asciiלשמור  להדפיסה  שמירת  או  על  בקובץ   קואורדינטותה 
Text    מאגר" בפרק  ראה  הדפסתן  לרשימה    -קואורדינטותהאו  הקשורים  פעולה  כפתורי 

 ומשפיעים עליה"(. 
המרחקים   הדפסת  כולל  שחושבו,  הנקודות  של  מסודרת  רשימה  ולהדפיס  לקבל  מנת  על 

יופיע דו"ח מפ הרצים וההיסטים לחץ על כפתור הד ורט אשר ניתן  ו"ח שבחלון מימין. לפניך 
 ( ע"י כפתור המדפסת בתחתית החלון.Excellלהדפיסו )או לשלחו ל

 
הציר  קואורדינטותחישובי   .2 לאורך  הדיקור  נקודות  חישוב   -של  מאפשרת  זו  אופציה 

שימוש   קואורדינטות ומימינו.  משמאלו  הציר,  לאורך  החתכים  של  הדיקור  נקודות  של 
מ רוחב  חתכי  הגדרת  כמובן  מחייב  זו,  הציר.  בפעולה  של  האופקי  התוואי  הגדרת  לבד 

 לביצוע בצע הפעולות הבאות:

 . לפניך יפתח חלון.   לחץ על כפתור חישוב נקודות הדיקור שבחלון הימני   
 בחלון שיפתח, קיימות האפשרויות הבאות: 

הדיקור .1 נקודות  את  לחשב  ברצונך  שלו  במצב  מחדל    -בחירה  כברירת 
. אם ברצונך  Designed G.L  -מחשבת התוכנה את הדיקורים לנקודות ה
( המבנה  פני  לשכבת  הדיקורים  החץ  Structureלחשב  בעזרת  העבר   ,)

מ הבחירה  שבתיבת  )דוגמא    Structure–ל     Designed G.L  -הקטן 
יכול להיות במצב    Structure  -למקרה שבו ברצונך לחשב נקודות דיקור ה

ה גובה  את  הכנסת  בתכנון  גובה    Structure  -שבו  ללא  עבודות  בלבד, 
 העפר(.

ברצוננו   .2 אם  ומימין.  משמאל  הדיקור  לנקודות  ביטחון"  "מרחק  הכנסת 
שהתוכנה תחשב את נקודות הדיקור בהיסט מסוים ממקומן האמיתי, נכניס 

לשדה   המתאימים:  בשדות  זה  לדיקור    Leftמרחק  המרחק  את  נכניס 
את המרחק לדיקור ימין. המרחק שיחושב יהיה תמיד    Rightשמאל, ולשדה  

 "(. -מהציר החוצה )המרחקים תמיד יוכנסו כערך אבסולוטי ללא סימן " 
. אם ברצונך שלשמות הנקודות שייווצרו( לנקודות  Prefixהכנסת תחילית ) .3

, יתווסף טקסט כלשהו בהתחלה )נניח שם הכביש אלו הן שייכות(, שייווצרו 
 שמופיע.  Prefix  -הכנס טקסט זה בשדה ה

 
לביצוע החישוב. התוכנה תחשב את הנקודות   Apply, לחץ  לאחר שהגדרת את הרצוי בחלון

ה   ברשימת  יתווספו  והן  להגדרות  שמות   Designed coordinatesבהתאם  שבתחתית. 
נה ילציון שהנקודה ה  Rאו    Lהנקודות יבחרו בהתאם לשם החתך שלו הן שייכות בתוספת  

ופיע בתחילת שמות (, היא תPrefixמשמאל או מימין לחתך. בנוסף, אם הוכנסה תחילית )

 .  ן  בדו"ח המחושב לחץ על כפתור הדו"ח שבחלון מימי לצפייהכל הנקודות. 
 
 
על מנת לקבל את רשימת הנתונים הגיאומטריים   -חישוב הנתונים הגיאומטריים של הציר .3

(, ולחץ על Coord -ל Geom)באפשרויות הבחירה המופיעות בין   Geomבחר ב 
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  לפניך יופיע הנתונים הגיאומטריים של הציר ובהם ח שיפתח " . בדוח  " כפתור הדו
ונתוני הקשתות. להדפסת הנתונים לחץ כל כפתור  IP -של ה קואורדינטותהנתוני 

 ח." המדפסת שבתחתית חלון הדו
ח הנתונים הגיאומטריים ניתן למקם על גבי השרטוט. על מנת לעשות כן,  " את דו

 הפעולות הבאות:ח כפי שזה עתה הוסבר ובצע " חשב תחילה את הדו

 .  ח על גבי השרטוט" לחץ על כפתור מיקום הדו 
 עבור לאזור השרטוט ומקם את הטבלה במקום הרצוי: 

גרסת .1 ה  AutoCAD/ZWCAD  -למשתמשי  של  הפקודות    -בשורת 
AutoCAD/ZWCAD " הכיתוב  מופיע   ,Locate table: Pick 

Location/Set/(Esc)nd:  שתופי ברצונך  בו  במקום  הסמן  את  מקם  ע ". 
יופיע   ו הטבלה. לחץ עם העכבר לקבלת גבולות המסגרת של הטבלה. הגבולות 

מחק לאחר שתסיים למקם את הטבלה. באפשרותך לבחון תיבשכבה זמנית, ש
מספר אופציות למיקום הטבלה, זאת אומרת לקבל את המסגרת מספר פעמים  
לחץ   הסופי,  במיקום  שבחרת  לאחר  הסופי.  למיקום  שתגיע  עד  מוגבל,   Sלא 

מחקו, והטבלה י. הגבולות הזמניים יEnter  -, וAutoCAD/ZWCAD  -בשורת ה
 תמוקם על פי בחירתך האחרונה.

   Options  - גודל הכתב של הטבלה ניתן לשינוי. על מנת לשנותו לחץ על כפתור ה
, בחר את Coordinates computationsשבחלון הימני. בחלון שנפתח, תחת הכיתוב: 

. לשינוי  OK. לאחר הבחירה לחץ  Scaleבעזרת החץ הקטן שליד השדה  גדול הטקסט הרצוי
 הטבלה על גבי השרטוט יהיה עליך לחזור ולמקמה כפי המתואר למעלה. 

  קואורדינטותלמעלה, מופיעות דרכים שונות לחישובי  1-3בסעיפים  -חות חישובים" קבלת דו
ח מסודר.  " בוצעו בדולאורך הציר. לכל חישוב שכזה ניתן לקבל את טבלת החישובים ש

(, ולחץ על כפתור  Coord -ל Geomבאפשרויות הבחירה )בין  Coordח בחר " לקבלת הדו

 ח החישובים יתקבל לפניך." . דוח " הדו
 

 שינוי התוואי האופקי 
 

הציר.   של  האופקי  התוואי  להגדרת  שונות  דרכים  ראינו  האופקי"  התוואי  "הגדרת  בפרק 
הסתמך על התוואי הנ"ל, ניתן לבסס חתך אורך וחתכי  במהלך שאר הפרקים ראינו כיצד, ב

רוחב של הכביש המתוכנן. במהלך ההסבר, דנו אף במקרה שבו רוצים לשנות את מיקומה 
מסוימת. בפרק זה נרחיב את הדיון בנושא שינוי התוואי האופקי של הציר וההשפעות    IPשל  
 שלו.
 

צע על מנת לשנות תוואי אופקי של נפרט אם כן, על בסיס דוגמא, את סדר הפעולות שיש לב
 ציר, ומהן ההשלכות של שינוי תוואי זה: 

 Horizontalהגדרת תוואי אופקי של ציר מתבצעת, כאמור, בחלון  -שינוי התוואי .1
alignment תוכנת .CivilCAD 10 קושרת את רשימת ה- IP   בטבלה הימנית שבחלון

Horizontal alignment לרשימת ה- IP  בחלון התחתון   רדינטותקואוה שברשימת
(Designed coordinates על ידי שמן של הנקודות. במקרה ובו נשנה )קואורדינאטה 

, ישתנה גם תוואי  OK -ו Apply, ונלחץ  Designed coordinates -ברשימת ה IPשל 
 Designed -הציר שלנו. אם נשנה את שמה של נקודה מסוימת ברשימת ה

coordinates תאבד תוכנת ,CivilCAD 10   את הקשר לנקודה, ואז שינוי
של אותה נקודה לא ישפיע על התוואי האופקי. ראינו כי קיימות מספר  קואורדינטותה
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שיטות להגדרת התוואי האופקי. נעבור ונראה כיצד ניתן לשנות את התוואי בשיטות 
 השונות:

a. ב בחירת    -Select  -שימוש  רשימת    Polylineבכל  התוכנה  פי    IPיוצרת  על 
, אנו נזיז תחילה את תוואי ציר הבסיס Select  -ומו. לשינוי התוואי בשימוש במיק

לראשונה   עשינו  הSelect)הציר שעליו  ידי  AutoCAD/ZWCAD  -( בעזרת  על   ,
, Select. נוכל לראות כי בכל בחירת  Selectוכדומה, ונבחר שוב    Stretchפעולות  

הקודמת, ומוסיפה את חדשה, בשמות שונים לרשימה    IPיוצרת התוכנה רשימת  
ה לרשימת  למנוע Designed coordinates  -הנקודות  מנת  על  זה,  בשלב   .

ה  רשימת  מתוך  הקודמת  הנקודות  רשימת  את  פיזי  באופן  למחוק  נוכל   -בלבול, 
Designed coordinates    למחיקת נקודות(IP   שלא בשימוש ראה הסבר בפרק

  (.IP-מספור שמות ה -זה בסעיף הגדרת התוואי האופקי 
b. ב ידנית  Pick  ,Locate  -שימוש  נקודות  בהזנת  את   -או  יצרנו  שבו  מקרה  בכל 

, אנו נזיז את מיקומה Select  -התוואי האופקי של הציר, ללא שימוש בפקודת ה
 -הנקודה ברשימת ה  קואורדינאטתאו של כל התוואי על ידי שנוי פיזי של    IPשל  

Designed coordinates  של נקודה, בצורה   אורדינאטהקו. שיטה נוספת לשינוי
כפי המוסבר בסעיף הגדרת התוואי   Move  -גרפית, ניתן לבצע על ידי אופציית ה

 האופקי. 
 

נוי התוואי האופקי, על מנת  ילאחר ש   -השפעת שינוי התוואי האופקי על חתך האורך  .2
. החתך שיופיע בחלון  Vertical Alignment  -לקבל את חתך הקרקע החדש, הכנס ל

באופן אוטומטי. התוכנה תבצע דגימה מחודשת של פני הקרקע בהתאם לתוואי יתעדכן  
היה  אורכו של חתך האורך. אם  ישנה את  ושינוי התוואי האופקי  יתכן  החדש. הערה: 
קיים כבר תכנון חתך לאורך, הוא יופיע באופן מיידי על פני הקרקע החדשים. אם זאת, 

אים לאורך החתך הקיים, ופה יהיה עליך  יתכן מצב שבו אורכו של החתך המתוכנן לא ית
 לבצע את השינויים כנדרש.

 
הרוחב .3 חתכי  על  האופקי  התוואי  שינוי  סביר    -השפעת  האופקי,  התוואי  שינוי  לאחר 

ה לחלון  כניסתך  עם  הציר.  של  אורכו  שישתנה  )חתכי    Cross sections  -להניח 
. במקרה ובו  Roads length  -הרוחב( תחשב התוכנה את אורך הציר החדש ותציגו ב

היו קיימים )לפני שינוי התוואי האופקי( חתכי רוחב לאורך כל הציר, לאחר שינוי אורך  
הציר, לא יהיו קיימים כאלה עתה. נפריד בין שני מקרים: אורך הציר קטן ביחס לאורכו  
שתי   פי  על  הרוחב  בחתכי  הנדרש,  השינוי  את  נסביר  גדל.  הציר  אורך  או  הקודם 

 דוגמאות:
מ',   215.32  -נניח ולפני השינוי היה אורך הציר שלנו כ  -: אורך הציר קטן א'  דוגמא 

מ'. שני החתכים האחרונים בציר היו אם כן    20ונניח כי חילקנו הציר לחתכי רוחב כל  
מ'. עכשיו נניח ולאחר השינוי השתנה אורכו של    215.32  -מ' ו  200במרחק רץ של  

יופיע ב  187.32  -הציר ל , בעוד ברשימת החתכים Roads length  -מ'. מרחק זה 
יופיע החתכים הקודמים, דהיינו כולל שני החתכים הנ"ל. אנו נתאים בין האורך לבין 

מרשימת   215.32  -ו  200רשימת החתכים בצורה הבאה: מחק את החתכים במרחק  
במרחק   יהיה  האחרון  עתה החתך  רשימת החתכים    180החתכים.  לסוף  עבור  מ'. 

 . 187.32רץ  והוסף חתך במרחק
, ונניח כי הוא 215.32נניח ולפני השינוי היה אורך הציר    -: אורך הציר גדל דוגמא ב' 

 נמחק מ'. אנו    240.56  -מ' לחתכי רוחב. עתה, נניח ואורך הציר גדל ל  20מחולק כל  
חתך   החתכים:    215.32את  את  לרשימה  ונוסיף  החתכים,    -ו  240,  220מרשימת 
 מ'.  240.56
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שהתאמנו   הקיימת.  לאחר  הקרקע  נתוני  את  שוב  נקרא  החדש,  הציר  לאורך  החתכים  את 

נעשה זאת לכל החתכים, הן לחדשים והן לקודמים )שכן הם שינו מיקומם(. לחץ על כפתור 

GetT all     ובחלון שנפתח לחץ  ,OK  נתוני המצב הקיים החדשים . התוכנה תקרא את 
ת )תוכל לעשות כן על ידי שימוש  לתוך החתכים. השלם את התכנון לחתכים החדשים שיצר

 כפי שהודגם בפרק תכנון חתכי הרוחב(. Paste -ו Copy -ב
 

והמצבים   הדיקורים  את  מחדש  התוכנה  תחשב  הקיים,  המצב  נתוני  דגימת  לאחר  הערה: 
זאת,   אם  הקיימת.  הקרקע  לשינוי שבפני  את החתכים  ותתאים  במקטעי החתכים,  השונים 

בתעלות צד, שבהן לא תבצע זאת התוכנה כראוי והשינוי לא   קיימים מקרים חריגים, במיוחד
לציין   חשוב  החתכים.  של  מחדש  אינטרפולציה  לבצע  עלינו  יהיה  כאלה,  במקרים  יורגש. 

האינטרפולצי ומעדכן  ה  שכפתור  עובר  ריקים,  ביניים  לחתכי  אינטרפולציה  ביצוע  מלבד   ,
 את כל חתכי הרוחב הקיימים.

 

 תכנון מלא שינוי תוואי הכביש לאחר 
 

מאפשרת שינוי של תוואי הציר בין אם בתחילתו, במהלכו או בסופו   CivilCAD 10 תוכנת

 תוך שמירת החתכים והמרחקים הרצים של קטעי הכביש אשר נותרו ללא שינוי.

בשם:    :הערה  לדוגמא  בפרויקט  להשתמש  ניתן  תרגול  Road-'Changing-לצורך 

Alignment' 

 
 הפרויקט נמצא במיקום ברירת המחדל:  Windows 7/8/10במערכת הפעלה 

C:\ProgramData\SivanDesign\CivilCAD\Samples\Changing-Road-
Alignment.prj\ 

 

 

 

 . ’Roads→Horizontal Alignment‘מהתפריט הראשי הפעל:  .13

שינוי הגיאומטריה ניתן לביצוע באמצעות הכלים לבניית גאומטריית הציר   :הערה 

 (. Roads→Horizontal Alignment Tools :)מתפריטCivilCAD של 

בחר באופציה:    Roads→Horizontal Alignment Tools :מתפריט .14

‘Line_Line_Curve’   

תתבקש לסמן את הקו הראשון. סמן  AutoCAD/ZWCADשל   ’Command‘בשורת  .15

 . קו הגיאומטריה החדש

תתבקש לסמן את הקו השני. סמן  AutoCAD/ZWCADשל   ’Command‘בשורת  .16

 להארכה. הקו
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תתבקש להזין עקום מעבר   AutoCAD/ZWCADשל   ’Command‘בשורת  .17

 . ’Enter‘)קלוטואידה( בכניסה. הזן את הנתון ולחץ 

תתבקש להזין רדיוס. הזן את הנתון  AutoCAD/ZWCADשל   ’Command‘בשורת  .18

 . ’Enter‘ולחץ 

תתבקש להזין עקום מעבר   AutoCAD/ZWCADשל   ’Command‘בשורת  .19

 . ’Enter‘ביציאה. הזן את הנתון ולחץ  )קלוטואידה(

 ור על פעולה זו לכל מקטע אם נדרש.חז .20

  לחץ על כפתור  ’Roads→Horizontal Alignments‘מתפריט:  .21

'Change Alignment'   התחל   –בפרויקט הדוגמא  נעזר)במידה והינך

 .משלב זה(

 Select corrected‘תופיע ההודעה:  AutoCAD/ZWCADשל   ’Command‘בשורת  .22

segment' . 

תזהה אוטומטית את מקטעי הכביש  CivilCAD 10סמן את הציר החדש. תוכנת  .23

 ותסמן אותם בחיצים צהובים.

לאישור שינוי   'OK'להמשך. בחלון הבא שייפתח, לחץ על כפתור  'Yes'לחץ על כפתור  .24

 הציר. 

 לבניית הציר ועדכונו בשרטוט.  'Apply'לחץ על כפתור  .25

על שמות החתכים והמרחקים הרצים עד לנקודת השינוי  שומרת   CivilCADתוכנת  .26

 הגיאומטרי והחל מהנקודה בה השינוי הסתיים ומייצרת חתכי ביניים לאורך הקטע החדש.

 המרחק בין חתכי הביניים יהיה ע"פ הגדרת המרחק בין חתכים.  :הערה 

 . ’Roads→Vertical Alignment‘מהתפריט הראשי הפעל:  .27

 . 'Apply'לחץ על כפתור  .28

שומרת על שמות החתכים והמרחקים הרצים עד לנקודת השינוי  CivilCAD  10וכנתת .29

 הגיאומטרי והחל מהנקודה בה השינוי הסתיים ומייצרת מקטע ביניים לאורך הקטע החדש.

למקטע שממנו  2Tבעמודת  -1מוסיפה באופן אוטומאטי  CivilCAD  10תוכנת :הערה 

 מתחיל השינוי הגיאומטרי של הציר.

 . 2Tמטבלת  -1הנתון  מחק את .30

ידנית בטבלת   .31 נתונים  בין הקטעים הקיימים או הזן  פוליליין המחבר   Designשרטט 

Centerline . 

 . 'Apply'הגדר רדיוסים במידת הצורך ולחץ על כפתור  .32
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 .’Roads→Cross Sections‘מהתפריט הראשי הפעל:  .33

תוספת האות הוסיפה את חתכי הביניים לרשימת חתכי הרוחב ב  CivilCAD 10תוכנת   .34

A . 

כפתור   .35 על  ולחץ  שהתווספו  בחתכים  הכביש  את  לבנייה     'Create Layout'תכנן 

 ועדכון של תנוחת הכביש.

רק לחתכים    'Extract'ניתן לבצע פעולת    -  'Extract'לכבישים אשר מתוכננים באמצעות    :הערה 

 שהתווספו.

 

 תכנון צמתים אוטומאטי 
 

והן  צמתי CivilCAD 10 ניתן לתכנן בתוכנת ולהציגם הן בחתכי הרוחב  ם באופן אוטומאטי 

 תנועה.-בתנוחת הכביש, כולל איי

 בשלב זה, התכנון הינו אוטומאטי בלבד.  :הערה 

 : לביצוע הפעולה

הפעל:   .1 הראשי  תפריט  'Roads→Vertical Alignment'מהתפריט   .'Vertical 

Alignment'   .ייפתח מימין 

 שימת הכבישים.בחר את הכביש אשר ישמש ככביש העיקרי מר .2

 .'Apply'הגדר את גבהי הציר במפגש הצירים )צומת( ולחץ על כפתור  .3

 . 'Update All'בחלון שנפתח, לחץ על כפתור  .4

 . 'Roads→Horizontal Alignment'מהתפריט הראשי הפעל:  .5

 ייפתח.   'Layout & Contours'. חלון 'Apply'לחץ על כפתור  .6

 . 'OK'חץ על כפתור ול  'Create Junctions'באפשרות  'V'סמן  .7

הכבישים,   :הערה  תנוחת  את  ותעדכן  אוטומאטי  באופן  צמתים  או  צומת  תבנה  התוכנה 

 כולל קווי הגובה בכל צומת ואת חתכי הרוחב של הכבישים.

 Junctions' . תפריט’Junctions→Junctions Definition‘מהתפריט הראשי הפעל:   .8

Definition'   .ייפתח בצד ימין 

ת את המרחק הרץ של תחילת הצומת והמרחק הרץ של סוף הצומת ע"ג  ניתן לשנו:  הערה 

 ציר הכביש שנבחר כציר הראשי. 

 לביצוע הפעולה: 
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ואת המרחק   '.Start St'  –הזן את המרחק הרץ של תחילת הצומת ב    'Range'תחת   .9

ב   הצומת  סוף  של  כפתור    '.End St'  –הרץ  על  לחץ  הציר   'Pick'או  גבי  על  וסמן 

 חק הרץ של תחילתו וסופו של הצומת.בתנוחה את המר

 .'OK'בסיום, לחץ על כפתור  .10

 . 'Roads→Horizontal Alignment'מהתפריט הראשי הפעל:  .11

 . 'OK'לחץ על כפתור  'Layout & Contours'ובחלון   'Apply'לחץ על כפתור  .12

Junctions 

 תנועה: -להגדרת איי

הפעל:   .1 הראשי  ת’Junctions→Junctions Islands‘מהתפריט   Junctions' פריט. 

Islands'   .ייפתח בצד ימין 

 התוכנה מזהה באופן אוטומאטי את כבישי הצומת.  :הערה 

כפתור   .2 על  אי  'New Island'לחץ  תיצור  התוכנה  ברשימת  -.   Junctions'תנועה 

Islands List' . 

התנועה להיות בנוי כ -התנועה מהשרטוט )על אי-ובחר את אי  'Select'לחץ על כפתור   .3

– Polyline .) 

ה    :הערה  מורכב  מהן  הנקודות  מס'  את  אוטומאטי  באופן  זיהתה  התוכנה  כי  לב    -שים 

Polyline התנועה.-של אי 

 לשמירת ההגדרות. 'OK'לחץ על כפתור  .4

 . 'Roads→Horizontal Alignment'מהתפריט הראשי הפעל:  .5

 . 'OK'לחץ על כפתור  'Layout & Contours'ובחלון   'Apply'לחץ על כפתור 
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 בדיקת מעטפת ראות 
 

 ייפתח מימין.  'Visibility'. תפריט ’Roads→Visibility‘מהתפריט הראשי הפעל:  .1

 

 

 

 

 .   'Report', לחץ על כפתור ’Roads→Visibility‘להפקת דו"ח, מתפריט  .2

 .  'DXF', לחץ על כפתור ’Roads→Visibility‘, מתפריט DXF –לייצוא החתכים ל  .3

 ע"פ נתוני אורך הכביש. הגדר מקטע לייצוא או השאר .4

 . 'OK'הגדר מרחק בין חתכים ולחץ על כפתור  .5

 במקום הרצוי.   DXF –שמור את קובץ ה  .6

 

 הגדרת מרחק מהציר 

 הגדרת גובה עין נהג 

 הגדרת כיוון נסיעה נהג 

 הגדרת גובה מדרכה

 רת השהייה )שניות( הגד

 רשימת חתכי הרוחב 

 שם הכביש 
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 תכנון מגרשים בין כבישים עם שיפוע "הפוך" 
 

בתוכנת לתכנן  שיפוע   CivilCAD ניתן  כלומר  "הפוך",  שיפוע  עם  כבישים  בין  מגרשים 

לות בנפחי עבודות העבר בין הכבישים  פנימה, אל תחום המגרש וזאת על מנת למנוע כפי

 למגרשים הנ"ל. 

 

 לביצוע הפעולה: 

 

הפעל:   .1 הראשי  תפריט  ’Roads→Roads Lots‘מהתפריט   .'Roads Lots'    ייפתח

 מימין. 

כפתור   .2 על  תפריט    'Filter Roads Lots from Drawing'לחץ   .'Roads Lots'  

 .'Filtering'ישתנה לתפריט 

 . 'Enter' –ן את אחד המגרשים בשרטוט והקש על מקש ה , סמ'Select'לחץ על כפתור  .3

 . תתקבל הודעה על מס' המגרשים שנמצאו ע"י התוכנה.'Apply'לחץ על כפתור  .4

כפתור   .5 על  לתפריט  'OK'לחץ  בחזרה  ישתנה  התפריט   .'Roads Lots'   רשימת עם 

 המגרשים שנמצאו.

חלוק  'Steps (m)'באפשרות   .6 עבור  במטרים  הרצוי  המרחק  את  רדיוסים  הקלד  ת 

 למקטעים.

 'Apply'לחץ על כפתור  .7

 . 'Roads→Horizontal Alignment'מהתפריט הראשי הפעל:  .8

 . 'OK'ולאחר מכן על כפתור   'Apply'לחץ על כפתור  .9

 התוכנה תבנה את המגרשים בין הכבישים.  .10

 .'Roads→Cross Sections'מהתפריט הראשי הפעל:  .11

 התוכנה תציג את המגרשים בחתכים.  .12
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 גשרים   תכנון
 

בתוכנת לתכנן  תוך  CivilCAD ניתן  הרוחב  בחתכי  והן  האורך  בחתך  הן  ולהציגם  גשרים 

 ביטול דיקור הכביש אל הקרקע באזור הגשר.

בשלב זה, חישוב עבודות העפר בכבישים אינו מתייחס לביטול דיקור הכביש לקרקע   :הערה 

 בתחום הגשר.

 לביצוע הפעולה, לאחר תכנון כביש מלא:

הפעל:  מהתפריט   .13 תפריט’Roads→Bridges/Tunnels‘הראשי   . 'Bridges/Tunnels'  

 ייפתח בצד ימין 

הקלק פעמיים ובחר באופציה    'Type'. בעמודת  'Bridge Name'הגדר שם לגשר תחת   .14

'Bridge'  . 

וסמן בעזרת העכבר את נקודת ההתחלה והסיום של הגשר על   'Pick 'לחץ על כפתור   .15

יד  From'( בעמודות  Rangeנית את המרחק הרץ )תחת  גבי הציר בתנוחה או הקלד 

station / To station' . 

 . 'Left / Right'( בעמודות Offsetהגדר את רוחב הגשר מכל צד של הציר )תחת  .16

 לשמירת הנתונים. 'Apply'לחץ על כפתור  .17

 לעדכון תנוחת הכביש.   'Create Layout'לחץ על כפתור  .18

מתפריט   .19 גשר,  כפתור    ’Roads→Bridges/Tunnels‘למחיקת  על   Erase'לחץ 

Bridges/Tunnels'    ולאחר מכן לחץ על כפתור'OK' . 

 

 תכנון מנהרות 
 

בתוכנת לתכנן  תוך   CivilCAD ניתן  הרוחב  בחתכי  והן  האורך  בחתך  הן  ולהציגן  מנהרות 

 ביטול דיקור הכביש אל הקרקע באזור המנהרה.

נו מתייחס לביטול דיקור הכביש לקרקע בשלב זה, חישוב עבודות העפר בכבישים אי  :הערה 

 בתחום המנהרה.

 לביצוע הפעולה, לאחר תכנון כביש מלא:

הפעל:   .20 הראשי  תפריט’Roads→Bridges/Tunnels‘מהתפריט   . 'Bridges/Tunnels'  

 ייפתח בצד ימין 

תחת   .21 למנהרה  שם  בעמודת  'Bridge Name'הגדר   .'Type'    ובחר פעמיים  הקלק 

 .  'Tunnel'באופציה 
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וסמן בעזרת העכבר את נקודת ההתחלה והסיום של  'Pick 'על כפתור  לחץ .22

(  Rangeהמנהרה על גבי הציר בתנוחה או הקלד ידנית את המרחק הרץ )תחת 

 . 'From station / To station'בעמודות 

 . 'Left / Right'( בעמודות Offsetהגדר את רוחב המנהרה מכל צד של הציר )תחת  .23

 לשמירת הנתונים. 'Apply'לחץ על כפתור  .24

 לעדכון תנוחת הכביש.   'Create Layout'לחץ על כפתור  .25

 Erase'פתור לחץ על כ ’Roads→Bridges/Tunnels‘למחיקת מנהרה, מתפריט  .26

Bridges/Tunnels'    ולאחר מכן לחץ על כפתור'OK'. 

 

 עבירי מים מתכנון 
 

של מעבירי מים, מידות   בתכנון מעבירי מים. ממשק זה מציע מיקום  ממשק זה נועד לסייע

 . לביצוע הפעולה: Box –של מעבירי המים המתאימים וצורתם כצינור או כ  

 . התפריט ייפתח מימין. ’Roads→Culverts‘מהתפריט הראשי הפעל:  .1
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 . 'Apply'לחץ על כפתור  .2

בתפריט זה תתקבל רשימת מעבירי מים מוצעת, מרחק רץ, שטח אגן היקוות המים   .3

אל מעביר המים, כמות המשקעים במ"מ בשעה לפי פרק זמן שממנו נאספים המים 

 וזאת, ע"פ סטטיסטיקות באלגוריתם מובנה.

 

 

שטח אגן ההיקוות, כולל הערוצים המתנקזים למעביר המים המוצע, יוצגו על גבי  .4

 שרטוט תנוחת הכביש.

 

: שטח האיגום וערוצי זרימת המים תלויים במדידה. ככל שהמדידה רחבה יותר הערה

 ויקת יותר, כך יתקבל שטח איגום, ערוצים ומיקום מעביר מים בצורה המדויקת ביותר.ומד
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 : הערות

, התוכנה תחשב את כמות  Runoff Coefficientsבמידה ומסומנת האפשרות  ▪

וזאת, ע"פ אלגוריתם   t(min)הגשם במ"מ לשעה לפי פרק זמן המצוין בעמודת 

  –אלגוריתם אינו מתאים למדינה מסוימת, יש לבטל את סימון ה מובנה. במידה וה

V  ולהזין נתונים ידנית בעמודתi(mm/hr)  ולהקישEnter .לאחר הזנת כל נתון 

באפשרות המתכנן לשנות מרחק רץ של מעבירי הימים, כמות המשקעים מתוך   ▪

שינוי  אגן ההיקוות אשר ינוקזו למעביר המים ואו תדירות המשקעים בשנים. לאחר 

 Update'ולאחר מכן ללחוץ על כפתור   Applyהנתונים, יש ללחוץ על כפתור 

Culverts'  .לעדכון סוגי המעבירים ומידותיהם המוצעים ע"י התוכנה 

תדירות המשקעים  
מסמל   ' 10'בשנים. 

 את כמות השנים 

  –מקדם נגר עילי 
כמות המשקעים  

מתוך אגן ההיקוות  
שמנוקזים למעביר  

 המים

חישוב כמות הגשם  
במ"מ לשעה לפי  
פרק הזמן בדקות   
המצוין בעמודת  

t(min) 

מידות מוצעות של  
ם כצינור  מעביר/י מי

 Box -או כ 
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 תכנון קירות תומכים  :15פרק 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  234עמוד 

 תכנון קירות תומכים 
 

למשתמש אשר מאפשר    CivilCAD 10מודל תכנון קירות תומכים, הינו מודל ייחודי לתוכנת  
ובין אם אלו קירות שאינם  קירות אלו תומכים כביש  בין אם  קירות תומכים,  תכנון מלא של 
אינה   בתוכנה  התומכים  הקירות  תכנון  שאופציית  לציין  חשוב  מסוים.  כביש  לציר  קשורים 
התכנון,  בכל האספקטים האחרים של  מטפלת  אלא  הקיר  ומבנה של  חוזק  לחישובי  נוגעת 

 ה וכולי.החל מהתוואי, הפריס
 

 בפרק זה נדון בסדר הפעולות שיש לבצע על מנת לתכנן קיר תומך: 
 הגדרת רשימת קירות.  
 הגדרת תוואי הקיר.  
 הגדרת החתך האורכי של הציר )פריסת הקיר התומך(. 
 הגדרת מימדי הקיר על פי החתך )חתך הרוחב(. 
 . דו"חותהפקת  

 
בתוכ תומכים  בקירות  לטיפול  הקשורות  הפעולות  כל  שימוש  ככלל,  כדי  תוך  מתבצעות  נה, 

". עוד חשוב לציין כי אופציית תכנון קירות תומכים בתוכנה מתאפשרת רק Wallsבתפריט " 
( שרטוט  סביבת  עם  בסביבת  AutoCAD/ZWCADבעבודה  אפשרית  ואינה   ,)Stand-

Alone . 
 

 הגדרת רשימת קירות 
 

תוך כדי מתן שם לקיר,    נגדיר באופן כללי את הקיר,  אנו כשלב ראשון בתכנון הקיר/קירות,  
 והחלטה האם הינו קיר הקשור לאחד מכבישי הפרויקט או לא.

 
 תכנון קיר הקשור לכביש 

 
הפעל:  מחל .1 הראשי  התפריט  רשימת Walls → Walls listון  חלון  יפתח  מימין   .

 הקירות. 
ה .2 עמודת    שבחלון  Wall name  -הכנס את שם הקיר/קירות שברצונך לתכנן, תחת 

 . Format1-ובחר ב
אשר מימין לשם הקיר שהכנסת, בחר את הכביש שאותו   Attach road  -בשדה ה .3

 ך את הקרקע הצמודה לכביש הרצוי(. תומך הקיר )או תומ
מימין או   -ימין או שמאל )הכיוון  -והגדר את צד הקיר ביחס לכביש   Sideעבור לשדה   .4

 משמאל, נקבע על ידי כיוון התקדמות תוואי הכביש(.
 

  4עד    1יר מספר קירות בלתי מוגבל לפרויקט על ידי חזרה על שלבים  תוכל להמשיך ולהגד
 . Closeברשימת הקירות. לסיום לחץ 
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 הגדרת תוואי הקיר 
 

 לאחר הגדרת הקיר הרצוי ברשימת הקירות, ניגש לטפל בתוואי האופקי של הקיר:
 

  אחיד לכל אורכו.  Polyline  -(, הגדר את תוואי הקיר בZWCAD)או    AutoCAD  -ב .1
ה  Polyline  -ה את  לשרטט  רצוי  וקשתות.  ישרים  לכלול  בשכבה   Polyline  -יכול 

 חדשה, לפי בחירתך.  
יפתח חלון  Walls -> Horizontal alignmentמהתפריט הראשי, הפעל:   .2 מימין   .

 התוואי האופקי.  
 מרשימת הקירות שבראש החלון מימין, בחר את הקיר הרצוי.   .3
ב .4 ובחSelect  -בחר  לשרטוט  עבור  )ה,  הקיר  ציר  את  לחץ  Polyline  -ר   .)Enter  

 של הקיר, כולל הרדיוסים שלו.   IP -להמשך. בחלון מימין תופיע רשימת נקודות ה
 . בשרטוט יופיעו הנתונים הגיאומטריים של הציר.  Applyלחץ כפתור  .5
 

 
 הגדרת קיר תומך במקביל לכביש באופן אוטומטי:

לכל   לכביש  במקביל  תומך  קיר  להגדיר  את ניתן  לשרטוט  צורך  ללא  אוטומטי,  באופן  אורכו 
 תוואי הקיר. על מנת לעשות כן, בצע הפעולות הבאות:

 מרשימת הקירות שבראש החלון מימין, בחר את הקיר הרצוי.  .1

". בחלון שיפתח הכנס את .Create wall at offset from CL"     לחץ על כפתור .2
ולחץ   הכביש,  מציר  הקיר  קיOKהיסט  תיצור  התוכנה  בהיסט .  לכביש,  במקביל  ר 

 הרצוי. 
 על מנת לראות את תוואי הקיר שנוצר. Applyלחץ כפתור  .3

 
 

 פעולות נוספות בחלון הגדרת התוואי האופקי: 

Clear all Ips  - מחיקת כל ה-IP .מהרשימה 

Erase current IP  -  מחיקתIP .בודד מתוך הרשימה 

Walls options   -    נוספות נ  –אופציות  זה  המרחק  בחלון  את  להגדיר   מקסימאלייתן 
הכיתוב:   ליד  לכביש(  הוצמד  הקיר  )אם  בכביש  הרוחב  חתכי  אם  Wall rangeלעדכון   .

בין הקיר למרכז הכביש בחתך   נתוני    מסויםהמרחק  לא תציג את  זה, התוכנה  גדול מערך 
 הקיר באותו החתך.  

 

 הגדרת החתך האורכי של הציר )פריסת הקיר התומך(. 
 

 ר את החתך האורכי של הציר, נפעל לפי השלבים הבאים:על מנת להגדי
 
, התוכנה תציג את חלון תכנון  Walls -> Vertical alignmentמהתפריט הראשי הפעל   .1

חלון זה מציג בחלקו העליון את שרטוט החתך, בחלקו התחתון מוצגות   החתך האורכי.
טבלאות   פריסת    –שתי  וטבלת  שמאל(  )מצד  הטופוגרפיה  נתוני  לאורך  טבלת  הקיר 

( נתוני הטופוגרפיה מכילה  Wall-dataהחתך  )ניתן להציג כל אחת   3(. טבלת  טבלאות 
 מהן ע"י בחירה מהרשימה הנפתחת שמעל הטבלה(: 

 Existing-  הקיימת. קרקע הטבלת נתוני 
 Design –  .)טבלת נתוני הקרקע המתוכננת )לדוגמא: גובה פיתוח מגרשים 
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 Road level  –    תומך והקיר  תכיל במידה  זו  טבלה  בפרויקט  כביש שקיים 
 את נתוני קצוות הכביש )גובה רום הקיר( הנתמך ע"י הקיר.

 
 מרשימת הקירות שבראש החלון מימין, בחר את הקיר הרצוי.   .2
תמלא את נתוני הטופוגרפיה באופן אוטומטי בטבלה שנמצאת    Applyלחיצה על כפתור   .3

נתוני הקרקע הקיימת ואת נתוני בחלקו התחתון השמאלי של המסך. התוכנה תמלא את  
 הכביש בקצוות שלו )אם הקיר תומך בכביש שקיים בפרויקט(. 

 על מנת להגדיר את פריסת הקיר ישנן שתי אופציות:  .4
 

 :   Wall data-אפשרות ראשונה: הקלדת נתוני הקיר בטבלת ה .1
 Station –  .מרחק רץ 
 Top Elev. –  .גובה הקצה העליון של הקיר 
 Base Elev. –  בסיס הקיר.  גובה 
 Drop in base  –    זו ירידה )מדרגה( מבסיס הקיר, אופציה  גובה להוספת 

 משמשת למיתון השיפוע במידה והוא גדול מדי. 
 

 :אפשרות שנייה: לפי קביעת הגדרות ראשוניות .2

כפתור   על  חלון    לחץ  יפתח   ,Walls – Init options  את מלא   .
 :הערכים הבאים למצב חפירה ולמצב מילוי

 
 Min height  –    בין הגבהים  הפרש  בהם  במקומות  תומך  קיר  תיצור  התוכנה 

 הקיים/קרקע מתוכננת לבין גובה הכביש גדול מהערך המוכנס. 
 Min dist –   בהתאם הקיר  בסיס  עומק  את  תקבע  התוכנה  זה  ערך  הכנסת  ע"י 

למרחק שלו מקצה הטופוגרפיה. ערך זה הוא המרחק האופקי בין בסיס הקיר לבין 
הקרקע לקצה   קצה  והמרחק  במידה  הקיר  בסיס  את  תעמיק  )התוכנה  הקיימת 

 הקרקע אינו מספיק רחב(. 
 Pop  –  המתוכננת הקרקע  מעל  הקיר  בליטת  גובה  את  מציין  זה  קיימת/או /ערך 

 מתכנון הכביש בהתאם לקרקע שאותה הקיר תומך.
 Base depth  –    ערך זה מציין את עומק בסיס הקיר התומך, ניתן לקבוע ערך זה

היא:   ע"י המחדל  ברירת  לדוגמא:  הקיר  מגובה  מושפעת  אשר  נוסחא    מתן 
H*0.15+0.4   

 
לאחר קביעת הגדרות ראשוניות יהיה ניתן להמשיך בשינוי הנתונים באופן ידני, ע"י הקלדת  

 ערכים בטבלה.
, התוכנה תציג את שרטוט הפריסה    Applyלאחר סיום מילוי הנתונים יש ללחוץ על כפתור  

חלון השרט תוכל ע"ג  והקיר תומך בכביש שקיים בפרויקט,  ואת טבלת הנתונים. במידה  וט 
להבחין שבטבלת הנתונים השורה התחתונה מכילה את שמות החתכים של הכביש הנתמך  

מול החתך    .Noמול הכיתוב   הוא המרחק שנמצא  מופיעים שמות אלו  )המרחק הרץ שבו 
ולא המרחק הרץ לחתך על הכביש(. במידה   והקיר מסתיים לפני חתך מסוים  בכביש עצמו 

." )לדוגמא אם 1בכביש, הכיתוב שיופיע במרחק זה יכיל את שם החתך הקודם עם תוספת " 
הוא   מולו  שהקיר  האחרון  החתך  הכיתוב    14שם  יופיע  )שאינן   (14.1,  חדות  תפניות   .

השינוי   זווית  ותוצג  החתך  שרטוט  ע"ג  בדגל  יסומנו  הקיר  האופקי של  בתוואי  של קשתות( 
 התפנית.

 
 פעולות נוספות בחלון זה:
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   + מתוכננת  קרקע   + נתוני הטופוגרפיה  כביש    הבאת  לחיצ  רום  על לאחר  ה 
שנמצאת  הטופוגרפיה  נתוני  טבלת  את  אוטומטי  באופן  תמלא  התוכנה  זה,  כפתור 
אשר  מסוים  לכביש  מחובר  הנוכחי  הקיר  )אם  המסך  של  השמאלי  התחתון  בחלקו 

ל ניתן  בפרויקט,  הנפתחת  קיים  ברשימה  מעבר  ע"י  הכביש  נתוני  את   Roadקבל 
level- אין צורך ללחוץ על כפתור זה אלא אם נמחקה אחת הטבלאות שאותה אנו .)

ונלחץ   זה  לחלון  הראשונה שנכנס  ימולאו   Applyרוצים למלא שוב, בפעם  הנתונים 
 אוטומטית.  

יפתח הגדר את לאחר לחיצה על כפתור זה, בחלון ש  -  DXFייצוא החתך לקובץ     
 ובחר את מיקום ושם הקובץ.  OKקנה המידה הרצוי. לחץ 

לאחר לחיצה על כפתור זה, בחר מהחלון שיפתח   -  מחיקת נתונים מהטבלאות   
 . OKאת שם הטבלה שאת נתוניה ברצונך למחוק ולחץ 

  Update design to cross sections land dev. –  הקיר    הכנסת גבהי 
הרוחב   לחתכי  קיים  התומך  לכביש  מוצמד  והקיר  )במידה  הכביש  (. בפרויקטשל 

ה לחלון  עבור  זה  כפתור  על  לחיצה  זה     Cross sections-לאחר  יציאה מחלון  ע"י 
התפריט:   מתוך  את  Roads->Cross sectionsוהפעלה  העבר  הטבלאות   אחת, 

.  תוכל להבחין שגבהי הקיר הוכנסו לטבלה Land development-בתחתית המסך ל
 כל חתך לאורך הכביש.זו ב

 Land development data     -    התכנון לתוך  וגבהים  מרחקים  דגימת 
ה  נתוני  טבלת  את  למלא  באפשרותך  המרחקים    Design-מהשרטוט.  דגימת  ע"י 

 מתוך השרטוט ע"י השלבים הבאים:
 לאחר לחיצה על כפתור זה יפתח חלון השרטוט ומעליו חלון קטן.  .1
בחלון הקטן עבור לשרטוט ולחץ    Pickץ על  לח  מסויםעל מנת לבחור מרחק   .2

  Stationליד שרטוט הקו באזור אשר ברצונך לדגום. התוכנה תמלא בשדה  
 את המרחק הרץ.

את   .3 ,הקלד  מרחק  באותו  גבהים  שני  או  אחד  גובה  להקליד  באפשרותך 
 . OKלפי הצורך ולחץ   Elevation1,2הגבהים הרצויים בשדות:  

 . Cancelיום לחץ חזור על הפעולה לפי הצורך ולס .4
, תוכל להבחין שהטבלה Design-בחלון הפריסה העבר בטבלה השמאלית ל .5

 מולאה לפי המרחקים והגבהים אשר נדגמו.
 על מנת לעדכן את השרטוט בנתונים אלו. Applyלחץ  .6

על מנת להציג את החתך בתחום מסוים הכנס את המרחק   –  תחום תצוגת החתך 
 .  Applyולחץ  Toהסופי ליד הכיתוב  ,והמרחק  Fromההתחלתי ליד הכיתוב
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 הגדרת מימדי הקיר על פי החתך )חתך הרוחב(.
 

לאחר הגדרת פריסת הקיר התומך, יש להגדיר את מימדי הקיר,ניתן להגדיר מספר 
מנת  על  מסוימים.  במקטעים  שונים  קירות  להגדיר  צורך  יש  אם  קירות  של  סוגים 

 ות:להגדיר את מימדי הקיר בצע את הפעולות הבא
 
הפעל:   .1 הראשי  התפריט  יWalls -> Dimensionsמתוך  הגדרת  י,  חלון  פתח 

 המימדים. 
 לון מימין, בחר את הקיר הרצוי. מרשימת הקירות שבראש הח .2
אם ברצונך להגדיר מספר מקטעים לאורך הקו )על מנת להגדיר סוג קיר שונה  .3

בחלקו   שנמצאת  בטבלה  מקטע  לכל  הרצים  המרחקים  את  הקלד  מקטע(,  לכל 
 Pickהימני העליון של המסך או לבחירת מרחק ע"ג התנוחה לחץ על הכיתוב  

להוסיף  שברצונך  המקטע  את  בשרטוט  הציר  ע"ג  וסמן  לטבלה  מתחת  שנמצא 
לטבלה. אם ברצונך להגדיר סוג של קיר אחד לכל אורך הציר השאר את הטבלה 

ופן  במצב ההתחלתי )אם לא הוגדר אחרת, בכניסה למסך זה התוכנה תמלא בא
 אוטומטי את הטבלה בשורה הראשונה בלבד(.

 
קיר  .4 ע"ג חלון השרטוט במבנה הסטנדרטי של  זה, תוכל להבחין  בכניסה למסך 

מצוינים  שהם  כפי  והשיפועים  המקטעים  סימני  מופיעים  זה  שרטוט  ע"ג  תומך, 
בחלקו הימני   Applyבטבלת הנתונים. הקלד את הערכים הרצויים בטבלה ולחץ  

חלון השרטוט יופיע מבנה הקיר כפי שהוגדר בטבלה. אם ברצונך של המסך. ע"ג  
להתבונן בשרטוט הקיר הטיפוסי )המוצג בהתחלה( תוכל לעשות כך ע"י לחיצה 

)לחיצה נוספת על כפתור זה תחזיר את השרטוט למימדי הקיר     על כפתור:
 כפי שהוכנסו לטבלה(. 

 
 הכנסת הערכים ע"י הגדרת נוסחאות: 

ניתן להק כן  חישוב המושפעת כמו  *פונקצית  או  ערכים אבסולוטיים  ליד בשדות 
מגובה הקיר )שמחושב ע"י התוכנה( ופונקציה לחישוב המושפעת **משדה אחר 

, כלומר: C   :B*2ובשדה      h/4+0.20ניתן להקליד:    Bבטבלה. לדוגמא בשדה  
שדה   הדוגמא,  ושדה    Bלפי  הקיר  מגובה  משדה    Cיושפע  ניתן  Bיושפע    .

 (.a,b,c,d,e)בתאים:   כל השדות ללא הגבלהלהשתמש ב
 

לשדה   פונקציה  הכנסת  כגון  נכונות  לא  פעולות  לבצע  לא  להיזהר  יש   *C 
. פעולות מסוג Cשתושפע משדה    Bוהכנסת פונקציה לשדה    Bשתושפע משדה  

 זה יגרמו לתוצאות לא רצויות.
 

החשבון,  **בעת הקלדת נוסחא מתמטית לא ניתן לבצע פעולות לפי סדר פעולות  
 הפעולות יבוצעו בפונקציה משמאל לימין לפי הסדר.

 
אם הגדרת מספר מקטעים שונים בטבלת המקטעים, בצע את הפעולה הנ"ל לכל  .5

כפי   הנתונים  בהכנסת  והמשך  בטבלה  הרצוי  המקטע  על  לחיצה  ע"י  מקטע 
 שהוסבר בסעיף הקודם.
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התומך. במידה   . תוכל לחזור לחתכי הרוחב ע"מ לצפות בקיר Closeבסיום לחץ   .6
חתכי   את  אוטומטי  באופן  תעדכן  התוכנה  בפרויקט,  שקיים  כביש  תומך  והקיר 

 הרוחב של הכביש שאותו תומך הקיר בהתאם להגדרות הקיר. 
 
(. על מנת שהקיר יוצג בחתך 10ניתן להציג את הקיר ב"חתך מהיר" )ראה פרק   .7

האופציה   כי  לוודא  יש  ב    ’Triangles‘מהיר  תנוחת בעת    ’V‘  –מסומנת  בניית 
 הכביש.

 
 פעולות נוספות בחלון זה:

 

, לאחר לחיצה על כפתור זה, בחלון שיפתח DXFייצוא שרטוט מימדי הקיר לקובץ    -    
 ובחר את מיקום ושם הקובץ.   OKהגדר את קנה המידה הרצוי, לחץ 

  - Zoom Extents.לחיצה על כפתור זה מציגה את השרטוט במלואו , 
 

 " שאינו קשור לכבישתכנון קיר "חופשי
 

הפעל:   .1 הראשי  התפריט  רשימת Walls → Walls listמחלון  חלון  יפתח  מימין   .
 הקירות. 

ה .2 עמודת    שבחלון  Wall name  -הכנס את שם הקיר/קירות שברצונך לתכנן, תחת 
 . Format2-ובחר ב

 הרצוי(. שיגדירו את תוואי הקיר. IP-, באפשרותך להזין תחילית לPrefix -בשדה ה .3
 הראשון שיגדיר את תוואי הקיר.  IP-הגדר את מספר ה .st turn num’1 שדהב .4

 
  4עד    1תוכל להמשיך ולהגדיר מספר קירות בלתי מוגבל לפרויקט על ידי חזרה על שלבים  

 . Closeברשימת הקירות. לסיום לחץ 
 

 הגדרת תוואי הקיר 
 

 הקיר: לאחר הגדרת הקיר הרצוי ברשימת הקירות, ניגש לטפל בתוואי האופקי של
 

אחיד לכל אורכו.    Polyline  -(, הגדר את תוואי הקיר בZWCAD)או    AutoCAD  -ב .1
ה  Polyline  -ה את  לשרטט  רצוי  וקשתות.  ישרים  לכלול  בשכבה   Polyline  -יכול 

 חדשה, לפי בחירתך.  
יפתח חלון  Walls -> Horizontal alignmentמהתפריט הראשי, הפעל:   .2 מימין   .

 התוואי האופקי.  
 הקירות שבראש החלון מימין, בחר את הקיר הרצוי.   מרשימת .3
ב .4 )הSelect  -בחר  הקיר  ציר  את  ובחר  לשרטוט  עבור   ,-  Polyline  לחץ  .)Enter  

 של הקיר, כולל הרדיוסים שלו.   IP -להמשך. בחלון מימין תופיע רשימת נקודות ה
 . בשרטוט יופיעו הנתונים הגיאומטריים של הציר.  Applyלחץ כפתור  .5
של  מהתפרי .6 הראשי  הפעל:  ZWCAD)או    AutoCADט   )Insert→Block יפתח  .

 . Insertחלון 
   ’USER_WDLEVEL‘בשם  Blockבחר  .7

 
 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  240עמוד 

 התיקייה נמצאת במיקום ברירת המחדל: Windows 7/8/10במערכת הפעלה 
C:\ProgramData\SivanDesign\CivilCAD\Road Blocks\ 

 
 שרטוט. הראשון של הקיר על גבי ה IP-ל Block-הצמד את ה .8
זן את הנתונים הרצויים  ה AutoCAD/ZWCAD -של Command Line –בשורת ה  .9

 לפי הדיאגראמה הבאה:
 

 
 

A. LEVEL 1 ( הנוכחי  IP -גובה עליון של הקיר ב ) 
B. DLEVEL 1 ( הנוכחי   IP -קרקע מתוכננת בגב הקיר ב ) 
C. LEVEL 2 ( הבא  IP -גובה עליון של הקיר ב ) 
D. DLEVEL 2 ( הבא  IP -ר בהקיקרקע מתוכננת בגב  ) 
E. DFLEVEL 1 ( הנוכחי   IP -קרקע מתוכננת לפני הקיר ב ) 
F. DFLEVEL 2 ( באה  IP -קרקע מתוכננת לפני הקיר ב ) 

 
. בשרטוט יופיעו הנתונים הגיאומטריים של הציר ע"פ ההגדרות Applyלחץ כפתור   .10

   .שהזנת
 של תוואי הקיר.  IPעבור כל  10 – 6חזור על שלבים   .11
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 דרת התוואי האופקי: פעולות נוספות בחלון הג

Clear all IPs  - מחיקת כל ה-IP .מהרשימה 
 

Erase current IP  -  מחיקתIP .בודד מתוך הרשימה 
 

  Walls options-  כי התוכנה תקבע את בחלון זה ניתן להגדיר  –אופציות נוספות
( בצורה  …WIP1,WIP2לדוגמא:  IP-)אות שתתווסף לפני ה של כל קיר IP-התחילית 

  .וטומאטיתא
 

 הגדרת החתך האורכי של הציר )פריסת הקיר התומך(. 
 

 על מנת להגדיר את החתך האורכי של הציר, נפעל לפי השלבים הבאים:
 
, התוכנה תציג את חלון תכנון  Walls -> Vertical alignmentמהתפריט הראשי הפעל  .1

תחתון מוצגות  חלון זה מציג בחלקו העליון את שרטוט החתך, בחלקו ה החתך האורכי.
טבלת נתוני הטופוגרפיה )מצד שמאל( וטבלת פריסת הקיר לאורך  –שתי טבלאות 

טבלאות )ניתן להציג כל אחת  3(. טבלת נתוני הטופוגרפיה מכילה Wall-dataהחתך )
 מהן ע"י בחירה מהרשימה הנפתחת שמעל הטבלה(: 

 Existing- קרקע הקיימת. טבלת נתוני ה 
 Front G.L. – לפני הקיר ע"פ מספור ההקרקע המתוכננת  טבלת נתוני-IP . 
 Back G.L. –  טבלת נתוני הקרקע המתוכננת בגב הקיר ע"פ מספור ה-IP . 

 
 מרשימת הקירות שבראש החלון מימין, בחר את הקיר הרצוי.   .2
תמלא את נתוני הטופוגרפיה באופן אוטומטי בטבלה שנמצאת    Applyלחיצה על כפתור  .3

המתוכננת לפני  מסך. התוכנה תמלא את נתוני הקרקע בחלקו התחתון השמאלי של ה
 . בקצוות שלו קירה ומאחורי

 על מנת להגדיר את פריסת הקיר ישנן שתי אופציות:  .4
 
 :   Wall data-אפשרות ראשונה: הקלדת נתוני הקיר בטבלת ה .3

 Station –  .מרחק רץ 
 Top Elev. –  .גובה הקצה העליון של הקיר 
 Base Elev. –   .גובה בסיס הקיר 

אחרת לא יופק דו"ח   ’Base Elevation‘חובה להגדיר נתונים בעמודת 
 כמויות(.

 Drop in base –   גובה להוספת ירידה )מדרגה( מבסיס הקיר, אופציה זו
 משמשת למיתון השיפוע במידה והוא גדול מדי. 

 
 :אפשרות שנייה: לפי קביעת הגדרות ראשוניות .4

. מלא את הערכים הבאים Walls – Init options, יפתח חלון לחץ על כפתור   
 :למצב חפירה ולמצב מילוי 

 Length- .)אורך הקיר במטרים )ימולא אוטומאטית בשדה זה 
 Dist – מגדיר את המרחק בין מקטע למקטע.  ערך זה 
 Delta Height – .ערך זה מגדיר את שינוי גובה ראש הקיר ממקטע למקטע 
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 Start Height – קיר בתחילת המקטע ערך זה מגדיר את גובה ראש ה
 הראשון.

 
 פעולות נוספות בחלון זה:

 

לפני הקיר + קרקע מתוכננת   הבאת נתוני הטופוגרפיה + קרקע מתוכננת  
לאחר לחיצה על כפתור זה, התוכנה תמלא באופן אוטומטי את  - מאחורי הקיר

   .טבלת נתוני הטופוגרפיה שנמצאת בחלקו התחתון השמאלי של המסך
ע"י מעבר ברשימה  קרקע המתוכננת לפני או מאחורי הקירתוני הניתן לקבל את נ

 . הטבלאותמאחת  עבור כל. לחץ על כפתור זה  .Front/Back G.L –ל הנפתחת 
 .לעדכון שרטוט החתך ע"פ הנתונים בטבלאות Applyלחץ 

  

, לאחר לחיצה על כפתור זה, בחלון שיפתח הגדר את DXFייצוא החתך לקובץ   
 ובחר את מיקום ושם הקובץ.  OK. לחץ קנה המידה הרצוי

, לאחר לחיצה על כפתור זה, בחר מהחלון שיפתח  מחיקת נתונים מהטבלאות  
 . OKאת שם הטבלה שאת נתוניה ברצונך למחוק ולחץ 

 Land development data  .דגימת מרחקים וגבהים לתוך התכנון מהשרטוט ,
ימת המרחקים מתוך השרטוט  ע"י דג Design-באפשרותך למלא את טבלת נתוני ה

 ע"י השלבים הבאים:
 לאחר לחיצה על כפתור זה יפתח חלון השרטוט ומעליו חלון קטן.  .7
בחלון הקטן עבור לשרטוט ולחץ   Pickלחץ על  על מנת לבחור מרחק מסוים .8

  Stationלדגום. התוכנה תמלא בשדה ליד שרטוט הקו באזור אשר ברצונך 
 את המרחק הרץ.

גובה אחד או שני גבהים באותו מרחק ,הקלד את באפשרותך להקליד  .9
 . OKלפי הצורך ולחץ   Elevation1,2הגבהים הרצויים בשדות:  

 . Cancelחזור על הפעולה לפי הצורך ולסיום לחץ  .10
, תוכל להבחין שהטבלה  Design-בחלון הפריסה העבר בטבלה השמאלית ל .11

 מולאה לפי המרחקים והגבהים אשר נדגמו.
 לעדכן את השרטוט בנתונים אלו.על מנת  Applyלחץ  .12

על מנת להציג את החתך בתחום מסוים הכנס את המרחק  – תחום תצוגת החתך 
 .  Applyולחץ  To,והמרחק הסופי ליד הכיתוב   Fromההתחלתי ליד הכיתוב

 

 הגדרת מימדי הקיר על פי החתך )חתך הרוחב(.
 

יתן להגדיר מספר  לאחר הגדרת פריסת הקיר התומך, יש להגדיר את מימדי הקיר,נ
סוגים של קירות אם יש צורך להגדיר קירות שונים במקטעים מסוימים. על מנת 

 להגדיר את מימדי הקיר בצע את הפעולות הבאות:
 
פתח חלון הגדרת  , יי Walls -> Dimensionsמתוך התפריט הראשי הפעל:  .8

 המימדים. 
 מרשימת הקירות שבראש החלון מימין, בחר את הקיר הרצוי.  .9

רצונך להגדיר מספר מקטעים לאורך הקו )על מנת להגדיר סוג קיר שונה  אם ב .10
לכל מקטע(, הקלד את המרחקים הרצים לכל מקטע בטבלה שנמצאת בחלקו 

  Pickהימני העליון של המסך או לבחירת מרחק ע"ג התנוחה לחץ על הכיתוב 
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שנמצא מתחת לטבלה וסמן ע"ג הציר בשרטוט את המקטע שברצונך להוסיף 
ה. אם ברצונך להגדיר סוג של קיר אחד לכל אורך הציר השאר את הטבלה לטבל

במצב ההתחלתי )אם לא הוגדר אחרת, בכניסה למסך זה התוכנה תמלא באופן 
 אוטומטי את הטבלה בשורה הראשונה בלבד(.

 
בכניסה למסך זה, תוכל להבחין ע"ג חלון השרטוט במבנה הסטנדרטי של קיר  .11

עים סימני המקטעים והשיפועים כפי שהם מצוינים  תומך, ע"ג שרטוט זה מופי 
בחלקו הימני  Applyבטבלת הנתונים. הקלד את הערכים הרצויים בטבלה ולחץ 

של המסך. ע"ג חלון השרטוט יופיע מבנה הקיר כפי שהוגדר בטבלה. אם ברצונך  
להתבונן בשרטוט הקיר הטיפוסי )המוצג בהתחלה( תוכל לעשות כך ע"י לחיצה 

)לחיצה נוספת על כפתור זה תחזיר את השרטוט למימדי הקיר      על כפתור:
 כפי שהוכנסו לטבלה(. 

 
 פעולות נוספות בחלון זה:

 

, לאחר לחיצה על כפתור זה, בחלון שיפתח DXFייצוא שרטוט מימדי הקיר לקובץ  - 
 ובחר את מיקום ושם הקובץ.   OKהגדר את קנה המידה הרצוי, לחץ 

 - Zoom Extentsצה על כפתור זה מציגה את השרטוט במלואו., לחי 
 
 

 דו"חות הפקת 
 

לאחר סיום ההגדרות של הקיר, ניתן להפיק דו"ח כמויות המציין את השטח והנפח של הקיר 
בכל חתך )הדו"ח יוצג לפי המרחקים הרצים שהוכנסו בתכנון החתך האורכי. על מנת להפיק 

 דו"ח כמויות בצע את הפעולות הבאות:
 

 , יפתח חלון בצד ימין.  Walls -> Quantitiesיט הפעל: מתוך התפר 
 מרשימת הקירות שבראש החלון מימין, בחר את הקיר הרצוי.  
 על מנת להציג את הדו"ח. Applyלחץ  
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 ותכנון כבישים עירוני Extract :16פרק 
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Extract  .ותכנון כבישים עירוני 
 

זו   אופציהון עירוני של כבישים.  אשר משמשת בעיקר לתכנ  Extractבאופצייתפרק זה ידון 
  CivilCAD 10. ע"י שימוש בכלי זה, תוכנת AutoCAD/ZWCADלמשתמשי רק אפשרית 

מאפשרת תכנון חתכי רוחב של כביש באופן אוטומטי ע"י מספר פעולות פשוטות. פעולה זו  
מתבססת על הגדרת חתך טיפוסי ודגימת מבנה בכביש מתוך התנוחה עצמה. בתכנון כביש 

יל ע"י הגדרת חתכי הרוחב ביצענו פעולה הפוכה, לאחר הגדרת חתכי הרוחב התוכנה רג
יצרה את התנוחה ע"ג השרטוט. אנו נעבור לאורך הפרק, ע"פ שלבים, על כל המרכיבים  

 הקשורים בתכנון כבישים עירוני:  
  

 הכנת הרקע לעבודה. 
 . בפרויקטוגיאומטריית הכביש הגדרת הצירים  
 . Extract -הטיפוסיים ושימוש בהגדרת חתכי הרוחב  
 . Typשמירת וקריאת חתכי רוחב טיפוסיים מקובץ  
 .Extractפרוט הפעולות בחלון  

 
בתהליך שהוסבר בפרק הקודם של תכנון כבישים, לאחר הגדרת הצירים האופקיים  

אלו נוצרה  רות הגדהוגדר חתך רוחב טיפוסי לחלקים שונים של הכביש, ומתוך  והאנכיים, 
 -תנוחה קיימת, אשר שורטטה בהיה תבפרק זה, נקודת המוצא של התכנון תנוחה. 

AutoCAD  או(ZWCAD  אנו נגדיר תוואי אופקי ואנכי לתכנון, נגדיר מספר חתכים .)
טיפוסיים בעלי מבנה כללי, ללא הגדרת אורך לכל מקטע ומקטע בחתכים, ונשליך חתכים אלו 

מלא, אשר יכלול גם את חתכי הרוחב  על התנוחה הקיימת. כתוצאה מכך נקבל תכנון 
 המותאמים.

 

 הכנת רקע לעבודה )הכנת המצב הקיים והמתוכנן(
 

המכיל   -AutoCAD/ZWCADניצור שרטוט ב  לפרויקטכשלב ראשון של הכנת הרקע  
 את שרטוט תנוחת הכביש 

קבצי  ע"י  להגדיר  גם  ניתן  הקיים  המצב  את  הקיים.  המצב  של  המדידה  ואת 
הוסבר בפרק תכנון כבישים(  ואין חובה להגדירו ע"ג השרטוט. )כפי ש  קואורדינטות

ניתן להתחיל   כן  ולאחר תחילת    פרויקטכמו   הפרויקט חדש ללא רקע מוכן מראש, 
את   הכביש.  מבנה  את  שמתארים  הקווים  את  לשרטט  או  יש הקווים  הלייבא  אלו 

יבות לכך. רצוי להגדיר שכבות חדשות )אין חש  המיועדותלשרטט בשכבות נפרדות  
לשמן( אשר יכילו אך ורק את הקווים המתארים את תנוחת הכביש. אנו נגדיר ע"ג 

( האופקי  הציר  קו  את  תנוחת Centerlineהשרטוט  את  המתארים  הקווים  ואת   )
 א:הכביש. ראה דוגמ
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 (, ותן שם לעבודה.File -> New projectחדש ) פרויקטפתח  .1
 בלבד:  AutoCAD/ZWCAD*למשתמשי גרסת  .2

 .File->Openהפעל -AutoCAD/ZWCAD תפריט המתוך  
 שישמש רקע לעבודה ופתח אותו. Dwg -בחלון הקבצים שיפתח בחר את קובץ ה 
. התוכנה תיצור העתק של קובץ File>-Saveהפעל  -CivilCAD 10מתוך תפריט  

המקורי שבחרת בספרית הפרויקט שלך )קובץ זה יקבל בהמשך שם כשם  Dwg -ה
 בתוספת התו '_'(. CivilCAD 10 -הפרויקט ב

  -הכוונה לאלו העובדים בשילוב בין ה -AutoCAD/ZWCADמשתמשי גרסת  
CivilCAD 10 ל- AutoCAD/ZWCAD  ולא בגרסתStand-alone . 

 
מדי. על בסיס מודל זה ימתבסס על מודל תלת מ CivilCAD 10עיקרון הפעולה של תוכנת 

י כמויות וכדומה. ע"מ ליצור את המודל מבצעת התוכנה את פעולותיה: הוצאת חתכים, חישוב
בפורמט טקסט  קואורדינטות. אם ברשותך קובץ קואורדינטותהנ"ל חייבת התוכנה קובץ  

((ASCII   מכאן מנקודה זוולא המשך במידה  , 15רגיל עבור לסעיף . 
 

. באם קובץ זה אינו קיים יכולה התוכנה לייצר  קואורדינטותכאמור, זקוקה התוכנה לקובץ 
 (, וזאת בתנאים מסוימים: Dwg -זה מתוך קובץ השרטוט )הקובץ 

 בלבד: AutoCAD/ZWCADלמשתמשי גרסת  .3
 . יפתח חלון מצד ימין. General -> Filteringהפעל  

( שכבה  Filteringנו של סינון )*ימהשרטוט ה קואורדינטותעקרון הפעולה של יצירת קובץ 
  האו קווי הגובה. אם כן, יהי(, בה נמצאים הנקודות AutoCAD/ZWCAD)שכבת שרטוט 

. לשכבה זו חייב להיות AutoCAD/ZWCAD -ב הרצויהעליך תחילה לאתר את השכבה 
 .(-AutocAD/ZWCADהגובה )ב -ממד ה

 
 Dwgטיפול בקבצי ראה פרק  Filtering*להסבר בהרחבה על 

 
 החלון הימני מחולק לשנים. בחלק העליון מופיע רשימת שכבות השרטוט ובחלק התחתון

 ( לבחירה.Entities) ישויות רשימת 
 סמן את השכבה הרצויה לסינון.  
 בחר את סוג הישות הרצוי לסינון. 
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נפרט כיצד ניתן לקבוע מהו סוג הישות הרצוי. נבדוק תחילה האם בשרטוט קיימת שכבת  
נקודות מדודות. אם שכבה זו אינה קיימת נסנן במקומה את שכבת קווי הגובה )בהנחה וזו 

לאחר שמצאנו את השכבה/שכבות שבהן יושבות הנקודות המדודות נבדוק את סוג  קיימת(.
( וזאת ע"י סינון השכבה בהם יושבים הבלוקים.  Blocksהישות. ככלל נעדיף לסנן בלוקים )

( בשרטוט, ואם הן עם  Points entitiesאם אין בשרטוט בלוקים, נחפש האם קיימות נקודות )
ן סינון. בעדיפות נמוכה מזאת נוכל גם לסנן את הטקסטים (, נבצע עליהZגובה )יש להן 

(Text entities  אך יש להביא בחשבון שיתכן ומיקום הטקסט שונה במקצת ממיקום ,)
 הנקודה המדודה עצמה.  

 
הגובה יש באפשרותך לקבוע את הגובה על פי   מצויןובטקסט  0אם גובה הטקסט הוא 

 הכיתוב בטקסט
 Dwg בפרק טיפול בקבצי  Optionsביעת גבהים בחלון הקראה  Optionsבע"י שימוש 

 
 
 
 

אם בקובץ אין כלל גבהים מדודים )נקודות מדודות(, נעבור לעדיפות נמוכה יותר והיא סינון  
, והאם יש להם גובה Polylinesאו  linesנם יקווי הגובה. לעשות כן נבדוק האם קווי הגובה ה

(Z.) 
תחל בסינון השכבה הנבחרת ע"פ סוג הישות  בחלון הימני. התוכנה Applyלחץ על  

המסוננות בחלון התחתון  קואורדינטותהשנבחרה. בסיום התהליך תופיע רשימת 
(Topography coordinates.) 

שמעל לשרטוט. התוכנה תיצור שכבת נקודות *חדשה ע"ג  לחץ על כפתור   
 השרטוט.

 
 *CivilCAD 10  תהיה בנוסף לשכבה שכבר  יוצרת שכבת נקודות חדשה משלה. שכבה זו

 קיימת. 
 
 בלבד:  AutoCAD/ZWCADלמשתמשי גרסת .4

-רציפות. לנושא קווי אי-יתכן מצב שבו בקובץ המדידה, בנוסף לנקודות, קיימים קווי אי
רציפות מוקדש חלק נרחב בתוך פרק קווי הגובה ועל כן לא נרחיב כאן את הדיון בנושא. אם ה

תי נפרד מקובץ המדידה ועליהם לעבור תהליך סינון  חלק בל םה ,אכן קיימים קווים כאלה
 רציפות בשרטוט, תוכל לדלג לסעיף הבא(.-נוסף )במידה ואינך יודע האם קיימים קווי אי

 
 Topography->Linesהפעל  

 .   Filter breaklines-לחץ על כפתור ה 
, עבור עם הסמן לשרטוט Selectלחץ על    Filter breaklinesבחלון  

או סמן את השכבה וסוג הקו   הקוויםמתוך השכבה של  ולחץ על קו
 ברשימות שבחלון.

תיצור את קווי   Yes. לפניך תופיע הודעה. לחיצה על Applyלחץ  
רציפות בלבד, ללא הוספת נקודות לרשימת הנקודות הקיימות.  ה-אי

רציפות, וכן תוסיף את נקודות  ה-, תיצור הן את קווי איNo -לחיצה על
 רציפות לרשימת הנקודות הקיימות. ה-ל קווי איש (Vertex) השבר
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ר לרשימה הקיימת שכן הערה: ברוב המקרים, אין צורך בהוספת נקודות השב 
נקודות אלו כבר קיימות שם. מכאן, שרק אם אתה יודע בפרוש כי ברצונך להוסיף 

 .Yes, ובכל מקרה אחר לחץ Noאת נקודות השבר לחץ 
רציפות והם יתווספו  ה-ל קווי אילאחר אישור ההודעה, יבוצע סינון ש 

 . לפרויקט
 

 Topography(, ורשימת הנקודות התחתונה )Filteringאם ביצעת את פעולת הסינון )
coordinates אם לא המשך מכאן:7( מלאה, דלג לסעיף . 

 
 של המצב הקיים:  קואורדינטותקליטת קובץ  .5

 בחלון התחתון, לחץ על הכפתור הצהוב של פתיחת קבצים   
 (Load from text file)  הרצוי.   קואורדינטותהובחר את קובץ

 לאחר בחירת הקובץ תופיע רשימת הנקודות בחלון התחתון. 

שמעל לשרטוט. התוכנה תיצור שכבת שרטוט  לחץ על כפתור   
 של נקודות קיימות מהרשימה.

 
 הקיים במערכת ומותקן עם התוכנה. לשם כך קואורדינטותלמימוש ההסבר נשתמש בקובץ 

 Samples, היושב בספריית  Sample7.Tco( את הקובץ 5פתח )על פי ההסבר בסעיף 
 

 הקובץ נמצא במיקום ברירת המחדל:  Windows 7/8/10במערכת הפעלה 
C:\ProgramData\SivanDesign\CivilCAD\Samples\Sample7\ 

  
 , ולא המשך מכאן:7רציפות דלג לסעיף -אם אין בידך קובץ קווי אי

 
 רציפות:-ץ קווי איקליטת קוב .6

 
. מימין  Topography ->Linesבסרגל התפריט הראשי הפעל:  

 יפתח חלון. 

. לפניך יפתח  בחלון מימין לחץ על הכפתור של פתיחת קבצים   
בלבד   Disחלון הקבצים כאשר הקבצים שתתבקש לבחור יהיו קבצי 

 (.Dis.* -של סוגי הקבצים יהיה ל Filter -)ה
טען, ורשימת קווי  יציפות שבידך. הקובץ י רה-בחר את קובץ קווי אי 

רציפות תופיע בחלון הימני. התוכנה תיצור שכבת שרטוט של ה-אי
 רציפות. ה-קווי אי

 
  רציפות. -קווי אי –יצירת קווי גובה אי רציפות ראה פרק -להרחבה בנושא קווי

 
 יצירת קווי גובה: .7

שיש  Dwgאם ברשותך קובץ  השלב האחרון בהכנת המצב הקיים הוא יצירת קווי הגובה. גם 
בו כבר קווי גובה, יהיה עליך לבצע שלב זה מכיוון שבשלב יצירת קווי הגובה, יוצרת התוכנה, 

מדי שעליו היא מתבססת. מודל זה אינו נראה למשתמש )למרות יגם את המודל התלת מ
 שניתן להציגו( אך חשוב להמשך העבודה בתוכנה.                            
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. Topography ->Contoursבסרגל התפריט הראשי הפעל:  
 מימין יפתח חלון. 

בחלון מימין הגדר את ההפרש האנכי בין קווי הגובה. לעשות כן מחק  
, והכנס את ההפרש  Intervalsשמימין למילה  Defaultאת המילה 

 (.1הרצוי במטרים )לדוגמא:  
ן מצב שבו . התוכנה תחל ביצירת קווי הגובה. יתכApplyלחץ  

תאתר התוכנה בקובץ הנקודות בעיה כלשהי אשר תמנע יצירת  
הקווים. אם הבעיה ניתנת לפתרון באופן פשוט יחסי, תתקבל הודעה 

)אשר ניתן   Logעל הבעיה/בעיות. פרוט הבעיות יופיע בקובץ 
פשוט(. מכיוון שאין ברצוננו להיכנס בפרטי יצירת   Editor -בלפתיחה 

שר את ההודעה על הבעיה, והתוכנה תמשיך קווי הגובה, אנו נא
 בפעולתה באופן רגיל. 

 
-נו פונקציה של מספר הנקודות בפרויקט ושל מספר קווי איי תהליך יצירת קווי הגובה ה

רציפות )אם יש כאלה(. יתכנו מקרים בהם תעבוד התוכנה זמן ממושך ועל כן יש להמתין ה
ופן תקין, תיצור התוכנה שכבות שרטוט בסבלנות עד סיום התהליך. אם התהליך יסתיים בא

מתאימות שבהן יופיעו קווי הגובה. אם לא מופיעות שכבות אלו, אזי קיימת בעיה שאינה ניתן 
ה עליך לעבד את קובץ הנקודות )על יצירת קווי הגובה ועיבודם  לפתרון באופן אוטומטי ויהי 

 ראה פרק נפרד(. 
 ל התלת ממדי:נראה כעת אמצעי לבדיקת תקינות והמצאות המוד

 
 
 איתור גובה קיים בנקודה כלשהי: .8

  Pick Height לחץ על כפתור  AutoCAD/ZWCAD -למשתמשי גרסת 
אשר נמצא בסרגל הכלים הראשי מעל לחלון השרטוט . עבור עם העכבר 
לשרטוט, והעמד את הסמן באזור קווי הגובה. לחץ לחיצה בעכבר. גובה 

וט בתחתית המסך, ליד הנקודה בה אתה נמצא יופיע מתחת לשרט
 . height_t,height_dהכיתובים 

נו המדד הנוח ביותר להמצאות ותקינות המודל  יכלי זה של איתור גובה, ה 
נו הגובה  יה height_d-נו גובה המצב הקיים, ויה  Height_tמדי. יהתלת מ

 וים. המתוכנן. בהעדר תכנון, יהיו שני גבהים אלו שו
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 בפרויקט יש וגיאומטריית הכבהגדרת הצירים 
 

לאחר שסיימנו להכין את הרקע לעבודה )המצב הקיים(, נתחיל בתכנון. נלמד בחלק זה של  
 את הצירים הרלוונטיים לפרויקט הנוכחי.  CivilCAD 10הפרק כיצד מארגנת תוכנת 

 
. מימין יפתח  Roads -> Roads listמסרגל התפריט הראשי הפעל:  

רויקט. בהעדר הגדרת צירים,  חלון. בחלון מופיע רשימת הצירים של הפ
 .  Road1באופן אוטומטי ציר בשם  CivilCAD 10פותחת תוכנת 

. לכל ציר  הצירים בפרויקט הנוכחי הקלד בטבלה מימין את רשימת 
בפרויקט יש לתת שם כלשהו. השם יכול להיות אלפא נומרי או מספר.  

חר ידך. לא-שמות הצירים אינם חשובים והם רק לצורך ארגון החומר על
 . Enterכל שם ציר הקלד 

 .OKבסיום הקלדת הרשימה לחץ  
 

 . Road1למימוש הדוגמה הכנס ציר בודד ותן לו את השם 
 

בראש כל חלון שיופיע בשלבי תכנון הכביש )הגדרת התוואי האופקי, תכנון חתך האורך, 
ל תמיד וכו'(, יופיע גם הכביש הנוכחי הנמצא בעבודה. אם קיימים מספר צירים בפרויקט, תוכ

 לדפדף בין הצירים בעזרת החץ הקטן שמופיע בצד שם הכביש לעבודה.
 

 –תכנון כבישים לאחר הגדרת שמות הצירים הגדר את התוואי האופקי כפי שהוסבר בפרק 
 הגדרת התוואי האופקי. 

 
לכל מקטע בתנוחה שכבה נפרדת    שייךעליך לכיוון שרוחב הכביש אינו אחיד, הערה: 

 .ואת רוחבתגדיר אשר 
 

הגדרת חתך  –תכנון כבישים לאחר מכן, הגדר את חתך האורך, שוב כפי שהוסבר בפרק 
 . האורך

 

 Extract-הגדרת חתכי הרוחב הטיפוסיים ושימוש ב
 

בסיום תהליך הגדרת התוואי האופקי וחתך האורך של הציר, )צירים( נעבור להגדרת חתכי  
 : Extract-הרוחב הטיפוסיים ושימוש ב

 
 <-Roadsהפעל  CivilCAD 10-מתוך התפריט ב  - -Extractכניסה למסך ה

Extract יפתח חלון בצד ימין המכיל את רשימת הצירים, רשימת המקטעים לכל ,
תך וכפתורי ההפעלה. בצדו השמאלי של החלון נמצא המסך המציג את הח ציר

( וגובה  Structureהטיפוסי ומתחתיו את הטבלאות של הגדרת גובה המבנה )
( של החתך הטיפוסי. שים לב שמבנה המסך  .Designed G.Lעפר ) עבודות

 (. Cross sectionדומה לחלון חתכי הרוחב הרגיל )
 

( Roadבחר מתוך הרשימה בחלקו העליון של המסך )ליד הכיתוב  -בחירת הציר
 את הציר לתכנון חתכי הרוחב.
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מקטע  לכלשכבה  שייךל עליך  -בחירת שכבות השרטוט המייצגות את התנוחה
הפעולה, הקלק פעמיים על עמודת   לביצוע (. השכבותרשימת מתוך )באופן ידני 
  מול המקטע המתאים ובחר את השכבה הרצויה Layer)השכבות )

 למקטע בתנוחה. ששויכה: חשוב לשייך לכל מקטע את השכבה כפי הערה
 

ייתכן מצב שבו נשתמש ביותר מחתך טיפוסי   – הגדרת קטעי הכביש השונים
ד לתכנון חתכי הרוחב. במקרה זה הגדר את המקטעים לכל סוג חתך  אח

ברשימת המקטעים הנמצאת בחלקו העליון של המסך. בטבלה זו כל שורה 
תחת לכל קטע ) והסופימייצגת קטע ובה ניתן להקליד את המרחק ההתחלתי 

. על מנת להוסיף שורות לטבלת המקטעים יש (To STו   From STהכיתוב 
. ENTERורה שלפניה ברצונך להוסיף שורה ריקה וללחוץ על מקש לעמוד על הש

אם ברצונך להגדיר לכל אורך הציר הנוכחי חתך טיפוסי אחד, הקלד שורה אחת 
את המרחק -ו  From STתחת הכיתוב  0בלבד ברשימת המקטעים ובה הקלד 

. דרך נוחה  To ST( תחת הכיתוב Road's lengthהכללי )נמצא ליד הכיתוב 
)בחלון מימין(,  Pickהיה לסמן  את הקטעים ע"ג שרטוט. לחץ על הכיתוב יותר ת

   Pick-עבור לאזור השרטוט ולחץ על הציר בנקודות הרצויות. לאחר השימוש ב
 טבלת המקטעים תתמלא באופן אוטומטי עם המרחקים בהתאם.

 
מטבלת המקטעים  מסוימתעל מנת למחוק שורה  – מחיקת מקטעים מהטבלה

. באפשרותך גם למחוק את כל  ל  רה שברצונך למחוק ולחץ עסמן את השו

 .ל הטבלה ע"י לחיצה ע
 

בדומה לתכנון חתכי הרוחב ניתן ליצור את החתך   – הגדרת החתך הטיפוסי
בחלקו   Structure -וה -Designהטיפוסי ע"י הקלדת הנתונים בטבלאות ה

( מתוך  TYPוסי )התחתון של המסך. בנוסף לאפשרות זו ניתן גם לייבא חתך טיפ
רשימת החתכים השמורים במערכת.  )בהמשך נראה כיצד ניתן לשמור חתכים  

טיפוסיים שיצרנו במערכת(. אם הכביש המתוכנן כולל לדוגמא חלקים בהם יש אי  
תנועה נגדיר חתך טיפוסי שונה למקטעים הכוללים את אי  -תנועה וחלקים ללא אי

 התנועה ולאלו שאינם כוללים.
 
 

 Typicalהקלד את נתוני מבנה הכביש בטבלה תחת הכיתוב תך: הגדרת הח
Structure ואת נתוני התכנון בטבלה תחת הכיתוב  Typical Design    שים(

לב שמבנה החתך אמור לשקף את המבנה לפי התנוחה שכבר משורטטת ע"ג  
הציר, התוכנה תשנה את המרחקים בחתך באופן אוטומטי(. לאחר מילוי הנתונים  

 לעדכון שרטוט החתך. נתבונן במספר דוגמאות:  Applyוץ יש ללח
 

 אי ללאומסלולי עם מדרכה -: נתונים לחתך טיפוסי דו1דוגמא 
 תנועה. 

 
לו אשר המקטע  את אורך בחלקו הימני העליון של המסך, הגדר

ועבור    (.From ST. ; To ST) נתוני החתך הטיפוסינזין את 
   להגדרת החתך הטיפוסי:
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 Typical Structureטבלת  
 

 
 

 Typical Designטבלת  
 

 
 
 

ישתנה בהתאם לרוחב   בכל מקטע Offset -נתון ה הערה: 
 החתך בתנוחה.

 
במידה והכביש אותו אנו מתכננים, מורכב ממקטעים של אי תנועה 

וללא אי תנועה, נצטרך לערוך שינוי בדוגמא אשר הובאה כאן 
ם ט של חתכי, כך שתיווצר התאמה בין מקטעי האספל1כדוגמא 

  2 מאדוגתנועה. במקרה כזה התנועה וחתכים ללא אי האי  עם
 תיראה כך: 
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לו אשר המקטע  את אורך בחלקו הימני העליון של המסך, הגדר
 From ST. ; Toעם אי התנועה ) נזין את נתוני החתך הטיפוסי

ST.:ועבור להגדרת החתך הטיפוסי )   
 

אי התנועה ע"י שימוש  ניתן להעתיק את נתוני החתך הטיפוסי ללא

 להדבקה.  -להעתקה ו  בכפתורים  
 

 Typical Structureטבלת  
 

 
 

  -1או  1הוסף שני מקטעים ריקים עבור כל צד ע"י סימון מקטע מס' 
 להוספת מקטע. Enterולחיצה על כפתור  
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ואי   מסלולי עם מדרכה-: נתונים לחתך טיפוסי דו2דוגמא 
 . תנועה

 
 Typical Structureטבלת  

 

 
 

הקלד על המקטע הרצוי את הנתונים כפי שמופיעים בטבלה  
 להוספת אי תנועה לחתך הטיפוסי. 

 
 

 Typical Designטבלת  
 

 
 

במקטע  כפי שמופיע בטבלה בעיגולשנה את הנתון המסומן 
  המתאים.

 
 

 
עבור למקטע הבא ברשימת המקטעים שהגדרת מימין והגדר את החתך  .1

פוסי השני. המשך בצורה זו כך שתמלא את כלל החתכים. )ניתן  הטי
שבחלון מימין על מנת להעתיק חתכים   Paste-ו  Copyלהשתמש בכפתורי 

 טיפוסיים ממקטע אחד לאחר(.
 

בחלון שייפתח   ,לחץ על כפתור   –קביעת ההגדרות לחלוקת החתכים  .2
 קבע את ההגדרות לפי ההסבר הבא: 

 Attach to Typical section offsets -    ע"י סימון אופציה זו התוכנה
תבנה את החתכים לרוחב רק לפי החתך הטיפוסי, ולא תשנה אותו בהתאם 

 לתנוחה. 
 Get structure and designed G.L. only each step -  אופציהכאשר  

מסומנת התוכנה תמלא את חתכי הרוחב בתכנון רק לפי החלוקה  זו 
(Steps ולא תתחשב בנקודות ).השבר על הקווים של התנוחה 
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  - Get existing G.L. only each step  זו מסומנת   אופציהכאשר
( ולא  Stepsהתוכנה תמלא את חתכי הרוחב במצב הקיים רק לפי החלוקה )

 תתחשב בנקודות השבר על הקווים של התנוחה.
 Rresolution (m) –  לדוגמא: ליצירת חתכי ביניים.  מקסימאלימרחק

 ביניהם, התוכנה לא תיצור חתכי ביניים שהמרחקים 2כנס ערך במידה ויו
 מטר.  2-קטנים מ

 Sections width –  .יש להכניס ערך חיובי לרוחב הצד הימני  רוחב החתך
 של החתך מהמרכז וערך שלילי לרוחב הצד השמאלי.

על מנת להגדיר את המרחק בין החתכים ואת שם החתך הראשון לחץ על 

 . OKתח קבע את ההגדרות הבאות ובסיום לחץ בחלון שייפ כפתור  
 Format1 -  .אפשרות זו מציגה את שמות החתכים לפי מספורם 
 Format2 -  ע"י שינוי הפרמטרים שיופיעו בתחתית החלון התוכנה תציג את

מרחק רץ+קמ ,לדוגמא: אם נשאיר את הערך   שם החתך בצורה הבאה:
,  000+0באה: , התוכנה תציג את החתכים בצורה הKM :0בשדה 
020+0 .... 

 Name of first section  –   שם החתך הראשון )התוכנה תמספר את
 החתכים בסדר עולה משם זה(. 

 Stepes  –   המרחק בין חתכי הרוחב שהתוכנה תיצור )בנוסף לאפשרות
 שתיצור גם חתכי ביניים בנקודות השבר(.

 
 . OKבסיום לחץ 

 
   – Extract-הפעלת ה .3

ובחתכי הרוחב קיימים נתוני מצב קיים התוכנה תתריע   במידה ,לחץ על כפתור   
, סמן אפשרות זו אם Get existing G.L. againעל כך ותציג חלון עם האפשרות: 

ברצונך לייבא את נתוני הטופוגרפיה לחתכים מחדש, במידה ולא תסמן אפשרות זו,  
 להמשך. OKתבוצע יותר מהר לחץ  Extract-פעולת ה

, לקבלת תנוחה מלאה סמן את Layout and contours-ן ההתוכנה תציג את  חלו 
. אם קיימים מספר כבישים Layout, Contours, Distancesכל אפשרויות התצוגה: 

חסוך זמן(, סמן את זה וברצונך לעדכן רק את הכביש הנוכחי )פעולה זו ת בפרויקט
 להמשך.  OK. לחץ Update current road onlyהאפשרות 

התוכנה תציג את התנוחה המלאה הכוללת גבהים וקווי   -Extractלאחר פעולת ה 
 גובה. 

 
, לא יימחקו בעת ביצוע  Road By Roadחתכי רוחב אשר נוצרו ע"פ הגדרת  :הערה 

 . Extractפעולת 
 Select Sections To‘, ייפתח חלון Extractלאחר לחיצה על כפתור 

Change’ . 
תופיע כוכבית בעמודת   ,Road By Roadלצד החתכים שנוצרו ע"פ הגדרת 

‘Freeze’ .שמסמלת כי חתכים אלה לא יימחקו , 
במידה וברצונך שחתך או חתכים מסויימים יימחקו, יש להקליק על הכוכבית לצד 

 החתך המבוקש כדי להסיר את הכוכבית.
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)כפי   - Super elevations ניתן להשלים את הגדרת מעברי שיפועים .4

)כפתור זה נמצא גם   לחיצה על כפתור   שמפורט בפרק תכנון כבישים( ע"י
 בחלון חתכי הרוחב(. 

 
 

 

   Tmlשמירת וקריאת חתכי רוחב טיפוסיים מקובץ  
 

במקרים רבים של תכנון כביש, נשתמש בחתכים טיפוסיים זהים. על מנת שלא להגדיר בכל 
תכנון מחדש את נתוני חתכי הרוחב, מאפשרת התוכנה לשמור חתך טיפוסי אשר הוגדר  

גר חתכים טיפוסיים וזאת לצורך קריאתו מאוחר יותר לתכנון כביש חדש. לאחר יצירת  במא
 Save  - שלו(; לחץ על כפתור ה  Designed-וה  Structure-החתך הטיפוסי )הגדרת ה

שם החתך הטיפוסי ולחץ שמור )רצוי לשמור את כל החתכים  שבחלון מימין . הכנס את  
(. באותו אופן,  CivilCAD 10\Typicalsים בספריית: הטיפוסיים ב"בנק" החתכים אשר קי

מתוך  TYPלקובץ    בכל פעם אשר נתחיל בתכנון נוכל לקרוא ע"י לחיצה על כפתור
  רשימת החתכים הקיימים, וזאת במקום להגדיר את החתך בכל פעם מחדש. 

 

  Extractפרוט הפעולות בחלון 
 

  Clear current section - סי מהמקטע הנוכחי. מחיקת החתך הטיפו 
 

  Clear all sections -   .מחיקת כל מקטעי החתכים הטיפוסיים 
 

  Copy currnent tables to clipboard -   העתקת החתך הטיפוסי
(Design+Structure מהמקטע הנוכחי אל ה  )– Clipboard . 
 

Paste all from clipboard  - ( העתקת החתך הטיפוסיDesign+ּStructure )מה-
Clipboard   .אל המקטע הנוכחי 

 

Load sections from text file  - ( טעינת החך הטיפוסי מקובץ טקסטTyp .) 
 

 Save sections to file  - ( שמירת החתך הטיפוסי לקובץ טקסטTyp.) 
 

 Extract  – .יצירת חתכי רוחב ובניית תנוחת הכביש 
 

 Options -  ביצוע ה הגדרות– Extract . 
 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  257עמוד 

 
 

Get Structure and Designed G.L. each step only –   התוכנה תייצר חתכי רוחב
 רק ע"פ הגדרת המרחק בין חתכים ללא חתכי ביניים. 

 
Get Existing G.L. each step only  –  התוכנה תייבא את נתוני הקרקע הקיימת ע"פ

 . רוחב הקרקע שהוגדר רק לחתכים שייווצרו ע"פ הגדרת המרחק בין חתכים
 

Resolution –   הגדרת מרחק שעל פיו התוכנה תדגום את תנוחת הכביש למציאת שינויים
 גיאומטריים. 

 
Include sections by Steps Definition -   חתכי רוחב

, לא יימחקו בעת Road By Roadאשר נוצרו ע"פ הגדרת 
 . Extractביצוע פעולת 

 Select‘, ייפתח חלון Extractלאחר לחיצה על כפתור 
Sections To Change’ . 

, תופיע  Road By Roadלצד החתכים שנוצרו ע"פ הגדרת 
, שמסמלת כי חתכים אלה לא ’Freeze‘כוכבית בעמודת 

 יימחקו. 
במידה וברצונך שחתך או חתכים מסויימים יימחקו, יש 

להקליק על הכוכבית לצד החתך המבוקש כדי להסיר את 
 הכוכבית.
 

Sections Width – וחב הקרקע בחתכים הגדרת ר 
 

  Superelevations –   חלון הגדרת מעברי השיפועים )להרחבה ראה פרק תכנון
 כבישים(.
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  Create layout –  עדכון תנוחת הכביש ע"ג השרטוט. )פעולה זו מבוצעת גם לאחר

 )  לחיצה על
Close - יציאה מחלון ה-Extract   .ושמירת השינויים 

 
Apply – יפוסי המעודכן למקטע הנוכחי.מציג את החתך הט 

 
 
 

 .Typical sectionפרוט הפעולות בחלון החתך הטיפוסי 
 

  Save project  -  הפרויקטשמירת נתוני כל . 
 

  Zoom extents – .תצוגת החתך באופן מלא 
 

  Erase current section -  .מחיקת הטבלה הנוכחית 
 

  Copy currnent table to clipboard - תקת הטבלה הנוכחית אל ההע-Clipboard  
 

 Paste all from clipboard - העתקת הטבלה האחרונה מתוך ה- Clipboard  אל
 הטבלה הנוכחית.
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 תכנון תעלות :17פרק 
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 תכנון תעלות 
 

 נם:ישלבי העבודה בתכנון תעלות ה
 
 (. Horizontal Alignmentהגדרת התוואי האופקי של התעלה ) 
 של תחתית התעלה בחתך האורך. Invert level -הגדרת ה 
 (. Cross sectionsתכנון חתכי הרוחב של התעלה ) 
 פרוט הפעולות בחלון חתכי הרוחב.  
 חישובי עבודות עפר בתעלות. 
 הצגת חתך האורך של רומי גדות התעלה. 
 לאורכה. קואורדינטותההתוואי הגיאומטרי של התעלה וחישובי  

 
 הנ"ל.   אנו נעבור בפרק על כל השלבים

 

 (. Horizontal Alignmentהגדרת התוואי האופקי של התעלה )
 

כשלב ראשון בתכנון תעלות, יש להכין את רקע המצב הקיים )לפרוט על הכנת רקע המצב 
הכנת רקע לעבודה"(. לאחר הכנת הרקע, נמשיך בהגדרת  -הקיים ראה פרק "תכנון כבישים

 התוואי האופקי לפי השלבים הבאים:
 
. מימין יפתח חלון.  Roads -> Horizontal Alignmentל התפריט הראשי הפעל: . מסרג1

( התחלפה, ובמקום Topography coordinatesשים לב כי הרשימה בחלון התחתון )
רשימת הנקודות הקיימות, הופיע רשימה חדשה, ריקה, של הנקודות המתוכננות 

(Designed coordinates.) 
 יר: של הצ IP -. הזנת נתוני ה2

החדש של  Center line -הגדרת התוואי האופקי של התעלה, יבוצע על ידי הגדרת קו ה
( אופקיות. בנוסף לנקודות  IPיוגדר על ידי נקודות תפנית ) זהתוואי התעלה העתידית. תוואי 

התפנית האופקיות, יתכן ונרצה להזין רדיוסים בנקודות התפנית, אם כי להבדיל מכבישים, 
 הכרחי. נתון זה אינו 

 של הציר. אנו נבחן שתי שיטות:  IP -קיימות מספר שיטות להזנת נתוני ה
 בלבד(  AutoCAD/ZWCADשיטה א': )למשתמשי גרסת 

(, שיהווה את התוואי האופקי של 2D Polyline) Polyline, העבר AutoCAD/ZWCAD -ב
 הציר. 
 (. Unused, Pick, Locate, Selectבטבלה מימין )הטבלה ובה הרשימה  Selectבחר 

להגדיר את התוואי בשיטה  באפשרותך. )יש Enter  ולחץ AutoCAD/ZWCAD  P-הקלד ב
מתקדמת ע"י כלים מיוחדים בתוכנה, להרחבה ראה פרק תכנון כבישים סעיף תכנון התוואי  

 י(.האופק
. הטבלה בחלון מימין  Enterהמשורטט ולחץ  Polyline –עבור לאזור השרטוט, בחר את ה 

של הציר,   IP -קבע כי, י Polyline -( בVertexשל הציר. כל שבר ) IP -ימת התתמלא ברש
 שלהם. קואורדינטותהובחלון התחתון תופיע רשימת 

 
מספר ה  y -מספר הציר, ו  x,   כאשר xIPyלציר יקבעו ע"פ:     IP -* הערה: שמות נקודות ה

IPפעולת י. בציר הראשון שי( בחרSelect ימוספרו ה ,)ראשונה- IP  :1בצורה הבאהIP1  ,
1IP2 ,1IP3  ,1IP4  וכו'. בכל פעולתSelect  של הרכו עחדשה, יגדל- x. 
 שיטה ב':      
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 של הציר, לדוגמא: IP -בחלון התחתון הקלד את רשימת ה 
 

IP1          175143.56            256123.76 
IP2          175200.40            256325.56 
IP3          175256.00            256327.12 

 
 

כפי שהוקלדו ברשימה  IP -בטבלה מימין הקלד את שמות ה 
  IP -נקליד כמובן תחת הכיתוב IP -התחתונה. את ה

 בטבלה. בדוגמא שלנו נזין את הרשימה בצורה הבאה:
 

                                      
 
 

 . הזנת הרדיוסים של הציר:3
. אם לא נגדיר IP -ואי האופקי יהיה הגדרת הרדיוסים בנקודות ההשלב הבא בהגדרת התו

 . 0 -רדיוסים תתייחס התוכנה לרדיוסים כ
הראשון והאחרון   IP -בטבלה מימין, הזן את הרדיוס הרצוי. ל IPמול כל  

 לא נגדיר רדיוס כלל.
 & Layout -מימין. לפניך יפתח חלון Applyלחץ על כפתור  

contours. 
שוב )לא נפרט כאן את השימוש בחלון הנ"ל. אנו   OKץ בחלון שיפתח לח 

 נחזור לחלון זה בהמשך ואז נפרט על השימוש בו(.
, יופיעו  IPהתוכנה תיצור את התוואי האופקי של הציר, אשר יופיע בשכבות נפרדות. ליד כל 

 נתוני הקשת. -שלה, וליד כל קשת קואורדינטותה
 

 בלבד: AutoCAD/ZWCADלמשתמשי גרסת 
מורכב,   Polylineמסוגלת להוציא את נתוני התוואי האופקי מתוך  CivilCAD 10ת תוכנ

המורכב על ידי   Polylineהבנוי מאוסף של קשתות וקווים ישרים יחדיו. לאחר שתבחר את ה 
, תבנה התוכנה את הציר כך שיכלול את הקשתות. לכל קשת יחושב Select  -פעולת ה 
)ראה   OKושוב  Applyבטבלה מימין. לאחר לחיצה על שלה, אשר יופיעו  IP -הרדיוס וה

 למעלה(, יופיע נתונים אלה ע"ג השרטוט.
 

בתוך הוואדי של פרויקט חדש בעל קובץ  Polylineלמימוש דוגמא של האמור לעיל, העבר 
העבר כך שיכלול הן קווים ישרים והן   Polyline -. את ה\Sample7.Tco \Samplesהמדידה 

 (. Polyline -בזמן ציור ה \Arc\קשתות )בחירת 
 
 
 

 : IP -. שינוי מיקום ה4
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ימה  של הציר, ואת הרש קואורדינטותההתוכנה קושרת את הרשימה התחתונה, בה מופיעות 
העליונה )מימין(, של הגדרת הציר, על פי שמות הנקודות. מכאן שכל עוד נשמור על שמות 

התחתונה, ישמר קשר זה. שינוי  , הן ברשימה העליונה והן ברשימה IP -ה נקודות זהים ל
בחלון הימני, ושוב   Applyשל נקודה מסוימת, ברשימה התחתונה, ולחיצה על  קואורדינאטה

OK   בחלון שיפתח, תזיז את כל תוואי הציר בהתאם למיקום החדש. נראה כעת כיצד ניתן
 פי: אע"י שינוי גר אלא, הקואורדינאטהלא ע"י שינוי ידני של  IPלהזיז 

  Unused, Locate, Pickמתוך הרשימה ) Moveחתון, בחר בחלון הת 
 וכו'(.
עבור לשרטוט ובחר את הנקודה הרצויה להזזה )תוכל  

 , הופעל(. Node -ל Object Snap -להבחין כי ה
סמן את נקודת הייחוס להזזה )סביר להניח שתבחר שוב את  

 הנקודה עצמה כנקודת ייחוס(. 
 הנקודה.סמן את המקום אליו ברצונך להזיז את  

מסרגל הכלים שמעל  להשלמת הפעולה לחץ כפתור  
 לשרטוט. הנקודה תזוז למיקום החדש. 

בחלון שיפתח. הציר יזוז   OKבחלון הימני, ושוב  Applyלחץ  
 . IP -בהתאם למיקום החדש של ה

 . Close. בסיום הגדרת התוואי האופקי לחץ 5
 
 
 

 פירוט פעולות נוספות בחלון: 
 

 .Dis. קריאת נתוני הציר מתוך קובץ כפתור פתיחת קובץ   .2

 .ההתרע. לפני ביצוע הפעולה תבוא מחיקת כל נתוני הציר   .3

,  OKניתן ללחוץ  IP -בודד בציר. לאחר מחיקת ה  IPמחיקת  -כפתור מחק   .4
 ע"מ לקבל את תוואי הציר החדש. OKובחלון שנפתח שוב 

רות. בחלון ניתן  לחיצה על כפתור זה תפתח את חלון ההגד  Optionsכפתור    .5
 לקבוע את ההגדרות הבאות:

 : Scale -שינוי קנה המידה של גודל הכיתוב .5
על מנת לשנות את גודל הכיתוב בנתוני הציר בחר את הקנ"מ הרצוי מתוך הרשימה. 

לעשות כן לחץ על כפתור החץ הקטן ליד המספר הנתון  בתיבה ובחר את הגודל  
הוא הגודל  X, כאשר X:1ל פי יחס של נו ביחידות מטרים עיהרצוי )קנה המידה ה

לסגירת החלון. בכדי לשנות את השרטוט , יהיה  OKהנבחר(. לאחר הבחירה לחץ 
 בחלון שיפתח.  OKשמימין, ושוב   Apply -עליך ללחוץ שוב על כפתור ה

 Pick( :IP counter in coordinates)כאשר עובדים עם  IP –שינוי מספור ה  .6
 -מתוך הרשימה )ראה חלון קודם Pickאופקי ע"י בחירת  ניתן להגדיר את התוואי ה 

Select, Pick, Locate  וכו'(. בכדי לקבוע את מספור ה- IP כפי שיבנו ע"י ה- Pick ,
ע"פ המספר   IP -הבאה, יקבע מספור ה Pick -הכנס מספר רצוי. בפעולת ה

 שהוכנס. 
 ( IP counter in layout: )בתנוחה IP -שינוי מספור ה  .7

. נדגיש שאין  0 -שלו לפי סדר עולה המתחיל ב IP -ממספרת התוכנה את ה לכל ציר,
כפי שהיא מופיע ברשימת תוואי   IP -של ה הקואורדינאטהקשר בין שם 

ע"ג התנוחה. ז"א,  IP -המתוכננות, ובין מספור ה קואורדינטותההציר/ברשימת 
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)אשר חייב  ( יופיע שם נקודה כלשהוIP    Radius    Clothoidשיתכן ובטבלה )
  IPלהיות זהה לשם שמופיע ברשימה שבחלון התחתון(, וע"ג התנוחה, יופיע לאותו 
 -מספור אחר. הזנת מספר בשדה הנוכחי, יקבע את המספר שממנו יבחרו שמות ה

IP .לציר הנוכחי, על גבי התנוחה 
, תצא ללא Close -, תאשר השינויים שבוצעו, ולחיצה עלApplyלחיצה על כפתור  .8

 ה.שמיר
9. Pick, Locate –   

פית של הציר, בנוסף על פעולת א מאפשרות הגדרה גר  Locate -וה Pick -פעולות ה
 שנלמדה בתחילת הפרק. נראה את השימוש בפעולות אלו:  Select -ה

 :Pick -שימוש ב
a.  בחרPick .ברשימה 
b.   עבור לאזור השרטוט, והחל בסימון הציר. בסיום סימון הציר, לחץSet ו-  

Enter בג( רסתStand-Alone בעכבר כפתור ימני  על , לחץ.)לסיום 
c. .המשך במתן רדיוסים ושאר שלבי תכנון הכביש 

 :Locate -שימוש ב
d.  בחרLocate  .ברשימה 
e. עבור לאזור השרטוט, הצבע על הנקודות בשרטוט אשר יהוו את ה- IP  אם .

  Object Snap -, תוכל לשים לב שAutoCAD/ZWCAD -נך משתמש ב יה
 ופעל באופן אוטו'.  ה Node -ל

f. .המשך במתן רדיוסים ושאר שלבי תכנון הכביש 
יוצרת נקודות חדשות, בעוד   Pickנו שפעולת יה Locate -ו  Pickההבדל העיקרי בין 

Locate   בוחרת נקודות שקיימות במאגר הנקודות. יתרונה של פקודתLocate   הוא בכך
  שאינה "מכבידה" על הרשימה.
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 של תחתית התעלה בחתך האורך.  velInvert le -הגדרת ה
 לאחר שהגדרנו את התוואי האופקי של התעלה, נעבור לטפל בחתך האורך של הציר: 

 
. לפניך יפתח חלון  Roads -> Vertical Alignment. מסרגל התפריט הראשי הפעל: 1

 חתך האורך.
 החלון שיפתח מחולק ל: 

ת השרטוט האזור המרכזי של החלון יוצג ע"י סביב  -אזור השרטוט 
  בפרויקטבהתאם להגדרות  AutoCAD/ZWCAD-הרגילה או ע"י חלון ה

-File)על מנת לשנות הגדרה זו הפעל מתוך התפריט הראשי 
>Configuration :ליד הכיתוב ,Vertical alignment mode   בחר

Drawing Environment Interface  לתצוגת החתך ע"י
רגילה. לצורך  לתצוגה Stand aloneאו  -AutoCAD/ZWCADה

, כדי ללמוד כיצד לעבוד עם  Stand aloneהדוגמא אנו נעבוד בשיטת 
תכנון כבישים סעיף הגדרת חתך  ראה הרחבה הפרק  השנייההשיטה 

 . AutoCAD/ZWCADהאורך ע"י 
 (. Topoהטבלה משמאל למטה )  -טבלת נתוני המצב הקיים 
 הטבלה מימין למטה.  -טבלת נתוני התכנון 
 לון הימני.הח -חלון הפעולות 

התוואי האופקי   -. השרטוט המרכזיAutoCAD/ZWCADשים לב שאזור השרטוט אינו חלון 
והמצב הקיים, נמצאים בחלון נפרד שנמצא מתחת לחלון החתך לאורך )הקטנת החלון  

 למינימום תגלה שוב את החלון הקודם(. 
 
י ותחשב את גבהי בחלון מימין. התוכנה תעבור לאורך התוואי האופק Apply. לחץ כפתור 2

החתך לאורך. גבהים אלו יופיע בטבלת המצב הקיים )הטבלה השמאלית התחתונה(, 
 מצב קיים.  -כפונקציה של מרחק רץ וגובה. בחלון השרטוט יופיע שרטוט החתך לאורך

 נבהיר מספר נקודות: 
החתך ניתן בקנה מידה מעוות של גובה לאורך וזאת ע"פ בחירה של  

 שתתקבל סביבת עבודה נוחה(. על מנתת עיוות התוכנה )התוכנה יוצר
מ'.   20בטבלה שבתחתית החתך, מופיעים גבהים ומרחקים רצים כל  

זוהי ברירת המחדל של התוכנה בהנחה וטרם הוגדרו חתכי רוחב. בכדי  
לשנות נתון זה יש להגדיר את חתכי הרוחב ולשוב לחתך האורך אשר 

 יתעדכן באופן אוטומטי. 
ואי אופקי, או שאין בידינו טופוגרפיה ניתן ליצור את  גם אם לא קיים תו  

החתך ע"י הזנת נתונים ידנית לטבלת המצב הקיים. לעשות כן יש למלא 
(. בכדי לקבל את Elev(, וגובה )STאת הטבלה בנתוני מרחק רץ )

 בחלון הימני.  OKהחתך לאחר הזנת הנתונים לחץ 
אורכי שגוי בחלקו,   אם, בעקבות נתוני טופוגרפיה שגויים, התקבל חתך 

ניתן לערוך את נתוני המצב הקיים שהתקבלו באופן ידני. בכדי למחוק  
שורה בטבלה, עמוד אם העכבר על טור המספר הסידורי של השורה 

מחק. לקבלת השינוי י. השורה תDel)העמודה השמאלית ביותר(, ולחץ 
 ין. בחלון מימ Applyע"ג השרטוט לחץ 

 
 נכיות:. תכנון נקודות המפנה הא3

 פי: אתכנון החתך לאורך יכול להתבצע ע"י הזנת נתונים בטבלה או ע"י שרטוט גר
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 הזנת נתונים בטבלה. -שיטה א' -
מס"ד  -טבלת נתוני התכנון )הטבלה הימנית התחתונה( מחולקת לעמודות על פי

(, שיפוע  Ele(, גובה )STללא כותרת(, מרחק רץ )  -)העמודה השמאלית ביותר 
 (.2T( ואורך הקשת האנכית )%Slopeיתן באחוזים )בין מקטעים הנ

הזן את הנתונים בטבלה, כאשר לכל מקטע הגדר את המרחק הרץ שלו ואת 
גובהו. התוכנה תחשב בין כל שני מקטעים את השיפוע ותציגו מול המקטע  

הרלוונטי. במקום גובה ניתן להזין את השיפוע ממקטע קודם ואז תמלא התוכנה 
למחיקת שורה שגויה, עמוד עם העכבר על עמודת המספר את עמודת הגובה. 

. לקבלת  Delהרלוונטית ולחץ ה השורהסידורי )העמודה השמאלית ביותר( מול 
 בחלון הימני.  Applyשרטוט החתך המתוכנן לחץ 

 פית. אשרטוט הנתונים גר -שיטה ב' -
 לשרטוט נתוני התכנון על גבי המצב הקיים, נראה שתי שיטות: 

a.  בחרPick בר( שימה התחתונהUnused, Pick, Locate עבור לאזור .)
השרטוט, עמוד בצדו השמאלי ביותר של החתך )ניתן לחרוג מעט שמאלה 
מהמצב הקיים(, ולחץ על כפתור העכבר. הנקודה שבחרת תיקבע כנקודת 

מפנה אנכית ונתוניה יופיע בטבלת התכנון )למטה(. המשך לשרטט את חתך  
גבי אזור השרטוט, תוכל לראות את מיקומך  האורך. במהלך תנועתך על

שמימין לשרטוט.   Elevation -ו Stהמדויק, גובה ומרחק, תחת הכיתוב 
 בחלון הימני.  Applyבסיום השרטוט לחץ 

שים לב: אם תבחר נקודה מחוץ לגבולות המצב הקיים, משמאל או מימין, תקבע  
מאל או סוף לש 0התוכנה את נקודת המפנה במרחק הרץ הקיצוני ביותר )

 הקרקע הטבעית לימין(, וזאת בגובה שבו עמדת.
b.  נה בעזרת ילשרטוט חתך האורך, ה השנייההשיטהLocateהשימוש ב .-  

Locate דומה מאד באופן פעולתו לשימוש ב- Pick  אלא, שכאשר תבחר
קיים , היא תקבע בדיוק בגובה המצב הכלשהונקודת מפנה במרחק רץ 

 שבאותו מרחק.
 
החתך  נהפי(. לאחר שנבאן, לשלב בין שתי השיטות )הזנה ידנית ותכנון גרניתן, כמוב

לקבלת   Applyפית, ניתן לשנות את הנתונים שהתקבלו בחלון התחתון, וללחוץ אגר
לשינוי הגובה   Enterהשינויים )תוכל לדוגמא, לשנות את השיפוע מול מקטע מסוים, ללחוץ 

 ט(. לעדכון השרטו Applyבהתאם לשיפוע, וללחוץ 
נו מנקודת המפנה האחרונה לנקודת מפנה חדשה בהמשך. להוספת יפי האהתכנון הגר

נקודת מפנה באמצע החתך, סמן עם העכבר את השורה של נקודת המפנה הקודמת )זאת  
שאחריה תופיע הנקודה החדשה שברצוננו להוסיף(, עבור לשרטוט וסמן את נקודת המפנה 

מימין להסדרת  Applyבמקום הרצוי. לחץ בטבלה ווסף תתה. הנקודה החדשה החדש
 השרטוט.

 
 
 . תכנון הקשתות האנכיות:4

לאחר שבטבלה קיימים נתוני תכנון נקודות המפנה האנכיות, הוסף את נתוני  
(. אם לא יתווסף רדיוס לקשת 2Tהקשת האנכית בעמודה הימנית ביותר )

ניתן להזין . את נתוני הקשתות 0האנכית, תחשב התוכנה את התפנית כרדיוס 
 בשתי צורות:
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אורך הקשת יינתן כפונקציה של המרחק בין טנגנטות   -אורך הקשת 
בחלון הימני לעדכון   Applyהקשת האנכית. לאחר הזנת הנתון לחץ 

 השרטוט.
בכדי להזין רדיוס קשת אנכית )במקום אורך(, לחץ עם   -רדיוס הקשת 

. עתה  R -ל )על כותרת העמודה(. הכיתוב ישתנה 2Tהעכבר על הכיתוב 
, תחזיר Rתוכל להזין את רדיוס הקשת. לחיצה נוספת על הכיתוב 

 .2T -לעבודה ב
 

 : OKלמימוש הדוגמא שלנו הקלד הנתונים הבאים בטבלת התכנון. בסיום לחץ 
 

ST 2T Elev 

0   232 

200.88 100 233.25 

315.74   235.108 

 
 
 של חתך האורך: DXF. יצור קובץ 5

של חתך האורך )נוכל גם   DXFהתכנון, נרצה להוציא קובץ  לאחר שסיימנו את
 כמובן לעשות כן למצב הקיים בלבד(:

 שמעל לחלון השרטוט. לחץ כפתור   
נו ביחס  יהה המידבחלון שיפתח הגדר קנה מידה לאורך ולרוחב. קנה  

הקש את קנה המידה לגובה )לדוגמא:  Height. בתיבת ה  X –ל  1של 
(.  1000הקש את קנה המידה לאורך )לדוגמא:  Long -(, ובתיבת ה100

 .OKלהמשך לחץ 
שיח קבצים שתפתח הכנס את שם קובץ השרטוט. לחץ -בתיבת דו 

Save  .לשמירת הקובץ 
 בחלון הימני לסיום תכנון חתך האורך.  Cancelלחץ  
מאפשרת חלוקת  CivilCAD 10תוכנת   - לגיליונותחלוקת חתך האורך  

על מנת לעשות כן,  בחר   באופן אוטומטי. גיליונותחתך האורך למספר 
 -הרצוי על פיו תבוצע החלוקה מתוך הרשימה הנגללת ב  הגיליוןאת גודל  

Divide by paper size    ולחץOK  לאחר מתן שם לקובץ ולחיצה על .
Save  תיצור התוכנה מספר קבצים בעלי השם שבחרת ומספור עולה ,

 והלאה. 1-מ
 

 : פירוט פעולות נוספות בחלון
 

 כפתורים בחלון הימני: 

 -( ASCIIטקסט ) קליטת נתוני חתך אורך מתוך קובץ  .1
כפתור זה קורא נתוני מצב קיים לתוך הטבלה )הטבלה 

השמאלית התחתונה( מתוך קובץ טקסט פשוט שבו רשימת 
מרחקים רצים וגובה. מבנה הקובץ צריך להיות של שורות 

 ובהן מרחק רץ וגובה מופרדים ברווח/פסיק. 

 -  (ASCIIך האורך בקובץ טקסט )שמירת נתוני חת  .2
כפתור שמירת כפתור זה שומר את נתוני המצב הקיים 
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שנקראו מהטופוגרפיה )אן הוזנו ידנית(, לתוך קובץ טקסט. 
 מבנה קבוץ הטקסט תהיה רשימה של מרחקים רצים וגובה.

 Getכפתור  -הוספת נתוני גדות תעלה לחתך האורך  .3
edges  ראה פרוט בהמשך  -ור צהוב מימין()כפתור עם צי
 הפרק.

4. Accurate/By sections  –   הצגת חתך אורך מדויק או
את  CivilCAD 10בחתכים בלבד. כאשר קוראת תוכנת 

חתך האורך מתוך הטופוגרפיה, היא מבצעת זאת באופן  
מדויק המושפע מצפיפות הנקודות המדודות )התוכנה בונה 

ת המשולשים שהיא את חתך האורך על פי מפגשי צלעו
יוצרת מתוך קובץ המדידה(. את המרחקים הרצים שבהם 
דגמה התוכנה את הגבהים, ניתן לראות בטבלה השמאלית 
התחתונה )טבלת במצב הקיים(. לעיתים, דגימה זאת, אל 
אף שהיא מדויקת, אינה טובה למשתמש )לדוגמא: בקובץ 
 המדידה נפלה טעות, המופיעה בחתך לאורך אך היא אינה
רלוונטית כיוון שאינה באחד מחתכי הרוחב(. העברת מצב 

, תפתור בעיה By sectionsלבין  Accurateהבחירה בין 
 זאת בצורה הבאה: 

1. Accurate  –   דגימה מדויקת של החתך. קו שרטוט החתך יהיה
בדיוק ע"פ הדגימה שבוצעה מהטופוגרפיה. הגבהים בטבלה  

מ'(,   20כל  -מחדלהתחתונה יופיע על פי חתכי הרוחב )ברירת 
 ובנוסף יופיע גבהים בנקודות קריטיות. 

2. By sections –    דגימה מדויקת של החתך אך קו שרטוט החתך
יבנה ע"פ הגבהים בחתכי הרוחב בלבד. הטבלה התחתונה תישאר 

 כפי שהייתה. 
 נו "בהחלקת" חתך האורך. חסרונה הוא בדיוק.יה By sectionsיתרונה של שיטת  

 
 : שרטוטה כפתורים בחלון 

 

5. Zoom Extents  -  צפייה בכל החתך. לחיצה על כפתור
זה תחזיר את הצפייה בכל השרטוט. במקרה בו הזיז 

המשתמש את השרטוט שמאלה/ימינה בעזרת פסי הגלילה, 
או הגדיל/הקטין השרטוט בלחיצה על כפתור שמאלי/ימני 
באזור השרטוט, לחיצה על כפתור זה תחזיר את הצפייה  

 רטוט.השלכל אזור 

6.  DXF -  יצור קובץDXF  של החתך )לאופן הפעולה ראה
 , בסעיף זה.20פירוט, שלב 

 
 כפתורים בחלון התחתון: 

 

מחיקת כל נתוני התכנון מהטבלה.  -Designבטבלת ה   .1
 לפני ביצוע הפעולה תופיע הודעת התרעה.
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 – dH -הגבהה/הנמכה של גבהי חתך האורך  .2
האורך בצע הפעולות להורדת/הוספת גובה לגבהי חתך 

 הבאות:
 . dHעל כפתור  לחץ .3
בחלון שיפתח תופיע רשימת הגבהים המתוכננים בחתך האורך. סמן  .4

A (All  )את הגבהים שברצונך לשנות. לשינוי כל הגבהים לחץ כפתור 
להוספה הרצוי  את הגובה  הזן)למטה(,  dH -בתחתית. בשורת ה

(. לחץ -ילי )הפרש בסימן של הזן. להורדת גובה להגבהה/הנמכה
OK  .לביצוע הפעולה 

הגבהים שנבחרו ישונו בטבלת התכנון התחתונה. לקבלת השינויים על גבי השרטוט  
 )מימין(.  OKלחץ 

 

מחיקת כל נתוני המצב הקיים מהטבלה. לפני ביצוע   -Topoבטבלת ה   .5
 הפעולה תופיע הודעת התרעה.

זה תפתח  לחיצה על כפתור  -קריאת חתך האורך מתוך הטופוגרפיה  .6
,  Existing G.L -חלון. בחלון בחר את הטבלה אליה יוכנסו נתוני הטופוגרפיה

  OK, לטבלת המצב המתוכנן. לחץ Designed G.Lלטבלת המצב הקיים, 
 להמשך. הנתונים יכנסו לטבלה בהתאם. 

לחיצה על  -העתקת המרחקים של המצב הקיים לתוך המצב המתוכנן   .7
ים בלבד )ללא הגובה( מתוך טבלת רצכפתור זה תעתיק את המרחקים ה

 המצב הקיים אל טבלת המצב המתוכנן.
 

שבחלון הימני קראה  Apply -הערה: בסדר הפעולות שהוצג בפרק זה, לחיצה על כפתור ה
את נתוני הטופוגרפיה אל חתך האורך. מהלך זה יהיה נכון רק אם טבלת נתוני המצב הקיים  

וכנה קריאה מחודשת של פני המצב הקיים  תהיה ריקה! בכל מקרה אחר לא תבצע הת
, אלא תחדש השרטוט על פי הנתונים הקיימים כבר בטבלה. הבעיה Applyבלחיצה על 

העיקרית תיווצר אם במהלך הפרויקט שונה התוואי האופקי של הציר, ו/או בוצעו שינויים  

  פןשאו  - בטופוגרפיה. לחידוש המצב הקיים של חתך האורך יש להשתמש בכפתור ה
 פעולתו הוסברה זה עתה.

 
 

 (. Cross sectionsתכנון חתכי הרוחב של התעלה )
  

לאחר שהגדרנו בפרק הקודם את חתך האורך של תחתית התעלה, נעבור להגדרת חתכי 
 הרוחב:

 
. לפניך יפתח חלון  Roads -> Cross sections. מסרגל התפריט הראשי הפעל: 1 

 חתכי הרוחב. 
 לשלושה חלקים:חלון חתכי הרוחב מחולק 

האזור המרכזי שבו יופיע שרטוט החתך. שמו של החתך  -אזור השרטוט 
 הנוכחי הנמצא בעבודה יופיע בכותרת מעל השרטוט.

 החלון הימני.  -טבלת רשימת חתכי הרוחב 
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הטבלאות בחלקו  -טבלאות נתוני המצב הקיים והמתוכנן לכל חתך וחתך 
ב הקיים בטבלה נתוני המצ – Existing G.Lהתחתון של המסך: 

 נתוני המצב המתוכנן בטבלה הימנית. -Designed G.Lהשמאלית, 
 

לפניך יפתח חלון הגדרת  -(Define sectionsשבחלון הימני ) . לחץ על כפתור  2
 חתכי הרוחב. בחלון הגדר את הנתונים הבאים:

 Start at station-  0מרחק רץ לחתך הראשון. ברירת המחדל תהיה  .
שהמרחק הרץ שיינתן לחתך הראשון בקטע הציר   בדרך כלל נרצה
. אם זאת קיימים מקרים בהם אנו מתכננים קטע שהוא 0המתוכנן יהיה 

 המשכו של ציר. במקרה כזה יהיה מרחקו הרץ של החתך הראשון שונה.  
 End at station-   מרחק רץ לחתך האחרון. ברירת המחדל תהיה על פי

התוכנה )אורך זה מופיע מיד עם  אורכן של הציר כפי שיחושב על ידי 
 (. Roads length -פתיחת חלון חתכי הרוחב, בחלון מימין

 Station of first section-  ברירת להתחלת הכבישמרחק רץ .
 תחילת הכבישנרצה שהמרחק הרץ שיינתן ל  במצב בו. 0המחדל תהיה 

נגדיר בשדה זה את המרחק הרץ  ,0יהיה לא בקטע הציר המתוכנן 
   הרצוי.

 Distance between sections-   המרחק בין חתכי הרוחב. ברירת
מ'. נראה בהמשך שאין חובה ביצירת חתכי רוחב   20נה יהמחדל ה

 סדרתיים, ויתרה מזאת, ניתן להגדיר את כל הציר באופן שאינו סידרתי. 
 Name of first section-  שמו של החתך הראשון )מספרו(. התוכנה

המצוין     Format-ר עולה בהתאם לתמספר את שאר החתכים בסד
 : Formatבחלון, נסביר את שני מצבי ה 

, המציגה את שמות החתכים כפי שהם מופיעים    Format1האפשרות הראשונה היא 
 ברשימת החתכים.

, ע"י שינוי הפרמטרים שיופיעו    Format2 אם נבחר את האפשרות 
מרחק בתחתית החלון התוכנה תציג את שם החתך בצורה הבאה:  

, התוכנה תציג KM :0רץ+קמ ,לדוגמא: אם נשאיר את הערך בשדה 
 380+0,.... 040+0,  020+0, 000+0את החתכים בצורה הבאה: 

 
על ידי סימון מקום החתכים עוד בשלב תכנון התוואי   הנהיאופציה נוספת להגדת חתכי רוחב 

לעשות כן בצע האופקי, כך שהחתכים ימוקמו במקומות קבועים על גבי רקע המדידה. 
 השלבים הבאים:

  -בהגדרת התוואי האופקי )החלק הראשון בתכנון התעלה(, העבר את ה 
Polyline אשר יקבע את ה- Center line כך שנקודות השבר שלו )ה ,-  

Vertex בחתכים.  מעוניינים( יהיו בדיוק במקומות בהם אנו 
התוכנה   .By Ips -בחלון הגדרת חתכי הרוחב )החלון הנוכחי(, העבר ל 

תיצור חתכים במרחקים הרצים אשר יקבעו על פי נקודות השבר לאורך 
 הציר.  

 
לבניית החתכים. רשימת  OKלאחר הגדרת החתכים )על פי אחת מהשיטות שנבחרו(, לחץ 

( ומרחק  Nameהחתכים שנבנו תופיע בטבלה מימין בהתאם להגדרות, ולכל חתך יופיע שם )
 (. Stationרץ )

 , בכל רגע נתון. לעשות כן בצע: לפרויקטי ביניים ניתן להוסיף חתכ
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מקם את הסמן )בעזרת העכבר( על השורה שברצונך להוסיף חתך  
 לפניה.

 )במקלדת(. השורה תקפוץ כלפי מטה ותופיע שורה חדשה. Enterלחץ  
בשורה החדשה הכנס שמו )מספרו( של החתך החדש. שם החתך יכול   

נו יותיות(. אם החתך החדש ה"/" )אך לא א -לכלול מספרים, "." ו
.  עבור עם החץ  1.1, תוכל לקרוא לו בשם 2 –ל  1לדוגמא בין חתך 

(, והכנס את המרחק הרץ של Stationהימני לעמודת המרחק הרץ )
 החתך שהוספת.

 

, לעבור מיד לחלון  ר  ניתן, במקום להגדיר חתכים באופן אוטומטי על ידי כפתו :הערה 
 שם ומרחק רץ לכל חתך וחתך.  -ידנין הימני ולבנות הטבלה באופ

 

שבחלון הימני. לפניך יפתח חלון       Optionsלחץ על כפתור  .17
 הגדרת רוחב החתכים: 

הגדר את רוחב החתך לעבודה. הכוונה היא לרוחב הקרקע שתדגום   
התוכנה למצב הקיים מתוך הטופוגרפיה. אנו נגדיר מרחק מהציר  

ו את רוחב רצועת הקרקע. את לשמאל ומרחק מהציר לימין שיחדו יגדיר 
מ'(,  20-)ברירת המחדל  Left -קצהו השמאלי של החתך נגדיר בשדה ה

מ'(, כאשר  20)ברירת המחדל  Right -ואת קצהו הימני נגדיר בשדה ה
 נו חיובי. ישלילי ומרחק מימין ה-נו מספר ימרחק משמאל לציר ה

רוחב  ,חתךקו עזר כך שבכל  עפ"יניתן להגדיר את רוחב הקרקע בחתך  
 הקרקע יהיה שונה הן בצידו השמאלי והן בצידו הימני. 

   Polylineקו עזר, שרטט   עפ"ירוחב בחתכי להגדרת רוחב קרקע 
(2D Polyline .בצד התנוחה הרצוי )  במידה ושורטטPolyline   בכל אחד מצידי

  צריכים להיות באותה שכבה! Polylines  -התנוחה, שני ה 

 .  Optionsולחץ על כפתור  Roads→Cross sectionsעבור לתפריט 

 לחץ על כפתור מכן  רלאח ו      באופציה ’V‘סמן  

Get section width by layer . פתח סמן את השכבה מתוך הרשימה  נבחלון ש
לחץ . לסיום (בשרטוט Polyline -ולסמן את ה   Select ע"י את השכבה לבחור )ניתן
OK  ושובOK . 

תופיע השכבה  Options -בחלון ה   Get section width by layerלצד כפתור 
 . Optionsליציאה מחלון  OKשנבחרה. לחץ 

 Get topo data for allלביצוע פעולת שינוי המרחק מצידי הציר לחץ על כפתור 

sections   לחץ אחר מכן ולOK . ,לחץ על כפתור לעדכון החתכים בחלון השרטוט

Interpolate empty sections  . 
 

יתכן מצב שבהן נרצה ברצועת ציר שכולה מימין )או משמאל( לציר שלנו. במקרים כאלה ניתן 
 להגדיר חתך שכולו מימין )או משמאל( וזאת בעזרת המרחקים הרצים המתאימים.

ניתן להגדיר   CivilCAD 10. בתוכנת dH  -ל  Elevation –העבר מ  
הים יחסיים.  חתכי רוחב בעלי גבהים אבסולוטיים, או חתכים בעלי גב

עבודה בגבהים אבסולוטיים תבטל למעשה את השפעת חתך האורך על 
חתכי הרוחב, ותחייב אותנו להגדיר תכנון נפרד לכל חתך וחתך )או מילוי  



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  271עמוד 

חתכי ביניים על ידי אינטרפולציות(. בהמשך הפרק נדון בעבודה עם  
 חתכים טיפוסיים ועל כן הגבהים יוגדרו באופן יחסי.  

. אופציה זו מגדירה את אופן ההצגה Design  -ל Earthwork -העבר מ 
הגרפית של החתך. לתוכנה שתי אפשרויות של הגדרת חתך: חתך 

, וחתך להצגת חתכים מתוכננים Earthworkלהצגת עבודות עפר 
Design  השוני בתצוגה יבוא ליידי ביטויי הן בצורת החתכים בחלון .

הן ביצירת קובץ חתכים  השרטוט, הן בהדפסתם דרך התוכנה למדפסת, ו
 .  AutoCAD/ZWCADעל גבי גיליון 

       

)כפתור כחול מימין(. בחלון שיפתח    GetT all לחץ על כפתור   .18
לשנות את נתוני המצב דת עומשהיא   תתריע. התוכנה OKלחץ 

  OKמחקו. לחץ יהקיים לנתונים חדשים וכי הנתונים הקודמים י 
ם את נתוני המצב הקיים  להמשך. התוכנה תעבור לאורך הציר ותדגו

 לאורכו, לפי החתכים שהוגדרו. 
-פעולת דגימת נתוני המצב הקיים תלויה במספר נקודות המדידה שבפרויקט, מספר קווי אי

רציפות שבו ובמספר חתכי הרוחב שהוגדרו. בפרויקטים גדולים יתכן ופעולה זאת תיקח ה
ובאורך הציר, אך במחשבים  אינה מוגבלת בגודל הפרויקט CivilCAD 10זמן מה. תוכנת 

 איטיים או בעלי זיכרון מועט, יתכן ופעולתה תיקח זמן רב ולעיתים אף "תיתקע". 
 

בסיום קריאת נתוני המצב הקיים יופיע החתך הראשון בחלון השרטוט ונתוני המצב הקיים  
יופיעו בטבלה משמאל למטה. בראש העמוד )בכותרת שמעל השרטוט(, יופיע שמו של 

, ובנוסף יופיע הגובה המתוכנן בציר של החתך Sections name: 1צג, לדוגמא: החתך המו
. ניתן לעבור בין  Elevation: 233.85הנ"ל )הגובה שנקבע לו בחתך האורך(, לדוגמא 

החתכים על ידי הצבעה על החתך הרצוי בטבלה מימין. כל חתך שיבחר יופיע באופן אוטומטי  
נך נמצא בחתך יבלאות למטה. להמשך ההדרכה וודא שהעל גבי השרטוט, ונתוניו יופיע בט

 הראשון.
 

(. בטבלה מופיעות שורות, כאשר Designed G.Lנסביר בקצרה את מבנה טבלת התכנון )
מקטעים    81 -)סה"כ כ 40+ועד   40- -כל שורה מייצגת מקטע. המקטעים ממוספרים מ

ר ללא כותרת(. לצורך  עמודות )השמאלית ביות 5אפשריים לכל חתך(. בטבלה מופיעות  
ההסבר, נמספר עמודות אלה בסדר עולה משמאל לימין כך שהעמודה השמאלית ביותר 

 : 1נה מספר יה
: בעמודה זאת מופיע המספר הסידורי של המקטע. 1עמודה מספר  

מייצג מרחק כלשהו. מקטעים משמאל לציר ייוצגו במספר   אינומספר זה 
 פר חיובי. שלילי ומספרים מימין לציר ייוצגו במס

עמודה זאת מייצגת את המרחק של המקטע  -( Offset) 2עמודה מספר  
מהציר. מרחק משמאל לציר יוכנס כשלילי ומספר מימין יוכנס כחיובי.  

למרחק מהציר שתי אופציות: מרחק אבסולוטי או מרחק יחסי. בעבודה  
(, יוכנסו הנתונים כמרחק יחסי,  24, כפי שמודגם כאן )ראה סעיף dHעם 
נו למעשה אורך המקטע ולא מרחק  ית אומרת שהמרחק שיוכנס הזא

, יוכנסו נתונים אלו כמרחק  Elevationאבסולוטי מהציר. בעבודה עם 
 אבסולוטי.

)כפי המודגם   dHלעמודה זאת שתי אופציות:   -(dH) 3עמודה מספר  
)ראה סעיף   Status -. האופציות נקבעות בחלון הElevationכאן( או 

, יוכנסו הגבהים כיחסיים, ביחס לגובה המקטע dHם  (. בעבודה ע24
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נו למעשה גובהו של המקטע. בעבודה עם  יהקודם, כך שהגובה שיוכנס ה
Elevation.יוכנסו גבהים אבסולוטיים , 

בעמודה זה ניתן להכניס את שיפוע  – (%Slope) 4עמודה מספר  
בעמודה   dHהמקטע. באפשרותך להכניס אחד משני הנתונים: הזנת 

,  4, תחשב את שיפוע המקטע באופן אוטומטי ותזינו בעמודה 3פר מס
 . 3ותכניסו בעמודה  dH -ולעומת זאת, הזנת שיפוע, תחשב אתה 

 
 

 לפני שנמשיך נסביר כעת מספר פעולות עריכה שניתן לבצע על הטבלה:
 בשדה מסוים תגרום למחיקת השדה הנ"ל.  Delלחיצה על  
 בוד כרגיל. )חץ אחורה(, תע Backspaceלחיצה על  
למחיקת שורה שלמה או צמצום שורות, עמוד על העמודה השמאלית   

. התוכנה תמחק את  Del( במקטע הרצוי, ולחץ 1ביותר )עמודה מספר 
 המקטע ותצמצם את השורות.

ניתן להעתיק מקטע, מחתך הרוחב הנוכחי, לשאר חתכי הרוחב. לביצוע   
בלה שתפתח סמן  העתקה עמוד על המקטע הרצוי ולחץ כפתור ימני. בט

את החתכים אליהם יועתקו נתוני המקטע )לבחירת כל החתכים לחץ 
. התוכנה תעתיק את נתוני המקטע לכל OKבתחתית( ולחץ  Allכפתור 

 החתכים שנבחרו. 
 

 נעבור כעת להגדרת תכנון החתך הטיפוסי: 
 

(.  Designed G.L -החל בהזנת נתוני התכנון בטבלה )טבלת ה .19
אנו נדגים כאן נתונים לחתך טיפוסי שילווה   לצורך הבהרת הנושא,

 בהסבר מפורט. הזן את הנתונים הבאים לטבלה:
, ושוב Enter", 0. הזן " 2עם העכבר, בעמודה מספר  0עמוד עם מקטע   
 ". זה עתה הגדרת שהגובה בציר זהה לגובה שתוכנן בחתך האורך.0" 
, עבור  Enter -", ו1.5. הזן " 2, עמודה מספר 1עבור עם החצים למקטע  

. המקטע שזה עתה  Enter" ו -1.5והזן "   3עם החץ ימינה לעמודה מספר 
 מ' לכל צד(. 1.5מ' ) 3 -נו תחתית התעלה ברוחב של כיהוגדר ה

 
 בסיום הזנת הנתונים, הטבלה צריכה להראות כך:

 
                      

  Offset  dH Slope% Cover 

-1 -1.5 0 -2.00   

 0     0 0     

 1   1.5 0 -2.00   

 
 

  בחלקה העליון והתחתון של הטבלה, מופיעים הכיתובים: 
 

Slp. left : Cut 1:        Fill 1:     
Slp right: Cut 1:        Fill 1: 
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 שדות אלו מייצגים את שיפועי גדות התעלה, משמאל ומימין: 
". את אותו 2ת המספר " (, אSlp right, שבתחתית הטבלה )ליד הכיתוב :Cut 1הכנס בשדה 

(. זה עתה :Fill 1שליד הכיתוב  :Cut 1נתון הכנס גם לאותו שדה שבראש הטבלה )שדה 
 . 1:2הגדרת כי שיפועי התעלה לשמאל ולימין הנם 

 בחלון הימני. התכנון יופיע על גבי השרטוט. Applyלחץ כפתור  .20
 

 כעת נשליך את החתך הטיפוסי לאורך כל הציר שבנינו:

שמשמאל לטבלת גובה עבודות העפר     Copy -תור הלחץ על כפ .21
(Designed G.L הכפתור ממוקם משמאל לטבלה. לאחר הלחיצה .)

 לזיכרון המחשב.  Designed G.L -תועתק טבלת ה
עבור, בעזרת הטבלה בחלון השמאלי )טבלת רשימת החתכים  .22

שמשמאל לשרטוט(, לחתך האחרון ברשימה. לחץ על כפתור ה  

Paste   הכפתו(ר שמתחת לכפתור ה- Copy על מנת להעתיק )
 את הנתונים מהזיכרון אל תוך הטבלה בחתך זה. 

 
 

נו בהזנת הנתונים בחתכים שבהם משתנה חתך  יה CivilCAD 10עיקרון העבודה של תוכנת 
הרוחב )ורק בחתכים אלו!(, ומילוי שאר חלקי הציר באינטרפולציות ביניים. כעת יש בידנו שני 

נתונים. שאר החתכים עדין ריקים )תוכל לראות זאת על ידי דפדוף ביניהם  חתכים מלאים ב
 טבלת רשימת החתכים(: -בעזרת לחיצה על חתך מסוים בטבלה הימנית

 Interpolate emptyלחץ על כפתור - ביצוע אינטרפולציות בינייםל .23

sections  בחלון שיפתח בחר ן  מימי .All design  על ולחץ
בצע אינטרפולציה לכל החתכים הריקים  . התוכנה תOKכפתור 

בפרויקט, ומכיוון שבידנו שני חתכים בלבד )ראשון ואחרון(, אשר  
 זהים בתכולתם, תמלא התוכנה את כל החתכים באותם נתוני תכנון. 

נך מעוניין, תוכל לעבור יבסיום האינטרפולציה, תוכל לדפדף בין החתכים. בשלב זה, אם ה
 תו.לחתך מסוים ולשנות את תכול

 
 הוצאת החתכים לגיליון שרטוט: 

 שמעל לחלון השרטוט.    -ה לחץ על כפתור  .24
    Model spaceלמצב  Paper spaceשנפתח, עבור ממצב חלון ב 
(. קנה  Length(, ולאורך )Heightקנה המידה לחתך לגובה ) הגדר 

לאורך.   100לגובה ו  100. הזן לדוגמא Xל  1המידה יוכנס כיחס של 
 . OKלחץ 

גודל דף מתוך רשימת הגיליונות. באפשרותך להגדיר גודל גיליון  בחר  
 (.No divisionאו לבחור בגיליון אינסופי ) Other –ע"י בחירה ב 

בגיליון אינסופי, בחלון שנפתח, הגדר את מס' החתכים במידה ובחרת  
,את המרחק  sections in each columnהרצוי בכל טור ליד הכיתוב 

ואת  dY Between sections (cm)יד הכיתוב ל בין החתכים נכיהא
 dX Between sectionsהכיתוב ליד   בין החתכים ופקיהמרחק הא

(cm) לחץ .Arrange סכמתי של מבנה הגיליון על מנת לראות תרשים  .
 .OKלסיום לחץ 

 . Saveבחר את שם הקובץ שהתוכנה תיצור ולחץ  
 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  274עמוד 

א על ידי רוב תוכנות השרטוט. ב נו קובץ שרטוט אשר ניתן לייבויה DXFהערה: קובץ 
AutoCAD/ZWCAD לדוגמא, ניתן לייבא קובץ זה על ידי פקודת ,DXFIN או על ידי ,File -

> Open  והעברת ,Filter   הקבצים לDXF לאחר יבוא הקובץ לחץ .Zoom  ו- Extents  על ,
 מנת לראות את כל החתכים.

 

מימין.    Create layoutלחץ על כפתור  - קבלת תנוחת התעלהל .25
 ,Layoutאת שלושת האפשרויות הקיימות )  V  -בחלון שיפתח סמן ב

Contours, Distances לחץ על כפתור .)OK  להמשך. התוכנה
תיצור תנוחה על גבי השרטוט הכוללת את קווי המתאר של התעלה  

 כולל קווי הדיקור.  
 כולל בתוכו שלוש אופציות:  Layout  -חלון ה

 Layout-   סימוןV  אופציה זו תיצור את קווי התנוחה של התעלה  ליד
 ואת כיתוב הגבהים בחתכים.

 Contours- .אופציה זו לא תהיה פעילה בתכנון תעלות 
 Distances-  סימוןV   .ליד אופציה זו תיצור שכבת מרחקים בין החתכים

התוכנה תירשום את המרחקים בן חתך וחתך, וכן את המרחקים בין  
 יו.החתך והטנגנטה הסמוכה אל

 Update current Road only –  " סימוןV מגדיר  " ליד אופציה זו
-לתוכנה לעדכן את תנוחת הכביש הנוכחי בלבד, אם נסיר את סימון ה

 "V "מוגדרים מספר כבישים התוכנה תעדכן את התנוחה  ובפרויקט
 לכולם.

 
נימום  , יעבור חלון חתך הרוחב למצב מיLayout  -בחלון ה  OK הערה: לאחר לחיצה על ה

"  בסרגל המשימות)על מנת שתוכל לראות את השינויים בתנוחה(. להגדילו חזרה לחץ עליו " 
אשר בתחתית המסך. המשך וערוך את החתכים בהתאם לרצוי כולל הוצאת  Windowsשל 

 . Closeהתנוחה המתאימה. בסיום עריכת החתכים לחץ 
 

 פרוט פעולות חלון חתכי הרוחב: 
 

ולות הנוספות הקיימות בחלון חתכי הרוחב, שלא נידונו בשלבי נעבור ונפרט כעת את הפע 
 ההדגמה:

 
 פעולות בחלון רשימת חתכי הרוחב )החלון הימני(: 

עמוד על החתך הרצוי למחיקה בתוך הרשימה,  - מחיקת חתך בודד  
ולחץ על הכפתור עם ציור מחק שבחלון רשימת החתכים )החלון הימני(.  

 .התוכנה תמחק חתך זה מהרשימה

שבחלון   X -לחץ על הכפתור עם ציור ה -מחיקת כל חתכי הפרויקט  
 למחיקה.  OKהימני. התוכנה תתריע לפני מחיקת כל החתכים. לחץ  

: לצורך מחיקת נתוני מספר חתכים  מחיקת נתוני קבוצת חתכים  
שבחלון רשימת החתכים )החלון   Clear all -יחדיו, לחץ על כפתור ה

 Existingמצב קיים ) –ר את הנתונים למחיקה הימני(. בחלון שיפתח בח
G.L( גובה עבודות עפר ,)Designed G.L  גובה פני מבנה הכביש ,)

(Structure או נתוני תעלות הצד. לחץ )OK פתחילהמשך. בטבלה שת, 
סמן את החתכים שאת נתוניהם ברצונך למחוק. לבחירת כל החתכים 
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את נתוני החתכים . התוכנה תמחק OKלמטה. לחץ  Allלחץ כפתור 
 שנבחרו. 

הוספת גובה לנתוני החתכים: אופציה זו שימושית בעיקר בעבודה    
עם גבהים אבסולוטיים )בגבהים יחסיים נעדיף לשנות את גובה חתך 
האורך על פני נתוני חתכי הרוחב(. להפעלה לחץ על הכפתור. בחלון  

ון  נתשיפתח הכנס את תוספת הגובה הרצויה )להורדת גובה הכנס 
בחר את הנתונים שברצונך  ,. בחלון שיפתחOKשלילי(. להמשך לחץ 

 OKלשנות )מצב קיים, גובה עבודות עפר, או גובה פני מבנה(. לחץ 
למטה,  Allלהמשך. בחלון הנוסף בחר את החתכים לשינוי )לחיצה על 

. התוכנה תוסיף את הגובה הרצוי  OKתבחר את כל החתכים(. לחץ 
 בלה שבחרת )קיים וכולי(. לחתכים הנבחרים, ובט

 

 החלון הימני(: –בחלון רשימת החתכים   )הפעלה על ידי כפתור  Optionsפעולות בחלון  
נו במהלך השלבים שבסעיף זה. נפרט אם כן את אותן פעולות  ודניחלק מהפעולות בחלון זה,  

 שלא פורטו: 
 

 Max/Min interval  – החתכים,  לעיתים, יתכן מצב בו יקראו נתונים חריגים אל
מתוך הטופוגרפיה. קיימות מספר סיבות לתופעה זאת כגון נתוני מדידה שגויים, גבול 

מדידה צר מגבול החתך הרצוי, אקסטרפולציות בקווי הגובה ועוד. למניעת תופעה 
לגובה נתון קרקע מהגובה בציר.   המקסימאליזאת ניתן להגדיר לתוכנה את ההפרש 

תמיד נכון )או לפחות אינו חורג מתחומי   נקודת ההנחה היא כי הגובה בציר
הטופוגרפיה( ועל כן גובה זה משמש נקודת יחוס. אנו מורים לתוכנה מהו ההפרש 

בגובה שאנו מתירים לשבר קרקע בחתך. כל שבר קרקע החורג מהפרש  המקסימאלי
,  230.55נו ימחק מנתוני הקרקע. לדוגמא, אם הגובה בציר היזה )למעלה או למטה( י

או גבוה  227.55מ', כל נתון קרקע הנמוך מ  3 -של כ Max/Min intervalהזנו ואנו 
מחק מנתוני הקרקע של החתך. השפעת הנתון תתרחש רק לאחר י, י233.55מ 

. אם יש כבר נתוני קרקע קיימים  GetT allשנבצע דגימת קרקע על ידי כפתור 
אה, ונחזור על פעולת ליצי OKשאותם ברצוננו לשנות, נזין את ההפרש הרצוי, נלחץ 

 . GetT all -ה
 Include edges-  עקרון הפעולה של תוכנתCivilCAD 10  בדגימת נתוני קרקע

הוא כזה: התוכנה תדגום תמיד את נתוני המצב הקיים בציר, וכל שבר קרקע שיזוהה 
בתחום רוחב החתך, יוכנס גם הוא לטבלה. בנוסף לנתונים אלו, תדגום התוכנה את 

קיים בקצה החתך, משמאל ומימין, על פי הרוחב שהוגדר. על מנת  גובה המצב ה
.  GetT allשבסימון וחזור על פעולת  Vלבטל את הדגימה בקצוות, הסר את ה 

 התוכנה תדגום הנתונים מחדש, ללא דגימת הקצוות. 
 
 

 פעולות בחלון השרטוט:
 

מימינו בחלקו   לחלון השרטוט )החלון הראשי שעליו מופיע שרטוט החתך( שלושה כפתורים
הסברנו במהלך ההדרכה. נפרט את פעולת  DXF  -. את פעולת כפתור ההשמאלי העליון

 שני הכפתורים הנוספים: 
 

 :הדפסת החתכים על גבי מדפסת  



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  276עמוד 

 לחץ על כפתור המדפסת. 
קנ"מ  -Lengthקנ"מ לגובה ,  -Heightבחלון שיפתח הגדר קנ"מ להדפסה:    

 להמשך. OK(. לחץ 1:100/1:100נ"מ של )ק   100,  100לאורך. אנו נכניס 
בחלון שיפתח הגדר את סוג, גודל הדף, ושאר הפרמטרים הרצויים הקשורים   

 )או "אישור"( להמשך.  OKבמדפסת שברשותך. לחץ  
תתאים את השרטוט לגודל הדף במדפסת וקנה   Scale to fitבאופציה  Vסימון  

 חתית השרטוט.המידה שנתקבל בהתאם להתאמה יצויין על גבי הדף בת

 כעת בחר את החתכים שברצונך להדפיס. לבחירת כל החתכים לחץ כפתור   
 להדפסה. OKשבתחתית החלון. לחץ 

 
התוכנה תדפיס את החתכים באופן רציף, על פי שפת העבודה המוגרת במערכת. לשינוי 

 שפה בצע הפעולות הבאות:
 . Closeצא מחתכי הרוחב על ידי  
 .File -> Configurationהפעל  
 את השפה הרצויה.  Languageבחלון שיפתח בחר ליד הכיתוב  
 (.File -> Cross sectionsוחזור לחתכי הרוחב ) OKלחץ  
 חזור והדפס את החתכים כנלמד. 

 
 
 

 Zoom extents  –  :לשליטה בתצוגת החתך קיימות מספר פעולות 
 פסי הגלילה למטה ומשמאל לשרטוט. 
של השרטוט. לחיצה על  2הגדלה פי  -רטוטלחיצה על כפתור שמאלי בתחומי הש 

 . 2הקטנה פי  -כתור ימני

 מחזיר את הצפייה לכל אזור השרטוט. -(Zoom extents) כפתור   
 

 פעולות בחלון הטבלאות )החלון התחתון(: 
משמאל לכל טבלה, שמאלית וימנית, מופיעים מספר כפתורים המאפשרים פעולות על 

 טבלאות אלו: 

 טבלה בחתך הנוכחי. מחיקת נתוני כל ה  

 GetT  -  ייבוא נתוני המצב הקיים של החתך הנוכחי מתוך

, מייבא כפתור זה GetT all הטופוגרפיה הקיימת. להבדיל מכפתור  
את נתוני המצב הקיים של החתך הנוכחי בלבד. לפני ביצוע הפעולה  
תתקבל הודעת התרעה על מחיקת נתוני המצב הקיים הנוכחים. אשר  

 להמשך. את ההודעה 
 GetD-   ייבוא נתונים מתוך הטופוגרפיה המתוכננת. להבדיל מכפתור

 GetD all מייבא כפתור זה את נתוני המצב המתוכנן של החתך ,
הנוכחי בלבד. לפני ביצוע הפעולה תתקבל הודעת התרעה על מחיקת 
הנתונים הנוכחים. אשר את ההודעה להמשך. במידה ואנו נשתמש 

וכננת רצוי לבצע את הפעולות הבאות לפני בדגימת נתוני קרקע מת
 פעולות אלו: 

 .Options לחץ על כפתור   .1
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 Design: devote -40 toבחלון שיפתח סמן את האופציה:  .2
40 segments אופציה זו מאפשרת לתוכנה לדגום נתוני .

 הסגמנטים 81טופוגרפיה לתוך נתוני התכנון ע"י שימוש בכל 
רים לאפשרויות אחרות בטבלה )בד"כ חלק מהסגמנטים שמו

 כגון תעלות אוט' ,ברמות וכו'...(. 
 

 הוסברו במהלך הפרק(. Paste  -ו  Copy)פעולות כפתור 
 

 חישובי עבודות עפר בתעלות 
 

משסיימנו להגדיר את חתכי הרוחב של התעלה, יתכן ויהיה ברצוננו לדעת את כמויות  
נראה כיצד ניתן לחשב כמויות עבודות העפר )הנפחים( שבפרויקט על פי התכנון. בפרק זה, 

 אלו.
 

 על מנת לסגור החלון ולשמור הנתונים(.  Cancel)בסיום תכנון חתכי הרוחב, לחץ 
 

. מימין יפתח חלון Roads -> Earthworks . מסרגל התפריט הראשי הפעל: 1 
 חישובי הכמויות. 

 . התוכנה תבצע חישוב ותציג טבלת כמויות. התוכנה תחלק אתApply. לחץ 2 
 טבלת הכמויות לשני חלקים:

 טבלת חישובי נפחים  
 טבלת ריכוז שטחי חישוף.  

את גלול  השנייה. על מנת לצפות בטבלה השנייה)שתי הטבלאות מסודרות אחת אחרי 
 הדו"ח להמשכו על ידי פס הגלילה שמימינו(.

נה הטבלה שבה ירוכזו נפחי העבודה כמכפלה של שטחי  יטבלת חישובי הנפחים ה
רחק ביניהם. טבלת ריכוז שטחי חישוף מציגה את שטח הפנים של החתכים במ

 העבודה כמכפלה של אורכי החתכים בחפירה ומילוי במרחק ביניהם. 
קבע את הגדרות  שיפתח . לחץ על כפתור המדפסת שבתחתית הדו"ח. בחלון 3 

 המדפסת הרצויות והמשך להדפסת הטבלאות. 
נה שבוצע. אם ברצונך להחליף את הערה: שפת הטבלאות שתתקבל תלויה בסוג ההתק

 השפה שבה יופיעו הדוחות )מעברית לאנגלית לדוגמא(, בצע הפעולות הבאות:
 .File -> Configuration -הכנס ל 
”. לחץ על החץ הקטן שמימין  Languageבחלון שנפתח ליד הכיתוב "  

 לשדה השפה ובחר את השפה הרצויה ברשימה. 
 לסגירת החלון.  OKלחץ  
 כפי שמופיעים למעלה.  2-1עיפים חזור ובצע ס 

 
 בחלון הדו"ח על מנת לסגור אותו. Close. לחץ כפתור 4

התוכנה תבצע חישוב ותציג    Detailed Sections Report. לחץ כפתור 5
טבלה מפורטת של נתוני כל חתך וחתך. השתמש בפס הגלילה שמימין לדו"ח על 

פיעים לכל חתך וחתך נתוני  מנת לצפות בנתוני שאר החתכים. בדו"ח המפורט מו 
המרחק והגובה של כל מקטע בו )שים לב: הנתונים כוללים את אלו שהוזנו בטבלאות 
החתך, וכן נתונים מחושבים כדוגמת נתוני הדיקור(, שיפועי הדיקור, שטח החפירה 
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ושטח המילוי של החתך ואורך החתך בחפירה ובמילוי. להדפסת הדו"ח לחץ על 
 יתו.כפתור המדפסת שבתחת

 
של עקום הובלות מצטבר או לפי חתכים )אופציה זו  דיאגראמה. באפשרותך לקבל 6

 קיימת במחשב(. לחץ על כפתור:  Microsoft Excellאפשרית רק אם תוכנת 
excel mass haul diagram  :יפתח חלון המציג שתי אפשרויות 

 Accumulated mass haul diagram –  המציגה את כמויות   דיאגראמה
 חפירה/מילוי המצטברות לאורך הציר. ה

 Sections volumes diagram – המציגה את כמויות החפירה/מילוי   דיאגראמה
 לכל חתך.

בחלון של  הדיאגראמההתוכנה תציג את   OKבחר מאחת האפשרויות ולחץ 
EXCELL על מנת לשמור מסמך .EXCELL  חלון ה בתוךזה יש לבצע שמירה-
EXCELL . 

 
 
 בכפתור מימין.  Closeי עבודות העפר לחץ . לסיום חישוב7 

 פרוט פעולות חלון חישובי כמויות עבודות העפר 
 

 נעבור ונפרט את שאר הפעולות האפשריות בחלון עבודות העפר: 
על מנת לחשב כמויות לחלק מהחתכים בצע את  -חישוב כמויות לחלק מהחתכים. 1 

 הפעולות הבאות:
תכים שברצונך לראות את ברשימת החתכים שבחלון, סמן רק את הח 

 עבודות העפר שלהם. 
 שבתחתית הרשימה. Block"( ליד המילה Vסמן בוי )"  
 . הטבלה שתבנה תכלול רק את החתכים הנבחרים.Applyלחץ  

 
2 .Stripping depth  – אפשרות זו תופיע רק לאחר סימון האופציה    -עומק חישוף(

show stripping table ף של עבודות העפר, אם קיים  ( בשדה זה יוזן עומק החישו
כזה. עומק החישוף יוזן במטרים. התוכנה מחלקת את החישוף לפי עומק שונה  

הזן את העומק לשטח  .Cut arלשטח חפירה ועומק שונה לשטח מילוי. ליד שדה 
את העומק לשטח מילוי )אי הזנת ערך לשדה מסוים   .Fill arחפירה, וליד שדה 

לקבלת דו"ח חדש אשר יושפע   Apply(. לחץ משמעותה שאין חישוף בשטח זה
 מעומק החישוף שהוזן. 

ומציג את   Optionsכפתור זה פותח את חלון ה  -Optionsכפתור  .  3
  Earthworksחות. הגדרות אלו נמצאות תחת הכיתוב " ההגדרות השונות לגבי הדו

נה לאפשר  י)חישוב נפחים לשכבת מבנה הכביש(. מטרתו העיקרית של החלון ה
ליטה בתצוגת דוחות הריכוזים הן לנפחים והן לשטחי חישוף. בחלון מופיעה  ש

חות. בחלקו השמאלי של החלון  " רשימה של כל השדות המופיעות בטבלאות הדו
מרוכזים שדות טבלת ריכוזי הנפחים, ובחלקו הימני מרוכזים שדות טבלת ריכוזי  

ימת, הורד את סימן חות עמודה מסו" שטחי החישוף. אם ברצונך להשמיט מאחד הדו
. בהפקת הדו"ח הבאה, הוא יופיע ללא OK, שליד עמודה זו. לאישור לחץ )”Vהוי )" 

 העמודה שהושמטה. אפשרויות נוספות בחלון זה: 
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 Accuracy in section's data  –  רמת הדיוק של הערכים המוצגים בדו"ח )מספר
 הספרות אחרי הנקודה העשרונית(.

 Stripping length – חישוב אורך החישוף  שיטת 
 Horizontal –  יהיה בהתאם לאורך התוואי האופקי.  החישוףחישוב אורך 
 Inclined  –  .האורך האמיתי של החישוף במקביל לתכנון 

-וה  design-ניתן לחשב את כמויות העפר בין טבלאות ה – שכבות החישוב 
existing  או בין טבלות ה-design וה-structure . 

 Display after stripping areas in volumes table –  הצגת חישוב הנפחים
 . לאחר חישוב החישוף

 
 

 הצגת חתך האורך של רומי גדות התעלה
 

מאפשרת הצגה של רומי גדות התעלה על גבי חתך האורך. בסיום   CivilCAD 10תוכנת 
 הגדרת חתכי הרוחב, הכנס לתכנון חתך האורך: 

Roads -> Vertical alignmentיפתח חלון חתך האורך של התעלה. לחץ על  . לפניך

התוכנה תוסיף לחתך האורך של המצב הקיים   .שבחלון הימני   Get edges -כפתור ה
והמתוכנן, גם את חתכי האורך של גדות התעלה משמאל ומימין. נתוני הגובה של הגדות  

 יתווספו בשורות חדשות שייפתחו בטבלה התחתונה.
 
 

 לאורכה.  קואורדינטותהעלה וחישובי התוואי הגיאומטרי של הת
 

מאפשרת חישובים גיאומטריים לאורך הציר מצורות שונות, ביניהם   CivilCAD 10תוכנת 
ברץ וניצב לאורך הציר, דו"ח נתונים גיאומטריים של הציר ועוד. את  קואורדינטותחישובי 

ל הגדרה של רוב הפעולות בחלון זה מיד לאחר הגדרת התוואי האופקי של הציר, וללא כ
של נקודות  קואורדינטותהחתכי רוחב. אם זאת, כפי שנראה, קיימת אפשרות לחשב את 

 הדיקור בחתכים ולכך חייבת התוכנה שבפרויקט המחושב יוגדרו חתכי רוחב. 
.  Roads -> Coordinates computations  -להפעלת חישובים גיאומטריים הכנס  ל

 :בחלון שיפתח קיימות האפשרויות הבאות
  -חישוב נקודה בודדה -לאורך הציר או בניצב לו קואורדינטותחישובי 
 -נך נמצא ביה Geom -ל Coordוודא שבאפשרויות הבחירה המופיעות בחלון בין  

Coord . 
הכנס את המרחק הרץ )במטרים(, של הנקודה שברצונך לחשב.  Station -בשדה ה 

 להמשך. Enter. לחץ 20לחישוב נקודה בחתך השני לדוגמה, הכנס 
, הכנס את היסט הנקודה המחושבת מהציר )בניצב לו(. לחישוב Offset -בשדה ה 

או השאר את השדה ריק. לחישוב נקודה משמאל לציר הזן  0נקודה בציר עצמו הזן 
 להמשך. Enterמרחק שלילי ולימינו מרחק חיובי. לחץ  

יכול , הכנס את שם הנקודה החדשה שתחושב. שם הנקודה New pointבשדה  
 להיות מספר, או שם אלפאנומרי הכולל אותיות. 

הרצויה,  הקואורדינאטה. התוכנה תחשב את Applyאו על כפתור  Enterלחץ על  
 שבחלון התחתון. קואורדינטותהותוסיף אותה לרשימת 
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  Designed coordinates -המחושבת לרשימת ה הקואורדינאטהתתווסף כברירת מחדל, 
או   Topography ->Coordinatesבצע, כאמור, על ידי בחירת  )דפדוף בין הרשימות מת

Design -> Coordinates  בסרגל התפריט הראשי(. ניתן להגדיר לתוכנה לאיזו רשימה
 תבצע את חישוביה. לעשות כן, בצע את הפעולות הבאות:

 
. מימין  Geometry -> Geometry parametersמסרגל התפריט הראשי הפעל:  

 יתפח חלון. 
לחישוב הנתונים לטבלה הקיימת או   Topo points onlyן שנפתח בחר בחלו 

Designed points only.לחישובם לטבלה המתוכננת , 
 לאישור. OKלחץ  

)על מנת לקבוע הגדרה זו לכל הפרויקטים של התוכנה, יש לבצע את סדר הפעולות הנ"ל  
 "(.Noname  -ו  Prototype. על כך ראה בהרחבה בפרק "הפרויקטים Prototypeבפרויקט 

 
 -חישוב רצף נקודות -לאורך הציר או בניצב לו קואורדינטותחישובי 

נך נמצא יה Geom -ל Coordוודא שבאפשרויות הבחירה המופיעות בחלון בין  
 . Coord -ב
, הכנס את המרחק הרץ של הנקודה הראשונה שברצונך לחשב Fromבשדה  

 .0. לתחילת הציר הכנס Enterולחץ 
כנס את המרחק הרץ של הנקודה האחרונה שברצונך לחשב ולחץ , הToבשדה  

Enter . 
. על  Roads lengthהתוכנה חישבה את אורך הציר והציגה אותו ליד השדה  

. לחץ To -מנת לחשב נקודות לאורך כל הציר הכנס את האורך ליד בשדה ה
Enter .להמשך 

יצב לו(. , הכנס את היסט הנקודות המחושבות מהציר )בנOffset -בשדה ה 
או השאר את השדה ריק. לחישוב נקודה   0לחישוב נקודות הציר עצמו הזן 

 להמשך.  Enterמשמאל לציר הזן מרחק שלילי ולימינו מרחק חיובי. לחץ 
 

באפשרותך לחשב מספר נקודות בהיסטים שונים בפעולה אחת. להכנסת מספר היסטים 
שב את נקודות החתכים בכביש הפרד ברווח בין היסט להיסט. לדוגמא, אם ברצוננו לח

 5 -בנקודת הציר עצמו, ובנקודות משמאל ומימין בהיסט של כ מעונייניםכשלכל חתך אנו 
 ".  5 0 5-את הנתון "  Offsetמטרים, אזי נזין לשדה 

, הכנס את מספר הנקודה הראשונה שתיווצר. התוכנה New point -בשדה ה 
 תמספר את הנקודות ממספר זה והלאה.

 
בדים עם רצף של נקודות )להבדיל מחישוב נקודה בודדה(, על שם הנקודה המוזן  כאשר עו
להיות מספר וזאת בכדי שהתוכנה תוכל למספר הנקודות בסדר עולה.  New pointבשדה 

. אם Prefixיתכן וברצוננו לתת לנקודות שם תחילי מאפיין כלשהו. לשם כך קיים שדה 
 . CLאת הנתון:  Prefix -עצמו, נכניס בשדה ה ברצוננו, לדוגמא, לחשב את נקודות הציר

. התוכנה תחשב את הנקודות ותוסיף אותן לרשימת Applyאו  Enterלחץ  
אזי שמות הנקודות יהיו עם   Prefixשבחלון התחתון. אם הוכנס  קואורדינטותה

הנמצא בחלקו   התחילית המתאימה. לאחר סיום החישוב לחץ על כפתור 
הכלים הראשי( על מנת לקבל את הנקודות על גבי   העליון של המסך )בסרגל

 השרטוט.
הרצוי, נוכל  קואורדינטותההחישובים, וברשימה התחתונה מופיע מאגר  שסיימתלאחר 

בקובץ  קואורדינטותאו להדפיסה )הרחבה על שמירת  ASCIIלשמור את הרשימה בקובץ 
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Text  הקשורים לרשימה כפתורי פעולה  -קואורדינטותהאו הדפסתן ראה בפרק "מאגר
                                                                         ומשפיעים עליה"(.

  
אופציה זו מאפשרת חישוב  -של נקודות הדיקור לאורך הציר קואורדינטותחישובי  .1

של נקודות הדיקור של החתכים לאורך הציר, משמאלו ומימינו. שימוש  קואורדינטות
זו, מחייב כמובן הגדרת חתכי רוחב מלבד הגדרת התוואי האופקי של הציר.   בפעולה

 לביצוע בצע הפעולות הבאות:

, לחץ על כפתור חישוב נקודות הדיקור שבחלון הימני   
 לפניך יפתח חלון. 

 בחלון שיפתח, קיימות האפשרויות הבאות: 
כברירת מחדל  -בחירה במצב שלו ברצונך לחשב את נקודות הדיקור 

. אם ברצונך  Designed G.L -בת התוכנה את הדיקורים לנקודות המחש
(, העבר בעזרת החץ הקטן Structureלחשב הדיקורים לשכבת פני המבנה )

)דוגמא למקרה שבו  Structure–ל   Designed G.L -שבתיבת הבחירה מ
יכול להיות במצב שבו בתכנון   Strucutre -ברצונך לחשב נקודות דיקור ה

 בלבד, ללא גובה עבודות העפר(.  Structure -ובה ההכנסת את ג
. אם ברצוננו הכנסת "מרחק ביטחון" לנקודות הדיקור משמאל ומימין 

שהתוכנה תחשב את נקודות הדיקור בהיסט מסוים ממקומן האמיתי, נכניס 
נכניס את המרחק לדיקור שמאל,  Leftמרחק זה בשדות המתאימים: לשדה 

ור ימין. המרחק שיחושב יהיה תמיד מהציר  את המרחק לדיק Rightולשדה 
 "(. -החוצה )המרחקים תמיד יוכנסו כערך אבסולוטי ללא סימן " 

. אם ברצונך שלשמות הנקודות שייווצרו( לנקודות Prefixהכנסת תחילית ) 
, יתווסף טקסט כלשהו בהתחלה )נניח שם הכביש אלו הן שייכות(, שייווצרו 

 פיע. שמו Prefix  -הכנס טקסט זה בשדה ה
לביצוע החישוב. התוכנה תחשב  Applyלאחר שהגדרת את הרצוי בחלון, לחץ  

 Designedאת הנקודות בהתאם להגדרות והן יתווספו ברשימת ה 
coordinates  שבתחתית. שמות הנקודות יבחרו בהתאם לשם החתך שלו הן

נה משמאל או מימין לחתך. בנוסף,  ילציון שהנקודה ה Rאו  Lשייכות בתוספת 
 (, היא תופיע בתחילת שמות כל הנקודות.Prefixם הוכנסה תחילית )א

 
על מנת לקבל את רשימת הנתונים   -הגיאומטריים של הציר  חישוב הנתונים .2

(,  Coord -ל Geom)באפשרויות הבחירה המופיעות בין  Geomהגיאומטריים בחר ב  

ובהם של הציר  יפתח לפניך יופיע הנתונים הגיאומטריים יח ש" . בדוולחץ על כפתור 
ונתוני הקשתות. להדפסת הנתונים לחץ כל כפתור  IP -של ה קואורדינטותה נתוני

 ח." המדפסת שבתחתית חלון הדו
ח הנתונים הגיאומטריים ניתן למקם על גבי השרטוט. על מנת לעשות כן, חשב " את דו

 ח כפי שזה עתה הוסבר ובצע הפעולות הבאות:" תחילה את הדו

 .ט  ח על גבי השרטו" הדו לחץ על כפתור מיקום 
 עבור לאזור השרטוט ומקם את הטבלה במקום הרצוי: 
 :Locate table, מופיע הכיתוב " AutoCAD/ZWCAD -בשורת הפקודות של ה 

Pick Location/Set/(Esc)nd:   מקם את הסמן במקום בו ברצונך שתופיע ."
  וופיע הטבלה. לחץ עם העכבר לקבלת גבולות המסגרת של הטבלה. הגבולות י

מחק לאחר שתסיים למקם את הטבלה. באפשרותך לבחון תיבשכבה זמנית, ש
מספר אופציות למיקום הטבלה, זאת אומרת לקבל את המסגרת מספר פעמים לא 
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 -בשורת ה Sשתגיע למיקום הסופי. לאחר שבחרת במיקום הסופי, לחץ עד מוגבל, 
AutoCAD/ZWCADו ,-  Enterבלה תמוקם על פי  מחקו, והטי. הגבולות הזמניים י
 בחירתך האחרונה.

  Options -גודל הכתב של הטבלה ניתן לשינוי. על מנת לשנותו לחץ על כפתור ה 

. בחלון שנפתח בחר את גדול הטקסט הרצוי בעזרת החץ הקטן  י שבחלון הימנ
. לשינוי הטבלה על גבי השרטוט יהיה OK. לאחר הבחירה לחץ Scaleשליד השדה 

 כפי המתואר למעלה. עליך לחזור ולמקמה 
למעלה, מופיעות דרכים שונות לחישובי   1-3בסעיפים  -חות חישובים" קבלת דו 

לאורך הציר. לכל חישוב שכזה ניתן לקבל את טבלת החישובים שבוצעו   קואורדינטות
  -ל Geomבאפשרויות הבחירה )בין  Coordח בחר " ח מסודר. לקבלת הדו" בדו

Coordח החישובים יתקבל לפניך.. דו  (, ולחץ על כפתור הדוח 
 Fileחות. להחלפה בין שפות הפעל  " הערה: ניתן לשלוט בשפה שבה מתקבלים הדו 

-> Configurationבחלון שנפתח מופיע שדה ה ,- Language  העבר לשפה .
 ח שוב. " והצג הדו  קואורדינטותה. חזור לחלון חישוב OKהרצויה, ולחץ 

 

 , תמחק את כל השדות שבחלון.ר  ולחיצה על כפת - מחיקת כל השדות בחלון  .3
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 תכנון מאגרים  :18פרק 
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 תכנון מאגרים 
 

 פרק "תכנון מאגרים" כולל את החלקים הבאים:
 

 תכנון תוואי הסוללה ההיקפית. 
 הגדרת חתך הרוחב של הסוללה עד תחתית המאגר.  
 יצירת מודל המאגר )כולל יצירת התחתית(. 
 איזון עבודות עפר.  
 המאגר. קבלת נפח איגום של 
 שינוי תוואי הסוללה ההיקפית. 
 יצירת שיפוע בתחתית המאגר. 
לביצוע  תוכניות  )  -הוצאת  יתוד  תוכנית  לאורך Scraper planeשרטוט  וחתכים   ,)

 המאגר.
 תכנון מאגר המורכב מסכר בלבד. 

 
מהווה כלי חזק ויעיל לתכנון מאגרים ובריכות. בעזרת התוכנה נוכל  CivilCAD 10תוכנת 

עד קבלת איזון עבודות עפר. כמו כן, תציג   אופטימאלית תוואי המאגר ולקבל גובה להגדיר א
לנו התוכנה את נפח האיגום של המאגר. בסיום התכנון נראה כיצד ניתן לקבל תוכנית 

 עבודות יתדות לעבודות עפר, וחתכים לאורך המאגר. 
מאגר המורכב (, ולא מDamהחלק האחרון של הפרק ידון בתכנון מאגר המורכב מסכר )

 (.Pondמסוללה היקפית מלאה )
 

 תכנון תוואי הסוללה ההיקפית
 

כשלב מקדים בתכנון מאגרים, יש להכין את רקע המצב הקיים )לפרוט על הכנת רקע המצב 
 הכנת רקע לעבודה"(.  -הקיים ראה פרק "תכנון כבישים

הסוללה יבוצע  בהמשך יש להגדיר את תוואי הסוללה ההיקפית של המאגר. הגדרת תוואי 
 (, ורדיוסים: IPכמו בתכנון כבישים או תעלות בעזרת נקודות תפנית )

 
. מימין יפתח חלון.  Roads -> Horizontal Alignmentמסרגל התפריט הראשי הפעל: 

( התחלפה, ובמקום Topography coordinatesשים לב כי הרשימה בחלון התחתון )
דשה, ריקה, של הנקודות המתוכננות רשימה חהופיעה רשימת הנקודות הקיימות,  

(Designed coordinates.) 
 

המותקן במחיצת  Sample7רקע נוח לתרגול הנושא המוסבר במהלך הפרק יהיה פרויקט  
Samples  המותקנת במחיצת ההתקנה של התוכנה. ניתן לפתוח פרויקט חדש ולקלוט את

 . Samples7.Tco -של הפרויקט קואורדינטותהקובץ 
 

 של הציר: IP -ני ההזנת נתו .1
הגדרת התוואי האופקי של הסוללה ההיקפית, יבוצע על ידי הגדרת קו מרכז 

( אופקיות ורדיוסים )אם  IPהסוללה. כאמור תוואי זו יוגדר על ידי נקודות תפנית )
 דרוש(:

 של הציר. אנו נבחן שתי שיטות:  IP -קיימות מספר שיטות להזנת נתוני ה
 :בלבד(  ZWCAD/AutoCAD: )למשתמשי גרסת שיטה א' -
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(, שיהווה את 2D Polyline) Polyline, העבר AutoCAD/ZWCAD -ב 
 (. Closedלהיות קו סגור ) Polyline -התוואי האופקי של הציר. על ה

 ,Unused, Pickבטבלה מימין )הטבלה ובה הרשימה  Selectבחר  
Locate, Select .) 

.  Enterטט, ולחץ המשור  Polyline –עבור לאזור השרטוט, בחר את ה  
 -( בVertexשל הציר. כל שבר ) IP -הטבלה בחלון מימין תתמלא ברשימת ה

Polylineיקבע כ ,- IP  של הציר, ובחלון התחתון תופיע רשימת
 שלהן. קואורדינטותה

 
 של הציר, לדוגמא:  IP -:  בחלון התחתון הקלד את רשימת השיטה ב' -

 

1000 1000 IP1 

1000 1200 IP2 

1000 1200 IP3 

1000 1000 IP4 

 
       

כפי שהוקלדו ברשימה התחתונה. את   IP -בטבלה מימין הקלד את שמות ה 
בטבלה. בדוגמא שלנו נזין את  IP -נקליד כמובן תחת הכיתוב IP -ה

 הרשימה בצורה הבאה: 
 

      
 

בחלון החדש שיפתח.  OKבחלון מימין, ושוב  Applyלאחר הגדרת הציר לחץ על 
 . IP -תשרטט את הציר שהוגדר, עם נקודות ההתוכנה 
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 הגדרת נקודת ההתחלה והסוף של הסוללה:  .2
נקודת תפנית,  אינה יכולה להיותנקודת ההתחלה והסוף של ציר סוללה ההיקפית 

זאת כיוון שיתכן ונרצה להגדיר רדיוסים גם בנקודות אלו. לשם כך אנו נוסיף נקודה 
הראשון לאחרון, שתשמש    IP -הישר המחבר בין ה כלשהי )שרירותית(, על הקו

כנקודת ההתחלה והסוף של הציר. הוספת נקודה כזאת יכולה להתבצע בשתי  
 דרכים: 
 דרך א':

, הוסף  IP-התחתונה, בהמשך לשאר ה  קואורדינטותהברשימת  
את הנקודה הרצויה. בדוגמא של שיטה ב' שזה עתה הוצגה,  

, והיא תהיה:    1000רוא לה ניתן להוסיף נקודה כזאת, שנוכל לק
,  X=1000 בקואורדינאטה, זאת אומרת     1050   1000   1000

Y=1050 . 

 שבסרגל הכלים הראשי. לחץ על כפתור   
החדש בהתחלה ובסוף   IP -בטבלה מימין, הקלד את שמות ה 

,  Enterהרשימה. לעשות כן עמוד על הנקודה הראשונה, לחץ 
ש )בדוגמא להלן החד IP -ובשורה שנפתחה הקלד את ה

, עלה  Enter(. לאחר מכן עמוד על השורה האחרונה, לחץ 1000
)גם   IPעם החץ מעלה לשורה החדשה והוסף גם כאן את אותו 

 (. בדוגמא שהובאה תיראה הרשימה מימין כך:1000כן 
  

            
 
 

בחלון שיפתח.   Applyבחלון מימין, ושוב   Applyלחץ על כפתור  
 ית יתעדכן בהתאם לשינוי שהוכנס.ציר הסוללה ההיקפ

 דרך ב':
ברשימת האפשרויות שבחלון התחתון )שים לב:  Pickלחץ על  

ולא בחלון מימין(.    Designed coordinates -בחלון התחתון
תופיע האפשרות  AutoCAD/ZWCAD -בשורת הפקודות של ה
Pick point <1000>: . 

 . Nearest -ל AutoCAD/ZWCADשל  Object snapבחר ב  
  IP  -עבור לשרטוט ובחר נקודה על גבי הקו המחבר בין ה 

האחרון שבציר הסוללה. ברשימת הנקודות   IP -הראשון וה
. עבור  1000שבחלון התחתון תופיע נקודה חדשה בשם 

 לרשימה, בחר את הנקודה ומחק לה את הגובה.

 שבסרגל הכלים הראשי. לחץ על כפתור   
החדש בהתחלה ובסוף   IP -בטבלה מימין, הקלד את שמות ה 

,  Enterהרשימה. לעשות כן עמוד על הנקודה הראשונה, לחץ 
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החדש )בדוגמא להלן  IP -ובשורה שנפתחה הקלד את ה
, עלה  Enter(. לאחר מכן עמוד על השורה האחרונה, לחץ 1000

)גם   IPעם החץ מעלה לשורה החדשה והוסף גם כאן את אותו 
 (.  1000כן 

בחלון שיפתח. ציר   OKן מימין, ושוב  בחלו Applyלחץ על כפתור  
 הסוללה ההיקפית יתעדכן בהתאם לשינוי שהוכנס. 

 
 הזנת הרדיוסים של הציר: .3

. אם  IP -השלב הבא בהגדרת תוואי הסוללה, יהיה הגדרת הרדיוסים בנקודות ה
 . 0 -לא נגדיר רדיוסים תתייחס התוכנה לרדיוסים כ

 IP -י. לבטבלה מימין, הזן את הרדיוס הרצו IPמול כל  
 הראשון והאחרון לא נגדיר רדיוס. 

 & Layout -מימין. לפניך יפתח חלון Applyלחץ על כפתור  
contours. 

שוב )לא נפרט כאן את השימוש  OKבחלון שיפתח לחץ  
בחלון הנ"ל. אנו נחזור לחלון זה בהמשך ואז נפרט על 

 השימוש בו(.
, יופיעו  IPע בשכבות נפרדות. ליד כל התוכנה תיצור את התוואי האופקי של הציר, אשר יופי 

 נתוני הקשת. -שלה, וליד כל קשת קואורדינטותה
 

 . Closeבסיום הגדרת התוואי האופקי לחץ  .4
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 פירוט פעולות נוספות בחלון: 
 

 . Disקריאת נתוני הציר מתוך קובץ  - כפתור פתיחת קובץ  .1

 .התרעה. לפני ביצוע הפעולה תבוא מחיקת כל נתוני הציר  .2

, ובחלון  Applyניתן ללחוץ  IP -. לאחר מחיקת הבודד בציר IPמחיקת   .3
 ע"מ לקבל את תוואי הציר החדש.  OKשנפתח שוב 

תפתח את חלון   Options -לחיצה על כפתור ה - Optionsכפתור   .4
 ההגדרות הראשי. בחלון ניתן לקבוע:

 : Scale -שינוי קנה המידה של גודל הכיתוב      
ודל הכיתוב בנתוני הציר בחר את הקנ"מ הרצוי מתוך הרשימה. על מנת לשנות את ג

לעשות כן לחץ על כפתור החץ הקטן ליד המספר הנתון  בתיבה ובחר את הגודל  
לסגירת  OKגודל הפונט יהיה בהתאם לקנה המידה(. לאחר הבחירה לחץ  ( הרצוי

  Apply -החלון. בכדי לשנות את השרטוט , יהיה עליך ללחוץ שוב על כפתור ה
 בחלון שיפתח.  OKשמימין, ושוב 

5. Pick, Locate   
פית של הציר, בנוסף על פעולת א מאפשרות הגדרה גר  Locate -וה Pick -פעולות ה

 שנלמדה בתחילת הפרק. נראה את השימוש בפעולות אלו:  Select -ה
 : Pick -שימוש ב

 ברשימה. Pickבחר  
ן הציר,  עבור לאזור השרטוט, והחל בסימון הציר. בסיום סימו  

 .Enter  -ו Setלחץ 
 המשך במתן רדיוסים ושאר שלבי תכנון הכביש. 

 :Locate -שימוש ב
 ברשימה.  Locateבחר  
עבור לאזור השרטוט, הצבע על הנקודות בשרטוט אשר יהוו   

, AutoCAD/ZWCAD -נך משתמש בי. אם הIP -את ה
באופן   Node -להפך  Object Snap -תוכל לשים לב ש

 אוטו'. 
 תן רדיוסים ושאר שלבי תכנון הסוללה של המאגר.המשך במ 

   Locateיוצרת נקודות חדשות, בעוד  Pickנו שפעולת יה Locate -ו  Pickההבדל העיקרי בין 
הוא בכך שאינה   Locateבוחרת נקודות שקיימות במאגר הנקודות. יתרונה של פקודת 

 "מכבידה" על הרשימה. 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  289עמוד 

 
 ד תחתית המאגר הגדרת חתך הרוחב של הסוללה ההיקפית ע

  
בפרק הקודם הגדרנו את תוואי הסוללה ההיקפית של המאגר. כעת נגדיר את חתך הרוחב  

 של הסוללה:
 

. לפניך יפתח חלון חתכי  Roads -> Cross sectionsמסרגל התפריט הראשי הפעל: 
 הרוחב.

 חלון חתכי הרוחב מחולק לשלושה חלקים:

וט החתך. שמו של החתך הנוכחי האזור המרכזי שבו יופיע שרט -אזור השרטוט 
 הנמצא בעבודה יופיע בכותרת מעל השרטוט.

 החלון הימני.  -טבלת רשימת חתכי הרוחב 
הטבלאות בחלקו התחתון של   -טבלאות נתוני המצב הקיים והמתוכנן לכל חתך וחתך 

 -Designed G.Lנתוני המצב הקיים בטבלה השמאלית,  – Existing G.Lהמסך: 
 נן בטבלה הימנית.נתוני המצב המתוכ

לפניך יפתח חלון הגדרת חתכי   -(Define sections) לחץ על הכפתור  .1
 הרוחב:

 בחלון הגדר את הנתונים הבאים:     
 Start at station-  ואנו לא נשנה   0מרחק רץ לחתך הראשון. ברירת המחדל תהיה

 אותה.
 End at station- אורכו של   מרחק רץ לחתך האחרון. ברירת המחדל תהיה על פי

הציר כפי שיחושב על ידי התוכנה )אורך זה מופיע מיד עם פתיחת חלון חתכי  
בפריסת חתכים   מעוניינים(, ומכיוון שאנו Roads length -הרוחב, בחלון מימין

 לאורך כל הסוללה, גם נתון זה לא נשנה.
 Distance between sections- נה יהמרחק בין חתכי הרוחב. ברירת המחדל ה

 '. מ 20
 Name of first section-  שמו של החתך הראשון )מספרו(. התוכנה תמספר את

המצוין בחלון, נסביר את שני מצבי    Format-שאר החתכים בסדר עולה בהתאם ל
 : Formatה 

 Format1   , שמות החתכים כפי שהם מופיעים  תצוגה של
 ברשימת החתכים.

 Format2     , דוגמא: אם  שם חתך:  מרחק רץ+קמ ,לתצוגה של
, התוכנה תציג את החתכים בצורה  KM :0נשאיר את הערך בשדה 

 ,....  040+0, 020+0, 000+0הבאה: 
 

לבניית החתכים. רשימת החתכים   OKלאחר הגדרת הפרמטרים הרצויים, לחץ 
(  Nameתופיע בטבלה מימין בהתאם להגדרות שנבחרו, ולכל חתך יופיע שם )

 (. Stationומרחק רץ )
מלאה התוכנה  הייתהי הרוחב כבר היו מוגדרים וטבלת שמות החתכים במידה וחתכ

 Overwrite previous section תציג חלון הודעה אשר מתריע על חתך קיים 
named  :ושם החתך הראשון ,כמו כן יוצגו האפשרויות הבאות 
 

 Rename section  – .התוכנה תשנה רק את שם החתך לפי ההגדרות החדשות 
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 Overwrite section –  התוכנה תמחק את נתוני החתך ותשנה את שמו לפי
 ההגדרות החדשות.

 Leave existing section – .התוכנה לא תבצע אף שינוי בחתך זה 
 

החלון יציג את אותם אפשרויות לחתך הבא, על מנת   OKע"י לחיצה על 
 . Ok to allלבצע את האפשרות הנבחרת לכל החתכים יש ללחוץ על כפתור 

 

לפניך יפתח חלון הגדרת רוחב   Options  -כפתור ה  לחץ על .2
 החתכים:

הגדר את רוחב החתך לעבודה. הכוונה היא לרוחב רצועת הקרקע   .3
שתדגום התוכנה למצב הקיים מתוך הטופוגרפיה. אנו נגדיר מרחק  

ו יגדירו את רוחב רצועת  ימהציר לשמאל ומרחק מהציר לימין שיחד
)ברירת   Left -נגדיר בשדה ההקרקע. את קצהו השמאלי של החתך 

)ברירת   Right -מ'(, ואת קצהו הימני נגדיר בשדה ה 20-המחדל 
נו מספר שלילי ומרחק  ימ'(, כאשר מרחק משמאל לציר ה 20המחדל 
חיובי. בתכנון מאגרים בעלי סוללה היקפית גדולה מספר נו ימימין ה

נצטרך רצועת קרקע גדולה מברירת המחדל )בעיקר לצד פנים  
 צד ימין(, ועל כן נשנה את הנתונים המופיעים בשדות.  -גרהמא

 -בתכנון מאגרים אנו נגדיר את גבהי החתכים כרומים אבסולוטיים .4
 . dHולא על  Elevationוודא שמצב העבודה עומד על 

. אופציה זו מגדירה את אופן  Design  -ל Earthwork -העבר מ .5
ל הגדרת פית של החתך. לתוכנה שתי אפשרויות שאההצגה הגר

, וחתך להצגת חתכים Earthworkחתך: חתך להצגת עבודות עפר 
. השוני בתצוגה יבוא ליידי ביטויי הן בצורת  Designמתוכננים 

החתכים בחלון השרטוט, הן בהדפסתם דרך התוכנה למדפסת, והן  
. ההבדל AutoCAD/ZWCADביצירת קובץ חתכים על גבי גיליון 
טבלת הנתונים. בחתך לצורכי תכנון  העיקרי בין שתי התצוגות הינו ב

מופיע טבלת נתוני הקרקע הקיימת בתחתית, ונתוני התכנון 
ממוקמים על גבי החתך. בחתכים לצורכי עבודות עפר יופיע כל  

הנתונים בטבלה התחתונה, וכן יופיעו שתי שורות נוספות בטבלה 
המציגות את אופן חישוב שטח החתך בחפירה ובמילוי, תוך כדי  

 למקטעים.  חלוקה
 

)כפתור כחול מימין(. בחלון שיפתח    GetT all לחץ על כפתור   .6
שהיא עומדת לשנות את נתוני המצב   תתריע. התוכנה OKלחץ 

  OKמחקו. לחץ יהקיים לנתונים חדשים וכי הנתונים הקודמים י 
להמשך. התוכנה תעבור לאורך הציר ותדגום את נתוני המצב הקיים  

 רו. לאורכו, לפי החתכים שהוגד
פעולת דגימת נתוני המצב הקיים תלויה במספר נקודות המדידה שבפרויקט,  

רציפות שבו ובמספר חתכי הרוחב שהוגדרו. בפרויקטים גדולים  ה-מספר קווי אי
אינה מוגבלת בגודל  CivilCAD 10יתכן ופעולה זאת תיקח זמן מה. תוכנת 

מועט, יתכן   הפרויקט ובאורך הציר, אך במחשבים איטיים או בעלי זיכרון
 ופעולתה תיקח זמן רב ולעיתים אף "תיתקע".
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בסיום קריאת נתוני המצב הקיים יופיע החתך הראשון בחלון השרטוט ונתוני  
המצב הקיים יופיעו בטבלה משמאל למטה. ניתן לעבור בין החתכים על ידי  

בחר יופיע באופן אוטומטי על יהצבעה על החתך הרצוי בטבלה מימין. כל חתך שי
נך נמצא יי השרטוט, ונתוניו יופיע בטבלאות למטה. להמשך ההדרכה וודא שהגב

 בחתך הראשון.
 

נסביר בקצרה את מבנה טבלת התכנון. כל שורה בטבלה מייצגת מקטע. המקטעים  
  5מקטעים אפשריים לכל חתך(. בטבלה מופיעות  81 -)סה"כ כ 40+ועד    40- -ממוספרים מ

רת(. לצורך ההסבר, נמספר עמודות אלה בסדר עולה  עמודות )השמאלית ביותר ללא כות
 : 1נה מספר ימשמאל לימין כך שהעמודה השמאלית ביותר ה

 
 

בעמודה זאת מופיע המספר הסידורי של המקטע.  -1עמודה מספר  .7
מייצג מרחק כלשהו. מקטעים משמאל לציר ייוצגו   אינומספר זה 

 י. במספר שלילי ומספרים מימין לציר ייוצגו במספר חיוב 
עמודה זאת מייצגת את המרחק של  -(Offset) 2עמודה מספר  .8

המקטע מהציר. מרחק משמאל לציר יוכנס כשלילי ומספר מימין  
יוכנס כחיובי. למרחק מהציר שתי אופציות: מרחק אבסולוטי או  

(,  24, כפי שמודגם כאן )ראה סעיף dHמרחק יחסי. בעבודה עם 
נו  ישהמרחק שיוכנס ה יוכנסו הנתונים כמרחק יחסי, זאת אומרת

למעשה אורך המקטע ולא מרחק אבסולוטי מהציר. בעבודה עם  
Elevation.יוכנסו נתונים אלו כמרחק אבסולוטי , 

 הגובה האבסולוטי של קצה המקטע. -(Elevation) 3עמודה מספר  .9
בעמודה זה ניתן להכניס את שיפוע  –( %Slope) 4עמודה מספר  .10

אם הוזן תוך שני הנתונים הנ"ל: המקטע. באפשרותך להכניס אחד מ
dH  תחשב את שיפוע המקטע באופן  התוכנה , 3בעמודה מספר

בעמודה   שיפועאם הוזן , ולעומת זאת, 4אוטומטי ותזינו בעמודה 
 . 3ותכניסו בעמודה  dH -ה את התוכנה תחשב, 4מספר 

 
 לפני שנמשיך נסביר כעת מספר פעולות עריכה שניתן לבצע בטבלה:

 
 בשדה מסוים תגרום למחיקת השדה הנ"ל.  Delלחיצה על  .11
 )חץ אחורה(, תעבוד כרגיל.  Backspaceלחיצה על  .12
למחיקת שורה שלמה או צמצום שורות, עמוד על העמודה  .13

.  Del( במקטע הרצוי, ולחץ 1השמאלית ביותר )עמודה מספר 
 התוכנה תימחק את המקטע ותצמצם את השורות. 

י, לשאר חתכי הרוחב.  ניתן להעתיק מקטע, מחתך הרוחב הנוכח .14
לביצוע העתקה עמוד על המקטע הרצוי ולחץ כפתור ימני. בטבלה 

שתפתח סמן את החתכים אליהם יועתקו נתוני המקטע )לבחירת כל 
. התוכנה תעתיק את OKבתחתית( ולחץ  Allהחתכים לחץ כפתור 

 נתוני המקטע לכל החתכים שנבחרו. 
ם כאן תכנון שילווה  החל בהזנת נתוני התכנון בטבלה. אנו נדגי .15

בהסבר מפורט. נתבונן בגובה המצב הקיים שבציר הסוללה אשר  
, עמודת הגובה Existing G.L -חושב לחתך הנוכחי )ראה טבלת ה

Elevation  נניח ולצורך הדוגמא הגובה הנ"ל  0של מקטע מספר .)
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. אנו נגדיר סוללה היקפית, אשר גובהה בחתך הנוכחי  26.55נו יה
ובה זה יקבע כנקודת מוצא לתחילת התכנון וישתנה מ' )ג 4יהיה 

  -נו כיבהמשך התכנון(. עוד נגדיר כי רוחב דרך המשא של הסוללה ה
, ועומק  1:4נו  י, שיפוע הפנים ה1:3נו י מ', שיפוע חוץ המאגר ה 5

 מ'. 6 -המאגר הוא כ
 

 , הזן את הנתונים הבאים:Designed G.L -בטבלת ה
 

  
 

)את כל שאר   3)ראה ראש הטבלה(, הכנס את הנתון  :Slp. Leftתוב  , ליד הכי:Fill 1בשדה 
 (. 0, השאר ריקים/בערך Slp. Rightשדות השיפועים, כולל 

 
  -, מציינים את רוחב דרך המשא של הסוללה, כ1ו    -1זנו: המקטעים ונתבונן בהגדרות שה

יוון השעון, אזי צד  מטרים. מכיוון שאת תוואי הסוללה הגדרנו בכ  5 -מ' לכל צד, סה"כ כ 2.5
 .Slpכלפי חוץ )שדה  1:3לציון יחס של  3שמאל יהיה כיוון חוץ המאגר ומכאן ההגדרה 

Left: מ' גובה ביחס של  6-מציין את שיפוע הסוללה כלפי פנים המאגר )סה"כ כ 2(. מקטע
 מ'(. 26.5מ' של המקטע הקודם מתקבלים  2.5מ'. בתוספת  24-נם כיה 1:4
 

 לקבלת החתך. Applyנים לחץ בסיום הזנת הנתו
 כעת נשליך את החתך הטיפוסי לאורך כל הציר שבנינו:

 

שמשמאל לטבלת גובה עבודות העפר     Copy -לחץ על כפתור ה .16
(Designed G.L הכפתור ממוקם משמאל לטבלה. לאחר הלחיצה .)

 לזיכרון המחשב.  Designed G.L -תועתק טבלת ה
טבלת רשימת החתכים שמימין  עבור, בעזרת הטבלה בחלון הימני ) .17

     Pasteלשרטוט(, לחתך האחרון ברשימה. לחץ על כפתור ה  
( על מנת להעתיק את הנתונים Copy -)הכפתור שמתחת לכפתור ה

 מהזיכרון אל תוך הטבלה בחתך זה.
 

נו בהזנת הנתונים בחתכים שבהם יש שינוי יה CivilCAD 10עיקרון העבודה של תוכנת 
 בחתכים אלו!(, ומילוי שאר חלקי הציר באינטרפולציות ביניים.  בצורת החתך )ורק 

כעת יש בידנו שני חתכים מלאים בנתונים. שאר החתכים עדין ריקים )תוכל לראות זאת על  
 טבלת רשימת החתכים(: -ידי דפדוף ביניהם בעזרת לחיצה על חתך מסוים בטבלה הימנית

 

 Interpolate  ביצוע אינטרפולציות ביניים: לחץ על כפתור   .18
empty sections   מימין. בחלון שייפתח בחרAll Design   ולחץ
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. התוכנה תבצע אינטרפולציה לכל החתכים הריקים  OKכפתור 
בפרויקט, ומכיוון שבידנו שני חתכים בלבד )ראשון ואחרון(, אשר  

 זהים בתכולתם, תמלא התוכנה את כל החתכים באותם נתוני תכנון. 
 

, תוכל לדפדף בין החתכים. בשלב זה, אם הנך מעוניין, תוכל לעבור בסיום האינטרפולציה
 לחתך מסוים ולשנות את תוכנו. 

 

, בחלון   Create layoutקבלת תנוחת המאגר: לחץ על כפתור  .19
 ,Layoutאת שלושת האפשרויות הקיימות ) V -שיפתח סמן ב

Contours, Distances לחץ על כפתור .)OK  להמשך. התוכנה
תנוחת המאגר על גבי השרטוט אשר תכלול את קווי  תיצור את 

 המתאר של המאגר כולל קווי הדיקור. 
, יעבור חלון חתך הרוחב למצב Layout -בחלון ה  OK כפתורהערה: לאחר לחיצה על 

מינימום )על מנת שתוכל לראות את השינויים בתנוחה(. להגדילו חזרה לחץ עליו "בסרגל  
ית המסך. כעת תוכל להמשיך ולערוך את נתוני אשר בתחת Windowsהמשימות" של 

 החתכים כרצונך, ולשנות התנוחה בהתאם. 
 

 לסיום הגדרת החתכים וחזרה למסך הראשי.  Closeלחץ על כפתור  .20
 
 

 פרוט פעולות חלון חתכי הרוחב:
 

נעבור ונפרט כעת את הפעולות הנוספות הקיימות בחלון חתכי הרוחב, שלא נידונו בשלבי 
 ההדגמה:

 
 לות בחלון רשימת חתכי הרוחב )החלון הימני(: פעו

עמוד על החתך הרצוי למחיקה בתוך הרשימה,  -מחיקת חתך בודד  
ולחץ על הכפתור שבחלון רשימת החתכים )החלון הימני(. התוכנה 

 תמחק חתך זה מהרשימה. 

התוכנה תתריע לפני מחיקת כל  -מחיקת כל חתכי הפרויקט  
 למחיקה. OKהחתכים. לחץ 

: לצורך מחיקת נתוני מספר חתכים  יקת נתוני קבוצת חתכיםמח  
שבחלון רשימת החתכים )החלון   Clear all -יחדיו, לחץ על כפתור ה

 Existingמצב קיים ) –הימני(. בחלון שיפתח בחר את הנתונים למחיקה 
G.L( גובה עבודות עפר ,)Designed G.L לחץ .OK    להמשך. בטבלה

נתוניהם ברצונך למחוק. לבחירת כל  שתפתח סמן את החתכים שאת 
. התוכנה תמחק את נתוני OKלמטה. לחץ  Allהחתכים לחץ כפתור 
 החתכים שנבחרו. 

: אופציה זו שימושית בעיקר בעבודה  החתכים הוספת גובה לנתוני  
עם גבהים אבסולוטיים, כפי המודגם בפרק זה. להפעלה לחץ על 

ה הרצויה )להורדת גובה הכפתור. בחלון שיפתח הכנס את תוספת הגוב
. בחלון שיפתח בחר את הנתונים OKהכנס גובה שלילי(. להמשך לחץ 

להמשך.  OKשברצונך לשנות )מצב קיים או גובה עבודות עפר(. לחץ 
למטה, תבחר את  Allבחלון הנוסף בחר את החתכים לשינוי )לחיצה על 
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. התוכנה תוסיף את הגובה הרצוי לחתכים  OKכל החתכים(. לחץ 
 הנבחרים, ובטבלה שבחרת )קיים וכולי(. 

 

 החלון הימני(: –בחלון רשימת החתכים   )הפעלה על ידי כפתור  Options פעולות בחלון
על חלק מהפעולות בחלון זה, דנו במהלך השלבים שבסעיף זה. נפרט אם כן את אותן 

 פעולות שלא פורטו: 
 

 Max/Min interval  – נים חריגים אל החתכים, קראו נתוילעיתים, יתכן מצב בו י
נתוני מדידה שגויים, גבול : כגוןזו, מתוך הטופוגרפיה. קיימות מספר סיבות לתופעה 

מדידה צר מגבול החתך הרצוי, אקסטרפולציות בקווי הגובה ועוד. למניעת תופעה 
לגובה קרקע נתון מהגובה בציר.   המקסימאליזאת ניתן להגדיר לתוכנה את ההפרש 

כי הגובה בציר תמיד נכון )או לפחות אינו חורג מתחומי   נקודת ההנחה היא
הטופוגרפיה( ועל כן גובה זה משמש נקודת יחוס. אנו מורים לתוכנה מהו ההפרש 

בגובה שאנו מתירים לשבר קרקע בחתך. כל שבר קרקע החורג מהפרש  המקסימאלי
,  230.55 נוימחק מנתוני הקרקע. לדוגמא, אם הגובה בציר היזה )למעלה או למטה( י

או גבוה  227.55מ', כל נתון קרקע הנמוך מ  3 -של כ Max/Min intervalואנו הזנו 
מחק מנתוני הקרקע של החתך. השפעת הנתון תתרחש רק לאחר י, י233.55מ 

. אם יש כבר נתוני קרקע קיימים  GetT allשנבצע דגימת קרקע על ידי כפתור 
ליציאה, ונחזור על פעולת  OK, נלחץ שאותם ברצוננו לשנות, נזין את ההפרש הרצוי

 . GetT all -ה
 Force edges-  עקרון הפעולה של תוכנתCivilCAD 10  בדגימת נתוני קרקע הוא

כזה: התוכנה תדגום תמיד את נתוני המצב הקיים בציר, וכל שבר קרקע שיזוהה 
 בתחום רוחב החתך, יוכנס גם הוא לטבלה. בנוסף לנתונים אלו, תדגום התוכנה את
גובה המצב הקיים בקצה החתך, משמאל ומימין, על פי הרוחב שהוגדר. על מנת  

.  GetT allשבסימון וחזור על פעולת  Vלבטל את הדגימה בקצוות, הסר את ה 
 התוכנה תדגום הנתונים מחדש, ללא דגימת הקצוות. 

 Include centerline-  מעלה, סימון שדה זה  2על פי אותו עקרון המוסבר בסעיף
 י סימונו יקבע האם התוכנה תדגום את הגובה בציר עצמו. או א
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 פעולות בחלון השרטוט:
 

לחלון השרטוט )החלון הראשי שעליו מופיע שרטוט החתך( סרגל כלים הנמצא מעליו. נסביר  
הסברנו במהלך  DXF  -את פעולות הכפתורים בסרגל כלים זה:  את פעולת כפתור ה

 ת פעולת שני הכפתורים הנוספים:(. נפרט א34ההדרכה )סעיף 
 

 הדפסת החתכים על גבי מדפסת: . 1
קנ"מ  -Heightלחץ על כפתור המדפסת. בחלון שיפתח הגדר קנ"מ להדפסה:   

 (.  1:100/1:100)קנ"מ של     100, 100קנ"מ לאורך. אנו נכניס  -Lengthלגובה , 
 .  Scale to fitבאופציה  Vאם ברצונך להתאים את החתך לגודל הדף, סמן 

באופציה זו באפשרותך לבחור את תנוחת הגיליון באופציה   Vלאחר סימון 
Oriantation . 

 למעבר להגדרת המדפסת. OKלחץ 
 החתכים שברצונך להדפיס.המדפסת ואת את  שנפתח, הגדר  Printבחלון 

 לבחירת חלק מהחתכים.  Selectאו  Allבחר באופציה לבחירת כל החתכים  
 להדפסה. OKלחץ 

,  Scale to fitבאופציה  V. במידה וסומן התוכנה תדפיס את החתכים באופן רציף
 החתכים יותאמו לגודל הדף וקנה המידה יוצג בתחתית השרטוט.

 .בגיליונות הינה בהתאם להגדרות המערכת ה אשר תוצגשפה
 לשינוי שפה בצע הפעולות הבאות:

 . Cancelצא מחתכי הרוחב על ידי  
 .File -> Configurationהפעל  
 את השפה הרצויה.  Languageיפתח בחר תחת  יבחלון ש 
 (.File -> Cross sectionsוחזור לחתכי הרוחב ) OKלחץ  
 חזור והדפס את החתכים כנלמד. 
 

 :לשליטה בתצוגת החתך קיימות מספר פעולות. 2
 פסי הגלילה למטה ומשמאל לשרטוט. 
ל השרטוט.   לחיצה  ש 2הגדלה פי  -לחיצה על כפתור שמאלי בתחומי השרטוט 

 .2הקטנה פי  -על כתור ימני

מחזיר את הצפייה לכל   -(Zoom extents) כפתור   
 אזור השרטוט.

 
    

מבלי   בפרויקט )על מנת לבצע שמירה לשינויים האחרונים  הפרויקטשמירת  .  3
 לצאת מחלון החתכים(.

 (.. )ראה הרחבה בפרק תכנון כבישיםלגיליונותחלוקת חתכי הרוחב  .  4

 שינוי צבע שכבת המצב הקיים.  .  5

 שינוי צבע שכבת המצב המתוכנן )גובה עבודות עפר(. .  6

 שינוי צבע שכבת מבנה הכביש. .  7
 
 

 פעולות נוספות בחלון הטבלאות )החלון התחתון(:
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משמאל לכל טבלה, שמאלית וימנית, מופיעים מספר כפתורים המאפשרים פעולות על 
 טבלאות אלו: 

 מחיקת נתוני כל הטבלה בחתך הנוכחי. - מחקכפתור   

ייבוא נתוני המצב הקיים של החתך הנוכחי מתוך    - GetTכפתור   
, מייבא כפתור זה את GetT allהטופוגרפיה הקיימת. להבדיל מכפתור 

נתוני המצב הקיים של החתך הנוכחי בלבד. לפני ביצוע הפעולה  
ים הנוכחים. אשר  תתקבל הודעת התרעה על מחיקת נתוני המצב הקי

 את ההודעה להמשך. 
 הוסברו במהלך הפרק(. Paste  -ו  Copy)פעולות כפתור  
 

 יצירת מודל המאגר 
 

בפרק הקודם ראינו כיצד ניתן להגדיר את חתך הרוחב של הסוללה ההיקפית עד קצה 
תחתית המאגר. בסיום הפרק ראינו כיצד ניתן אף לראות את תנוחת המאגר שתוכנן 

(Layoutאם .)  זאת, על מנת שתוכנתCivilCAD 10   תוכל לחשב את נפחי עבודות העפר
של המאגר, נפח האיגום ולהוציא תוכניות לביצוע, יהיה עלינו להורות על בניית מודל המאגר. 
פקודת בניית המודל "תטביע" את המאגר כך שיהיה חלק מהמודל התלת ממדי של התוכנה. 

תחתית המאגר ולשרטוט קווי הגובה המתוכננים על עוד תגרום פעולה זאת לבניית קרקעית 
 גבי הסוללה והתחתית.

 
 . מימין יפתח חלון המאגרים. General -> Reservoir. מסרגל התפריט הראשי הפעל: 35
מסומנת(  התוכנה תחשב את   Pondבחלון שנפתח. )וודא שהאפשרות  Apply. לחץ 36

הגדרות חתכי הרוחב של פי גר על המודל התלת ממדי של המאגר, תיצור את תחתית המא
 הסוללה  ותשרטט את קווי הגובה המתוכננים.

 
במספר פרקים במהלך ספר ההסברים, מאחסנת התוכנה שני מודלים תלת שהוסבר כפי 

ממדיים, האחד של המצב הקיים והשני של המתוכנן. על מנת לדעת את גובהה של נקודה 
משתמשי  לבור לשרטוט לאזור תכנון המאגר. מסוימת במודלים, הן בקיים והן במתוכנן, ע

אשר בסרגל הכלים הראשי   Pick height לחץ על כפתור - AutoCAD/ZWCADגרסת 
עם העכבר בנקודה כלשהי. הגבהים  ץר לשרטוט לאזור תכנון המאגר ולחוולאחר מכן עב

  Height_T,Height_Dהקיימים והמתוכננים של המודל בנקודה שנלחצה יופיעו ליד הכיתוב 
 אשר בתחתית המסך. בצורה זו ניתן לבחון בדיוק את אופן יצירת המודל. 

מאפשרת גם את קבלת המודל במלואו. לשם כך השתמש באופציית   CivilCAD 10תוכנת 
 הצגת המודל התלת ממדי כפי המוסבר בפרק "חתכים מהירים ומודל תלת ממדי".

 
 

 פרוט פעולות נוספות אפשריות בחלון: 
 

במצב שבו אנו עובדים על מספר מאגרים, שדה זה יאפשר  -Roadשדה  .1
 דפדוף בין המאגרים השונים.

  -Pond/Dam -שדות הבחירה .2
Pond- הדוגמא, כפי שהוצגה במהלך המאגר דנה במאגרים אשר תוכננו   -מאגר סגור

 כמאגר סגור בעל סוללה היקפית מוגדרת. 
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Dam- ון בהבדלים העיקריים חלקו האחרון של הפרק יד  -מאגר פתוח הבנוי מסכר
 כאשר מתכננים מאגר המוגדר על ידי סוללת סכר בלבד.

3. Capacity   על פעולות שדות אלו והכפתור   - + כפתור חישוב נפח איגום
 נדון בהמשך הפרק )ראה "קבלת נפח איגום של המאגר"(. 

 

 איזון עבודות עפר 
 

דות העפר, חפירה/מילוי.  נו קבלת איזון יחס עבויאחד מהשלבים החשובים בתכנון המאגר ה
 את איזון עבודות העפר ניתן לבצע על ידי שינוי נתוני התכנון בשני מישורים: 

 
 שינוי תוואי המאגר.  .1
 שינוי הגובה המתוכנן של המאגר. .2

 
אופן שינוי תוואי המאגר מורכב במעט, ועל כך נרחיב בהמשך הפרק בחלק "שינוי תוואי  

 של שינוי הגובה נדון בחלק זה של הפרק. השנייההסוללה ההיקפית". על האופציה 
מספקת כלי חזק, מהיר ונוח לאיזון עבודות העפר בפרויקט על ידי   CivilCAD 10תוכנת 

שינוי מהיר של גובה הפרויקט. אנו לא נעבור ונשנה את תכנון המאגר פיסית, אלא נשתמש 
 באפשרות שמספקת התוכנה של שינוי גובה המודל המתוכנן.

 
. מימין יפתח חלון חישוב  Earthworks -> Generalהתפריט הראשי הפעל: . מסרגל 37

 עבודות העפר הכלליות. 
. התוכנה תחשב את נפח עבודות העפר בפרויקט, לחפירה  Apply. בחלון מימין לחץ 38

ולמילוי, ותציגם בדו"ח אשר ירכז את הנתונים בטבלה. בתחתית הטבלה נוכל לראות גם את 
ירה ומילוי. אנו נאזן את עבודות העפר על ידי "משחק" עם גובה היחס המחושב בין חפ

 סוללות ותחתית יחדיו.  -המאגר
. הכנסת שינוי גובה, חיובי או שלילי בשדה add to design. בחלון מימין מופיע השדה 39

תציג את כמויות עבודות העפר אילו היינו   Applyזה )תוספת או החסרת גובה(, ולחיצה על 
 תכננים את המאגר בגובה הגבוה או נמוך על פי הנתון שהזנו. לדוגמא:תחילה מלכמ

. זאת אומרת שנפח החפירה גדול  2.5נניח וקיבלנו יחס בין חפירה ומילוי   
כך שהתוכנה   add to designבשדה  2מנפח המילוי. אנו נזין  2.5פי 

תציג את הנפחים על פי גובה מתוכנן הגבוה בשני מטרים מהגובה  
 הנוכחי.

. כרגע נפח המילוי גדול  0.8ניח ועתה קיבלנו יחס בין חפירה ומילוי של נ 
ונקבל את  add to designבשדה  1.5במעט מנפח החפירה. נזין  

הנפחים אילו היינו מתכננים על פי גובה מתוכנן הגבוה במטר וחצי  
מהגובה הנוכחי )השינוי, שני מטרים, מטר וחצי וכולי, הנו תמיד ביחס 

 ן המקורי ולא לגובה האחרון שהוכנס(. לגובה התכנו
)אנו עלינו . יחס זה מקובל 1.1נניח וכרגע קיבלנו יחס חפירה למילוי  

במעט יותר חפירה ממילוי(, זאת אומרת שאם היינו מתכננים   מעוניינים
מ' מגובה התכנון הנוכחי, עבודות   1.5 -את המאגר בגובה הגבוה ב

 העפר בפרויקט שלנו היו מאוזנות.
)לדוגמא  add to designתוספת גובה שלילית בשדה נזין : להחסרת גובה מתוכנן הערה
0.5- .) 
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ניגש עתה ונשנה פיסית את התכנון המקורי של המאגר, לשם כך נבצע את סידרת השלבים 
 הבאים:

 (.Roads -> Cross sectionsחזור לחתכי הרוחב ) .1

 שמימין.  כפתור בחלון שנפתח, לחץ על  .2
מ' במקרה שלנו, ולחץ  1.5כנס את הפרש הגובה הרצוי,  בחלון שנפתח, ה .3

 להמשך. OKכפתור 
, ולחץ  Designed G.L -בחלון שיפתח עתה, העבר בעזרת חץ הבחירה ל .4

OK. 

אשר בתחתית   כעת יפתח חלון ובו רשימת החתכים. לחץ על כפתור   .5
 להמשך. OKהחלון. כל החתכים ברשימה יבחרו. לחץ 

 OKובה המתוכנן של החתכים הנ"ל. לחץ התוכנה תתריע על שינוי הג .6
 לאישור.

 גובהם של כל החתכים, ישתנה בהתאם לשינוי הגובה שנבחר.

 לקבלת תנוחת המאגר המחודשת. OKומשם  לחץ על כפתור התנוחה  .7
 . Closeסגור את חלון חתכי הרוחב על ידי כפתור  .8
ל לקבלת המוד Applyובחלון שנפתח לחץ   General -> Reservoirהפעל   .9

 ית קרקעית המאגר המחודשת.יהחדש ובנ
לקבל את יחס  Apply, ולחץ Earthworks -> Generalחזור לחלון  .10

 החפירה/מילוי החדש בהתאם לשינוי הפיסי בגבהים. 
 
 

 קבלת נפח איגום של מאגר 
 

בחלקים הקודמים של הפרק ראינו כיצד ניתן לתכנן מאגר על פי השלבים השונים. אחד  
  CivilCAD 10נו נפח האיגום שלו. תוכנת ירוצים לדעת לגבי המאגר ה הנתונים אשר היינו

מסוגלת להפיק דו"ח המתאר את נפח האיגום שטח פני המאגר ביחס לגובה מפלסים שונים  
 של פני מים. 

. מימין יפתח חלון  General -> Reservoirמחלון התפריט הראשי הפעל:  .1
 המאגרים.

גובה ראש את תחתית המאגר והתוכנה תחשב באופן אוטומטי את גובה  .2
 הסוללה של המאגר, ותמלא את השדות הבאים: 

Max liquid level-  במאגר. כברירת מחדל יהיה גובה   מקסימאליגובה פני מים
, אזי גובה 31.79 -)לדוגמא אם גובה ראש הסוללה כלפי מטה ראש הסוללה מעוגל 

 (.31יהיה   מקסימאליפני מים 
Min liquid level- במאגר. כברירת מחדל יהיה גובה   מינימאלימים  גובה פני

 מעלה.כלפי תחתית המאגר מעוגל 
Compute in steps-   הקפיצות שבו יחושב דו"ח. כברירת מחדל יהיה שדה זה

 מ'(.  1) 1בעל ערך 
הערה: את השדות אותם מילאה התוכנה כברירת מחדל ניתן לשנות לפי רצון  

 המשתמש.

התוכנה תחשב דו"ח איגום   Compute capacity. לחץ על כפתור   .3
למאגר ותציגו על פי הפרמטרים הקיימים בשדות. 
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להצגת הדו"ח על גבי השרטוט בצע   -הצגת דו"ח הכמויות על גבי השרטוט
 השלבים הבאים:

 

 . לחץ על הכפתור  .1
 עבור לאזור השרטוט: .2

מקם את הטבלה באזור הרצוי  AutoCAD/ZWCAD -למשתמשי גרסת
קום המיועד ליצירת הדו"ח תופיע מסגרת צהובה. ולחץ עם העכבר. במ

” בשורת הפקודות, ולא, חזור  Sאם מיקום הטבלה הוא כרצוי, הכנס " 
” תיבנה שכבה  Sומקם את הטבלה במקום הרצוי. לאחר לחיצה על “

 שתכיל את הדו"ח הרצוי.
 
 

 חישוב נפח איגום לשטח שאינו מוגדר על ידי סוללה היקפית: 
 

ציג את אופן חישוב נפח איגום למאגר אשר הוגדר על ידי סוללה  ההסבר שפורט להלן מ
 היקפית, על פי השלבים השונים אשר פורטו במהלך הפרק.

מאפשרת חישוב נפח איגום לאזור כלשהו, אשר תחום נניח על ידי   CivilCAD 10תוכנת 
רכב הרים, גבעות או על ידי סכר כפי המתואר בחלקו האחרון של הפרק: "תכנון מאגר המו

 מסכר בלבד". 
 על מנת לחשב נפח איגום של שטח כלשהו, בצע את הפעלות הבאות:

  General -> Reservoir)הפעלת  Reservoir -הכנס לחלון ה .1
 (. CivilCAD 10 -מסרגל התפריט הראשי של ה

 Polyline  (2D, העבר AutoCAD/ZWCAD -בתוך ה .2
polyline אשר יתחם את גבול שטח המאגר שברצונך לחשב .)
 את נפחו.

 .Dam -ל Pond -בחלון מימין העבר מ .3
, עבור לאזור השרטוט Select area -ליד שדה ה )”Vסמן בוי )"  .4

 -לאחר בחירת ה Enterששורטט. לחץ  Polyline -ובחר את ה
Polylineמימין יתחלף הכיתוב מ .- None ל- Selected . 

. התוכנה תחשב את גובה המים Applyלחץ כל כפתור  .5
ותציגם   Polyline -בתחום ה המינימאליגובה המים ו המקסימאלי

בשדות מימין. בשלב זה ניתן לשנות את הפרמטרים כרצוי  
)לדוגמא: לחשב את מפלסי המים בקפיצות שונות מברירת 

 מ'(.  1 –המחדל 

התוכנה תחשב דו"ח    Compute capacityלחץ על כפתור  .6
 איגום למאגר ותציגו על פי הפרמטרים הקיימים בשדות.
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 הצגת נפח "מת" בדו"ח נפחי האיגום 

 
 

 ניתן לחשב ולהציג נפח "מת" בדו"ח נפחי איגום של מאגר מים. 
 לביצוע הפעולה: 

 
  'Reservoirs‘. תפריט 'General→Reservoir‘מהתפריט הראשי הפעל:  .1

 ייפתח מימין. 
 , הגדר את רום צינור איסוף המים מהמאגר.Pipe Levelבשורת  .2

. התוכנה תבצע חישוב ותציג    'Compute Capacity'לחץ על כפתור  .3
  Minimum Liquid Levelדו"ח נפחי איגום. הנפח שבין רום הצינור לבין 

 יחושב כנפח "מת".
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 שינוי תוואי הסוללה ההיקפית 
 

כחלק מתכנון המאגר, יתכן ונצטרך לבחון מספר אופציות של תכנון בהן נשנה את תוואי  
בפרק זה נסביר כיצד ניתן לשנות את תוואי הסוללה ההיקפית   הסוללה ההיקפית של המאגר.

 ומהם השלבים שעלינו לעבור על מנת להשלים את שינוי התוואי באופן מלא:
של ציר הסוללה ניתן  IPלשינוי   -של ציר הסוללה IPהזזת  .1

 להשתמש בשתי דרכים:
 . השתמשDesigned coordinates -ברשימת ה הקואורדינאטהשינוי פיסי של  

של  הקואורדינאטהעל מנת לשנות את  Designed coordinates -בעורך של ה
( כפי  IP1לשמור את שם הנקודה )נניח  חובה לערך חדש. IP-אחת או יותר מה

 שהיה.
ברשימת הבחירה שבחלון התחתון   Move -בחר ב -Moveשימוש באופציית  

זור השרטוט …(. עבור לאPick, Locate, Freeze)ראה רשימה בחלון התחתון: 
שברצונך לשנות את מיקומה. בחר את נקודת הייחוס   IP -ובחר את נקודת ה

של   קואורדינטותה. השנייההראשונה להזזה ולאחר מכן את נקודת הייחוס 
 הנקודה ברשימת הנקודות התחתונה ישתנו בהתאם למיקום החדש. 

י. הנקודה  שבסרגל הכלים הראש למיקומה החדש, לחץ על כפתור   IPלאחר הזזת ה 
. בחלון  Roads -> Horizontal alignmentתשנה את מיקומה על גבי השרטוט. הפעל 

. התוכנה תשנה את שרטוט ציר  OK, ובחלון החדש לחץ שוב Applyשנפתח מימין לחץ 
תו מיקום החתכים,  יזאת, מכיוון שאורך הציר השתנה ואעם הסוללה בהתאם לתוואי החדש. 

 ם בהתאם ואתם לקבל את קווי התנוחה )כולל קווי הדיקור(. יהיה עלינו לתקן את החתכי
 Cross -. עם כניסתך לחלון הRoads -> Cross sections -. הכנס ל2

sections חתכי הרוחב( תחשב התוכנה את אורך הציר החדש ותציגו ב(- Roads 
length במקרה ובו היו קיימים )לפני שינוי התוואי האופקי( חתכי רוחב לאורך כל . 

הציר, לאחר שינוי אורך הציר, לא יהיו קיימים כאלה עתה. נפריד בין שני מקרים:  
אורך הציר קטן ביחס לאורכו הקודם או אורך הציר גדל. נסביר את השינוי הנדרש, 

 בחתכי הרוחב על פי שתי דוגמאות:
  215.32 -נניח ולפני השינוי היה אורך הציר שלנו כ  -דוגמא א': אורך הציר קטן 

מ'. שני החתכים האחרונים בציר   20נניח כי חילקנו הציר לחתכי רוחב כל מ', ו
מ'. עכשיו נניח ולאחר השינוי   215.32  -מ' ו 200היו אם כן במרחק רץ של 
, בעוד Roads length -מ'. מרחק זה יופיע ב 187.32  -השתנה אורכו של הציר ל

חתכים הנ"ל. אנו ברשימת החתכים יופיע החתכים הקודמים, דהיינו כולל שני ה
נתאים בין האורך לבין רשימת החתכים בצורה הבאה: מחק את החתכים 

מרשימת החתכים. עתה החתך האחרון יהיה במרחק   215.32 -ו  200במרחק 
 . 187.32מ'. עבור לסוף רשימת החתכים והוסף חתך במרחק רץ  180

, ונניח כי  215.32נניח ולפני השינוי היה אורך הציר  -דוגמא ב': אורך הציר גדל 
מ'.   240.56 -מ' לחתכי רוחב. עתה, נניח ואורך הציר גדל ל 20הוא מחולק כל 

מרשימת החתכים, ונוסיף לרשימה את החתכים:  215.32את חתך  נמחקאנו 
 מ'.  240.56  -ו 240, 220

 
לאחר שהתאמנו את החתכים לאורך הציר החדש, נקרא שוב את נתוני הקרקע הקיימת.  

החתכים, הן לחדשים והן לקודמים )שכן הם שינו מיקומם(. לחץ על כפתור  נעשה זאת לכל 
GetT all  כפתור כחול מימין(, ובחלון שנפתח לחץ(OK התוכנה תקרא את נתוני המצב .
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)תוכל לעשות כן  שיצרתהקיים החדשים לתוך החתכים. השלם את התכנון לחתכים החדשים 
ם בפרק הגדרת חתך הרוחב של הסוללה עד כפי שהודג Paste  -ו Copy -על ידי שימוש ב
 תחתית המאגר(. 

. התוכנה תתקן את OK. בחלון שנפתח לחץ   Create layout. לחץ על כפתור 3
 התנוחה בהתאם למצבה החדש.

, והפעל מסרגל התפריט  Cancel -. צא מחלון חתכי הרוחב על ידי כפתור ה4
. התוכנה תבנה את Apply. בחלון שנפתח לחץ General -> Reservoirהראשי: 

 תחתית המאגר בהתאם לתוואי הסוללה החדש.
 

 בתחתית המאגר מתוכנן יצירת שיפוע 
 

במהלך הפרק ראינו כיצד ניתן לתכנן מאגר בעל תחתית ישרה. נראה כעת כיצד ניתן ליצור  
 שיפוע בתחתית המאגר המתוכנן.

 יצירת השיפוע בתחתית תתבצע באחת משתי השיטות הבאות:
 שיפוע על ידי שינוי חתכי הרוחב. שינוי ה .1
 יצירת נקודות גובה מתוכננות בתחתית. .2

 
 . שינוי השיפוע על ידי שינוי חתכי הרוחב: 1

עיקרון זה מבוסס על שינוי מקטע התחתית שהוגדר בחתכי הרוחב, באותם חתכים שבהם 
 קיים השינוי בשיפוע, וביצוע אינטרפולציה בין חתכים אלה. 

ן את החתכים בקצות המאגר אשר ברצונך לשנות את גובה . בתנוחת השרטוט, בח1
 התחתית בהם.

 . Roads -> Cross sections. מסרגל התפריט הראשי הפעל: 2 
  2. בחלון שיפתח הכנס לחתכי הרוחב המיועדים לשינוי ושנה את מקטע מס' 3 

 .                   Designed G.L -בטבלת ה

       Designed G.L -ון שיפתח בחר את טבלת ה. בחל  Clear all. לחץ על כפתור 4
 .                                               OK)העבר בעזרת החץ הקטן(, ולחץ 

. לפניך תופיע רשימת חתכי הרוחב. סמן את החתכים הרצויים למחיקה )אלו יהיו  5
ירת מספר  חתכי הביניים שברצוננו למלא באינטרפולציה בין החתכים ששינינו(. לבח

 להמשך. OK. לחץ Ctrl -וה  Shift -חתכים השתמש במקשי ה
 . התוכנה תתריע כי היא עומדת למחוק את נתוני התכנון. אשר את ההודעה.6

בחלון שנפתח. תנוחת המאגר  OK. לחץ ה . לחץ על כפתור יצירת התנוח7
 החדשה תשורטט.

 לסגירת החלון.  Close. לחץ 8
. בחלון שיפתח מימין Roads -> Reservoirעל: . מסרגל התפריט הראשי הפ9

. התוכנה תיצור מחדש את תחתית המאגר, קווי הגובה החדשים, ותבנה Applyלחץ 
 את המודל התלת ממדי מחדש.

 
 . הוספת נקודות מתוכננות בתחתית:2

וודא שבחלון התחתון מופיע רשימת הנקודות המתוכננות  .1
(Designed coordinatesאם הרשימה הי .) קואורדינטותא של  

, לרשימה Design -> Coordinatesהמצב הקיים, העבר בעזרת 
 הרצויה. 
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 ,Pick, Locateשברשימת הפעולות בחלון התחתון )  Pickלחץ על   .2
Freeze... .) 

נקודות גובה חדשות בתחתית. והוסף עבור לאזור השרטוט  .3
 שבחלון התחתון.  קואורדינטותה הנקודות יופיעו ברשימת 

ף נקודות, לא רק בתחום תחתית המאגר אלא גם חובה להוסי
בתחום השיפוע הפנימי של המאגר ע"מ שהתוכנה תוכל לחשב את  

 החיבור לשיפוע המתוכנן. 
השתמש בעורך של החלון התחתון על מנת לשנות את גובה  .4

הנקודות החדשות שנוצרו )על שימוש בעורך ראה פרק "מאגר 
 "(.קואורדינטותהרשימת  -קואורדינטותה

 על מנת לקבל את הנקודות החדשות בתחתית. חץ ל .5
ומחק את כל  Design → Linesמסרגל התפריט הראשי הפעל:  .6

קווי השיפועים המופיעים ברשימה. אלו הם קווי השיפועים של 
התוכנה  –המאגר ויש למחוק אותם על מנת שבעת יצירתם מחדש 

 תתחשב בנקודות החדשות שהוספת.
ולחץ על  Design → Contours מסרגל התפריט הראשי הפעל: .7

 . Applyכפתור 
  Roads --> Cross sectionsמסרגל התפריט הראשי הפעל:  .8

. לאחר המחיקה Design -את המקטע האחרון בטבלת ה ומחק
סמן עם העכבר את המקטע, לחץ על הכפתור הימני של העכבר  

 All. לחץ על כפתור  Send toובחלון שייפתח בחר באופציה 
 לשליחת מחיקת נתוני המקטע לכל החתכים. OKולאחר מכן 

ולאחר מכן גע עם העכבר בנתון שהזנת,   הגדר יחס שיפוע רצוי  .9
 Sentלחץ על הכפתור הימני בעכבר ובחלון שייפתח בחר באופציה  

to  לחץ על כפתור ,All   ו–  OK  על מנת לשלוח את יחס השיפוע
נתון יחס  יש לחזור על פעולה זו בכל מקום בו הזנת0לכל החתכים 

 (.Design –שיפוע בטבלת ה 
  Existingוהזן תת שכבה תחת  Insert Layersלחץ על כפתור  .10

 (. ”Bottom“)לדוגמא: 
 לתת השכבה שיצרת.  Existing –עבור בטבלת ה  .11
ובחלון שייפתח בחר   Get data for all sectionsלחץ על כפתור  .12

, לתת )כפתור בחירה עליון(  Existing –לשלוח את הנתונים ל 
 השכבה שיצרת )כפתור בחירה תחתון(. 

בתת השכבה יופיעו נתונים   Existing –במידה ובטבלת ה  .13
יש למחוק אותם ולשלוח   –...(  -3,  -2,   -1במקטעים השליליים )

 . Send toאת המחיקה לשאר החתכים ע"י 
ולאחר מכן על   Interpolate empty sectionsלחץ על כפתור  .14

   .Create Layoutכפתור 
 Roads → Horizontalמסרגל התפריט הראשי הפעל:  .15

alignment  ומחק את הנקודות המתוכננות אשר יצרת בתוך
)חלון ימני   Eraseתחום השיפוע הפנימי ע"י בחירה בפעולת 

  AutoCAD/ZWCADשל  Command –תחתון( , בשורת ה 
של תחתית המאגר  Layout –ה  וסמן את  Outעבור  ”O“הקלד 

דיר את קונטור תחתית המאגר(. לאחר שסימנת את )הקו אשר מג
 . Refreshלחץ על כפתור  –הקו 
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  ’V‘סמן  , General→Reservoirמסרגל התפריט הראשי הפעל:  .16
 .Applyולחץ על כפתור   Use last segmentsבאופציה 

 התוכנה תיצור תחתית חדשה למאגר ע"פ השיפוע המתוכנן. 
 
 

 הוצאות תוכניות לביצוע 
 

  CivilCAD 10בהוצאת תוכניות לביצוע. תוכנת  מעונייניםן המאגר נהיה בסיום תכנו
 מאפשרת:
 ( על גבי תנוחת השרטוט.Scraper planeשרטוט תוכנית יתוד ) .1
 הוצאת חתכים לאורך המאגר. .2

 
 . שרטוט תוכנית יתוד: 1

 . מימין יפתח חלון. Earthworks -> Grid. מסרגל התפריט הראשי הפעל:   1
 -על ידי מילוי השדות המתאימים ב Yוכיוון   Xוחים ברשת לכיוון . קבע את המרו2

Grids steps        .)ראש שדות מימין( 
 בחלון מימין, עבור לאזור השרטוט וסמן: Pick. לחץ כל 3 
נקודה שמאלית תחתונה של קו הבסיס אשר יגדיר את  

 .Base first -הרשת
נקודה ימנית תחתונה של קו הבסיס אשר יגדיר את  

 . Base second -רשתה
 -נקודה ניצבת לקו הבסיס אשר תגדיר את גובה הרשת 

End corner . 
לשדות שבחלון מימין. אנו נבחר את נקודות  יוכנסו של הנקודות הנבחרות  קואורדינטותה

 הגדרת הרשת כך שתהיה ניצבת למאגר.
על מנת לקבל דיוק  Use accurate system" ליד הכיתוב Vסמן "  .4

 בחישוב. מרבי
בחלון מימין. התוכנה תיצור רשת על גבי  Applyלחץ על כפתור  .5

השרטוט, על פי הגודל שנקבע. בכל פינת רשת יופיע גובה המצב 
הקיים, גובה המצב המתוכנן וההפרש ביניהם. בתוך כל ריבוע של 
הרשת יופיע נפח החפירה ונפח המילוי של הריבוע הנ"ל. בסיום  

סך כל כמויות עבודות העפר  יצירת הרשת יופיע דו"ח המסכם את 
 על פי סכומי הריבועים שברשת.

נושאים  -הערה: על פירוט הפעולות הנוספות האפשריות בחלון ראה פרק "עבודות עפר
 נוספים. יצירת רשת איזון עבודות עפר". 

 
 . הוצאת חתכים לאורך המאגר:2

ו חתכי רוחב ניצבים  על מנת להוציא חתכים לאורך המאגר, אנו ניצור ציר אורך אשר נגדיר ל
 אשר ישמשו כחתכי האורך של המאגר. 

. מימין  Roads → Roads listמסרגל התפריט הראשי הפעל:  .1
 יפתח חלון. 

בטבלה שבחלון מימין הוסף ציר חדש לרשימה )עמוד בסוף  .2
(. לחץ  Road2הרשימה והכנס את שם הכביש החדש, לדוגמא: 

Cancel .להמשך 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  305עמוד 

של הציר אשר יהיה ניצב  CL -על גבי השרטוט, העבר את ה .3
ליצור. העברת תוואי הציר,   מעונייניםלחתכי האורך אותם אנו 

תתבצע בדיוק באותה שיטה שבה העברנו את תוואי הסוללה  
ההיקפית )אך ללא סגירת הציר למקום ההתחלה כמובן(. את 

 Roads → Horizontalהגדרת הציר נבצע על ידי  הפעלת 
alignment החלון מימין, נעביר על ידי כפתור  , ומיד לאחר שיפתח

החץ הקטן שבראש החלון, מציר הסוללה לציר החדש שאנו 
 עומדים להגדיר. 

או כל פעולה  Select ,Pickלאחר שנגדיר את הציר )על ידי  .4
לקבלת הציר על גבי   OK -ו  Applyאחרת, וכן לאחר לחיצה על 

 Roads -> Crossהשרטוט(, נעבור לחלון חתכי הרוחב: 
sections . 

נך בציר הנכון )ולא בציר הסוללה יבחלון שנפתח וודא שה .5
 ההיקפית(. 

מ'   20)כפתור הגדרת החתכים( והגדר חתכים כל   לחץ על    .6
 בחלון שנפתח(.   OK)לחץ 

  Sections width -. בשדות ה  Options -לחץ כל כפתור ה .7
פי  קבע על י הגדר את רוחב החתך לשמאל ולימין. רוחב החתך י

 ות המאגר מהציר שהעברנו. מרחק קצ
.  Design Devote -40 to 40 segments" באפשרות: Vסמן "  .8

  81לכל   Design-אופציה זו מאפשרת דגימה של קרקע לטבלת ה
בטבלה כך שניתן לדגום את שברי הקרקע בצורה   הסגמנטים
 .המרבית

 להמשך. OKלחץ  .9

  )כפתור כחול מימין( על מנת לקבל  GetT all לחץ כל כפתור  .10
 את המצב הקיים של כל החתכים.  

)כפתור אדום מימין( על מנת לקבל    GetD all לחץ כל כפתור  .11
את המצב המתוכנן של כל החתכים. התוכנה "תלביש" את המצב 
המתוכנן על גבי המצב הקיים. לאחר קבלת חתכי האורך הרצויים,  

)סרגל הכלים שמעל לשרטוט ( כדי   לחץ על כפתור  יהיה ניתן 
 .  .DXFלקובץ  את החתכים או להוציא להדפיס

 

 תכנון מאגר המורכב מסכר בלבד 
 

(, Pondבחלק האחרון של הפרק נדון בהבדל שבין תכנון מאגר בעל סוללה היקפית מלאה )
(. עיקרון הפעולה בשתי השיטות יהיה דומה, אם כי  Damלבין תכנון מאגר המורכב מסכר )

על סדר הפעולות לתכנון מאגר המורכב מסכר,  נו פשוט יותר. נעמוד אם כןיתכנון סכר ה
 ובעיקר נדגיש את ההבדלים שבן שני סוגי התכנון: 

, והגדר את ציר הסכר. את ציר הסכר Roads → Horizontal alignment -. הכנס ל1
ניתן להגדיר בדיוק באותה צורה של הגדרת תוואי הסוללה ההיקפית של המאגר, אלא שכאן 

 . הציר יהיה כמובן פתוח
 : Roads → Cross sections -. הכנס ל2

 .ר  הגדר את חתכי הרוחב ע"י לחיצה על כפתו 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  306עמוד 

 .ר  הגדר את רוחב הקרקע הקיימת ע"י לחיצה על כפתו 
 הוצא את חתכי הקרקע של המצב הקיים מתוך הטופוגרפיה.  
(. להבדיל 1הגדר את חתך הרוחב המתוכנן בגובה הרצוי )בחתך מספר  

גר סגור, לא נגדיר כאן תחתית למאגר. מהגדרת חתך הרוחב במא
 דוגמא להגדרת חתך רוחב במקרה כזה יכולה להיות:

 

        
 

 Slp, ליד הכיתוב :Fill 1)ראה ראש הטבלה(, ובשדה  :Slp. Left, ליד הכיתוב  :Fill 1בשדה 
Right:  את שאר שדות השיפועים למצב של  3)ראה תחתית הטבלה(, הכנס את הנתון(

 (.0ריקים/בערך  חפירה השאר 
לכל   1:3 -מ', ובשיפוע סוללה של כ 5זה עתה הגדרנו חתך סוללה בעלת דרך משא ברוחב 

 צד. 
 העתק החתך הראשון לאחרון, ובצע אינטרפולציה בין החתכים. 

 מימין(.  שרטט את תנוחת הסוללה )כפתור  
. בחלון שנפתח  General → Reservoir, והפעל Closeסיים על ידי  

 ליצירת מודל הסוללה.  Apply. לחץ Dam  -ל Pond -מ מימין העבר
 

רגיל, על מנת לקבל איזוני עבודות עפר ונפח איגום   בתכנון מאגריםהמשך כפי המוסבר 
)ראה "חישוב נפח איגום לשטח שאינו מוגדר על ידי סוללה היקפית" שבתוך פרק "קבלת  

 נפח איגום של המאגר"(.
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 תכנון קווי גז  :19פרק 
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 ווי גז תכנון ק
 

פרק זה ידון בתהליך תכנון צנרת לגז. תכנון זה מתבסס על תכנון הכבישים בתוכנה. במהלך  
 הפרק יוסברו השלבים הבאים:

 
 . הפרויקטאתחול  
 תכנון תנוחת הקווים.  
 תכנון החתך לאורך. 
 מחתך האורך.  לגיליונותוחלוקה  DXFיצירת קבצי  
 (. Cross sectionsתכנון חתכי הרוחב של התעלה ) 

 

 הפרויקט אתחול 
 

 תכנון קו גז, ראשית יש לפעול לפי השלבים הבאים: בפרויקטעל מנת להתחיל 
. מימין יפתח חלון.  Roads → Roads listמסרגל התפריט הראשי הפעל:  

 בחלון מופיע רשימת הצירים של הפרויקט. 
הקלד בטבלה מימין את רשימת הצירים בפרויקט הנוכחי. לכל ציר בפרויקט יש  

שם כלשהו. השם יכול להיות אלפא נומרי או מספר. בניגוד לתכנון כבישים  לתת 
בתחילת השם.  GASשמות הצירים חשובים ויש להקלידם ע"י הוספת האותיות: 

 ע"י כך התוכנה מזהה שהוגדר קו גז. 
 .OKבסיום הקלדת הרשימה לחץ  

 שים. כעת בצע את שלבי הכנת הרקע )המצב הקיים( כפי שהוסבר בפרק תכנון כבי
 

 הקווים תכנון תנוחת 
 

 בסיום ארגון רשימת הצירים נתחיל בתכנון התוואי האופקי של הקו. 
. מימין  Roads → Horizontal Alignmentמסרגל התפריט הראשי הפעל:  .5

(  Topography coordinatesיפתח חלון. שים לב כי הרשימה בחלון התחתון )
רשימה חדשה, ריקה, של  התחלפה, ובמקום רשימת הנקודות הקיימות, הופיע

 (. Designed coordinatesהנקודות המתוכננות )
 

 :של הציר IP -הזנת נתוני ה .6
 של הציר. אנו נבחן שתי שיטות:  IP -קיימות מספר שיטות להזנת נתוני ה

 (, שיהווה את התוואי האופקי של הציר. 2D Polyline) Polylineהעבר  
 ,Unused, Pick, Locateמה בטבלה מימין )הטבלה ובה הרשי Selectבחר  

Select .) 
 Enter an option תופיע ההודעה: AutoCAD/ZWCAD-בשורת הפקודות של ה 

(<Polyline>/Segment**) הקלד ,p  ולחץEnter.   האפשרותSegment  
מאפשרת תכנון אופקי בעזרת כלים מתקדמים וניתן לקרוא עליה בהרחבה בפרק 

 י. תכנון התוואי האופק –תכנון כבישים 
. הטבלה Enterהמשורטט, ולחץ  Polyline –עבור לאזור השרטוט, בחר את ה  

,  Polyline -( בVertexשל הציר. כל שבר ) IP -בחלון מימין תתמלא ברשימת ה
 שלהם. קואורדינטותהשל הציר, ובחלון התחתון תופיע רשימת   IP -קבע כיי
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מספר   x,   כאשר xIPyקבעו ע"פ:    לציר י IP -* הערה: שמות נקודות ה
ראשונה(,   Select. בציר הראשון שיבחר )פעולת  IPמספר ה   y -הציר, ו

וכו'. בכל פעולת   1IP1 ,1IP2 ,1IP3  ,1IP4בצורה הבאה:  IP -ימוספרו ה
Select חדשה, יגדל ה- x . 

 
ם עם כלים מתקדמי AutoCAD/ZWCAD-** קיימת שיטה נוספת ליצירת התוואי בעזרת ה

 כלים מתקדמים לתכנון התוואי האופקי(. ראה הרחבה בסעיף הבא ) 
 

 הגדרת חתך האורך 
 

לאחר שהגדרנו את התוואי האופקי של הקו, נעבור לטפל בחתך האורך של הציר. תוכנת 
CivilCAD 10  מאפשרת תכנון חתך לאורך בשתי שיטות: תכנון בסביבת השרטוט של

. על מנת להגדיר את שיטת העבודה יש לפעול  AutoCAD/ZWCADהתוכנה ותכנון בסביבת 
 לפי השלבים הבאים:

 
 . File → Configurationמהתפריט הראשי הפעל:  
 , בחר באחת מהאפשרויות:Vertical alignment modeליד הכיתוב  
 Stand alone-  .)עבודה בסביבת השרטוט של התוכנה )בשיטה הישנה 
 Drawing environment interface- יבת עבודה בסבAutoCAD/ZWCAD . 

 
. לפניך יפתח חלון   Roads → Vertical Alignment .  מהתפריט הראשי הפעל:1

 חתך האורך.
 החלון שיפתח מחולק ל: 

 האזור המרכזי של החלון )המשטח השחור(. -אזור השרטוט 
 (. Topoהטבלה משמאל למטה )  -טבלת נתוני המצב הקיים 
 הטבלה מימין למטה.  -טבלת נתוני התכנון 
 החלון הימני. -חלון הפעולות 

התוואי האופקי והמצב הקיים, נמצאים בחלון נפרד   -השרטוט המרכזי
שנמצא מתחת לחלון החתך לאורך )הקטנת החלון למינימום תגלה שוב את 

 החלון הקודם(. 
 

בחלון מימין. התוכנה תעבור לאורך התוואי   Applyלחץ כפתור  .2
בטבלת  ום אלו יופיעהאופקי ותחשב את גבהי החתך לאורך. גבהי

הקיים )הטבלה השמאלית התחתונה(, כפונקציה של מרחק המצב 
 מצב קיים.  - רץ וגובה. בחלון השרטוט יופיע שרטוט החתך לאורך

 נבהיר מספר נקודות: 
)תחת הכיתוב   Length -ו Heightהחתך ניתן בקנה לפי הערכים בשדות  

View.) 
יקום חתכי הרוחב. אם  הגבהים שבטבלה בתחתית החתך מופיעים לפי מ 

מ', יופיעו הגבהים בחתך האורך כל  20לדוגמא חתכי רוחב קיימים כל 
מ. על מנת לשלוט במיקום הגבהים הנתונים יש לשנות את מיקום  20

 מ':  25חתכי הרוחב. נשנה לדוגמא את המיקום כל 

חלון ההגדרות הראשי, תחת הכיתוב נפתח (. (Options לחץ על כפתור   
Vertical Alignment  :הכנס את המרחק הרצוי ליד הכיתובData intervals . 
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 . OKעל מנת לסגור את חלון ההגדרות הראשי לחץ  
 על מנת לחדש את השרטוט. Applyבחלון מימין לחץ  

 
גם אם לא קיים תוואי אופקי, או שאין בידינו טופוגרפיה ניתן ליצור את   

. לעשות כן יש למלא החתך ע"י הזנת נתונים ידנית לטבלת המצב הקיים
(. בכדי לקבל את Elev(, וגובה )STאת הטבלה בנתוני מרחק רץ )

 בחלון הימני. Applyהחתך לאחר הזנת הנתונים לחץ 
אם, בעקבות נתוני טופוגרפיה שגויים, התקבל חתך אורכי שגוי בחלקו,   

ניתן לערוך את נתוני המצב הקיים שהתקבלו באופן ידני. בכדי למחוק  
ה, עמוד אם העכבר על טור המספר הסידורי של השורה שורה בטבל

מחק. לקבלת השינוי י. השורה תDel)העמודה השמאלית ביותר(, ולחץ 
 בחלון מימין.  Applyע"ג השרטוט לחץ 

 

 תכנון נקודות המפנה האנכיות: 
 

 :להלן דוגמא לטבלת נתוני קו גז
 

 
 

 St –  .מרחק רץ 
 T.O.P – .רום עליון של הצינור 
 Slope(%) – שיפוע הצינור. 
 R – רדיוס הקשת האנכית.  
 Diameter(“) – .קוטר הצינור 
 Bedding width – .גובה מצע 

 
 

 פי: אתכנון החתך לאורך יכול להתבצע ע"י הזנת נתונים בטבלה או ע"י שרטוט גר
 

 הזנת נתונים בטבלה.  -שיטה א' 
מס"ד  -יטבלת נתוני התכנון )הטבלה הימנית התחתונה( מחולקת לעמודות על פ

(, שיפוע  Ele(, גובה )STללא כותרת(, מרחק רץ )  -)העמודה השמאלית ביותר 
 (.2T( ואורך הקשת האנכית )%Slopeבין מקטעים הניתן באחוזים )

הזן את הנתונים בטבלה, כאשר לכל מקטע הגדר את המרחק הרץ שלו ואת 
טע  גובהו. התוכנה תחשב בין כל שני מקטעים את השיפוע ותציגו מול המק

הרלוונטי. במקום גובה ניתן להזין את השיפוע ממקטע קודם ואז תמלא התוכנה 
את עמודת הגובה. למחיקת שורה שגויה, עמוד עם העכבר על עמודת המספר 

. לקבלת Delהסידורי )העמודה השמאלית ביותר( מול השורה הרלוונטית ולחץ 
 בחלון הימני.  Applyשרטוט החתך המתוכנן לחץ 
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-פית )ע"י שימוש בחלון הארטוט הנתונים גרש  -שיטה ב' 
AutoCAD/ZWCAD.) 

 ע"י שיטה זו ניתן לשרטט את חתך האורך ע"ג אזור השרטוט:
 . VerEditהינה:   AutoCAD/ZWCAD-וודא שהשכבה הנוכחית ב .1
 .)ניתן לחבר מספר קווים( Polylineהחל לשרטט את חתך האורך בעזרת  .2
בצע את השלבים  מסויםבשיפוע  Polyline-במידה וברצונך לשרטט את ה .3

 הבאים:

 . Define design slope לחץ על כפתור   
 . Enter slopeתופיע ההודעה:   AutoCAD/ZWCAD-בחלון ה 
 . Enterהקלד את ערך השיפוע ולחץ  
 . ORTHOמסומנת האפשרות  AutoCAD/ZWCAD-וודא שב 
 בשיפוע הרצוי.  Polyline-כעת תוכל לשרטט את ה 
 שוב על כפתור זה והקלד ערך חדש.לשינוי השיפוע לחץ  
 .  ESCלסיום לחץ על כפתור זה שוב ולחץ 

על מנת לעדכן את הקשתות האנכיות, ניתן למלא באופן ידני את ערכם   .4
בטבלת התכנון או ע"י סימון נקודת מעבר הקשת   Rתחת הכיתוב 

 בשרטוט:
 סמן את השורה אשר ברצונך לעדכן את רדיוס הקשת בטבלת התכנון. 

 .  Arc thru point   כפתור:לחץ על  
 הרצוי. במקום  , לחץ עם העכברבאזור השרטוט 
 במידה ולא תתאפשר מעבר קשת בנקודה זו התוכנה תתריע על כך. 
 .לאחר סימון הנקודה תוכל להבחין שבטבלה עודכן הערך בעמודת הרדיוסים  

 לסיום.  Applyלחץ  .5
 

 (. AutoCAD/ZWCADפית )ללא אשרטוט הנתונים גר -שיטה ג' 
 לשרטוט נתוני התכנון על גבי המצב הקיים, נראה שתי שיטות: 

(. Unused, Pick, Locate,Overwriteברשימה התחתונה ) Pickבחר  .1
עבור לאזור השרטוט, עמוד בצדו השמאלי ביותר של החתך )ניתן לחרוג  
מעט שמאלה מהמצב הקיים(, ולחץ על כפתור העכבר. הנקודה שבחרת 

בטבלת התכנון )למטה(. המשך   וונתוניה יופיע תיקבע כנקודת מפנה אנכית
לשרטט את חתך האורך. במהלך תנועתך על גבי אזור השרטוט, תוכל 

  Elevation -ו Stלראות את מיקומך המדויק, גובה ומרחק, תחת הכיתוב 
 בחלון הימני. Applyשמימין לשרטוט. בסיום השרטוט לחץ 

יים, משמאל או מימין, תקבע  שים לב: אם תבחר נקודה מחוץ לגבולות המצב הק
לשמאל או סוף  0התוכנה את נקודת המפנה במרחק הרץ הקיצוני ביותר )

 הקרקע הטבעית לימין(, וזאת בגובה שבו עמדת.
  -. השימוש בLocateנה בעזרת ילשרטוט חתך האורך, ה השנייההשיטה  .2

Locate דומה מאד באופן פעולתו לשימוש ב- Pick  אלא, שכאשר תבחר
קבע בדיוק בגובה המצב הקיים ימפנה במרחק רץ כלשהי, היא תנקודת 

 שבאותו מרחק.
אנכי קיים למיקום חדש נבצע זאת  IP. אם ברצוננו להזיז  Move-שימוש ב .3

אותו ברצונך להזיז,   IPשל ה ה. סמן בטבלה התחתונה את השורMoveע"י 
. לחץ IPהברשימה, עבור לשרטוט וקבע את מיקומו החדש של  Moveבחר 

Apply .בחלון מימין כדי לחדש את השרטוט 
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שהוגדר  פי(. לאחר אניתן, כמובן, לשלב בין שתי השיטות )הזנה ידנית ותכנון גר
פית, ניתן לשנות את הנתונים שהתקבלו בחלון התחתון, וללחוץ  אהחתך גר

Apply   ,לקבלת השינויים )תוכל לדוגמא, לשנות את השיפוע מול מקטע מסוים
 לעדכון השרטוט(.  Applyנוי הגובה בהתאם לשיפוע, וללחוץ  לשי Enterללחוץ 

נו מנקודת המפנה האחרונה לנקודת מפנה חדשה בהמשך.  יפי האהתכנון הגר
להוספת נקודת מפנה באמצע החתך, סמן עם העכבר את השורה של נקודת  
המפנה הקודמת )זאת שאחריה תופיע הנקודה החדשה שברצוננו להוסיף(, 

תתווסף את נקודת המפנה החדשה. הנקודה החדשה  עבור לשרטוט וסמן
 מימין להסדרת השרטוט.  Applyבמקום הרצוי. לחץ  לטבלה 

 
 פרוט נתוני שרטוט החתך

 
 Cumm. Distance – .אורך מצטבר 
 Existing G.L.–  .רום קרקע קיים 
 Top Elevation – .רום ראש צינור 
 Min Cover - .שורה זו תעודכן באופן ידני ע"י המשתמש 
 Horizontal distance – מרחק אופקי . 
 Type of pipe bend –  .)סוג הקשת האנכית )אופקית או אנכית 
 Details  – .שורה זו תעודכן באופן ידני ע"י המשתמש 
 Diameter, w.t., Coating – קוטר צינור וחומר מבנה. 
 Section N.R.  –  .שורה זו תעודכן באופן ידני ע"י המשתמש 
 Ditch Elevation-  .רום תחתית התעלה 
 Excavation Depth – .עומק חפירה 
 Slopes & Bends –  שיפועים ותפניות. התוכנה תקבע את הקשתות לפי

 הפרמטרים הבאים: 
 . 1000Dרדיוס של מעל או שווה  -Eקשת  .1
 . 10Dומעל  D200 -רדיוס של מתחת ל -Cקשת  .2
 . 10Dרדיוס עד  -Hרשת  .3

 ודעת שגיאה למשתמש. התוכנה תיתן ה 1000D -ל 200Dבקשת שבין  
 
 
 
 
 

 פעולות נוספות בחלון החתך: 
 

(. H C E -כל קבוצת קשתות תמוספר בסדר עולה נפרד )נפרד ל -הקשתות  מספור
המשתמש יוכל לקבוע את המספר הרץ הראשון לכל סוג קשת. על מנת לקבוע מספור זה 

 פעל לפי השלבים הבאים:

 .  Optionsלחץ על כפתור  Vertical alignment-בחלון ה 
, עדכן את המספור לפי הצורך Gas radius indexesבחלון שיפתח, תחת הכיתוב  

 לשלושת סוגי הקשתות:
 E-Elastic 
 C-Cold 
 H-Hot 
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 לעדכון השרטוט.  Applyלאישור וסגירת החלון ובחלון מימין לחץ  OKלחץ  
 

Accurate/By sections – הצגת חתך אורך מדויק או בחתכים בלבד. כאשר קוראת 
את חתך האורך מתוך הטופוגרפיה, היא מבצעת זאת באופן מדויק   CivilCAD 10תוכנת 

המושפע מצפיפות הנקודות המדודות )התוכנה בונה את חתך האורך על פי מפגשי צלעות 
המשולשים שהיא יוצרת מתוך קובץ המדידה(. את המרחקים הרצים שבהם דגמה התוכנה  

ית התחתונה )טבלת במצב הקיים(. לעיתים,  את הגבהים, ניתן לראות בטבלה השמאל
דגימה זאת, אל אף שהיא מדויקת, אינה טובה למשתמש )לדוגמא: בקובץ המדידה נפלה 
טעות, המופיעה בחתך לאורך אך היא אינה רלוונטית כיוון שאינה באחד מחתכי הרוחב(. 

 ה הבאה: , תפתור בעיה זאת בצורBy sectionsלבין  Accurateהעברת מצב הבחירה בין  
 Accurate  –   דגימה מדויקת של החתך. קו שרטוט החתך יהיה בדיוק

ע"פ הדגימה שבוצעה מהטופוגרפיה. הגבהים בטבלה התחתונה יופיע  
מ'(, ובנוסף יופיע גבהים   20כל  -על פי חתכי הרוחב )ברירת מחדל

 בנקודות קריטיות. 
 By sections –  ה דגימה מדויקת של החתך אך קו שרטוט החתך יבנ

ע"פ הגבהים בחתכי הרוחב בלבד. הטבלה התחתונה תישאר כפי  
 שהייתה.

 נו "בהחלקת" חתך האורך. חסרונה הוא בדיוק.יה By sectionsיתרונה של שיטת  
 

 Unlock datum–   במידה ושרטוט החתך חורג לתוך טבלת הנתונים יש לסמן אפשרות זו
שהקווים בשרטוט לא יחרגו לתוך  . התוכנה תגביה את רשת החתך על מנת Applyוללחוץ 

 הנתונים. במידה ואופציה זו לא מסומנת גובה הרשת יהיה "נעול". 
 

 כפתורי פעולה נוספים: 
 

Pick point   -  לאחר לחיצה מסוימתבדיקת נתוני קרקע ושיפועים בנקודה .
-על כפתור זה יש לבחור את הנקודה הרצויה בשרטוט. התוכנה תציג מעל לטבלת ה

Design   :את הנתונים הבאים 
 Station –  .המרחק הרץ של נקודה זו על הציר 

 Elevation –  .גובה הנקודה 
 Slp(T) –  .שיפוע הקרקע הקיימת בנקודה זו 
 Slp(D) –  .שיפוע התכנון בנקודה זו 

 

Define designed slope    – פעולה זו מאפשרת  הגדרת שיפוע מתוכנן .
ות כך בצע את השלבים הבאים: לחץ על הגדרת השיפוע לשרטוט הקו על מנת לעש

הקלד את ערך השיפוע הרצוי. כעת אם  AutoCAD/ZWCAD-כפתור זה ובחלון ה
-)בחלקו התחתון של חלון ה ORTHOלמצב  AutoCAD/ZWCAD-תעביר בחלון ה

AutoCAD/ZWCAD .תוכל לשרטט את קו התכנון בשיפוע אשר הוגדר ) 
 

(. פעולה זו  ASCII) טקליטת נתוני חתך אורך מתוך קובץ טקס 
קוראת נתוני מצב קיים לתוך הטבלה )הטבלה השמאלית התחתונה(  

מתוך קובץ טקסט פשוט שבו רשימת מרחקים רצים וגובה. מבנה הקובץ 
 צריך להיות של שורות ובהן מרחק רץ וגובה מופרדים ברווח/פסיק. 
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(.פעולה זו שומרת   ASCII) שמירת נתוני חתך האורך בקובץ טקסט 
ת נתוני המצב הקיים שנקראו מהטופוגרפיה )או הוזנו ידנית(, לתוך  א

קובץ טקסט. מבנה קבוץ הטקסט תהיה רשימה של מרחקים רצים  
 וגובה. 

 

על מנת  הטבעת הדו"ח הגיאומטרי של הקו ע"ג שרטוט התנוחה. 
להטביע את הדו"ח ע"ג השרטוט לחץ על כפתור זה, חלון התנוחה יופיע,  

 . AutoCAD/ZWCAD-בחלון הEnter  -ו setח והקלד  לחץ למיקום הדו" 
 

  -Get edgesכפתור  -הוספת נתוני גדות תעלה לחתך האורך 
יכולה לשמש לצורכי תכנון תעלה/הסדרת נחלים.  CivilCAD 10תוכנת 

תכנון כזה יתבצע בצורה דומה לתכנון כביש, אלא שחתך האורך ישמש 
אפשרות התוכנה להוסיף ( של תחתית התעלה. בIL) Invert Level -כ

לחתך האורך של התעלה, גם את חתך האורך של גדות התעלה/הנחל,  
 משמאל ומימין. להלן סדר הפעולות לקבלת חתכי אורך אלו:

 הגדר חתך אורך של תחתית התעלה )כפי המפורט בסעיף זה(.
עבור לחתכי רוחב והסדר את חתכי הרוחב של התעלה/נחל )לפרוט ראה 

 הרוחב(.  פרק הגדרת חתכי
חזור לחלון חתך האורך ולחץ על הכפתור הנ"ל. התוכנה תקרא את נתוני  

האורך   -התכנון, מתוך חתכי הרוחב, של קצוות התעלה, ותוסיפם בחתך
 הן כשרטוט, והן כשורות נוספות בטבלה התחתונה.  

 

. על מנת להציג את הנתון  Offset-קבלת גבהי הטופוגרפיה ב 
 מהציר יש לבצע את השלבים הבאים: מסוים  גבהי הטופוגרפיה במרחק

והקלד בשדה מימין לאפשרות זו   G.L. at offset (L)סמן את האפשרות  
 את המרחק מהצד השמאלי של הציר. 

והקלד בשדה מימין לאפשרות זו   G.L. at offset (R)סמן את האפשרות  
 את המרחק מהצד הימני של הציר.

תוכנה תוסיף שכבות אלו ע"ג . הApplyלאחר מילוי נתונים אלו, לחץ  
 החתך.

 

 מחתך האורך.  לגיליונות וחלוקה  DXFיצירת קבצי  
 

לאחר שסיימנו את התכנון, נרצה להוציא  : של חתך האורך  DXFיצור קובץ 
 של חתך האורך )נוכל גם כמובן לעשות כן למצב הקיים בלבד(: DXFקובץ 

 

 הנמצא בסרגל הכלים שמעל לחלון לשרטוט.   לחץ כפתור   
נו ביחס  יבחלון שיפתח הגדר קנה מידה לאורך ולרוחב. קנה המידה ה 

הקש את קנה המידה לגובה )לדוגמא:  Height-ה. בתיבת X –ל  1של 
 (.  1000הקש את קנה המידה לאורך )לדוגמא:  Long -(, ובתיבת ה100

 No Divisionללא חלוקה בחר באפשרות  DXFעל מנת ליצור קובץ  
. אם ברצונך ליצור חלוקה לפי  Divide by paper sizeתחת הכיתוב: 

 גודל דף בחר מתוך הרשימה את גודל הדף הרצוי. 
 .OKלהמשך לחץ  
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שיח קבצים שתפתח הכנס את שם קובץ השרטוט. לחץ -בתיבת דו 
Save  .לשמירת הקובץ 

 
 

מאפשרת חלוקת חתך  CivilCAD 10. תוכנת לגיליונותחלוקת חתך האורך 
בצע  לגיליונותאופן אוטומטי. על מנת לחלק את החתך ב גיליונותהאורך למספר 

 את השלבים הבאים:

 מתוך סרגל הכלים שנמצא מעל לחלון השרטוט.  לחץ על כפתור   
 בחלון שייפתח קבע את ההגדרות הבאות: 
 . Scaleהקלד את קנה המידה תחת הכיתוב  
 . Divide by paper sizeבחר את גודל הדף לחלוקה ליד הכיתוב  
על מנת לכלול בגיליון את התוואי   –  Show layoutפשרות סמן את הא 

 האופקי באותו קטע. 
את החתך   בגיליוןעל מנת לכלול  –  Show sectionsסמן את האפשרות  

 עצמו. 
 . Paper overlappingליד הכיתוב:  הגיליונותהכנס מרחק חפיפה בין  
 . Frames grid stepsהכנס את מרווחי הרשת ליד הכיתוב:  
לייבא קובץ בלוק המכיל את חץ הצפון לחץ על הכפתור ליד   אם ברצונך 

 ובחר את מיקום הקובץ.  Arrow-blockהכיתוב 
אם ברצונך להטביע בלוק המכיל את לוגו/פרטי החברה לחץ על הכפתור  

לקבוע  באפשרותך .ובחר את מיקום הקובץ Table-blockליד הכיתוב 
 . Table positionות את מיקום הבלוק מימין או משמאל לגיליון באפשר

 . Rangeתחת הכיתוב  בגיליונותהקלד את תחום החתך שיופיע  
 להמשך. OKלחץ  
 .Paper space-ב הגיליונותהתוכנה תיצור את חלוקת  
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 (. Cross sections) תעלההתכנון חתכי הרוחב של  
  

 לאחר שהגדרנו בפרק הקודם את חתך האורך של הקו, נעבור להגדרת חתכי הרוחב:
 

. לפניך יפתח  Roads → Cross sectionsל התפריט הראשי הפעל: מסרג .1
 חלון חתכי הרוחב. 

 חלון חתכי הרוחב מחולק לשלושה חלקים:
האזור המרכזי שבו יופיע שרטוט החתך. שמו של החתך  -אזור השרטוט 

 הנוכחי הנמצא בעבודה יופיע בכותרת מעל השרטוט.
 החלון הימני.  -טבלת רשימת חתכי הרוחב 
הטבלאות בחלקו  -נתוני המצב הקיים והמתוכנן לכל חתך וחתך טבלאות 

נתוני המצב הקיים בטבלה  – Existing G.Lהתחתון של המסך: 
 נתוני המצב המתוכנן בטבלה הימנית. -Designed G.Lהשמאלית, 

 

לפניך יפתח חלון   -(Define sectionsשבחלון הימני ) לחץ על כפתור   .2
 ר את הנתונים הבאים:הגדרת חתכי הרוחב. בחלון הגד

 Start at station-  בדרך כלל 0מרחק רץ לחתך הראשון. ברירת המחדל תהיה .
. אם זאת 0נרצה שהמרחק הרץ שיינתן לחתך הראשון בקטע הציר המתוכנן יהיה 

קיימים מקרים בהם אנו מתכננים קטע שהוא המשכו של ציר. במקרה כזה יהיה 
 מרחקו הרץ של החתך הראשון שונה.  

 End at station-   מרחק רץ לחתך האחרון. ברירת המחדל תהיה על פי אורכן של
הציר כפי שיחושב על ידי התוכנה )אורך זה מופיע מיד עם פתיחת חלון חתכי  

 (. Roads length -הרוחב, בחלון מימין
 Distance between sections-  המרחק בין חתכי הרוחב. ברירת המחדל הנה

אין חובה ביצירת חתכי רוחב סדרתיים, ויתרה מזאת, ניתן מ'. נראה בהמשך ש 20
 להגדיר את כל הציר באופן שאינו סידרתי.

 Name of first section-  שמו של החתך הראשון )מספרו(. התוכנה תמספר את
 המצוין בחלון, נסביר את שני מצבי    Format-שאר החתכים בסדר עולה בהתאם ל

   :Format -ה
, המציגה את שמות החתכים כפי שהם מופיעים    Format1יא האפשרות הראשונה ה

 ברשימת החתכים.
, ע"י שינוי הפרמטרים שיופיעו    Format2 אם נבחר את האפשרות 

בתחתית החלון התוכנה תציג את שם החתך בצורה הבאה:  מרחק 
, התוכנה תציג KM :0רץ+קמ ,לדוגמא: אם נשאיר את הערך בשדה 

 380+0,.... 040+0,  020+0, 000+0את החתכים בצורה הבאה: 
 

על ידי סימון מקום החתכים עוד בשלב תכנון התוואי  הינה אופציה נוספת להגדת חתכי רוחב 
האופקי, כך שהחתכים ימוקמו במקומות קבועים על גבי רקע המדידה. לעשות כן בצע 

 השלבים הבאים:
  -ה בהגדרת התוואי האופקי )החלק הראשון בתכנון התעלה(, העבר את 

Polyline אשר יקבע את ה- Center line כך שנקודות השבר שלו )ה ,-  
Vertex בחתכים.  מעוניינים( יהיו בדיוק במקומות בהם אנו 
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. התוכנה  By Ips -בחלון הגדרת חתכי הרוחב )החלון הנוכחי(, העבר ל 
תיצור חתכים במרחקים הרצים אשר יקבעו על פי נקודות השבר לאורך 

 הציר.  
 

לבניית החתכים. רשימת  OKדרת החתכים )על פי אחת מהשיטות שנבחרו(, לחץ לאחר הג
( ומרחק  Nameהחתכים שנבנו תופיע בטבלה מימין בהתאם להגדרות, ולכל חתך יופיע שם )

 (. Stationרץ )
 , בכל רגע נתון. לעשות כן בצע: לפרויקטניתן להוסיף חתכי ביניים 

 
ברצונך להוסיף חתך מקם את הסמן )בעזרת העכבר( על השורה ש 

 לפניה.
 )במקלדת(. השורה תקפוץ כלפי מטה ותופיע שורה חדשה. Enterלחץ  
בשורה החדשה הכנס שמו )מספרו( של החתך החדש. שם החתך יכול   

נו י"/" )אך לא אותיות(. אם החתך החדש ה -לכלול מספרים, "." ו
חץ  .  עבור עם ה1.1, תוכל לקרוא לו בשם 2 –ל  1לדוגמא בין חתך 

(, והכנס את המרחק הרץ של Stationהימני לעמודת המרחק הרץ )
 החתך שהוספת.

 

, לעבור מיד לחלון  ר  הערה: ניתן, במקום להגדיר חתכים באופן אוטומטי על ידי כפתו
 שם ומרחק רץ לכל חתך וחתך.  - הימני ולבנות הטבלה באופן ידני

 

תח חלון הגדרת רוחב  שבחלון הימני. לפניך יפ     Optionsלחץ על כפתור  .3
 החתכים:

הגדר את רוחב החתך לעבודה. הכוונה היא לרוחב הקרקע שתדגום   
התוכנה למצב הקיים מתוך הטופוגרפיה. אנו נגדיר מרחק מהציר  

ו יגדירו את רוחב רצועת הקרקע. את  ילשמאל ומרחק מהציר לימין שיחד
מ'(,  20-)ברירת המחדל  Left -קצהו השמאלי של החתך נגדיר בשדה ה

מ'(, כאשר  20)ברירת המחדל  Right -ואת קצהו הימני נגדיר בשדה ה
 נו חיובי.  ישלילי ומרחק מימין ה -נו מספר ימרחק משמאל לציר ה

יתכן מצב שבהן נרצה ברצועת ציר שכולה מימין )או משמאל( לציר שלנו. במקרים כאלה ניתן 
 קים הרצים המתאימים.להגדיר חתך שכולו מימין )או משמאל( וזאת בעזרת המרח

ניתן להגדיר   CivilCAD 10. בתוכנת dH  -ל  Elevation –העבר מ  
חתכי רוחב בעלי גבהים אבסולוטיים, או חתכים בעלי גבהים יחסיים.  

עבודה בגבהים אבסולוטיים תבטל למעשה את השפעת חתך האורך על 
ילוי  חתכי הרוחב, ותחייב אותנו להגדיר תכנון נפרד לכל חתך וחתך )או מ
חתכי ביניים על ידי אינטרפולציות(. בהמשך הפרק נדון בעבודה עם  

 חתכים טיפוסיים ועל כן הגבהים יוגדרו באופן יחסי.  
. אופציה זו מגדירה את אופן ההצגה Design  -ל Earthwork -העבר מ 

פית של החתך. לתוכנה שתי אפשרויות של הגדרת חתך: חתך  אהגר
, וחתך להצגת חתכים מתוכננים  Earthworksלהצגת עבודות עפר 

Design הן בצורת החתכים בחלון  ביטוי . השוני בתצוגה יבוא לידי
השרטוט, הן בהדפסתם דרך התוכנה למדפסת, והן ביצירת קובץ חתכים  

 .  AutoCAD/ZWCADעל גבי גיליון 
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תתריע כי היא . התוכנה OK. בחלון שיפתח לחץ  Get T all לחץ על כפתור   .4
לשנות את נתוני המצב הקיים לנתונים חדשים וכי הנתונים הקודמים  עומדת 

להמשך. התוכנה תעבור לאורך הציר ותדגום את נתוני המצב   OKמחקו. לחץ  יי
 הקיים לאורכו, לפי החתכים שהוגדרו. 

-פעולת דגימת נתוני המצב הקיים תלויה במספר נקודות המדידה שבפרויקט, מספר קווי אי
ר חתכי הרוחב שהוגדרו. בפרויקטים גדולים יתכן ופעולה זאת תיקח רציפות שבו ובמספה

אינה מוגבלת בגודל הפרויקט ובאורך הציר, אך במחשבים  CivilCAD 10זמן מה. תוכנת 
 איטיים או בעלי זיכרון מועט, יתכן ופעולתה תיקח זמן רב ולעיתים אף "תיתקע". 

 
בחלון השרטוט ונתוני המצב הקיים   בסיום קריאת נתוני המצב הקיים יופיע החתך הראשון 

יופיעו בטבלה משמאל למטה. בראש העמוד )בכותרת שמעל השרטוט(, יופיע שמו של 
, ובנוסף יופיע הגובה המתוכנן בציר של החתך  Sections name: 1החתך המוצג, לדוגמא: 

ן  . ניתן לעבור ביElevation: 233.85/ :הנ"ל )הגובה שנקבע לו בחתך האורך(, לדוגמא
בחר יופיע באופן  יהחתכים על ידי הצבעה על החתך הרצוי בטבלה מימין. כל חתך שי

כי הינך  אוטומטי על גבי השרטוט, ונתוניו יופיע בטבלאות למטה. להמשך ההדרכה וודא 
 נמצא בחתך הראשון.

 
(. בטבלה מופיעות שורות, כאשר Designed G.Lנסביר בקצרה את מבנה טבלת התכנון )

מקטעים    81 -)סה"כ כ 40+ועד   40- -צגת מקטע. המקטעים ממוספרים מכל שורה מיי
עמודות )השמאלית ביותר ללא כותרת(. לצורך   5אפשריים לכל חתך(. בטבלה מופיעות  

ההסבר, נמספר עמודות אלה בסדר עולה משמאל לימין כך שהעמודה השמאלית ביותר 
 : 1נה מספר יה

הסידורי של המקטע.  : בעמודה זאת מופיע המספר1עמודה מספר  
מייצג מרחק כלשהו. מקטעים משמאל לציר ייוצגו במספר   אינומספר זה 

 שלילי ומספרים מימין לציר ייוצגו במספר חיובי. 
עמודה זאת מייצגת את המרחק של המקטע  -( Offset) 2עמודה מספר  

מהציר. מרחק משמאל לציר יוכנס כשלילי ומספר מימין יוכנס כחיובי.  
ר שתי אופציות: מרחק אבסולוטי או מרחק יחסי. בעבודה  למרחק מהצי

(, יוכנסו הנתונים כמרחק יחסי,  24, כפי שמודגם כאן )ראה סעיף dHעם 
נו למעשה אורך המקטע ולא מרחק  יזאת אומרת שהמרחק שיוכנס ה
, יוכנסו נתונים אלו כמרחק  Elevationאבסולוטי מהציר. בעבודה עם 

 אבסולוטי.
)כפי המודגם   dHלעמודה זאת שתי אופציות:   -(dH) 3עמודה מספר  

)ראה סעיף   Status -. האופציות נקבעות בחלון הElevationכאן( או 
, יוכנסו הגבהים כיחסיים, ביחס לגובה המקטע dH(. בעבודה עם  24

נו למעשה גובהו של המקטע. בעבודה עם  יהקודם, כך שהגובה שיוכנס ה
Elevationם., יוכנסו גבהים אבסולוטיי 

בעמודה זה ניתן להכניס את שיפוע  – (%Slope) 4עמודה מספר  
בעמודה   dHהמקטע. באפשרותך להכניס אחד משני הנתונים: הזנת 

,  4, תחשב את שיפוע המקטע באופן אוטומטי ותזינו בעמודה 3מספר 
 . 3ותכניסו בעמודה  dH -ולעומת זאת, הזנת שיפוע, תחשב אתה 

 
 

 פעולות עריכה שניתן לבצע על הטבלה: לפני שנמשיך נסביר כעת מספר
 בשדה מסוים תגרום למחיקת השדה הנ"ל.  Delלחיצה על  
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 )חץ אחורה(, תעבוד כרגיל.  Backspaceלחיצה על  
למחיקת שורה שלמה או צמצום שורות, עמוד על העמודה השמאלית   

. התוכנה תמחק את  Del( במקטע הרצוי, ולחץ 1ביותר )עמודה מספר 
 ת השורות.המקטע ותצמצם א

ניתן להעתיק מקטע, מחתך הרוחב הנוכחי, לשאר חתכי הרוחב. לביצוע   
העתקה עמוד על המקטע הרצוי ולחץ כפתור ימני. בטבלה שתפתח סמן  

את החתכים אליהם יועתקו נתוני המקטע )לבחירת כל החתכים לחץ 
. התוכנה תעתיק את נתוני המקטע לכל OKבתחתית( ולחץ  Allכפתור 

 חרו. החתכים שנב
 

 נעבור כעת להגדרת תכנון החתך הטיפוסי: 
(. לצורך הבהרת Designed G.L -החל בהזנת נתוני התכנון בטבלה )טבלת ה .5

הנושא, אנו נדגים כאן נתונים לחתך טיפוסי שילווה בהסבר מפורט. הזן את  
 הנתונים הבאים לטבלה: 

ב , ושוEnter", 0. הזן " 2עם העכבר, בעמודה מספר  0עמוד עם מקטע   
 ". זה עתה הגדרת שהגובה בציר זהה לגובה שתוכנן בחתך האורך.0" 
, עבור  Enter -", ו1.5. הזן " 2, עמודה מספר 1עבור עם החצים למקטע  

. המקטע שזה עתה  Enter" ו -1.5והזן "   3עם החץ ימינה לעמודה מספר 
 מ' לכל צד(. 1.5מ' ) 3 -נו תחתית התעלה ברוחב של כיהוגדר ה

 
 
 

 הנתונים, הטבלה צריכה להראות כך: בסיום הזנת
 

                      
 

  בחלקה העליון והתחתון של הטבלה, מופיעים הכיתובים: 
 

Slp. left : Cut 1:        Fill 1:     
Slp right: Cut 1:        Fill 1: 

  
 שדות אלו מייצגים את שיפועי גדות התעלה, משמאל ומימין: 

". את אותו 2(, את המספר " Slp rightתית הטבלה )ליד הכיתוב , שבתח:Cut 1הכנס בשדה 
(. זה עתה :Fill 1שליד הכיתוב  :Cut 1נתון הכנס גם לאותו שדה שבראש הטבלה )שדה 

 . 1:2נם יהגדרת כי שיפועי התעלה לשמאל ולימין ה
 בחלון הימני. התכנון יופיע על גבי השרטוט. Applyלחץ כפתור  .6

 
 פוסי לאורך כל הציר שבנינו:כעת נשליך את החתך הטי 
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שמשמאל לטבלת גובה עבודות העפר     Copy -לחץ על כפתור ה .7
(Designed G.L הכפתור ממוקם משמאל לטבלה. לאחר הלחיצה תועתק .)

 לזיכרון המחשב.   Designed G.L -טבלת ה
עבור, בעזרת הטבלה בחלון השמאלי )טבלת רשימת החתכים שמשמאל   .8

)הכפתור     Pasteרשימה. לחץ על כפתור ה  לשרטוט(, לחתך האחרון ב
( על מנת להעתיק את הנתונים מהזיכרון אל תוך  Copy -שמתחת לכפתור ה
 הטבלה בחתך זה. 

 
 

נו בהזנת הנתונים בחתכים שבהם משתנה חתך  יה CivilCAD 10עיקרון העבודה של תוכנת 
ניים. כעת יש בידנו שני הרוחב )ורק בחתכים אלו!(, ומילוי שאר חלקי הציר באינטרפולציות בי

ין ריקים )תוכל לראות זאת על ידי דפדוף ביניהם  יחתכים מלאים בנתונים. שאר החתכים עד
 טבלת רשימת החתכים(: - בעזרת לחיצה על חתך מסוים בטבלה הימנית

 Interpolate empty sectionsביצוע אינטרפולציות ביניים: לחץ על כפתור  .9

.  OKכפתור על ולחץ   All designבאופציה פתח בחר י מימין. בחלון שי 
התוכנה תבצע אינטרפולציה לכל החתכים הריקים בפרויקט, ומכיוון שבידנו שני  

חתכים בלבד )ראשון ואחרון(, אשר זהים בתכולתם, תמלא התוכנה את כל  
 החתכים באותם נתוני תכנון. 

מעוניין, תוכל לעבור נך יבסיום האינטרפולציה, תוכל לדפדף בין החתכים. בשלב זה, אם ה
 לחתך מסוים ולשנות את תכולתו.

 
 הוצאת החתכים לגיליון שרטוט: 

 

 שמעל לחלון השרטוט.     - לחץ על כפתור ה .10
חלון עם רשימת החתכים, סמן את החתכים הרצויים או לחץ על  נפתח  

 . OKעל מנת לבחור את כל החתכים ולחץ  כפתור  
(, ולאורך  Heightלגובה )יפתח בחר קנה מידה לחתך יבחלון הבא ש 
(Length קנה המידה יוכנס כיחס של .)ל  1X לגובה ו   100. הזן לדוגמא

 . OKלאורך. לחץ  100
 Do you want to manually arrange crossהתוכנה תציג הודעה:   

sections, or CivilCAD 10 to do it for you?   אם ברצונך לסדר,
התוכנה תסדר את חתכי  NO ,אם לא לחץ  YESאת מבנה הקובץ לחץ 

 הרוחב באופן אוט'. 
(, התוכנה תציג חלון  YESבמידה ובחרת לסדר את מבנה הקובץ ) 

לסידור החתכים בחלון זה הכנס את מספר החתכים שיופיעו בכל טור  
 ביניהםואת המרחק האנכי   sections in every columnליד הכיתוב 
על מנת  Arrange. לחץ dY Between sections (cm)ליד הכיתוב

 . OKלראות את תרשים המבנה. לסיום לחץ 
 . Saveבחר את שם הקובץ שהתוכנה תיצור ולחץ  

 
נו קובץ שרטוט אשר ניתן לייבוא על ידי רוב תוכנות השרטוט. ב יה DXFהערה: קובץ 

AutoCAD/ZWCAD לדוגמא, ניתן לייבא קובץ זה על ידי פקודת ,DXFIN או על ידי ,File -
> Open ברת , והעFilter   הקבצים לDXF לאחר יבוא הקובץ לחץ .Zoom  ו- Extents  על ,

 מנת לראות את כל החתכים.
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מימין. בחלון    Create layoutקבלת תנוחת התעלה: לחץ על כפתור  .11
 ,Layout, Contoursאת שלושת האפשרויות הקיימות ) V -יפתח סמן ביש

Distances לחץ על כפתור .)OK צור תנוחה על גבי  להמשך. התוכנה תי
 השרטוט הכוללת את קווי המתאר של התעלה כולל קווי הדיקור.  

 כולל בתוכו שלוש אופציות:  Layout  -חלון ה
 Layout-   סימוןV   ליד אופציה זו תיצור את קווי התנוחה של התעלה

 ואת כיתוב הגבהים בחתכים.
 Contours- .אופציה זו לא תהיה פעילה בתכנון תעלות 
 Distances-  סימוןV   .ליד אופציה זו תיצור שכבת מרחקים בין החתכים

ן חתך וחתך, וכן את המרחקים בין  יהתוכנה תרשום את המרחקים ב
 החתך והטנגנטה הסמוכה אליו.

 Update current Road only –  " סימוןV  ליד אופציה זו תגדיר "
בלבד,  תעלה( –)במקרה זה  לתוכנה לעדכן את תנוחת הכביש הנוכחי

)במקרה זה  " ובפרויקט מוגדרים מספר כבישיםV" -ם נסיר את סימון הא
 התוכנה תעדכן את התנוחה לכולם. תעלות(,  –

 
, יעבור חלון חתך הרוחב למצב מינימום  Layout  -בחלון ה  OK הערה: לאחר לחיצה על ה

"  תבסרגל המשימו)על מנת שתוכל לראות את השינויים בתנוחה(. להגדילו חזרה לחץ עליו " 
אשר בתחתית המסך. המשך וערוך את החתכים בהתאם לרצוי כולל הוצאת  Windowsשל 

 . Closeהתנוחה המתאימה. בסיום עריכת החתכים לחץ 
 

 פרוט פעולות חלון חתכי הרוחב: 
 

נעבור ונפרט כעת את הפעולות הנוספות הקיימות בחלון חתכי הרוחב, שלא נידונו בשלבי 
 ההדגמה:

 
 ת חתכי הרוחב )החלון הימני(: פעולות בחלון רשימ

עמוד על החתך הרצוי למחיקה בתוך הרשימה,  -מחיקת חתך בודד  
(. התוכנה  נמצא בחלקו הימני העליון של המסך) זהולחץ על כפתור 

 תמחק חתך זה מהרשימה. 

שבחלון   X -לחץ על הכפתור עם ציור ה -מחיקת כל חתכי הפרויקט  
 למחיקה.  OKל החתכים. לחץ  הימני. התוכנה תתריע לפני מחיקת כ

: לצורך מחיקת נתוני מספר חתכים  מחיקת נתוני קבוצת חתכים  
שבחלון רשימת החתכים )החלון   Clear all -יחדיו, לחץ על כפתור ה

מצב קיים    –בחר את הנתונים למחיקה  , יפתחיהימני(. בחלון ש
(Existing G.L( גובה עבודות עפר ,)Designed G.Lגובה פני מבנ ,) ה

להמשך. בטבלה   OK( או נתוני תעלות הצד. לחץ Structureהכביש )
שתפתח סמן את החתכים שאת נתוניהם ברצונך למחוק. לבחירת כל  

. התוכנה תמחק את נתוני OKלמטה. לחץ  Allהחתכים לחץ כפתור 
 החתכים שנבחרו. 

: אופציה זו שימושית בעיקר בעבודה  הוספת גובה לנתוני החתכים  
אבסולוטיים )בגבהים יחסיים נעדיף לשנות את גובה חתך עם גבהים 

האורך על פני נתוני חתכי הרוחב(. להפעלה לחץ על הכפתור. בחלון  
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שיפתח הכנס את תוספת הגובה הרצויה )להורדת גובה הכנס גובה  
. בחלון שיפתח בחר את הנתונים שברצונך OKשלילי(. להמשך לחץ 

 OKאו גובה פני מבנה(. לחץ  לשנות )מצב קיים, גובה עבודות עפר, 
למטה,  Allלהמשך. בחלון הנוסף בחר את החתכים לשינוי )לחיצה על 

. התוכנה תוסיף את הגובה הרצוי  OKתבחר את כל החתכים(. לחץ 
 לחתכים הנבחרים, ובטבלה שבחרת )קיים וכולי(. 

 

 הימני(: החלון  –בחלון רשימת החתכים   )הפעלה על ידי כפתור  Optionsפעולות בחלון  
על חלק מהפעולות בחלון זה, דנו במהלך השלבים שבסעיף זה. נפרט אם כן את אותן 

 פעולות שלא פורטו: 
 

 Max/Min interval  – קראו נתונים חריגים אל החתכים, ילעיתים, יתכן מצב בו י
מתוך הטופוגרפיה. קיימות מספר סיבות לתופעה זאת כגון נתוני מדידה שגויים, גבול 

מגבול החתך הרצוי, אקסטרפולציות בקווי הגובה ועוד. למניעת תופעה  מדידה צר
לגובה נתון קרקע מהגובה בציר.   המקסימאליזאת ניתן להגדיר לתוכנה את ההפרש 

נקודת ההנחה היא כי הגובה בציר תמיד נכון )או לפחות אינו חורג מתחומי  
תוכנה מהו ההפרש הטופוגרפיה( ועל כן גובה זה משמש נקודת יחוס. אנו מורים ל

בגובה שאנו מתירים לשבר קרקע בחתך. כל שבר קרקע החורג מהפרש  המקסימאלי
,  230.55נו ימחק מנתוני הקרקע. לדוגמא, אם הגובה בציר היזה )למעלה או למטה( י

או גבוה  227.55מ', כל נתון קרקע הנמוך מ  3 -של כ Max/Min intervalואנו הזנו 
הקרקע של החתך. השפעת הנתון תתרחש רק לאחר מחק מנתוני  י, י233.55מ 

. אם יש כבר נתוני קרקע קיימים  GetT allשנבצע דגימת קרקע על ידי כפתור 
ליציאה, ונחזור על פעולת  OKשאותם ברצוננו לשנות, נזין את ההפרש הרצוי, נלחץ 

 . GetT all -ה
 Include edges-  עקרון הפעולה של תוכנתCivilCAD 10 י קרקע בדגימת נתונ

הוא כזה: התוכנה תדגום תמיד את נתוני המצב הקיים בציר, וכל שבר קרקע שיזוהה 
בתחום רוחב החתך, יוכנס גם הוא לטבלה. בנוסף לנתונים אלו, תדגום התוכנה את 
גובה המצב הקיים בקצה החתך, משמאל ומימין, על פי הרוחב שהוגדר. על מנת  

.  GetT allשבסימון וחזור על פעולת  " V" -הלבטל את הדגימה בקצוות, הסר את 
 התוכנה תדגום הנתונים מחדש, ללא דגימת הקצוות. 
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 פעולות בחלון השרטוט:

 
לחלון השרטוט )החלון הראשי שעליו מופיע שרטוט החתך( שלושה כפתורים מימינו. את 

הסברנו במהלך ההדרכה. נפרט את פעולת שני הכפתורים   DXF  -פעולת כפתור ה
 הנוספים:

 

 :הדפסת החתכים על גבי מדפסת  
 לחץ על כפתור המדפסת. 
קנ"מ  -Lengthקנ"מ לגובה ,  -Heightהגדר קנ"מ להדפסה:   שנפתח בחלון  

 להמשך. OK(. לחץ 1:100/1:100)קנ"מ של    100,  100לאורך. אנו נכניס 
הגדר את סוג, גודל הדף, ושאר הפרמטרים הרצויים הקשורים  שנפתח בחלון  

 )או "אישור"( להמשך.  OKותך. לחץ  במדפסת שברש

 כעת בחר את החתכים שברצונך להדפיס. לבחירת כל החתכים לחץ כפתור   
 להדפסה. OKשבתחתית החלון. לחץ 

 
רת במערכת. דהתוכנה תדפיס את החתכים באופן רציף, על פי שפת העבודה המוג

 לשינוי שפה בצע הפעולות הבאות:
 . Closeצא מחתכי הרוחב על ידי  
 .File -> Configurationל הפע 
 את השפה הרצויה.  Languageבחר ליד הכיתוב שנפתח בחלון  
 (.File -> Cross sectionsוחזור לחתכי הרוחב ) OKלחץ  
 חזור והדפס את החתכים כנלמד. 

 
 
 

 Zoom extents  –  :לשליטה בתצוגת החתך קיימות מספר פעולות 
 פסי הגלילה למטה ומשמאל לשרטוט. 
של השרטוט. לחיצה על  2הגדלה פי  -פתור שמאלי בתחומי השרטוטלחיצה על כ 
 . 2הקטנה פי   -תור ימניפכ

 מחזיר את הצפייה לכל אזור השרטוט. -(Zoom extents) כפתור   
 

 פעולות בחלון הטבלאות )החלון התחתון(: 
משמאל לכל טבלה, שמאלית וימנית, מופיעים מספר כפתורים המאפשרים פעולות על 

 ו: טבלאות אל

 מחיקת נתוני כל הטבלה בחתך הנוכחי.   

 GetT  -  ייבוא נתוני המצב הקיים של החתך הנוכחי מתוך

, מייבא כפתור זה GetT all הטופוגרפיה הקיימת. להבדיל מכפתור  
את נתוני המצב הקיים של החתך הנוכחי בלבד. לפני ביצוע הפעולה  

וכחים. אשר  תתקבל הודעת התרעה על מחיקת נתוני המצב הקיים הנ
 את ההודעה להמשך. 

 GetD  -  ייבוא נתונים מתוך הטופוגרפיה המתוכננת. להבדיל

, מייבא כפתור זה את נתוני המצב המתוכנן של GetD all מכפתור  
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החתך הנוכחי בלבד. לפני ביצוע הפעולה תתקבל הודעת התרעה על 
מחיקת הנתונים הנוכחים. אשר את ההודעה להמשך. במידה ואנו  

תמש בדגימת נתוני קרקע מתוכננת רצוי לבצע את הפעולות הבאות נש
 לפני פעולות אלו: 

 .Options לחץ על כפתור   .3
 Design: devote -40 toבחלון שיפתח סמן את האופציה:  .4

40 segments אופציה זו מאפשרת לתוכנה לדגום נתוני .
 הסגמנטים 81טופוגרפיה לתוך נתוני התכנון ע"י שימוש בכל 

)בד"כ חלק מהסגמנטים שמורים לאפשרויות אחרות  בטבלה
 כגון תעלות אוט' ,ברמות וכו'...(. 

 הוסברו במהלך הפרק(. Paste  -ו  Copy)פעולות כפתור 
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 תכנון קווי ניקוז וביוב :20פרק 
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 תכנון קווי ניקוז וביוב 
 

 עפ"י ההנחיות בחוברת. CivilCAD 10 -עבודה ב פרויקט כשלב מקדים, עליך לפתוח 
 לבי העבודה בתכנון קווי ביוב וניקוז הנם: ש
 

 . הפרויקטאתחול  
 הכנת רקע המצב הקיים ו/או המתכונן. 
 תכנון תנוחת הקווים.  
 . (crossings)סימון חציות קווים  
 תכנון חתכים.  
 פרוט הפעולות בחלון החתכים.  
 חות. " הפקת דו 

 

 הפרויקט אתחול 
 

  Pipelines →  Pipelines listמסרגל התפריט הראשי הפעל:  
 . הפרויקט. זהו חלון הגדרות כלליות של  Pipelines listמימין יפתח חלון בשם 

 
 )ביוב או ניקוז(. בפרויקט, בחר מתוך הרשימה את סוג הצנרת Pipe's type. ליד הכיתוב  1
, בחר מתוך הרשימה  את יחידות העבודה לקוטר צנרת )מ"מ  Diam units. ליד הכיתוב 2

 ,ס"מ ,אינצ'ים(.
 . בפרויקט, מלא בכל שורה את שמות הקווים המתוכננים Pipelines names. תחת 3
 . OK. לסיום לחץ 4
 

 כעת נעבור אל תכנון הקווים.  
 בפניך עומדות שתי אפשרויות תכנון: 

 . תכנון כולל תנוחה. תכנון תנוחה יאפשר לך לקבל את חתך הקרקע לאורך הקו. 1
 . תכנון ללא תנוחה.2

 
 .הכנת רקע המצב הקיים ו/או המתוכנןוחה המשך אל סעיף לשם תכנון עם תנ

 אם ברצונך לתכנן ללא תנוחה, עבור אל סעיף תכנון חתכים.
 

ללא תנוחה, באפשרותך לבצע סימון  ובין אם * בין אם הינך מבצע תכנון קווים עם תנוחה 
 . חציות קוויםלשם כך עבור לפרק   crossings)חציות קווים )

 
 

 Pipeline`s listון פרוט הפעולות בחל

  New pipeline -   הוספת קו חדש לרשימת הקווים. ניתן גם ע"י לחיצה עלENTER. 
 

Clear all pipelines  –   מחיקת כל רשימת הקווים )הקווים ימחקו מהרשימה ואם
 (. מהפרויקטהוגדרו להם נתונים הם גם יימחקו 

 

Erase pipeline  –  ם הקו ברשימה וללחוץ על כפתור  . יש לסמן את שמסויםמחיקת קו
 (. מהפרויקטזה על מנת למחוק אותו מהרשימה )אם הוגדרו נתונים לקו זה הם יימחקו 
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 Find Pipeline – .במידה ומזינים שם לצינור   מציאת צינור על פי שם ברשימת הקווים
ר  שכבר קיים ברשימת הצינורות, התוכנה תתריע על כך ולא תאפשר הזנת שם זהה לצינו

 הנ"ל. 
 

 הכנת רקע המצב הקיים ו/או המתוכנן 
 

 על  מנת לתכנן את תנוחת הקווים, עליך להכין ראשית כל את רקע הטופוגרפיה לתכנון.
 באפשרותך לעבוד עם עד שתי שכבות טופוגרפיה: מצב קיים ומצב מתוכנן. 

צב אם אתה עובד עם שכבת טופוגרפיה אחת, התייחס אליה כאל מצב קיים )גם אם היא מ
 מתוכנן(.

 
 :לפרויקט בפניך מספר אפשרויות להבאת המצב הקיים 

 
, כמוסבר בפרק לפרויקט, הבא אותו Dwgאם ברשותך קובץ  -Dwgייבוא קובץ  

והוצאת נקודות מקובץ   Dwg)בצע את השלבים: יבוא קובץ  Dwgטיפול בקבצי 
Dwg. ) 

 
         של הקרקע בצע:    ASCIIאם ברשותך קובץ   ASCII- ייבוא קובץ 

 לחץ על כפתור:   קואורדינטותה.  מתוך כפתורי הפעולה של רשימת 1
 Topography–)נמצא בקבוצת הכפתורים  הממוקמת מעל לרשימת ה 

coordinates    שבתחתית המסך(. אם רשימה זו לא מופיעה ניתן להציג
 . Topography->Coordinates-אותה ע"י בחירה מתוך התפריט הראשי ב

של המצב  קואורדינטותהדו השיח שנפתחה בחר את קובץ  . בתיבת2 
שבתחתית  המסך  תוזן בנתוני  קואורדינטותההקיים. רשימת 

 . קואורדינטותה
 

 באפשרותך להזין ידנית את נתוני הטופוגרפיה:   - באופן ידני 
  coordinates  –בשורת עריכת הנקודות )השורה הריקה מתחת לכותרת 

Topographyני הנקודות באופן הבא:  גובה ( הקלד את נתוy    x     שם
 הנקודה

 .        Enterאחרי כל נקודה לחץ 
 

הנמצא בסרגל הכלים הראשי מעל  , לחץ על כפתור  קואורדינטותהלאחר הזנת נתוני  
 לחלון השרטוט וצור קווי גובה:

 . Topography → Contoursבחר, מהתפריט הראשי:   
 . Applyשנפתח מימין, לחץ על כפתור  Topography contours –בחלון ה  

 שהוכנסו.  קואורדינטותלהתוכנה תבנה את קווי הגובה בהתאם 
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 הוספת שכבת המצב המתוכנן
 

 Topography –אם ברשותך נתוני שכבה נוספת, מתוכננת, החלף את רשימת ה 
coordinates  ל– Design coordinates   :ע"י בחירה מהתפריט הראשיDesign → 

Coordinates . 
 הזן את נתוני המצב המתוכנן כפי שהזנת את נתוני המצב הקיים.  
 

 לאחר הזנת נתוני המצב המתוכנן, צור קווי גובה מתוכננים :
 . Design → Contoursבחר, מהתפריט הראשי: 

 . Applyשנפתח מימין, לחץ על הכפתור  Design contours –בחלון ה 
 שהוכנסו. קואורדינטותלבהתאם  התוכנה תבנה את קווי הגובה המתוכננים

 

 תכנון תנוחת הקווים. 
 
a.  מסרגל התפריט הראשי הפעלPipelines →List   מימין נפתח מסך .

 (.Listהתנוחה )
 הזן שם לצינור, הגדר את יחידות המידה לקוטר, והגדר את סוג הצינור. 

 ע. עגול או מרוב –בתכנון קו ניקוז, ניתן להגדיר גם את פרופיל הצינור  :הערה 
b. מסרגל התפריט הראשי הפעל Pipelines → Layuot  נפתח  . מימין

 (. Layoutמסך התנוחה )
c.  בחר את שם הקו שברצונך לסמן בתיבה שבראש חלון ה-  Layout . 
d.  .סמן את תוואי הקו 

 בפניך שלוש דרכים לסימון התוואי:         
  

 :שיטה א'        
 

( שיהווה את התוואי 2D Polyline)  Polyline, העבר   AutoCAD/ZWCAD –ב  
 האופקי של הקו. 

 .בתיבה:    Selectבחר  
. הטבלה Enterהמשורטט ולחץ   Polyline -עבור אל אזור השרטוט, בחר את ה 

בחלון מימין תתמלא ברשימת השוחות של הצינור,מספרי השוחות והמרחקים הרצים  
פיע רשימת  תו Design coordinates)   - חלון ה)לכל שוחה. בחלון התחתון  

 שלהם.  קואורדינטותה
  

 : שיטה ב'        
 

 .בתיבה:   Pickבחלון הימני, בחר   
 עבור אל אזור השרטוט ושרטט את תוואי הקו.  
ובמרחקים   קואורדינטותבנך משרטט, טבלת השוחות מתמלאת יהבחן כי בזמן שה 

המתוכננות מתמלאת   קואורדינטותה(. כמו כן רשימת  Stationsרצים )
 נך מסמן.ישה ורדינטותקואב
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 :  שיטה ג'        
 

המתוכננות שבתחתית המסך. עשה זאת  קואורדינטותהבטבלת  קואורדינטותהזן  
 בשורת העריכה שבראש הרשימה. לדוגמא: קואורדינטותהבאמצעות הקלדת 

  

256123.76 175143.56 MN1 

256325.56 175200.40 MN2 

256327.12 175256.00 MN3 

 
( MN1 ,MN2 ,MN3) קואורדינטותהמימין, הקלד את שמות  Layout – בטבלת ה 

 עפ"י הדוגמא הבאה:
 

                        

Diam. St. Man Coor.  

      MN1 

      MN2 

      MN3 

 
 

 * באפשרותך לשרטט קו המתחבר לקו אחר בשוחה משותפת, באופנים הבאים: 
ת את כל הסעיפים של תכנון התנוחה עבור הקו  צעי' , אחרי שבשיטה אנך עובד ביאם ה

 הראשי ועברת לתכנון קו המשני המתחבר לראשי בצע:
שלו אל הקו     Polyline –של הקו המשני, חבר את ה   2D Polylineנך משרטט יכאשר ה

( משותפת לשניהם. המשך בשאר הפעולות כרגיל. נקודת  IPהראשי בנקודת שבירה )
 תפת לשני הקווים. השבירה תתפרש כשוחה משו

 השוחה המשותפת תסומן ע"י התוכנה בסימן "+", בקו המשני. 
 

)העמודה:   קואורדינאטהמופיע משמאל שם    Layout - * הבחן כי לכל שוחה בטבלת ה
Coor. מופיעים בטבלת ה  הקואורדינאטה(. נתוני–  Design coordinates   שבתחתית
 המסך.

על מנת שלא יאבד הקשר בין    Layout –בטבלת ה  ההקואורדינאטרצוי לא לשנות את שם 
 שלה.  לקואורדינאטהשוחה 

 –שלה, בטבלת ה  הקואורדינאטהלמעשה באפשרותך לשנות מיקום שוחה ע"י שינוי נתוני 
Design coordinates   

 מופיע פירוט על אופן הזזת שוחות. Layout  –אפשרויות נוספות בחלון ה בסעיף 
  
e.  :מול כל שוחה בטבלת ה הזן קטרי צינורות- Layout  מימין, הזן את

 הרדיוס הרצוי. 
f.   לחץApply .לשרטוט הקווים 

 התוכנה תיצור שרטוט של התוואי האופקי של הקו.  
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,  Layout –על מנת לעבור לתכנון הקו הבא, בחר את שם הקו בתיבה שבראש חלון ה 
 ובצע את התכנון כמוסבר לעיל.

 
בסיום תכנון של כל קו וקו. ניתן לתכנן את כל הקווים   Applyאין צורך ללחוץ   –* הערה 
 על מנת שהתוכנה תבנה את שרטוט הקווים.   Applyללחוץ  ובסיום

 
 :Layout -אפשרויות נוספות בחלון ה 

 

     Options-  את ההגדרות הבאות:בחלון שנפתח , ניתן לשנות זהע"י לחיצה על כפתור 
 Scale- וני הצינור. שינוי גודל הכיתוב של נת 
 Pipes number in select mode (manholes perfix) –  המספורשינוי תחילת  

תגרום לצינור הבא שיוגדר   2של שמות הנקודות של השוחות לדוגמא: הכנסת הערך 
 3-ב  שיתחילו, לקו שיוגדר אחריו שמות 2MN1 2MN2. 2MN3  להכיל את השמות: 

 וכ"ו.. 
 לעדכון השרטוט.   OKוץ שוב עללאחר השינויים בחלון זה יש ללח

  Pipeline width-  ,ללא  -1מציין את עובי ברירת המחדל,   0עובי הצינור בשרטוט
 עובי.  

 Display angle value –   צינורות ע"ג שרטוט תנוחת   2הצגת נתון הזוית בין
 הצינור. 

  

   Clear all manholes- הנוכחי.  מחיקת כל נתוני הקו 
 

   Delete one manhole-  מחיקת שוחה בודדת.  סמן את השוחה הרצויה ולחץ על
 מצינור זה. מסוימתכפתור זה כדי למחוק שוחה 

         

   - Show pipeline .איתור צינור ע"ג השרטוט. לחץ על הצינור הנוכחי יסומן בצהוב 
 

Pipe type –  .הקלדת טקסט חופשי לצורך תאור סוג הצינור 
 
 

 הזזת שוחה. 
בחלון   קואורדינאטה. באם תשנה נתוני לקואורדינאטהי כל שוחה קשורה שים לב כ

 .קואורדינאטהשבתחתית  המסך, ישתנה מיקום השוחה הקשורה לאותה  קואורדינטותה
 אליה השוחה קשורה. הקואורדינאטהע"מ להזיז שוחה , עליך להזיז את 

 בפניך שתי אפשרויות: 
 

 : הקואורדינאטהשינוי ידני של נתוני  
 

שברצונך  הקואורדינאטהשבתחתית המסך, בחר את   קואורדינטותהימת ברש
בשורת עריכת הנקודות )השורה  הקואורדינאטהלשנות. ערוך  מחדש את 
 (. Design coordinates –הריקה מתחת לכותרת 

 שמימין.  Layout  –בחלון ה  Applyלמימוש השינוי בשרטוט, לחץ 
  

 :הזזת השוחה מתוך השרטוט 
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המתוכננות שבתחתית המסך את   קואורדינטותהמימין לרשימת בחר במלבן ש

 .:  Moveהאופציה 
עבור אל אזור השרטוט. בחר את הנקודה שברצונך להזיז ולחץ עליה 

במיקום החדש אליו ברצונך להעביר את  עם העכברפעמיים. כעת לחץ 
 הנקודה.

 ימין. שמ Layout –בחלון ה  Applyלמימוש השינוי בשרטוט, לחץ           
 
 

 שינוי צורת שוחה בשרטוט. 
 באפשרותך לקבוע אם שוחה תהיה עגולה או מרובעת.

 ניקוז.  בפרויקט ביוב ושוחות מרובעות  בפרויקט ברירת המחדל היא שוחות עגולות 
 – סמן באמצעות העכבר את השוחה שברצונך לשנות בטבלת ה –לשם שינוי צורת שוחה 

Layoutתיבה נפתחה כפתור ימני בעכבר. על הטבלה ולחץ . עמוד על הטור הימני ביותר ב
  Apply. בחר בצורה הרצויה. בפעם הבאה שתלחץ   Squared –ו  Roundעם אפשרות : 

 השרטוט יתעדכן בהתאם. 
 

 שרטוט קו המסתיים ללא שוחה. 
( אל שם השוחה -אם ברצונך לסיים קו ללא שוחה )באזור שפך למשל( , הוסף את הסימן )

 1.3-       מימין. לדוגמא:
 התוכנה תזהה כי זו נקודה ללא שוחה ולא תשרטט בנקודה זו שוחה. 

 
 שינוי שם שוחה. 

 . Layout –שבטבלת ה   Man. –באפשרותך לשנות שם שוחה בעמודת ה 
 

   (Crossings)סימון חציות קווים 
 

אלה  , אם נקודות  לפרויקטבאפשרותך לסמן נקודות חציה של קווים ע"י קווים שאינם שייכים 
 ידועות לך. 

 Pipelines → Crossingsלשם כך בחר מהתפריט הראשי:  
 

 . Crossings  –מימין יפתח חלון ה 
 נסביר תחילה את מבנה הטבלה בחלקו העליון של חלון זה:

St.   במטרים(. בפרויקט : מרחק רץ. הכוונה למקום בו עובר הקו  החוצה על גבי הקו הקיים( 
IL. צה )לא חובה למילוי(.: רום פני הצינור החו 

Dpt. .)עומק הצינור החוצה )לא חובה למילוי : 
Diam.  .קוטר הצינור החוצה. נתון זה אינו חובה למילוי : 
Type  הזן את האות( חציה מימין או משמאל :R   לחציה מימין אוL  )נתון  –לחציה משמאל

 זה אינו חובה למילוי. 
 
 ( בתיבה שבראש החלון. crossingsיות). בחר את הצינור עבורו ברצונך לסמן חצ1
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 ע"י אחת מהדרכים הבאות: .Station - . מלא את נתון ה2
 

 מרחק רץ של הקווים החוצים במטרים.  Crossings  –בטבלת ה  הזן  -באופן ידני 
 

 . Pick –שימוש ב  
 בתיבה שבתחתית החלון.   Pickסמן  
   Station –.נתון ה  עבור אל אזור השרטוט וסמן את הנקודה בקרבת הקו הרצוי 

   AutoCAD/ZWCAD. למשתמשי גרסת crossings –יוזן אוטומטית בטבלת ה 
אליהן   להיצמדאם ברצונך לסמן נקודות שקיימות כבר בשרטוט, באפשרותך  -

 -לנקודה ב   Object Snap Settingsע"י שימוש באפשרות של  
AutoCAD/ZWCAD . 

                                                                                                   
לרשימת  החצייה. לשם כך עליך, קודם כל להוסיף את נקודות Locate –שימוש ב  

, להציגן על גבי השרטוט ולאחר מכן CivilCAD 10 –המתוכננות ב  קואורדינטותה
 : Locate  –לבחור אותן ע"י שימוש ב

 . Design → Coordinatesבחר בתפריט הראשי:  
 Design coordinates –בטבלת ה  החצייהשל נקודות  קואורדינטותההקלד את  

 שבתחתית המסך משמאל. 
  –נעשית בתוך שורת עריכת הנקודות שבראש חלון ה  קואורדינטותההקלדת  

Design coordinates      :לפי הפורמטx     y         שם נקודה. )אין להקליד
 . Enterהקלדת כל נקודה לחץ  גובה נקודה( . בסיום

 לרענון השרטוט. בסיום הרענון, הנקודות יופיעו על גבי השרטוט. לחץ  
 מימין.   Crossings  –בחלון ה   Locateבחר  
  –עבור אל אזור השרטוט וסמן את הנקודות אשר הקלדת קודם לכן בטבלת ה  

Design     coordinates    ע"י לכידתן. נתון ה–  Station וטומטית לטבלת ה יוזן א–  
Crossings . 

 
באפשרותך לבחור את הקו החוצה את הקו הנוכחי ע"י סימון קו   .Select -שימוש ב 

, עבור   Select. לחץ על בפרויקטמשורטט ע"ג התנוחה גם אם אינו מוגדר כציר 
, הטבלה תתעדכן במרחקים ENTERלאזור השרטוט וסמן את הקו הרצוי. לחץ 

ההצטלבות לפי הגובה שמוגדר בקו המשורטט. אם בקו הרצים ותחשב את גובה 
מטר מתחת לגובה  1.5 -שבחרת אין גובה התוכנה תגדיר את גובה ההצטלבות כ

 המצב הקיים באותה הנקודה.
 

. באפשרותך לבחור מספר קווים שחוצים את הקו הנוכחי ע"י Filtering -שימוש ב 
י קווים בבת אחת ע"י סינון קווים אלו מהשרטוט ממספר שכבות וממספר סוג

 הפעולות הבאות:

פתח החלון  י , יFilter crossings lines from dwg לחץ על כפתור   
Filter crossings . 

( את השכבות שבהם נמצאים  Layersבאפשרותך לסמן ברשימת השכבות ) 
 -Select( את סוג הקווים או להשתמש בEntitiesהקווים וברשימת הצורות )

קווים המסמלים את סוג הקו והשכבה שמהם אנו נבצע  וללחוץ על הקו או ה
 את הסינון.



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  333עמוד 

כדי לבצע את הסינון. בקווים שאינם מכילים גובה התוכנה תקבע  Applyלחץ  
 מטר מתחת למצב הקיים באותה נקודה. 1.5-את גובה ההצטלבות כ

 
אילו  וקוטר הצינורות, אם יש )שני נתונים   IL –הזן את נתוני ה  Crossings . בטבלת ה3

 אינם חובה להקלדה(. 
  חציות הקווים יופיעו בשרטוט החתכים.

 

 . Crossingsאיתור מיקום חציית קווים בתנוחה מתוך תפריט  - 
 

Don’t scan crossings nearer than [ X ] m  –  למשתמש מאפשרת זו אפשרות  
המרחק  בטווח התוכנה תתעלם מהחציה, שתי חציות בין X -ל מתחת מרחק להגדיר
 . המוגדר

 

 תכנון חתכים 
 
 . Pipelines → Sections. מסרגל התפריט הראשי, הפעל:  1
 החלון שיפתח מחולק ל:  לפניך יפתח חלון החתכים. 

 משטח השחור(.אזור השרטוט )ה -         
 (. Topoהטבלה משמאל למטה ) -טבלת נתוני הקרקע  -         
 הטבלה מימין למטה. –טבלת נתוני השוחות  -         

 . בחר את הקו שברצונך לתכנן בתיבה שבראש החלון מימין :  2 
  

. משמאל נפתח חלון ההגדרות.  Options  :  לחץ על כפתור קביעת ההגדרות לתכנון. 3
 ן זה באפשרותך לקבוע את ההגדרות על פיהן התוכנה תיישם את התכנון:בחלו

 Slope calculation –   אופן חישוב השיפועים: באפשרותך לבחור בין חישוב
 . Edges, או מקצות שוחות ע"י בחירת Centersשיפועים ממרכזי שוחות ע"י בחירת 

 - Min. Manhole`s cover(Cm) וחה במקרה של  לשוחה. כיסוי ש מינימאליכיסוי
 חשיפת שוחה מעל פני הקרקע.

  - Min. Pipe`s cover(Cm) לצינור. אם נתון זה קיים, התוכנה   מינימאליכיסוי
תתריע בנקודות בהן יש חשיפת צינור ע"י סימון בצבע כתום ע"ג הקרקע באזור 

 החשיפה.
 External Drop –  באפשרותך לקבוע כי עבור מפלים מגובה מסוים התוכנה

 מפל חיצוני.  תשרטט
 Keep slopes inside manholes-   שמירת שיפועים בתוך שוחות. אם אופציה זו

 תסומן, התוכנה תשמור על השיפוע של כניסת הצינור לשוחה, גם בתוך השוחה.
 Fit pipes top levels -   
 Check crossings –  התוכנה תבדוק את גובה הצינור במצב של הצטלבות עם

 תו במידת הצורך. צינור אחר ותשנה או
 Keep fixed IL -  ע"י סימון אפשרות זו התוכנה תשמור עלInvert level   קבוע

 .מסוימתבשוחות גם אם נבצע שינוי בשיפוע של שוחה 
 Keep fixed slopes –   זו התוכנה תשמור על שיפועים קבועים  אופציהע"י סימון

 .מסוימתשל שוחה  ILגם אם נבצע שינוי ב 
 Slopes precision –   צורת הדיוק בהצגת כיתובי השיפועים ע"ג הטבלה בשרטוט

 החתך.
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 Manhole's size table  –  שינוי חלוקת גודל השוחות לפי עומקים )ראה הרחבה
 . פרוט הפעולות בחלון החתכיםבסעיף 

 
 
 
 : נתוני טופוגרפיהיבוא . 4

ות התוכנה בצעת את הסעיפים: הכנת רקע המצב הקיים ותכנון תנוחת קווים, באפשר אם

המופיע משמאל לטבלת   לגזור את נתוני הקרקע מהתנוחה:  לחץ על כפתור  
( ורום  stationהטופוגרפיה. טבלת  הטופוגרפיה תתמלא בנתוני המצב הקיים לפי מרחק רץ )

    (.elevation)פני הקרקע 
  הקלד נתוני טופוגרפיה בטבלת הטופוגרפיה –אם לא בצעת את שלב תכנון התנוחה תנוחה 

 )רום פני הקרקע(.   Elevation –)מרחק( ו  Distance)מרחק רץ( או   Stationלפי 

בצעת את הסעיפים: הכנת רקע המצב אם (: הזנת נתוני קרקע מתוכננת )לא חובה. 5
הקיים ותכנון תנוחת קווים, באפשרות התוכנה לגזור את נתוני קרקע המתוכננת מהתנוחה:  

לטבלת הטופוגרפיה. טבלת הטופוגרפיה תתמלא בנתוני  המופיע משמאל לחץ על כפתור  
 קרקע מתוכננת.

בחר  Ground Level -אם ברצונך להזין ידנית נתוני קרקע מתוכננת, בצע: בטבלת ה 
 .  ”Design“באופציה 

 הזן נתוני הקרקע המתוכננת באותו האופן בו הזנת את נתוני הטופוגרפיה. 
 
 

מימין(. על המסך יופיע שרטוט הטופוגרפיה עם   להבאת השרטוט )מופיע  Apply. לחץ 6
 סימון מיקום השוחות, אם קיימות. 

 
 : פרוט נתוני השוחות .7

 
 Man .מספור השוחה : 
 St  מרחק רץ )במטרים(. אם בצעת תכנון תנוחה, נתון זה כבר מופיע בטבלה. אם :

 . Enterנתון זה ריק, הזן אותו לגבי השוחות המתוכננות. ע"מ להוסיף שוחה, לחץ 
של שוחה   .Stב 0להזין מרחק בין שוחות במקום מרחק רץ. הזן  באפשרותך 

 . Distance’ . עבור שאר השוחות הזן Enterראשונה ולחץ 
 Distance  –  באפשרותך להזין מרחק בין שוחות במקום   –המרחק בין השוחות

 במרחק הרץ של השוחה הראשונה.  0מרחקים רצים, בתנאי שתזין 
 IL Lt.  את גובה הכניסה באפשרותך למלא  סה כניסת הצינור לשוחהכני: גובה .

 במספר אופנים: 
 עבור כל השוחות. .IL Lt –הזנת נתוני ה  
 ( Depth –הזנת עומק שוחה )ראה  
 (.%Slשל שוחה ראשונה ושיפועים עבור שאר השוחות )ראה  .IL Ltהזנת  
יף  ראה סע –תכנון צינור באופן אינטראקטיבי )שרטוט פיזי של השוחות  

 אפשרויות נוספות(. 
 Drop הכוונה להפרש בין גובה כניסה  –: מפל בתוך השוחה ) IL Lt.  לגובה יציאה )

 (IL Rt.  .)במטרים( ) 
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 Depth עומק שוחה )במטרים(. באפשרותך להזין נתון זה עבור השוחות במקום :IL 
Lt העומק יתייחס אליהם. –. אם קיימים נתוני קרקע מתוכננת 

 Sl (%)  ע כניסת הצינור לשוחה. יש באפשרותך להזין שיפוע כניסה לשוחה : שיפו
 . Invert levelבמקום 

 Diam  . קוטר הצינור : 
 Wall Thick (mm)  .עובי דופן צינור : 
 Receptors  .קולטנים : 
 Size  :גודל השוחה. אם השוחה עגולה רשום כוכבית משמאל לגודל, לדוגמא :

 יחידות הגודל לפי רצונך. .  100/80*. אם השוחה מרובעת רשום כך: 100
 Pop השוחה מעל פני הקרקע )בס"מ(.  תטי: בל 
 Ground   רום פני הקרקע בשוחה. לא למילוי ע"י המשתמש. התוכנה תמלא נתון :

זה. אם ישנם נתוני קרקע מתוכננת עבור הקו המתוכנן, אזי נתוניה יופיעו בעמודה זו.  
 ניה יופיעו בעמודה זו. אם קיימים רק נתוני קרקע קיימת , אזי נתו

 Gr. Sl.  "המשתמש. גם כאן, השיפוע מתייחס לקרקע  י: שיפוע הקרקע. לא למילוי ע
 מתוכננת, אם זו קיימת. אם אין קרקע מתוכננת, אזי השיפוע מתייחס לקרקע קיימת.

  
 לשרטוט התכנון.  Apply.  לחץ 8
 
 
 

 פרוט הפעולות בחלון החתכים 
 

  - Save projectלחיצה על כפתור זה  – תוך סרגל הכלים שמעל לשרטוט(שמירה )מ
 , כפתור זה מאפשר את השמירה מבלי לצאת מחלון החתכים. הפרויקטתבצע שמירה לכל 

 

 של חתך לאורך בודד, או של כל החתכים:   Dxfיצירת קובץ  
 לאחר לחיצה על כפתור זה תפתח חלון, נסביר את האפשרויות בחלון זה: 

 .Height,Longבשדות מלא את קנה המידה  
הרצוי   הגיליון , בחר את גודל מסוים גיליוןעל מנת להדפיס את החתך לפי גודל  

 . Divide by paper sizeברשימה הנפתחת, תחת הכיתוב 
. על מנת לקבל קובץ עם כל  OKעל מנת להוציא את החתך הנוכחי בלבד ,לחץ   

 .DXF-Allהחתכים לחץ 
מיקום הקובץ, הקלד שם קובץ ולחץ   נפתחה תיבה לשמירת קבצים. בחר את 

 שמירה.
 

לאחר לחיצה על כפתור זה יפתח חלון שבו יש להקליד את קנה  –הדפסת החתך   
בחלון    OKכדי להדפיס את החתך ולאחר מכן יש ללחוץ   OKהמידה וללחוץ על כפתור
 ההגדרות של המדפסת. 

 

גה של כל החתך ע"ג חלון  יש ללחוץ על כפתור זה על מנת לצפות בתצו –תצוגה מלאה   
 השרטוט.

 

 כפתור זה מוחק לגמרי את השוחה, כולל מרחק רץ. -מחיקת שוחה 
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שומר את נתוני המרחקים   –.  )לא מבטל לגמרי את השוחה מחיקת נתוני כל השוחות  
 ומרחקים בין השוחות(. .St–הרצים 

 
ה של השוחה . סמן את העמודה השמאלית ביותר בטבלת השוחות בשורהוספת שוחה

רשום את  שתתווסףבמקלדת. בשורה  Enterהעוקבת את השוחה שברצונך להוסיף , ולחץ  

 המרחק הרץ של השוחה החדשה או את מרחקה מהשוחה הקודמת ואת שאר פרטיה.

פעולה זו תעתיק את  – העתקת המרחקים הרצים של נתוני הקרקע אל טבלת השוחות 
 אל טבלת השוחות, לצורך נוחות תכנון.   Topography -מטבלת ה  Stations -ה
 

התוכנה תמלא את גודל השוחות בהתאם לגובהן  - הזנת גודל שוחות באופן אוטומטי 
 עפ"י התקן. 

 
באפשרותך לקבוע את האופן בו התוכנה תזין את  -שינוי חלוקת גודל שוחות לפי עומקים

 גדלי השוחות.  

 (תכנון החתכיםזה ראה . )להרחבה על כפתור   Optionsלחץ על כפתור  
 . Manholes size tableבחלון שנפתח לחץ על הכפתור:  
 פתח חלון גדלי שוחות.ילפניך י 
 . Shapeבחר את סוג השוחה )מרובעת או עגולה( ליד הכיתוב   
הזן גודל שוחה )עבור שוחה מרובעת רשום עפ"י   ”Size“בעמודה שכותרתה  

 (  80/100הפורמט:
 ” הזן את העומק שעד אליו יינתן הגודל המתאים.Up to depthבעמודה שכותרתה “ 
 . OKלאישור לחץ  

על יד    CivilCAD 10 -חדש ב פרויקט*באפשרותך לקבוע חלוקה רצויה קבועה עבור כל 
 ושמירת השינויים.  Prototypeשנקרא  פרויקטביצוע השלבים הנ"ל בתוך 

 
 חדל: הפרויקט נמצא במיקום ברירת המ Windows 7/8/10במערכת הפעלה 

C:\ProgramData\SivanDesign\CivilCAD\Prototype.prj\ 
 

 . Auto Design –פתח חלון ה י: לחץ על הכפתור. לפניך יתכנון אוטומטי 
 באפשרותך להשתמש בתכנון אוטומטי של חתך הקו בשתי שיטות : 
 Mode 1 :   בשיטה זו , המשתמש מזיןIL LT.   של שוחה אחת בטבלת השוחות, כיסוי

ותשנה את  המינימאלילקו. התוכנה תבנה קו עם השיפוע  מינימאלילצינור ושיפוע  מאלימיני
 שיפוע הקו באם תהיה חשיפת צינור. 

Mode 2 :  בשיטה זו , המשתמש מזיןIL lt.   של שוחה אחת בטבלת השוחות, כיסוי
חשיפת  לצינור ושיפוע לקו. התוכנה שומרת על שיפוע קבוע של הקו, ובמקום בו יש  מינימאלי

 צינור, היא יוצרת מפל בשוחה שלפני החשיפה.   
 . OKמלא את הנתונים בהתאם ולחץ 

 הבחן כי נתוני השוחות התמלאו בהתאם. 
Mode 3 :  תכנון קו גרביטציוני 

 והגדר קו כביוב/ניקוז.  ’Pipelines→List‘מהתפריט הראשי הפעל:  •

 הקו. והגדר את תוואי  ’Pipelines→Layout‘מהתפריט הראשי הפעל:  •
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 . ’Pipelines→Sections‘מהתפריט הראשי הפעל:  •

רצוי והקש   .I.L, הגדר '.IL Lt', תחת עמודת 'Manhole's details'בטבלת  •

 . 'ENTER'על כפתור 

 ייפתח.  'Auto Design'. חלון   'Auto Design'לחץ על כפתור  •

ולחץ על כפתור   'Mode 3: Gravitational design'סמן את האפשרות  •

'Define slopes according to stations'   חלון .'Pipes stations'  

 ייפתח. 

 הזן את התנאים הרצויים עבור תכנון הקו הגרביטציוני.  •

 

ו   'Slope'תבצע בדיקה של הנתונים שהוזנו בעמודות  CivilCAD 10תוכנת  :הערה 

– 'Depth'  ,ותבדוק אם ע"פ שיפוע שהוגדר מתקיים העומק שהוגדר. במידה ולא

ועומק  1%: במידה והוזן שיפוע  לדוגמאכנה תפעל לפי התנאי המחמיר יותר. התו

התוכנה  –ס"מ  60-ס"מ וישנו מצב בו בשוחה הבאה עומק השוחה פחות מ 60

 ס"מ ובכך ישתנה אחוז השיפוע.  60-תעמיק את השוחה עד ל

 

 לביצוע החישוב ובניית חתך הקו. 'OK'לחץ על כפתור  •

 
       

, כולל קווי גובה בפרויקט. )בתנאי שקיימת קרקע מתוכננת קע מתוכננתהבאת נתוני קר  
 מתוכננים וכן קיים תכנון תנוחת הקווים(. 

 

. )בתנאי שקיימת קרקע מתוכננת הבאת נתוני קרקע מתוכננת עבור כל הקווים  
 , כולל קווי גובה מתוכננים(.בפרויקט

 

, כולל בפרויקטשקיימת טופוגרפיה  .  )בתנאיהבאת טופוגרפיה קיימת עבור כל הקווים  
 קווי גובה וכן קיים תכנון תנוחת הקווים(. 

 

. ע"י לחיצה על כפתור זה ניתן לבחור בחלון הקבצים שייפתח קובץ  ייבוא קובץ חתכים 
ASCII .המכיל את נתוני החתכים 

 

. לאחר לחיצה על כפתור זה יש לסמן בחלון שנפתח את הורדת גובה לשוחות\הוספת 
אם ברצוננו לבחור את כל  Aלהוריד גובה או ללחוץ על כפתור \וחות שלהן ברצוננו להוסיףהש

. בחלון הבא שיפתח יש להכניס את הערך לשינוי הגובה OKהשוחות ולאחר מכן ללחוץ  
 )ערך שלילי ינמיך את השוחות(.
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- View   נה  מגדירה לתוכ ריקים. השארת הנתונים תחת כיתוב זה התצוגה של החתךטווח
 Totalלהציג תמיד את החתך במלואו )האורך המלא של החתך מופיע ליד הכיתוב:  

range הרץ  המרחקע"י הכנסת הערכים של   מסויםבטווח (. ניתן להציג את החתך
. שינוי גובה החתך יתבצע ע"י שינוי הערך From,Toההתחלתי והסופי לתוך השדות 

Height factor יש ללחוץ .Apply נתונים אלו לעדכון התצוגה. לאחר שינוי ב 
 

Topography data – לאופציהע"י המעבר   .החלקת הקרקע Smooth  פני הקרקע
בשרטוט על מנת  מסוים)התוכנה תיצור עיוות  מדויקישורטטו באופן חלק יותר אך פחות 

 שהקו יהיה יותר חלק( 
 

ך ע"י באפשרותך לשלוט על הצבעים בכל שכבה בחת – שינוי הצבעים בשכבות החתך
 לחיצה על הריבועים  הנמצאים בחלקו העליון של המסך ליד הכיתובים הבאים: 

  - Ground level  .שכבת גבהי המצב הקיים 
  - Design level .שכבת גבהי המצב המתוכנן 
  - Manholes .שכבת השוחות 

 פתח חלון עם צבעים וממנו ניתן לבחור את הצבע הרצוי. ילאחר לחיצה על צבע השכבה י
 

. באפשרותך לשרטט צינור באופן אינטראקטיבי ע"ג נון צינור באופן אינטראקטיביתכ
 . Invert levelהמסך, במקום להזין נתוני 

 בתיבה:  Pickבחר את האופציה  
עבור אל אזור השרטוט ושרטט את הצינור. שים לב כי באפשרותך להיצמד אל  

 טוט.שוחות קיימות, ואף ליצור חדשות. הטבלה תתעדכן בעת השר
  

 -. מאפשר איתור שוחה בשרטוטLocate  -שימוש ב 
 בחר בטבלה את השוחה שברצונך לאתר או לשנות.  

 .בתיבה:  Locateבחר את האופציה  
 עבור אל אזור השרטוט. סמן העכבר ייצמד לשוחה שבחרת. 

 

 חות "הפקת דו
 

 . Pipelines →Reportsהפעל מהתפריט הראשי:     
 ך הרשימה את סוג הדו"ח אשר ברצונך לקבל:בחלון שיפתח מימין בחר מתו 

 
Manholes Report –  .דו"ח שוחות 

 
לחיצה על כפתור הפקת הדו"ח תציג בפניך דו"ח מפורט של נתוני שוחות. באפשרותך להציג 

 דו"ח זה ע"ג השרטוט ע"י הפעולות הבאות:
 Manholesבחר מתוך הרשימה הנפתחת  
 כדי להפיק את הדו"ח  Applyלחץ 

 .  התוכנה תציג את הדו"ח סגור את החלון )חלון הדו"ח( ולחץ על כפתורלאחר ש 
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על הנקודה הרצויה למיקום הדו"ח )בחר את הפינה עבור לאזור השרטוט ולחץ   
 השמאלית תחתונה שבה ימוקם הדו"ח(.

 .Enterולחץ  AutoCAD/ZWCAD  SET-לאחר שתופיע מסגרת צהובה הקלד ב 
Quantities Report  - יות )עבור צינורות ביוב וניקוז בלבד(. דו"ח כמו 

 
 דו"ח כמויות זה מורכב משני דוחות: 

 
 דו"ח אורכי צינורות לפי קטרים ועומקים. 

 
 דו"ח שוחות לפי גדלים ועומקים. 

על  " את מספרי הצינורות אשר ברצונך לכלול בדו"ח או לחץ על כפתור  V" -סמן ב 
 מנת לסמן את כל הצינורות.

מתאימה לחלוקה המקובלת. קיימת חלוקה שונה  בפרויקטמת חלוקת העומקים הקיי 
ניקוז. באפשרותך לשנות את אופן החלוקה לעומקים   ביוב ולקווישל עומקים לקווי 

 לצורך הפקת הדוחות: 

 Depth. יפתח חלון ,הקלד תחת הכותרת    depth segmentsלחץ על כפתור 
segments   את העומקים לחלוקה ובסיום לחץOK . 

 . Applyלחץ  
 

Pipes Report –   דו"ח אורכי צינורות לפי קטרים. דו"ח זה מציג סיכום של אורכי הצינורות
 . בפרויקטלכל קוטר אשר הוגדר 

 
Detailed report –  דו"ח מפורט המציג את נתוני השוחות, נתוני המצב הקיים ונתוני המצב

" Vאו לסמן "  על כפתור  המתוכנן לאורך הצינור. ניתן לבחור את כל הצינורות ע"י לחיצה 
 רק ליד מספרי הצינורות אותם נרצה לכלול בדו"ח.

 
Discharge –  .דו"ח נתוני זרימה. דו"ח המציג את נתוני הזרימה לכל צינור 

 
 Dischargeחות " בחר מהרשימה בחלון הדו

 

 .   Discharge inputלחץ על כפתור  
 . Pipelineתוב: בחלון שייפתח בחר את מספר הקו מתוך הרשימה ליד הכי 
 . Q(Lit.\Sec.)הקלד את מהירות הזרימה לכל שוחה תחת הכיתוב  
 . Applyחות לחץ " ובחלון הדו OKלאחר סיום מילוי הטבלה לחץ  
 

 חות" אפשרויות נוספות בחלון הדו
 

 הדפסת הדו"ח, ע"י לחיצה על כפתור זה הנמצא בחלון הדו"ח.  
 

חלון   הדו"ח תפתחזה המופיע בחלון שמירת הדו"ח כקובץ טקסט. לחיצה על כפתור  
לשמירת קבצים. בחר את המיקום הרצוי לשמירה. הקלד שם קובץ בשורה המתאימה, 

 ולחץ שמירה. כעת באפשרותך לפתוח את הקובץ ולערוך אותו כרצונך. 
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. ע"י לחיצה על כפתור זה הנמצא בחלון הדו"ח התוכנה Excellייצוא הדו"ח לקובץ  
 ותמלא אותו בנתוני הדו"ח האחרון.  Excell גיליון תפתח 

 
 
 

 קביעת החלוקה לעומקים באופן קבוע
 

באפשרותך לשנות את אופן החלוקה לעומקים עבור דו"ח כמויות באופן קבוע, עבור כל 
 . CivilCAD 10 –שתפתח בעתיד ב   פרויקט

 
אב  פרויקט“ . זהו   Prototypeהנקרא “ בפרויקטלשם כך עליך להזין את החלוקה הרצויה 

  –חדש שתפתח ב  פרויקט טיפוס הקיים בתוכנה , אשר ההגדרות המופיעות בו, יופיעו בכל 
CivilCAD 10. 

  
 Prototype  (File →Open Project.)  פרויקטפתח את  

 
 הפרויקט נמצא במיקום ברירת המחדל:  Windows 7/8/10במערכת הפעלה 

C:\ProgramData\SivanDesign\CivilCAD\Prototype.prj\ 
 
 
 הפרויקט. בחר את סוג Pipelines → Pipelines listפתח מסרגל התפריט הראשי:  

 . (Sewage / Drainage)הרצוי  
 . Pipelines → Reportsפתח בתפריט:  
 .  Quantitiesחות בחלקו העליון של חלון זה בחר ב: " ברשימת הדו 

 .  Depth segmentsלחץ על כפתור  
 בחלון שנפתח הזן עומקים לחלוקה. 
 לאישור וסגירת החלון.  OKץ לח 
 ושמור השינויים בו.   הפרויקטסגור  

 . Prototype בפרויקטחדש שתפתח יקבל את החלוקה שהזנת  פרויקט כעת , כל 
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 ים מתכנון קווי  :21פרק 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  342עמוד 

  תכנון קווי מים
 

 עפ"י ההנחיות בחוברת. CivilCAD 10 -עבודה ב פרויקט כשלב מקדים, עליך לפתוח 
 נון קווי מים הנם:שלבי העבודה בתכ

 
 . הפרויקטאתחול  
 הכנת רקע המצב הקיים ו/או המתכונן. 
 תכנון תנוחת הקווים.  
 . crossings)סימון חציות קווים ) 
 תכנון חתכים.  
 פרוט הפעולות בחלון החתכים.  
   חות.”הפקת דו 

 

 הפרויקט אתחול 
 

  Pipelines → Pipelines listמסרגל התפריט הראשי הפעל:
 . הפרויקט. זהו חלון הגדרות כלליות של  Pipelines listן בשם פתח חלו ימימין י 

 
 (.Water)בחר  בפרויקט, בחר מתוך הרשימה את סוג הצנרת Pipe's type. ליד הכיתוב  1
, בחר מתוך הרשימה  את יחידות העבודה לקוטר צנרת )מ"מ  Diam units. ליד הכיתוב 2

 ,ס"מ ,אינצ'ים(.
 . בפרויקטבכל שורה את שמות הקווים המתוכננים , מלא Pipelines names. תחת 3
 . OK. לסיום לחץ 4
 

 כעת נעבור אל תכנון הקווים.  
 בפניך עומדות שתי אפשרויות תכנון: 

 . תכנון כולל תנוחה. תכנון תנוחה יאפשר לך לקבל את חתך הקרקע לאורך הקו. 1
 . תכנון ללא תנוחה.2

 
 .מצב הקיים ו/או המתוכנןהכנת רקע הלשם תכנון עם תנוחה המשך אל סעיף 

 אם ברצונך לתכנן ללא תנוחה, עבור אל סעיף תכנון חתכים.
 

ללא תנוחה, באפשרותך לבצע סימון  ובין אם * בין אם הינך מבצע תכנון קווים עם תנוחה 
 . חציות קוויםלשם כך עבור לפרק   crossings)חציות קווים )

 
 

 Pipeline`s listפרוט הפעולות בחלון 

  New pipeline -   הוספת קו חדש לרשימת הקווים. ניתן גם ע"י לחיצה עלENTER. 
 

Clear all pipelines  –  מחקו מהרשימה ואם ימחיקת כל רשימת הקווים )הקווים י
 (. מהפרויקטהוגדרו להם נתונים הם גם יימחקו 

 

Erase pipeline  –  ור  . יש לסמן את שם הקו ברשימה וללחוץ על כפתמסויםמחיקת קו
 (. מהפרויקטזה על מנת למחוק אותו מהרשימה )אם הוגדרו נתונים לקו זה הם יימחקו 
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 Find Pipeline – .במידה ומזינים שם לצינור   מציאת צינור על פי שם ברשימת הקווים
שכבר קיים ברשימת הצינורות, התוכנה תתריע על כך ולא תאפשר הזנת שם זהה לצינור  

 הנ"ל. 
 
 

 יים ו/או המתוכנן הכנת רקע המצב הק
 

 על  מנת לתכנן את תנוחת הקווים, עליך להכין ראשית כל את רקע הטופוגרפיה לתכנון.
 באפשרותך לעבוד עם עד שתי שכבות טופוגרפיה: מצב קיים ומצב מתוכנן. 

אם אתה עובד עם שכבת טופוגרפיה אחת, התייחס אליה כאל מצב קיים )גם אם היא מצב 
 מתוכנן(.

 
 :לפרויקט פשרויות להבאת המצב הקיים בפניך מספר א

 
, כמוסבר בפרק לפרויקט, הבא אותו Dwgאם ברשותך קובץ  -Dwgייבוא קובץ  

והוצאת נקודות מקובץ   Dwg)בצע את השלבים: יבוא קובץ  Dwgטיפול בקבצי 
Dwg. ) 

 
    של הקרקע בצע:         ASCIIאם ברשותך קובץ   ASCII - ייבוא קובץ 

a.  לחץ על  קואורדינטותהולה של רשימת מתוך כפתורי הפע

)נמצא בקבוצת הכפתורים  הממוקמת מעל    כפתור: 
שבתחתית   Topography coordinates–לרשימת ה 

ניתן להציג אותה ע"י  ,המסך(. אם רשימה זו לא מופיעה
-Topography-בחירה מתוך התפריט הראשי ב

>Coordinates . 
b.  של   ואורדינטותקהשיח שנפתחה בחר את קובץ -הדובתיבת

שבתחתית  המסך   קואורדינטותההמצב הקיים. רשימת 
 . קואורדינטותהתוזן בנתוני 

 
 באפשרותך להזין ידנית את נתוני הטופוגרפיה:   - באופן ידני 

  coordinates  –בשורת עריכת הנקודות )השורה הריקה מתחת לכותרת 
Topography הקלד את נתוני הנקודות באופן הבא:  גובה )y    x     שם

 הנקודה
 .        Enterאחרי כל נקודה לחץ 

 

הנמצא בסרגל הכלים הראשי מעל  , לחץ על כפתור  קואורדינטותהלאחר הזנת נתוני  
 לחלון השרטוט וצור קווי גובה:

 . Topography → Contoursבחר, מהתפריט הראשי:   
 . Applyשנפתח מימין, לחץ על כפתור  Topography contours –בחלון ה  

 שהוכנסו.  קואורדינטותלהתוכנה תבנה את קווי הגובה בהתאם 
 
 

 הוספת שכבת המצב המתוכנן 
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 Topography –אם ברשותך נתוני שכבה נוספת, מתוכננת, החלף את רשימת ה 

coordinates  ל– Design coordinates   :ע"י בחירה מהתפריט הראשיDesign  → 
Coordinates . 

 תוכנן כפי שהזנת את נתוני המצב הקיים. הזן את נתוני המצב המ 
 

 לאחר הזנת נתוני המצב המתוכנן, צור קווי גובה מתוכננים :
 . Design → Contoursבחר, מהתפריט הראשי:  
 . Applyשנפתח מימין, לחץ על הכפתור  Design contours –בחלון ה  

 שהוכנסו. קואורדינטותלהתוכנה תבנה את קווי הגובה המתוכננים בהתאם 
 

 תכנון תנוחת הקווים 
 

 פתח מסך התנוחה.י . מימין י Layout -> Pipelines פתח בתפריט: .1
 

 בחר את שם הקו שברצונך לסמן בתיבה שבראש החלון.  .2
 סמן את תוואי הקו.  .3

          
 בפניך שלוש דרכים לסימון התוואי:

  
 :  שיטה א'        

 
יהווה את התוואי ( ש2D Polyline)  Polyline, העבר   AutoCAD/ZWCAD –ב  

 האופקי של הקו. 

 .בתיבה:    Selectבחר  
. הטבלה Enterהמשורטט ולחץ   Polyline -עבור אל אזור השרטוט, בחר את ה 

 Designשל הצינור. בחלון התחתון )  IP's-בחלון מימין תתמלא ברשימת ה
coordinates שלהם.  קואורדינטותה( תופיע רשימת 

  
 :  שיטה ב'        

 .בתיבה:   Pickהימני, בחר  בחלון  
 עבור אל אזור השרטוט ושרטט את תוואי הקו.  
ובמרחקים   קואורדינטותבמתמלאת  -Layoutנך משרטט, טבלת היהבחן כי בזמן שה 

המתוכננות מתמלאת   קואורדינטותה(. כמו כן רשימת  Stationsרצים )
 נך מסמן.ישה קואורדינטותב

         
 :  ג'שיטה         

 
המתוכננות שבתחתית המסך. עשה זאת   קואורדינטותהבטבלת  אורדינטותקו הזן 

 בשורת העריכה שבראש הרשימה. לדוגמא:  קואורדינטותהבאמצעות הקלדת  
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256123.76 175143.56 MN1 

256325.56 175200.40 MN2 

256327.12 175256.00 MN3 

 
( MN1, MN2 ,MN3) קואורדינטותהמימין, הקלד את שמות  Layout –בטבלת ה  

 עפ"י הדוגמא הבאה:
 

    
 
 
 
 
 

 
הזן קטרי צינורות:  מול כל שוחה בטבלה מימין, הזן את הרדיוס הרצוי תחת הכיתוב  .4

Diam . 
 לשרטוט הקווים.  OKלחץ   .5
 

 התוכנה תיצור שרטוט של התוואי האופקי של הקו.    
  

 :Layout -ת נוספות בחלון ה אפשרויו 
 

Options   - ניתן לשנות את ההגדרות הבאות:שנפתח בחלון  ,ע"י לחיצה על כפתור זה , 
 Scale-  .שינוי גודל הכיתוב של נתוני הצינור 
 Pipes number in select mode (manholes perfix) –  המספורשינוי תחילת  

תגרום לצינור הבא שיוגדר   2הערך של שמות הנקודות של השוחות לדוגמא: הכנסת 
 3-ב  שיתחילו, לקו שיוגדר אחריו שמות 2MN1 2MN2. 2MN3  להכיל את השמות: 

 וכ"ו.. 
 Pipes first number  –   .תחילת מספור הנקודות לאורך הקו ע"ג התנוחה 
 לעדכון השרטוט.   OKלאחר השינויים בחלון זה יש ללחוץ שוב על 
  Pipeline width-  ללא  -1מציין את עובי ברירת המחדל,   0בשרטוט, עובי הצינור

 עובי.  
 Data intervals  –  .המרחק בין נתוני הקו 

 

  Clear all manholes - הנוכחי.  מחיקת כל נתוני הקו 
 

 Delete one manhole -   מחיקתIP בודד. סמן את הIP  כפתור זה .  עלהרצוי ולחץ 
 

   - Show pipeline רטוט. לחץ על הצינור הנוכחי יסומן בצהוב.איתור צינור ע"ג הש 
 

Compute water supply coordinates   –  לאורך הציר.    קואורדינטותהחישוב
מטר ותוסיף   20על הציר כל  קואורדינטותהלאחר לחיצה על כפתור זה התוכנה תחשב את 

 המתוכננות. קואורדינטותהאת הנקודות המחושבות לרשימת 
 

Diam. St. Man Coor.  

      MN1 

      MN2 

      MN3 
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 .IPהזזת 
בחלון   קואורדינאטה. באם תשנה נתוני לקואורדינאטהקשורה  IPלב כי כל שים     
 . קואורדינאטההקשורה לאותה  IP -שבתחתית המסך, ישתנה מיקום ה  קואורדינטותה

 קשורה.  IPאליה ה הקואורדינאטה, עליך להזיז את  IPע"מ להזיז 
 בפניך שתי אפשרויות: 

 :הקואורדינאטהשינוי ידני של נתוני  
שברצונך  הקואורדינאטהשבתחתית המסך, בחר את   קואורדינטותהברשימת  .1

 בשורת עריכת הנקודות. הקואורדינאטהלשנות. ערוך מחדש את 
 שמימין.  Layout –בחלון ה   Applyלמימוש השינוי בשרטוט, לחץ  .2

  
 

 מתוך השרטוט.  IP -הזזת ה
המתוכננות שבתחתית המסך את   קואורדינטותהבחר במלבן שמימין לרשימת  .1

 . :  Moveהאופציה 
עבור אל השרטוט. בחר את הנקודה שברצונך להזיז ולחץ עליה פעמיים. כעת   .2

לחץ במיקום החדש אליו ברצונך להעביר הנקודה ) אם אתה עובד בגרסת 
AutoCAD/ZWCAD–  באפשרותך להיצמד אל נקודה מסומנת ע"יObject 

snap settings   .לנקודה 
 שמימין.  Layout –בחלון ה   Applyלמימוש השינוי בשרטוט, לחץ  .3

 

   (Crossings)סימון חציות קווים 
 

, אם נקודות אלה ידועות    לפרויקטבאפשרותך לסמן נקודות חציה של קווים שאינם שייכים 
 לך.

 Pipelines → Crossingsלשם כך בחר מהתפריט הראשי:  
 

 . Crossings –מימין יפתח חלון ה 
St במטרים(.  בפרויקט בר הקו  החוצה על גבי הקו הקיים : מרחק רץ. הכוונה למקום בו עו( 
IL .)רום פני הצינור החוצה )לא חובה למילוי : 

Dpt : .)עומק הצינור )לא חובה למלא 
Diam  .קוטר הצינור החוצה. נתון זה אינו חובה למילוי : 
Type  הזן את האות( חציה מימין או משמאל :R   לחציה מימין אוL  )ן נתו –לחציה משמאל

 זה אינו חובה למילוי. 
 
 ( בתיבה שבראש החלון. crossings. בחר את הצינור עבורו ברצונך לסמן חציות)1
 ע"י אחת מהדרכים הבאות: Station - . מלא את נתון ה2
 

 מרחק רץ של הקווים החוצים במטרים.   Crossings  –בטבלת ה  הזן  -באופן ידני  
 

 . Pick –שימוש ב  
 תית החלון. בתיבה שבתח  Pickסמן  
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   Station –עבור אל אזור השרטוט וסמן את הנקודה בקרבת הקו הרצוי.נתון ה   
. למשתמשי גרסת Crossings –יוזן אוטומטית בטבלת ה 

AutoCAD/ZWCAD  -   ,אם ברצונך לסמן נקודות שקיימות כבר בשרטוט
   Object Snap Settingsאליהן ע"י שימוש באפשרות של   להיצמדבאפשרותך 

 .AutoCAD/ZWCAD -דה בלנקו
                                                                                                   

לרשימת  החצייה. לשם כך עליך, קודם כל להוסיף את נקודות Locate –שימוש ב  
מכן , להציגן על גבי השרטוט ולאחר CivilCAD 10 –המתוכננות ב  קואורדינטותה

 : Locate  –לבחור אותן ע"י שימוש ב
 . Design → Coordinatesבחר בתפריט הראשי:  
 Design coordinates –בטבלת ה  החצייהשל נקודות  קואורדינטותההקלד את  

 שבתחתית המסך משמאל. 
  –נעשית בתוך שורת עריכת הנקודות שבראש חלון ה  קואורדינטותההקלדת  

Design coordinates      ורמט: לפי הפx     y        שם נקודה. )אין להקליד גובה
 . Enterנקודה( . בסיום הקלדת כל נקודה לחץ 

 לרענון השרטוט. בסיום הרענון, הנקודות יופיעו על גבי השרטוט. לחץ  
 מימין.   Crossings  –בחלון ה   Locateבחר  
  –עבור אל אזור השרטוט וסמן את הנקודות אשר הקלדת קודם לכן בטבלת ה  

Design coordinates   ע"י לכידתן. נתון ה–  Station  יוזן אוטומטית לטבלת ה–  
Crossings . 

. באפשרותך לבחור את הקו החוצה את הקו הנוכחי ע"י סימון קו  Select -שימוש ב 
, עבור   Select. לחץ על בפרויקטמשורטט ע"ג התנוחה גם אם אינו מוגדר כציר 

, הטבלה תתעדכן במרחקים ENTERוי. לחץ לאזור השרטוט וסמן את הקו הרצ
הרצים ותחשב את גובה ההצטלבות לפי הגובה של הקו המשורטט. אם בקו שבחרת 

מטר מתחת לגובה פני הקרקע  1.2אין גובה התוכנה תגדיר את גובה ההצטלבות 
 באותה הנקודה.

 . באפשרותך לבחור מספר קווים שחוצים את הקו הנוכחי ע"י Filtering -שימוש ב 
סינון קווים אלו מהשרטוט ממספר שכבות וממספר סוגי קווים בבת אחת ע"י 

 הפעולות הבאות:

פתח החלון  י, י   Filter crossings lines from dwg לחץ על כפתור   
Filter crossings . 

( את השכבות שבהם נמצאים  Layersבאפשרותך לסמן ברשימת השכבות ) 
ת סוג הקווים או להשתמש ( אEntitiesהקווים וברשימת הישויות )

וללחוץ על הקו או הקווים המסמלים את סוג הקו והשכבה שמהם  -Selectב
 אנו נבצע את הסינון.

כדי לבצע את הסינון. בקווים שאינם מכילים גובה התוכנה  Applyלחץ  
 מטר מתחת לפני הקרקע באותה נקודה. 1.2תקבע את גובה ההצטלבות 

 
וקוטר הצינורות, אם יש )שני נתונים אילו    IL –נתוני ה  הזן את Crossings . בטבלת ה3

 אינם חובה להקלדה(.חציות הקווים יופיעו בשרטוט החתכים.
 

 . לאיתור מיקום חציית קווים על גבי התנוחה לחץ על כפתור 
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 תכנון חתכים 
 
 . Pipelines → Sections. מסרגל התפריט הראשי, הפעל:  1
 החלון שיפתח מחולק ל:  .לפניך יפתח חלון החתכים    

 אזור השרטוט )המשטח השחור(. 
 (.Topoהטבלה משמאל למטה ) -טבלת נתוני הקרקע  
 הטבלה מימין למטה. –טבלת נתוני התכנון  

 . בחר את הקו שברצונך לתכנן בתיבה שבראש החלון:  2
  

. משמאל נפתח חלון ההגדרות.    Options: לחץ על כפתור קביעת הגדרות התכנון . 3
 בחלון זה באפשרותך לקבוע הגדרות התכנון: 

 Min. Pipe’s cover -   באם ברצונך לקבל סימון באזור חשיפת הצינור, מלא כיסוי
לצינור. בעת קבלת שרטוט הצינור, יופיע סימון בצבע כתום ע"ג פני הקרקע  מינימאלי

 )מתוכננת או קיימת( באזורים בהם יש חשיפת צינור. 
 Check crossings 
 Show turns along pipelines –    הצגת התפניות ע"ג החתך. עם בחירת

זו יופיעו  בחתך האורך דגלים המסמנים את מיקום התפניות וליד כל דגל   אופציה
 תופיע הזווית של התפנית.

  - Pipes division  לשם נוחות התכנון, באפשרותך לבקש מהתוכנה לחלק את קו
וחה(, או שניהם. לשם כך, סמן את החלוקה )אם קיימת תנ IPמ', או כל  20המים כל 
 הרצויה. 

 Data intervals -   
 Keep fixed IL -  ע"י סימון אפשרות זו התוכנה תשמור עלInvert level   קבוע

 .מסוימתבנקודות גם אם נבצע שינוי בשיפוע של נקודה 
 Keep fixed slopes –   זו התוכנה תשמור על שיפועים קבועים  אופציהע"י סימון

 .מסוימתשל שוחה  IL - אם נבצע שינוי ב גם
 Slopes precision –   ע"י אופציה זו ניתן לבחור את רמת הדיוק לתצוגת ערכי

 השיפועים. 
 Trim section’s edge below [ X ] m-  מים צינורות על החלה, זו אפשרות ,

  לבין הקטע סוף  בין X -ל מתחת  מרחק ישו הבמיד להגדיר למשתמש מאפשרת
 . ויוצג  הקטע בסוף הנתונים'(,   וכו' מ 25 כל',  מ 20 כל) האחרונה המרחק חלוקת

 .OKלאישור ההגדרות לחץ  
 
 : הבא נתוני טופוגרפיה. 4
 
 אם  בצעת את הסעיפים: הכנת רקע המצב הקיים ותכנון תנוחת קווים, באפשרותך   -

המופיע משמאל לטבלת   הקרקע מהתנוחה:  לחץ על כפתור   למצות את נתוני  
 הטופוגרפיה. טבלת הטופוגרפיה תתמלא.

)מרחק     Stationהקלד נתוני טופוגרפיה בטבלת הטופוגרפיה לפי  –אם לא תכננת תנוחה  -
 )גובה(.  Elevation  –)מרחק( ו   Distanceרץ( או 

  
 . הזנת נתוני קרקע מתוכננת )לא חובה(: 5
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 אם  בצעת את הסעיפים: הכנת רקע המצב הקיים ותכנון תנוחת קווים, באפשרותך   -

 המופיע משמאל         לגזור את נתוני הקרקע המתוכננת מהתנוחה:  לחץ על כפתור  
 לטבלת הטופוגרפיה. טבלת הטופוגרפיה תתמלא בנתוני קרקע מתוכננת.

בחר  Ground Level -בטבלת ה אם ברצונך להזין ידנית נתוני קרקע מתוכננת, בצע: 
. הזן נתוני הקרקע המתוכננת באותו האופן בו הזנת את נתוני ”Design“באופציה 

 הטופוגרפיה. 
להבאת השרטוט )מופיע מימין(. על המסך יופיע שרטוט הטופוגרפיה עם סימון   OKלחץ 

 מיקום השוחות. 
 
את  ”( , עליך להזיןDesign. בטבלת התכנון שבתחתית המסך )הטבלה בעלת הכותרת: “6

נתוני חתך האורך של הקו. באפשרותך להקליד לכל נקודה את העומק האבסולוטי ע"י מילוי  
. לפי הקלדת Depthאו למלא את עומק הנקודה תחת הכיתוב    Elevationתחת הכיתוב 

 אחד מהנתונים הנ"ל התוכנה תעדכן את הנתון השני באופן אוטומטי. 
 
 כנון הזן נתוני החתך של קו המים כדלהלן: : בטבלת התנתוני החתך. 7

 St. .מרחק רץ : 
 Distance  במקום מרחק רץ של החתך, באפשרותך למלא מרחקים בין נקודות :

 של הנקודה הראשונה.  .Stב 0השבר, כאשר עליך להזין 
 Elevation/dH  גובה או הפרש גובה מפני הקרקע המתוכננת, אם יש, או לחילופין :

 מקרקע קיימת. 
  Slope% באפשרותך להזין,  במקום גובה מתוכנן, את שיפוע הקו ב :- .% 
 Depth (m)  רום פני הקרקע . התוכנה מציגה נתון זה והוא אינו למילוי ע"י :

, נתוניה יופיעו כאן. אחרת, יופיעו כאן בפרויקטהמשתמש. אם קיימת קרקע מתוכננת 
 נתוני הקרקע הקיימת. 

 Slope (%)המשתמש. גם כאן, השיפוע מתייחס   יי ע" : שיפוע הקרקע. לא למילו
לקרקע מתוכננת, אם זו קיימת. אם אין קרקע מתוכננת, אזי השיפוע מתייחס לקרקע 

 קיימת. 
 Diam. (mm):   קוטר הצינור. ערך הקוטר יוקלד ביחידות אשר נקבעו בחלון

Pipeline- list  בחלון ה  המצויה. ניתן גם להזין את קוטרי הצינור מטבלת הקווים- 
Pipeline-layout :לפי הדוגמא הבאה. 

 

 
 

 Material : .החומר ממנו מתוכנן להיות הצינור 
 Wall thick (mm)  :עובי דופן צינור . 
 Devices:  .הגדרת אלמנטים כגון מגופים, משאבות ומיכלים 
 Flow rate (cu. m/h):  .הגדרת קצב זרימת מים 
 

 בחלון הימני לעדכון השרטוט.  OK. לחץ 8
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 פעולות בחלון החתכים פרוט ה

 

  - Save project)לחיצה על כפתור זה  – שמירה )מתוך סרגל הכלים שמעל לשרטוט
 , כפתור זה מאפשר את השמירה מבלי לצאת מחלון החתכים. הפרויקטתבצע שמירה לכל 

 

 של חתך לאורך בודד, או של כל החתכים:   Dxfיצירת קובץ  
 נסביר את האפשרויות בחלון זה: לאחר לחיצה על כפתור זה תפתח חלון, 

 .Height,Lengthמלא את קנה המידה בשדות 
הרצוי ברשימה  הגיליון , בחר את גודל מסוים גיליוןעל מנת להדפיס את החתך לפי גודל 

 . Divide by paper sizeהנפתחת, תחת הכיתוב 
כים . על מנת לקבל קובץ עם כל החתOKעל מנת להוציא את החתך הנוכחי בלבד ,לחץ  

 .DXF-Allלחץ 
 . נפתחה תיבה לשמירת קבצים. בחר את מיקום הקובץ, הקלד שם קובץ ולחץ שמירה

 

פתח חלון שבו יש להקליד את קנה י לאחר לחיצה על כפתור זה י –הדפסת החתך   
בחלון    OKכדי להדפיס את החתך ולאחר מכן יש ללחוץ   OKהמידה וללחוץ על כפתור
 ההגדרות של המדפסת. 

 

יש ללחוץ על כפתור זה על מנת לצפות בתצוגה של כל החתך ע"ג חלון   –וגה מלאה תצ  
 השרטוט.

 

 כפתור זה מוחק לגמרי את השוחה, כולל מרחק רץ. - מחיקת שוחה 
  

שומר את נתוני המרחקים   –)לא מבטל לגמרי את השוחה   - מחיקת נתוני כל השוחות  
 ומרחקים בין השוחות(. .St–הרצים 

 
:  סמן את העמודה השמאלית ביותר בטבלת התכנון בשורה נקודת מפנה אנכיתהוספת 

רשום את   שתתווסףבמקלדת. בשורה   Enterהעוקבת את הנקודה שברצונך להוסיף , ולחץ 
 המרחק הרץ החדש ואת גובהו או שיפועו. 

 

לאחר לחיצה על כפתור זה יופיע חלון עם נתוני התכנון.  - הגבהה/הנמכה של הצינור 
. בתחתית הטבלה  Aמן את הנקודות הרצויות להגבהה/הנמכה )לסימון כל הנקודות לחץ ס

 . טבלת התכנון תשתנה בהתאם. OKהזן גובה רצוי )להנמכה מס' שלילי(, ולחץ 
                                                                                                                 

מכיל טופוגרפיה וכן   שהפרויקט.  )בתנאי הבאת טופוגרפיה קיימת עבור כל הקווים  
 תנוחת הקווים(. 

 

, כולל קווי גובה בפרויקט. )בתנאי שקיימת קרקע מתוכננת הבאת נתוני קרקע מתוכננת  
 מתוכננים וכן תנוחת הקווים(.
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קרקע מתוכננת . )בתנאי שקיימת הבאת נתוני קרקע מתוכננת עבור כל הקווים  
 , כולל קווי גובה מתוכננים(.בפרויקט

 
 - View  השארת הנתונים תחת כיתוב זה ריקים מגדירה לתוכנה התצוגה של החתך טווח .

(. ניתן  Total rangeהצגת החתך במלואו )האורך המלא של החתך מופיע ליד הכיתוב:  
סופי לתוך השדות ע"י הכנסת המרחק הרץ ההתחלתי וה מסויםלהציג את החתך של קטע 

From,To  שינוי גובה החתך יתבצע ע"י שינוי הערך .Height factor יש ללחוץ .OK   לאחר
 שינוי בנתונים אלו לעדכון התצוגה.

 
Topography data לאופציהע"י המעבר  – החלקת פני הקרקע Smooth  פני הקרקע

 . מדויקישורטטו באופן חלק יותר אך פחות 
 

באפשרותך לשלוט על הצבעים בכל שכבה בחתך ע"י  – החתךשינוי הצבעים בשכבות 
 לחיצה על הריבועים  הנמצאים בחלקו העליון של המסך ליד הכיתובים הבאים: 

 
 - G.L.  .שכבת גבהי המצב הקיים 
 - D.L. .שכבת גבהי המצב המתוכנן 
 - M.H. .שכבת הנקודות 

 ן לבחור את הצבע הרצוי. פתח חלון עם צבעים וממנו ניתילאחר לחיצה על צבע השכבה י

פעולה זו תעתיק את  – העתקת המרחקים הרצים של נתוני הקרקע אל טבלת התכנון 
 אל טבלת התכנון, לצורך נוחות תכנון.   Topography -מטבלת ה  Stations -ה
 

. באפשרותך לשרטט צינור באופן אינטראקטיבי ע"ג תכנון צינור באופן אינטראקטיבי
 ן נתוני הקו.המסך, במקום להזי

 בתיבה:  Pickבחר את האופציה  
 עבור אל אזור השרטוט ושרטט את הקו. טבלת התכנון תתמלא בעת השרטוט.  

  
 -. מאפשר איתור והחברות אל נקודת מפנה אנכית בשרטוטLocate  -שימוש ב 

 בחר בטבלה את הנקודה שברצונך לאתר.  

 .בתיבה:  Locateבחר את האופציה  
 שרטוט. סמן העכבר ייצמד לנקודה שבחרת.עבור אל אזור ה 

 

 חות "הפקת דו
 

 . Pipelines →Reportsהפעל מהתפריט הראשי:    
 

 בחלון שיפתח מימין בחר מתוך הרשימה את סוג הדו"ח אשר ברצונך לקבל:
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Pipes Report –   דו"ח אורכי צינורות לפי קטרים. דו"ח זה מציג סיכום של אורכי הצינורות
 . בפרויקטגדר לכל קוטר אשר הו

 
IP's Report  –  הכוונה לנקודות התנוחה( בפרויקטדו"ח נקודות מפנה של הקווים (– 

 . בפרויקטאפשרי רק אם קיימת תנוחה של הקווים 
 

Quantities Report  -  .)דו"ח כמויות )עבור צינורות ביוב וניקוז בלבד 
 

 דו"ח אורכי צינורות לפי קטרים ועומקים.  .1

על  הצינורות אשר ברצונך לכלול בדו"ח או לחץ על כפתור   " את מספריV" -סמן ב 
 מנת לסמן את כל הצינורות.

מתאימה לחלוקה המקובלת. באפשרותך לשנות  בפרויקטחלוקת העומקים הקיימת  
 חות: " את אופן החלוקה לעומקים לצורך הפקת הדו

 Depthפתח חלון ,הקלד תחת הכותרת י . י   depth segmentsלחץ על כפתור 
segments   את העומקים לחלוקה ובסיום לחץOK . 

 . Applyלחץ  
 

Detailed report  –  דו"ח מפורט המציג את נתוני הצינור, נתוני המצב המתוכנן ונתוני המצב
 הקיים לאורך הצינור. 

 
 

 חות "אפשרויות נוספות בחלון הדו
 

 הדפסת הדו"ח, ע"י לחיצה על כפתור זה הנמצא בחלון הדו"ח.  
 

חלון   הדו"ח תפתחו"ח כקובץ טקסט. לחיצה על כפתור זה המופיע בחלון שמירת הד 
לשמירת קבצים. בחר את המיקום הרצוי לשמירה. הקלד שם קובץ בשורה המתאימה, 

 ולחץ שמירה. כעת באפשרותך לפתוח את הקובץ ולערוך אותו כרצונך. 
 

הדו"ח התוכנה . ע"י לחיצה על כפתור זה הנמצא בחלון Excellייצוא הדו"ח לקובץ  
 ותמלא אותו בנתוני הדו"ח האחרון.  Excell גיליון תפתח 

 
 

 קביעת החלוקה לעומקים באופן קבוע
 

באפשרותך לשנות את אופן החלוקה לעומקים עבור דו"ח כמויות באופן קבוע, עבור כל 
 . CivilCAD 10 –שתפתח בעתיד ב   פרויקט

 
אב  פרויקט“ . זהו   Prototypeקרא “הנ בפרויקטלשם כך עליך להזין את החלוקה הרצויה 

  –חדש שתפתח ב  פרויקט טיפוס הקיים בתוכנה , אשר ההגדרות המופיעות בו, יופיעו בכל 
CivilCAD 10 . 

 Prototype  (File →Open Project.)  פרויקטפתח את  
 

 הפרויקט נמצא במיקום ברירת המחדל:  Windows 7/8/10במערכת הפעלה 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  353עמוד 

C:\ProgramData\SivanDesign\CivilCAD\Prototype.prj\ 
 

 הפרויקט. בחר את סוג Pipelines→ Pipelines listפתח מסרגל התפריט הראשי:  
Water).) 

 . Pipelines → Reportsפתח בתפריט:  
 .  Quantitiesחות בחלקו העליון של חלון זה בחר ב: " ברשימת הדו 

 .  Depth segmentsלחץ על כפתור  
 לוקה.בחלון שנפתח הזן עומקים לח 
 לאישור וסגירת החלון.  OKלחץ  
 ושמור השינויים בו.   הפרויקטסגור  

 
 . Prototype בפרויקטחדש שתפתח יקבל את החלוקה שהזנת  פרויקט כעת , כל 
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 תכנון קווי כבלים  :22פרק 
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 תכנון קווי כבלים 
 

 . ההנחיות בפרקים האחרים לפי CivilCAD 10 -עבודה ב פרויקט כשלב מקדים, עליך לפתוח 
 שלבי העבודה בתכנון קווי כבלים הנם:

 
 . הפרויקטאתחול  
 הכנת רקע המצב הקיים ו/או המתכונן. 
 תכנון התוואי האופקי.  
 הגדרת תאי הבקרה לאורך הקו.  
 הגדרת גודל תאי הבקרה. 
 אחרים.  crossings)סימון חציות קווים ) 
 תכנון חתכים.  
 פרוט הפעולות בחלון החתכים 
  .דו"חותהפקת  

 

 רויקט הפ אתחול 
 

  Pipelines → Pipelines listמסרגל התפריט הראשי הפעל: 
. בחלון זה אנו נגדיר את מספר הקווים אותם נרצה  Pipelines listמימין יפתח חלון בשם 

 לתכנן ושמותיהם.
 
 . Pipeline`s typeליד הכיתוב:  -Cables. בחר את ב1
 'ים(.. בחר את יחידות העבודה לקוטר צנרת )מ"מ ,ס"מ ,אינצ2
 . בפרויקט, מלא בכל שורה את שמות הקווים המתוכננים Pipelines names. תחת 3
 

 כעת נעבור אל תכנון הקווים.  
 בפניך עומדות שתי אפשרויות תכנון: 

 . תכנון כולל תנוחה.  תכנון תנוחה יאפשר לך לקבל את חתך הקרקע לאורך הקו. 1
 . תכנון ללא תנוחה.2
 

 אל סעיף הכנת רקע המצב הקיים ו/או המתוכנןלשם תכנון עם תנוחה המשך 
 .תכנון חתכיםאם ברצונך לתכנן ללא תנוחה, עבור אל סעיף 

 
ללא תנוחה, באפשרותך לבצע סימון  ובין אם * בין אם הינך מבצע תכנון קווים עם תנוחה 

 . חציות קוויםלשם כך עבור לפרק  crossings)חציות של קווים אחרים )
 
 

 Pipeline`s listן פרוט הפעולות בחלו

  New pipeline -   הוספת קו חדש לרשימת הקווים. ניתן גם ע"י לחיצה עלENTER. 
 

Clear all pipelines  –   מחיקת כל רשימת הקווים )הקווים ימחקו מהרשימה ואם
 (. מהפרויקטהוגדרו להם נתונים הם גם יימחקו 

 



 
 
 

 

 
 

 09-7469295 פקס: 09-7778101, רעננה.  טל': 3019, ת.ד. בנין מישורים   17תדהר סיון תכנון ד.ש. בע"מ. רח' ה 
 

    382מתוך  356עמוד 

Erase pipeline  –  הקו ברשימה וללחוץ על כפתור   . יש לסמן את שםמסויםמחיקת קו
 (. מהפרויקטזה על מנת למחוק אותו מהרשימה )אם הוגדרו נתונים לקו זה הם יימחקו 

 

 Find Pipeline – .במידה ומזינים שם לצינור   מציאת צינור על פי שם ברשימת הקווים
  שכבר קיים ברשימת הצינורות, התוכנה תתריע על כך ולא תאפשר הזנת שם זהה לצינור

 הנ"ל. 
 
 

 הכנת רקע המצב הקיים ו/או המתוכנן 
 

 על  מנת לתכנן את תנוחת הקווים, עליך להכין ראשית כל את רקע הטופוגרפיה לתכנון.
 באפשרותך לעבוד עם עד שתי שכבות טופוגרפיה: מצב קיים ומצב מתוכנן. 

צב אם אתה עובד עם שכבת טופוגרפיה אחת, התייחס אליה כאל מצב קיים )גם אם היא מ
 מתוכנן(.

 
 :לפרויקט בפניך מספר אפשרויות להבאת המצב הקיים 

 
, כמוסבר בפרק לפרויקט, הבא אותו Dwgאם ברשותך קובץ  -Dwgייבוא קובץ  

והוצאת נקודות מקובץ   Dwg)בצע את השלבים: יבוא קובץ  Dwgטיפול בקבצי 
Dwg. ) 

 
         של הקרקע בצע:    ASCIIאם ברשותך קובץ   ASCII- ייבוא קובץ 

  לחץ על כפתור:  קואורדינטותהמתוך כפתורי הפעולה של רשימת  .1
 Topography–) נמצא בקבוצת הכפתורים  הממוקמת מעל לרשימת ה  

coordinates    שבתחתית המסך(. אם רשימה זו לא מופיעה ניתן להציג
-Topography-אותה ע"י בחירה מתוך התפריט הראשי ב

>Coordinates . 
של המצב  קואורדינטותהשנפתחה בחר את קובץ שיח -דוהבתיבת   .2

שבתחתית  המסך תוזן בנתוני  קואורדינטותההקיים. רשימת 
 . קואורדינטותה

 
 באפשרותך להזין ידנית את נתוני הטופוגרפיה:   - באופן ידני 

  coordinates  –בשורת עריכת הנקודות )השורה הריקה מתחת לכותרת 
Topographyקודות באופן הבא: גובה  ( הקלד את נתוני הנy    x     שם

  הנקודה
 .        Enterאחרי כל נקודה לחץ 

 

הנמצא בסרגל הכלים הראשי מעל  , לחץ על כפתור  קואורדינטותהלאחר הזנת נתוני  
 לחלון השרטוט וצור קווי גובה:

 . Topography → Contoursבחר, מהתפריט הראשי:   
 . Applyח מימין, לחץ על כפתור שנפת Topography contours –בחלון ה  

 שהוכנסו.  קואורדינטותלהתוכנה תבנה את קווי הגובה בהתאם 
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 הוספת שכבת המצב המתוכנן 
 Topography –אם ברשותך נתוני שכבה נוספת, מתוכננת, החלף את רשימת ה 

coordinates  ל–  Design coordinates :ע"י בחירה מהתפריט הראשי Design → 
Coordinates 

 הזן את נתוני המצב המתוכנן כפי שהזנת את נתוני המצב הקיים. 
 

 לאחר הזנת נתוני המצב המתוכנן, צור קווי גובה מתוכננים :
 . Design → Contoursבחר, מהתפריט הראשי:  
 . Applyשנפתח מימין, לחץ על הכפתור  Design contours –בחלון ה  

 שהוכנסו. קואורדינטותלהתוכנה תבנה את קווי הגובה המתוכננים בהתאם 
 

 תכנון התוואי האופקי 
 
 . מימין יפתח מסך התנוחה. Layout →  Pipelines. פתח בתפריט: 1
 . בחר את שם הקו שברצונך לסמן בתיבה שבראש החלון. 2
 . Centerline-( בCables. בחר מתוך הרשימה )ליד הכיתוב סימון תוואי הקו. 3
 בפניך שלוש דרכים לסימון התוואי:    
  

 :  שיטה א'        
 

( שיהווה את התוואי 2D Polyline)  Polyline, העבר   AutoCAD/ZWCAD –ב  
 האופקי של הקו. 

 

 .בתיבה:   Selectבחר  
. הטבלה Enterהמשורטט ולחץ   Polyline -עבור אל אזור השרטוט, בחר את ה 

 Designשל תוואי הקו. בחלון התחתון ) IP'sבחלון מימין תתמלא ברשימת ה 
coordinates של ה  קואורדינטותה( תופיע רשימתIP's  . 

  
 :  שיטה ב'        

 

 .בתיבה:   Pickבחלון הימני, בחר   
 עבור אל אזור השרטוט ושרטט את תוואי הקו.  
ובמרחקים   קואורדינטותבמתמלאת  -Layoutנך משרטט, טבלת היהבחן כי בזמן שה 

המתוכננות מתמלאת   טותקואורדינה(. כמו כן רשימת  Stationsרצים )
 נך מסמן.ישה קואורדינטותב

         
 :  אפשרות ג'        

 
המתוכננות שבתחתית המסך. עשה זאת   קואורדינטותהבטבלת  קואורדינטותהזן 

 בשורת העריכה שבראש הרשימה. לדוגמא:  קואורדינטותהבאמצעות הקלדת  
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256123.76 175143.56 IP1 

256325.56 175200.40 IP2 

256327.12 175256.00 IP3 

 
( עפ"י IP3  ,IP2 ,IP1) קואורדינטותהמימין, הקלד את שמות  Layout –בטבלת ה 

 הדוגמא הבאה: 
 

             
 
 
 
 

    
 . Radiusבאפשרותך לסמן רדיוסים, הזן את הרדיוס הרצוי תחת הכיתוב   
 התוכנה תיצור שרטוט של התוואי האופקי של הקו.     לשרטוט הקווים.  Applyלחץ    
 
  

 (:-Cables)בהגדרת ה Layout –אפשרויות נוספות בחלון ה 
 

Options    - :ע"י לחיצה על כפתור זה בחלון שיפתח, ניתן לשנות את ההגדרות הבאות 
 Scale-   .שינוי גודל הכיתוב של נתוני הצינור ועובי הקו 
 Pipes number in select mode (manholes perfix) -   שינוי תחילת המספור

תגרום לצינור הבא שיוגדר   2של שמות הנקודות של השוחות לדוגמא: הכנסת הערך 
  3-, לקו שיוגדר אחריו שמות שיתחילו ב2IP1  ,2IP2  ,2IP3  להכיל את השמות:

 וכ"ו.
 

Clear all Manholes  -  הנוכחי.  מחיקת כל תאי הבקרה השייכים לקו 
 

  Delete one manhole -  מחיקת תא בקרה בודד. סמן את השוחה הרצויה ולחץ על
 כפתור זה . 

 

   - Show pipeline  איתור צינור ע"ג השרטוט. לאחר לחיצה על כפתור זה הצינור
 הנוכחי יסומן בצהוב ע"ג השרטוט.

 
 .IPהזזת 

בחלון   רדינאטהקואו. באם תשנה נתוני לקואורדינאטהקשורה  IPשים לב כי כל 
 . קואורדינאטההקשורה לאותה  IP -שבתחתית המסך, ישתנה מיקום ה  קואורדינטותה

 קשורה.  IPאליה ה הקואורדינאטה, עליך להזיז את  IPע"מ להזיז 
 בפניך שתי אפשרויות: 

 
 :הקואורדינאטהשינוי ידני של נתוני  
 

שברצונך  הקואורדינאטהשבתחתית המסך, בחר את  קואורדינטותהברשימת  -
 בשורת עריכת הנקודות. הקואורדינאטהלשנות. ערוך מחדש את 

Radius IP 

  IP1 

  IP2 

  IP3 
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 שמימין.  Layout –בחלון ה   OKלמימוש השינוי בשרטוט, לחץ  -
  
 

 :מתוך השרטוט IP -הזזת ה 
 
המתוכננות שבתחתית המסך את   קואורדינטותהבחר במלבן שמימין לרשימת  -

 .:  Moveהאופציה 
ת הנקודה שברצונך להזיז ולחץ עליה פעמיים. כעת עבור אל אזור השרטוט. בחר א -

לחץ במיקום החדש אליו ברצונך להעביר הנקודה )אם אתה עובד בגרסת 
AutoCAD/ZWCAD –  באפשרותך להיצמד אל נקודה מסומנת ע"יObject Snap 

Settings   .לנקודה 
 שמימין.  Layout –בחלון ה   OKלמימוש השינוי בשרטוט, לחץ  -

 

 בקרה לאורך הקו הגדרת תאי ה
 

בחר מתוך הרשימה )ליד הכיתוב  Pipeline layoutלצורך המעבר להגדרה זו, בחלון  
Cablesב )-Cables . 

 
 באפשרותך להגדיר את השוחות ע"ג הקו הנוכחי ע"י שתי שיטות: 

 
 : אפשרות א'       
 

 בתיבה:.  Pickבחלון הימני, בחר   
 ת בהם יש להכניס תא בקרה. עבור אל אזור השרטוט ולחץ לאורך הקו במקומו 
 קואורדינטותבמתמלאת  -Layoutנך לוחץ על הקו, טבלת היהבחן כי בזמן שה 

המתוכננות מתמלאת   קואורדינטותה(. כמו כן רשימת Stationsובמרחקים רצים )
 נך מסמן.ישה קואורדינטותב

         
 :אפשרות ב'             

  
מתוכננות שבתחתית המסך. עשה זאת  ה קואורדינטותהבטבלת  קואורדינטותהזן 

 בשורת העריכה שבראש הרשימה. לדוגמא:  קואורדינטותהבאמצעות הקלדת  
 

( MN3 ,MN2 ,MN1) קואורדינטותהמימין, הקלד את שמות  Layout –בטבלת ה 
 עפ"י הדוגמא הבאה:
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)המרחקים  St-)שם השוחה ע"ג השרטוט( ו Manהשדות  OKלאחר לחיצה על  
 ים( ימולאו בטבלה באופן אוטומטי. הרצ

ואת  Noהגדרת הצינורות. לכל שוחה בטבלה הגדר את מספר הצינורות תחת הכיתוב  
 .D-rהקוטר של כל צינור תחת הכיתוב 

 
 

 הגדרת גודל תאי הבקרה
 

בחר מתוך הרשימה )ליד הכיתוב  Pipeline layoutלצורך המעבר להגדרה זו, בחלון  
Cablesב )-Manholes . 

( ע"י  Pipeline listל תא בטבלה הכנס את גודלו )לפי היחידות שהוגדרו בחלון הלכ 
 ראה לפי הדוגמא הבאה:  Widthו  Lengthהקלדת הערכים תחת הכיתובים 

 

        
 

 ניתן לקבוע את הגדלים של תאי הבקרה באופן קבוע ע"י הפעולות הבאות: 

בטבלה  .  Options תורולחץ על כפ Pipeline →Sectionsמתוך התפריט הפעל: 
ואת גודל תא הבקרה Type הקלד שם לסוג הגודל לפי בחירתך תחת הכיתוב  שנפתחה,

 Pipeline)בהתאם ליחידות שהוגדרו בחלון    Length  ,Widthלכל סוג תחת הכיתובים 
list:ראה לפי הדוגמא ) 

 

        
 

את אותם גדלים,  במקום להכניס מספר פעמים   Pipeline layoutהכעת תוכל בחלון 
 . לפי הדוגמא: Typeלהקליד רק את שם הסוג שהגדרת תחת הכיתוב 

 

 
 

 (:-Manholes)בהגדרת ה Layout –אפשרויות נוספות בחלון ה 
 

Clear all Manholes  - הנוכחי.  מחיקת כל נתוני התאים השייכות לקו 
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  Delete one manhole -  הרצוי ולחץ על מחיקת הנתונים של תא אחד. סמן את התא
 כפתור זה.

  

   - Show pipeline  איתור צינור ע"ג השרטוט. לאחר לחיצה על כפתור זה הצינור
 הנוכחי יסומן בצהוב ע"ג השרטוט.

 
 

   (Crossings)סימון חציות קווים 
 

, אם נקודות אלה   לפרויקטבאפשרותך לסמן נקודות חציה של קווים ע"י קווים שאינם שייכים 
 . ידועות לך

 . Pipelines → Crossingsלשם כך בחר מהתפריט הראשי:  
 

 . Crossings –מימין יפתח חלון ה 
St.   במטרים(. בפרויקט : מרחק רץ. הכוונה למקום בו עובר הקו  החוצה על גבי הקו הקיים( 
IL. .)רום פני הצינור החוצה )לא חובה למילוי : 

Diam. למילוי.  : קוטר הצינור החוצה. נתון זה אינו חובה 
R/L  הזן את האות( חציה מימין או משמאל :R    לחציה מימין אוL  )נתון   –לחציה משמאל

 זה אינו חובה למילוי. 
 
 ( בתיבה שבראש החלון. crossings) . בחר את הצינור עבורו ברצונך לסמן חציות1
 ע"י אחת מהדרכים הבאות: Station -ה . מלא את נתון 2
 

 מרחק רץ של הקווים החוצים במטרים.  -Crossingsה בטבלת הזן  -באופן ידני  
 

 . Pick –שימוש ב  
 בתיבה שבתחתית החלון.    Pickסמן  
   Station  –נתון ה  עבור אל אזור השרטוט וסמן את הנקודה בקרבת הקו הרצוי. 

. אם ברצונך לסמן נקודות שקיימות כבר  crossings –יוזן אוטומטית בטבלת ה 
 Object Snapאליהן ע"י שימוש באפשרות של  מדלהיצבשרטוט, באפשרותך 

Settings  לנקודה ב- AutoCAD/ZWCAD . 
                                                                                                   

לרשימת  החצייה. לשם כך עליך, קודם כל להוסיף את נקודות Locate –שימוש ב  
, להציגן על גבי השרטוט ולאחר מכן CivilCAD  10–המתוכננות ב  תקואורדינטוה

 : Locate  –לבחור אותן ע"י שימוש ב
 . Design → Coordinatesבחר בתפריט הראשי:  
 Design coordinates –בטבלת ה  החצייהשל נקודות  קואורדינטותההקלד את  

 שבתחתית המסך משמאל. 
  –יכת הנקודות שבראש חלון ה נעשית בתוך שורת ער קואורדינטותההקלדת  

Design coordinates :לפי הפורמטx     y         שם נקודה. )אין להקליד גובה
 . Enterנקודה( . בסיום הקלדת כל נקודה לחץ 

 לרענון השרטוט. בסיום הרענון, הנקודות יופיעו על גבי השרטוט. לחץ  
 מימין.   Crossings  –בחלון ה   Locateבחר  
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  –השרטוט וסמן את הנקודות אשר הקלדת קודם לכן בטבלת ה  עבור אל אזור 
Design coordinates   ע"י לכידתן. נתון ה–   Station  יוזן אוטומטית לטבלת ה–  

Crossings . 
 

. באפשרותך לבחור את הקו החוצה את הקו הנוכחי ע"י סימון קו  Select -שימוש ב 
, עבור   Select. לחץ על קטבפרוימשורטט ע"ג התנוחה גם אם אינו מוגדר כציר 

, הטבלה תתעדכן במרחקים ENTERלאזור השרטוט וסמן את הקו הרצוי. לחץ 
הרצים ותחשב את גובה ההצטלבות לפי הגובה שמוגדר בקו המשורטט. אם בקו 

מטר מתחת לגובה  1.5 -שבחרת אין גובה התוכנה תגדיר את גובה ההצטלבות כ
 המצב הקיים באותה הנקודה.

 
. באפשרותך לבחור מספר קווים שחוצים את הקו הנוכחי ע"י Filtering -שימוש ב 

סינון קווים אלו מהשרטוט ממספר שכבות וממספר סוגי קווים בבת אחת ע"י 
 הפעולות הבאות:

פתח החלון  י, י   Filter crossings lines from dwg לחץ על כפתור   
Filter crossings . 

( את השכבות שבהם נמצאים  Layersבאפשרותך לסמן ברשימת השכבות ) 
 -Select( את סוג הקווים או להשתמש בEntitiesהקווים וברשימת הצורות )

וללחוץ על הקו או הקווים המסמלים את סוג הקו והשכבה שמהם אנו נבצע  
 את הסינון.

כדי לבצע את הסינון. בקווים שאינם מכילים גובה התוכנה  Applyלחץ  
 מטר מתחת למצב הקיים באותה נקודה.  1.5-תקבע את גובה ההצטלבות כ

 
וקוטר הצינורות, אם יש )שני נתונים אילו    IL –הזן את נתוני ה  Crossings . בטבלת ה3

 אינם חובה להקלדה(. 
 חציות הקווים יופיעו בשרטוט החתכים.

 

 תכנון חתכים 
 
 . Pipelines → Sections. מסרגל התפריט הראשי, הפעל:  1
 החתכים.לפניך יפתח חלון     
 החלון שיפתח מחולק ל:     

 אזור השרטוט )המשטח השחור(. -         
 (. Topoהטבלה משמאל למטה ) -טבלת נתוני הקרקע  -         
 הטבלה מימין למטה.  –טבלת נתוני התכנון  -         

 . בחר את הקו שברצונך לתכנן בתיבה שבראש החלון:   2 
  

פתח טבלה. ית   Options : לחץ על כפתורפן אוטומטידלי תאי הבקרה באווקביעת ג. 3
ואת גודל התא לכל סוג תחת Type הקלד שם לסוג הגודל לפי בחירתך תחת הכיתוב 

( ראה לפי  Pipeline list)בהתאם ליחידות שהוגדרו בחלון   Length  ,Widthהכיתובים 
 הדוגמא:
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 :נתוני טופוגרפיה תהבא. 4
 ם: הכנת רקע המצב הקיים ותכנון תנוחת קווים, באפשרותך  בצעת את הסעיפיאם  -

המופיע משמאל לטבלת  ,  לגזור את נתוני הקרקע מהתנוחה:  לחץ על כפתור    
 הטופוגרפיה תתמלא.טבלת   הטופוגרפיה.

)מרחק    Stationהקלד נתוני טופוגרפיה בטבלת הטופוגרפיה לפי –אם לא תכננת תנוחה  -
    Distanceרץ( או 

 )גובה(.   Elevation  –)מרחק( ו   
 
  הזנת נתוני קרקע מתוכננת )לא חובה(:. 5

 בצעת את הסעיפים: הכנת רקע המצב הקיים ותכנון תנוחת קווים, באפשרותך  אם 

 המופיע משמאל        , לגזור את נתוני הקרקע המתוכננת מהתנוחה:  לחץ על כפתור  
 לא בנתוני קרקע מתוכננת.לטבלת הטופוגרפיה. טבלת הטופוגרפיה תתמ

בחר  Ground Level -אם ברצונך להזין ידנית נתוני קרקע מתוכננת, בצע: בטבלת ה 
. הזן נתוני הקרקע המתוכננת באותו האופן בו הזנת את נתוני ”Design“באופציה 

 הטופוגרפיה. 
קום  להבאת השרטוט )מופיע מימין(. על המסך יופיע חתך פני הקרקע עם סימון מי OKלחץ 

 תאי הבקרה.
 
את  ”( , עליך להזיןDesign. בטבלת התכנון שבתחתית המסך )הטבלה בעלת הכותרת: “6

הזנת נתוני חתך האורך של הקו. באפשרותך להקליד לכל שוחה את העומק האבסולוטי ע"י 
. לפי הקלדת Depthאו למלא את עומק הקו תחת הכיתוב   Elevationתחת הכיתוב נתונים 

 ם הנ"ל התוכנה תעדכן את הנתון השני באופן אוטומטי. אחד מהנתוני
 
 : בטבלת התכנון הזן נתוני החתך של הקו כדלהלן:נתוני החתך. 7
 

 Man. .מספר השוחה : 
 St. .מרחק רץ : 
 Distance  במקום מרחק רץ של החתך, באפשרותך למלא מרחקים בין נקודות :

 של הנקודה הראשונה.  .Stב 0השבר, כאשר עליך להזין 
 Elevation/dH גובה או הפרש גובה ממצב הקרקע המתוכננת, אם יש. אם לא, אזי :

 ההפרש מתייחס למצב קיים.
 Depth- עומק השוחה 
 Ground .רום פני הקרקע . התוכנה מציגה נתון זה והוא אינו למילוי ע"י המשתמש :

ני  , נתוניה יופיעו כאן. אחרת, יופיעו כאן נתובפרויקטאם קיימת קרקע מתוכננת 
 הקרקע הקיימת.

 Number :מספר הצינורות לשוחה הנוכחית. 
 Diameter :קוטר כל צינור בשוחה הנוכחית. 
 Type אם מוגדרים סוגי שוחות ב( סוג השוחהSTATUS) 
 Length אין צורך למלא אם משתמשים ב( אורך השוחהType) 
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 Width אין צורך למלא אם משתמשים ב( רוחב השוחהType) 
 

 ן הימני לעדכון השרטוט. בחלו Applyלחץ  .8
 

 פרוט הפעולות בחלון החתכים 
 

  - Save project)לחיצה על כפתור זה  – שמירה )מתוך סרגל הכלים שמעל לשרטוט
 , כפתור זה מאפשר את השמירה מבלי לצאת מחלון החתכים. הפרויקטתבצע שמירה לכל 

 

 של חתך לאורך בודד, או של כל החתכים:   Dxfיצירת קובץ  
 לחיצה על כפתור זה תפתח חלון, נסביר את האפשרויות בחלון זה:  לאחר

 .Height,Lengthמלא את קנה המידה בשדות  
הרצוי   הגיליון , בחר את גודל מסוים גיליוןעל מנת להדפיס את החתך לפי גודל  

 . Divide by paper sizeברשימה הנפתחת, תחת הכיתוב 
. על מנת לקבל קובץ עם כל  OKעל מנת להוציא את החתך הנוכחי בלבד ,לחץ   

 .DXF-Allהחתכים לחץ 
 . נפתחה תיבה לשמירת קבצים. בחר את מיקום הקובץ, הקלד שם קובץ ולחץ שמירה

 

לאחר לחיצה על כפתור זה יפתח חלון שבו יש להקליד את קנה  –הדפסת החתך   
לון  בח  OKכדי להדפיס את החתך ולאחר מכן יש ללחוץ   OKהמידה וללחוץ על כפתור
 ההגדרות של המדפסת. 

 

יש ללחוץ על כפתור זה על מנת לצפות בתצוגה של כל החתך ע"ג חלון   –תצוגה מלאה   
 השרטוט.

 

 כפתור זה מוחק לגמרי את השוחה, כולל מרחק רץ. - מחיקת שוחה 
  

 מחיקת נתוני כל התכנון.( -Design)ליד טבלת ה 
 

כל הטופוגרפיה של הטבלה הנוכחית  מחיקת נתוני( Ground level-)ליד טבלת ה 
(Design/Existing.)   
 

:  סמן את העמודה השמאלית ביותר בטבלת התכנון בשורה שלפני הוספת תא בקרה
הוסף את הנתונים   שתתווסףבמקלדת. בשורה  Enterהנקודה שברצונך להוסיף , ולחץ 

 הדרושים. 
 

יע חלון עם נתוני התכנון. סמן  . לאחר לחיצה על כפתור זה יופהגבהה/הנמכה של הצינור 
. בתחתית הטבלה הזן Aאת הנקודות הרצויות להגבהה/הנמכה )לסימון כל הנקודות לחץ 

 . טבלת התכנון תשתנה בהתאם.OKגובה רצוי )להנמכה מס' שלילי(, ולחץ 
                                                                                                                 

מכיל טופוגרפיה וכן   שהפרויקט.  )בתנאי הבאת טופוגרפיה קיימת עבור כל הקווים 
 תנוחת הקווים(. 
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, כולל קווי גובה בפרויקט. )בתנאי שקיימת קרקע מתוכננת הבאת נתוני קרקע מתוכננת 
 מתוכננים וכן תנוחת הקווים(.

 

. )בתנאי שקיימת קרקע מתוכננת הקווים הבאת נתוני קרקע מתוכננת עבור כל 
 , כולל קווי גובה מתוכננים(.בפרויקט

 
 - View  השארת הנתונים תחת כיתוב זה ריקים מגדירה לתוכנה התצוגה של החתך טווח .

(. ניתן  Total rangeהצגת החתך במלואו )האורך המלא של החתך מופיע ליד הכיתוב:  
סת המרחק הרץ ההתחלתי והסופי לתוך השדות ע"י הכנ מסויםלהציג את החתך של קטע 

From,To  שינוי גובה החתך יתבצע ע"י שינוי הערך .Height factor יש ללחוץ .OK   לאחר
 שינוי בנתונים אלו לעדכון התצוגה.

 
Topography data לאופציהע"י המעבר  – החלקת פני הקרקע Smooth  פני הקרקע

 . מדויקישורטטו באופן חלק יותר אך פחות 
 

באפשרותך לשלוט על הצבעים בכל שכבה בחתך ע"י  – שינוי הצבעים בשכבות החתך
 לחיצה על הריבועים  הנמצאים בחלקו העליון של המסך ליד הכיתובים הבאים: 

  - Ground level  .שכבת גבהי המצב הקיים 
  - Design level .שכבת גבהי המצב המתוכנן 
  - Manholes .שכבת השוחות 

 פתח חלון עם צבעים וממנו ניתן לבחור את הצבע הרצוי. יל צבע השכבה ילאחר לחיצה ע
 

פעולה זו תעתיק את  – העתקת המרחקים הרצים של נתוני הקרקע אל טבלת התכנון 
 אל טבלת התכנון, לצורך נוחות תכנון.   Topography -מטבלת ה  Stations -ה
  

נור באופן אינטראקטיבי ע"ג . באפשרותך לשרטט ציתכנון צינור באופן אינטראקטיבי
 המסך, במקום להזין נתוני הקו.

 בתיבה:  Pickבחר את האופציה  
 עבור אל אזור השרטוט ושרטט את הקו. טבלת התכנון תתמלא בעת השרטוט.  

  
 -. מאפשר איתור והחברות אל נקודת מפנה אנכית בשרטוטLocate  -שימוש ב 

 בחר בטבלה את הנקודה שברצונך לאתר.  

 .בתיבה:  Locateאת האופציה בחר  
 עבור אל אזור השרטוט. סמן העכבר ייצמד לנקודה שבחרת. 

 

 חות "הפקת דו
  

 . Pipelines → Reportsהפעל מהתפריט הראשי: 
 

 פתח מימין בחר מתוך הרשימה את סוג הדו"ח אשר ברצונך לקבל: יבחלון שי
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Manholes report  –   .דו"ח שוחות 
 

ו"ח תציג בפניך דו"ח מפורט של נתוני שוחות. באפשרותך להציג לחיצה על כפתור הפקת הד
 דו"ח זה ע"ג השרטוט ע"י הפעולות הבאות:

 
 Manholes באופציה בחר מתוך הרשימה הנפתחת 
 כדי להפיק את הדו"ח  Applyלחץ 

 .  לאחר שהתוכנה תציג את הדו"ח סגור את החלון )חלון הדו"ח( ולחץ על כפתור 
חץ על הנקודה הרצויה למיקום הדו"ח )בחר את הפינה עבור לאזור השרטוט ול 

 השמאלית תחתונה שבה ימוקם הדו"ח(.
 . Enterולחץ   ’AutoCAD/ZWCAD  ‘SET-הקלד ב, לאחר שתופיע מסגרת צהובה  

 
IP's Report  – )אפשרי  –דו"ח נקודות מפנה של הקווים בפרויקט )הכוונה לנקודות התנוחה

באפשרותך להציג דו"ח זה ע"ג השרטוט כפי  פרויקט. רק אם קיימת תנוחה של הקווים ב 
 שהוסבר בסעיף זה בדו"ח השוחות.

 
 חות ”אפשרויות נוספות בחלון הדו

 

 , ע"י לחיצה על כפתור זה הנמצא בחלון הדו"ח. הדפסת הדו"ח 
 

. לחיצה על כפתור זה המופיע בחלון הדו"ח תפתח חלון  שמירת הדו"ח כקובץ טקסט 
את המיקום הרצוי לשמירה. הקלד שם קובץ בשורה המתאימה, לשמירת קבצים. בחר 

 ולחץ שמירה. כעת באפשרותך לפתוח את הקובץ ולערוך אותו כרצונך. 
 

. ע"י לחיצה על כפתור זה הנמצא בחלון הדו"ח התוכנה Excellייצוא הדו"ח לקובץ  
 ותמלא אותו בנתוני הדו"ח האחרון.  Excell גיליון תפתח 
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 כלליים  נושאים :23 פרק
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 נושאים כללים 
 

. הפעולות שיתוארו יאפשרו  CivilCAD 10הפרק שלפניכם דן בנושאים כלליים של תוכנת 
 . החלקים בפרק הנם:פרויקטיםקביעת הגדרות לעבודה עם 

 
 Configurationתאור הפעולות בחלון  
 קואורדינטות יצירת מסגרת  
 לגיליונות חלוקה  
 הפרויקטקביעת פרמטרים של  
 כלונסאותרשי חישוב הפ 

 
 

 Configurationתאור הפעולות בחלון  
 

שבו אנו עובדים, באפשרות תוכנת  בפרויקט הפעולות בחלון זה קובעות את צורת העבודה 
CivilCAD 10  חדש שנפתח כדי שלא   פרויקטלקבוע את הגדרות אלו באופן קבוע לכל

ת אלו. קביעת נצטרך לעשות זאת בכל פעם מחדש אלא אם כן נרצה לשנות את הגדרו
 . Prototype  בפרויקטהחדשים תבוצע ע"י שינוי ההגדרות   הפרויקטיםההגדרות לכל 

 
 הפרויקט נמצא במיקום ברירת המחדל:  Windows 7/8/10במערכת הפעלה 

C:\ProgramData\SivanDesign\CivilCAD\Prototype.prj\ 
 

 לחץ על כפתור  או  File → Configurationלהפעלת חלון זה בחר מהתפריט הראשי 
  ע"י הכפתורים ביניהם מסכים שניתן לדפדף  4-מתוך סרגל הכלים הראשי, חלון זה מורכב מ

 שנמצאים בחלקו העליון של חלון זה. נסביר את הפעולות בחלון זה לפי סדר המסכים:
 

General settings .1 
 

 Language - .תוכנת  בחירת השפהCivilCAD 10  עובדת בשפה העברית
שהתוכנה מייצרת. יש   DXFצי ה ובחות, ובק" ית. ערך זה קובע את השפה בדווהאנגל

, לאחר שינוי השפה נצטרך לבצע DXFלזכור שכאשר אנו מפיקים דו"ח או קובץ 
 פעולה זאת שוב.

 System of units -  .בחירת שיטת המידות שבה התוכנה תשתמש 
1. Metric - .)השיטה המטרית )מטרים 
2. English  – השיטה האנגל( יתfeet .) 

 Angle's units  –  .שיטת הזוויות שבה התוכנה תשתמש 
1.  – Degrees .מעלות 
2. Grads -  .גראדים 

 Printout font's size חות שהתוכנה " ערך זה קובע את גודל הכיתובים בדו
 מייצרת. 

Auto launch - .זו ניתן לבחור את סוג  באופציהקביעת סביבת העבודה הגראפית
, כאשר נבחר CivilCAD 10ר הסביבה הגראפית לתוכנת התוכנה שבה נשתמש בתו 

התוכנה תעבוד כיחידה עצמאית ללא תוכנה חיצונית כמו    NO  באפשרות
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AutoCAD  או ZWCAD התוכנה תפעיל את סביבת העבודה החדשה שנבחר רק .
 לאחר היציאה מהתוכנה עם שמירת הנתונים והפעלתה מחדש.

 Auto Save - זמן קבועים, יש לסמן ' שמירה אוטומאטית בפרקיV  באופציה זו '
 ולהגדיר את הזמן הרצוי )בדקות( לביצוע שמירה אוטומאטית.

 Save Backup -  ות.גירסהשמירה של פרויקט במספר 

 . ’Files→Configurations‘מהתפריט הראשי הפעל:  •

 . ’Save Backup‘באופציה  ’V‘', סמן ’General Settingsבלשונית  •

ות הפרויקט ולחץ על  גירסהגדרת נתיב למיקום שמירת לה לחץ על כפתור   •
 . 'Open'כפתור 

 ות. גירסה 3ות לשמירה. ברירת המחדל הינה  גירסההגדר מספר  •

הישנה  גירסהות ובוצעה שמירה בפעם הרביעית, הגירסה 3במידה והגדרת  •
 הנוכחית. גירסהביותר תידרס ובמקומה תישמר ה

 
 Lha.*ות תישמרנה בפורמט גירסהה :הערה 

 

כדי להגדיר שמירה אוטומאטית באופן קבוע עבור כל פרויקט חדש, יש לבצע   •
 . Prototypeאת ההגדרה הנ"ל בפרויקט 

, מהתפריט הראשי הפעל: Backup –כדי לטעון פרויקט שנשמר כ  •
File→Restore Project . 

 . 'Open'בחר את הקובץ הרצוי ולחץ על כפתור  •
 
 
 Auto Vertical alignment mode – בת העבודה בחלון חתך האורך  סבי

 )בכבישים(. 
1. Drawing environment interface -   סביבת עבודה של

AutoCAD/ZWCAD . 
2. Stand alone - ( סביבת עבודה ללא תוכנה חיצוניתAutoCAD/ZWCAD .) 

  AutoCAD styles- מצב חלון ה –AutoCAD/ZWCAD   יש לקבוע הגדרות אלו(
 (: Prototype בפרויקט

1. Menu – ת התפריט הראשי.תצוג 
2. Toolbars  –  .סרגלי הכלים 
3. Command line  –  .שורת הפקודות 
4. Status bar  –  נמצא תמיד בחלקו התחתון של חלון   הסטאטוססרגל(

 התוכנה(. 
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Drawing environment .2 

 
 2D/3D Work state -  נסמן את  ממדייםכאשר נרצה שהתוכנה תייצר קווים תלת

שהתוכנה תייצר יהיה בעל נפח   Dwgרה זה קובץ ה, במק3D work state האופציה
התוכנה תייצר קווים ללא גובה. הגדרות אלו  2D work stateיותר גדול. ובמצב של 

 משפיעות על אופן תצוגת הקווים בלבד ולא על חישובי התוכנה.
 Blocks mode פרויקטזו מאפשר יצירת   אופציהסימון  -מצב עבודה עם בלוקים 

ולבצע שמירה. לאחר   Prototype בפרויקטם. יש לסמן ערך זה לעבודה עם בלוקי
עם בלוקים. להרחבה בנושא זה ראה  כפרויקטחדש שייפתח יוגדר  פרויקט מכן כל 

 פרק עבודה עם בלוקים. 
 Standard mode זו מאפשר יצירת   אופציהסימון  - מצב עבודה עם טקסטים

ולבצע   Prototype רויקטבפלעבודה עם טקסטים בלבד. יש לסמן ערך זה  פרויקט
 עם טקסטים.   כפרויקטחדש שייפתח יוגדר  פרויקטשמירה. לאחר מכן כל 

Purge all when refreshing   –   מחיקת שכבות מיותרות. כאשר בחירה זו
התוכנה תמחק  Refresh allאו     Refreshמסומנת, בכל פעם שנלחץ על כפתור  

 קשורות לתוכנה. את כל השכבות המיותרות כולל שכבות שאינן
  - Global scale .)שינוי ערך זה יגדיר לכל התוכנה גודל פונט קבוע )לפי קנה מידה 
 DXF File's format - שינוי ערך זה יקבע את הפורמט של קבציי הDXF- 

שהתוכנה מייצרת כאשר אנו מבצעים שמירה מכל מקום בתוכנה אשר ניתן דרכו  
 תכים לרוחב, שרטוט מחלון התלת מימד וכו'.כגון חתכים לאורך,ח DXFלייצר קובץ 

 Do not reverse section´s labels (Hebrew mode only) –   כאשר אנו
עובדים בשפה העברית, התוכנה הופכת את הכיתובים בשרטוטים של החתכים  

לא נרצה שהתוכנה   מסוימיםהשונים בתוכנה כדי שיוצגו בשפה העברית. במקרים 
 AutoCAD/ZWCAD – זו לדוגמא, כאשר בתוכנת ה פציהאו נסמןתבצע זאת ולכן 

מותקנת תוכנה שהופכת כבר את הכיתובים בעברית, בכל פעם שנטען את החתך 
 זו.  באופציה, נקבל את הכיתובים הפוכים אם לא בחרנו DXFבפורמט 

 
Coordinates format .3 

 
 Dis files format - ה  קביעת פורמט קובץdis-או מייצאים   . כאשר אנו מייבאים

הכיתוב  לידאם  :זו. לדוגמא באופציההתוכנה קוראת אותו באופן המוגדר  DISקובץ 
xstart וxend -   כאשר נייבא קובץ 11-ו  1מופיעים הערכים ,DIS   , התוכנה תקרא

, וכך לגבי שאר הפרמטרים המוגדרים  X-מתוך עמודות אלו בקובץ את פרמטר ה
 זו.  באופציה

 Code columns - ערך זה יקבע את  . קואורדינטותה יקום הקודים ברשימתמ
שבו יוצגו הקודים במידה ונעבוד עם קודים   קואורדינטותההטורים ברשימת טווח 

 . בפרויקט
 New points counter -  כאשר אנו מכניסים נקודות קביעת שמות הנקודות .

באופן  חדשות לרשימה ע"י בחירתם ע"ג השרטוט עצמו, התוכנה נותנת את השמות 
אוטומטי. כדי לבחור את תחילת מספור השמות לפי רצוננו, נקליד את השם הראשון 

מסומנת, התוכנה  Auto names, אם הבחירה   Start counting fromליד הכיתוב 
תייצר נקודות לפי מספר הנקודות ברשימה. כלומר כל נקודה תקבל את השם לפי 

בהתאם לרשימה בה היא    Dוא T מיקומה ברשימה ובנוסף תוצמד אליה האות
 . (Designאו   Topography) נמצאת
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 Coordinate's length –  הקואורדינאטה אורך : 
1. Max 10 digits – 6 .ספרות משמאל לנקודה העשרונית 
2. Max 11 digits – 7 .ספרות משמאל לנקודה העשרונית 

 
Files settings .4 

 

File's paths - נה. הגדרת תיקיות ברירת המחדל של התוכ 
 

1. Project’s files -  תיקיית ברירת המחדל לפתיחה או שמירה של
 . פרויקטים

2. Coordinate`s files -  תיקיית ברירת המחדל לפתיחה או שמירת קובץ
 . קואורדינטות

3. Distomat`s files -  תיקיית ברירת המחדל לפתיחה או שמירת קובץ
 תצפיות בחלון הדיסטומט. 

 Save/Load from text file format -  של רשימת כאשר אנו מבצעים שמירה
לפורמט טקסט, יש באפשרותנו לבחור מראש לאיזה פורמט התוכנה  קואורדינטותה

תבצע שמירה ע"י בחירת המכשיר שאליו אנו מעוניינים להעביר את הקובץ או ממנו 
 אנו מעוניינים לקרוא. 

 

 קואורדינטותיצירת מסגרת 
 

ע"ג השרטוט. ע"י הפעלה  קואורדינטותסגרת מאפשרת הוספת מ CivilCAD 10תוכנת 
. לאחר כל שינוי בנתונים שבחלון זה General → Coordinates frameמתוך התפריט: 

כדי שהתוכנה תסמן מחדש את המסגרת לפי ההגדרות החדשות שנקבעו.  Applyיש ללחוץ 
 האפשרויות בחלון זה: 

 
End corner  –  ליונה של המסגרת המייצג את הפינה הע הקואורדינאטהערך 

Base first –  המייצג את הפינה הראשונה של בסיס המסגרת. הקואורדינאטהערך 
Base second -  של בסיס המסגרת. השנייההמייצג את הפינה  הקואורדינאטהערך 

 

(, התוכנה תשנה  (Extendsכפתור זה קובע את גבולות המסגרת כגבול השרטוט כולו   
 יצגות את המסגרת באופן אוטומטי. המי קואורדינטותהאת ערכי 

 

 המייצגות את פינות המסגרת. קואורדינטותהכפתור זה מוחק את ערכי   
 

Steps –  ע"ג המסגרת. קואורדינטותההמרחקים בין סימון 
Scale –  .ערך גודל המסגרת 

 
Select –   את המסגרת הרצויה  המייצגלחיצה על כפתור זה ולאחר מכן סימון קו

(Polyline ) .יקבע את המסגרת לפי הבחירה 
 

Pick -   בחירת פינות המסגרת ע"י לחיצה על כפתור זה ולאחר מכן בשרטוט: לחיצה על
 פינה ראשונה,פינה שנייה ופינה עליונה. 
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 לגיליונות חלוקה 
 

שונים ע"פ הגדרת כל  גיליונותמאפשרת חלוקה של השרטוט למספר  CivilCAD 10תוכנת 
)אפשרות זו  General → Frames makerהתפריט הראשי   בנפרד. הפעל מתוך גיליון

נסביר את האפשרויות בחלון זה וכיצד לייצר   .(  AutoCAD/ZWCADקיימת רק בעבודה עם  
 : לגיליונותחלוקה 

 
 Frames makerפרוט הפעולות בחלון 

 

  New border -  כפתור זה מוסיף מסגרת חדשה לרשימת המסגרות שנמצאת בחלקו
 החלון, השם המסומן בחלון זה מייצג את המסגרת הנוכחית.העליון של 

 

  Erase border - .כפתור זה מוחק מסגרת מרשימת המסגרות 
 

Mark project`s border as the frame window  -  כפתור זה קובע את גבולות כל
 . הנוכחיתכגבול המסגרת  הפרויקטהשרטוט של 

 

Show border contour  - הנוכחית ציג את הגבולות של המסגרת כפתור זה מ . 
 

 Options -   :כפתור זה מאפשר להגדיר את האפשרויות הבאות 
 Steps -  ע"ג המסגרת. קואורדינטותההמרחקים בין סימון 
 Scale - .ערך גודל המסגרת 
 Arrow block -  .מיקום קובץ הבלוק המייצג את חץ הצפון 
 Table block -  את הלוגו של החברה.מיקום קובץ הבלוק המייצג 
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 - Pick  ולאחר מכן בחירת שלוש פינות על זו   בחירה באופציהבחירת המסגרת ע"י
 .השרטוט

 
Select -  וסימון בחירה באופציה זו בחירת המסגרת ע"יPolyline  בשרטוט המגדיר את

 המסגרת. 
 

 Find- (.איתור המסגרת הנוכחית ע"ג השרטוט )המסגרת המסומנת ברשימת המסגרות 
 

 :גיליונות ליצירתנסביר בעזרת דוגמא את סדר הפעולות 
 

 General →Frames maker מתוך התפריט הפעל 
 קבע את גבולות המסגרת ע"י אחת מהדרכים הבאות: 
 

1. Selectשרטט ב : –  AutoCAD/ZWCAD המיקום   מסגרת לפי הגודל ,
רת. לחץ סגור כדי להגדיר את גבולות המסג  Polylineע"י    והזווית הרצויים

 .ENTER, סמן את המסגרת  שיצרת בשרטוט ולחץ  Selectעל 
2. Pick  :  לחץ על כפתור זה ולאחר מכן עבור לשרטוט וסמן את פינת הבסיס

 ואת הפינה העליונה ע"י שלושה לחיצות.  השנייההראשונה, 

 תקבע את גבול השרטוט כולו כגבול המסגרת. לחיצה על כפתור   .3
של הפינות   קואורדינטותהבאופן ידני את ערכי אפשרות נוספת היא להכניס  .4

 . End corner, Base first, Base secondבשדות: 
 

אם ברצונך להגדיר מסגרות  , כעת לאחר שהגדרת את המסגרת הראשונה  

כדי להוסיף עוד מסגרת לרשימה וחזור על   נוספות לחץ על כפתור  
 הפעולות מהתחלה עד לשלב זה כמספר המסגרות הרצוי. 

 . Applyשברצונך לייצר ולחץ   הגיליונותאת מספרי  הגיליונותן ברשימת סמ 
 

 הפרויקט קביעת פרמטרים של 
 

, היא מבצעת חישוב  בפרויקט מבצעת את חישובי הגבהים  CivilCAD 10כאשר תוכנת 
בעת חישובי   מסוימים. במקרים מסויםשאינו נראה למשתמש. חישוב זה מתבצע ע"פ דיוק 

לכן נגדיר לתוכנה להגדיל את הדיוק בשיטת   מדויקותבל תוצאות יותר עבודות עפר נרצה לק
 החישוב.

 כדי לקבוע את הדיוק בצע את הפעולות הבאות:
 

 General → Project parametersהפעל  
  המקסימאליכאשר הדיוק  Yה  וציר  Xבחר את הדיוק לציר ה  Stepsתחת הכיתוב 

 . 0.25הוא 
 

ייתכן ובמחשבים  המקסימאליגדולה אם נבחר בדיוק בעלי טופוגרפיה  בפרויקטיםהערה: 
 התוכנה תעבוד מאוד לאט )בהתאם למהירות המעבד(. מסוימים
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 חישוב הפרשי כלונסאות
 

מאפשרת חישוב של הפרשי כלונסאות ,החישוב מתבסס על חישוב  CivilCAD 10תוכנת 
 טח.ההפרשים של כלונסאות מתוכננות על השרטוט לבין המדידות הנלקחות מהש

 
התוכנה מבצעת חישוב זה ע"י השוואה בין המצב המתוכנן למצב הקיים, מציגה דו"ח מפורט  

של כל נקודה שנמדדה בשטח, התכנון המקורי שלה, הסטייה האופקית,האנכית והסטייה 
 הכללית. 

לאחר הצגת הדו"ח של חישוב זה, התוכנה תיצור שכבות חדשות על השרטוט המקורי.  
חצים ומרחקים המסמנים את הסטייה האופקית, האנכית והכללית בין בשכבות אלו יופיעו 

המצב הקיים למתוכנן. לפני פעולות אלו יש לבצע מספר הכנות שיבוצעו על השרטוט המקורי  
 בכדי שהתוכנה תוכל לבצע את החישובים בצורה נכונה.

 
 השלבים להכנת השרטוט: 

 
 במטרים עם דיוק של שלוש ספרות.שינוי הדיוק במידות ע"י העברתן למצב של עבודה 1

  AutoCAD/ZWCAD – אחרי הנקודה. את שיטת הדיוק אפשר לשנות מתוך התפריט של ה
, יש   Drawing units -בסרגל הראשי. נפתח חלון  Format→Unitsכניסה לתפריטע"י 

 את הדיוק של שלוש ספרות אחרי הנקודה.  Precision לבחור מתוך
 
  AutoCAD/ZWCAD  – צע ע"י כתיבה בשורת הפקודות של ה.שינוי המידות למטרים מתב2
 :Scale → All 

כאשר תופיע    0.01,בחירת הבסיס והפקטור )אם העברנו מסנטימטרים למטרים אז נכתוב 
 (. Scale-Factorהפקודה 

 ( יש לכבות שכבות אלו DIMהערה: יתכן ויהיו שכבות שלא ישונו ע"י פעולה זו )
 
.  AutoCAD/ZWCAD – בשורת הפקודות של ה Rotate → Allי  .שינוי זווית השרטוט ע" 3

 והכנסת הזווית הדרושה כך שהשרטוט יהיה מיושר. 
 
 

 והוצאת הנתונים ממנו. לפרויקטהכנסת השרטוט 
 

 נמשיך לשלב הוצאת הנתונים ממנו.השרטוט לאחר שסיימנו את שלב הכנת 
 
 . CivilCAD 10 -חדש ב  פרויקטפתח .1
 
 File → Openהפעל:   AutoCAD/ZWCAD-י בתוכנת ה.מתוך התפריט הראש2

 ובחר את קובץ השרטוט שעליו ביצעת את פעולות ההכנה.
 
 General → Filtering .לאחר שהשרטוט יופיע, מתוך התפריט הראשי בחר:3

רשימות העליונה תכיל את שמות השכבות שמופיעות שתי פתח מימין יופיעו  יבחלון שי
  קואורדינטותהתכיל את שמות הצורות שאפשר להוציא את בשרטוט והרשימה התחתונה 

 שלהן.
ומיד   selectבאפשרותך לסמן באופן ידני את הצורות והשכבות מרשימות אלו או ללחוץ על 

לעבור לשרטוט )הסמן יהפוך לריבוע קטן( וללחוץ על הצורה המבוקשת. לאחר שהצורה )או 
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ומנו באופן אוטומטי בשכבות ובצורות  ,התיבות יס  Enterמספר צורות( סומנה יש ללחוץ 
 .  Dwg בציועבודה עם קראה פרק  Filteringהמתאימות. להרחבה בנושא 

 
  קואורדינטותשהבכדי  Topography - בחר ב Topography,Design  . מתוך האפשרויות:4

 . Topography → Coordinates - שהתוכנה תסרוק יועברו לרשימת ה
 
 שנבחרו וממספרת באופן אוטומטי את שמות הנקודות,  .התוכנה סורקת את השכבות5

אם ברצונך לבחור את שמות הנקודות ע"י שכבה מסוימת בשרטוט שבה ישנם צורות מסוג 
Text  אוBLOCK פתח את חלון האפשרויות ע"י לחיצה על . המסמלות את שם הנקודה

בחר את . OKמתוך החלון ולחץ   Set names by layerוסמן את האפשרות  כפתור  
 –קביעת שם הנקודה להרחבה בנושא ראה בפרק   שכבת הטקסט ברשימה הנפתחת.

 . Dwgבצי וטיפול בק
 
התוכנה תסרוק את השכבות הנבחרות ,תמספר אוטומטית את שמות  . Apply.לחץ 6

הנקודות או שתתאים שמות שנסרקו בשכבת טקסט )אם אפשרות זו נבחרה( ותוסיף את 
)בשרטוטים גדולים ומורכבים   Topography coordinates - ת הלתוך רשימ  קואורדינטותה

 פעולה זו יכולה לערוך מספר דקות(.
 
 

 לפרויקטהכנסת המדידה 
 

 , נעלה את קובץ המדידה.לפרויקטלאחר שהוצאנו את נתוני התכנון מהשרטוט 
 

, בתיבה קואורדינטותה( בסרגל הכלים מעל לרשימת  Load from text file)  .לחץ על  1
 בחר את קובץ הטקסט .  -שנפתחה 

 ( Design-coordinates.)קואורדינטותה. הקובץ ייטען ויופיע ברשימת 2
 
 

 חישוב ההפרשים 
 

 לאחר שיצרנו את המצב הקיים והמצב המתוכנן נותר לנו רק לחשב את ההפרשים.
בחר את גודל . General→poles computations באופציה .מתוך התפריט הראשי בחר1

התוכנה תחשב את ההפרשים  .Applyלחץ ( וMaximum distance) המקסימאליה הסטיי
מתוך חלון זה ניתן להדפיס את  .בין המצב הקיים למתוכנן ותציג דו"ח מפורט בחלון שייפתח

 הדו"ח או לשמור אותו כקובץ טקסט.
 -. על מנת למקם את הדו"ח ע"ג השרטוט את הדו"ח ע"ג השרטוט עצמולמקם .ניתן גם 2

 , עבור לאזור השרטוט וסמן את המיקום שברצונך להוסיף את הדו"ח,  חץ על כפתורל
הדו"ח יופיע על השרטוט )ניתן  .  AutoCAD/ZWCAD– בשורת הפקודה של ה SETהקלד 

 (. Scale entitysרשימת לשנות את גודלו ע"י בחירת הגודל הרצוי מתוך 
   
ישפיע על גודל החצים שיופיעו ליד כל   ,  בלפני החישו Scale-entitysברשימת .שינוי הערך 3

 נקודה.
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 Poles computationsפרוט האפשרויות הנוספות בחלון 
 

התוכנה תציג את הדו"ח המחושב ואת הסטיות ע"ג  Applyלאחר לחיצה על כפתור 
השרטוט. ניתן לשלוט בתצוגת הסטיות ע"ג השרטוט ע"י בחירת כל אחת מהאפשרויות או  

ליד כל אפשרות תורה לתוכנה להציג אותה ע"ג השרטוט לאחר  Vן ע"י הסרתם )סימו
 החישוב(.

 
 Draw offsets values - .ערך הסטיות האופקיות והאנכיות 
 Draw offsets arrows -   .חצים המורים את כיוון הסטיות האופקיות והאנכיות 
 Draw total values -  ערך הסטייה הכללית )הערך של המרחק הישיר מהמצב

 יים ועד למתוכנן(.הק
 Draw total arrows -  .חצים המורים את כיוון הסטייה הכללית 
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 Dwgטיפול בקבצי  :24פרק 
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 Dwgבצי  וטיפול בק
 

בצי ועל ק CivilCAD 10הפרק שלפניכם דן בפעולות שונות שניתן לבצע עם תוכנת 
AutoCAD/ZWCADבצי ו, קDwgך . הפעולות שיתוארו יאפשרו הוצאת נתונים מתו

 השרטוט או כנתונים בודדים או על ידי "סינון נתונים" משכבות. החלקים בפרק הנם:
 

 . Dwgיבוא קובץ  
 . Dwgהוצאת נקודות מקובץ  
 . Dwgשימוש במסנן להוצאת נקודות מקובץ  
 קביעת שמות הנקודות המסוננות. 
 קביעת גבהי הנקודות המסוננות. 
 .צמצום מספר הנקודות המסוננות 

 

 Dwgיבוא קובץ 
 

עשה בד"כ כשלב ראשון בבניית הפרויקט.  יי CivilCAD 10לתוך פרויקט  DWGיבוא קובץ 
את הקובץ נרצה לייבא על מנת שישמש כרקע עבודה או על מנת שנוכל לחלץ מתוכו נתונים  

 , כפי המוסבר בהמשך הפרק. קואורדינטותכשונים 
 

 File → New -כשלב ראשון פתח פרויקט חדש ותן לו שם מסוים )השתמש ב 
project  .)כפי שמוסבר בפרקים שונים בספר 

 . File → Openהפעל:  AutoCAD/ZWCADמסרגל התפריט הראשי בתוכנת  
   לפרויקטהרצוי. לאחר ביצוע שמירה  Dwg -בחלון שנפתח, בחר את קובץ ה 

תבצע העתקה של הקובץ הנבחר לתוך  CivilCAD 10תוכנת  ,   File →Saveע"י
ט ותשנה את שמו לשם הפרויקט בתוספת _. מעתה, כל המחיצה בה נפתח הפרויק 

  Dwg -פתח הפרויקט הנ"ל, תפתח התוכנה באופן אוטומטי גם את קובץ היפעם שי
 המועתק.

 
 

הערה: אם כבר בוצעו פעולות שונות בפרויקט, כגון העלאת נקודות מדידה, יצירת קווי גובה 
. במקרה כזה יהיה עליך לבצע וכולי, הפעולה הנ"ל תגרום למחיקת השכבות שכבר נוצרו

 . ע"י לחיצה על כפתור  הפרויקטשחזור לשכבות 
 

 Dwg  הוצאת נקודות מקובץ
 

 Dwgשל נקודות מתוך קובץ  קואורדינטותמספקת כלי נוח לקליטת  CivilCAD 10תוכנת 
 בצע הפעולות הבאות: Dwg  לצורך התוויתם בשטח. על מנת לקלוט נקודות מקובץ

 
יבוא כפי המוסבר בחלק הקודם של הפרק "  Dwgוייבא אליו קובץ פתח פרויקט חדש  .1

 ".Dwgקובץ 
 ,Pickמתוך הרשימה ) Pick -(, בחר בTopography coordinatesבחלון התחתון ) .2

Locate, Freeze( בשורת הפקודות .)…Command:של ה )-  
AutoCAD/ZWCAD  יופיע הכיתובPick point/<1000>: אם ברצונך לשנות את .
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  -הכנס את מספרה החדש ו( , 1000  -)שונה מ וצר ונקודה החדשה שתישם ה
Enter .שורת הפקודה תשתנה בהתאם . 

עבור לאזור השרטוט ובחר עם העכבר את הנקודה שברצונך לקלוט. תוכל להשתמש  .3
  Endpoint)כמו  AutoCAD/ZWCAD -של ה Object Snap -בכל אופציות ה

. לאחר שנבחרה הנקודה היא תופיע, שם  לדוגמא( על מנת לבחור נקודה מדויקת
, ברשימת הנקודות שבתחתית. המשך ובחר את שאר הנקודות וקואורדינאטה

 הרצויות. 

בסרגל הכלים הראשי. הנקודות שבחרת יצורפו   בסיום קליטת הנקודות לחץ  .4
 לשרטוט. המשך וקלוט עוד נקודות עד קבלת הרשימה הרצויה. 

 
תמש בפעולות העורך, כגון מחיקת נקודה שגויה על ידי  במהלך קליטת הנקודות, ניתן להש

  פרוטל, שינוי שמות מספר נקודות על ידי סימונם כבלוק והוספת תו מסוים וכולי )  כפתור
 "(.קואורדינטותהין בפרק "מאגר יפעולות העורך ע  כל
 
 

 הצעת שיטת עבודה: 
 

הפרויקט תחילה,  נה קבלת פרויקט, עריכת נקודות כליאחת משיטות העבודה הנוחות ה
פי. נסביר כיצד ניתן להשתמש בתוכנה  אולאחר מכן בחירה של הנקודות לפי אזורים באופן גר

 באופן כזה:
 . Dwgפתח פרויקט חדש וייבא אליו קובץ  .1
השתמש בפעולות שנלמדו בפרק זה על מנת לערוך את נקודות המדידה לגבי כל   .2

קודות במספור ובשם רצוי, ולחץ ובחר נקודות, ערוך את הנ Pickהפרויקט. עבור עם  

 על מנת לקבלם על גבי המסך. 

מתוך סרגל הכלים. לאחר שמירת הפרויקט   שמור את הפרויקט ע"י לחיצה על  .3
תוכל לסגור את התוכנה ולחזור אליה בכל זמן רצוי על מנת "לחלץ" נתונים מתוך 

 הפרויקט. 
 

 : "חילוץ" נתונים מתוך פרויקט מוכן
 

 שר הכנת את נקודותיו. פתח את הפרויקט א .1
מתוך הרשימה  Locate -(, בחר בTopography coordinatesבחלון התחתון ) .2

(Pick, Locate, Freeze( בשורת הפקודות .)…Command:של ה ) –  
AutoCAD/ZWCAD   :יופיע הכיתוב

PolygonIn/PolygonOut/<Single>/(Esc)nd: " הכנס .I ( "PolygonInו )- 
 "Enterורת הפקודות יתחלף ל".  הכיתוב בש-  From point/Close/(Esc)nd:  .

עבור לאזור השרטוט ותחום את האזור שברצונך להוציא את הנקודות שבו. לסיום 
תאתר את הנקודות  CivilCAD 10". תוכנת Enter"  -( וClose" ) C"  לחץהפעולה 

 התחתונה. קואורדינטותהשבתוך התחום שסימנת, ותסמנם ברשימת 
 ספר אופציות:באפשרותך מ .3

 
שבחלון  Block" ליד המילה  Vיצירת קובץ של הנקודות שסימנת: סמן "  

הנמצא בסרגל   " Textהתחתון. לחץ על כפתור "שמירת הנקודות בקובץ 
 Block. לפניך תופיע ההודעה " קואורדינטותההכלים שמעל לרשימת 
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mode is on, Saving only block sectionן ”. אשר את ההודעה. בחלו
בחר את שם הקובץ הרצוי ליצירה ושמור אותו. התוכנה , הקבצים אשר יופיע 

, דהיינו הנקודות אשר כבלוקתשמור בקובץ רק את אותן נקודות אשר סומנו 
 נתחמו על ידי הפוליגון. 

  Block" ליד המילה  Vשליחת הנקודות המסומנות לתוך המכשיר: סמן "  

. אשר את ההודעה שתקבל.    Distomat -שבחלון התחתון. לחץ כפתור ה
המכשיר, סוג פתח חלון התקשורת. בחר את הפרמטרים הרצויים )ילפניך י

. התוכנה  Sendקצב תקשורת וכולי(, הכן את המכשיר לקבלת נתונים, ולחץ 
 תשמור את הנתונים בתוך המכשיר.

יצירת רשימת זוויות ומרחקים לנקודות המסומנות: מסרגל התפריט הראשי  
 -פתח חלון. בשדה הין יי . מימGeometry → Distance & Angleהפעל: 

Station  הכנס את שם התחנה ממנה יחושבו התצפיות. בחלוןZero point  
" )אם אין נקודה כזאת הכנס  0"  -הכנס את שם נקודת הייחוס שתשמש כ

על מנת לבחור את   Locate -ב כעתאחת מהנקודות במקום(. השתמש 
"  V( את הנקודות )" Block)כבלוק צפיות. סמן הנקודות עליהן יחושבו הת

שבחלון מימין.   ליד המילה בלוק שבחלון התחתון(, ולחץ על כפתור  
התוכנה תעביר את רשימת הנקודות המסומנות בבלוק לרשימת הנקודות 

בחלון מימין. התוכנה תחשב ותציג את  Applyשבחלון מימין. לחץ כפתור  
 ים לנקודות שסומנו. דו"ח המרחקים, זוויות ואזימוט

 

 Dwgשימוש במסנן להוצאת נקודות וקווים מקובץ  
 

  קואורדינטותהאת קובץ  CivilCAD 10מדי צריכה תוכנת יכחומר גלם ליצירת מודל תלת מ
של המצב הקיים. לעיתים קרובות קובץ זה אינו קיים בידנו אלא רק קובץ הרקע, כשרטוט 

לי נוח ויעיל על מנת "לחלץ" נקודות גובה מספקת כ CivilCAD 10. תוכנת Dwgבפורמט 
 : Dwgמתוך קובץ 

 
כפי המוסבר בתחילת הפרק )ראה "יבוא  Dwgפתח פרויקט חדש, וייבא אליו קובץ  .1

 "(.Dwgקובץ 
פתח חלון המסנן.  י. מימין יGeneral → Filteringמסרגל התפריט הראשי הפעל:  .2

( Entitiesימת ישויות )בחלון מופיעות שתי רשימות: רשימת שכבות השרטוט, ורש
 לבחירה.

 ע"י בחירתהנקודות סמן את הרשימה אליה אתה מעוניין לסנן את  .3
Topography/Design  . 

בתוך השרטוט, אתר את השכבה בה נמצאות נקודות המדידה, ומהו סוג הישות  .4
 וכולי(.  Point, Blockשמאפיין אותן )

. עליך לאתר את  Text -ו  Pointכגון שים לב: יתכן וישנם מספר מאפיינים לנקודות המדידה 
, לדוגמא, אינה במקום המדויק של הנקודה אלה Textהישות המדויקת ביותר )ישות מסוג 

 מוזזת ממנה במקצת(. 
, סמן  Selectברשימה מימין, סמן את השכבה ואת סוג הישות שנבחר או לחץ על  .5

. ע"י ENTERאת אחת הצורות בשרטוט המייצגת את השכבה ואת סוג הישות ולחץ 
 ברשימה. הישותבאופן אוטומטי את השכבה וסוג  התוכנה תסמן  Selectהשימוש ב
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. התוכנה תעבור על השרטוט ותסנן את נקודות המדידה לפי  Applyלחץ על כפתור  .6
השכבה והישות שנבחרו. בסיום התהליך תופיע רשימת נקודות המדידה בחלון  

 (. Topography coordinatesהתחתון )

 Select inside window  בשרטוט לחץ על כפתור    מסויםנך לסנן אזור  אם ברצו .7
בחלון מימין, עבור לשרטוט ולחץ על שתי פינות אשר ייצגו את החלון שבו התוכנה  

 תסרוק את הנקודות.

 . התוכנה תוסיף לשרטוט את שכבות הנקודות שיצרה. ץ לח .8
 

 ה וכולי. מכאן תוכל להמשיך ולעבוד כרגיל, כולל יצירת קווי גוב 
 

 : הערות
 

", אשר יפריעו בהמשך העבודה.    0יתכן ובשכבה שבחרת קיימות נקודות בעלות גובה " 
 לסילוק נקודות אלה הפעל:

 .  Findבחלון התחתון בחר בכפתור  .1
 . Accurate  - ו  Height  ,All - פתח בחר בישי Find -בחלון ה .2
ל הנקודות . התוכנה תאתר ותסמן את כOK" בשורת השדה ולחץ 0הכנס "  .3

 .0שהגובה שלהן הוא 

בקבוצת הכפתורים. התוכנה    , ולחץ כפתור Block" ליד המילה  Vסמן "  .4
 . 0את כל הנקודות בעלות גובה  תמחק

 לרענון השרטוט והמשך לעבוד כרגיל. לחץ  .5
 

 קביעת שמות הנקודות המסוננות.
 

רשימה וברצוננו  במידה והפעלנו את פעולת הסינון על מנת להוציא נקודות מהשרטוט ל
לקבוע את שמות הנקודות לפי שכבת טקסט המכילה את כיתובי השמות בצמוד לכל נקודה 
או שכבה המכילה בלוקים שבתוכם מוגדרים שמות הנקודות נבצע את הפעולות הבאות לפני 

 .General → Filteringבחלון  Applyלחיצה על כפתור 
 

 Options.-על מנת לפתוח את חלון ה לחץ על כפתור   
 Set points names by layer.ליד הכיתוב  V סמן 
את השכבה   Scan from layer בחר מתוך הרשימה הנפתחת תחת הכיתוב  

 המכילה את כיתובי השמות 
של רדיוס  המקסימאליהכנס את הערך  Scan names radiusליד הכיתוב  

שבחרנו,   הסריקה. התוכנה תסרוק לכל נקודה ברדיוס הנתון ותחפש טקסט בשכבה
 בערך של הטקסט לשם הנקודה. התוכנה תשתמש , באם תמצא

,  נסמן את Block -של ה  Attributeבמידה ואנו מסננים בלוקים והשם נמצא ב 
את השכבה שבה  Scan from layerונבחר תחת הכיתוב   Attributeהאופציה 
 . Attuributeנמצא ה

 .Applyקודות ע"י לחיצה על והפעל את סינון הנ Options-לצאת מחלון ה  OKלחץ  
 

 קביעת גבהי הנקודות המסוננות.
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על מנת להוציא נקודות מהשרטוט לרשימה ולקבוע את גבהי הנקודות לפי שכבת טקסט 
המכילה את כיתובי הגבהים בצמוד לכל נקודה או לפי שכבה המכילה בלוקים שבתוכם 

 בחלון  Applyעל כפתור   מוגדרים גבהי הנקודות נבצע את הפעולות הבאות לפני לחיצה
 General → Filtering . 

 

 Options.-על מנת לפתוח את חלון ה לחץ על כפתור   
 . Set points height by layerליד הכיתוב    Vסמן  
את השכבה   Scan from layer בחר מתוך הרשימה הנפתחת תחת הכיתוב  

 .המכילה את כיתובי השמות 
של רדיוס  המקסימאלינס את הערך הכ Scan heights radiusליד הכיתוב  

הסריקה. התוכנה תסרוק לכל נקודה ברדיוס הנתון ותחפש טקסט בשכבה שבחרנו,  
 בערך של הטקסט לגובה הנקודה.התוכנה תשתמש  ,באם תמצא

,  נסמן את Block -של ה Attribute - במידה ואנו מסננים בלוקים והגובה נמצא ב 
את השכבה שבה נמצא  Sacn from layerוב ונבחר תחת הכית  Attributeהאופציה 

 .   Attribute -ה
 .Applyוהפעל את סינון הנקודות ע"י לחיצה על  Options-לצאת מחלון ה  OKלחץ  

 

 צמצום מספר הנקודות המסוננות
 

נרצה לסנן קובץ מדידה שמורכב ממספר רב של שבהם   CivilCAD 10יתכנו מצבים בתוכנת
  CivilCAD 10, תוכנת לשנייהב של נקודות אשר קרובות אחת קווים ובכל קו ישנו מספר ר 

תסנן כל נקודה אשר נמצאת על קו. בשרטוטים כבדים פעולה זו תכביד על מעבד המחשב 
בין   מינימאליוגם על משקל הקובץ, לכן ניתן לצמצם את מספר נקודות אלו ע"י הגדרת מרחק 

 נקודה לנקודה. 
קו )כפי שהוסבר בסעיפים הקודמים( ,מתוך לאחר בחירת השכבות הרצויות וסוג ה 

 Options.-על מנת לפתוח את חלון ה לחץ על כפתור    Filtering-חלון ה
 . Reduce polyline pointsליד הכיתוב   Vסמן  
בין הנקודות אשר התוכנה תסנן )במטרים( ליד הכיתוב  המינימאליהכנס את המרחק  

Minimum distance . 
 .Applyוהפעל את סינון הנקודות ע"י לחיצה על  Options-לצאת מחלון ה  OKלחץ  

 

 
 


